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CHAPTER 1

Préambule

Ce document est le guide utilisateur original du logiciel décrit QGIS. Le logiciel et le matériel décrit dans ce
document sont la plupart du temps des marques enregistrées et sont donc soumis aux lois en vigueur. QGIS est
sous licence GNU General Public License. Vous pouvez trouver plus d’information sur la page principale de QGIS
https://www.qgis.org.

Les détails, données et résultats inclus dans ce document ont été écrits et vérifiés au mieux des connaissances des
auteurs et des éditeurs. Néanmoins, il est possible que des erreurs subsistent.

Ainsi l’ensemble des données ne saurait faire l’objet d’une garantie. Les auteurs et les éditeurs ne sauraient être
responsables de tout dommage direct, indirect, secondaire ou accessoire découlant de l’utilisation de ce manuel.
Les éventuelles corrections sont toujours les bienvenues.

Ce document a été rédigé en utilisant reStructuredText. Il est disponible sous forme de code source reST via github
et en ligne en HTML et PDF via https://www.qgis.org/fr/docs/. Les versions traduites de ce document peuvent
être téléchargées dans différents formats via la zone de documentation du projet QGIS. Pour plus d’information
pour contribuer à ce document et à sa traduction, allez sur https://qgis.org/fr/site/getinvolved/index.html.

Références de ce document

Ce document contient des références internes et externes sous forme de lien. Cliquer sur un lien interne provoque
un déplacement dans le document, tandis que cliquer sur un lien externe ouvrira une adresse internet dans le
navigateur choisi par défaut. Dans le PDF, les liens internes et externes sont indiqués en bleu et sont gérés par le
navigateur du logiciel. En HTML, le navigateur affiche et gère les deux types de liens de la même façon.

Auteurs et éditeurs :

La liste des personnes qui contribuent à l’écriture, à la relecture et à la traduction des documents suivants est
disponible à Contributeurs.

Copyright (c) 2004 - 2017 QGIS Development Team

Internet : https://www.qgis.org

Licence de ce document

La permission de copier, distribuer, modifier ce document est accordée sous les termes de la GNU Free Docu-
mentation License, dans sa version 1.3 ou plus récente telle que publiée par la Free Software Foundation; sans
modification de son contenu, sans ajouts la précédant ou la suivant. Une copie de la licence est incluse dans la
section Licence GNU de documentation libre.
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CHAPTER 2

Avant-propos

Bienvenue dans le monde merveilleux des Systèmes d’Informations Géographiques (SIG) !

QGIS est un logiciel SIG libre qui a débuté en mai 2002 et s’est établi en tant que projet sur SourceForge en juin
2002. Nous avons travaillé dur pour faire de ce logiciel SIG un choix accessible et viable pour toute personne
ayant un ordinateur (qui sont traditionnellement des logiciels propriétaires assez coûteux). QGIS est utilisable
sur la majorité des Unix, macOS et Windows. QGIS utilise la bibliothèque logicielle Qt (https://www.qt.io) et le
langage C++, ce qui se traduit par une interface graphique simple et réactive.

QGIS se veut être un logiciel SIG simple à utiliser, fournissant des fonctionnalités courantes. L’objectif initial
du projet était de fournir un visionneur de données SIG. QGIS a, depuis, atteint un stade dans son évolution où
beaucoup y recourent pour leurs besoins quotidiens. QGIS gère un grand nombre de formats raster et vecteur,
avec le support de nouveaux formats facilité par l’architecture basée sur les extensions.

QGIS est distribué sous la licence GNU GPL (General Public License). Ceci signifie que vous pouvez étudier et
modifier le code source, tout en ayant la garantie d’avoir accès à un programme SIG non onéreux et librement
modifiable. Vous devez avoir reçu une copie complète de la licence avec votre exemplaire de QGIS, que vous
pouvez également trouver dans l’Annexe licence GNU General Public License.

Astuce: Documentation à jour

La dernière version de ce document est disponible dans la section documentation du site de QGIS : https://www.
qgis.org/fr/docs/.
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CHAPTER 3

Conventions

Cette section décrit les styles utilisés uniformément dans ce manuel.

3.1 Conventions pour les éléments d’interface

Les conventions de styles de l’interface (GUI) dans le texte ressemblent autant que possible à l’apparence du
logiciel. En général, le style reflètera l’apparence des éléments lorsque la souris ne passe pas dessus, l’objectif
étant de permettre à l’utilisateur de repérer plus facilement les éléments mentionnés dans les instructions.

• Options du menu : Couches → Ajouter une couche raster ou Préférences → Barre d’outils → Numérisation

• Outil : Ajouter une couche raster

• Bouton : Sauvegarder par défaut

• Titre de boîte de dialogue : Propriétés de la couche

• Onglet : Général

• Case à cocher : Rendu

• Bouton radio : Postgis SRID EPSG ID

• Sélection d’un chiffre :

• Sélection d’une ligne :

• Parcourir pour trouver un fichier : . . .

• Sélection d’une couleur :

• Barre coulissante :

• Zone de saisie de texte :

Une ombre indique un élément de l’interface qui peut être cliqué.

5
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3.2 Text or Keyboard Conventions

Le manuel utilise également des styles pour le texte, les commandes du clavier et le code pour désigner différents
éléments tels que des classes et des méthodes. Ces styles ne correspondent pas à l’apparence réelle dans QGIS.

• Liens hypertexte : https://qgis.org

• Combinaisons de touches : appuyez sur Ctrl+B, signifie qu’il faut rester en appui sur la touche Contrôle
(Ctrl) tout en pressant la touche B.

• Nom d’un fichier : lakes.shp

• Nom d’une classe : NewLayer

• Méthode : classFactory

• Serveur : myhost.de

• Texte pour l’utilisateur : qgis --help

Les lignes de code sont indiquées comme suit :

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

3.3 Instructions spécifiques à un système d’exploitation

Une séquence d’interface peut être exprimée sur une ligne : Cliquez sur File QGIS → Quitter pour
fermer QGIS. Ceci indique que sur Linux, Unix et Windows, vous devez cliquer sur le menu Fichier puis sur
Quitter, alors que sur Macintosh OS X, vous devez cliquer sur le menu QGIS puis sur Quitter.

Les textes plus longs seront formatés comme des listes :

• Faites ceci

• Faites cela

• ou faites cela ;

ou comme des paragraphes :

Faites ceci et cela. Puis cela et ceci pour obtenir ça, etc.

Faites ceci et cela. Puis cela et ceci pour obtenir ça, etc.

Les copies d’écrans ont été prises sous différentes plateformes, un icône à la fin de la légende de la figure indique
le système en question.

6 Chapter 3. Conventions
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CHAPTER 4

Fonctionnalités

QGIS offre beaucoup d’outils SIG standards par défaut, et via les extensions de multiples contributeurs. Voici
un bref résumé en six catégories de fonctionnalités et extensions, suivi d’un premier aperçu de la console Python
intégrée.

4.1 Visualiser des données

Vous pouvez afficher et superposer des couches de données rasters et vecteurs (en 2D et 3D) dans différents
formats et projections sans avoir à faire de conversion dans un format commun. Les formats supportés incluent :

• Les tables spatiales et les vues PostGIS, SpatiaLite, MS SQL Spatial et Oracle Spatial, les formats vecteurs
supportés par la bibliothèque OGR installée, ce qui inclut les GeoPackages, Shapefiles ESRI, MapInfo,
SDTS, GML et beaucoup d’autres. Voir Les données vectorielles.

• Les formats raster supportés par la bibliothèque GDAL (Geospatial Data Abstraction Library) tels que
GeoTIFF, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG et beaucoup d’autres, voir section Les données
raster.

• Les formats raster et vecteur provenant des bases de données GRASS. Voir section Intégration du SIG
GRASS.

• Les données spatiales en ligne diffusées comme services web de l’OGC qui incluent le WMS, WMTS,
WCS, WFS et WFS-T. Voir la section Les données OGC.

4.2 Parcourir les données et créer des cartes

Vous pouvez créer des cartes et les parcourir de manière interactive avec une interface intuitive. Les outils
disponibles dans l’interface sont :

• l’Explorateur QGIS

• La reprojection à la volée

• Le Gestionnaire BD

• La Mise en page de cartes

• Le panneau d’aperçu

7
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• Les signets géospatiaux

• Les outils d’annotation

• L’identification et la sélection des entités

• L’affichage, l’édition et la recherche de données attributaires

• L’étiquetage se basant sur les valeurs des données attributaires

• Les outils de style définis par les données vecteur et raster

• La création d’atlas avec des couches de carroyage

• La flèche indiquant le nord, la barre d’échelle et l’étiquette de droits d’auteur

• La gestion de la sauvegarde et de la restauration des projets

4.3 La création, l’édition, la gestion et l’export des données

Vous pouvez créer, éditer, gérer et exporter des couches vectorielles et raster de nombreux formats. QGIS permet
notamment :

• La numérisation pour les formats gérés par OGR et les couches vectorielles de GRASS

• La création et l’édition de multiples formats de données ainsi que des couches vectorielles GRASS

• Le géoréférencement d’images

• L’importation et exportation du format GPX pour les données GPS, avec la conversion des autres formats
GPS vers le GPX ou l’envoi, la réception directement vers une unité GPS (pour Linux, le port USB a été
ajouté à la liste des ports utilisables)

• La visualisation et l’édition des données OpenStreetMap

• La création de tables de base de données avec l’extension DB Manager

• L’amélioration de la gestion des tables spatiales issues de bases de données

• Des outils pour la gestion des tables d’attributs des couches vectorielles

• La possibilité d’enregistrer des captures d’écran en tant qu’images géoréférencées

• L’outil Export-DXF avec capacités améliorées pour exporter les styles et des extensions fournissant des
fonctions similaires à celle d’une CAO.

4.4 Analyser des données

Vous pouvez réaliser des analyses de données spatiales sur des bases de données spatiales ou tout autre format géré
par OGR. QGIS propose pour le moment des analyses vectorielles, des outils de rééchantillonage, de traitements
spatiaux, et de gestion des géométries et des bases de données. Vous pouvez également utiliser les outils intégrés de
GRASS, ce qui inclut les fonctionnalités complètes de GRASS avec plus de 400 modules (voir section Intégration
du SIG GRASS). Ou bien travailler avec l’extension de Traitements, qui fournit un espace de travail puissant
d’analyse géospatiale pour appeler des algorithmes natifs tiers à partir de QGIS, comme GDAL, SAGA, GRASS,
fTools et plus (voir section Introduction).

4.5 Publier des cartes sur Internet

QGIS can be used as a WMS, WMTS, WMS-C or WFS and WFS-T client, and as a WMS, WCS or WFS server
(see section Les données OGC). Additionally, you can publish your data on the Internet using a webserver with
UMN MapServer or GeoServer installed.
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4.6 Étendre les fonctionnalités de QGIS à l’aide d’extensions

QGIS peut être adapté à vos propres besoins du fait de son architecture extensible à base de modules. QGIS fournit
des bibliothèques qui peuvent être employées pour créer des extensions, vous pouvez même créer de nouvelles
applications en C++ ou Python !

4.6.1 Extensions principales

Les extensions principales sont :

1. Saisie de coordonnées (enregistrer les coordonnées du pointeur de la souris dans un SCR différent)

2. DB Manager (éditer et visualiser des couches et des tables, exécution de requêtes SQL).

3. eVIS (visualiser des événements)

4. Vérificateur de géométrie (vérifier les erreurs de géométrie)

5. Géoréférenceur GDAL (projeter une image via GDAL)

6. Outils GPS (importer et exporter des données GPS)

7. GRASS 7 (intégration du SIG GRASS)

8. MetaSearch (interagir avec des services de catalogage de données gérant le standard OGC CSW (Catalogue
Service for the Web))

9. Édition hors connexion (éditer hors connexion et synchroniser avec une base de données)

10. Traitement (le module de traitement de données spatiales de QGIS)

11. Vérificateur de topologie (chercher des erreurs de topologie dans les couches vectorielles)

4.6.2 Extensions Python externes

QGIS offre un nombre croissant d’extensions en Python fournies par la communauté. Ces extensions sont en-
treposées dans le Dépôt d’Extensions officiel et peuvent être facilement installées en utilisant le Gestionnaire
d’extensions Python. Voir section La fenêtre des Extensions.

4.7 Console Python

For scripting, it is possible to take advantage of an integrated Python console, which can be opened with: Plugins
→ Python Console. The console opens as a non-modal utility window. For interaction with the QGIS environment,
there is the qgis.utils.iface variable, which is an instance of QgisInterface. This interface provides
access to the map canvas, menus, toolbars and other parts of the QGIS application. You can create a script, then
drag and drop it into the QGIS window and it will be executed automatically.

Pour de plus amples informations sur la console Python et la programmation d’extensions et d’applications QGIS,
référez-vous à La Console Python de QGIS et PyQGIS-Developer-Cookbook.

4.8 Problèmes connus

4.8.1 Limite du nombre de fichiers ouverts

Si vous ouvrez un gros projet QGIS et êtes sûrs que toutes les couches sont valides, mais que certaines sont
signalées comme mauvaises, vous faites probablement face à ce problème. Linux (et d’autres OSs, d’ailleurs) a
une limite de fichiers ouverts par processus. Les limites de ressource sont par processus et héritées. La commande

4.6. Étendre les fonctionnalités de QGIS à l’aide d’extensions 9
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ulimit, qui est intégrée dans l’interpréteur de commandes, change les limites seulement pour le processus en
cours de l’interpréteur; la nouvelle limite sera héritée par n’importe quel processus enfant.

Vous pouvez voir toutes les infos ulimit en cours en tapant

$ ulimit -aS

Vous pouvez voir le nombre actuellement autorisé de fichiers ouverts par processus avec la commande suivante
dans une console

$ ulimit -Sn

Pour modifier les limites d’une session existante, vous devriez pouvoir utiliser quelque chose comme ceci

$ ulimit -Sn #number_of_allowed_open_files
$ ulimit -Sn
$ qgis

Pour le régler définitivement

Sur la plupart des systèmes Linux, les limites des ressources sont définies à la connexion par le module
pam_limits conformément aux paramètres contenus dans le fichier /etc/security/limits.conf ou
/etc/security/limits.d/*.conf. Vous devriez pouvoir éditer ces fichiers si vous avez le droit root
(aussi possible via sudo), mais il vous faudra vous reconnecter avant que ces modifications ne prennent effet.

Plus d’infos :

https://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ https://linuxaria.com/article/
open-files-in-linux
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CHAPTER 5

Nouveautés dans QGIS 3.4

Cette version contient de nouvelles fonctionnalités et étend l’interface de programmation par rapport aux anciennes
versions. Nous recommandons d’utiliser cette version préférentiellement aux précédentes.

Cette version inclut des centaines de corrections de bugs et de nombreuses nouvelles fonctionnalités et améliora-
tions apportées depuis QGIS 2.18. Chacune d’elles sera décrite dans ce manuel. Vous pourrez également consulter
le journal des modifications : https://qgis.org/fr/site/forusers/visualchangelogs.html

11
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CHAPTER 6

Premiers Pas

Ce chapitre donne un bref aperçu de l’installation de QGIS, du téléchargement de quelques jeux de données QGIS
et du lancement d’une première session d’affichage de couches rasters et vectorielles.

6.1 Installer QGIS

QGIS project provides different ways to install QGIS depending on your platform.

6.1.1 Installing from binaries

Standard installers are available for MS Windows and macOS. Binary packages (rpm and deb) or software

repositories are provided for many flavors of GNU/Linux .

Pour plus d’information et des instructions pour votre système d’exploitation, rendez vous sur https://qgis.org/fr/
site/forusers/download.html.

6.1.2 Installation depuis les sources

Si vous souhaitez compiler QGIS à partir des sources, veuillez vous référer aux instructions d’installation. Elles
sont distribuées avec le code source de QGIS dans un fichier appelé INSTALL. Vous pouvez aussi le trouver en
ligne à https://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html.

If you want to build a particular release and not the version in development, you should replace master with
the release branch (commonly in the release-X_Y form) in the above-mentioned link (installation instructions
may differ).

6.1.3 Installation sur support externe

Il est possible d’installer QGIS (avec tous les plugins et paramètres) sur une clé USB. Ceci est réalisé en définissant
l’option –profiles-path qui remplace l’option par défaut user profile et force aussi QSettings à utiliser ce répertoire
. Voir la section :ref:‘env_options‘pour plus d’informations.
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6.1.4 Téléchargement des données exemple

This user guide contains examples based on the QGIS sample dataset (also called the Alaska dataset).

L’installateur Windows possède une option qui permet de télécharger le jeu de données échantillon de QGIS. Si
vous la cochez, les données seront téléchargées dans votre répertoire intitulé Mes Documents et placées dans
un répertoire GIS Database. Vous pouvez utiliser l’explorateur Windows pour choisir un autre répertoire de
votre choix. Si vous ne cochez pas cette option durant l’installation QGIS, vous pouvez :

• Utiliser des données que vous possédez déjà.

• Télécharger des données exemples depuis https://qgis.org/downloads/data/qgis_sample_data.zip

• Désinstaller et réinstaller QGIS en cochant, cette fois, la case de téléchargement (uniquement si les solutions
proposées ci-dessus ne fonctionnent pas).

For GNU/Linux and macOS, there are no dataset installation packages available as rpm, deb or dmg. To use
the sample dataset, download it from https://qgis.org/downloads/data/qgis_sample_data.zip and unzip the archive
on any convenient location on your system.

Le jeu de données Alaska inclut toutes les données SIG qui sont utilisées dans les exemples et dans les copie
d’écran du guide de l’utilisateur mais aussi dans une petite base de données GRASS. La projection du jeu de
données à renseigner dans QGIS est Alaska Albers Equal Area avec comme unités le pied. Le code EPSG est
2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Si vous avez l’intention d’utiliser QGIS comme interface graphique pour GRASS, vous pouvez trouver des
échantillons de données (par exemple, Spearfish ou South Dakota) sur le site officiel de GRASS GIS, https:
//grass.osgeo.org/download/sample-data/

6.2 Démarrer et arrêter QGIS

QGIS peut être démarré comme toute autre application sur votre ordinateur. Cela signifie que vous pouvez lancer
QGIS par :

• en utilisant le menu Applications s’il s’agit d’une version précompilée, le menu Démarrer ou le
Dock

• en double-cliquant sur l’icône dans votre répertoire d’Applications ou sur un raccourci sur le bureau

• en double-cliquant sur un fichier de projet QGIS (.qgs) existant. Notez que cela ouvrira le projet dans
QGIS
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• en tapant qgis dans une console (en supposant que QGIS a été ajouté à votre PATH ou que vous êtes dans
le répertoire d’installation)

Pour arrêter QGIS :

• cliquez sur le menu Projet → Fermer QGIS ou utilisez le raccourci clavier Ctrl+Q

• cliquez sur QGIS → Quit QGIS ou utilisez le raccourci clavier Cmd+Q

• ou utilisez la croix rouge située au coin supérieur droit de l’interface principale.

6.3 Exemple de session : Chargement de couches raster et vecto-
rielles

Now that you have QGIS installed and a sample dataset available, we will demonstrate a first sample session. In
this example, we will visualize a raster and a vector layer. We will use:

• la couche raster landcover du fichier (qgis_sample_data/raster/landcover.img)

• et la couche vectorielle lakes du fichier (qgis_sample_data/gml/lakes.gml)

Where qgis_sample_data represents the path to the unzipped dataset.

1. Démarrer QGIS comme vu dans Démarrer et arrêter QGIS.

2. To load the files in QGIS:

(a) Click on the Open Data Source Manager icon. The Data Source Manager should open in Browser mode.

(b) Browse to the folder qgis_sample_data/raster/

(c) Select the ERDAS IMG file landcover.img and double-click it. The landcover layer is added in
the background while the Data Source Manager window remains open.

(d) To load the lakes data, browse to the folder qgis_sample_data/gml/, and double-click the
lakes.gml file to open it.

(e) A Coordinate Reference System Selector dialog opens. In the Filter menu, type 2964, filtering the list
of Coordinate Reference Systems below.

(f) Select the NAD27 / Alaska Alberts entry

(g) Click OK

(h) Close the Data Source Manager window

You now have the two layers available in your project in some random colours. Let’s do some customization on
the lakes layer.

1. Select the Zoom In tool on the Navigation toolbar

2. Zoom to an area with some lakes

3. Double-click the lakes layer in the map legend to open the Properties dialog

4. To change the lakes color:

(a) Click on the Symbology tab

(b) Select blue as fill color.

(c) Press OK. Lakes are now displayed in blue in the map canvas.

5. To display the name of the lakes:

(a) Reopen the lakes layer Properties dialog

(b) Click on the Labels tab

6.3. Exemple de session : Chargement de couches raster et vectorielles 15
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Figure 6.1: Adding data to a new project in QGIS
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Figure 6.2: Select the Coordinate Reference System of data
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Figure 6.3: Selecting Lakes color
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(c) Select Single labels in the drop-down menu to enable labeling.

(d) From the Label with list, choose the NAMES field.

Figure 6.4: Showing Lakes names

(e) Press Apply. Names will now load over the boundaries.

6. You can improve readability of the labels by adding a white buffer around them:

(a) Click the Buffer tab in the list on the left

(b) Check Draw text buffer

(c) Choose 3 as buffer size

(d) Click Apply

(e) Check if the result looks good, and update the value if needed.

(f) Finally click OK to close the Layer Properties dialog and apply the changes.

Let’s now add some decorations in order to shape the map and export it out of QGIS:

1. Select View → Decorations → Scale Bar menu

2. In the dialog that opens, check Enable Scale Bar option

3. Customize the options of the dialog as you want

4. Press Apply

5. Likewise, from the decorations menu, add more items (north arrow, copyright. . . ) to the map canvas with
custom properties.

6. Click Project → Import/Export → Export Map to Image. . .

6.3. Exemple de session : Chargement de couches raster et vectorielles 19
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7. Press Save in the opened dialog

8. Select a file location, a format and confirm by pressing Save again.

9. Press Project → Save. . . to store your changes as a .qgz project file.

Vous pouvez constater combien il est facile d’afficher des couches raster ou vecteur dans QGIS, de les configurer
et de générer votre carte dans un format image que vous pouvez utiliser dans d’autres logiciels. Poursuivons pour
en savoir plus sur les fonctionnalités, les fonctions et les paramètres disponibles, ainsi que sur la façon de les
utiliser.

Note: Pour continuer à apprendre QGIS à travers des exercices pas-à-pas, suivre le :ref‘Manuel
d’apprentissage<QGIS-training-manual-index-reference>‘.
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CHAPTER 7

Working with Project Files

7.1 Introducing QGIS projects

The state of your QGIS session is called a project. QGIS works on one project at a time. Any settings can be
project-specific or an application-wide default for new projects (see section Options). QGIS can save the state of

your workspace into a project file using the menu options Project → Save or Project → Save As. . . .

Note: If the project you loaded has been modified in the meantime, by default, QGIS will ask you if you want

to overwrite the changes. This behavior is controlled by the Prompt to save project and data source changes
when required setting under Settings → Options → General menu.

You can load existing projects into QGIS using Project → Open. . . , Project → New from template or Project
→ Open Recent →.

At startup, a list of recently opened projects is displayed, including screenshots, names and file paths (for up to
ten projects). This is a handy quick way to access recently used projects. Double-click an entry in this list to open
the corresponding project. If you instead want to create a new project, just add any layer and the list disappears,
giving way to the map canvas.

If you want to clear your session and start fresh, go to Project → New. This will prompt you to save the
existing project if changes have been made since it was opened or last saved.

The information saved in a project file includes:

• Layers added

• Which layers can be queried

• Layer properties, including symbolization and styles

• Projection for the map view

• Last viewed extent

• Print layouts

• Print layout elements with settings

• Print layout atlas settings
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Figure 7.1: Starting a new project in QGIS

• Digitizing settings

• Table Relations

• Project Macros

• Project default styles

• Plugins settings

• QGIS Server settings from the OWS settings tab in the Project properties

• Queries stored in the DB Manager

The project file is saved in XML format. This means that it is possible to edit the file outside of QGIS if you know
what you are doing. The file format has been updated several times compared with earlier QGIS versions. Project
files from older QGIS versions may not work properly any more.

Note: By default, QGIS will warn you of version differences. This behavior is controlled in Settings → Options.

On the General tab, you should tick Warn when opening a project file saved with an older version of QGIS.

Whenever you save a .qgs project in QGIS, a backup of the project file is created with the extension .qgs~ and
stored in the same directory as the project file.

The extension for QGIS projects is .qgs but when saving from QGIS, the default is to save using a compressed
format with the .qgz extension. The .qgs file is embedded in the .qgz file (a zip archive), together with its
associated sqlite database (.qgd) for auxiliary data. You can get to these files by unzipping.

Note: A zipped project may be particularly useful with the Auxiliary Storage Properties mechanism in order to
embed the underlying database.

Projects can also be saved/loaded to/from a PostgreSQL database using the following Project menu items:

• Project → Open from

• Project → Save to
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Both menu items have a sub-menu with a list of extra project storage implementations (currently just PostgreSQL).
Clicking the action will open a dialog to pick a PostgreSQL connection name, schema name and project.

Projects stored in PostgreSQL can be also loaded from the QGIS browser panel (the entries are located within the
schema they are stored in), either by double-clicking them or by dragging them to the map canvas.

7.2 Generating output

There are several ways to generate output from your QGIS session. We have already discussed saving as a project
file in Introducing QGIS projects. Other ways to produce output files are:

• Creating images: Project → Import/Export → Export Map to Image. . . opens a file dialog where you
select the name, path and type of image (PNG, JPG and many other formats). This will also create a world
file (with extension PNGW or JPGW) that is saved in the same folder as your image. This world file is used
to georeference the image.

• Exporting to DXF files: Project → Import/Export → Export Project to DXF. . . opens a dialog where you
can define the “Symbology mode”, the “Symbology scale” and vector layers you want to export to DXF.
Through the “Symbology mode” symbols from the original QGIS Symbology can be exported with high
fidelity (see section Creating new DXF files).

• Designing print maps: Project → New Print Layout. . . opens a dialog where you can layout and print
the current map canvas (see section Laying out the maps).
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CHAPTER 8

Interface de QGIS

Lorsque QGIS démarre, une interface graphique s’affiche comme indiqué dans la figure ci-dessous (les chiffres 1
à 5 dans les cercles jaunes sont présentés ci-dessous).

Figure 8.1: Interface de QGIS avec les données d’exemple sur l’Alaska

Note: Le style des fenêtres peut apparaître différemment en fonction de votre système d’exploitation et de votre
gestionnaire de fenêtres.

L’interface de QGIS est divisée en 5 parties:

1. Barre de Menu
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2. Barres d’outils

3. Panneaux

4. Affichage de la carte

5. Barre d’état

Faites défiler vers le bas pour obtenir des explications détaillées de ces fonctions.

8.1 Barre de Menu

La barre de menu permet d’accéder à diverses fonctions de QGIS à l’aide d’un menu hiérarchique standard. Les
menus, leurs options, les icônes associées et les raccourcis clavier sont décrits ci-dessous. Ces raccourcis clavier
sont les paramètres par défaut, mais ils peuvent être reconfigurés en utilisant raccourcis clavier Dans le menu
préférences.

La plupart des options de menu ont un outil correspondant et vice-versa. Cependant, les menus ne sont pas
organisés exactement comme les barres d’outils. L’emplacement des options de menu dans les barres d’outils
est indiqué dans le tableau ci-dessous. Les plugins peuvent ajouter de nouvelles options aux menus. Pour plus
d’informations sur les outils et les barres d’outils, voir Barres d’outils.

Note: QGIS est une application multiplateforme - bien que les mêmes outils soient disponibles sur toutes les
plates-formes, ils peuvent être placés dans différents menus sur différents systèmes d’exploitation. Les listes
ci-dessous indiquent les endroits les plus courants, y compris les variations connues.

8.1.1 Projet

Le menu Projet fournit les points d’accès et de sortie du fichier projet. Il fournit les outils pour :

• Créer un Nouveau fichier à partir de zéro ou en utilisant un autre fichier projet comme modèle (voir Pro-
priétés du projet pour la configuration du modèle)

• Ouvrir. . . un fichier projet à partir d’un navigateur de fichiers ou d’une base de données PostgreSQL

• Fermer un projet ou le ramener à son dernier état sauvegardé

• Enregistrer un projet dans un format de fichier .qgs ou .qgz, ou dans une base de données PostgreSQL

• Exporter le canevas de carte dans différents formats ou utiliser les mises en page pour des sorties plus
complexes.

• Régler les propriétés du projet et les options d’accrochage lors de l’édition des couches.
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Barre de Menu Raccourci Barre
d’outils

Référence

Nouveau Ctrl+N Projet Introducing QGIS projects
Nouveau depuis un modèle → Introducing QGIS projects

Ouvrir. . . Ctrl+O Projet Introducing QGIS projects
Ouvrir depuis → PostgreSQL Introducing QGIS projects
Ouvrir un projet récent → Introducing QGIS projects
Fermer Introducing QGIS projects

Enregistrer Ctrl+S Projet Introducing QGIS projects

Enregistrer sous. . . Ctrl+Shift+SProjet Introducing QGIS projects
Enregistrer sous. . . → Post-
greSQL

Introducing QGIS projects

Rétablir. . .
Propriétés Ctrl+Shift+P Propriétés du projet
Options d’accrochage Définir le rayon de tolérance d’accrochage

et de recherche
Import/Export →

Exporter la carte au format
image. . .

Generating output

exporter la carte au format
PDF. . .

Generating output

Exporter la carte au format
DXF. . .

Generating output

Importer couches depuis
DWG/DXF. . .

Importing a DXF or DWG file

Nouvelle mise en page. . . Ctrl+P Projet Laying out the maps

Nouveau rapport. . . Laying out the maps

Gestionnaire de mise en
page. . .

Projet Laying out the maps

Mises en page → Laying out the maps

Fermer QGIS Ctrl+Q

Sous Mac OS, la commande Fermer QGIS correspond à l’entrée de menu QGIS → Quitter QGIS (Cmd+Q).

8.1.2 Éditer

Le menu Editer fournit la plupart des outils natifs nécessaires pour éditer les attributs ou la géométrie des couches
(voir Éditer pour les détails).

Barre de Menu Raccourci Barre d’outils Référence

Annuler Ctrl+Z Numérisation Annuler et refaire

Refaire Ctrl+Shift+Z Numérisation Annuler et refaire

Couper des entités Ctrl+X Numérisation Couper, Copier et Coller des entités
Continued on next page
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Table 8.1 – continued from previous page
Barre de Menu Raccourci Barre d’outils Référence

Copier les entités Ctrl+C Numérisation Couper, Copier et Coller des entités

Coller les entités Ctrl+V Numérisation Couper, Copier et Coller des entités
Coller les entités comme → Travailler avec la table d’attributs
Sélection → Attributs Sélectionner des entités

Ajouter un enregistrement Ctrl+. Numérisation

Ajouter une entité ponctuelle Ctrl+. Numérisation Ajouter des entités

Ajouter une entité linéaire Ctrl+. Numérisation Ajouter des entités

Ajouter une entité polygonale Ctrl+. Numérisation Ajouter des entités

Ajouter une courbe Forme Add Circular string

Ajouter une courbe à partir d’un rayon Forme Add Circular string
Ajouter un cercle → Forme
Ajouter un rectangle → Forme
Ajouter un polygone régulier → Forme
Ajouter une ellipse → Forme

Déplacer l’entité Numérisation avancée Move Feature(s)

Copier et déplacer les entités Numérisation avancée Move Feature(s)

Supprimer les entités sélectionnées Numérisation Supprimer les entités sélectionnées

Modifier les attribues des entités sélectionnées Numérisation Editer les valeurs d’attributs

Pivoter l’entité Numérisation avancée Pivoter l’entité

Simplifier l’entité Numérisation avancée Simplifier l’entité

Ajouter un anneau Numérisation avancée Ajouter un anneau

Ajouter une partie Numérisation avancée Ajouter une partie

Remplir l’anneau Numérisation avancée Remplir l’anneau

Effacer un anneau Numérisation avancée Effacer un anneau

Effacer une partie Numérisation avancée Effacer une partie

Remodeler les entités Numérisation avancée Remodeler les entités

Décalage X,Y Numérisation avancée Décalage X,Y

Séparer les entités Numérisation avancée Séparer les entités

Séparer les parties Numérisation avancée Séparer les parties

Fusionner les entités sélectionnées Numérisation avancée Fusionner les entités sélectionnées

Fusionner les attributs des entités sélectionnées Numérisation avancée Fusionner les attributs des entités sélectionnées

Outil de noeud (toutes les couches) Numérisation Vertex tool

Outil de noeud (couche active) Numérisation Vertex tool

Rotation des symboles de points Numérisation avancée Rotation des symboles de point

décalage des symboles de points Numérisation avancée Décaler le symbole ponctuel

Inverser les lignes Numérisation avancée
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Les outils suivant sont activés en fonction du type de géométrie (point, polyligne, polygone) :

Barre de Menu Point Polyline Polygone

Déplacer les entités

Copier et déplacer le(s) entité(s)

8.1.3 Affichage de la carte

La carte est affichée dans des vues cartographiques. Vous pouvez interagir avec ces vues en utilisant les outils du
menu Vue (voir Working with the map canvas pour plus d’informations). Par exemple, vous pouvez :

• Créez de nouvelles vues cartographiques 2D ou 3D à côté du caneva de carte principal.

• Zoomer ou se déplacer n’importe où

• Interroger les attributs ou la géométrie des entités affichés

• Améliorez l’affichage de la carte avec des modes de prévisualisation, des annotations ou des décorations.

• Accédez à n’importe quel panneau ou barre d’outils

Le menu vous permet également de réorganiser l’interface QGIS elle-même à l’aide d’actions telles que :

• Basculer en mode plein écran: couvre tout l’écran tout en masquant la barre de titre

• Basculer la visibilité des panneaux: affiche ou masque les panneaux activés - utile lors de la numérisation
d’entités (pour une visibilité maximale du caneva) ainsi que pour les présentations (projetées/enregistrées)
utilisant le caneva principal de QGIS

• Basculer en affichage carte plein écran : cache les panneaux, les barres d’outils, les menus et la barre d’état
et affiche uniquement le canevas de la carte. Combiné avec l’option plein écran, il permet à votre écran
d’afficher uniquement la carte.

Barre de Menu Raccourci Barre d’outils Référence

Nouvelle vue cartographique Ctrl+M Navigateur de carte

Nouvelle vue cartographique 3D Ctrl+Shift+M Vue 3D

Se déplacer dans la carte Navigateur de carte Zoomer et se déplacer

Déplacer la carte jusqu’à la sélection Navigateur de carte

Zoom + Ctrl+Alt++ Navigateur de carte Zoomer et se déplacer

Zoom - Ctrl+Alt+- Navigateur de carte Zoomer et se déplacer

Identifier les entités Ctrl+Shift+I Attributs Identifying Features
Mesure → Attributs Mesurer

Résumé statistique Attributs Panneau de résumé statistiques

Zoom sur l’emprise totale Ctrl+Shift+F Navigateur de carte

Zoom sur la couche Navigateur de carte

Zoom sur la sélection Ctrl+J Navigateur de carte

Zoom précédent Navigateur de carte

Zoom suivant Navigateur de carte
Continued on next page

8.1. Barre de Menu 29



QGIS User Guide, Version 3.4

Table 8.2 – continued from previous page
Barre de Menu Raccourci Barre d’outils Référence

Zoom à la résolution native (100%) Navigateur de carte
Décorations → Décorations
Mode d’affichage →

Afficher les infobulles Attributs Propriétés des Infobulles

Nouveau signet. . . Ctrl+B Navigateur de carte Signets spatiaux

Liste des signets Ctrl+Shift+B Navigateur de carte Signets spatiaux

Rafraîchir F5 Navigateur de carte

Afficher toutes les couches Ctrl+Shift+U Le panneau Couches

Cacher toutes les couches Ctrl+Shift+H Le panneau Couches

Afficher les couches sélectionnées Le panneau Couches

Cacher les couches sélectionnées Le panneau Couches

Cacher les couches désélectionnées Le panneau Couches
Panneaux → Panneaux et barres d’outils
Barres d’outils → Panneaux et barres d’outils
Basculer en mode plein écran F11
Basculer la visibilité des panneaux Ctrl+Tab
Basculer en affichage carte plein écran Ctrl+Shift+Tab

Sous Linux KDE, Les menus Panneaux →, Barres d’outils → et Basculer en mode plein écran sont dans le
menu Préférences.

8.1.4 Couche

Le menu Couche fournit un grand nombre d’outils pour créer de nouvelles sources de données, Les ajouter au
projet ou enregistrer leurs modifications. En utilisant les mêmes sources de données, vous pouvez également :

• Dupliquer génère une copie que vous pouvez modifier dans le même projet

• Copier et Coller des couches ou des groupes d’un projet à un autre comme une nouvelle instance dont vous
pouvez modifier les entités et les propriétés indépendamment de l’original

• Ou Intégrer des couches et des groupes à partir d’un autre projet, comme des copies en lecture seule que
vous ne pouvez pas modifier (voir Inclusion de projets)

Le menu Couche contient également des outils pour configurer, copier ou coller les propriétés des couches (style,
échelle, SCR. . . ).
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Barre de Menu Raccourci Barre d’outils Référence

Gestionnaire de source de
données

Ctrl+L Gestionnaire de
source de données

Opening Data

Créer une couche → Gestionnaire de
source de données

Creating new vector layers

Ajouter une couche → Gestionnaire de
source de données

Ouverture des données

Intégrer des couches et des
groupes

Inclusion de projets

Ajouter depuis un fichier de Défi-
nition de Couche (.qlr)

Fichier de définition de couche
(QLR)

Copier le style Sauvegarder et Partager les pro-
priétés d’une couche

Coller le style Sauvegarder et Partager les pro-
priétés d’une couche

Copier la couche

Coller Couche/Groupe

Ouvrir la table d’attributs F6 Attributs Travailler avec la table
d’attributs

Basculer en mode édition Numérisation Numériser une couche existante

Enregistrer les modifications
de la couche

Numérisation Sauvegarder les couches éditées

Éditions en cours → Numérisation Sauvegarder les couches éditées
Enregistrer Sous. . . Creating new layers from an ex-

isting layer
Enregistrer dans un fichier de défi-
nition de couche. . .

Fichier de définition de couche
(QLR)

Supprimer la couche/groupe Ctrl+D

Dupliquer une couche(s)
Définir l’échelle de visibilité des
couches
Définir le SCR des couches Ctrl+Shift+C
Définir le SCR du projet depuis
cette couche
Propriétés de la couche. . . Fenêtre Propriétés d’une couche

vecteur
Filtrer Ctrl+F Constructeur de requête

Étiquetage Propriétés d’Étiquetage

Montrer dans l’aperçu Overview Panel
Montrer tout dans l’aperçu Overview Panel

Cacher tout dans l’aperçu Overview Panel
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8.1.5 Préférences

Barre de Menu Référence
Profils utilisateurs → Utiliser les profils utilisateur

Gestionnaire de symboles. . . Le Gestionnaire de style

Projections personalisées. . . Système de Coordonnées de Référence personnalisé

Raccourcis clavier. . . Raccourcis clavier

Personalisation de l’interface. . . Personnalisation
Options. . . Options

Sous Linux KDE, vous trouverez d’autres outils dans le menu Paramètres avec les menu Panneaux→, Barres
d’outils→ et Basculer en mode plein écran.

8.1.6 Extensions

Barre de Menu Raccourci Barre d’outils Référence

Installer/Gérer les extensions La fenêtre des Extensions

Console python Ctrl+Alt+P Extensions La Console Python de QGIS

Les extensions principales ne sont pas toutes chargées lorsque vous démarrez QGIS pour la première fois.

8.1.7 Vecteur

C’est ce à quoi ressemble le menu Vecteur si toutes les extensions sont activées.

Barre de Menu Raccourci Barre d’outils Référence

Saisie de coordonnées Vecteur Coordinate Capture Plugin

Vérificateur de géométries. . . Vecteur Geometry Checker Plugin

Outils GPS Vecteur Extension GPS

vérificateur de topologie Vecteur Topology Checker Plugin
Traitement → Alt+O + G Configurer le Module de Traitements
Outils de géométrie → Alt+O + E Configurer le Module de Traitements
Outils d’analyse → Alt+O + A Configurer le Module de Traitements
Outils de gestion des données → Alt+O + D Configurer le Module de Traitements
Outils de recherche → Alt+O + R Configurer le Module de Traitements
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Par défaut, QGIS ajoute des algorithmes de Processing au menu Vecteur, groupés par sous-menus. Cela fournit
des raccourcis pour de nombreuses tâches SIG vectorielles courantes de différents fournisseurs de traitements.
Si ces sous-menus ne sont pas disponibles, activez le plugin Traitement dans Extension → Installer/Gérer les
extensions. . . .

Notez que la liste des outils du menu Vecteur peut être étendue avec n’importe quel algorithme de traitement ou
par certaines extensions externes..

8.1.8 Raster

Voici à quoi ressemble le menu Raster si tous les plugins de base sont activés.

Barre de Menu Barre d’outils Référence

Calculatrice raster. . . Calculatrice Raster
Aligner des Rasters. . . Alignement de rasters
Analyse → Configurer le Module de Traitements
Projection → Configurer le Module de Traitements
Divers → Configurer le Module de Traitements
Extraction → Configurer le Module de Traitements
Conversion → Configurer le Module de Traitements

Georeferenceur GDAL Raster Georeferencer Plugin

Par défaut, QGIS ajoute des algorithmes de Processing au menu Raster, groupés par sous-menus. Il s’agit d’un
raccourci pour de nombreuses tâches SIG raster courantes de différents fournisseurs de traitements. Si tous ces
sous-menus ne sont pas disponibles, activez l’extension Processing dans Extensions → Installer/gérer les exten-
sions. . . .

Notez que la liste des outils du menu Raster peut être étendue avec n’importe quel algorithme de traitement ou
certains plugins externes..

8.1.9 Base de données

This is what the Database menu looks like if all the core plugins are enabled. If no database plugins are enabled,
there will be no Database menu.

Barre de Menu Barre d’outils Référence

DB Manager Base de données DB Manager Plugin
eVis → Base de données eVis Plugin
Edition hors connexion→ Base de données Offline Editing Plugin

Les extensions principales ne sont pas toutes chargées lorsque vous démarrez QGIS pour la première fois.

8.1.10 Web

This is what the Web menu looks like if all the core plugins are enabled. If no web plugins are enabled, there will
be no guilabel:Web menu.
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Barre de Menu Barre d’outils Référence

MetaSearch Internet MetaSearch Catalog Client

Les extensions principales ne sont pas toutes chargées lorsque vous démarrez QGIS pour la première fois.

8.1.11 Traitement

Barre de Menu Raccourci Référence

Boîtes à outils Ctrl+Alt+T La boîte à outils

Modeleur graphique. . . Ctrl+Alt+M Le modeleur graphique

Historique. . . Ctrl+Alt+H Le gestionnaire d’historique

Visualiseur de résultats Ctrl+Alt+R Configuration des applications tierces

Editer les entités sur place The Processing in-place layer modifier

Les extensions principales ne sont pas toutes chargées lorsque vous démarrez QGIS pour la première fois.

8.1.12 Aide

Barre de Menu Raccourci Barre d’outils

Table des matières de l’aide F1 Aide
Documentation de l’API
Signaler un problème
Besoin de support commercial ?

Site officiel de QGIS Ctrl+H
Vérifier la version de QGIS

A propos

Sponsors de QGIS

8.1.13 QGIS

Ce menu n’est disponible que sous Mac OS et il contient des commandes propres à cet OS.
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Barre de Menu Raccourci Référence
Preferences
À propos de QGIS
Cacher QGIS
Tout Afficher
Masquer les autres
Quitter QGIS Cmd+Q

Préférences et A propos de QGIS sont les mêmes commandes que Préférences → Options et Aide → A propos.
Quitter QGIS correspond à Projet → Fermer QGIS pour les autres plate-formes.

8.2 Panneaux et barres d’outils

Depuis le menu Vue” (ou |kde| :menuselection:‘préférences), vous pouvez activer et désactiver les widgets QGIS
(Panneaux→) et barres d’outils (Barres d’outils→). Pour (dé)activer l’un d’entre eux, cliquez avec le bouton droit
de la souris sur la barre de menu ou la barre d’outils et choisissez l’élément que vous voulez. Chaque panneau ou
barre d’outils peut être déplacé et placé où vous le souhaitez dans l’interface QGIS. La liste peut également être
étendue avec l’activation d’extensions de :ref:‘cœur ou externes <plugins> ‘.

8.2.1 Barres d’outils

La barre d’outils permet d’accéder à la plupart des mêmes fonctions que les menus, ainsi qu’à des outils supplé-
mentaires pour interagir avec la carte. Chaque élément de la barre d’outils dispose d’une aide contextuelle. Passez
votre souris sur l’élément et une courte description de l’objectif de l’outil s’affichera.

Chaque barre d’outils peut être déplacée selon vos besoins. Vous pouvez les désactiver à partir du menu contextuel
qui s’affiche d’un clic droit de la souris sur la barre d’outils.

Astuce: Restaurer des barres d’outils

Si vous avez accidentellement masqué une barre d’outils, vous pouvez la retrouver via le menu Vue → Barres

d’outils → (ou Préférences → Barres d’outils →). Si, pour une raison ou une autre, une barre d’outils (ou
n’importe quel autre élément d’interface) disparaît complètement de l’interface, vous trouverez des conseils pour
la retrouver dans Restaurer facilement l’IHM initiale de QGIS.

8.2.2 Panneaux

Outre les barres d’outils, QGIS dispose de plusieurs panneaux; les panneaux sont des widgets spéciaux qui vous
permettent des interactions (sélection d’options, cases à cocher, saisie de champs. . . ) afin d’exécuter des tâches
plus complexes.

Les panneaux disponibles par défaut dans QGIS sont listés ci-après:

• le Le panneau Couches

• the explorateur

• le panneau Numérisation Avancée

• le panneau Signets Spatiaux
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Figure 8.2: Le menu Barres d’outils

Figure 8.3: Le menu Panneaux
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• le panneau Information GPS

• le panneau Echelle des Tuiles

• le Panneau Identifier Panel

• le panneau Entrée d’Utilisateur

• le Panneau Ordre des Couches

• le Panneau de style de couche

• le Panneau de résumé statistiques

• le Overview Panel

• le panneau de Gestion des logs

• le Panneau Annuler/Refaire

• le Processing Toolbox

8.3 Affichage de la carte

Encore appelé Canevas de carte, c’est la partie centrale de QGIS puisque les cartes y sont affichées ! Le contenu
qui s’affiche dépend des couches de types raster et vecteur que vous avez choisies de charger.

Lorsque vous ajoutez une couche (voir par exemple Ouverture des données), QGIS recherche automatiquement
son Système de Coordonnées de Référence (SCR) et zoome le projet sur l’étendue de la couche si aucune autre
couche n’est présente. Le SCR de la couche est alors appliquée au projet. Si d’autres couches étaient déjà
affichées, et dans l’hypothèse où la nouvelle couche est dans le même SCR que le projet, ses entités disponibles
dans l’étendue courante de la carte sont alors visibles. Si le SCR de la nouvelle couche est différente, vous devrez
Autoriser la transformation à la volée du SCR via le menu Projet → Propriétés du Projet → SCR (voir On The Fly
(OTF) CRS Transformation). La couche ajoutée devrait maintenant être visible dans l’étendue courante si entités
disponibles.

L’emprise de la carte peut être modifiée en portant le focus sur une autre région, ou en zoomant en avant ou en
arrière. Plusieurs opérations peuvent être effectuées sur la carte à l’aide des Barres d’outils. La carte et la légende
du panneau Couche sont étroitement liées — la carte reflète les changements que vous opérez dans la légende.

Astuce: Zoomer sur la carte avec la molette de la souris

Vous pouvez utiliser la molette de la souris pour changer le niveau de zoom de la carte. Placez votre curseur dans
la zone d’affichage de la carte et faites rouler la molette vers l’avant pour augmenter l’échelle, vers vous pour la
réduire. La vue sera recentrée sur la position du curseur de la souris. Vous pouvez modifier le comportement de la
molette de la souris en utilisant l’onglet Outils cartographiques dans le menu Préférences → Options.

Astuce: Se déplacer sur la carte avec les flèches et la barre espace

Vous pouvez utiliser les flèches du clavier pour vous déplacer sur la carte. Placez le curseur sur la carte et appuyez
sur la flèche droite pour décaler la vue vers l’Est, la flèche gauche pour la décaler vers l’Ouest, la flèche supérieure
vers le Nord et la flèche inférieure vers le Sud. Vous pouvez aussi déplacer la carte en gardant la touche espace
appuyée et en bougeant la souris ou encore simplement en gardant la molette de la souris appuyée.

8.4 Vue 3D

Le support de visualisation 3D est disponible par la vue cartographique 3D.

8.3. Affichage de la carte 37



QGIS User Guide, Version 3.4

Note: La visualisation 3D dans QGIS nécessite une version récente de la bibliothèque QT (5.8 ou ultérieure).

Vous créez et ouvrez une vue cartographique 3D via Vue → Nouvelle vue cartographique 3D. Un panneau
QGIS flottant apparaîtra. Le panneau peut être ancré.

Pour commencer, la vue cartographique 3D a la même étendue et la même vue que le canevas 2D. Il n’y a pas de
barre d’outils dédiée à la navigation dans le canevas 3D. Vous effectuez un zoom avant/arrière et un panoramique
de la même manière que dans le canevas 2D principal. Vous pouvez également effectuer un zoom avant et arrière
en faisant glisser la souris vers le bas/haut avec le bouton droit de la souris.

Options de navigation pour explorer la carte en 3D :

• Inclinaison et rotation

– To tilt the terrain (rotating it around a horizontal axis that goes through the center of the window):

* Déplacez la souris vers l’avant/vers l’arrière avec le bouton central de la souris enfoncé.

* Appuyez sur Shift et faites glisser la souris en avant/en arrière avec le bouton gauche de la
souris enfoncé.

* Appuyez sur Shift et utilisez les touches haut/bas.

– Pour faire pivoter le terrain (autour d’un axe vertical qui passe par le centre de la fenêtre) :

* Faites glisser la souris droite/gauche avec le bouton central de la souris enfoncé.

* Appuyez sur Shift et faites glisser la souris droite/gauche avec le bouton gauche de la souris
enfoncé.

* Appuyez sur Shift et utilisez les touches gauche/droite

• Modifier l’angle de la caméra

– Appuyer sur Ctrl et faire glisser la souris avec le bouton gauche appuyé change l’angle de la caméra
dans le sens correspondant au sens du déplacement.

– Appuyez sur :kbd:‘Ctrl‘et utilisez les touches flèches pour tourner la caméra dans le sens monter,
descendre, aller à gauche ou à droite.

• Déplacer la caméra vers le haut/bas

– Appuyer sur les touches Page Up/Page Down déplace le terrain vers le haut et le bas, respective-
ment

• Zoom avant et arrière

– Glisser la souris avec le bouton droit de la souris enfoncé permet de zoomer (glisser vers le bas) et de
dézoomer (glisser vers le haut).

• Déplacer le terrain

– Glisser la souris avec le bouton gauche de la souris enfoncé permet de déplacer le terrain.

– L’utilisation des touches haut/bas/gauche/droite déplace le terrain plus près, plus loin, à droite et à
gauche respectivement.

Pour réinitialiser la vue de la caméra, cliquez sur le bouton Zoom Full situé en haut de la vue cartographique 3D.

8.4.1 Configuration du terrain

Un raster terrain fournit l’élévation. Cette couche raster doit contenir une bande qui représente l’élévation. Pour
sélectionner le raster terrain :

1. Cliquez sur le bouton Configurer. . . en haut du panneau de la vue 3D pour ouvrir la fenêtre 3D configuration.

2. Choisissez la couche raster de terrain dans le menu déroulant Elevation.
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Dans la fenêtre de configuration 3D, il existe plusieurs autres options pour affiner la scène 3D. Avant d’entrer dans
les détails, il convient de noter que le terrain dans une vue 3D est représenté par une hiérarchie de tuiles de terrain
et que lorsque la caméra se rapproche du terrain, les tuiles existantes qui ne sont pas suffisamment détaillées sont
remplacées par des tuiles plus petites et plus détaillées. Chaque tuile a une géométrie de maillage dérivée de la
couche raster d’élévation et de la texture des couches 2D.

Options de configuration et leur signification :

• Elevation : Raster à utiliser pour la génération du terrain.

• Echelle verticale : Facteur d’échelle pour l’axe vertical. Augmenter l’échelle exagérera le relief.

• Résolution des tuiles : quantité de données de couche raster terrain à utiliser pour chaque tuile. Une valeur
de 16px signifie que la géométrie de chaque dalle sera construite à partir d’échantillons d’élévation 16x16.
Des nombres plus élevés créent des tuiles de terrain plus détaillées au détriment d’une complexité de rendu
accrue.

• Hauteur de la jupe : Parfois, il est possible de voir de petites fissures entre les tuiles du terrain. En augmen-
tant cette valeur, on ajoutera des murs verticaux (« jupes ») autour des tuiles du terrain pour masquer les
fissures.

• Résolution de la tuile de carte: Largeur et hauteur des images cartographiques 2D utilisées comme textures
pour les tuiles terrain. 256px signifie que chaque tuile sera rendue en une image de 256x256 pixels. Des
nombres plus élevés créent des tuiles de terrain plus détaillées au détriment d’une complexité de rendu
accrue.

• Max. erreur d’écran : Détermine le seuil d’échange des tuiles de terrain avec des tuiles plus détaillées (et
vice versa) - c’est-à-dire le moment où la vue 3D utilisera des tuiles de meilleure qualité. Des nombres plus
bas signifient plus de détails dans la scène au détriment d’une complexité de rendu accrue.

• Max. erreur de terrain : Résolution des tuiles du terrain à laquelle la division des tuiles en tuiles plus
détaillées s’arrêtera (les diviser n’introduirait de toute façon aucun détail supplémentaire). Cette valeur
limite la profondeur de la hiérarchie des tuiles : des valeurs inférieures rendent la hiérarchie plus profonde,
augmentant la complexité du rendu.

• Étiquettes Zoom : Affiche le nombre de niveaux de zoom (dépend de la résolution de la tuile de carte et de
l’erreur de terrain maximale).

• Afficher les étiquettes : Activer/désactiver les étiquettes de carte

• Afficher l’information de la tuile de carte : Inclure les numéros de bordure et de tuile pour les tuiles de
terrain (utile pour le dépannage des problèmes de terrain)

• Afficher les zones d’emprise : Afficher les cases de délimitation 3D des tuiles du terrain (utile pour le
dépannage des problèmes de terrain)

• Montrer le centre de la vue de la caméra.

8.4.2 Couches vectorielles 3D

Une couche vectorielle avec des valeurs d’élévation peut être affichée dans la vue 3D de la carte en cochant
Activer le rendu 3D dans la section Vue 3D des propriétés de la couche vectorielle. Un certain nombre d’options
sont disponibles pour contrôler le rendu de la couche vectorielle 3D.

8.5 Barre d’état

La barre d’état vous fournit des informations générales sur le visualiseur de carte et les actions traitées ou
disponibles, et vous offre des outils pour gérer le visualiseur de carte. Sur le côté gauche de la barre d’état,
la barre de localisation, un widget de recherche rapide, vous aide à trouver et à exécuter toutes les fonctions ou
options du QGIS. Tapez simplement le texte associé à l’élément que vous recherchez (nom, tag, mot-clé. . . ) et
vous obtenez une liste qui se met à jour au fur et à mesure que vous écrivez. Vous pouvez également limiter la
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portée de la recherche en utilisant les filtres de localisation. Cliquez sur le bouton pour sélectionner l’un
d’entre eux et appuyez sur Configurer pour avoir les paramètres globaux.

Dans la zone située à côté de la barre de localisation, un résumé des actions que vous avez effectuées s’affichera
si nécessaire (comme la sélection d’entités dans un calque, la suppression d’un calque) ou une description longue
de l’outil sur lequel vous passez la souris (non disponible pour l’ensemble des outils).

En cas d’opérations de longue durée, telles que la collecte de statistiques de couches raster, l’exécution
d’algorithmes de traitement ou le rendu de plusieurs couches dans la vue de carte, une barre de progression
est affichée dans la barre d’état.

L’option Coordonnées affiche la position actuelle de la souris, en suivant les déplacements sur la carte. Vous
pouvez définir les unités (et la précision) dans le menu Projet → Propriétés. . . . → Onglet Général. Cliquez sur

le petit bouton à gauche de la zone de texte pour basculer entre l’option Coordonnées et l’option Emprise
qui affiche les coordonnées des coins inférieur gauche et supérieur droit actuels de la vue de carte en unités
cartographiques.

A côté de l’affichage des coordonnées se trouve l’affichage Echelle. Il montre l’échelle de la carte. Il y a un
sélecteur qui vous permet de choisir des échelles prédéfinies et personnalisées.

Sur le côté droit de l’affichage de l’échelle, appuyez sur la touche pour verrouiller l’échelle et utiliser la loupe
pour effectuer un zoom avant ou arrière. La loupe vous permet de zoomer sur une carte sans modifier l’échelle de la
carte, ce qui facilite l’ajustement précis de la position des étiquettes et des symboles. Le niveau d’agrandissement
est exprimé en pourcentage. Si le la loupe a un niveau de 100%, alors la carte courante n’est pas agrandie. De
plus, une valeur d’agrandissement par défaut peut être définie dans le menu préférences → Options → Options
→ Rendu→ Comportement de rendu, ce qui est très utile pour les écrans haute résolution pour agrandir les petits
symboles.

À droite de la loupe, vous pouvez définir un angle de rotation horaire en degrés à appliquer à la carte.

Sur le côté droit de la barre d’état, il y a une petite case à cocher qui peut être utilisée temporairement pour
empêcher le rendu des couches dans le Visualisateur de carte (voir section Rendu).

A droite des fonctions de rendu, vous trouvez le bouton code EPSG montrant le SCR du projet courant.
Cliquer sur ce bouton ouvre la boîte de dialogue Propriétés du projet et vous permet d’appliquer un autre SCR.

Le bouton Messages situé à côté ouvre le journal des messages qui contient des informations sur les processus
sous-jacents (démarrage QGIS, chargement des plugins, outils de traitement. . . ).

Selon les paramètres du gestionnaire d’extensions Plugin Manager, la barre d’état peut parfois afficher des icônes

à droite pour vous informer de la disponibilité de nouvelles extensions ou de mises à jour . Cliquez sur
l’icône pour ouvrir la boîte de dialogue du gestionnaire d’extensions.

Astuce: Calculer l’échelle correcte de la carte

Lorsque vous démarrez QGIS, le SCR par défaut est WGS 84 (EPSG 4326) et les unités sont des degrés.
Cela signifie que QGIS interprétera n’importe quelle coordonnée dans votre couche comme étant en degrés. Pour
obtenir des valeurs d’échelle correctes, vous pouvez soit modifier manuellement ce paramètre dans l’onglet Gen-

eral dans le menu Projet → Propriétés. . . (par exemple pour des mètres), soit utiliser l’icône code EPSG vue
ci-dessus. Dans ce dernier cas, les unités sont réglées sur ce que spécifie la projection du projet (par exemple,
+units=m).

Merci de prendre note que le choix du SCR au démarrage peut être configuré dans Préférences → Options →
SCR.
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CHAPTER 9

Configuration de QGIS

QGIS est hautement configurable. Au travers du menu Options , il fournit différents outils pour :

• Options. . . :permet de régler les options à appliquer à différents endroits du logiciel. Ces réglages sont
sauvegardés dans le profil utilisateur actif et sont appliquées par défaut à chaque fois que vous ouvrez un
nouveau projet avec ce profil. Mais ils peuvent être écrasés pendant chaque session QGIS avec les propriétés
du projet (accessibles sous Projet menu).

• Personnalisation de l’interface. . . : configure l”interface, en cachant des dialogues ou des outils dont
vous n’avez pas besoin.

• Raccourcis Clavier. . . : permet de définir vos propres Raccourcis Clavier.

• Gestionnaire de symboles. . . : créer et gérer vos propres symboles et palettes de couleurs.

• Projections personnalisées . . . : créer vos propres systèmes de référence des coordonnées.

9.1 Options

Quelques options basiques peuvent être sélectionnées dans la fenêtre Options. Selectionnez le menu
Préférences → Options. Vous pouvez modifier les options à votre guise. Certaines modifications peuvent
nécessiter un redémarrage de QGIS pour être effectives.

Les onglets où vous pouvez configurer vos options sont décrits ci-dessous.

Note: Les plugins peuvent intégrer leurs paramètres dans la boîte de dialogue Options

Bien que seuls les paramètres de base soient présentés ci-dessous, notez que cette liste peut être étendue par les
Extensions installées implémentant leurs propres options dans la boite de dialogue standard. Ceci évite que chaque
extension ait sa propre boîte de dialogue de configuration avec des éléments de menu supplémentaires juste pour
elle. . .
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9.1.1 Général

Paramètres régionaux du système

• Cocher Remplacer les paramètres régionaux du système si vous souhaitez utiliser une langue différente
de celle de votre système et choisissez la Locale (fomat monétaire, des nombres et des dates) dans la liste.

• Les informations sur les paramètres de lieu (locale) sont affichées.

Application

• Sélectionner le Style (redémarrage de QGIS nécessaire) pour choisir entre “Oxygen”, “Windows”,
“Motif”, “CDE”, “Plastique” and “Cleanlooks”;

• Définir le Theme UI . Soit “default” soit “Night Mapping”;

• Définir la Taille de l’icône ;

• Définir la Police et sa Taille. La police peut être Qt default ou choisie par l’utilisateur ;

• Choisir le Délai d’abandon pour les messages ou fenêtres ;

• Cacher l’écran de démarrage;

• Vérifier la version au démarrage pour vous tenir informé si une nouvelle version est publiée;

• Dialogue du gestionaire de source de données sasn interruption pour conserver le data source manager
ouvert ce qui permet d’interagir avec qgis tout en ajoutant des couches au projet;

• Utiliser les fenêtres natives de choix de couleur (voir sélecteur de couleur).

Fichiers projet

• Ouverture du projet au démarrage (choisissez entre “Nouveau”, “Dernier utilisé”,”Page d’accueil”
et “Spécifique”). Lorsque vous choisissez “Spécifique”, utilisez le bouton . . . pour sélectionner un projet
par défaut. “Page d’accueil” affiche les liste des projets récents avec leur capture d’écran.

• Créer les nouveaux projets à partir du projet par défaut. Vous pouvez choisir d”Utiliser le projet courant
comme défaut ou de Réinitialiser le projet par défaut. Vous pouvez parcourir vos fichiers et sélectionner
le répertoire où sont stockés vos modèles de projets personnalisés. Cela créera une nouvelle entrée dans le

menu Projet → Nouveau depuis un modèle si vous cochez Créer les nouveaux projets à partir du projet
par défaut et sauvegardez un projet dans le répertoire de modèles de projets spécifié.

• Demander de sauver le projet et les sources de données quand nécessaire pour éviter de perdre les
changements effectués.

• Demander une confirmation lorsqu’une couche va être supprimée

• Avertir lors de l’ouverture d’un fichier projet sauvegardé dans une version précédente de QGIS. Vous
pouvez toujours ouvrir des projets créés avec une ancienne version de QGIS, mais une fois le projet en-
registré, tenter de l’ouvrir avec une version plus ancienne peut échouer en raison de fonctionnalités non
disponibles dans cette version.

• Activer les macros . Cette option a été créée pour gérer les macros devant exécuter des actions sur des
événements du projet. Vous pouvez choisir entre “Jamais”, “Demander”, “Uniquement pour cette session”
et “Toujours (non recommandé)”.

9.1.2 Système

Chemins SVG
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Ajouter ou enlever Chemin(s) vers les symboles SVG. Ces fichiers SVG seront utilisables pour styler les objets de
la carte et disponibles pour les mises en page.

Chemins vers les extensions

Ajouter ou enlever Chemin(s) vers des extensions C++ supplémentaires.

Chemins de documentation

Ajouter ou enlever Chemins de documentation pour utiliser l’aide de Qgis. Par défaut, un lien vers le manuel
officiel en ligne correspondant à la version utilisée est ajouté. Vous pouvez cependant ajouter d’autres liens et les
hiérarchiser de haut en bas : à chaque fois que vous cliquez sur le bouton Aide, le lien le plus haut est vérifié et si
aucune page correspondante n’est trouvée, la page suivante est essayée, et ainsi de suite.

Note: Documentation is versioned and translated only for QGIS Long Term Releases (LTR), meaning that if you
are running a regular release (eg, QGIS 3.0), the help button will by default open the next LTR manual page (ie.
3.4 LTR), which may contain description of features in newer releases (3.2 and 3.4). If no LTR documentation is
available then the testing doc, with features from newer and development versions, is used.

Paramètres

Cela vous permet de Réinitialiser l’interface utilisateur aux réglages d’origine (redémarrage requis) si vous avez
effectué une personnalisation.

Environnement

Les variables d’environnement Système peuvent maintenant être visualisées et configurées pour certains dans
le groupe Environnement (voir figure_environment_variables). Ceci est pratique sur certaines plateformes, no-
tamment sur Mac, ou une application avec interface graphique n’hérite pas nécessairement des paramètres de
l’environnement en ligne de commande de l’utilisateur. Ceci est aussi utile pour paramétrer/visualiser les variables
d’environnement des outils externes contrôlés par la boîte à outils de traitement (par exemple SAGA, GRASS) et
activer les sorties de débogage pour des sections spécifiques du code source.

• Utiliser des variables personnalisées (redémarrage requis - utiliser les séparateurs). Vous pouvez
Ajouter et Supprimer des variables. Les variables d’environnement prédéfinies sont affichées dans Variables

d’environnement courantes, et il est possible de les filtrer en cochant Afficher uniquement les variables
liées à Qgis.

9.1.3 SCR

Default CRS for new projects

There is an option to automatically set new project’s CRS:

• Use CRS from first layer added: the CRS of the project is turned to match the CRS of the first layer
loaded into it

• Use a default CRS: a preselected CRS is applied by default to any new project and is left unchanged
when adding layers to the project.

The choice will be saved for use in subsequent QGIS sessions and in any case, the Coordinate Reference System
of the project can still be overridden from the Project → Project properties → CRS tab.

SCR pour les nouvelles couches

Cet espace vous permet de définir une action à faire lorsqu’une nouvelle couche est créée ou lorsqu’une couche
sans SCR est chargée.

• Demander le SCR

• Utiliser le SCR du projet
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Figure 9.1: Variables d’environnement Système dans QGIS

• Utiliser le SRC par défaut

Transformations géodésiques par défaut

Dans ce groupe, vous pouvez contrôler si la reprojection des couches vers un autre SCR doit être effectuée :

• automatiquement en utilisant les transformations par défaut des options de Qgis ;

• et/ou contrôlée par vous avec des préférences personnalisées telles que :

– Demander de choisir la transformation de datum si plusieurs sont disponibles(défini dans le
paramétrage global)

– une liste prédéfinie de transformations de datum à appliquer par défaut. Voir Datum Transformations
pour plus de détails.

Note: Pour plus d’informations sur la façon dont QGIS gère la projection de couches, veuillez lire la section
dédiée à Utiliser les projections.

9.1.4 Sources de données

Attributs et tables

• Ouvrir la table d’attributs dans une fenêtre intégrée

• Copier les entités comme “Texte uniquement, pas de géométrie”, “Texte uniquement, géométrie WKT”, ou
“GeoJSON” quand on colle les entités vers d’autres applications.
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Figure 9.2: Paramètres SCR dans Qgis
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• Comportement des tables d’attributs : filtre la table d’attribut à l’ouverture. Il y a trois possibilités :
“Montrer toutes les entités”, “Ne montrer que les entités sélectionnées” et “Montrer les entités visibles sur
la carte”.

• Vue par défaut: définit le mode d’ouverture de la table d’attributs lors de l’ouverture. Cela peut être : “Se
souvenir de la dernière vue”, “Voir la table “ ou “Voir le formulaire”.

• Cache de la table attributaire . Ce cache permet de garder en mémoire les n dernières lignes
d’attributs chargées afin de rendre l’utilisation de la table attributaire plus réactive. Le cache est supprimé à
la fermeture de la table attributaire.

• Représentation des valeurs NULL permet de définir une valeur par défaut pour les champs contenant la
valeur NULL.

Astuce: Amélioration de l’ouverture d’une grande table attributaire

Lorsque vous travaillez avec des couches avec un grand nombre d’enregistrements, l’ouverture de la table
d’attributs peut être lente car la fenêtre doit afficher toutes les lignes de la couche. Régler Comportement des
tables d’attributs à “Montrer les entités visibles sur la carte va permettre à Qgis de ne rechercher que les entités
affichées sur la carte quand on ouvre la table attributaire, ce qui permet un meilleur temps de chargement.

Notez que les données de la table attributaire seront toujours liées à l’étendue de la carte dans laquelle elle est
ouverte, ce qui signifie qu’en sélectionnant Montrer toutes les entités avec une telle table n’affichera pas les
nouvelles entités. Vous pouvez tout de même mettre à jour le jeu de données affiché en changeant l’étendue de la
carte et en sélectionnant Montrer les entités visibles sur la carte .

Gestion des sources de données

• Rechercher les fichiers valides dans l’explorateur . Vous pouvez choisir entre “Vérifier l’extension”
ou “Vérifier le contenu du fichier”.

• Rechercher du contenu dans les fichiers compressés (.zip) définit le niveau de détail affiché dans la
fenêtre informations en bas de l’explorateur - outil des propriétés- lors de la sélection du fichier. Les options
sont : “Non”, “Scan Basique” et “Scan complet”.

• Demande à l’ouverture s’il y a des sous-couches raster. Certains rasters comportent des sous-couches
- appelées sous-jeux de données dans GDAL. Par exemple les fichiers netCDF - s’il y a de nombreuses
variables netCDF, GDAL considérera chaque variable comme un sous-jeux de données. L’option vous
permet de choisir comment traiter les sous-jeux de données quand un fichier avec des sous-couches est
ouvert. Vous avez les choix suivants :

– “Toujours” : Demande toujours (s’il existe des sous-couches)

– “Si nécessaire” : Demande si la couche n’a pas de bande, mais qu’elle possède des sous-couches

– “Jamais” : Ne demande jamais, mais ne charge rien

– “Charger tout” : Ne demande jamais, mais charge toutes les sous-couches

• Ignorer la déclaration interne d’encodage des shapefiles. Si une couche shapefile a une information
d’encodage interne, elle sera ignorée par Qgis.

• Ajouter des couches PostGIS avec un double-clic et sélectionner en mode étendu

• Ajouter les couches Oracle par double-clic et sélection en mode étendu

• Exécuter les expressions coté serveur si possible

• Évaluer les valeurs par défaut définit si les valeurs par défaut du fournisseur de base de données doivent
être calculées lors de la numérisation de la nouvelle entité (checked status) ou lors de la sauvegarde des
modifications.

Chemins masqués
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La fenêtre liste les dossiers que vous avez choisis de cacher dans le panneau de l’explorateur. Supprimer un
dossier dans la liste permet de le retrouver dans le panneau de l’explorateur.

Figure 9.3: Les paramètres Sources de données dans Qgis

9.1.5 Rendu

Comportement du rendu

• Par défaut les couches supplémentaires sont affichées: Décocher cette option peut être pratique lors du
chargement de plusieurs couches pour éviter que chaque nouvelle couche ne soit restituée dans la carte et
ralentisse le processus.

• Utiliser le cache du rendu si possible pour accélérer l’affichage

• Rendu des couches en parallèle en utilisant plusieurs cœurs du processeur

• Nombre de cœurs à utiliser

• Intervalle de rafraîchissement de l’affichage de la carte (par défaut de 250 ms)

• Activer la simplification des entités par défaut lors de l’ajout de nouvelles couches

• Seuil de simplification

9.1. Options 47



QGIS User Guide, Version 3.4

Figure 9.4: Onglet Rendu des Options de Qgis

• Algorithme de simplification: Cette option effectue une simplification « à la volée » des entités et accélère
le rendu de la géométrie. Cela ne change pas la géométrie récupérée auprès des fournisseurs de données.
Ainsi, lorsque vous avez des expressions qui utilisent la géométrie de l’élément (par exemple, le calcul de
la surface) - cela garantit que ces calculs soient effectués sur la géométrie originale et non sur la géométrie
simplifiée. QGIS propose trois algorithmes de simplification :”Distance” (par défaut), “SnapToGrid” et
“Visvalingam”.

• Réaliser la simplification par le fournisseur de données lorsque c’est possible: Les géométries sont
simplifiées par le fournisseur (PostGIS, Oracle. . . ) et contrairement à la simplification locale, les calculs
basés sur la géométrie peuvent être affectés.

• Échelle maximale à partir de laquelle la couche doit être simplifiée

• Niveau d’agrandissement (see the agrandissement)

Note: En plus des Options de configuration de Qgis, les entités peuvent être simplifiées pour chaque couche
depuis l’onglet Propriétés de la couche → Rendu .

Qualité du rendu

• Les lignes semblent moins déchiquetées aux dépends d’une certaine vitesse d’exécution

Segmentation courbe

• Tolerance de segmentation: ce paramètre contrôle la façon dont les arcs circulaires sont segmentés. Le
plus petit angle maximum (entre les deux sommets consécutifs et le centre de la courbe, en degrés) ou la
différence maximale (distance entre le segment des deux sommets et la ligne de la courbe, en unités de la
carte), permet de définir les segments de la ligne la plus droite qui seront utilisés.
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• Type de tolérance: on choisira Angle maximal ou *Différence maximale * pour gérer la façon de segmenter
la courbe.

Rasters

• Avec la Sélection de bande RVB, vous pouvez définir la valeur des bandes Rouge, Verte et Bleue.

Amélioration du contraste

Les options d’amélioration du contraste peuvent être appliquées à Bande grise unique, Couleur à bandes multiples
(octet /bande) or Couleur à bandes multiples (>octet / bande). Pour chacun, vous pouvez définir :

• l”Algorithme à utiliser, dont les valeurs peuvent être “Pas d’étirement”,”Étirement jusqu’au MinMax”,
“Étirement et couper jusqu’au MinMax” ou “Couper jusqu’au MinMax”

• les Limites (minimum/maximum) à appliquer, avec des valeurs telles que “Histogramme cumulatif - dé-
compte de coupe”, “Minimum /maximum”, “Moyenne+/- écart type”.

Pour le rendu des rasters, vous pouvez également définir les options suivantes :

• Limite de découpe pour le comptage cumulé de pixels

• Multiplicateur de l’écart-type

Déboggage

• Actualisation du canevas de carte pour suivre la durée de rendu dans le panneau journal des messages
onglet Rendu.

9.1.6 Canevas et légende

Figure 9.5: Canevas et légende

Cet onglet vous permet de définir :

• L” Apparence de carte par défaut (écrasée par les propriétés du projet ): la Couleur de sélection et la
Couleur de fond.

• Interaction avec la Légende des couches :

– Double click dans la légende . Vous pouvez soit “Ouvrir les propriétés de la couche” soit “Ouvrir
la table attributaire” ou “Ouvrir le panneau de style de couche” .

– Afficher les attributs de classification dans le titre des calques dans le panneau des couches ,
notamment pour la symbologie catégorisée oubasée sur des règles (voir Onglet Symbologie pour plus
d’informations).

– La résolution de l’image getLegendGraphic pour le WMS
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• Le Délai en millisecondes pour les couches map tips display

9.1.7 Outils cartographiques

Cet onglet propose des options concernant le comportement de l”Outil Identifier.

• l:Rayon de recherche pour identifier les entités et afficher les infobulles est la distance à l’intérieur de
laquelle l’outil d’identification affichera les résultats.

• Couleur de surbrillance vous permet de choisir avec quelle couleur les entités qui devraient être identifiées
sont en surbrillance.

• Tampon détermine une zone tampon pour la mise en surbrillance des bordures des entités identifiés.

• Largeur minimum détermine l’épaisseur de la bordure d’un objet mis en surbrillance.

Outils de mesure

• Définir la Couleur du trait des outils de mesure

• Définir le Nombre de décimales

• Garder l’unité de base pour ne pas convertir automatiquement des grands nombres (ex: mètres en
kilomètres).

• Unités de distance préférées (“Mètres”, “Kilomètres”, “Pieds”, “Yards”, “Miles”, “Miles Nautiques”,
“Degrés” ou “Unités de la carte”)‘

• Unités de surface préférées (“Mètres carrés”, “kilomètres carrés”, “Pieds carrés”, “Yards carrés”,
“Miles carrés”, “Hectares”, “Acres”, “Miles nautiques carrés”,”Degrés carrés” or “Unités de carte”)

• Unités d’angle préférées (“Degrés”, “Radians”, “Grades/gradians”, “Minutes d’arc”, “Secondes d’arc”
or “Tours/révolutions”)

Déplacement et zoom

• Définit le Facteur de zoom pour les outils de zoom ou la molette de la souris.

Échelles prédéfinies

Vous trouverez ici une liste d’échelles prédéfinies. Avec et Vous pouvez ajouter ou supprimer vos échelles
personnelles. Vous pouvez également importer ou exporter des échelles depuis / vers un fichier .XML. Notez que
vous avez toujours la possibilité de supprimer vos modifications et de réinitialiser les échelles par défaut.

9.1.8 Couleurs

Ce menu vous permet de créer ou de mettre à jour les palettes de couleurs utilisées dans le sélecteur de couleurs.
Vous pouvez choisir :

• Couleurs récentes montre les couleurs utilisées récemment

• Couleurs standard, la palette de couleurs par défaut

• Couleurs du projet, un jeu des couleurs utilisées dans le projet courant (voir Onglet Style par défaut pour
plus de détails)

• Nouvelles couleurs de couches, un jeu de couleurs à utiliser par défaut lorsque de nouvelles couches sont
ajoutées.

• Les palettes personnalisées, peuvent être crées ou importées grâce au bouton . . . à côté de la liste déroulante
de la palette.
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Figure 9.6: Paramètres des outils cartographiques dans QGIS
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Par défaut, les palettes, Couleurs récentes, Couleurs standard et Couleurs du projet ne peuvent pas être supprimées
et sont définies pour apparaître dans le menu déroulant du bouton couleur. Des palettes personnalisées peuvent
également être ajoutées à ce widget grâce à l’option Afficher dans les Boutons de Couleur .

Pour toutes les palettes, vous pouvez gérer la liste des couleurs à l’aide de l’ensemble des outils à côté du cadre,
c’est à dire :

• Ajouter ou Supprimer une couleur

• Copier ou Coller une couleur

• Importer ou Exporter le jeu de couleurs depuis/vers le fichier .gpl .

Double-cliquez sur une couleur dans la liste pour la modifier ou la remplacer dans le Sélecteur de couleurs . Vous
pouvez aussi le renommer en double-cliquant dans la colonne Étiquette .

Figure 9.7: Couleurs

9.1.9 Numérisation

Cet onglet vous permet de configurer les paramètres généraux lors de l”édition d’une couche vecteur (attribut et
géométrie).

Création d’entités

• :guilabel:‘Supprimer la fenêtre de saisie des attributs lors de la création d’une nouvelle entité: ce choix
peut être écrasé dans chaque boîte de dialogue de propriétés de calque.

• Réutiliser les dernières valeurs d’attribut saisies.

• Valider les géométries. L’édition de lignes ou de polygones complexes, composés de nombreux nœuds,
peut entrainer un rendu très lent. Ceci parce que les procédures de validation par défaut dans QGIS peuvent
prendre beaucoup de temps. Pour accélérer le rendu, sélectionnez l’option de validation GEOS (à partir
de GEOS 3.3) ou désactivez l’option. La validation de géométrie GEOS est beaucoup plus rapide, mais
l’inconvénient est qu’elle ne signale que le premier problème de géométrie rencontré.

• Valeur Z par défaut à utiliser lors de la création de nouvelles entités 3D.

Contours d’édition

• Définit le coutour Largeur de ligne, Couleur de Ligne et Couleur de remplissage.

• Ne pas mettre à jour le contour lors de l’édition.
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Accrochage

• Enable snapping by default activates snapping when a project is opened

• Définit le mode d’accrochage par défaut (“Sommet”, “Sommet et segment”,”Segment”)

• Définir Tolérance d’accrochage par défaut en unités de carte ou en pixels

• Définir le Rayon de recherche pour l’édition des sommets en unités de carte ou en pixels

• Afficher la fenêtre principale en tant que (redémarrage nécessaire): permet de définir si la boîte de dialogue
“Configuration avancée / Paramètres d’accrochage du projet” doit être affichée en tant que “Dialogue” ou
“Intégré” .

• Couleur du marqueur d’accrochage

• Afficher les infobulles d’accrochage telles que le nom de la couche dont vous êtes sur le point d’accrocher
l’entité. Utile lorsque plusieurs entités se chevauchent.

• Activer l’accrochage sur des entités invisibles (non visibles sur la carte)

Symbole des sommets

• Montrer les symboles uniquement pour les entités sélectionnées

• Définir le Syle de marqueur (“Croix” (par défaut), “Cercle semi-transparent” ou “Aucun”) du sommet

• Définir la Taille du marqueur des sommets

Outil de décalage de courbe

Les trois options suivantes se réfèrent à l’outil de Décalage de courbe dans Numérisation avancée. Grâce aux
différents réglages, il est possible de modifier la forme du décalage de ligne. Ces options sont possibles à partir de
GEOS 3.3.

• style de jointure: “Round”, “Angle droit” or “Oblique”

• Segments de quadrant

• Limite de la pointe

9.1.10 Mises en page

Valeurs par défaut pour les compositions

Vous pouvez définir la police par défaut à utiliser dans les mises en page.

Apparence de la grille

• Définir le Style de la grille (“Continu”, “Pointillés”, “Croix”)

• Définir la Couleur de la grille

Grille et guide par défaut

• Définir l”Espacement de la grille

• Définit le décalage de la Grille en X et Y

• Définir la Tolérance d’accrochage

Répertoires des modèles de mises en page

• Définit le(s) Chemin(s) de recherche des modèles supplémentaires d’impression : la liste des dossiers con-
tenant des modèles à utiliser lors de la création de nouvelles mises en page .

9.1. Options 53



QGIS User Guide, Version 3.4

Figure 9.8: Paramètres de la numérisation dans QGIS
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Figure 9.9: Paramètres des mises en page dans Qgis

9.1.11 GDAL

GDAL est une bibliothèque d’échange de données pour les fichiers vectoriels et raster. Il fournit des pilotes pour
lire et/ou écrire des données dans différents formats. L’onglet GDAL expose actuellement les pilotes pour les
formats raster avec leurs capacités.

Options des pilotes GDAL

This frame provides ways to customize the behavior of drivers that support read and write access:

• Edit create options: allows you to edit or add different profiles of file transformation, i.e. a set of predefined
combinations of parameters (type and level of compression, blocks size, overview, colorimetry, alpha. . . ) to
use when outputting raster files. The parameters depend on the driver.

Figure 9.10: Sample of create options profile (for GeoTiff)

The upper part of the dialog lists the current profile(s) and allows you to add new ones or remove any of
them. You can also reset the profile to its default parameters if you have changed them. Some drivers (eg,
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GeoTiff) have some sample of profiles you can work with.

At the bottom of the dialog:

– The button lets you add rows to fill with the parameter name and value

– The button deletes the selected parameter

– Click the Validate button to check that the creation options entered for the given format are valid

– Use the Help button to find the parameters to use, or refer to the GDAL raster drivers documentation.

• Edit Pyramids Options

Figure 9.11: Sample of Pyramids profile

GDAL drivers

In this frame, you can define which GDAL driver is to use to read and/or write files, as in some cases more than
one GDAL driver is available.

Astuce: Double-click a driver that allows read and write access (rw+(v)) opens the Edit Create options dialog
for customization.

9.1.12 Variables

L’onglet Variables liste toutes les variables disponibles au niveau global.

Il permet également à l’utilisateur de gérer des variables de niveau global. Cliquez sur le bouton|signPlus| pour
ajouter une nouvelle variable de niveau global personnalisée. De même, sélectionnez une variable de niveau global

personnalisée dans la liste et cliquez sur le bouton pour la supprimer.

Plus d’informations dans la section Storing values in Variables section.

9.1.13 Authentification

Dans l’onglet Authentification , vous pouvez définir des configurations d’authentification et gérer des certificats
PKI. Voir Système d’authentification pour plus de détails.
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Figure 9.12: Paramètres de GDAL dans Qgis

Figure 9.13: Variables
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Figure 9.14: Paramètres d’authentification dans Qgis

9.1.14 Réseau

Général

• Définir l”Adresse de recherche WMS, par défaut : http://geopole.org/wms/search?
search=\%1\&type=rss

• Définir le Délai d’abandon pour les requêtes réseaux (ms) - la valeur par défaut est 60000

• Define Durée par défaut d’expiration du cache des listes de couches WMS (en heures) - la valeur par défaut
est 24

• Définir le Délai d’expiration pour les tuiles WMSC/WMTS (en heures)- la valeur par défaut est 24

• Define Nombre maximal de tentatives lors d’erreurs de récupération de tuile ou d’entités

• Définir le User-Agent

Paramètres du cache

Defines the Directory and a Size for the cache. Also offers tools to automatically clear the connection authentica-
tion cache on SSL errors (recommended).

Proxy pour l’accès Internet

• Utiliser un proxy pour l’accès Internet

• Paramétrez le Type de proxy en fonction de vos besoins, définissez “Host” et “Port”. Les types de
proxy disponibles sont :

– Proxy par Défaut: le proxy est déterminé sur la base du proxy système.

58 Chapter 9. Configuration de QGIS



QGIS User Guide, Version 3.4

Figure 9.15: Paramètres de proxy dans Qgis
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– Socks5Proxy : proxy générique pour tout type de connexion. Supporte le TCP, UDP, binding à un port
(connexions entrantes) et l’authentification.

– HttpProxy : implémenté avec la commande « CONNECT » , supporte uniquement les connexions
TCP sortantes, supporte l’authentification.

– HttpCachingProxy : implémenté via les commandes HTTP normales, utile uniquement dans un con-
texte de requêtes HTTP.

– FtpCachingProxy : implémenté avec un proxy FTP, utile uniquement dans un contexte de requêtes
FTP.

Les authentifications au niveau du proxy sont décrites dans authentication widget.

Vous pouvez exclure certaines adresses en les ajoutant dans la zone de texte sous les paramètres de proxy (voir
Figure_Network_Tab).

Si vous avez besoin d’informations plus détaillées sur les différents paramètres de proxy, référez-vous au manuel
de la bibliothèque sous-jacente QT : https://doc.qt.io/qt-5.9/qnetworkproxy.html#ProxyType-enum

Astuce: Utiliser les proxy

L’utilisation de proxy peut se révéler difficile. Il est utile de tester les types de proxy décrits ci-dessus et vérifier
s’ils conviennent.

9.1.15 Localisateur

L’onglet Localisateur permet de configurer la barre de localisation, un widget de recherche rapide disponible
dans la barre d’état qui vous aide à effectuer des recherches n’importe où dans l’application. Il fournit quelques
filtres par défaut (avec préfixe) à utiliser :

• Les couches du projet (l): trouve et sélectionne une couche dans le panneau Couches .

• Mises en pages (pl): trouve et ouvre une mise en page.

• Actions (.): trouve et exécute une action QGIS ; les actions peuvent représenter tout outil ou menu de
QGIS, ouvrir un panneau . . .

• Entités de la couche active (f): recherche les attributs correspondants dans n’importe quel champ de la
couche active actuelle et effectue un zoom sur l’élément sélectionné.

• Entités de toutes les couxhes (af): recherche dans les attributs définis dans le display name pour chaque
searchable layers et zoome sur l’entité selectionnée.

• Calculateur (=): permet d’évaluer n’importe quelle expression Qgis et si elle est valide, le résultat peut être
copié dans le presse-papier .

• Signets spatiaux (b): trouve et zoome sur l’étendu du signet.

• Options (set): affiche et ouvre des boîtes de dialogue de propriétés pour l’ensemble du projet et des options
de Qgis.

• Traitements (a): Cherche et ouvre les fenêtres des algorithmes de traitement.

• Modifier les entités sélectionnées (ef): vous donne un accès rapide et lance un algorithme de traitement
compatible avec modify-in-place sur la couche active.

Vous pouvez personnaliser chaque le filtre, définir s’il est activé par défaut ou non. L’ensemble des filtres de
localisation par défaut peut être étendu par des plugins, par exemple pour les recherches nominatives OSM, les
recherches directes dans les bases de données, les recherches dans les catalogues de couches.

La barre de recherche de localisateur peut être activée en appuyant sur Ctrl+K. Tapez votre texte pour effectuer
une recherche. Par défaut, les résultats sont retournés pour tous les filtres de localisation activés, mais vous pouvez
limiter la recherche à un certain filtre en préfixant votre texte avec le préfixe de filtre de localisation, c’est-à-dire
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que si vous tapez l cad seules les couches dont le nom contient cad seront affichées. Cliquez sur le résultat
pour exécuter l’action correspondante, selon le type d’élément.

La recherche est gérée à l’aide de threads, de sorte que les résultats sont toujours disponibles le plus rapidement
possible, indépendamment du fait que des filtres de recherche lente puissent être installés ou non. Ils apparaissent
également dès que chaque résultat est rencontré par chaque filtre, ce qui signifie par exemple qu’un filtre de
recherche de fichier affichera les résultats un par un au fur et à mesure que l’arborescence des fichiers est analysée.
Cela garantit que l’interface utilisateur est toujours réactive, même en présence d’un filtre de recherche très lent
(par exemple, un filtre qui utilise un service en ligne).

Astuce: Accès rapide aux configurations du localisateur

Cliquez sur l’icône à l’intérieur du widget de recherche dans la barre d’état pour afficher la liste des filtres
que vous pouvez utiliser ainsi que la fonction Configure qui ouvre l’onglet Localisateur du menu Préférences →
Options. . . .

Figure 9.16: Onglet Localisateur dans Qgis

9.1.16 Avancé

En fonction de votre système d’exploitation, tous les paramètres relatifs à QGIS (interface utilisateur, outils,
fournisseurs de données, valeurs par défaut, options des plugins. . . ) sont enregistrés :

• dans un fichier texte : $HOME/.config/QGIS/QGIS2.conf

• dans le fichier de propriétés : $HOME/Library/Preferences/org.qgis.qgis.plist

• dans la base de registre, sous: HKEY\CURRENT_USER\Software\QGIS\qgis

L’onglet Avancé vous offre en un seul endroit, quel que soit votre système d’exploitation, la possibilité de gérer
ces paramètres via l “Éditeur avancé de paramètres. Après avoir promis d’être prudent, le widget est rempli par
l’arborescence de tous les paramètres QGIS, que vous pouvez modifier directement.
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Avertissement: N’utilisez l’onglet « Avancé » qu’en connaissance de cause

Soyez prudent lorsque vous modifiez des éléments dans cette boîte de dialogue étant donné que les modifica-
tions sont automatiquement appliquées. Effectuer des changements sans en connaître les conséquences peut
corrompre votre installation QGIS de diverses façons.

Figure 9.17: L’onglet Avancé dans Qgis

9.1.17 Traitement

L’onglet Traiement vous permet d’accéder aux paramètres généraux des outils et fournisseurs de traitement
utilisés dans l’extension Processing de Qgis. Plus d’informations Outils de traitement QGIS.

9.2 Utiliser les profils utilisateur

Le menu Préférences → Profils utilisateurs permet de définir des profils utilisateur et d’y accéder. Un profil
utilisateur permet d’enregistrer dans un même dossier les configurations suivantes :

• all the global settings, including locale, projections, authentication settings, color palettes, shortcuts. . .

• Configurations et personnalisation de l’interface

• Les plugins installés et leurs configurations

• les modèle de projet et l’historique des projets sauvegardés avec leur imagette de pré-visualisation

• les réglages des traitements, logs, scripts, modèles.

Par défaut, une installation QGIS contient un seul profil d’utilisateur appelé » par défaut « . Mais vous pouvez
créer autant de profils utilisateurs que vous le souhaitez :

1. Cliquez sur Nouveau profil. . . .
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Figure 9.18: Onglet Traitement
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2. Vous pouvez saisir le nom du profil, ce qui crée un dossier du même nom sous ~/<UserProfiles>/ où
:

• ~ représente le dossier HOME , qui sous Windows est en général C:\Users\(user).

• et‘‘<UserProfiles>‘‘ représente le dossier racine du profil, i.e.:

– .local/share/QGIS/QGIS3/profiles/

– AppData\Roaming\QGIS\QGIS3\profiles\

– Library/Application Support/QGIS/QGIS3/profiles/

Le dossier du profil peut être ouvert depuis Qgis en utilisant Ouvrir le dossier du profil actif.

3. A new instance of QGIS is started, using a clean configuration. You can then set your custom configurations.

Comme chaque profil utilisateur contient des paramètres, des plugins et un historique propres, ils peuvent être
utilisés pour différents Workflows, démos, utilisateurs de la même machine, ou pour tester des paramètres, etc. Et
vous pouvez passer de l’un à l’autre en les sélectionnant dans le menu Préférences → Profils utilisateurs . Vous
pouvez aussi lancer Qgis avec un profil spécifique en ligne de commande command line.

À moins qu’il ne soit modifié, le profil de la dernière session QGIS sera utilisé dans les sessions QGIS suivantes .

Astuce: Exécuter QGIS avec un nouveau profil utilisateur pour vérifier la persistance des bogues

Lorsque vous rencontrez un comportement bizarre avec certaines fonctions dans QGIS, créez un nouveau profil
utilisateur et exécutez à nouveau les commandes. Parfois, les bogues sont liés à des restes dans le profil utilisateur
actuel et la création d’un nouveau profil utilisateur peut les corriger en redémarrant QGIS avec le nouveau profil
(propre).

9.3 Propriétés du projet

Dans la fenêtre des propriétés du projet sous Projet → Propriétés, vous pouvez définir des options spécifiques au
projet. Les options spécifiques au projet écrasent leur équivalent dans les Options décrites ci-dessus.

9.3.1 Onglet Général

Dans l’onglet Général, les Paramètres généraux vous permettent de:

• voir l’emplacement du ficher projet

• définir le dossier racine du projet (nommé Dossier du projet dans l’explorateur). Le chemin peut
être relatif au dossier du fichier projet (si saisi) ou absolu. La dossier racine du projet peut être utilisé pour
stocker des données et d’autres contenus utiles pour le projet.

• Donner un titre au projet en supplément du chemin de fichier

• Choisir la couleur des entités sélectionnées

• Choisir la couleur de fond du canevas

• Définir si le chemin d’accès aux couches dans le projet doit être enregistré en absolu (complet) ou en relatif
par rapport à l’emplacement du fichier de projet. Vous pouvez préférer le chemin relatif lorsque les couches
et le fichier de projet peuvent être déplacés ou partagés ou si le projet est accessible à partir d’ordinateurs
sur différentes plates-formes.

• Choisir d’éviter les artefacts lorsque le projet est rendu sous forme de tuiles. Utiliser cette option peut
entraîner une dégradation des performances.

Le calcul des surfaces et des distances est un besoin courant dans les SIG. Cependant, ces valeurs sont réellement
liées aux paramètres de la projection. La partie Mesures vous permet de contrôler ces paramètres. Vous pouvez en
effet choisir :
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• l” Ellipsoïde, sur laquelle les calculs de distance et de surface sont entièrement basés ; il peut être :

– None/Planimetric: les valeurs retournées sont dans ce cas, des mesures cartésiennes.

– **Personnalisation ** : Vous permet de saisir les valeurs des axes Semi-majeur ou demi grand axe et
Semi-mineur .

– ou en choisir dans la liste prédéfinie (Clarke 1866, Clarke 1880 IGN, New International 1967, WGS
84. . . ).

• Les Unités pour les mesures de distance pour les longueurs et périmètres et Unités pour les mesures de
surface. Ces paramètres remplacent les unités définies par défaut dans les options QGIS pour le projet en
cours, elles sont utilisés dans:

– Barre de mise à jour des champs de la table des attributs

– Les calculs de la calculatrice de champ

– Les calculs dérivés de longueurs, périmètres et surfaces de l’outil identifier

– Unité par défaut affichée dans la boîte de dialogue de mesure

L” Affichage des Coordonnées vous permet de choisir le format des unités à utiliser pour afficher les coordonnées
de l’emplacement de la souris dans la barre d’état et les coordonnées dérivées affichées via l’outil d’identification.

Enfin, vous pouvez définir la liste des Échelles de projet prédéfinies, qui remplace les options « Échelles
prédéfinies ».

9.3.2 Onglet Metadonnées

L’onglet Metadonnées permet de définir des métadonnées détaillées, incluant (entre autres) : auteur, date de
création, langue, résumés, catégories, mots clés, coordonnées, liens, historique. Il y a aussi une fonctionnalité de
validation qui vérifie si des champs spécifiques ont été remplis, mais sans obliger la validation. Voir Propriétés
des Méta données des couches vectorielles pour plus de détails.

9.3.3 Onglet SCR

L’onglet SCR vous permet de définir le Système de Coordonnées de Référence à utiliser dans le projet. Les
options sont :

• Aucune projection (or projection inconnue /projection non terrestre) : ce paramètre peut être utilisé pour
simuler un CRS de couche ou lors de l’utilisation de QGIS pour des utilisations non terrestres comme des
cartes de jeux de rôle, des cartes de bâtiments ou des objets microscopiques. Dans ce cas-ci :

– Aucune reprojection n’est effectuée lors de l’affichage des couches: les entités sont simplement dess-
inées en utilisant leurs coordonnées brutes.

– L’ellipsoïde est verrouillé et forcé à « Non/Planimétrique ».

– Les unités de distance et de surface ainsi que l’affichage des coordonnées sont verrouillés et forcés à
« unités inconnues » ; toutes les mesures sont effectuées dans des unités cartographiques inconnues et
aucune conversion n’est possible.

• ou il existe un système de coordonnées de référence qui peut être géographique, projeté ou défini par
l’utilisateur. Un aperçu de l’étendue terrestre du SCR s’affiche pour vous aider à choisir le bon. Les couches
ajoutées au projet sont transformées à la volée dans ce SCR afin de les superposer, indépendamment de leur
SCR d’origine. L’utilisation des unités, le paramétrage de l’ellipsoïde sont possibles et ont un sens et vous
pouvez effectuer les calculs en conséquence.

L’onglet SCR vous permet également de contrôler les paramètres de reprojection des couches en configu-
rant les préférences de transformation de données à appliquer dans le projet en cours. Comme d’habitude, ces
paramètres remplacent tous les paramètres globaux correspondants. Voir Datum Transformations pour plus de
détails.
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Figure 9.19: Onglet Général de la boîte de dialogue Propriétés du projet

66 Chapter 9. Configuration de QGIS



QGIS User Guide, Version 3.4

9.3.4 Onglet Style par défaut

L’onglet Style par défaut vous permet de contrôler comment les nouvelles couches seront symbolisées dans le
projet quand elles n’ont pas de fichier de style défini .qml. Vous le pouvez :

• Définir les symboles par défaut (Symbole, Ligne, Remplissage) à appliquer selon le type de géométrie de la
couche ainsi que la Palette de couleur par défaut

• Appliquer une Opacité par défaut aux nouvelles couches.

• Assigner une couleur aléatoire aux symboles, en gérant les couleurs de remplissage des symboles pour
éviter le même rendu pour toutes les couches.

Figure 9.20: Onglet Style par défaut

En utilisant le bouton Gestionnaire de symboles, vous pouvez aussi accéder rapidement à la fenêtre Gestion-
naire de style et configurer les symboles et les palettes de couleurs.

Il y a aussi une section supplémentaire où vous pouvez définir des couleurs spécifiques pour le projet en cours.
Comme dans l’onglet couleurs des options globales, vous pouvez :

• Ajouter ou Supprimer une couleur

• Copier ou Coller une couleur

• Importer ou Exporter le jeu de couleurs depuis/vers le fichier .gpl .

Double-cliquez sur une couleur dans la liste pour la modifier ou la remplacer dans le Sélecteur de couleurs . Vous
pouvez aussi le renommer en double-cliquant dans la colonne Étiquette .

Ces couleurs sont identifiées comme les Couleurs du projet et listées comme faisant partie d Sélecteur de couleurs.

Astuce: Utilisez les couleurs du projet pour assigner et mettre à jour rapidement le sélecteur de couleurs
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Les couleurs du projet peuvent être référencées à l’aide de leur étiquette et les sélecteurs de couleurs dans lesquels
elles sont utilisées leurs sont liés. Cela signifie qu’au lieu de définir à plusieurs reprises la même couleur pour de
nombreuses propriétés et, pour éviter une mise à jour fastidieuse, vous pouvez :

1. Définir la couleur comme couleur de projet

2. Appliquez le en utilisant l’expression‘‘project_color(“color_label”)‘‘ dans couleur données définies

3. Mettre à jour la couleur une fois dans une liste Couleurs du projet.

4. Et le changement se reflète PARTOUT

9.3.5 Onglet sources de données

Dans l’onglet Sources de données, vous pouvez :

• Créez automatiquement des groupes de transactions lorsque c’est possible: Lorsque ce mode est activé,
toutes les couches (postgres) d’une même base de données sont synchronisées dans leur état d’édition, c’est-
à-dire que lorsqu’une couche passe en mode édition, toutes le sont et quand une couche est sauvegardé ou
une couche est réinitialisée, les autres le sont aussi. De plus, au lieu de garder les modifications en mémoire
tampon localement, elles sont directement envoyées à une transaction dans la base de données qui est validée
lorsque l’utilisateur clique sur Enregistrer la couche. Notez que vous ne pouvez (dé)activer cette option que
si aucune couche n’est en cours d’édition dans le projet.

• Évaluer les valeurs par défaut depuis le fournisseur de données : Lors de l’ajout de nouvelles en-
tités dans une table PostgreSQL, les champs avec contrainte de valeur par défaut sont évalués et remplis
à l’ouverture du formulaire, et non au moment de la validation. Cela signifie qu’au lieu d’une expression
comme nextval('serial'), le champ du formulaire Ajout d’entité affichera la valeur attendue (par
exemple, 25).

• Projet de confiance lorsque la source de données n’a pas de métadonnées : Accélérer le chargement
du projet en sautant les contrôles de données. Utile dans le contexte de QGIS Serveur ou dans des projets
avec d’énormes vues de base de données / vues matérialisées. L’emprise des couches sera lue à partir du
fichier de projet QGIS (au lieu des sources de données) et lorsque vous utilisez le fournisseur PostgreSQL,
l’unicité de la clé primaire ne sera pas vérifiée pour les vues et les vues matérialisées.

• Configurez les Capacités des couches :

– Définir quelles couches sont identifiables, c’est-à-dire qu’elles répondront à l’outil identifier
des entités. Par défaut, les couches sont identifiables.

– Définir si une couche doit être en lecture seule, ce qui signifie qu’elle ne peut pas être modifiée par
l’utilisateur, quelles que soient les capacités du fournisseur de données. Bien que cette protection soit
faible, elle reste une configuration rapide et pratique pour éviter que les utilisateurs finaux ne modifient
les données lorsqu’ils travaillent avec des couches basées sur des fichiers.

– Définir quelles couches sont recherchables, c’est-à-dire qu’elles peuvent être interrogées à l’aide
de la :ref:‘ barre de localisation <locator_options>‘. Par défaut, les couches sont recherchables.

– Définir quelles couches sont « requises ». Les couches cochées dans cette liste sont protégées contre
une suppression accidentelle du projet.

La section Capacités des couches fournit des outils pratiques pour :

– Sélectionnez plusieurs cases et appuyez sur Inverser la sélection pour changer leur état ;

– Afficher les tables spatiales seulement, en excluant les couches non spatiales ;

– Filtrer les couches. . . pour trouver rapidement une couche particulière à configurer.
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9.3.6 Onglet Relations

L’onglet Relations permet de définir les relations 1:n. Les relations sont définies dans la boîte de dialogue des
propriétés du projet. Une fois que des relations existent pour une couche, un nouvel élément dans la vue formu-
laire (par exemple, lors de l’identification d’un élément et de l’ouverture de son formulaire) va lister les entités
associées. Il s’agit d’un moyen puissant d’exprimer, par exemple, l’historique d’inspection sur une longueur de
pipeline ou un segment de route. Vous pouvez en savoir plus sur le support des relations 1:n dans la section Créer
des relations un ou plusieurs à plusieurs.

9.3.7 Onglet Variables

L’onglet Variables Variables‘ liste toutes les variables disponibles au niveau du projet (ce qui inclut les variables
globales). En outre, il permet également à l’utilisateur de gérer des variables au niveau du projet. Cliquez sur

le bouton pour ajouter une nouvelle variable personnalisée au niveau du projet. De même, sélectionnez une

variable de projet personnalisée dans la liste et cliquez sur le bouton pour la supprimer. Plus d’informations
sur l’utilisation des variables dans la section Outils généraux Storing values in Variables.

9.3.8 Onglet Macros

L’onglet Macros permet d’éditer des modules Python pour les projets. Actuellement, seules trois macros sont
disponibles : openProject(), saveProject() et closeProject().

9.3.9 Onglet QGIS Server

L’onglet QGIS Server vous permet de configurer votre projet afin de le publier en ligne. Ici, vous pouvez définir
des informations sur les capacités WMS et WFS de QGIS Server, l’emprise et les restrictions de SCR. Plus
d’informations disponibles dans la section Configure your project et suivantes.

9.4 Personnalisation

La fenêtre de Personnalisation vous permet de (dés)activer presque tous les éléments de l’interface utilisateur de
QGIS. Cela peut s’avérer très utile si vous souhaitez fournir à vos utilisateurs finaux une version “légère” de QGIS
avec uniquement les icônes, les menus ou les panneaux dont ils ont besoin.

Note: Pour que les modifications soient appliquées, vous devrez redémarrer QGIS.

Cocher Autoriser la modification est la première étape pour personnaliser l’IHM de QGIS. Cela active la barre
d’outils et le panneau permettant de sélectionner/désélectionner les éléments d’IHM.

Les éléments personnalisables sont :

• un Menu ou des sous-menus de la Barre de Menu

• un Panel complet (voir Panneaux et barres d’outils)

• la Barre d’état décrite dans Barre d’état ou certains de ses éléments

• une Toolbar: complète, ou certains des boutons

• Ou tout widget: label, bouton, combobox,. . . dans n’importe quelle boîte de dialogue de QGIS.

Avec Selection interactive d’objet depuis la fenêtre principale, vous pouvez cliquer sur un élément de l’interface de QGIS que
vous souhaitez cacher et automatiquement décocher l’entrée correspondante dans la liste de personnalisation.
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Figure 9.21: Paramètres des macros dans QGIS

Figure 9.22: La fenêtre de personnalisation (Paramétrage)
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Une fois les options configurées, cliquez sur Appliquer ou OK pour valider vos modifications. Cette configuration
devient celle utilisée par défaut par QGIS au prochain démarrage.

Les modifications peuvent également être sauvegardées dans un fichier .ini en utilsant le bouton
Enregistrer dans le fichier. C’est une façon pratique de partager une interface QGIS commune entre plusieurs utilisateurs.

Il suffit de cliquer sur Charger depuis le fichier dans l’ordinateur de destination afin d’importer le fichier .ini. Vous
pouvez également utiliser les options de ligne de commande et enregistrer diverses configurations pour différents
cas d’utilisation.

Astuce: Restaurer facilement l’IHM initiale de QGIS

La configuration initiale de l’IHM de QGIS peut être restaurée par l’une des méthodes ci-dessous :

• décocher Autoriser la modification option dans la boite de dialogue Paramétrage ou cliquer
Sélectionner tout

• en appuyant sur le bouton Réinitialiser l’interface utilisateur aux réglages d’origine” dans la section
**Paramètres** dans le menu :menuselection:‘Préférences–> Options , onglet Système

• démarrer QGIS en ligne de commande avec la commande suivante qgis --nocustomization

• mettre à false la valeur de la variable UI → Customization → Enabled du menu Préférences → Options,
onglet Avancé (voir warning).

Dans la plupart des cas, vous aurez à redémarrer QGIS pour que les modifications soient prises en compte.

9.5 Raccourcis clavier

QGIS fournit des raccourcis clavier par défaut pour de nombreuses actions. Vous pouvez les trouver dans la section

Barre de Menu. De plus, l’option de menu Préférences→ Raccourcis clavier. . . vous permet de changer les
raccourcis clavier par défaut et d’en ajouter de nouveaux à QGIS fonctionnalités.

Figure 9.23: Définir les options des raccourcis

La configuration est très simple. Utilisez la boîte de recherche en haut pour trouver une action particulière,
sélectionnez-la dans la liste et cliquez sur :
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• guilabel:Modifier et appuyez sur la nouvelle combinaison de touches que vous voulez utiliser comme nou-
veau raccourci.

• Ne rien définir pour effacer le raccourci

• ou Définir par défaut pour restaurer le raccourci à sa valeur originale par défaut.

Procédez comme ci-dessus pour tout autre outil que vous souhaitez personnaliser. Une fois votre configuration ter-
minée, il vous suffit de Fermer pour que vos modifications soient appliquées. Vous pouvez également Enregistrer
les modifications dans un fichier:.XML et les Charger dans une autre installation QGIS.

9.6 Lancer QGIS avec des paramètres avancés

9.6.1 Command line and environment variables

We’ve seen that launching QGIS is done as for any application on your OS. QGIS provides command line options
for more advanced use cases (in some cases you can use an environment variable instead of the command line
option). To get a list of the options, enter qgis --help on the command line, which returns:

QGIS is a user friendly Open Source Geographic Information System.
Usage: /usr/bin/qgis.bin [OPTION] [FILE]

OPTION:
[--version] display version information and exit
[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text (changes existing

→˓override)
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noversioncheck] don't check for new version of QGIS at startup
[--noplugins] don't restore plugins on startup
[--nocustomization] don't apply GUI customization
[--customizationfile path] use the given ini file as GUI customization
[--globalsettingsfile path] use the given ini file as Global Settings

→˓(defaults)
[--authdbdirectory path] use the given directory for authentication

→˓database
[--code path] run the given python file on load
[--defaultui] start by resetting user ui settings to default
[--hide-browser] hide the browser widget
[--dxf-export filename.dxf] emit dxf output of loaded datasets to

→˓given file
[--dxf-extent xmin,ymin,xmax,ymax] set extent to export to dxf
[--dxf-symbology-mode none|symbollayer|feature] symbology mode for dxf

→˓output
[--dxf-scale-denom scale] scale for dxf output
[--dxf-encoding encoding] encoding to use for dxf output
[--dxf-map-theme maptheme] map theme to use for dxf output
[--take-screenshots output_path] take screen shots for the user

→˓documentation
[--screenshots-categories categories] specify the categories of

→˓screenshot to be used (see QgsAppScreenShots::Categories).
[--profile name] load a named profile from the user's profiles

→˓folder.
[--profiles-path path] path to store user profile folders. Will create

→˓profiles inside a {path}\profiles folder
[--version-migration] force the settings migration from older version if

→˓found
[--openclprogramfolder] path to the folder containing the sources

→˓for OpenCL programs.

72 Chapter 9. Configuration de QGIS



QGIS User Guide, Version 3.4

[--help] this text
[--] treat all following arguments as FILEs

FILE:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs and .qgz):
1. Rasters - supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Astuce: Exemple d’utilisation des arguments en ligne de commande

Vous pouvez lancer QGIS en spécifiant un ou plusieurs fichiers de données sur la ligne de commande. Par exemple,
en supposant que vous êtes dans le répertoire qgis_sample_data, vous pouvez démarrer QGIS avec une
couche vectorielle et un fichier raster à charger au démarrage en utilisant la commande suivante : qgis ./
raster/landcover.img ./gml/lakes.gml

--version

This option returns QGIS version information.

--snapshot

Cette option vous permet de créer une capture d’écran au format PNG à partir de la vue courante. Ceci est
pratique lorsque vous avez plusieurs projets et que vous voulez générer des copies d’écran à partir de vos données,
ou lorsque vous avez besoin d’en créer à partir du même projet avec des données mises à jour.

Actuellement, il génère un fichier PNG de 800x600 pixels. La taille peut être ajustée en utilisant les arguments
--width et `--height. Le nom de fichier peut être ajouté après --snapshot. Par exemple: :

qgis --snapshot my_image.png --width 1000 --height 600 --project my_project.qgs

--width

This option returns the width of the snapshot to be emitted (used with --snapshot).

--height

This option returns the height of the snapshot to be emitted (used with --snapshot).

--lang

En fonction de votre locale, QGIS sélectionne la localisation correcte. Si vous souhaitez changer de langue, vous
pouvez spécifier un code de langue. Par exemple, qgis --lang it lance QGIS en localisation italienne.

--project

Démarrer QGIS avec un fichier de projet existant est également possible. Ajoutez simplement l’option de ligne
de commande --project suivie du nom de votre projet et QGIS s’ouvrira avec toutes les couches du fichier
projet.
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--extent

Pour démarrer avec une étendue de carte spécifique, utilisez cette option. Vous devez ajouter l’emprise du rectangle
encombrant dans l’ordre suivant, séparée par une virgule: :

--extent xmin,ymin,xmax,ymax

Cette option est certainement plus pertinente lorsqu’elle est jumelée à l’option » –projet » pour ouvrir un projet
spécifique avec une emprise souhaitée « .

--nologo

Cette option masque l’écran d’accueil lorsque vous lancez QGIS.

--noversioncheck

Ne fait pas la recherche d’une nouvelle version de QGIS au démarrage.

--noplugins

Si vous avez des problèmes au démarrage avec les plugins, vous pouvez éviter de les charger au démarrage grâce
à cette option. Ils seront toujours disponibles à partir du gestionnaire de plugins par la suite.

--nocustomization

En utilisant cette option, aucune personnalisation de l’interface ne sera appliquée au démarrage. Cela signifie
que tous les boutons cachés, éléments de menu, barres d’outils,et autres, apparaîtront au démarrage de QGIS. Il
ne s’agit pas d’un changement permanent. La personnalisation sera de nouveau appliquée si QGIS est lancé sans
cette option.

Cette option est utile pour autoriser temporairement l’accès aux outils qui ont été supprimés par la personnalisation
de l’interface.

--customizationfile

Cette option vous permet de définir un fichier de personnalisation de l’interface utilisateur qui sera utilisé au
démarrage.

--globalsettingsfile

Using this option, you can specify the path for a Global Settings file (.ini), also known as the Default Set-
tings. The settings in the specified file replace the original inline default ones, but the user profiles” settings
will be set on top of those. The default global settings is located in your_QGIS_PKG_path/resources/
qgis_global_settings.ini.

Actuellement, il n’y a aucun moyen de spécifier un fichier dans lequel écrire les paramètres ; vous pouvez donc
créer une copie d’un fichier de paramètres original, le renommer et l’adapter.

Définir le chemin d’accès du fichier :fichier:‘qgis_global_setting.ini” vers un dossier partagé réseau, permet à un
administrateur système de modifier les paramètres globaux et les valeurs par défaut sur plusieurs machines en
modifiant un seul fichier.

The equivalent environment variable is QGIS_GLOBAL_SETTINGS_FILE.
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--authdbdirectory

Cette option est similaire à --globalsettingsfile, mais définit le chemin vers le répertoire où la base de
données d’authentification sera stockée et chargée.

--code

Cette option peut être utilisée pour définir un fichier python qui sera exécuté directement après le démarrage de
QGIS.

Par exemple, lorsque vous avez un fichier python nommé :fichier:‘load_alaska.py‘ avec le contenu suivant :

from qgis.utils import iface
raster_file = "/home/gisadmin/Documents/qgis_sample_data/raster/landcover.img"
layer_name = "Alaska"
iface.addRasterLayer(raster_file, layer_name)

En supposant que vous êtes dans le répertoire où se trouve le fichier :fichier:‘load_alaska.py‘, vous pouvez dé-
marrer QGIS, charger le fichier raster :fichier:‘landcover.img‘ et donner à la couche le nom “Alaska” en utilisant
la commande suivante: :

qgis --code load_alaska.py

--defaultui

Au chargement, réinitialise de façon permanente l’interface utilisateur (UI) aux paramètres par défaut. Cette
option restaure la visibilité, la position et la taille des panneaux et des barres d’outils. A moins qu’il ne soit à
nouveau modifié, les paramètres par défaut de l’interface utilisateur seront utilisés dans les sessions suivantes.

Notez que cette option n’a aucun effet sur la personnalisation de l’interface. Les éléments cachés par la per-
sonnalisation de l’interface graphique (par exemple la barre d’état) resteront cachés même en utilisant l’option
--defaultui. Voir aussi l’option --nocustomization.

--hide-browser

Au chargement, cache le panneau Explorateur” de l’interface utilisateur. Le panneau peut être activé en cliquant
avec le bouton droit de la souris sur un espace dans les barres d’outils ou en utilisant la commande :menuselec-

tion: Vue–> Panneaux‘ (Settings → Panels in Linux KDE).

A moins qu’il ne soit à nouveau activé, le panneau Explorateur restera caché dans les sessions suivantes.

--dxf-*

Ces options peuvent être utilisées pour exporter un projet QGIS dans un fichier DXF. Plusieurs options sont
disponibles :

• –dxf-export : le nom du fichier DXF dans lequel exporter les couches ;

• –dxf-extent : l’emprise du fichier DXF final ;

• –dxf-symbologie-mode : plusieurs valeurs peuvent être utilisées ici : none (pas de symbologie),
symbollayer (Symbolisation de la couche de symboles), feature (symbologie de l’entité);

• –dxf-scale-denom : le dénominateur de l’échelle de la symbologie ;

• –dxf-encoding : l’encodage du fichier ;

• –dxf-map-theme : choisissez un thème de carte dans l’arborescence des couches.
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--take-screenshots

Prend des captures d’écran pour la documentation utilisateur. Peut être utilisé avec --
screenshots-categories pour filtrer les catégories/sections de la documentation à créer (voir QgsApp-
ScreenShots::Categories).

--profile

Charge QGIS en utilisant un profil spécifique à partir du dossier de profil de l’utilisateur. À moins qu’il ne soit
modifié, le profil sélectionné sera utilisé dans les sessions QGIS suivantes.

--profiles-path

Avec cette option, vous pouvez choisir un chemin pour charger et enregistrer les profils (options utilisateur). Il
crée des profils à l’intérieur d’un dossier {chemin}\profils, qui inclut les paramètres, les plugins installés,
les modèles de traitement et les scripts, et ainsi de suite.

Cette option vous permet, par exemple, de transporter tous vos plugins et paramètres dans une clé USB ou, par
exemple, de les partager entre différents ordinateurs à l’aide d’un service de partage de fichiers.

The equivalent environment variable is QGIS_CUSTOM_CONFIG_PATH.

--version-migration

Si des paramètres d’une version plus ancienne sont trouvés (par exemple, le dossier .qgis2 de QGIS 2.18), cette
option les importera dans le profil QGIS par défaut.

--openclprogramfolder

Cette option vous permet de spécifier un chemin alternatif pour vos programmes OpenCL. Ceci est utile pour les
développeurs qui testent les nouvelles versions des programmes sans avoir besoin de remplacer celles qui existent
déjà.

The equivalent environment variable is QGIS_OPENCL_PROGRAM_FOLDER.

9.6.2 Deploying QGIS within an organization

If you need to deploy QGIS within an organization with a custom configuration file, first you need
to copy/paste the content of the default settings file located in your_QGIS_PKG_path/resources/
qgis_global_settings.ini. This file already contains some default sections identified by a block starting
with []. We recommend that you keep these defaults values and add your own sections at the bottom of the file.
If a section is duplicated in the file, QGIS will take the last one from top to bottom.

You can change allowVersionCheck=false to disable the QGIS version check.

If you do not want to display the migration window after a fresh install, you need the following section:

[migration]
fileVersion=2
settings=true

If you want to add a custom variable in the global scope:

[variables]
organisation="Your organization"
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To discover all possibilities of the settings INI file, we suggest that you set the config you would like in QGIS
Desktop and then search for it in your INI file located in your profile using a text editor. A lot of settings can be
set using the INI file such as WMS/WMTS, PostGIS connections, proxy settings, maptips. . .

Finally, you need to set the environment variable QGIS_GLOBAL_SETTINGS_FILE to the path of your cus-
tomized file.

In addition, you can also deploy files such as Python macros, color palettes, layout templates, project templates. . .
either in the QGIS system directory or in the QGIS user profile.

• Layout templates must be deployed in the composer_templates directory.

• Project templates must be deployed in the project_templates directory.

• Custom Python macros must be deployed in the python directory.
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CHAPTER 10

Utiliser les projections

A Coordinate Reference System, or CRS, is a method of associating numerical coordinates with a position on the
surface of the Earth. QGIS has support for approximately 7,000 standard CRSs, each with different use cases,
pros and cons! Choosing an appropriate reference system for your QGIS projects and data can be a complex task,
but fortunately QGIS helps guide you through this choice, and makes working with different CRSs as transparent
and accurate as possible.

10.1 Aperçu de la gestion des projections

QGIS has support for approximately 7,000 known CRSs. These standard CRSs are based on those defined by
the European Petroleum Search Group (EPSG) and the Institut Geographique National de France (IGNF), and are
made available in QGIS through the underlying « Proj » projection library. Commonly, these standard projections
are identified through use of an authority:code combination, where the authority is an organisation name such as
« EPSG » or « IGNF », and the code is a unique number associated with a specific CRS. For instance, the common
WGS 84 latitude/longitude CRS is known by the identifier EPSG:4326, and the web mapping standard CRS is
EPSG:3857.

Custom, user-created CRSs are stored in a user CRS database. See section Système de Coordonnées de Référence
personnalisé for information on managing your custom coordinate reference systems.

10.2 Layer Coordinate Reference Systems

In order to correctly project data into a specific target CRS, either your data must contain information about
its coordinate reference system or you will need to manually assign the correct CRS to the layer. For PostGIS
layers, QGIS uses the spatial reference identifier that was specified when that PostGIS layer was created. For
data supported by OGR or GDAL, QGIS relies on the presence of a recognized means of specifying the CRS.
For instance, for the Shapefile format this is a file containing the Well-Known Text (WKT) representation of the
layer’s CRS. This projection file has the same base name as the .shp file and a .prj extension. For example,
alaska.shp would have a corresponding projection file named alaska.prj.

Whenever a layer is loaded into QGIS, QGIS attempts to automatically determine the correct CRS for that layer. In
some cases this is not possible, e.g. when a layer has been provided without retaining this information. Whenever
QGIS cannot automatically determine the correct CRS for a layer, it will prompt you to manually select the CRS.
Selecting the correct choice is crucial, as a wrong choice will place your layer in the wrong position on the Earth’s
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surface! Sometimes, accompanying metadata will describe the correct CRS for a layer, in other cases you will
need to contact the original author of the data to determine the correct CRS to use.

10.3 Project Coordinate Reference Systems

Every project in QGIS also has an associated Coordinate Reference System. The project CRS determines how
data is projected from its underlying raw coordinates to the flat map rendered within your QGIS map canvas.
Behind the scenes, QGIS transparently reprojects all layers contained within your project into the project’s CRS,
so that they will all be rendered in the correct position with respect to each other!

It is important to make an appropriate choice of CRS for your QGIS projects. Choosing an inappropriate CRS can
cause your maps to look distorted, and poorly reflect the real-world relative sizes and positions of features. Usually,
while working in smaller geographic areas, there will be a number of standard CRSs used within a particular
country or administrative area. It’s important to research which CRSs are appropriate or standard choices for the
area you are mapping, and ensure that your QGIS project follows these standards.

The project CRS can be set through the CRS tab of the Project properties dialog (Project → Properties. . . ). It will
also be shown in the lower-right of the QGIS status bar.

Figure 10.1: Fenêtre Propriétés du projet

The CRS tab also has an optional setting for No projection. Checking this setting will disable ALL projection
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handling within the QGIS project, causing all layer and map coordinates to be treated as simple 2D Cartesian
coordinates, with no relation to positions on the Earth’s surface.

Whenever you select a new CRS for your QGIS project, the measurement units will automatically be changed
in the General tab of the Project properties dialog (Project → Properties. . . ) to match the selected CRS. For
instance, some CRSs define their coordinates in feet instead of meters, so setting your QGIS project to one of
these CRSs will also set your project to measure using feet by default.

10.4 CRS Settings

By default, QGIS starts each new project using a global default projection. This default CRS is EPSG:4326
(also known as « WGS 84 »), and it is a global latitude/longitude based reference system. This default CRS can be
changed via the CRS for New Projects setting in the CRS tab under Settings → Options. There is an option to
automatically set the project’s CRS to match the CRS of the first layer loaded into a new project, or alternatively
you can select a different default CRS to use for all newly created projects. This choice will be saved for use in
subsequent QGIS sessions.

Figure 10.2: The CRS tab in the QGIS Options Dialog

When you use layers that do not have a CRS, you can define how QGIS responds to these layers. This can be done
globally in the CRS tab under Settings → Options.

Les options montrées sur figure_projection_options sont :

• Demander le SCR

• Utiliser le SCR du projet

• Use a default CRS
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If you want to define the Coordinate Reference System for a certain layer without CRS information, you can also
do that in the Source tab of the raster and vector properties dialog (see Source Properties for rasters and Onglet
Source for vectors). If your layer already has a CRS defined, it will be displayed as shown in Onglet Source
de la fenêtre Propriétés de la couche vectorielle. Note that changing the CRS in this setting does not alter the
underlying data source in any way, rather it just changes how QGIS interprets the raw coordinates from the layer
in the current QGIS project only.

Astuce: SCR dans le Panneau Couches

Un clic-droit sur une couche dans la légende (section Le panneau Couches) propose deux raccourcis con-
cernant les SCR: Définir le SCR de la couche ouvre directement la fenêtre de sélection de SCR (voir fig-
ure_projection_project) et Définir le SCR du projet depuis cette couche applique le SCR de la couche au projet.

10.5 On The Fly (OTF) CRS Transformation

QGIS supports « on the fly » CRS transformation for both raster and vector data. This means that regardless of
the underlying CRS of particular map layers in your project, they will always be automatically transformed into
the common CRS defined for your project.

10.6 Sélectionneur de système de coordonnées de référence

Cette fenêtre vous permet de choisir un Système de Coordonnées de Référence pour un projet ou une couche et
propose un ensemble de systèmes de coordonnées. Cette fenêtre dispose des éléments suivants :

• Filter: If you know the EPSG code, the identifier, or the name for a Coordinate Reference System, you can
use the search feature to find it. Enter the EPSG code, the identifier or the name.

• Systèmes de coordonnées de référence récemment utilisés : Si vous utilisez certains SCR fréquemment
dans vos travaux quotidiens, ils seront affichés dans cette liste. Cliquez sur l’un d’entre eux pour sélectionner
le SCR du projet.

• Liste de tous les SCR : C’est une liste de tous les SCR gérés par QGIS, incluant les systèmes de coordon-
nées de référence géographiques, projetés et personnalisés. Pour utiliser un SCR, sélectionnez-le dans la
liste en dépliant le nœud approprié et en choisissant le système de coordonnées. Le SCR actif est présélec-
tionné.

• PROJ text: This is the CRS string used by the PROJ projection engine. This text is read-only and provided
for informational purposes.

The CRS selector also shows a rough preview of the geographic area for which a selected CRS is valid for use.
Many CRSs are designed only for use in small geographic areas, and you should not use these outside of the area
they were designed for. The preview map shades an approximate area of use whenever a CRS is selected from the
list. In addition, this preview map also shows an indicator of the current main canvas map extent.

10.7 Système de Coordonnées de Référence personnalisé

Si QGIS ne fournit pas le système de coordonnées de référence dont vous avez besoin, vous pouvez en définir un.

Pour cela, sélectionnez Projection personnalisée. . . à partir du menu Préférences. Les SCR personnalisés
sont stockés dans votre base de données utilisateur de QGIS. En plus de ceux-ci, cette base de données contient
également vos signets spatiaux et autres données personnalisées.

Defining a custom CRS in QGIS requires a good understanding of the PROJ projection library. To begin, refer to
« Cartographic Projection Procedures for the UNIX Environment - A User’s Manual » by Gerald I. Evenden, U.S.
Geological Survey Open-File Report 90-284, 1990 (available at ftp://ftp.remotesensing.org/proj/OF90-284.pdf).
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Figure 10.3: Fenêtre de SCR personnalisé

10.7. Système de Coordonnées de Référence personnalisé 83



QGIS User Guide, Version 3.4

This manual describes the use of proj and related command line utilities. The cartographic parameters used with
proj are described in the user manual and are the same as those used by QGIS.

La fenêtre Définir un système de coordonnées de référence personnalisé nécessite seulement deux paramètres pour
définir un SCR personnalisé :

1. Un nom descriptif

2. The cartographic parameters in PROJ format

Pour créer un nouveau SCR, cliquez sur le bouton Ajouter un nouveau SRC et entrez un nom descriptif et les
paramètres du SCR.

Remarquez que les Paramètres doivent débuter par un bloc +proj= pour représenter le nouveau système de
coordonnées de référence.

Vous pouvez tester vos paramètres de SCR pour voir s’ils produisent des résultats valides. Entrez des latitude et
longitude connues en WGS 84 dans les champs Nord et Est respectivement. Cliquez sur le bouton Calculer et
comparez les résultats avec les valeurs connues dans votre système de coordonnées de référence.

10.7.1 Integrate an NTv2-transformation in QGIS

To integrate an NTv2 transformation file in QGIS you need one more step:

1. Place the NTv2 file (.gsb) in the CRS/Proj folder that QGIS uses (e.g. C:\OSGeo4W64\share\proj
for windows users)

2. Add nadgrids (+nadgrids=nameofthefile.gsb) to the Proj definition in the Parameters field of
the Custom Coordinate Reference System Definition (Settings → Custom Projections. . . ).

Figure 10.4: Setting an NTv2 transformation

10.8 Datum Transformations

In QGIS, “on-the-fly” CRS transformation is enabled by default, meaning that whenever you use layers with
different coordinate systems QGIS transparently reprojects them to the project CRS. For some CRS, there are a
number of possible transforms available to reproject to the project’s CRS! QGIS optionally allows you to define a
particular transformation to use, otherwise QGIS uses a default one.

Cette personnalisation s’effectue dans le menu Préférences →‘|options| :guilabel:‘Options → SCR dans le groupe
Transformatoins géodésiques (datum) par défaut :

• en utilisant demander à choisir la transformation de datum si plusieurs sont disponibles : lorsqu’il existe
plus d’une transformation de données appropriée pour une combinaison source/destination de SCR, une
boîte de dialogue s’ouvre automatiquement invitant les utilisateurs à choisir laquelle de ces transformations
de données doit être utilisée pour le projet ;

• ou prédéfinir une liste des transformations pertinentes par défaut à utiliser lors du chargement de couche
dans des projets ou de la reprojection d’une couche.

Utilisez le bouton pour ouvrir le dialogue Sélectionner la transformation de datum. Alors :

1. Indiquez le SCR Source de la couche, en utilisant le menu déroulant ou le widget Selectionner le SCR.

2. De même, indiquez le SRC de destination.

3. En fonction des fichiers de grille de transformation (basés sur la version GDAL et PROJ installée sur
votre système), une liste des transformations disponibles de la source à la destination est construite
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dans le tableau. Cliquer sur une ligne permet d’afficher le détail des paramètres appliqués (code epsg,
précision de la transformation, nombre de stations impliquées. . . ).

Vous pouvez choisir de n’afficher que les transformations valides actuelles en cochant l’option
Masquer les obsolètes.

4. Trouvez votre transformation préférée, sélectionnez-la et cliquez sur OK.

Une nouvelle ligne est ajoutée au tableau sous SCR→ Transformations géodésiques par défaut avec
des informations sur “SCR d’origine” et “SCR de destination” ainsi que “Datum de transformation
d’origine” et “Datum de transformation de destination”.

Dès lors, QGIS utilise automatiquement la transformation de données sélectionnée pour les transformations

ultérieures entre ces deux SCRs jusqu’à ce que vous la supprimiez de la liste ou la remplaciez par
une autre.

Figure 10.5: Sélection d’une transformation de datum par défaut

Datum transformations set in the Settings → Options –> CRS tab will be inherited by all new QGIS projects
created on the system. Additionally, a particular project may have its own specific set of transformations specified
via the CRS tab of the Project properties dialog (Project → Properties. . . ). These settings apply to the current
project only.
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CHAPTER 11

Outils généraux

11.1 Aide contextuelle

Lorsque le besoin d’aide se fait sentir sur un sujet spécifique, vous pouvez accéder à l’aide contextuelle via le
bouton Aide disponible dans la plupart des fenêtres de dialogue - notez que les extensions additionnelles peuvent
pointer vers des pages web dédiées.

11.2 Panneaux

QGIS fournit par défaut de nombreux panneaux pour travailler. Quelques uns de ces panneaux sont décrits ci-
dessous, tandis que les autres peuvent être trouvés dans différentes parties du document. Une liste complète des
panneaux par défaut fournis par QGIS est disponible via le menu Vue → Panneaux →

11.2.1 Le panneau Couches

Le panneau Couches liste toutes les couches du projet et vous aide à gérer leur visibilité. Vous pouvez le montrer
ou le masquer en pressant Ctrl+1. Une couche peut être sélectionnée et glissée vers le haut ou vers le bas dans
la légende pour modifier l’ordre d’empilement des couches. Une couche se situant au sommet de la liste de cette
légende sera affichée au-dessus de celles qui se situent plus bas dans la liste.

Note: Le comportement de l’empilement de couches peut être supplanté par le panneau Ordre des couches.

En haut du panneau de couches, une barre d’outils vous permet de :

• Ouvrir le panneau de style de couche (F7): activer ou non le panneau « style de couche ».

• Ajouter un nouveau groupe

• |showPresets| Gérer la visibilité des couches: gérer la visibilité des couches et enregistrer les réglages dans différents
thèmes

• Filtrer le contenu de légende par le contenu de la carte: seules les couches qui sont visibles et dont les entités inter-
sectent le canevas de carte actuel ont leur style affiché dans le panneau des couches. Dans les autres cas, un
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symbole générique NULL est appliqué à la couche. En se basant sur la symbologie de la couche, c’est un
moyen pratique pour identifier quel type d’entité de quelles couches sont situées dans votre secteur d’intérêt.

• Filtrer la légende par une expression: vous aide à appliquer une expression pour supprimer les styles sélectionnés
de l’arbre des couches dont les entités ne remplissent pas la condition. Cela peut être utilisé par exemple
pour mettre en avant les entités situées à l’intérieur d’une surface donnée d’une autre couche. À partir du
menu contextuel, vous pouvez supprimer ou éditer l’expression appliquée.

• Étendre tout ou Réduire tout, les couches et les groupes du panneau des couches.

• Supprimer la couche/groupe sélectionné.

Figure 11.1: Barre d’outils de couches dans le panneau couches

Note: Les outils qui gèrent le panneau des couches sont également disponibles pour gérer la disposition des
objets de carte et de légende dans le composeur d’impression.

Configurer les thèmes de carte

Le menu déroulant Gérer les thèmes de carte donne accès à des raccourcis pratiques permettant de manipuler la
visibilité des couches dans le panneau Couches :

• Afficher toutes les couches

• Cacher toutes les couches

• Afficher les couches sélectionnées

• Cacher les couches sélectionnées

• Cacher les couches désélectionnées

En plus du simple contrôle de la visibilité des couches, le menu Gérer les thèmes de carte vous permet de configurer
des Thèmes de carte dans la légende et basculer d’un thème à un autre. Un thème est un instantané de la légende
courante de la carte qui contient :

• les couches définies comme visibles dans le panneau Couches

• et pour chaque couche visible:

– la référence du style appliqué à la couche

– les classes visibles du styles, c’est à dire les classes cochées dans le panneau Couches. Cela s’applique
aux symbologies autre que le rendu de symbole unique

– l’état réduit / développé du ou des classes de la couche et du ou des groupes dans lesquels il est placé

Pour créer un thème de carte:

1. Cochez la couche que vous voulez montrer

2. Configurez les propriétés de la couche (symbologie, diagrammes, étiquettes. . . )

3. Déployez le menu Style → en bas et cliquez sur Ajouter. . . pour enregistrer les paramètres comme nouveau
style embarqué dans le projet
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Note: Un thème de carte ne contient pas le détails des propriétés, uniquement la référence au nom du style
est sauvegardé, donc lorsque vous appliquez des modification à la couche pendant que le style est actif (par
exemple modifier la symbologie), le thème est mis à jour avec les nouvelles informations.

4. Répétez l’étape précédente autant de fois que nécessaire pour les autres couches

5. If applicable, expand or collapse groups or visible layer nodes in the Layers panel

6. Cliquez sur Gérer les thèmes de carte en haut du panneau, et Ajouter un thème. . .

7. Entrez le nom du thème et cliquez sur OK

Le nouveau thème est listé dans la partie basse du menu déroulant

You can create as many map themes as you need: whenever the current combination in the map legend (visible
layers, their active style, the map legend nodes) does not match any existing map theme contents as defined above,
click on Add Theme. . . to create a new map theme, or use Replace Theme → to update a map theme. Use the
Remove Current Theme button to delete the active theme.

Map themes are helpful to switch quickly between different preconfigured combinations: select a map theme in
the list to restore its combination. All configured themes are also accessible in the print layout, allowing you to
create different map items based on specific themes and independent of the current main canvas rendering (see
Map item layers).

Apercu du menu contextuel du panneau couches

Sous de la barre d’outils, le composant principal du panneau de couches est le cadre listant les couches vecteur
ou raster ajoutées au projet et, ces couches peuvent être organisée en groupes. En fonction de l’objet sélectionné
dans le panneau, un clic droit affiche un ensemble d’options dédiées et présentées ci-après.

Option Couche vecteur Couche raster Groupe

Zoomer sur la
couche / le groupe

Zoomer sur la sélec-
tion

Montrer dans
l’aperçu

Montrer le décompte des
entités

Copier la couche/le
groupe

Renommer la couche/le
groupe

Zoom to Native Res-
olution (100%)

Stretch Using Current
Extent

Mettre à jour la
couche SQL. . .

Ajouter un groupe

Dupliquer la couche
Continued on next page
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Table 11.1 – continued from previous page
Option Couche vecteur Couche raster Groupe

Supprimer la
couche/le groupe

Sortir du groupe

Déplacer au-dessus

Check and all its Parents

Group Selected

Ouvrir la table
d’attributs

Basculer en mode
édition

Éditions en cours →
Filtrer

Définir l’échelle de visi-
bilité

Zoom à l’échelle visible

Définir le SCR →

• Définir le SCR
de la couche/du
groupe

• Définir le SCR du
projet depuis cette
couche

Définir les données asso-
ciées au groupe WMS. . .

Groupe mutuelle-
ment exclusif

Cocher ainsi que ses
sous-éléments (Ctrl-
click)

Décocher ainsi que ses
sous-éléments (Ctrl-
click)

Make Permanent

Exporter →

• Enregistrer
sous. . .

Continued on next page
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Table 11.1 – continued from previous page
Option Couche vecteur Couche raster Groupe

• Sauvegarder les
entités sous. . .

• Sauvegarder les
entités sélection-
nées sous. . .

• Enregistrer dans
un Fichier de Déf-
inition de Couche
. . .

• Enregistrer comme
fichier de style
QGIS. . .

Styles →

• Copier le style

• Coller le style

• Ajouter. . .

• Renommer
l’actuel. . .

Propriétés. . .

Tableau : Menu contextuel des objets du panneau de couches

Pour les couches vectorielles GRASS Basculer en mode édition n’est pas disponible. Veuillez lire la section Numéri-
sation et édition de couche vectorielle GRASS pour plus d’informations sur l’édition de couches vectorielles
GRASS.

Interagir avec les Groupes et les Couches

Les couches peuvent être organisées en groupe. Il y a deux manières de procéder :

1. Appuyez sur l’icône pour ajouter un nouveau groupe. Renseignez un nom pour le groupe et appuyez
sur Entrée. Cliquez maintenant sur une couche existante et déplacez-là à l’intérieur du groupe.

2. Sélectionnez des couches, faites un clic droit dans la légende et choisissez Grouper la sélection. Les couches
sélectionnées seront automatiquement placées dans un nouveau groupe.
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Pour retirer une couche d’un groupe, glissez le en dehors, ou effectuez un clic droit dessus et choisir Sortir du
Groupe: la couche est déplacée au dessus du groupe. Les groupes peuvent aussi être imbriqué dans d’autres
groupes. Si une couche est placée dans un groupe imbriqué, Sortir du Groupe déplace la couche en dehors de
toute l’imbrication.

Pour déplacer un groupe ou une couche en haut du panneau de couche, soit glissez le en haut, ou choisissez
Déplacer au-dessus. Si vous utilisez cette option sur une couche incluse dans un groupe, celle-ci est déplacer au
sommet de son groupe.

La case à cocher d’un groupe permet d’afficher ou de cacher toutes les couches du groupe en un seul clic.

Activer l’option Groupe Mutuellement Exclusif vous permet de créer un groupe où une seule couche peut être
visible à un instant donné. Lorsqu’une couche du groupe est rendue visible, les autres couches ne le sont plus.

Il est possible de sélectionner plus d’une couche ou groupe en même temps en maintenant appuyé la touche Ctrl
pendant que vous sélectionnez les autres couches. Vous pouvez déplacer toutes les couches sélectionnées dans un
nouveau groupe.

Vous pouvez également supprimer plus d’une couche ou d’un groupe à la fois en les sélectionnant avec la touche
Ctrl puis en tapant sur Ctrl+D. Toutes les couches et les groupes sélectionnés seront supprimés de la légende.

Plus d’informations sur les icônes indicateurs des couches et groupes

Dans certains cas, des icônes apparaissent à côté de la couche ou groupe dans le panneau Couches pour indiquer
plus d’informations sur la couche/le groupe. Ces symboles sont:

• indique que la couche est en mode édition, les données sont modifiables

• indique que la couche contient des modifications qui ne sont pas enregistrées

• Pour indiquer qu”un filtre est appliqué à la couche. Survolez l’icône pour voir l’expression du filtre et
double cliquez pour modifier le paramétrage.

• to identify an embedded group or layer and the path to their original project file

• to remind you that the layer is a temporary scratch layer and its content will be discarded when you
close this project. To avoid data loss and make the layer permanent, click the icon to store the layer in any
of the OGR vector formats supported by QGIS.

Éditer le style des couches vecteurs

Depuis le panneau de couche, vous avez des raccourcis pour changer rapidement et facilement le rendu. Faites un
clic-droit sur une couche vecteur et sélectionnez Styles →, dans la liste pour :

• consulter les styles actuellement appliqués à la couche. Pour le cas ou vous avez défini plusieurs styles pour
cette couche, vous pouvez basculer de l’un à l’autre et la rendu de la couche sera automatiquement mis à
jour dans le canevas de carte.

• copier le style courant et, lorsque c’est possible, coller un style copié depuis une autre couche.

• renommer le style courant, ajouter un style (qui est en fait une copie du style courant) ou supprimer le style
courant (lorsque plusieurs styles sont disponibles)

Note: Les options précédentes sont aussi disponibles pour les couches rasters.

Que les entités de la couche vecteur disposent du même symbole unique ou qu’elles soient classifiées (dans ce
cas, la couche est affichée sous forme d’arbre avec chaque classe comme sous-item), les options suivantes sont
disponible au niveau de la couche ou de la classe:
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• Editer le symbole. . . pour ouvrir le The Symbol Selector pour modifier n’importe quelle propriété de la
couche ou du symbole d’entité (symbole, taille, couleur. . . ) Double-cliquer sur une classe ouvre également
le Sélecteur de symbole

• sélecteur de couleur avec une roue de couleur depuis laquelle vous pouvez cliquer sur une couleur pour
mettre à jour automatiquement la couleur de remplissage du symbole. Par commodités, les couleurs ré-
centes sont disponibles en base de la roue de couleur.

• Afficher tous les items et Masquer tous les items pour activer ou désactiver la visibilité de toutes les
classes d’entités. Cela évite de (dé)cocher tous les items un par un.

Astuce: Partager rapidement un style de couche

Depuis le menu contextuel, copiez un style d’une couche et collez le dans un groupe ou sur une sélection de
couches : le style est appliqué à toutes les couches qui ont le même type (vecteur ou raster) comme la couche
d’origine et, dans le cas de vecteur, le même type de géométrie (point, ligne ou polygone).

11.2.2 Panneau de style de couche

The Layer Styling panel (also enabled with Ctrl+3) is a shortcut to some of the functionalities of the Layer
Properties dialog. It provides a quick and easy way to define the rendering and the behavior of a layer, and to
visualize its effects without having to open the layer properties dialog.

In addition to avoiding the blocking (or « modal ») layer properties dialog, the layer styling panel also avoids
cluttering the screen with dialogs, and contains most style functions (color selector, effects properties, rule edit,
label substitution. . . ): e.g., clicking color buttons inside the layer style panel causes the color selector dialog to be
opened inside the layer style panel itself rather than as a separate dialog.

From a drop-down list of current layers in the layer panel, select an item and:

• Set raster layer Symbology, Transparency, and Histogram properties. These options are the
same as those in the Fenêtre Propriétés de la couche raster.

• Set vector layer Symbology, 3D View and Labels properties. These options are the same as
those in the Fenêtre Propriétés d’une couche vecteur.

• Manage the associated style(s) in the Style Manager (more details at Gestion des styles personnalisés).

• See the History of changes you applied to the layer style in the current project: you can therefore cancel
or restore to any state by selecting it in the list and clicking Apply.

Another powerful feature of this panel is the Live update checkbox. Tick it to render your changes immediately
on the map canvas: you no longer need to click the Apply button.

Astuce: Add custom tabs to the Layer Styling panel

Using PyQGIS, you can set new tabs to manage layer properties in the Layer Styling Panel. See https://nathanw.
net/2016/06/29/qgis-style-dock-part-2-plugin-panels/ for an example.

11.2.3 Layer Order Panel

By default, layers shown on the QGIS map canvas are drawn following their order in the Layers panel: the higher
a layer is in the panel, the higher (hence, more visible) it’ll be in the map view.

You can define a drawing order for the layers independent of the order in the layers panel with the Layer Order

panel enabled in View → Panels → menu or with Ctrl+9. Check Control rendering order underneath the
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Figure 11.2: Defining a layer’s symbology from the layer styling panel
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list of layers and reorganize the layers in the panel as you want. This order becomes the one applied to the map
canvas. For example, in figure_layer_order, you can see that the airports features are displayed over the
alaska polygon despite those layers” respective placement in the Layers panel.

Unchecking Control rendering order will revert to default behavior.

Figure 11.3: Define a layer order independent of the legend

11.2.4 Overview Panel

The Overview panel (Ctrl+8) displays a map with a full extent view of some of the layers. The Overview map is
filled with layers using the Show in Overview option from the Layer menu or in the layer contextual menu. Within
the view, a red rectangle shows the current map canvas extent, helping you quickly to determine which area of
the whole map you are currently viewing. If you click-and-drag the red rectangle in the overview frame, the main
map view extent will update accordingly.

Note that labels are not rendered to the map overview even if the layers used in the map overview have been set
up for labeling.

11.2.5 Gestion des logs

When loading or processing some operations, you can track and follow messages that appear in different tabs

using the Log Messages Panel. It can be activated using the most right icon in the bottom status bar.

11.2.6 Panneau Annuler/Refaire

For each layer being edited, the Undo/Redo (Ctrl+5) panel shows the list of actions carried out, allowing you
quickly to undo a set of actions by selecting the action listed above. More details at Undo and Redo edits.
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11.2.7 Panneau de résumé statistiques

The Statistics panel (Ctrl+6) provides summarized information on any vector layer. This panel allows you to
select:

• the vector layer to compute the statistics on

• the column to use, or an expression

• the statistics to return using the drop-down button at the bottom-right of the dialog. Depending on the field’s
(or expression’s values) type, available statistics are:

Statistiques Caractère Entier Flottant Date

Compte

Compte (distinct)

Compte (manquant)

Somme

Moyenne

Écart-type

Standard Deviation on Sample

Valeur minimale

Valeur maximale

Plage

Minorité

Majorité

Variété

Premier quartile

Troisième quartile

Plage inter-quartile

Longueur minimale

Longueur maximale

Tableau : statistique disponible pour chaque champ

The statistical summary can be:

• returned for the whole layer or selected features only

• recalculated using the button when the underlying data source changes (eg, new or removed fea-
tures/fields, attribute modification)

• copied to the clipboard and pasted as a table in another application

11.3 Inclusion de projets

Sometimes, you’d like to keep some layers in different projects, but with the same style. You can either create a
default style for these layers or embed them from another project to save time and effort.

Intégrer les couches et les groupes depuis un projet existant présente des avantages par rapport à la mise en forme
:
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Figure 11.4: Montrer les statistiques dans le champs
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• Tous types de couches (vecteur, raster, couches locales ou en ligne. . . ) peuvent être ajoutés

• En allant chercher des groupes et des couches, il est possible de conserver la même arborescence des couches
utilisées en « arrière-plan » dans vos différents projets

• Bien que les couches intégrées soient éditables, il n’est pas possible de modifier leurs propriétés, telles que
leur symbologie, formes, étiquettes, valeurs par défaut et actions associées, afin d’assurer la cohérence à
travers tous les projets

• Les modifications des éléments dans le projet originale sont propagées à tous les autres projets

Pour intégrer du contenu d’autres fichiers de projet dans le projet courant, sélectionner :menuselection: “Couche
–> Intégrer des couches et des groupes. . . ”:

1. Click the . . . button to look for a project: you can see the content of the project (see figure_embed_dialog)

2. Hold down Ctrl ( or Cmd) and click on the layers and groups you wish to retrieve

3. Click OK

The selected layers and groups are embedded in the Layers panel and displayed on the map canvas. An icon
is added next to their name for recognition and hovering over displays a tooltip with the original project file path.

Figure 11.5: Sélectionner les couches et les groupes à intégrer.

Like any other layer, an embedded layer can be removed from the project by right-clicking on the layer and

clicking Remove.

Astuce: Change rendering of an embedded layer

It’s not possible to change the rendering of an embedded layer, unless you make the changes in the original project
file. However, right-clicking on a layer and selecting Duplicate creates a layer which is fully-featured and not
dependent on the original project. You can then safely remove the linked layer.

11.4 Working with the map canvas

11.4.1 Rendu

Par défaut, QGIS effectue le rendu de toutes les couches visibles à chaque fois que l’affichage de la carte est mis
à jour. Les évènements qui déclenchent ce rafraîchissement incluent :

• adding a layer

• panning or zooming

• resizing the QGIS window

• changing the visibility of a layer or layers

QGIS vous laisse contrôler le processus de rendu de plusieurs manières.
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Rendu dépendant de l’échelle

Scale-dependent rendering allows you to specify the minimum and maximum scales at which a layer (raster or
vector) will be visible. To set scale-dependent rendering, open the Properties dialog by double-clicking on the

layer in the legend. On the Rendering tab, tick Scale dependent visibility and enter the Minimum (exclusive)
and Maximum (inclusive) scale values.

You can also activate scale dependent visibility on a layer from the Layers panel. Right-click on the layer and in
the context menu, select Set Layer Scale Visibility.

The Set to current canvas scale button allow you to use the current map canvas scale as boundary of the range visibil-
ity.

Note: When a layer is not rendered in the map canvas because the map scale is out of its visibility scale range,
the layer is greyed in the Layers panel and a new option Zoom to Visible Scale appears in the layer context menu.
Select it and the map is zoomed to the layer’s nearest visibility scale.

Contrôler le rendu

Le rendu de la carte peut être contrôlé de différentes manières, décrites ci-dessous.

Suspendre le rendu

To suspend rendering, click the Render checkbox in the bottom-right corner of the status bar. When Render
is not checked, QGIS does not redraw the canvas in response to any of the events described in the section Rendu.
Examples of when you might want to suspend rendering include:

• adding many layers and symbolizing them prior to drawing

• adding one or more large layers and setting scale dependency before drawing

• adding one or more large layers and zooming to a specific view before drawing

• any combination of the above

Cocher la case Rendu activera de nouveau le rendu et provoquera un rafraîchissement immédiat de la carte.

Définir les options d’ajout de couche

You can set an option to always load new layers without drawing them. This means the layer will be added to the
map, but its visibility checkbox in the legend will be unchecked by default. To set this option, choose menu option

Settings → Options and click on the Rendering tab. Uncheck By default new layers added to the map should
be displayed. Any layer subsequently added to the map will be off (invisible) by default.

Arrêter le rendu

To stop the map drawing, press the Esc key. This will halt the refresh of the map canvas and leave the map
partially drawn. It may take a bit of time between pressing Esc for the map drawing to halt.

Note: Il n’est maintenant plus possible d’arrêter le rendu — cela a été désactivé dans Qt4 à cause de problèmes
et de crashes dans l’interface utilisateur (IHM).
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Influencer la qualité du rendu

QGIS dispose d’une option qui permet d’influencer la qualité du rendu de la carte. Dans le menu Préférences →
Options puis l’onglet Rendu, sélectionnez ou désélectionnez la case Les lignes semblent moins déchiquetées
aux dépends d’une certaine vitesse d’exécution.

Accéler le rendu

Il y a plusieurs manières d’améliorer la rapidité du rendu de la carte. Dans le menu Préférences → Options puis
onglet Rendu, sélectionnez ou désélectionnez les cases suivantes :

• Use render caching where possible to speed up redraws.

• Rendu des couches en parallèle en utilisant plusieurs cœurs du processeur puis définissez le Nombre
de cœurs à utiliser.

• Le rendu cartographique est calculé en arrière-plan sur une image distincte et chaque Intervalle de
rafraîchissement de l’affichage de la carte, le contenu (hors écran) est pris pour mettre à jour la représenta-
tion visible. Si le rendu se termine plus rapidement que cette durée, il sera affiché instantanément.

• With Enable Feature simplification by default for newly added layers, you simplify features” geometry
(fewer nodes) and as a result, they display more quickly. Be aware that this can cause rendering inconsis-
tencies.

11.4.2 Zoomer et se déplacer

QGIS fournit des outils pour zoomer et se déplacer vers une zone d’intérêt.

Apart from using the pan and zoom-in/ zoom-out icons on the toolbar with the mouse, you can also navigate
with the mouse wheel, spacebar and arrow keys. A Zoom factor can be set under the Settings → Options →
Map tools menu to define the scale behavior while zooming.

Avec la molette de la souris

You can press the mouse wheel to pan inside of the main window (on macOS, you may need to hold down the
cmd key). You can roll the mouse wheel to zoom in and out on the map; the mouse cursor position will be the
center of the zoomed area of interest. Holding down Ctrl while rolling the mouse wheel results in a finer zoom.

Avec les flèches du clavier

Panning the map is possible with the arrow keys. Place the mouse cursor inside the map area, and click on the
arrow keys to pan up, down, left and right.

You can also use the space bar to cause mouse movements temporarily to pan the map. The PgUp and PgDown
keys on your keyboard will cause the map display to zoom in or out following the zoom factor set. Pressing
Ctrl++ or Ctrl+- also performs an immediate zoom in/out on the map canvas.

When certain map tools are active (Identify, Measure. . . ), you can perform a zoom by holding down Shift and
dragging a rectangle on the map to zoom to that area. This is not enabled for selection tools (since they use Shift
for adding to selection) or edit tools.
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11.4.3 Signets spatiaux

Spatial Bookmarks allow you to « bookmark » a geographic location and return to it later. By default, bookmarks
are saved on the computer, meaning that they are available from any project in the same computer. If you wish to
store the bookmark in the project file (.qgs) then you can do this by selecting the In Project checkbox.

Créer un signet

Pour créer un signet :

1. Déplacez-vous sur la zone concernée.

2. Select the menu option View → New Bookmark or press Ctrl+B. The Spatial Bookmarks panel opens with
the newly created bookmark.

3. Entrez un nom pour décrire le signet (jusqu’à 255 caractères).

4. Check the In Project box if you wish to save the bookmark in the project file.

5. Appuyez sur Enter pour ajouter le signet ou cliquer ailleurs.

Notez que vous pouvez avoir plusieurs signets portant le même nom.

Travailler avec les signets

To use or manage bookmarks, select View → Show Bookmarks or press Ctrl+7. The Spatial Bookmarks panel
allows you to:

• Zoom sur un signet: sélectionnez le signet souhaité, puis cliquez sur Zoomer jusqu’au signet. Vous pouvez
également zoomer sur un signet en double-cliquant dessus.

• Supprimer un signet: sélectionnez le signet et cliquez sur Effacer le signet. Confirmez votre choix.

• Import or Export a bookmark: To share or transfer your bookmarks between computers you can use the
Import/Export Bookmarks drop-down menu to export all bookmarks to an .xml file or import bookmarks
from such a file.

You can also zoom to saved bookmarks by typing the bookmark name in the locator.

11.4.4 Décorations

Decorations include Grid, Copyright Label, North Arrow, Scale Bar and Layout Extents. They are used to “deco-
rate” the map by adding cartographic elements.

Grille

Grille vous permet d’ajouter un graticule et des coordonnées à la carte.

1. Select View → Decorations → Grid to open the dialog.

2. Tick Enable grid and set grid definitions according to the layers loaded in the map canvas.

3. Tick Draw annotations and set annotation definitions according to the layers loaded in the map canvas.

4. Click Apply to verify that it looks as expected or OK if you’re satisfied.
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Figure 11.6: La fenêtre Grille

Étiquette de Copyright

Copyright label adds a copyright label to the map using your choice of text.

1. Select View → Decorations → Copyright Label to open the dialog

Figure 11.7: La fenêtre de Copyright

2. Make sure Enable Copyright Label is checked.

3. Enter the text you want to place on the map. You can include expressions (using the Insert an Expression
button).

4. Choose the font for the label from the Font combo box. Set the font color and opacity by clicking the
black arrow to the right of the font combo box.

5. Choisissez l’emplacement de l’étiquette dans la liste déroulante Position .

6. Refine the placement of the item by setting a horizontal and/or vertical Margin from Edge. These values can
be in Millimeters or Pixels or set as a Percentage of the width or height of the map canvas.

7. You can change the color to apply

8. Click Apply to verify that it looks as expected or OK if you’re satisfied.

In the example above, which is the default, QGIS places a copyright symbol followed by the date in the bottom-
right corner of the map canvas.
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Flèche du nord

North Arrow adds a north arrow on the map canvas, with options for style and placement.

To add a north arrow:

1. Select View → Decorations → North Arrow to open the dialog.

Figure 11.8: La fenêtre de flèche du nord

2. Make sure Enable north arrow is checked

3. Optionally change the color and size, or choose a custom SVG.

4. Optionally change the angle or choose Automatic to let QGIS determine the direction

5. Optionally choose the placement from the Placement combo box

6. Optionally refine the placement of the arrow by setting a horizontal and/or vertical Margin from (Canvas)
Edge. These values can be in Millimeters or Pixels or set as a Percentage of the width or height of the map
canvas.

7. Click Apply to verify that it looks as expected and OK if you’re satisfied.

Échelle graphique

Échelle graphique ajoute une simple barre d’échelle sur la carte. Vous choisissez le style, l’emplacement ainsi que
les étiquettes de la barre.

QGIS only supports displaying the scale in the same units as your map frame. So, if the units of your project’s
CRS are meters, you can’t create a scale bar in feet. Likewise, if you are using decimal degrees, you can’t create
a scale bar to display distance in meters.

Pour ajouter une échelle graphique :

1. Select View → Decorations → Scale Bar to open the dialog

2. Make sure Enable scale bar is checked

3. Choose a style from the Scale bar style combo box

4. Select the Color of bar by choosing a fill color (default: black) and an outline color
(default: white). The scale bar fill and outline can be made opaque by clicking on the down arrow to the
right of the color input.
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Figure 11.9: La fenêtre de barre d’échelle

5. Select the font for the scale bar from the Font of bar combo box

6. Set the Size of bar

7. Optionally check Automatically snap to round number on resize to display easy-to-read values

8. Choose the placement from the Placement combo box

9. You can refine the placement of the item by setting a horizontal and/or vertical Margin from (Canvas) Edge.
These values can be in Millimeters or Pixels or set as a Percentage of the width or height of the map
canvas.

10. Click Apply to verify that it looks as expected or OK if you’re satisfied.

Layout Extents

Layout Extents adds the extents of map item(s) in print layout(s) to the canvas. When enabled, the extents of all
map items within all print layouts are shown using a lightly dotted border labeled with the name of the print layout
and map item. You can control the style and labeling of the displayed layout extents. This decoration is useful
when you are tweaking the positioning of map elements such as labels, and need to know the actual visible region
of print layouts.

To add layout extent(s):

1. Select View → Decorations → Layout Extents to open the dialog

2. Make sure Show layout extents is checked

3. Optionally change the symbol and labeling of the extents

4. Click Apply to verify that it looks as expected and OK if you’re satisfied

Astuce: Decorations Settings

When you save a QGIS project file, any changes you have made to Grid, North Arrow, Scale Bar, Copyright and
Layout Extents will be saved in the project and restored the next time you load the project.
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Figure 11.10: Example of layout extents displayed in a QGIS project with two print layouts. The print layout
named “Sights” contains two map items, while the other print layout contains one map item.

Figure 11.11: The Layout Extents Dialog
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11.4.5 Outils d’annotation

Annotations are information added to the map canvas and shown within a balloon. This information can be of
different types and annotations are added using the corresponding tools in the Attributes Toolbar:

• Text Annotation for custom formatted text

• HTML Annotation to place the content of an html file

• SVG Annotation to add an SVG symbol

• Form Annotation: useful to display attributes of a vector layer in a customized ui file (see fig-
ure_custom_annotation). This is similar to the custom attribute forms, but displayed in an annotation item.
Also see this video https://youtu.be/0pDBuSbQ02o?t=2m25s from Tim Sutton for more information.

Figure 11.12: Customized QT Designer annotation form

To add an annotation, select the corresponding tool and click on the map canvas. An empty balloon is added.
Double-click on it and a dialog opens with various options. This dialog is almost the same for all the annotation
types:

• At the top, a file selector to fill with the path to an html, svg or ui file depending on the type of annotation.
For text annotation, you can enter your message in a text box and set its rendering with the normal font tools.

• Fixed map position: when unchecked, the balloon placement is based on a screen position (instead of
the map), meaning that it’s always shown regardless the map canvas extent.

• Linked layer: associates the annotation with a map layer, making it visible only when that layer is visible.

• Map marker: using QGIS symbols, sets the symbol to display at the balloon anchor position (shown only
when Fixed map position is checked).

• Frame style: sets the frame background color, transparency, stroke color or width of the balloon using QGIS
symbols.

• Contents margins: sets interior margins of the annotation frame.

Annotations can be selected when an annotation tool is enabled. They can then be moved by map position (by

dragging the map marker) or by moving only the balloon. The Move Annotation tool also allows you to move the
balloon on the map canvas.
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Figure 11.13: La fenêtre d’annotation de texte

To delete an annotation, select it and either press the Del or Backspace button, or double-click it and press the
Delete button in the properties dialog.

Note: If you press Ctrl+T while an Annotation tool (move annotation, text annotation, form annotation) is
active, the visibility states of the items are inverted.

Astuce: Layout the map with annotations

You can print or export annotations with your map to various formats using:

• map canvas export tools available in the Project menu

• print layout, in which case you need to check Draw map canvas items in the corresponding map item
properties

11.4.6 Mesurer

Information générale

QGIS propose quatre moyens de mesurer des géométries :

• interactive measurement tools

• measuring in the Field Calculator

• derived measurements in the Identifying Features tool

• the vector analysis tool: Vector → Geometry Tools → Export/Add Geometry Columns

Les mesures fonctionnent pour les systèmes de coordonnées projetés (par ex. UTM) et non projetés. Les trois
premiers outils de mesure utilisent les mêmes options, globales au projet :

• Unlike most other GIS, the default measurement metric is ellipsoidal, using the ellipsoid defined in Project
→ Properties. . . → General. This is true both when geographic and projected coordinate systems are
defined for the project.
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• If you want to calculate the projected/planimetric area or distance using cartesian maths, the measurement
ellipsoid has to be set to « None/Planimetric » (Project → Properties. . . → CRS). However, with a ge-
ographic (ie unprojected) CRS defined for the data and project, area and distance measurement will be
ellipsoidal.

However, neither the identify tool nor the field calculator will transform your data to the project CRS before
measuring. If you want to achieve this, you have to use the vector analysis tool: Vector → Geometry Tools → Add
Geometry Attributes. . . . Here, measurement is planimetric, unless you choose the ellipsoidal measurement.

Measure length, areas and angles interactively

Click the icon in the Attribute toolbar to begin measurements. The down arrow near the icon switches between

length, area or angle. The default unit used in the dialog is the one set in Project → Properties. . . →
General menu.

Note: Configuring the measure tool

While measuring length or area, clicking the Configuration button at the bottom of the widget opens the Settings
→ Options → Map Tools menu, where you can select the rubberband color, the precision of the measurements
and the unit behavior. You can also choose your preferred measurement or angle units, but keep in mind that those
values are overridden in the current project by the selection made in the Project → Properties. . . → General
menu, and by the selection made in the measurement widget.

All measuring modules use the snapping settings from the digitizing module (see section Définir le rayon de
tolérance d’accrochage et de recherche). So, if you want to measure exactly along a line feature, or around a
polygon feature, first set its layer snapping tolerance. Now, when using the measuring tools, each mouse click
(within the tolerance setting) will snap to that layer.

By default, Measure Line measures real distances between given points according to a defined ellipsoid. The tool
then allows you to click points on the map. Each segment length, as well as the total, shows up in the measure
window. To stop measuring, click the right mouse button.

Note that you can use the drop-down list near the total to change the measurement units interactively while work-
ing with the measure tool (“Meters”, “Kilometers”, “Feet”, “Yards”, “Miles”, “Nautical miles”, “Centimeters”,
“Millimeters”, “Degrees”, “Map units”). This unit is retained for the widget until a new project is created or
another project is opened.

The Info section in the dialog explains how calculations are made according to the CRS settings available.

Figure 11.14: Mesure de distance

Measure Area: Areas can also be measured. In the measure window, the accumulated area size appears. Right-
click to stop drawing. The Info section is also available as well as the ability to switch between different area
units (“Square meters”, “Square kilometers”, “Square feet”, “Square yards”, “Square miles”, “Hectares”, “Acres”,
“Square centimeters”, “Square millimeters”, “Square nautical miles”, “Square degrees”, “Map units”).
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Figure 11.15: Mesure d’une aire

Measure Angle: You can also measure angles. The cursor becomes cross-shaped. Click to draw the first segment
of the angle you wish to measure, then move the cursor to draw the desired angle. The measurement is displayed
in a pop-up dialog.

Figure 11.16: Mesure d’un angle

11.5 Interacting with features

11.5.1 Sélectionner des entités

QGIS provides several tools to select features on the map canvas. Selection tools are available in the View →
Select menu or in the Attributes toolbar.

Note: Selection tools work with the currently active layer.

Selecting manually on the map canvas

To select one or more features with the mouse, you can use one of the following tools:

• Select Features by area or single click

• Sélection d’entités avec un polygone

• Sélection d’entités à main levée

• Sélection d’entités selon un rayon

Note: Other than Select Features by Polygon, these manual selection tools allow you to select feature(s) on the map
canvas with a single click.

Note: Use the Select Features by Polygon tool to use an existing polygon to select overlapping features. Right-click
in the polygon and choose it from the context menu that shows a list of all the polygons that contain the clicked
point. All the overlapping features from the active layer are selected.
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While using the Select Feature(s) tool, holding Shift or Ctrl toggles whether a feature is selected (ie either
adds to the current selection or remove from it).

For the other tools, different behaviors can be performed by holding down:

• Shift: add features to the current selection

• Ctrl: substract features from the current selection

• Ctrl+Shift: intersect with current selection, ie only keep overlapping features from the current selection

• Alt: select features that are totally within the selection shape. Combined with Shift or Ctrl keys, you
can add or substract features to/from the current selection.

Automatic selection

The other selection tools, also available from the Attribute table, perform a selection based on a feature’s attribute
or its selection state (note that attribute table and map canvas show the same information, so if you select one
feature in the attribute table, it will be selected on the map canvas too):

• Select By Expression. . . select features using expression dialog

• Sélectionner des entités par valeur. . . ou tapez F3

• Deselect Features from All Layers or press Ctrl+Shift+A to deselect all selected features in all layers

• Select All Features or press Ctrl+A to select all features in the current layer

• Invert Feature Selection to invert the selection in the current layer

For example, if you want to find regions that are boroughs from regions.shp of the QGIS sample data, you

can use the Select features using an Expression icon. Then, expand the Fields and Values group and choose the field that
you want to query. Double-click the field “TYPE_2” and also click All Unique in the panel that shows up. From
the list, choose and double-click “Borough”. In the Expression field, write the following query:

"TYPE_2" = 'Borough'

From the expression builder dialog, you can also use Function list → Recent (Selection) to make a selection that
you have used before. The dialog remembers the last 20 expressions used. See Expressions for more information
and examples.

Astuce: Save your selection into a new file

Users can save selected features into a New Temporary Scratch Layer or a New Vector Layer using Edit →
Copy Features and Edit → Paste Features as in the desired format.

Sélectionner des Entités par Valeur

This selection tool opens the layer’s feature form allowing the user to choose which value to look for for each
field, whether the search should be case-sensitive, and the operation that should be used. The tool has also
autocompletes, automatically filling the search box with existing values.

Alongside each field, there is a drop-down list with options to control the search behaviour:
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Figure 11.17: Filter/Select features using form dialog

Field search option Caractère Numeric Date

Exclude Field from the search

Égal à (=)

Not equal to ()

Supérieur à (>)

Inférieur à (<)

Greater than or equal to ()

Less than or equal to ()

Entre (inclusif)

Not between (inclusive)

Contient

Ne contient pas

Est manquant (null)

N’est pas manquant (non nul)

Starts with

Ends with

For string comparisons, it is also possible to use the Case sensitive option.

After setting all search options, click Select features to select the matching features. The drop-down options are:

• Select features

• Ajouter à la sélection actuelle
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• Filtrer la sélection courante

• Supprimer de la sélection actuelle

You can also clear all search options using the Reset form button.

Once the conditions are set, you can also either:

• Zoom to features on the map canvas without the need of a preselection

• Flash features, highlighting the matching features. This is a handy way to identify a feature without selec-
tion or using the Identify tool. Note that the flash does not alter the map canvas extent and would be visible
only if the feature is within the bounds of the current map canvas.

11.5.2 Identifying Features

L’outil Identifier vous permet d’interagir avec le canevas de la carte et d’afficher des informations sur les entités
dans un menu contextuel. Pour identifier des entités, vous pouvez :

• View → Identify Features

• Ctrl+Shift+I (or Cmd+Shift+I),

• Identify Features icon on the Attributes toolbar

Utiliser l’outil Identifier

QGIS offers several ways to identify features with the Identify Features tool:

• left click identifies features according to the selection mode and the selection mask set in the Identify Results
panel

• right click with Identify Feature(s) as selection mode set in the Identify Results panel fetches all snapped
features from all visible layers. This opens a context menu, allowing the user to choose more precisely the
features to identify or the action to execute on them.

• right click with Identify Features by Polygon as selection mode in the Identify Results panel identifies the
features that overlap with the chosen existing polygon, according to the selection mask set in the Identify
Results panel

Astuce: Choisir les couches à interroger avec l’outil Identifier

Under Layer Capabilities in Project → Properties. . . → Data Sources, uncheck the Identifiable column next to a

layer to avoid it being queried when using the Identify Features tool in a mode other than Current Layer. This is
a handy way to return features from only layers that are of interest for you.

If you click on feature(s), the Identify Results dialog will list information about the feature(s) clicked. The default
view is a tree view in which the first item is the name of the layer and its children are its identified feature(s). Each
feature is described by the name of a field along with its value. This field is the one set in Layer Properties →
Display. All the other information about the feature follows.

Feature information

The Identify Results dialog can be customized to display custom fields, but by default it will display the following
information:

• The feature display name;
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• Actions : Elles sont ajoutées à la fenêtre « Identifier les résultats ». L’action se lance par un clic. Par défaut,
une seule action est présente,‘‘Afficher le formulaire de l’entité‘‘. Vous pouvez ajouter d’autres actions à
partir de l’onglet des propriétés de la couche (voir Propriétés des Actions).

• Derived: This information is calculated or derived from other information. It includes:

– general information about the feature’s geometry:

* depending on the geometry type, the cartesian measurements of length, perimeter or area in the
layer’s CRS units

* depending on the geometry type and if an ellipsoid is set in the project properties dialog for
Measurements, the ellipsoidal values of length, perimeter or area using the specified units

* the count of geometry parts in the feature and the number of the part clicked

* the count of vertices in the feature

– coordinate information, using the project properties Coordinates display settings:

* X and Y coordinate values of the point clicked

* the number of the closest vertex to the point clicked

* X and Y coordinate values of the closest vertex (and Z`/`M if applicable)

* if you click on a curved segment, the radius of that section is also displayed.

• Attributs de données: Il s’agit de la liste des champs et des valeurs de l’entité sur laquelle vous avez cliqué.

Note: Links in the feature’s attributes are clickable from the Identify Results panel and will open in your default
web browser.

Figure 11.18: Panneau des résultats de l’identification

Le panneau des résultats de l’identification

At the top of the window, you have a handful of tools:

• Open Form of the current feature

• Déplier

• Replier

• Expand New Results by Default to define whether the next identified feature’s information should be collapsed
or expanded
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• Effacer les résultats

• Copier les entités sélectionnées dans le presse papier

• Imprimer la réponse HTML sélectionnée

• selection mode to use to fetch features to identify:

– Identify Features by area or single click

– Identify Features by Polygon

– Identify Features by Freehand

– Identify Features by Radius

Note: When using Identify Features by Polygon, you can right-click any existing polygon and use it to identify
overlapping features in another layer.

At the bottom of the window are the Mode and View comboboxes. Mode defines from which layers features should
be identified:

• Current layer: only features from the selected layer are identified. The layer need not be visible in the
canvas.

• Top down, stop at first: only features from the upper visible layer.

• Top down: all features from the visible layers. The results are shown in the panel.

• Layer selection: opens a context menu where the user selects the layer to identify features from, similar to
a right-click. Only the chosen features will be shown in the result panel.

The View can be set as Tree, Table or Graph. “Table” and “Graph” views can only be set for raster layers.

The identify tool allows you to Auto open form. If checked, each time a single feature is identified, a form
opens showing its attributes. This is a handy way to quickly edit a feature’s attributes.

D’autres fonctions peuvent être trouvées dans le menu contextuel d’un élément identifié, via un clic droit. Par
exemple, depuis le menu contextuel, vous pouvez :

• Voir le formulaire d’entité

• Zoomer sur l’entité

• Copier l’entité : copie toute la géométrie et les attributs d’une entité

• Toggle feature selection: Add identified feature to selection

• Copier les valeurs d’attributs : copie uniquement les valeurs d’attributs de l’entité identifiée

• Copier les attributs de l’entité: Copie les attributs de l’entité

• Lâcher les résultats : la fenêtre de résultats est vidée

• Masquer la surbrillance : la surbrillance des entités identifiées sur la carte est retirée

• Tout mettre en surbrillance

• Mettre la couche en surbrillance

• Activer une couche : Choisir la couche à activer

• Propriétés : ouvre la fenêtre des propriétés de la couche

• Tout déplier

• Tout replier
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11.6 Sauvegarder et Partager les propriétés d’une couche

11.6.1 Gestion des styles personnalisés

Lorsqu’une couche est ajoutée au canevas de carte, QGIS utilise un symbole/couleur aléatoire pour le rendu de ses
entités. Vous pouvez néanmoins paramétrer un symbole par défaut dans menuselection:Projet –> Propriétés –>
Styles par défaut qui sera appliqué à chaque nouvel ajout de couche selon le type géométrique de cette dernière.

Cependant, la plupart du temps, vous voudrez disposer d’un style plus complexe et plus personnalisé qui pourra
être appliqué automatiquement ou manuellement (mais avec moins d’effort). Vous pouvez y parvenir en utilisant
la liste déroulante Style située en bas de la boîte de dialogue des Propriétés de la couche. Cette liste déroulante
vous permet de créer, de charger et de gérer les styles.

Un style enregistre toute information renseignée dans la boîte de dialogue des propriétés de la couche pour ef-
fectuer le rendu ou l’interaction avec la couche (comprenant les paramètres de la symbologie, de l’étiquetage,
des formulaires, des actions, des diagrammes,etc.) pour les couches vectorielles, ou les pixels (bande et rendu de
couleurs, opacité, pyramides, histogrammes. . . ) pour les rasters.

Figure 11.19: Options de la liste déroulante de style.

Par défaut, le style appliqué à la couche chargée est nommé défaut. Une fois que vous avez paramétré le rendu

idéal pour votre couche, vous pouvez l’enregistrer en cliquant sur la liste déroulante Style et en choisissant
:

• Renomme l’actuel : Le style actif sera renommé et mis à jour avec les options courantes.

• Ajouter: Un nouveau style sera créé avec les options courantes. Par défaut, il sera sauvegardé dans le fichier
projet QGIS. Voir ci-dessous pour sauvegarder le style dans un autre fichier ou une base de données

• Supprimer l’actuel: Si vous avez plus d’un style pour la couche, vous pouvez supprimer actuel.

En bas de la liste déroulante Style, vous pouvez voir les styles définis pour la couche. Celui qui est actif est coché.

Notez que chaque fois que vous validez la boîte de dialogue des propriétés de la couche, le style activé est mis à
jour avec les changements que vous avez faits.

Vous pouvez créer autant de styles que vous voulez pour une couche donnée mais vous ne pouvez en activer qu’un
seul à la fois. Combiné avec les Thèmes de la carte, Ceci offre un moyen rapide et puissant de gérer des projets
complexes sans qu’il soit nécessaire de dupliquer aucune couche dans la légende de la carte.
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Note: Étant donné que chaque fois que vous appliquez des modifications aux propriétés de la couche, les modi-
fications sont stockées dans le style actif, assurez-vous toujours que vous modifiez le style correct pour éviter de
modifier par erreur un style utilisé dans un :ref:‘thème de la carte ‘.

Astuce: Gérer les styles depuis le menu contextuel d’une couche

Faire un clic-droit sur une couche dans le Panneau des couches pour ajouter, renommer ou supprimer un style de
couche.

11.6.2 Enregistrer un style dans un fichier ou une base de données

Alors que les styles créés à partir de la liste déroulante Style sont enregistrés par défaut dans le projet et peuvent
être copiés collés de couche en couche dans le projet, il est également possible de les enregistrer hors projet pour
qu’ils puissent être chargés dans un autre projet.

Enregistrer dans un fichier

En cliquant sur le bouton Style → Enregistrer le style, vous pouvez enregistrer le style comme :

• Fichier de style de couche QGIS (*.qml)

• fichier de style SLD (.sld), uniquement pour les couches vectorielles

Utilisé sur les couches de format de fichier (.shp, .tab. . . ), Enregistrer par défaut génère un fichier .qml pour
la couche (avec le même nom). Les SLD peuvent être exportés à partir de n’importe quel type de moteur de rendu
– symbole unique, catégorisé, gradué ou basé sur des règles – mais lorsqu’on importe un SLD, un seul symbole ou
un moteur de rendu basé sur des règles est créé. Cela signifie que les styles catégorisés ou gradués sont convertis
en styles basés sur des règles. Si vous voulez préserver ces rendus, vous devez utiliser le format QML. D’un autre
côté, il peut être parfois très pratique de convertir ainsi les styles en règles.

Enregistrer en base de données

Les styles de couches vectorielles peuvent également être stockés dans une base de données si la source de
données de la couche est une de base de données. Les formats supportés sont PostGIS, GeoPackage, SpatiaLite,
MSSQL et Oracle. Le style de couche est sauvegardé dans une table (nommée layer_styles') de la
base de données. Cliquez sur :menuselection:`Enregistrer le style.... -->
dans la base de données puis saisissez un nom de style, ajouter une description, un fichier:‘‘.ui‘ fichier
si applicable et indiquez si le style doit être le style par défaut.

Vous pouvez sauvegarder plusieurs styles pour une seule table dans la base de données. Cependant, chaque table
ne peut avoir qu’un seul style par défaut. Les styles par défaut peuvent être sauvegardés dans la base de données
de la couche ou dans la base de données locale QGIS, une base de données SQLite située dans le répertoire
~/.qgis2/ (celle où QGIS enregistre ses paramètres locaux).

Astuce: Partager les fichiers de style entre bases de données

Vous ne pouvez sauvegarder votre style dans une base de données que si la couche provient de cette base. Vous
ne pouvez pas mélanger les bases de données (couche dans Oracle et style dans MSSQL par exemple). Utilisez
plutôt un fichier texte si vous voulez que le style soit partagé entre les bases de données.

Note: Si vous rencontrez des problèmes lors de la restauration de la table layer_styles'
depuis une sauvegarde de base de données PostgreSQL, reportez vous à
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Figure 11.20: Fenêtre d’enregistrement d’un style dans une base de données

:ref:`layer_style_backup pour corriger cela.

Charger le style

Lors du chargement d’une couche dans QGIS, si un style par défaut existe déjà pour cette couche, QGIS charge
la couche avec ce style. De même :menuselection:‘Style –> Restaurer le style par défaut” recherche et charge ce
fichier, remplaçant le style courant de la couche.

menuselection:Style –> Charger le style vous aide à appliquer n’importe quel style enregistré à une couche. Alors
que les fichiers de style texte (:file:.sld ou :file:‘‘.qml‘) peuvent être appliqués à n’importe quelle couche, peu
importe son format, le chargement de styles stockés dans une base de données n’est possible que si la couche est
de la même base ou si le style est enregistré dans la base locale QGIS.

La boîte de dialogue Database Styles Manager affiche une liste de styles liés à la couche trouvée dans la base de
données et tous les autres styles enregistrés dans celle-ci, avec nom et description.

Astuce: Partager rapidement un style de couche au sein du projet

Vous pouvez également partager des styles de couche au sein d’un projet sans importer un fichier de style ou de
base de données : faites un clic droit sur la couche dans le Panneau des couches et, à partir de Styles, copiez le
style de la couche et collez-le à un groupe ou une sélection de couches : le style est appliqué sur toutes les couches
qui sont du même type (vecteur vs raster) que la couche originale et ont, pour les couches de vecteur, le même
type géométrie (point, ligne ou polygone).

11.6.3 Fichier de définition de couche (QLR)

Les définitions de couche peuvent être sauvegardées en tant que Fichier de définition de couches
(.qlr) en utilisant Exporter → Enregistrer dans un Ficher de Définition de Couche . . . dans le menu contextuel
de la couche active. Un fichier de définition de couches (.qlr) inclut des références à la source de données des
couches et à leurs styles. Les fichiers .qlr sont affichés dans l’explorateur et peuvent servir à ajouter les couches
(avec le style enregistré) au panneau couches. Vous pouvez également glisser-déposer des fichiers .qlr depuis le
gestionnaire de fichiers du système vers la carte.

11.7 Storing values in Variables

In QGIS, you can use variables to store useful recurrent values (e.g. the project’s title, or the user’s full name) that
can be used in expressions. Variables can be defined at the application’s global level, project level, layer level,
layout level, and layout item’s level. Just like CSS cascading rules, variables can be overwritten - e.g., a project
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level variable will overwrite any application global level variables set with the same name. You can use these
variables to build text strings or other custom expressions using the @ character before the variable name. For
example in print layout creating a label with this content:

This map was made using QGIS [% @qgis_version %]. The project file for this
map is: [% @project_path %]

Rendra l’étiquette comme ceci:

This map was made using QGIS 3.4.4-Madeira. The project file for this map is:
/gis/qgis-user-conference-2019.qgs

Besides the preset read-only variables, you can define your own custom variables for any of the levels mentioned
above. You can manage:

• global variables from the Settings → Options menu

• project variables from the Project Properties dialog (see Propriétés du projet)

• vector layer variables from the Layer Properties dialog (see Fenêtre Propriétés d’une couche vecteur);

• layout variables from the Layout panel in the Print layout (see The Layout Panel);

• and layout item variables from the Item Properties panel in the Print layout (see Layout Items Common
Options).

To differentiate from editable variables, read-only variable names and values are displayed in italic. On the other
hand, higher level variables overwritten by lower level ones are strike through.

Note: You can read more about variables and find some examples in Nyall Dawson’s Exploring variables in
QGIS 2.12, part 1, part 2 and part 3 blog posts.

11.8 Authentification

QGIS has the facility to store/retrieve authentication credentials in a secure manner. Users can securely save
credentials into authentication configurations, which are stored in a portable database, can be applied to server or
database connections, and are safely referenced by their ID tokens in project or settings files. For more information
see Système d’authentification.

Un mot de passe principal doit être fourni lors de l’initialisation du système d’authentification et de sa base de
données portable.

11.9 Common widgets

In QGIS, there are some options you’ll often have to work with. For convenience, QGIS provides you with special
widgets that are presented below.

11.9.1 sélecteur de couleur

The color dialog

The Select Color dialog will appear whenever you click the icon to choose a color. The
features of this dialog depend on the state of the Use native color chooser dialogs parameter checkbox in Settings
→ Options. . . → General. When checked, the color dialog used is the native one of the OS on which QGIS is
running. Otherwise, the QGIS custom color chooser is used.
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Figure 11.21: Variables editor at the project level
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The custom color chooser dialog has four different tabs which allow you to select colors by Color ramp,
Color wheel, Color swatches or Color picker. With the first two tabs, you can browse to all possible color combina-
tions and apply your choice to the item.

Figure 11.22: Onglet du sélecteur de couleur

In the Color swatches tab, you can choose from a list of color palettes (see Couleurs for details). All but the

Recent colors palette can be modified with the Add current color and Remove selected color buttons at the bottom of
the frame.

The . . . button next to the palette combobox also offers several options to:

• Copier, coller, importer ou exporter des couleurs

• create, import or remove color palettes

• add the custom palette to the color selector widget with the Show in Color Buttons item (see fig-
ure_color_selector)

Another option is to use the Color picker which allows you to sample a color from under your mouse cursor at
any part of the QGIS UI or even from another application: press the space bar while the tab is active, move the
mouse over the desired color and click on it or press the space bar again. You can also click the Sample Color
button to activate the picker.

Whatever method you use, the selected color is always described through color sliders for HSV (Hue, Saturation,
Value) and RGB (Red, Green, Blue) values. The color is also identifiable in HTML notation.

Modifying a color is as simple as clicking on the color wheel or ramp or on any of the color parameters sliders.
You can adjust such parameters with the spinbox beside or by scrolling the mouse wheel over the corresponding
slider. You can also type the color in HTML notation. Finally, there is an Opacity slider to set transparency level.

The dialog also provides a visual comparison between the Old color (applied to object) and the Current one (being

selected). Using drag-and-drop or pressing the Add color to swatch button, any of these colors can be saved in a
slot for easy access.

Astuce: Modification rapide de la couleur

Drag-and-drop a color selector widget onto another one to apply its color.
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Figure 11.23: Color selector swatches tab

The color drop-down shortcut

Click the drop-down arrow to the right of the color button to display a widget for quick color
selection. This shortcut provides access to:

• a color wheel to pick a color from

• an alpha slider to change color opacity

• the color palettes previously set to Show in Color Buttons

• copy the current color and paste it into another widget

• pick a color from anywhere on your computer display

• choose a color from the color selector dialog

The color ramp drop-down shortcut

Color ramps are a practical way to apply a set of colors to one or many features. Their creation is described
in the Palettes de couleur section. As for the colors, pressing the color ramp button opens the
corresponding color ramp type dialog allowing you to change its properties.

The drop-down menu to the right of the button gives quick access to a wider set of color ramps and options:

• Invert Color Ramp

• a preview of the gradient or catalog: cpt-city color ramps flagged as Favorites in the Style
Manager dialog

• All Color Ramps to access the compatible color ramps database

• Create New Color Ramp. . . of any supported type that could be used in the current widget (note that this
color ramp will not be available elsewhere unless you save it in the library)

• Edit Color Ramp. . . , the same as clicking the whole color ramp button

• Save Color Ramp. . . , to save the current color ramp with its customizations in the style library
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Figure 11.24: Raccourci pour la sélection de couleur

Figure 11.25: Customizing a colorbrewer ramp

Figure 11.26: Quick color ramp selection widget
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11.9.2 Modes de fusion

QGIS offers different options for special rendering effects with these tools that you may previously only know
from graphics programs. Blending modes can be applied on layers and features, and also on print layout items:

• Normal : il s’agit du mode de fusion standard qui utilise la valeur de transparence (canal alpha) du pixel
supérieur pour le fusionner avec le pixel sous-jacent, les couleurs ne sont pas mélangées.

• Éclaircir : Sélectionne le maximum entre chaque composante depuis les pixels du premier-plan et de
l’arrière-plan. Soyez attentif au fait que le résultat obtenu peut présenter un aspect dur et crénelé.

• Screen: Light pixels from the source are painted over the destination, while dark pixels are not. This mode
is most useful for mixing the texture of one item with another item (such as using a hillshade to texture
another layer).

• Dodge: Brighten and saturate underlying pixels based on the lightness of the top pixel. Brighter top pixels
cause the saturation and brightness of the underlying pixels to increase. This works best if the top pixels
aren’t too bright. Otherwise the effect is too extreme.

• Addition: Adds pixel values of one item to the other. In case of values above the maximum value (in the
case of RGB), white is displayed. This mode is suitable for highlighting features.

• Darken: Retains the lowest values of each component of the foreground and background pixels. Like
lighten, the results tend to be jagged and harsh.

• Multiply: Pixel values of the top item are multiplied with the corresponding values for the bottom item.
The results are darker.

• Burn: Darker colors in the top item cause the underlying items to darken. Burn can be used to tweak and
colorize underlying layers.

• Overlay: Combines multiply and screen blending modes. Light parts become lighter and dark parts become
darker.

• Soft light: Very similar to overlay, but instead of using multiply/screen it uses color burn/dodge. This is
supposed to emulate shining a soft light onto an image.

• Lumière dure : Ce mode est lui aussi très similaire au mode revêtement. Il est censé émuler une lumière
très intense projetée dans l’image.

• Difference: Subtracts the top pixel from the bottom pixel, or the other way around, in order always to get a
positive value. Blending with black produces no change, as the difference with all colors is zero.

• Subtract: Subtracts pixel values of one item from the other. In the case of negative values, black is dis-
played.

11.9.3 Valeurs définies par des données

Next to many options in the vector layer properties dialog or settings in the print layout, you will find a
Data defined override icon. Using expressions based on layer attributes or item settings, prebuilt or custom functions
and variables, this tool allows you to set dynamic values for parameters. When enabled, the value returned by this
widget is applied to the parameter regardless of its normal value (checkbox, textbox, slider. . . ).

The data defined override widget

Clicking the Data defined override icon shows the following entries:

• Description. . . that indicates if the option is enabled, which input is expected, the valid input type and the
current definition. Hovering over the widget also pops up this information.

• Store data in the project: a button allowing the property to be stored using to the Auxiliary Storage Proper-
ties mechanism.
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• Field type: an entry to select from the layer’s fields that match the valid input type.

• An entry to list the Variable available.

• Edit. . . button to create or edit the expression to apply, using the Expression String Builder dialog. To help
you correctly fill in the expression, a reminder of the expected output’s format is provided in the dialog.

• Paste and Copy buttons.

• le bouton Effacer pour réinitialiser les valeurs.

• For numeric and color properties, Assistant. . . to rescale how the feature data is applied to the property
(more details below)

Astuce: Use right-click to (de)activate the data override

When the data-defined override option is set up correctly the icon is yellow or . If it is broken, the icon is

red or .

You can enable or disable a configured data-defined override button by simply clicking the widget with the right
mouse button.

Using the data-defined assistant interface

When the Data-defined override button is associated with a numeric or color parameter, it has an Assistant. . . option
that allows you to change how the data is applied to the parameter for each feature. The assistant allows you to:

• Define the Input data, ie:

– the attribute to represent, using the Field listbox or the Set column expression function (see Expressions)

– the range of values to represent: you can manually enter the values or use the Fetch value range from layer

button to fill these fields automatically with the minimum and maximum values returned by the chosen
attribute or the expression applied to your data

• Apply transform curve: by default, output values (see below for setting) are applied to input features
following a linear scale. You can override this logic: enable the transform option, click on the graphic to
add break point(s) and drag the point(s) to apply a custom distribution.

• Define the Output values: the options vary according to the parameter to define. You can globally set:

– the minimum and maximum values to apply to the selected property (n case of a color setting, you’ll
need to provide a color ramp)

– the Scale method of representation which can be Flannery, Exponential, Surface or Radius

– the Exponent to use for data scaling

– the output value or color to represent features with NULL values

When compatible with the property, a live-update preview is displayed in the right-hand side of the dialog to help
you control the value scaling.

The values presented in the varying size assistant above will set the size “Data-defined override” with:

coalesce(scale_exp(Importance, 1, 20, 2, 10, 0.57), 1)
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Figure 11.27: The data-defined size assistant
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CHAPTER 12

Gérer les sources de données

12.1 Ouverture des données

As part of an Open Source Software ecosystem, QGIS is built upon different libraries that, combined with its own
providers, offer capabilities to read and often write a lot of formats:

• Vector data formats include ESRI formats (Shapefile, Geodatabase. . . ), MapInfo and MicroStation file for-
mats, AutoCAD DWG/DXF, GeoPackage, GeoJSON, GRASS, GPX, KML, Comma Separated Values, and
many more. . . Read the complete list of OGR vector supported formats.

• Raster data formats include ArcInfo Binary Grid, ArcInfo ASCII Grid, JPEG, GeoTIFF, ERDAS IMAGINE,
MBTiles, R or Idrisi rasters, ASCII Gridded XYZ, GDAL Virtual, SRTM, Sentinel Data, and many more. . .
Read the complete list of raster supported formats.

• Database formats include PostgreSQL/PostGIS, SQLite/SpatiaLite, Oracle, DB2 or MSSQL Spatial,
MySQL. . .

• Support of web data services (WM(T)S, WFS, WCS, CSW, ArcGIS Servers. . . ) is also handled by QGIS
providers (see QGIS comme client de données OGC).

• You can also read supported files from archived folders and use QGIS native formats such as virtual and
memory layers.

As of the date of this document, more than 80 vector and 140 raster formats are supported by the GDAL/OGR and
QGIS native providers.

Note: Not all of the listed formats may work in QGIS for various reasons. For example, some require external
proprietary libraries, or the GDAL/OGR installation of your OS may not have been built to support the format you
want to use. To have a list of available formats, run the command line ogrinfo --formats (for vector) or
check settings → Options → GDAL menu (for raster) in QGIS.

In QGIS, depending on the data format, there are different tools to open it, mainly available in the Layer →
Add Layer → menu or from the Manage Layers toolbar (enabled through View → Toolbars menu). However, all

these tools point to a unique dialog, the Data Source Manager dialog that you can directly open with the
Open Data Source Manager button available on the Data Source Manager Toolbar or by pressing Ctrl+L. Indeed, the
Data Source Manager dialog offers a unified interface to open vector or raster file-based data as well as databases

or web services supported by QGIS. It can be set modal or not with the Modeless data source manager dialog
in Settings → Options → General menu.
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Figure 12.1: QGIS Data Source Manager dialog
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Beside this main entry point, you also have the DB Manager plugin that offers advanced capabilities to analyze
and manipulate connected databases. More information on DB Manager capabilities are exposed in DB Manager
Plugin.

There are also many other tools, native or third-party plugins, that help you open dedicated data formats.

This chapter will describe only the tools provided by default in QGIS to load data. It will mainly focus on the
Data Source Manager dialog but more than describing each tab, it will also explore the tools based on the data
provider or format specificities.

12.1.1 The Browser Panel

The Browser is one of the main ways to quickly and easily add your data to projects. It’s available as:

• a Data Source Manager tab, enabled pressing the Open Data Source Manager button (Ctrl+L);

• as a QGIS panel you can open from the menu View → Panels (or Settings → Panels) or by pressing
Ctrl+2.

In both cases, the Browser helps you navigate in your file system and manage geodata, regardless the type of layer
(raster, vector, table), or the datasource format (plain or compressed files, database, web services).

To add a layer into a project, using the Browser interface:

1. Enable the Browser as described above. A browser tree with your file system, databases and web services is
displayed. You may need to connect databases and web services before they appear (see dedicated sections).

2. Find the layer in the list.

3. Double-click its name or drag-and-drop it into the map canvas. Your layer is now added to the Layers panel
and can be viewed in the map canvas.

Astuce: Open a QGIS project directly from the browser

You can also open a QGIS project directly from the Browser panel by double-clicking its name or by drag-
and-drop into the map canvas.

Once a file is loaded, you can zoom around it using the map navigation tools. To change the style of a layer, open
the Layer Properties dialog by double clicking on the layer name or by right-clicking on the name in the legend
and choosing Properties from the context menu. See section Onglet Symbologie for more information on setting
symbology of vector layers.

At the top of the Browser panel, you find some icons that help you to:

• Add Selected Layers: you can also add data into the map canvas by selecting Add selected layer(s) from the
layer’s context menu;

• Actualiser l’arborescence

• Filter Browser to search for specific data. Enter a search word or wildcard and the browser will filter the tree
to only show paths to matching DB tables, filenames or folders – other data or folders won’t be displayed.
See the Browser Panel(2) example on the figure_browser_panels. The comparison can be case-sensitive or
not. It can also be set to:

– ormal : renvoie tous les éléments qui contiennent la chaîne de texte cherchée

– joker : optimise la recherche en utilisant les caractères ? et/ou * pour spécifier la position de la chaîne
recherchée

– expression régulière

• Collapse All the whole tree;
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• Enable/disable properties widget: when toggled on, a new widget is added at the bottom of the panel showing, if
applicable, metadatas of the selected item.

Faire un clic-droit sur un élément de l’arborescence vous permez de :

• Dans le cas d’un fichier ou une table, afficher les métadonnées ou l’ouvrir dans votre projet. Les tables
peuvent également être renommées, supprimées ou tronquées.

• Dans le cas d’un répertoire, l’ajouter aux favoris, le masquer de l’arborescence de l’Explorateur. La liste
des répertoires masqués se gère dans Préférences → Options → Sources de données.

• create connection to databases or web servers;

• actualiser, renommer ou supprimer un schéma de base de données.

Vous pouvez également importer des fichiers dans les bases de données ou copier des tables d’un schéma / d’une
base à une autre via un glisser-déposer. Vous pouvez afficher un deuxième panneau Explorateur pour faciliter les
manipulations. Sélectionnez juste le fichier et déplacez-le d’un panneau à l’autre.

Figure 12.2: Les deux panneaux de l’Explorateur QGIS côte à côte

Astuce: Add layers to QGIS by simple drag-and-drop from your OS file browser

You can also add file(s) to the project by drag-and-dropping them from your operating system file browser to the
Layers Panel or the map canvas.

12.1.2 The DB Manager

The DB Manager Plugin is another one of the main and native tools to integrate and manage spatial database
formats supported by QGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, MSSQL, DB2, Virtual layers) in
one user interface. It can be activated from the Plugins → Manage and Install Plugins. . . menu.

The DB Manager Plugin provides several features:

• connect to databases and display its structure and contents;

• preview tables of databases;
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• add layers to map canvas, either by double-click or drag-and-drop;

• add layers to a database from the QGIS Browser or from another database;

• create and add output of SQL queries to the map canvas;

• create virtual layers.

More information on DB Manager capabilities are exposed in DB Manager Plugin.

Figure 12.3: Fenêtre DB Manager

12.1.3 Provider-based loading tools

Beside Browser Panel and DB Manager, the main tools provided by QGIS to add layers regardless the format,
you’ll also find tools that are specific to data providers.

Note: Some external plugins also propose tools to open specific format files in QGIS.

Charger une couche à partir d’un fichier

To load a layer from a file, you can:

• for vector data (like Shapefile, Mapinfo or dxf layer), click on Add Vector Layer toolbar button, select the

Layer → Add Layer → Add Vector Layer menu option or press Ctrl+Shift+V. This will bring up
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a new window (see figure_vector_add) from which you can check File and click on Browse. You can
also specify the encoding for the file if desired.

Figure 12.4: Fenêtre d’ajout d’une couche vectorielle

• for raster layers, click on the Add Raster Layer icon, select the Layer → Add Layer → Add Raster Layer
menu option or type Ctrl+Shift+R.

That will bring up a standard open file dialog (see figure_vector_open), which allows you to navigate the file

system and load a shapefile, a geotiff or other supported data source. The selection box Filter allows you
to preselect some supported file formats. Only the formats that have been well tested appear in the list. Other
untested formats can be loaded by selecting All files (*.*).

Figure 12.5: Fenêtre d’ouverture de données vectorielles dont le format est géré par OGR

Selecting a file from the list and clicking Open loads it into QGIS. More than one layer can be loaded at the same
time by holding down the Ctrl or Shift key and clicking on multiple items in the dialog. Figure_vector_loaded
shows QGIS after loading the alaska.shp file.

Note: Because some formats like MapInfo (e.g., .tab) or Autocad (.dxf) allow mixing different types of
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Figure 12.6: QGIS après avoir chargé le Shapefile de l’Alaska

geometry in a single file, loading such format in QGIS opens a dialog to select geometries to use in order to have
one geometry per layer.

Using the Add Vector Layer tool:

• You can also load specific formats like ArcInfo Binary Coverage, UK. National Transfer
Format, as well as the raw TIGER format of the US Census Bureau or OpenfileGDB. To do that,

you’d need to select Directory as Source type. In this case a directory can be selected in the dialog after
pressing Browse.

• With the Database source type you can select an existing database connection or create one to
the selected database type. Available database types are ODBC, OGDI Vectors, Esri Personal
Geodatabase, MySQL as well as PostgreSQL or MSSQL.

Pressing the New button opens the Create a New OGR Database Connection dialog whose parameters are
among the ones you can find in Créer une connexion enregistrée. Pressing Open you can select from the
available tables for example of the PostGIS enabled database.

• The last source type, Protocol, enables to open data from the web using for example GeoJSON or
CouchDB format. After selecting the type you have to fill URI of the source.

Astuce: Load layers and projects from mounted external drives on macOS

On macOS, portable drives that are mounted beside the primary hard drive do not show up as expected under File
→ Open. . . . We are working on a more macOS-native open/save dialog to fix this. As a workaround, you can
type /Volumes in the File name box and press Enter. Then you can navigate to external drives and network
mounts.
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Importing a delimited text file

Delimited text file (e.g. .csv, .txt) can be loaded in QGIS using the tools described above. However, loaded
this way, it’ll show up like a simple table data. Sometimes, delimited text files can contain geometric data you’d

want to visualize; this is what the Add Delimited Text Layer is designed for.

Click the Open Data Source Manager icon to open the Data Source Manager dialog and enable the Delimited
Text tab, as shown in figure_delimited_text.

Figure 12.7: Fenêtre d’ajout de couche depuis un fichier texte délimité

First, select the file to import (e.g., qgis_sample_data/csv/elevp.csv) by clicking on the Browse but-
ton. In the Layer name field, provide the name to use for the layer in the project (e.g., Elevation).

File format

Once the file is selected, QGIS attempts to parse the file with the most recently used delimiter, trying to identify
fields and rows. To enable QGIS to properly parse the file, it is important to select the correct delimiter. You can
specify a delimiter by activating:
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• CSV (comma separated values) to use the comma character;

• Custom delimiters, choosing among some predefined delimiters like comma, space, tab,
semicolon. . . ;

• or Regular expression delimiter and entering text into the Expression field. For example, to change the
delimiter to tab, use \t (this is a regular expression for the tab character).

Records and fields

Other than settings to identify rows and fields in the data, some convenient options can be used to tweak the data
recognition:

• Number of header lines to discard: convenient when you want to avoid some lines to show in the import,
either because those are blank lines or with another formatting.

• First records has field names: values in the first row of data are used as field names, otherwise QGIS
adds a fields row of a type field_1, field_2. . .

• Detect field types: automatically recognizes the field type. If unchecked then all attributes are treated as
text fields.

• Decimal separator is comma: if necessary, you can force a comma to be the decimal separator.

• Trim fields: allows you to trim leading and trailing spaces from fields.

• Discard empty fields.

As you set the parser properties, a sample data preview updates at the bottom of the dialog.

Geometry definition

Once the file is parsed, set Geometry definition to

• Point coordinates and provide the X field and Y field if the layer is of point geometry type and contain

such coordinate fields. If the coordinates are defined as degrees/minutes/seconds, activate the DMS
coordinates checkbox;

• Well known text (WKT) option if the spatial information is represented by WKT: select the Geometry
field containing the WKT definition and choose the approriate Geometry field or let QGIS auto-detect it;

• If the file contains non-spatial data, activate No geometry (attribute only table) and it will be loaded as
an ordinary table.

Besides the features geometry information, you can also set the layer’s Geometry CRS using the Select CRS

widget.

Layer settings

En complément, vous pouvez activer :

• Use spatial index to improve the performance of displaying and spatially selecting features;

• Use subset index to improve performance of subset filters (when defined in the layer properties);

• Watch file to watch for changes to the file by other applications while QGIS is running.
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At the end, click OK to add the layer to the map. In our example, a point layer named Elevation is added to
the project and behaves like any other map layer in QGIS. However, this layer is the result of a query on the .csv
source layer (hence, linked to it) and would require to be saved in order to get a spatial layer on disk.

Importing a DXF or DWG file

DXF and DWG files can be added to QGIS by simple drag-and-drop from the common Browser Panel. You’ll be
prompted to select the sublayers you’d like to add to the project. Layers are added with random style properties.

Note: Les fichiers DXF contiennent généralement plusieurs types géométriques (point, ligne et/ou polygone), le
nom de la couche sera basé sur <nom_de_fichier.dxf> entities <type géométrique>.

To keep the dxf/dwg file structure and its symbology in QGIS, you may want to use the dedicated Project →
Import/Export → Import Layers from DWG/DXF. . . tool which allows you to:

1. import elements from the drawing file into a GeoPackage database.

2. and add to the project any of the imported elements.

In the DWG/DXF Import dialog, to first import the drawing file contents:

1. Input the location of the Target package, i.e. the new GeoPackage file that will store the data. If an existing
file is provided, then it will be overwritten.

2. Specify the coordinate reference system of the data in the drawing file.

3. Check Expand block references to import the blocks in the drawing file as normal elements.

4. Check Use curves to promote the imported layers to a curved geometry type.

5. Use the Import button to select the DWG/DXF file to use (one per geopackage). The GeoPackage database
will be automatically populated with the drawing file content. Depending on the size of the *CAD file, this
could take some time.

After the .dwg or .dxf data is imported into the GeoPackage database the frame in the lower half of the dialog
is populated with the list of layers from the imported file. There you can select which layers to add to the QGIS
project:

1. At the top, set a Group name to group the drawing files in the project.

2. Check layers to show: Each selected layer is added to an ad hoc group which contains vector layers for the
point, line, label and area features of the drawing layer. The style of each layer is setup so that it resembles
the look it originally had in *CAD.

3. Check whether layer should be visible at opening.

4. Alternatively using the Merge layers option places all layers in a single group.

5. Press OK to open the layers in QGIS.

Importer des données vecteur OpenStreetMap

Ces dernières années, le projet OpenStreetMap (OSM) a gagné en popularité, car dans beaucoup de pays, aucune
donnée géographique sous licence libre, telle que par exemple le réseau routier, n’est disponible. L’objectif du
projet OSM est de créer une base de données géographiques libre sur le monde entier et qui est éditable par tous à
partir de données GPS, de photographies aériennes ou tout simplement des connaissances locales du terrain. Pour
soutenir ce projet, QGIS fournit une extension qui permet aux utilisateurs de travailler avec les données OSM.

Using the Browser Panel, you can load a .osm file to the map canvas, in which case you’ll get a dialog to select
sublayers based on the geometry type. The loaded layers will contain all the data of that geometry type in the file
and keep the osm file data structure.
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Figure 12.8: Import dialog for DWG/DXF files
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Couches SpatiaLite

The first time you load data from a SpatiaLite database, begin by:

• clicking on the Add SpatiaLite Layer toolbar button;

• selecting the Add SpatiaLite Layer. . . option from the Layer → Add Layer menu;

• or by typing Ctrl+Shift+L.

This will bring up a window that will allow you either to connect to a SpatiaLite database already known to QGIS,
which you can choose from the drop-down menu, or to define a new connection to a new database. To define a
new connection, click on New and use the file browser to point to your SpatiaLite database, which is a file with a
.sqlite extension.

QGIS gère les vues SpatiaLite éditables.

GPS

Loading GPS data in QGIS can be done using the core plugin: GPS Tools. Instructions are described in Section
Extension GPS.

GRASS

Le travail sur des couches vectorielles GRASS est décrit dans la Section Intégration du SIG GRASS.

Outils liés aux bases de données

Créer une connexion enregistrée

Pour lire et écrire des tables à partir des nombreux formats de base de données pris en charge par QGIS, vous
devez créer une connexion à cette base de données. Bien que Explorateur QGIS i soit le moyen le plus simple
et recommandé pour connecter et utiliser des bases de données, QGIS fournit d’autres outils pour se connecter à
chacune d’elles et charger leurs tables :

• Ajouter une couche Postgis. . . ou taper Ctrl+Shift+D;

• Ajouter une couche spatiale MSSQL ‘ ou taper :kbd:‘Ctrl+Shift+M;

• Ajouter une couche Oracle Spatial. . . ou taper Ctrl+Shift+O;

• Ajouter une couche DB2 Spatial. . . ou taper Ctrl+Shift+2;

Ces outils sont accessibles soit à partir de la Barre d’outils des couches ‘ soit à partir du menu :menuselec-
tion:‘Couche–> Ajouter une couche –>. La connexion à la base de données SpatiaLite est décrite à Couches
SpatiaLite.

Astuce: Créer une connexion à la base de données à partir de l’explorateur QGIS

Sélectionnez le format de base de données correspondant dans l’arborescence du navigateur, cliquez avec le bouton
droit de la souris et choisissez Connecter pour afficher la boîte de dialogue de connexion à la base de données.

La plupart des dialogues de connexion utilisent des paramètres communs qui seront décrits ci-dessous en utilisant
l’outil de base de données PostGreSQL comme exemple. Pour des paramètres supplémentaires spécifiques à
d’autres fournisseurs, vous trouverez la description correspondante sous :

• Connecting to MSSQL Spatial;
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• Connecting to Oracle Spatial;

• Connecting to DB2 Spatial.

La première fois que vous utilisez une source de données PostGIS, vous devez créer une connexion à une base
de données contenant les données. Commencez par cliquer sur le bouton approprié comme exposé ci-dessus, en
ouvrant un dialogue Ajouter une table Postgis (voir figure_add_postgis_tables). Pour accéder au gestionnaire de
connexion, cliquez sur le bouton Nouveau pour afficher le dialogue Créer une nouvelle connexion PostGIS.

Figure 12.9: Fenêtre Créer une Nouvelle Connexion PostGIS

Les paramètres requis pour une connexion PostGIS sont exposés ci-dessous. Pour les autres types de bases de
données, voir leurs différences à Paramètres particuliers de connexion.

• Nom : Un nom pour cette connexion. Il peut être identique à Base de données.

• Service : Paramètre de nom de service à utiliser alternativement au couple hôte/port (et potentiellement
base de données). Il peut être défini dans pg_service.conf. Consultez la section Fichier de connexion
de service pour plus de détails.

• Hôte : Nom pour l’hôte de la base de données. Il doit s’agir d’un nom existant, car il sera utilisé pour ouvrir
une connexion TCP/IP ou interroger l’hôte. Si la base de données est sur le même ordinateur que QGIS,
mettez simplement localhost.

• Port : numéro de port que le serveur de base de données PostgreSQL écoute. Le port par défaut est 5432.

• Base de données : nom de la base de données.

• Mode SSL : Comment sera négociée la connexion SSL avec le serveur. Notez qu’une importante accéléra-
tion du rendu des couches PostGIS peut être obtenue en désactivant le SSL dans l’éditeur de connexion. Les
options suivantes sont proposées :

– Désactive : Essaye uniquement une connexion SSL non cryptée.

– Permet : Essaye une connexion non-SSL. En cas d’échec, essaye une connexion SSL.

– Préfère (par défaut) : Essaye une connexion SSL. En cas d’échec, essaye une connexion non-SSL.
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– *Requiertù : Essaye uniquement une connexion SSL.

• Nom d’utilisateur : Nom d’utilisateur utilisé pour se connecter à la base de données.

• Mot de passe : mot de passe associé au Nom d’utilisateur pour se connecter à la base de données.

Vous pouvez sauvegarder l’un ou l’autre des paramètres » nom d’utilisateur » et » mot de passe » ou
les deux, auquel cas ils seront utilisés par défaut chaque fois que vous devez vous connecter à cette base
de données. Si ils ne sont pas sauvegardés, vous serez invité à remplir les informations d’identification
manquantes pour vous connecter à la base de données lors des prochaines sessions QGIS ; cependant les
paramètres de connexion que vous entrez sont enregistrés dans un cache interne temporaire et vous seront
retournés chaque fois qu’un nom d’utilisateur et un mot de passe pour cette base de données sont requis,
jusqu’à la clôture du processus actuel QGIS.

Avertissement: Paramètres utilisateur de QGIS et Sécurité

Dans l’onglet Authentification, l’enregistrement de nom d’utilisateur et mot de passe conserve les
informations d’identification non protégées dans la configuration de la connexion. Ces identifiants
seront visibles si, par exemple, vous avez partagé le fichier projet avec quelqu’un. Par conséquent,
il est conseillé d’enregistrer vos informations d’identification dans une configuration d’authentification
(onglet:guilabel:Configurations - Voir Système d’authentification pour plus de détails) ou dans un fichier
de connexion de service (voir Fichier de connexion de service par exemple).

Vous pouvez également, selon le type de base de données, activer les cases à cocher suivantes :

• N’afficher que les couches dont la géométrie est listée (dans geometry_columns)

• Ne pas résoudre le type pour les géométries non restreintes (GEOMETRY)

• Ne regarder que dans le schéma “public”

• Lister les tables sans géométrie

• Utiliser la table des métadonnées estimées

• Allow saving/loading QGIS projects in the database: more details here

Astuce: Utiliser la table de métadonnées estimées pour accélérer les opérations

Lors de l’initialisation des couches, plusieurs requêtes doivent être lancées pour établir les caractéristiques des
géométries contenus dans la table de la base de données. Lorsque l’option Utiliser la table de métadonnées
estimées est cochée, ces requêtes examinent uniquement un nombre restreint de lignes et utilisent la table des
statistiques plutôt que la totalité de la table. Cela peut accélérer drastiquement les performances sur des données
volumineuses mais peut entraîner une caractérisation incorrecte (ex: le décompte des entités des couches filtrées
ne sera pas déterminé avec précision) ainsi qu’un comportement anormal lorsque des colonnes qui devraient être
uniques ne le sont pas.

Une fois tous les paramètres et options définis, vous pouvez tester la connexion en cliquant sur le bouton
Tester la connexion ou l’appliquer en cliquant sur OK. A partir de Ajouter une table PostGIS, cliquez main-
tenant sur Connecter et le dialogue se rempli avec les tables de la base sélectionnée (comme montré dans fig-
ure_add_postgis_tables).

Paramètres particuliers de connexion

Paramètres de connexion particulières Même si chaque type de base de données possède des particularités, les op-
tions fournies ci dessus sont les mêmes pour toutes les bases de données. Ci-dessous sont exposées ces spécificités
de connexion.
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Fichier de connexion de service

Le fichier de connexion de service permet aux paramètres de connexion PostgreSQL d’être associés à un seul nom
de service. Ce nom de service peut alors être utilisé par un client et les paramètres associés seront utilisés.

Il est nommé .pg_service.conf sous les systèmes *nix (GNU/Linux, macOs, etc.) et pg_service.conf
sous Windows.

Le fichier de service ressemble à

[water_service]
host=192.168.0.45
port=5433
dbname=gisdb
user=paul
password=paulspass

[wastewater_service]
host=dbserver.com
dbname=water
user=waterpass

Note: Il y a deux services dans l’exemple ci-dessus: water_service et wastewater_service. Vous
pouvez les utiliser pour vous connecter depuis QGIS, pgAdmin, etc. en indiquant uniquement le nom du ser-
vice auquel vous souhaitez vous connecter (sans les crochets). Si vous souhaitez utiliser le service avec psql,
vous devrez déclarer une variable sous la forme export PGSERVICE=water_service avant de lancer vos
commandes psql.

Vous trouverez tous les paramètres ici

Note: Si vous ne souhaitez pas sauvegarder les mots de passe dans le fichier de service, vous pouvez utiliser
l’option .pg_pass.

Sur les systèmes d’exploitation *nix (GNU/Linux, macOs, etc.) vous pouvez sauvegarder le fichier .
pg_service.conf dans le répertoire home de l’utilisateur et les clients PostgreSQL l’utiliseront automatique-
ment. Par exemple si l’utilisateur connecté est web, le fichier .pg_service.conf devra être sauvegardé dans
le répertoire /home/web/ pour fonctionner correctement (sans nécéssiter de créer une variable d’environnement
spécifique).

Vous pouvez indiquer l’emplacement du fichier de service en créer une variable d’environnement
PGSERVICEFILE (ex: lancez la commande export PGSERVICEFILE=/home/web/.pg_service.
conf sous votre OS *nix pour créer temporairement la variable PGSERVICEFILE).

Vous pouvez également utiliser un fichier de service disponible pour l’ensemble du système (tous les utilisa-
teurs), soit en plaçant le fichier .pg_service.conf à l’emplacement pg_config --sysconfdir, soit
en ajoutant une variable d’environnement PGSYSCONFDIR indiquant le répertoire contenant le fichier de service.
Si des définitions de service partagent le même nom dans le fichier de service de l’utilisateur et dans le fichier de
service système, le fichier de l’utilisateur est prioritaire.

Avertissement: Il existe quelques limites sous Windows :

• Le fichier de service doit être nommé pg_service.conf et non .pg_service.conf.

• Le fichier de service doit être sauvegardé au format Unix pour fonctionner. Un moyen de le garantir est
de l’ouvrir avec Notepad++ et d’utiliser Editer -> Conversion des retours à la ligne -> Format Unix ->
Sauvegarder le fichier.

• Vous pouvez ajouter des variables d’environnement de différentes manières ; une méthode testée, connue
pour fonctionner de manière fiable, est d’aller dans le Panneau de configuration→ Système et sécurité
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→ Système → Paramètres système avancés → Variables d’environnement et d’ajouter ‘‘PGSERVICE-
FILE”“et le chemin vers le ficher :fichier:‘C:\\Users\\John\\pg_service.conf‘

• Après avoir ajouté une variable d’environnement, vous aurez peut-être besoin de redémarrer l’ordinateur.

Connecting to Oracle Spatial

The spatial features in Oracle Spatial aid users in managing geographic and location data in a native type within
an Oracle database. In addition to some of the options in Créer une connexion enregistrée, the connection dialog
proposes:

• Base de données : SID ou SERVICE_NAME de l’instance Oracle.

• Port : numéro de port que le serveur de base de données Oracle écoute. Le port par défaut est 1521.

• Workspace: Workspace to switch to.

Vous pouvez également activer les options suivantes :

• Only look in metadata table: restricts the displayed tables to those that are in the
all_sdo_geom_metadata view. This can speed up the initial display of spatial tables.

• Only look for user’s tables: when searching for spatial tables, restricts the search to tables that are owned
by the user.

• Also list tables with no geometry: indicates that tables without geometry should also be listed by default.

• Use estimated table statistics for the layer metadata: when the layer is set up, various metadata are
required for the Oracle table. This includes information such as the table row count, geometry type and
spatial extents of the data in the geometry column. If the table contains a large number of rows, determining
this metadata can be time-consuming. By activating this option, the following fast table metadata operations
are done: Row count is determined from all_tables.num_rows. Table extents are always determined
with the SDO_TUNE.EXTENTS_OF function, even if a layer filter is applied. Table geometry is determined
from the first 100 non-null geometry rows in the table.

• Only existing geometry types: only lists the existing geometry types and don’t offer to add others.

• Inclure les attributs géométriques additionnels.

Astuce: Couches Oracle Spatial

Normalement, une couche Oracle Spatial est définie par une entrée dans la table USER_SDO_METADATA.

Connecting to DB2 Spatial

In addition to some of the options described in Créer une connexion enregistrée, the connection to a DB2 database
(see Couches DB2 Spatial for more information) can be specified using either a Service/DSN name defined to
ODBC or using the driver, host and port information.

An ODBC Service/DSN connection requires the service name defined to ODBC.

A driver/host/port connection requires:

• Driver: Name of the DB2 driver. Typically this would be IBM DB2 ODBC DRIVER.

• DB2 Host: Name of the database host. This must be a resolvable host name such as would be used to
open a TCP/IP connection or ping the host. If the database is on the same computer as QGIS, simply enter
localhost here.
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• DB2 Port: Port number the DB2 database server listens on. The default DB2 LUW port is 50000. The
default DB2 z/OS port is 446.

Astuce: DB2 Spatial Layers

A DB2 Spatial layer is defined by a row in the DB2GSE.ST_GEOMETRY_COLUMNS view.

Note: In order to work effectively with DB2 spatial tables in QGIS, it is important that tables have an INTEGER
or BIGINT column defined as PRIMARY KEY and if new features are going to be added, this column should also
have the GENERATED characteristic.

It is also helpful for the spatial column to be registered with a specific spatial reference identifier (most often 4326
for WGS84 coordinates). A spatial column can be registered by calling the ST_Register_Spatial_Column
stored procedure.

Connecting to MSSQL Spatial

In addition to some of the options in Créer une connexion enregistrée, creating a new MSSQL connection dialog
proposes you to fill a Provider/DSN name. You can also display available databases.

Loading a Database Layer

Once you have one or more connections defined to a database (see section Créer une connexion enregistrée), you
can load layers from it. Of course, this requires having available data. See e.g. section Importer des données dans
PostgreSQL for a discussion on importing data into a PostGIS database.

To load a layer from a database, you can perform the following steps:

1. Open the « Add <database> table(s) » dialog (see Créer une connexion enregistrée).

2. Choose the connection from the drop-down list and click Connect.

3. Cochez ou décochez selon votre besoin Lister les tables sans géométrie

4. Optionally, use some Search Options to reduce the list of tables to those matching your search. You can
also set this option before you hit the Connect button, speeding this way the database fetching.

5. Trouvez la ou les couches que vous souhaitez ajouter dans la liste des couches disponibles.

6. Select it by clicking on it. You can select multiple layers by holding down the Shift key while clicking.

7. If applicable, use the Set Filter button (or double-click the layer) to start the Query Builder dialog (See sec-
tion Constructeur de requête) and define which features to load from the selected layer. The filter expression
appears in the sql column. This restriction can be removed or edited in the Layer Properties → General
→ Provider Feature Filter frame.

8. The checkbox in the Select at id column that is activated by default gets the features ids without the
attributes and speeds in most cases the data loading.

9. Click on the Add button to add the layer to the map.

Astuce: Use the Browser Panel to speed up loading of database table(s)

Adding DB tables from their ad hoc tab of the Data Source Manager dialog to QGIS may sometimes be time
consuming as QGIS fetches statistics and properties (e.g. geometry type and field, CRS, number of features) of
each table beforehand. To avoid this, once the connection is set, it’s better to use the Browser Panel or the DB
Manager to drag and drop the database tables in the map canvas.
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Figure 12.10: Add PostGIS Table(s) Dialog

12.1.4 QGIS Custom formats

QGIS proposes two custom formats you can load in the application using their own loading tool:

• Temporary Scratch Layer: a memory layer that is bound to the project it’s opened with (see Créer une
nouvelle couche temporaire en mémoire for more information)

• Virtual Layers: a layer resulting from a query on other layer(s) (see Creating virtual layers for more infor-
mation)

12.1.5 Connecting to web services

With QGIS you can have access to different types of OGC web services (WM(T)S, WFS(-T), CSW . . . ). Thanks
to QGIS Server, you can also publish these services. Description of these capabilities and how-to are provided in
chapter Les données OGC.

12.2 Créer des couches

Layers can be created in many ways, including:

• empty layers from scratch;

• layers from existing layers;

• layers from the clipboard;

• layers as a result of an SQL-like query based on one or many layers: the virtual layer.

QGIS also provides tools to import/export different formats.
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12.2.1 Creating new vector layers

QGIS allows you to create new Shapefile layers, new SpatiaLite layers, new GPX layers and new Temporary
Scratch layers. Creation of a new GRASS layer is supported within the GRASS plugin. (Please refer to section
Création d’une nouvelle couche vectorielle GRASS for more information on creating GRASS vector layers.)

Creating a new GeoPackage layer

To create a new GeoPackage layer go to Layer → New → New GeoPackage Layer. . . . The New GeoPackage
Layer dialog will be displayed as shown in figure_create_geopackage.

Figure 12.11: Creating a New GeoPackage layer dialog

The first step is to select an existing GeoPackage or create a new one. This can be done by pressing the ellipses
. . . button at the right of the Database field. Then, give a name for the new layer, define the layer type and specify
the coordinate reference system with Specify CRS.

To define an attribute table for the new GeoPackage layer, add the names of the attribute columns you want to
create with the corresponding column type, and click on the Add to Fields List button. Once you are happy with
the attributes, click OK. QGIS will automatically add the new layer to the legend, and you can edit it in the same
way as described in section Numériser une couche existante.
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Créer une nouvelle couche Shapefile

To create a new Shapefile layer, choose Create Layer → New Shapefile Layer. . . from the Layer menu or
select it from the Data Source Manager toolbar. The New Shapefile Layer dialog will be displayed as shown in
figure_create_shapefile. The first step is to provide a path and name for the Shapefile. QGIS will automatically add
the .shp extension to the name you specify Next, choose the type of layer (point, line or polygon) and optional
Z or M dimensions, as well as the CRS (coordinate reference system).

Figure 12.12: Fenêtre de création d’une nouvelle couche Shapefile

To complete the creation of the new Shapefile layer, add the desired attributes by specifying a name and type
for each attribute and clicking on the Add to Fields List button. A first “id” column is added by default but

can be removed, if not wanted. Only Decimal number , Whole number , Text data and Date

attributes are supported. Additionally, depending on the attribute type, you can also define the length and
precision of the new attribute column. Once you are happy with the attributes, click OK. Once the Shapefile has
been created, it will be added to the map as a new layer, and you can edit it in the same way as described in section
Numériser une couche existante.

Créer une nouvelle couche SpatiaLite

To create a new SpatiaLite layer for editing, choose Create Layer → New SpatiaLite Layer. . . from the Layer
menu or select it from the Data Source Manager toolbar. The New SpatiaLite Layer dialog will be displayed as
shown in Figure_create_spatialite.

The first step is to select an existing SpatiaLite database or to create a new SpatiaLite database. This can be
done with the . . . button at the right of the database field. Then, add a name for the new layer, define the layer

type, and specify the coordinate reference system with Specify CRS. If desired, you can select Create an
autoincrementing primary key.
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Figure 12.13: Fenêtre de création d’une nouvelle couche SpatiaLite

To define an attribute table for the new SpatiaLite layer, add the names of the attribute columns you want to create
with the corresponding column type, and click on the Add to Fields List button. Once you are happy with the
attributes, click OK. QGIS will automatically add the new layer to the legend, and you can edit it in the same way
as described in section Numériser une couche existante.

D’autres opérations de gestion des couches SpatiaLite peuvent être effectuées via DB Manager. Voir DB Manager
Plugin.

Créer une nouvelle couche GPS

Pour créer un nouveau fichier GPX, vous devez d’abord charger l’extension GPS. Extension→ Installer/Gérer

les extensions ouvre la fenêtre Gestionnaire d’extensions. Activez la case Outils GPS.

When this plugin is loaded, choose New → Create new GPX Layer. . . from the Layer menu. In the Save new
GPX file as dialog, choose where to save the new file and press Save. Three new layers are added to the Layers
Panel: waypoints, routes and tracks with predefined structure.

Créer une nouvelle couche temporaire en mémoire

Temporary Scratch Layers are in-memory layers, meaning that they are not saved on disk and will be discarded
when QGIS is closed. They can be handy to store features you temporarily need or as intermediate layers during
geoprocessing operations.

Empty, editable temporary scratch layers can be defined using Layer → Create Layer → New Temporary

Scratch Layer or New temporary scratch layer button from the Data Source Manager Toolbar. Here you can create a:

• No geometry type layer, served as simple table,
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• Point or MultiPoint layer,

• LineString/CompoundCurve or MultiLineString/MultiCurve layer,

• Polygon/CurvePolygon or MultiPolygon/MultiSurface layer.

Figure 12.14: Creating a new Temporary Scratch layer dialog

By default, a new temporary scratch layer is created without any attribute. But you can also create prepopulated
temporary scratch layers using e.g. the clipboard (see Creating new layers from the clipboard) or as a result of a
Processing algorithm.

Astuce: Permanently store a memory layer on disk

To avoid data loss when closing project with temporary scratch layers, you can save these layers to any vector
format supported by QGIS:

• clicking the indicator icon next to the layer;

• selecting the Make permanent entry in the layer contextual menu;

• or as of any other vector layer, using the Export → entry from the contextual menu or the Layer → Save
As. . . menu.

Each of these commands prompts the Save Vector Layer as dialog exposed in Creating new layers from an existing
layer section and the saved file replaces the temporary one in the Layers panel.

12.2.2 Creating new layers from an existing layer

Both raster and vector layers can be saved in a different format and/or reprojected to a different coordinate ref-
erence system (CRS) using the Layer → Save As. . . menu or right-clicking on the layer in the Layers panel and
selecting:

• Export → Save As. . . for raster layer

• Export → Save Features As. . . or Export → Save Selected Features As. . . for vector layer.

• Drag’n drop layer from the layer tree to the PostGIS entry in the Browser Panel. Note that you should have
already a PostGIS connection in the Browser Panel.
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Paramètres en commun

The Save Layer as. . . dialog shows several parameters to change the behavior when saving the layer. Among the
common parameters for raster and vector are:

• Nom de fichier

• CRS: can be changed to reproject the data

• Add saved file to map: to add the new layer to the canvas

• Étendue (les valeurs possibles sont couche, Canevas de carte ou définie par l’utilisateur)

Certains paramètres sont toutefois spécifiques au format vecteur ou raster:

Paramètres spécifiques au raster

Depending on the format of export, some of these options may not be available:

• Output mode (it can be raw data or rendered image)

• Format: exports to any raster format GDAL can write to, such as GeoTiff, GeoPackage, MBTiles, Geospatial
PDF, SAGA GIS Binary Grid, Intergraph Raster, ESRI .hdr Labelled. . .

• Résolution

• Create Options: use advanced options (file compression, block sizes, colorimetry. . . ) when generating files,
either from the predefined create profiles related to the output format or by setting each parameter.

• création de Pyramides

• VRT Tiles in case you opted to Create VRT

• No data values

Figure 12.15: Saving as a new raster layer
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Paramètres spécifiques au vecteur

Selon le format d’export, certaines des options suivantes pourraient ne pas être disponibles:

• Format: exports to any vector format GDAL can write to, such as GeoPackage, ESRI Shapefile, AutoCAD
DXF, ESRI FileGDB, Mapinfo TAB or MIF, SpatiaLite, CSV, KML, ODS. . .

• Layer name depending on the selected format

• Encoding

• Save only selected features

• Select fields to export and their export options. In case you set your fields behavior with some Edit widgets,

e.g. value map, you can keep the displayed values in the layer by checking Replace all selected raw
fields values by displayed values.

• Exporter la symbologie : peut être utilisé principalement pour l’export en DXF et pour tous les formats de
fichiers qui gèrent les styles d’entités OGR (voir la remarque ci-dessous) comme le KML, TAB. . .

– Pas de symbologie : Style par défaut dans l’application qui lit les données

– Symbologie de l’entité : Enregistre le style avec les styles d’entités OGR (voir la remarque ci-dessous)

– Symbologie de la couche de Symboles : Enregistre avec les styles d’entités OGR (voir la remarque
ci-dessous), mais exporte la même géométrie plusieurs fois si plusieurs symbologies de symboles sont
utilisées

– A Scale value can be applied to the latest options.

Note: OGR Feature Styles are a way to store style directly in the data as a hidden attribute. Only some formats
can handle this kind of information. KML, DXF and TAB file formats are such formats. For advanced users, you
can read the OGR Feature Styles specification document.

• Geometry: you can configure the geometry capabilities of the output layer

– geometry type: keeps the original geometry of the features when set to Automatic, otherwise removes
or overrides it with any type. You can add an empty geometry column to an attribute table, remove the
geometry column of a spatial layer.

– Force multi-type: forces creation of multi-geometry features in the layer.

– Include z-dimension to geometries.

Astuce: Overriding layer geometry type makes it possible to do things like save a geometryless table (e.g. .csv
file) into a shapefile WITH any type of geometry (point, line, polygon), so that geometries can then be manually

added to rows with the Add Part tool.

• Datasources Options, Layer Options or Custom Options which allow you to configure some advanced pa-
rameters. See the gdal-ogr driver documentation.

Lors de la sauvegarde d’une couche vecteur dans un fichier existant, et selon les capacités du format ciblé (ex
GeoPackage, SpatiaLite, FileGDB. . . ), l’utilisateur peut se voir offrir différentes options telles que:

• overwrite the whole file

• overwrite only the target layer (the layer name is configurable)

• append features to the existing target layer

• append features, add new fields if there are any.

For formats like ESRI Shapefile, MapInfo .tab, feature append is also available.
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Figure 12.16: Saving as a new vector layer
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12.2.3 Creating new DXF files

Besides the Save As. . . dialog which provides options to export a single layer to another format, including *.
DXF, QGIS provides another tool to export multiple layers as a single DXF layers. It’s accessible in the Project
→ Import/Export → Export Project to DXF. . . menu.

In the DXF Export dialog:

1. Indicate the destination layer file.

2. Choose the symbology mode and scale (see the OGR Feature Styles note) if applicable.

3. Select the data Encoding.

4. Select the CRS to apply: the selected layers will be reprojected to the given CRS.

5. select the layers to include in the DXF files either by checking each in the table widget or automatically
pick them from an existing map theme. The Select All and Deselect All buttons can also help to quickly set
the data to export.

For each layer, you can also choose whether to export all the features in a single DXF layer or rely on a field
whose values are used to split the features in generated destination layers in the DXF output.

Optionally, you can also choose to:

• Use the layer title as name if set instead of the layer name itself;

• Export features intersecting the current map extent;

• Force 2d output (eg. to support polyline width);

• Export label as MTEXT elements or TEXT elements.

Figure 12.17: Exporting a project to DXF dialog
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12.2.4 Creating new layers from the clipboard

Features that are on the clipboard can be pasted into a new layer. To do this, Select some features, copy them to
the clipboard, and then paste them into a new layer using Edit → Paste Features as → and choosing:

• New Vector Layer. . . : you need to select the layer CRS, poping up the Save vector layer as. . . dialog
from which you can select any supported data format (see Creating new layers from an existing layer for
parameters);

• or Temporary Scratch Layer. . . : you need to select the layer CRS and give a name.

A new layer, filled with selected features and their attributes is created and added to map canvas if asked.

Note: Creating layers from clipboard is possible with features selected and copied within QGIS as well as features
from another application, as long as they are defined using well-known text (WKT) string.

12.2.5 Creating virtual layers

Virtual layers are a special kind of vector layer. They allow you to define a layer as the result of an SQL query in-
volving any number of other vector layers that QGIS is able to open. Virtual layers do not carry data by themselves
and can be seen as views to other layers.

To create a virtual layer, open the virtual layer creation dialog by:

• clicking Add Virtual Layer option in the Layer → Add Layer → menu;

• enabling the Add Virtual Layer tab in the Data Source Manager dialog;

• or using the DB Manager dialog tree item.

The dialog allows you to specify a Layer name and an SQL Query. The query can use the name (or id) of loaded
vector layers as tables, as well as their field names as columns.

For example, if you have a layer called airports, you can create a new virtual layer called
public_airports with an SQL query like:

SELECT *
FROM airports
WHERE USE = "Civilian/Public"

The SQL query will be executed, regardless of the underlying provider of the airports layer, even if this
provider does not directly support SQL queries.

Joins and complex queries can also be created, for example, to join airports and country information:

SELECT airports.*, country.population
FROM airports
JOIN country
ON airports.country = country.name

Note: It’s also possible to create virtual layers using the SQL window of DB Manager Plugin.

Embedding layers for use in queries

Besides the vector layers available in the map canvas, the user can add layers to the Embedded layers list, which
he can use in queries without the need to have them showing in the map canvas or Layers panel.

To embed a layer, click Add and provide the Local name, Provider, Encoding and the path to the Source.
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Figure 12.18: Create virtual layers dialog

The Import button allows adding layers loaded in the map canvas into the Embedded layers list. This allows to
later remove those layers from the Layers panel without breaking any existent query.

Supported query language

The underlying engine uses SQLite and SpatiaLite to operate.

It means you can use all of the SQL your local installation of SQLite understands.

Functions from SQLite and spatial functions from SpatiaLite can also be used in a virtual layer query. For instance,
creating a point layer out of an attribute-only layer can be done with a query similar to:

SELECT id, MakePoint(x, y, 4326) as geometry
FROM coordinates

Functions of QGIS expressions can also be used in a virtual layer query.

To refer the geometry column of a layer, use the name geometry.

Contrary to a pure SQL query, all the fields of a virtual layer query must be named. Don’t forget to use the as
keyword to name your columns if they are the result of a computation or function call.

Performance issues

With default parameters set, the virtual layer engine will try its best to detect the type of the different columns of
the query, including the type of the geometry column if one is present.

This is done by introspecting the query when possible or by fetching the first row of the query (LIMIT 1) at last
resort. Fetching the first row of the result just to create the layer may be undesirable for performance reasons.

The creation dialog allows to specify different parameters:
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• Unique identifier column: this option allows specifying which field of the query represents unique integer
values that QGIS can use as row identifiers. By default, an autoincrementing integer value is used. Defining
a unique identifier column allows to speed up the selection of rows by id.

• No geometry: this option forces the virtual layer to ignore any geometry field. The resulting layer is an
attribute-only layer.

• Geometry Column: this option allows to specify the name of the column that is to be used as the geometry
of the layer.

• Geometry Type: this option allows to specify the type of the geometry of the virtual layer.

• Geometry CRS: this option allows to specify the coordinate reference system of the virtual layer.

Special comments

The virtual layer engine tries to determine the type of each column of the query. If it fails, the first row of the
query is fetched to determine column types.

The type of a particular column can be specified directly in the query by using some special comments.

The syntax is the following: /*:type*/. It has to be placed just after the name of a column. type can be either
int for integers, real for floating point numbers or text.

For instance:

SELECT id+1 as nid /*:int*/
FROM table

The type and coordinate reference system of the geometry column can also be set thanks to special comments
with the following syntax /*:gtype:srid*/ where gtype is the geometry type (point, linestring,
polygon, multipoint, multilinestring or multipolygon) and srid an integer representing the
EPSG code of a coordinate reference system.

Use of indexes

When requesting a layer through a virtual layer, indexes of this source layer will be used in the following ways:

• if an = predicate is used on the primary key column of the layer, the underlying data provider will be asked
for a particular id (FilterFid)

• for any other predicates (>, <=, !=, etc.) or on a column without a primary key, a request built from an
expression will be used to request the underlying vector data provider. It means indexes may be used on
database providers if they exist.

A specific syntax exists to handle spatial predicates in requests and triggers the use of a spatial index: a hidden
column named _search_frame_ exists for each virtual layer. This column can be compared for equality to a
bounding box. Example:

SELECT *
FROM vtab
WHERE _search_frame_=BuildMbr(-2.10,49.38,-1.3,49.99,4326)

Spatial binary predicates like ST_Intersects are significantly sped up when used in conjunction with this
spatial index syntax.
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12.3 Découvrir les formats de données et de champs

12.3.1 Données Raster

Les données raster dans les SIG sont des matrices de cellules discrètes qui représentent des objets, au-dessus
ou en dessous de la surface de la Terre. Les cellules de la grille raster sont de la même taille et généralement
rectangulaires (dans QGIS, elles seront toujours rectangulaires). Les jeux de données raster les plus classiques
sont des données de télédétection telles que des photographies aériennes ou des images satellitaires et des données
issues de modèles telles que les matrices d’élévation.

Unlike vector data, raster data typically do not have an associated database record for each cell. They are geocoded
by pixel resolution and the X/Y coordinate of a corner pixel of the raster layer. This allows QGIS to position the
data correctly in the map canvas.

Pour afficher correctement les données, QGIS utilise les informations de géoréférencement intégrées aux couches
raster (par exemple GeoTiff) ou présentes dans un fichier world.

12.3.2 Données Vecteurs

Many of the features available in QGIS work the same, regardless the vector data source. However, because of the
differences in formats specifications (ESRI Shapefile, MapInfo and MicroStation file formats, AutoCAD DXF,
PostGIS, SpatiaLite, DB2, Oracle Spatial and MSSQL Spatial databases, and many more), QGIS may handle
differently some of their properties. This section describes how to work with these specificities.

Note: QGIS gère les entités de type (multi)point, (multi)ligne, (multi)polygone, CircularString, CompoundCurve,
CurvePolygon, MultiCurve, MultiSurface avec des valeurs Z et/ou M.

Merci de prendre note que certains pilotes ne gèrent pas certains de ces types d’entités comme les types Circu-
larString, CompoundCurve, CurvePolygon, MultiCurve et MultiSurface. QGIS les convertira alors en entités de
type (multi)polygone.

ESRI Shapefile

ESRI Shapefile is still one of the most used vector file format in QGIS. However, this file format has some
limitation that some other file format have not (like GeoPackage, SpatiaLite). Support is provided by the OGR
Simple Feature Library.

A Shapefile format dataset consists of several files. The following three are required:

1. .shp fichier contenant la géométrie des entités;

2. .dbf fichier contenant les attributs au format dBase;

3. .shx fichier d’index.

A Shapefile format dataset can also include a file with a .prj suffix, which contains the projection information.
While it is very useful to have a projection file, it is not mandatory. A Shapefile format dataset can contain addi-
tional files. For further details, see the ESRI technical specification at https://www.esri.com/library/whitepapers/
pdfs/shapefile.pdf.

Improving Performance for Shapefile format datasets

To improve the performance of drawing a Shapefile format dataset, you can create a spatial index. A spatial index
will improve the speed of both zooming and panning. Spatial indexes used by QGIS have a .qix extension.

Voici les étapes de création d’un index spatial :

1. Load a Shapefile format dataset (see The Browser Panel).

2. Open the Layer Properties dialog by double-clicking on the layer name in the legend or by right-clicking
and choosing Properties. . . from the context menu.
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3. In the Source tab, click the Create Spatial Index button.

Problème de chargement de fichier .prj

If you load a Shapefile format dataset with a .prj file and QGIS is not able to read the coordinate reference
system from that file, you will need to define the proper projection manually within the Layer Properties →

Source tab of the layer by clicking the Select CRS button. This is due to the fact that .prj files often do not
provide the complete projection parameters as used in QGIS and listed in the CRS dialog.

For the same reason, if you create a new Shapefile format dataset with QGIS, two different projection files are cre-
ated: a .prj file with limited projection parameters, compatible with ESRI software, and a .qpj file, providing
the complete parameters of the used CRS. Whenever QGIS finds a .qpj file, it will be used instead of the .prj.

Fichiers de Texte Délimité

Delimited text file is a very common and widely used format because of its simplicity and readability – data can
be viewed and edited even in a plain text editor. A delimited text file is a tabular data with each column separated
by a defined character and each row separated by a line break. The first row usually contains the column names. A
common type of delimited text file is a CSV (Comma Separated Values), with each column separated by a comma.
Such data files can also contain positional information (see Storing geometry information in delimited text file).

QGIS allows you to load a delimited text file as a layer or ordinal table (see The Browser Panel or Importing a
delimited text file). But first check that the file meets the following requirements:

1. The file must have a delimited header row of field names. This must be the first line of the data (ideally the
first row in the text file).

2. If geometry should be enabled, the header row must contain field(s) with geometry definition. These field(s)
can have any name.

3. The X and Y coordinates fields (if geometry is defined by coordinates) must be specified as numbers. The
coordinate system is not important.

4. Si vous avez des champs qui ne sont pas de type texte et que le fichier est un CSV, vous devriez avoir un
fichier CSVT (voir section Using CSVT file to control field formatting).

Comme exemple de fichier texte valide, nous pouvons importer le fichier point d’élévation elevp.csv fourni
avec le jeu de données échantillon de QGIS (voir section Téléchargement des données exemple) :

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Notons les points suivants à propos du fichier texte :

1. Le fichier texte d’exemple utilise le ; (point-virgule) comme délimiteur. N’importe quel caractère peut être
utilisé comme délimiteur de champ.

2. La première ligne est la ligne d’en-tête. Elle contient les champs X, Y et ELEV.

3. Aucun guillemet (") n’est utilisé pour délimiter les champs de type texte.

4. Les coordonnées X sont stockées dans le champ X.

5. Les coordonnées Y sont stockées dans le champ Y.

Storing geometry information in delimited text file

Delimited text files can contain geometry information in two main forms:

• As coordinates in separate columns (eg. Xcol, Ycol. . . ), compatible with point geometry data;

• As well-known text (WKT) representation of geometry in a single column, for any geometry type.
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Features with curved geometries (CircularString, CurvePolygon and CompoundCurve) are supported. Here are
some examples of such geometry types as a delimited text with WKT geometries:

Label;WKT_geom
LineString;LINESTRING(10.0 20.0, 11.0 21.0, 13.0 25.5)
CircularString;CIRCULARSTRING(268 415,227 505,227 406)
CurvePolygon;CURVEPOLYGON(CIRCULARSTRING(1 3, 3 5, 4 7, 7 3, 1 3))
CompoundCurve;COMPOUNDCURVE((5 3, 5 13), CIRCULARSTRING(5 13, 7 15,

9 13), (9 13, 9 3), CIRCULARSTRING(9 3, 7 1, 5 3))

Le format texte délimité gère également les coordonnées Z et M dans les géométries:

LINESTRINGZ(10.0 20.0 30.0, 11.0 21.0 31.0, 11.0 22.0 30.0)

Using CSVT file to control field formatting

Lors du chargement de fichiers CSV, le pilote OGR suppose que tous les champs sont des chaînes de caractères
(c’est-à-dire du texte), sauf indication contraire. Vous pouvez créer un fichier CSVT pour indiquer à OGR (et à
QGIS) le type de données correspondant aux différentes colonnes:

Type Nom Exemple
Nombre entier Entier 4
Nombre décimal Réel 3.456
Date Date (YYYY-MM-DD) 2016-07-28
Temps Temps (HH:MM:SS+nn) 18:33:12+00
Date & Heure DateTime (YYYY-MM-DD HH:MM:SS+nn) 2016-07-28 18:33:12+00

Le fichier CSVT est un fichier texte brut d”UNE ligne avec les types de données entre guillemets et séparés par
des virgules, par exemple:

"Integer","Real","String"

Vous pouvez même spécifier la largeur et la précision de chaque colonne, par exemple:

"Integer(6)","Real(5.5)","String(22)"

Ce fichier est sauvegardé dans le même dossier que le fichier .csv, avec le même nom, mais en tant qu’extension
.csvt

Vous trouverez plus d’informations à Pilote CSV de GDAL.

Couches PostGIS

Les couches PostGIS sont stockées dans une base de données PostgreSQL. Les avantages de PostGIS sont les
possibilités d’indexation spatiale, de filtre et de requête qu’il fournit. En utilisant PostGIS, les fonctions vecteur
telles que la sélection ou l’identification fonctionnent avec plus de précision qu’avec les couches OGR dans QGIS.

Astuce: Couches PostGIS

Normalement, une couche PostGIS est définie par une entrée dans la table geometry_columns. QGIS peut cepen-
dant charger des couches qui n’ont pas d’entrée dans la table geometry_columns. Ceci concerne aussi bien les
tables que les vues. Définir une vue spatiale fournit un moyen puissant pour visualiser vos données. Référez-vous
à votre manuel PostgreSQL pour plus d’informations sur la création des vues.

Cette section fournit quelques détails sur la manière dont QGIS accède aux couches PostgreSQL. La plupart du
temps, QGIS devrait simplement fournir une liste des tables de la base de données qui peuvent être chargées et il
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les chargera à la demande. Cependant, si vous avez des problèmes pour charger une table PostgreSQL dans QGIS,
les informations données ci-dessous peuvent vous aider à comprendre les messages de QGIS et vous donner une
indication sur comment changer la table ou la vue PostgreSQL pour qu’elle se charge dans QGIS.

Clé primaire

QGIS demande que les couches PostgreSQL aient un champ pouvant être utilisé comme clé unique pour la couche.
Pour les tables, cela signifie qu’elles doivent avoir une clé primaire ou un champ ayant une contrainte d’unicité. De
plus, QGIS impose que cette colonne soit de type int4 (un entier de 4 octets). Alternativement, la colonne ctid peut
être utilisée comme clé primaire. Si une table ne respecte pas ces conditions, le champ oid sera utilisé à la place.
Les performances seront améliorées si le champ est indexé (notez que les clés primaires sont automatiquement
indexées dans PostgreSQL).

QGIS propose une case à cocher Sélectionner par identifiant qui est activée par défaut. Cette option permet de
récupérer les identifiants sans les attributs, ce qui est plus rapide dans la plupart des cas.

Vue

Si la couche PostgreSQL est une vue, les mêmes conditions s’appliquent, mais elles n’ont pas toujours de clé
primaire ou de champ ayant une contrainte d’unicité. Dans ce cas, vous devez définir une clé primaire (de type
entier) avant de charger la vue. Si aucun champ ne convient, QGIS ne chargera pas la vue. Si cela arrive, la
solution est de modifier la vue de sorte qu’elle inclue un champ qui convient (de type entier et qui soit une clé
primaire ou ayant une contrainte d’unicité, de préférence indexé).

Comme pour les tables, une case à cocher Sélectionner par identifiant est activée par défaut (voir ci-dessus pour
la signification de la case à cocher). Ça peut avoir du sens de désactiver cette option lorsque vous utilisez des vues
coûteuses.

Table QGIS layer_style et sauvegarde de la base de données

Si vous voulez faire une sauvegarde de votre base de données PostGIS en utilisant les commandes pg_dump et
pg_restore et que les styles par défaut des couches sauvés par QGIS ne sont pas restaurés, vous devez définir
l’option XML à DOCUMENT et la restauration fonctionnera.

SET XML OPTION DOCUMENT;

Filter database side

QGIS permet de filtrer les entités directement côté serveur. Cochez l’option Settings → Options → Data Sources

→ Exécuter les expressions du côté du serveur postgres si possible pour l’activer. Seules les expressions
supportées seront envoyées à la base de données. Les expressions qui utilisent des opérateurs ou des fonctions non
prises en compte seront évaluées en local.

Types de données supportés par PostgreSQL

Most of common data types are supported by the PostgreSQL provider: integer, float, varchar, geometry, times-
tamp, array and hstore.

Importer des données dans PostgreSQL

Différents outils, notamment le Gestionnaire de bases de données (BD Manager plugin) ou les outils en ligne
de commande comme sh2pgsql ou ogr2ogr, permettent d’importer les données dans une base de données Post-
greSQL/PostGIS.
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DB Manager

QGIS comes with a core plugin named DB Manager. It can be used to load data, and it includes support for
schemas. See section DB Manager Plugin for more information.

shp2pgsql

PostGIS includes an utility called shp2pgsql that can be used to import Shapefile format datasets into a PostGIS-
enabled database. For example, to import a Shapefile format dataset named lakes.shp into a PostgreSQL
database named gis_data, use the following command:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data

Ceci crée une nouvelle couche nommée lakes_new dans la base de données gis_data. La nouvelle couche
aura l’identifiant de référence spatiale (SRID) 2964. Référez-vous à la section Utiliser les projections pour plus
d’informations sur les systèmes de référence spatiale et les projections.

Astuce: Exporter des jeux de données depuis PostGIS

Like the import tool shp2pgsql, there is also a tool to export PostGIS datasets in the Shapefile format: pgsql2shp.
This is shipped within your PostGIS distribution.

ogr2ogr

En plus de shp2pgsql et DB Manager, un autre outil est fourni pour importer des données géographiques dans
PostGIS : ogr2ogr. Il est inclus dans GDAL.

To import a Shapefile format dataset into PostGIS, do the following:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

This will import the Shapefile format dataset alaska.shp into the PostGIS database postgis using the user
postgres with the password topsecret on host server myhost.de.

Notez qu’OGR doit être compilé avec PostgreSQL pour gérer PostGIS. Vous pouvez le vérifier en tapant (sous

)

ogrinfo --formats | grep -i post

Si vous préférez utiliser la commande COPY de PostgreSQL au lieu de la méthode INSERT INTO par défaut,

vous pouvez exporter la variable d’environnement suivante (au moins sur et ) :

export PG_USE_COPY=YES

ogr2ogr ne crée pas d’index spatial comme le fait shp2pgsl. Vous devez donc effectuer une étape supplémentaire
en le créant manuellement avec la commande SQL classique CREATE INDEX (comme détaillé dans la section
suivante Améliorer les performances).

Améliorer les performances

Retrieving features from a PostgreSQL database can be time-consuming, especially over a network. You can
improve the drawing performance of PostgreSQL layers by ensuring that a PostGIS spatial index exists on each
layer in the database. PostGIS supports creation of a GiST (Generalized Search Tree) index to speed up spatial
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searches of the data (GiST index information is taken from the PostGIS documentation available at https://postgis.
net).

Astuce: You can use the DBManager to create an index to your layer. You should first select the layer and click
on Table → Edit table, go to Indexes tab and click on Add Spatial Index.

La syntaxe pour créer un index GiST est la suivante :

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Notez que pour de grandes tables, créer un index peut prendre du temps. Une fois cet index créé, vous devriez
faire une VACUUM ANALYZE. Référez-vous à la documentation de PostGIS (POSTGIS-PROJECT Bibliographie)
pour plus d’informations.

Voici un exemple de création d’un index GiST

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

Couches vectorielles franchissant la ligne des 180° de longitude

Many GIS packages don’t wrap vector maps with a geographic reference system (lat/lon) crossing the 180 degrees
longitude line (http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). As result, if
we open such a map in QGIS, we will see two far, distinct locations, that should appear near each other. In
Figure_vector_crossing, the tiny point on the far left of the map canvas (Chatham Islands) should be within the
grid, to the right of the New Zealand main islands.

Figure 12.19: Carte en lat/lon de part et d’autre de la ligne des 180° longitude

Une solution est de transformer les valeurs longitudinales en utilisant PostGIS et la fonction ST_Shift_Longitude.
Cette fonction lit chaque point/sommet de chacune des entités dans une géométrie et si la coordonnée de longitude
est inférieure à 0°, elle lui ajoute 360°. Le résultat est une version 0° - 360° des données sur une carte centrée à
180°.
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Figure 12.20: Traversée de la longitude 180° en utilisant la fonction ST_Shift_Longitude

Usage

• Importer des données dans PostGIS (Importer des données dans PostgreSQL) en utilisant, par exemple,
l’extension DB Manager.

• Utiliser l’interface en ligne de commande PostGIS pour exécuter la commande suivante (dans cet ex-
emple, « TABLE » est bien le nom de votre table PostGIS): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);

• Si tout s’est bien passé, vous devriez recevoir une confirmation sur le nombre d’entités qui ont été mises à
jour. Ensuite, vous pouvez charger la carte et voir la différence (Figure_vector_crossing_map).

Couches SpatiaLite

If you want to save a vector layer to SpatiaLite format, you can do this by right clicking the layer in the legend.
Then, click on Save as. . . , define the name of the output file, and select “SpatiaLite” as format and the CRS. Also,
you can select “SQLite” as format and then add SPATIALITE=YES in the OGR data source creation option field.
This tells OGR to create a SpatiaLite database. See also https://www.gdal.org/ogr/drv_sqlite.html.

QGIS gère les vues SpatiaLite éditables.

Si vous souhaitez créer une nouvelle couche SpatiaLite, référez-vous à la section Créer une nouvelle couche
SpatiaLite.

Astuce: Extensions de gestion de données SpatiaLite

Pour gérer des données SpatiaLite, vous pouvez également utiliser diverses extensions Python : QSpatiaLite,
SpatiaLite Manager ou Gestionnaire de base de données (extension principale, recommandée). Elles peuvent
toutes être téléchargées et installées via le Gestionnaire d’extensions.

GeoJSON specific parameters

When exporting layers to GeoJSON, this format has some specific Layer Options available. These options actually
come from GDAL which is responsible for the writing of the file:

• COORDINATE_PRECISION the maximum number of digits after the decimal separator to write in coor-
dinates. Defaults to 15 (note: for Lat Lon coordinates 6 is considered enough). Truncation will occur to
remove trailing zeros.

• WRITE_BBOX set to YES to write a bbox property with the bounding box of the geometries at the feature
and feature collection level
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Couches DB2 Spatial

IBM DB2 for Linux, Unix and Windows (DB2 LUW), IBM DB2 for z/OS (mainframe) and IBM DashDB products
allow users to store and analyse spatial data in relational table columns. The DB2 provider for QGIS supports the
full range of visualization, analysis and manipulation of spatial data in these databases.

User documentation on these capabilities can be found at the DB2 z/OS KnowledgeCenter, DB2 LUW Knowl-
edgeCenter and DB2 DashDB KnowledgeCenter.

For more information about working with the DB2 spatial capabilities, check out the DB2 Spatial Tutorial on IBM
DeveloperWorks.

The DB2 provider currently only supports the Windows environment through the Windows ODBC driver.

The client running QGIS needs to have one of the following installed:

• DB2 LUW

• IBM Data Server Driver Package

• IBM Data Server Client

To open a DB2 data in QGIS, you can refer to The Browser Panel or Loading a Database Layer section.

If you are accessing a DB2 LUW database on the same machine or using DB2 LUW as a client, the DB2 executa-
bles and supporting files need to be included in the Windows path. This can be done by creating a batch file like
the following with the name db2.bat and including it in the directory %OSGEO4W_ROOT%/etc/ini.

@echo off
REM Point the following to where DB2 is installed
SET db2path=C:\Program Files (x86)\sqllib
REM This should usually be ok - modify if necessary
SET gskpath=C:\Program Files (x86)\ibm\gsk8
SET Path=%db2path%\BIN;%db2path%\FUNCTION;%gskpath%\lib64;%gskpath%\lib;%path%
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CHAPTER 13

Les données vectorielles

13.1 Le Gestionnaire de symboles

13.1.1 Le Gestionnaire de style

The Style Manager is the place where users can manage and create generic symbols and color ramps to be used in
several QGIS projects. You can open that modeless dialog:

• with the Style Manager button of the Project toolbar;

• from the Settings → Style Manager. . . menu;

• or from a vector Layer Properties → Symbology tab (using the Style Manager button in a symbol property
dialog).

The dialog allows you to:

• create, edit and remove symbols and color ramps;

• organize symbols and color ramps in custom groups;

• export and import symbols and color ramps.

Organizing symbols and color ramps

The Style Manager dialog displays in its center a frame with previewed items organized into tabs:

• All for a complete collection of point, linear and surface symbols as the following items allow only to display
a single item group;

• Marker for point symbols;

• Line for linear symbols;

• Fill for surface symbols;

• and Color ramp
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Figure 13.1: Le Gestionnaire de style

For each family of items, you can organize the elements into different categories, listed in the panel on the left:

• Favorites: displayed by default when configuring an item, it shows a set of default symbols and color ramps
you can extend;

• All: listing all the installed symbols and color ramps;

• Tags: shows a list of labels you can use to identify the items. A symbol or color ramp can be tagged more
than once. Select a tag in the list and you’ll see the items that belong to it for each type of item. To create a

new tag you could later attach to symbols or color ramps, use the Add Tag. . . button or select the Add
Tag. . . from any tag contextual menu;

• Smart Group: a smart group dynamically fetches its symbols according to conditions set (see eg, fig-
ure_smart_group). Click the Add Smart Group. . . button to create smart groups. The dialog box allows you
to enter an expression to filter the items to select (has a particular tag, have a string in its name, etc.). Any
symbol or color ramp that satisfies the entered condition(s) is automatically added to the smart group.

Figure 13.2: Créer un Groupe Intelligent

Tags and smart groups are not mutually exclusive: they are simply two different ways to organize your symbols and
color ramps. Unlike the smart groups that automatically fetch their belonged items based on the input constraints,
tags are filled by the user. To edit any of those categories, you can either:

• select the items, right-click and choose Add to Tag → and then select the tag name or create a new tag;
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• select the tag and press Modify group. . . → Attach Selected Tag to Symbols. A checkbox appears near
each item to help you select or deselect it. When selection is finished, press Modify group. . . → Finish
Tagging.

• select the smart group, press Modify group. . . → Edit smart group. . . and configure a new set of constraints
in the Smart Group Editor dialog. This option is also available in the contextual menu of the smart group.

To remove a tag or a smart group, right-click on it and select the Remove button. Note that this does not delete
the items grouped in the category.

Adding, editing or removing an item

As seen earlier, symbols and color ramps are listed under different tabs whose contents depend on the active
category (tag, smart group, favorites. . . ). For each type of symbols (Marker , Line or Fill) and color ramp, when
the tab is enabled, you can:

• Add new items: press the Add item button and configure the item following symbols or color ramps
builder description.

• Modify an existing item: select an item and press Edit item button and configure as mentioned above.

• Delete existing items: to delete a symbol you no longer need, select it and click Remove item (also available
through right-click). The symbol will be deleted from the local symbols database.

Right-clicking over a selection of items also allows you to:

• Add to Favorites;

• Remove from Favorites;

• Add to Tag → and select the appropriate tag or create a new one to use;

• Clear Tags: detaching the symbols from any tag;

• Remove Item(s);

• Edit Item: applies to the item you right-click over;

• Export Selected Symbol(s) as PNG. . . (not available with color ramps);

• Export Selected Symbol(s) as SVG. . . (not available with color ramps);

Sharing symbols and color ramps

The Import/Export tool, at the left bottom of the Style Manager dialog, offers options to easily share symbols
and color ramps with others. These options are also available through right-click over the items.

Exporting items

You can export a set of items to an .XML file:

1. Expand the Import/Export drop-down menu and select Export Item(s). . .

2. Choose the symbols and color ramps you’d like to integrate. Symbol selection can be done with the mouse
or using a tag or group previously set.

3. Press Export when ready. You’ll be prompted to indicate the destination of the saved file. The XML format
generates a single file containing all the selected symbols. This file can then be imported in another user’s
style library.

13.1. Le Gestionnaire de symboles 167



QGIS User Guide, Version 3.4

Figure 13.3: Exporting symbols and color ramps

When symbols are selected, you can also export them to .PNG or .SVG. Exporting to .PNG or .SVG (both not
available for color ramp symbols) creates a file for each selected symbol in a given folder. The SVG folder can be
added to the SVG paths in Settings → Options → System menu of another user, allowing him direct access to all
these symbols.

Importing items

You can extend your symbols library by importing new symbols:

1. Expand the Import/Export drop-down menu and select Import Item(s) at the left bottom of the
dialog.

2. In the new dialog, indicate the source of the symbols (it can be an .xml file on the disk or a url).

3. Set whether to Add to favorites the items to import.

4. Check Do not import embedded tags to avoid the import of tags associated to the items being imported.

5. Give the name of any Additional tag(s) to apply to the new items.

6. Select from the preview the items you want to add to your library.

7. And press Import.

Palettes de couleur

The Color ramp tab in the Style Manager dialog helps you preview different color ramps based on the category
selected in the left panel.

Pour créer une rampe de couleur personnalisée, activez l’onglet Palette de couleur et cliquez sur le bouton
Ajouter objet. Le bouton affiche alors une liste déroulante pour choisir le type de palette de couleur :
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Figure 13.4: Importing symbols and color ramps

• Graduée: génère une palette de couleurs à partir d’une couleur de départ et une couleur de fin, soit de type
continue or discrète. En double-cliquant sur la pré-visualisation de la palette, vous pouvez ajouter autant
de couleurs intermédiaires que vous le souhaitez.

• Color presets: allows to create a color ramp consisting of a list of colors selected by the user;

• Random: creates a random set of colors based on range of values for Hue, Saturation, Value and Opacity
and a number of colors (Classes);

• Catalog: ColorBrewer: a set of predefined discrete color gradients you can customize the number of colors
in the ramp;

• or Catalog: cpt-city: an access to a whole catalog of color gradients to locally save as standard gradient.
The cpt-city option opens a new dialog with hundreds of themes included “out of the box”.

Astuce: Easily adjust the color stops of the gradient color ramp

Double-clicking the ramp preview or drag-and-drop a color from the color spot onto the ramp preview adds a
new color stop. Each color stop can be tweaked using the sélecteur de couleur widgets or by plotting each of its
parameters. You can also reposition it using the mouse, the arrow keys (combine with Shift key for a larger
move) or the Relative position spinbox. Pressing Delete stop as well as DEL key removes the selected color stop.

13.1.2 The Symbol Selector

Le sélecteur de symbole est la boîte de dialogue principale pour construire un symbole. Vous pouvez créer ou
éditer des marqueurs, des lignes ou des symboles de remplissage.

Two main components structure the symbol selector dialog:

• the symbol tree, showing symbol layers that are combined afterwards to shape a new global symbol

• and settings to configure the selected symbol layer in the tree.
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Figure 13.5: Exemple de personnalisation de palette de couleurs graduées avec arrêts multiples
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Figure 13.6: Fenêtre cpt-city et ses centaines de palettes de couleur
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Figure 13.7: Designing a Line symbol
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The symbol layer tree

A symbol can consist of several Symbol layers. The symbol tree shows the overlay of these symbol layers that are
combined afterwards to shape a new global symbol. Besides, a dynamic symbol representation is updated as soon
as symbol properties change.

A set of tools is available to manage the symbol tree items and according to the level selected, you’ll get enabled
different tools at the bottom of the dialog to:

• Ajouter une nouvelle couche de symbole: vous pouvez empiler autant de symboles que vous voulez.

• Supprimer la couche de symbole sélectionnée.

• Verrouiller les couleurs d’une couche de symbole: une couleur verrouillée reste non modifiée lorsque
l’utilisateur modifie la couleur du symbole global (ou supérieur).

• Dupliquer une (un groupe de) couche(s) de symbole.

• Déplacer en haut ou en bas la couche de symbole.

When a symbol layer is selected in the tree, you can also:

• control its visibility with the Enable layer option. Disabled symbol layers are not drawn, but are saved
and can be enabled at a later stage. This makes it easier to customize parts of the symbol based on the
feature attributes or to tweak symbol appearance without having to totally delete a symbol layer;

• apply rendering effects using the Draw effects button.

Configurer un symbole

In QGIS, configuring a symbol is done in two steps: the symbol and then the symbol layer.

The symbol

At the top level of the tree, it depends on the layer geometry and can be of Marker, Line or Fill type. Each
symbol can embed one or more symbols (including, of any other type) or symbol layers.

You can setup some parameters that apply to the global symbol:

• Unit: it can be Millimeter, Points, Pixels, Meters at Scale, Map unit or Inches

• Transparency

• Color: when this parameter is changed by the user, its value is echoed to all unlocked sub-symbols color

• Size and Rotation for marker symbols

• Width for line symbols

Note: The Data-defined override button beside the last layer-related parameters is inactive when setting the
symbol from the Style manager dialog. When the symbol is connected to a map layer, this button helps you create
proportional or multivariate analysis rendering.

The symbols used at this level are items you can pick from the symbols library. Available symbols of the cor-
responding type are shown and, through the editable drop-down list just above, can be filtered by free-form text

or by categories. You can also update the list of symbols using the Style Manager button and open the eponym
dialog. There, you can use any capabilities as exposed in Le Gestionnaire de style section.

The symbols are displayed either:
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• in an icon list (with thumbnail, name and associated tags) using the List View button below the frame;

• or as icon preview using the Icon View button.

Press the Save Symbol button to add any symbol being edited to the symbols library. With the Advanced
option, you can:

• set the symbol levels: defining the way symbol layers are connected to each other in the map canvas (see
Niveaux de symbole for more information)

• and for line and fill symbols, clip features to canvas extent.

Astuce: Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of the whole
symbol can be changed with the Size (for marker symbols) or the Width (for line symbols) menu in the first level
again. The size of the lower levels changes accordingly, while the size ratio is maintained.

The symbol layer

At a lower level of the tree, you can customize the symbol layers. The available symbol layer types depend on the

upper symbol type. You can apply on the symbol layer paint effects to enhance its rendering.

Because describing all the options of all the symbol layer types would not be possible, only particular and signifi-
cant ones are mentioned below.

Common parameters

Some common options and widgets are available to build a symbol layer, regardless it’s of marker, line or fill
sub-type:

• the color selector widget to ease color manipulation

• Units: it can be Millimeter, Points, Pixels, Meters at Scale, Map unit or Inches

• the data-defined override widget near almost all options, extending capabilities of customizing each symbol
(see Valeurs définies par des données for more information)

Note: While the description below assumes that the symbol layer type is bound to the feature geometry, keep
in mind that you can embed symbol layers in each others. In that case, the lower level symbol layer parameter
(placement, offset. . . ) might be bound to the upper-level symbol, and not to the feature geometry itself.

Symboles ponctuels

Appropriate for point geometry features, marker symbols have several Symbol layer types:

• Simple marker (default);

• Ellipse marker: a simple marker symbol layer, with customizable width and height;

• Filled marker: similar to the simple marker symbol layer, except that it uses a fill sub symbol to render the
marker. This allows use of all the existing QGIS fill (and stroke) styles for rendering markers, e.g. gradient
or shapeburst fills;

• Font marker: use installed fonts as marker symbols;

• Geometry generator (see The Geometry Generator);

• Vector Field marker (see The Vector Field Marker);
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• SVG marker: provides you with images from your SVG paths (set in Settings → Options. . . → System
menu) to render as marker symbol. Width and height of the symbol can be set independently or using the

Lock aspect ratio. Each SVG file colors and stroke can also be adapted.

Note: SVG version requirements

QGIS renders SVG files that follow the SVG Tiny 1.2 profile, intended for implementation on a range of
devices, from cellphones and PDAs to laptop and desktop computers, and thus includes a subset of the
features included in SVG 1.1 Full, along with new features to extend the capabilities of SVG.

Some features not included in these specifications might not be rendered correctly in QGIS.

Astuce: Enable SVG marker symbol customization

To have the possibility to change the colors of a SVG marker, you have to add the placeholders
param(fill) for fill color, param(outline) for stroke color and param(outline-width) for
stroke width. These placeholders can optionally be followed by a default value, e.g.:

<svg width="100%" height="100%">
<rect fill="param(fill) #ff0000" stroke="param(outline) #00ff00" stroke-width=
→˓"param(outline-width) 10" width="100" height="100">
</rect>
</svg>

For each marker symbol layer type, you can set some of the following properties:

• Taille

• Fill color using all the capabilities of the sélecteur de couleur widget, extended by a shortcut to apply a
Transparent fill in the drop-down menu;

• Stroke color using all the capabilities of the color selector widget, extended by a shortcut to apply a Trans-
parent stroke in the drop-down menu;

• Stroke style

• Stroke width

• Style de jointure

• Rotation

• Offset: You can shift the symbol in the X or Y direction;

• Point d’ancrage.

In most of the marker symbols dialog, you also have a frame with previews of predefined symbols you can choose
from.

Symboles de ligne

Appropriate for line geometry features, line symbols have following symbol layer types:

• Simple line (default): available settings are:

– Couleur

– Stroke width

– Stroke style

– Style de jointure

– Style de fin de ligne
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– Décalage

– Use custom dash pattern: overrides the Stroke style setting with a custom dash.

• Arrow: draws lines as curved (or not) arrows with a single or a double head with configurable width, length
and thickness. To create a curved arrow the line feature must have at least three vertices. It also uses a fill
symbol such as gradients or shapeburst to render the arrow body. Combined with the geometry generator,
this type of layer symbol helps you representing flow maps;

• Geometry generator (see The Geometry Generator);

• Marker line: displays a marker symbol along the line. It can be at a regular distance or based on its
geometry: first, last or each vertex, on central point or on every curve point. You can set an offset along the
line for the marker symbol, or offset the line itself. The Rotate marker option allows you to set whether the
marker symbol should follow the line orientation or not.

Fill Symbols

Appropriate for polygon geometry features, fill symbols have also several symbol layer types:

• Simple fill (default): the following settings are available:

– Fill color using all the capabilities of the sélecteur de couleur widget, extended by a shortcut to apply
a Transparent fill

– Style de remplissage

– Stroke color using all the capabilities of the color selector widget, extended by a shortcut to apply a
Transparent stroke

– Stroke width

– Stroke style

– Style de jointure

– Offset: You can shift the symbol in the X or Y direction;

• Centroid fill: places a marker symbol at the centroid of the visible feature. The position of the marker may
however not be the real centroid of the feature because calculation takes into account the polygon(s) clipped
to area visible in map canvas for rendering and ignores holes. Use the geometry generator symbol if you
want the exact centroid.

The marker can be placed on every part of a multi-part feature or only on its biggest part, and forced to be
inside the polygon;

• Geometry generator (see The Geometry Generator);

• Gradient fill: uses a radial, linear or conical gradient, based on either simple two color gradients or a
predefined gradient color ramp to fill polygon layers. Gradient can be rotated and applied on a single
feature basis or across the whole map extent. Also start and end points can be set via coordinates or using
the centroid (of feature or map);

• Line pattern fill: fills the polygon with a hatching pattern of line symbol layer. You can set the spacing
between lines and an offset from the feature boundary;

• Point pattern fill: fills the polygon with a hatching pattern of marker symbol layer. You can set the spacing
between lines and an offset from the feature boundary;

• Raster image fill: you can fill polygons with a tiled raster image. Options include (data defined) file name,
opacity, image size (in pixels, mm or map units), coordinate mode (feature or view) and rotation;

• SVG fill: fills the polygon using SVG markers;

• Shapeburst fill: this option buffered a gradient fill, where a gradient is drawn from the boundary of a
polygon towards the polygon’s centre. Configurable parameters include distance from the boundary to
shade, use of color ramps or simple two color gradients, optional blurring of the fill and offsets;
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• Outline: Arrow: uses a line arrow symbol layer to represent the polygon boundary;

• Outline: Marker line: uses a marker line symbol layer to represent the polygon boundary;

• Outline: simple line: uses a simple line symbol layer to represent the polygon boundary. The Draw line
only inside polygon option helps polygon borders inside the polygon and can be useful to clearly represent
adjacent polygon boundaries.

Note: When geometry type is polygon, you can choose to disable the automatic clipping of lines/polygons to the
canvas extent. In some cases this clipping results in unfavourable symbology (e.g. centroid fills where the centroid
must always be the actual feature’s centroid).

The Geometry Generator

Available with all types of symbols, the geometry generator symbol layer allows to use expression syntax to
generate a geometry on the fly during the rendering process. The resulting geometry does not have to match with
the original geometry type and you can add several differently modified symbol layers on top of each other.

Some examples:

-- render the centroid of a feature
centroid( $geometry )

-- visually overlap features within a 100 map units distance from a point
-- feature, i.e generate a 100m buffer around the point
buffer( $geometry, 100 )

-- Given polygon layer1( id1, layer2_id, ...) and layer2( id2, fieldn...)
-- render layer1 with a line joining centroids of both where layer2_id = id2
make_line( centroid( $geometry ),

centroid( geometry( get_feature( 'layer2', 'id2', attribute(
$currentfeature, 'layer2_id') ) )

)

The Vector Field Marker

The vector field marker is used to display vector field data such as earth deformation, tidal flows, and the like.
It displays the vectors as lines (preferably arrows) that are scaled and oriented according to selected attributes of
data points. It can only be used to render point data; line and polygon layers are not drawn by this symbology.

The vector field is defined by attributes in the data, which can represent the field either by:

• cartesian components (x and y components of the field)

• or polar coordinates: in this case, attributes define Length and Angle. The angle may be measured either
clockwise from north, or Counterclockwise from east, and may be either in degrees or radians.

• or as height only data, which displays a vertical arrow scaled using an attribute of the data. This is appro-
priate for displaying the vertical component of deformation, for example.

The magnitude of field can be scaled up or down to an appropriate size for viewing the field.

13.2 Fenêtre Propriétés d’une couche vecteur

La fenêtre de Propriétés d’une couche vectorielle permet d’accéder aux paramètres généraux pour gérer
l’apparence des entités de la couche sur la carte (style, étiquetage, diagrammes) et les interactions avec la souris
(actions, infobulles, formulaires). Elle fournit également des informations sur la couche.
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Pour ouvrir la boîte de dialogue Propriétés de la couche vectorielle :

• Dans le panneau Couches, effectuez un double-clic ou un clic droit et sélectionner Propriétés de la couche
depuis le menu contextuel.

• Allez dans le menu Couche → Propriétés. . . quand la couche est sélectionnée.

La boîte de dialogue Propriétés de la couche vecteur choisie propose les sections suivantes :

• Information

• Source

• Symbologie (également disponible dans le Panneau de style de couche)

• Étiquettes (également disponible dans le Panneau de style de couche)

• Diagrammes

• Vue 3D (également disponible dans le Panneau de style de couche)

• Champs source

• Formulaire d’attributs

• Jointures

• Stockage auxiliaire

• Actions

• Infobulles

• Rendu

• Variables

• Métadonnées

• Dépendances

• Légende

• QGIS Server

• Numérisation

• et optionnellement, de nouvelles sections ajoutées par des Extensions que vous avez installées. Elles ne sont
pas présentées ci-dessous.

Astuce: **Partager tout ou partie des propriétés des styles de la couche **

Le menu Style en bas de la fenêtre vous permet d’importer ou exporter toutes ou certaines des propriétés
depuis/vers plusieurs destinations (fichier, presse-papier, base de données). Voir Gestion des styles personnal-
isés.

Note: Vu que les propriétés (symbologie, étiquette, actions, valeurs par défaut, formulaires,. . . ) des couches
provenant d’un projet incorporé (Voir Inclusion de projets) sont issues et liées au projet d’origine, et pour éviter
des changements qui pourraient casser ce fonctionnement, les propriétés de ces couches ne sont pas accessibles.
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13.2.1 Onglet Informations

L’onglet Information , en lecture seule, permet de connaitre rapidement les informations et métadonnées
résumées sur la couche courante. Les informations fournies sont :

• suivant le fournisseur de la couche (format et chemin de stockage, type de géométrie , encodage, emprise
. . . );

• extraits des Propriétés des metadonnées (accès, liens, contacts, historique..);

• soit en fonction de sa géométrie (emprise spatiale, SCR. . . ) ou de ses attributs (nombre de champs, carac-
téristiques de chacun. . . ).

13.2.2 Onglet Source

Utilisez cet onglet pour définir les paramètres de la couche vectorielle.

Figure 13.8: Onglet Source de la fenêtre Propriétés de la couche vectorielle

Outre le Nom de la couche qui sera affiché dans le Panneau couches, les options sont:

Système de Coordonnées de Référence

• Affiche le Système de Coordonnées de Référence (SCR) de la couche sous la forme d’une chaîne PROJ.4.
Vous pouvez changer le SRC de la couche, en sélectionnant un de ceux récemment utilisés dans la liste

déroulante ou en cliquant sur le bouton Sélectionner le SRC (voir Sélectionneur de système de coordonnées
de référence). Utilisez ce processus uniquement si le SCR appliqué à la couche est erroné ou si aucun
ne l’a été. Si vous souhaitez reprojeter vos données dans un autre SCR, utilisez plutôt les algorithmes de
reprojection de couche dans la boite de traitements ou Sauvegarder dans une nouvelle couche.

• Créer un index spatial (uniquement pour les formats gérés par OGR ).

• Mise à jour de l’emprise de la couche.
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Constructeur de requête

Le Constructeur de requête est accessible par le bouton éponyme en bas de l’onglet Source dans les Propriétés de
la couche, sous le groupe Filtre d’entités du fournisseur de données.

Le Constructeur de requête fournit une interface qui vous permet de définir un sous-ensemble d’entités dans la
couche en utilisant une clause WHERE de type SQL et d’afficher le résultat dans la fenêtre principale. Tant que le
filtre est actif, seules les entités filtrées sont disponibles dans le projet. Par exemple, en utilisant le champ TYPE_2
de la couche regions du jeu de données d’exemple de la documentation, vous pouvez limiter l’affichage unique-
ment aux régions qui ont le type borough (voir l’illustration Figure_vector_querybuilder ). Le filtre est réalisé
au niveau du fournisseur de données (OGR, PostgreSQL, MSSQL. . . ).

Figure 13.9: Constructeur de requête

You can also open the Query Builder dialog using the Filter. . . option from the Layer menu or the layer contextual
menu. The Fields, Values and Operators sections in the dialog help you to construct the SQL-like query exposed
in the Provider specific filter expression box.

La liste Champs contient tous les champs de la couche. Pour ajouter un champ dans l’expression de filtrage SQL,
double-cliquez sur son nom ou tapez-le simplement dans la zone SQL.

La liste Valeurs contient les valeurs du champ actuellement sélectionné. Pour lister toutes les valeurs uniques
d’un champ, cliquez sur le bouton Tout. Pour lister les 25 premières valeurs uniques du champ, cliquez sur le
bouton Échantillon. Pour ajouter une valeur dans l’expression de filtrage SQL, double-cliquez sur son nom dans
la liste Valeurs. Vous pouvez utiliser la boîte de recherche en haut du cadre Valeurs pour naviguer facilement et
trouver les valeurs d’attribut dans la liste.

La section Opérateurs contient tous les opérateurs utilisables. Pour ajouter un opérateur à l’expression de filtrage
SQL, cliquez sur le bouton approprié. Les opérateurs relationnels ( =, `>, . . . ), les opérateurs de comparaison de
chaînes (LIKE) et les opérateurs logiques (AND, OR, . . . ) sont disponibles.

Le bouton Test vous aide à vérifier votre requête et affiche un message avec le nombre d’entités satisfaisant la
requête. Utilisez le bouton Effacer pour effacer la requête SQL et réinitialiser la couche à son état d’origine
(c’est-à-dire, charger toutes les entités).

Lorsqu’un filtre est appliqué, QGIS traite le sous-ensemble résultant comme s’il s’agissait de la couche entière.
Par exemple, si vous avez appliqué le filtre ci-dessus pour « Borough » ("TYPE_2" ='Borough'), vous ne
pouvez pas afficher, interroger, sauvegarder ou modifier la ville Anchorage, car c’est une “municipalité” et ne
fait donc pas partie du sous-ensemble Borough (Arrondissement).
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Astuce: Les couches filtrées sont indiquées dans le panneau des couches.

Dans le panneau Couches, la couche filtrée apparaît avec une icône Filtre sur le côté affichant la requête utilisée
lorsque vous la survolez avec la souris. Double-cliquez sur l’icône pour ouvrir la boîte de dialogue Constructeur
de requête afin de modifier le filtre.

13.2.3 Onglet Symbologie

L’onglet Symbologie vous offre un outil complet pour symboliser vos données vectorielles. Vous pouvez
utiliser des outils communs à toutes les données vectorielles, ainsi que des outils de symbolisation spéciaux qui ont
été conçus pour les différents types de données vectorielles. Ainsi, tous les types de vecteur partagent la structure
de dialogue suivante : dans la partie supérieure, vous pouvez définir la classification et le symbole à utiliser pour
les entités et dans la partie inférieure, le Rendu de couche.

Astuce: Passer rapidement d’un style de représentation à un autre pour une couche

En utilisant le menu Styles → Ajouter en bas de la boîte de dialogue Propriétés de la couche, vous pouvez
enregistrer autant de styles que nécessaire. Un style est la combinaison de toutes les propriétés de la couche
(comme la symbologie, l’étiquetage, le diagramme, le formulaire des champs, les actions. . . ) que vous voulez.
Ensuite, il suffit de passer d’un style à l’autre dans le menu contextuel de la couche du Panneau des couches pour
obtenir automatiquement différentes représentations de vos données.

Astuce: Exporter le style d’une couche vecteur

Vous avez la possibilité d’exporter la symbologie d’une couche vecteur de QGIS vers les fichiers *.kml de Google,
*.dxf et *.tab de MapInfo. Il suffit d’un clic droit sur la couche, puis de cliquer sur Enregistrer sous → pour spé-
cifier le nom du fichier de sortie et son format. Dans la boîte de dialogue, utilisez l’option Exporter la symbologie
pour enregistrer la symbologie comme Symbologie de l’entité ou comme Symbologie de la couche de symboles.
Si vous avez utilisé des couches de symboles, il est recommandé d’utiliser le deuxième paramètre.

Rendu d’entités

Le moteur de rendu est responsable du dessin de chaque entité avec le symbole correct. Quel que soit le type de
géométrie de la couche, il existe quatre types communs de rendus : symbole unique, catégorisé, gradué et basé sur
des règles. Pour les couches de points,le déplacement de point et le rendu par carte de chaleur sont disponibles,
tandis que les couches de polygones peuvent également être affichées avec les polygones inversés et le 2.5 D.

Il n’y a pas de rendu de couleur continue, car il s’agit en fait d’un cas particulier du rendu gradué. Les rendus
catégorisé et gradué peuvent être créés en spécifiant un symbole et un dégradé de couleurs qui définissent les
couleurs pour les symboles de manière appropriée. Pour chaque type de données (points, lignes et polygones), des
types de couches de symboles vectoriels sont disponibles. Selon le moteur de rendu choisi, la boite de dialogue
fournit différentes sections supplémentaires.

Note: Si, en travaillant sur le style d’une couche vectorielle, vous changez de mode de rendu, les changements
effectués sur le symbole sont mémorisés. Notez que cela ne fonctionne qu’une seule fois. Si vous changez à
nouveau de mode de rendu, les paramètres seront perdus.
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Rendu Symbole Unique

Le moteur de rendu Symbole unique est utilisé pour définir et rendre de manière identique toutes les entités
de la couche. Voir The Symbol Selector pour plus d’informations sur la représentation des symboles.

Figure 13.10: Propriétés « Symbole Unique » de ligne

Astuce: Modifier la symbologie depuis le panneau Couches

Si dans le Panneau des couches, vous avez des couches avec une symbologie catégorisée, graduée ou basée sur
des règles, vous pouvez rapidement changer la couleur de remplissage du symbole d’une catégorie en faisant un

clic droit sur une catégorie et choisir la couleur que vous préférez dans un menu palette de couleurs. Un clic droit
sur une catégorie vous donnera également accès aux options Masquer tous les items, Afficher tous les items et
Éditer le symbole.

Aucun rendu de symbole

Le type de rendu Aucun Symbole est un cas particulier du rendu en Symbole unique car il applique le même
style à toutes les entités. Avec ce rendu, aucun symbole ne sera dessiné pour représenter les entités mais les
étiquettes, les diagrammes et tout ce qui ne concerne pas les symboles seront affichés.

Il est toujours possible de faire des sélections sur la couche dans le canevas et les entités sélectionnées seront
affichées avec un symbole par défaut. Les entités en cours d’édition seront également affichées.

Cela permet de faire un raccourci pour les couches dont vous voulez uniquement afficher les étiquettes ou les
diagrammes et évite de générer des symboles avec un remplissage/bordure complètement transparent.
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Rendu Catégorisé

Le moteur de rendu Catégorisé est utilisé pour afficher les entités d’une couche en utilisant un symbole défini
par l’utilisateur à partir des valeurs distinctes d’un champ ou d’une expression. Le menu Catégorisé vous permet
de

• sélectionner un champ existant (en utilisant la liste déroulante Colonne) ;

• saisir ou construire une expression à l’aide du Calculateur d’expressions. Le résultat de l’expression peut être
de n’importe quel type, par exemple :

– être une comparaison comme monChamp >= 100, $id = @atlas_featureid, monChamp
% 2 = 0, within( $geometry, @atlas_geometry ). Dans ce cas, QGIS renvoie les
valeurs 1 (Vrai) ou 0 (Faux).

– combiner différents champs, comme concat( champ1, ' ', champ2 ), particulièrement
utile lorsque vous souhaitez classer vos entités sur les valeurs de deux ou plusieurs champs en même
temps.

– être un résultat d’un calcul de champs, comme monChamp % 2, year( monChamp ), champ_1
+ champ_2.

– transformer des valeurs continues en classes discrètes, comme :

CASE WHEN x > 1000 THEN 'Big' ELSE 'Small' END

– combiner plusieurs valeurs discrètes en une seule catégorie, comme :

CASE
WHEN building IN ('residence', 'mobile home') THEN 'residential'
WHEN building IN ('commercial', 'industrial') THEN 'Commercial and
→˓Industrial'
END

Note: Même si vous pouvez utiliser n’importe quel type d’expression pour classer vos entités, pour les
expressions les plus complexes, il est sans doute plus simple d’utiliser le rendu basé sur des règles.

• choisir le symbole (en utilisant la fenêtre The Symbol Selector) qui sera utilisé comme symbole de base pour
chaque classe ;

• les couleurs (en utilisant la liste des palettes de couleur) parmi lesquelles la couleur appliquée au symbole
est choisie.

Cliquez ensuite sur le bouton Classer afin de générer les classes pour toutes les valeurs différentes trouvées dans le
champ de la table attributaire. Chaque classe peut être désactivée en décochant la case située à gauche du symbole
de classe.

Pour changer le symbole, la valeur et / ou la légende, double-cliquez sur l’élément à modifier.

Un clic-droit vous propose de Copier / Coller, Modifier la couleur, Modifier la transparence, Modifier l’unité
de sortie ou Modifier la taille.

L’exemple de la figure figure_categorized_symbology montre le rendu des catégories de la couche des rivières de
l’échantillon de données de QGIS.

Astuce: Sélectionner et modifier plusieurs symboles

Il est possible de sélectionner plusieurs symboles, de faire un clic-droit dessus et de changer en une seule opération
leur couleur, leur transparence, leur taille ou leur épaisseur.
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Figure 13.11: Options du mode de rendu Catégorisé

Astuce: Apparier les catégories aux noms de symboles

Dans le menu [Avancé], sous les classes, vous pouvez choisir l’une des deux premières actions pour faire corre-
spondre le nom du symbole à un nom de catégorie de la classification. Apparier aux symboles sauvegardés fait
correspondre un nom de catégorie avec un nom de symbole du Gestionnaire de symboles. Apparier aux symboles
à partir du fichier fait correspondre un nom de catégorie à un nom de symbole dans un fichier externe de symboles.

Rendu Gradué

Le rendu gradué Gradué est utilisé pour afficher toutes les entités de la couche, en faisant varier la couleur ou
la taille de symbole suivant la classe de valeurs à laquelle l’entité appartient.

De la même manière que le rendu catégorisé, le rendu Gradué permet de faire varier l’angle de rotation et la taille
des symboles selon les valeurs des champs spécifiés.

De la même façon que le rendu Catégorisé, il vous permet de choisir :

• L’attribut (en utilisant la liste déroulante de Colonne ou la fonction Définir une expression de colonne)

• le symbole (en utilisant la fenêtre de Sélection de symbole)

• Le format de la légende et la précision des valeurs numériques

• La méthode à utiliser pour modifier la couleur ou la taille des symboles

• Les couleurs (en utilisant la liste des palettes de couleur), si la méthode couleur est sélectionnée

• La taille (en choisissant une plage de valeurs et les unités)

Ensuite vous pouvez utiliser l’onglet Histogramme qui permet d’afficher un histogramme interactif des valeurs du
champ ou de l’expression utilisé pour le rendu. Les classes peuvent être définies ou ajoutées depuis l’histogramme.
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Note: Vous pouvez utiliser le panneau Statistique pour obtenir plus d’information sur votre couche vecteur. Voir
Panneau de résumé statistiques.

De retour dans l’onglet Classes, vous pouvez choisir le nombre de classes et la méthode de classification (depuis
la liste déroulante Mode). Les modes disponibles sont :

• Intervalle égal : chaque classe a la même taille (par exemple, valeurs de 0 à 16 et 4 classes, chaque classe a
une taille de 4).

• Quantile (nombre égal) : chaque classe aura le même nombre d’éléments à l’intérieur de chaque classe.

• Ruptures naturelles (Jenks) : la variance de chaque classe est minimale tandis que la variance entre les
différentes classes est maximale;

• Écart-type : les classes sont construites en fonction le l’écart-type calculé sur l’ensemble des valeurs;

• Jolies ruptures: Calcule une séquence d’environ n+1 valeurs d’espacement équidistantes qui couvrent la
plage des valeurs de x. Les valeurs sont choisies de sorte qu’elles soient 1, 2 ou 5 fois une puissance de 10.
(basé sur “jolis points d’arrêt” de l’environnement statistique de R http://astrostatistics.psu.edu/datasets/R/
html/base/html/pretty.html)

La zone déroulante dans la partie centrale du menu Symbologie répertorie les classes ainsi que leurs étendues,
étiquettes et symboles de rendu.

Cliquez sur le bouton Classer pour générer les classes selon le mode choisi. Chaque classe peut être désactivée
en décochant la case située à gauche du symbole de classe.

Pour changer le symbole, la valeur et / ou la légende, double-cliquez sur l’élément à modifier.

Un clic-droit vous propose de Copier / Coller, Modifier la couleur, Modifier la transparence, Modifier l’unité
de sortie ou Modifier la taille.

L’exemple de la figure figure_graduated_symbology montre le rendu gradué de la couche des rivières de
l’échantillon de données de QGIS.

Figure 13.12: Options du mode de rendu Gradué

Astuce: Cartes thématiques utilisant une expression
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Les cartes thématiques faites avec le rendu Catégorisé ou Gradué peuvent être créées en utilisant le résultat d’une

expression. Dans la fenêtre Propriétés des couches vectorielles, le sélecteur de colonne accueille une fonction
Définir une expression de colonne. Vous n’avez donc pas besoin d’écrire l’attribut de la classification dans une nouvelle
colonne de votre table si vous souhaitez que l’attribut de classification soit un composite de plusieurs champs, ou
une formule quelconque.

Symboles Proportionnels et Analyse Multivariée

Les représentations par symbole proportionnel et analyse multivariée ne sont pas disponibles dans la liste
déroulante du rendu de style. Toutefois, les options de data-defined override appliquées sur l’une des options
de rendu précédentes vous permettent d’afficher vos données de point et de ligne avec de telles représentations.

Créer des Symboles Proportionnels

Pour appliquer un rendu proportionnel :

1. Appliquez d’abord à la couche un rendu de symbole unique.

2. Définissez ensuite le symbole à appliquer aux entités.

3. Sélectionnez l’élément au niveau supérieur de l’arborescence des symboles et utilisez le bouton
Définition de données imposée à droite de Taille (pour une couche de points) ou d”Épaisseur (pour une couche
linéaire) .

4. Sélectionnez un champ ou entrez une expression, pour que, à chaque entité, QGIS redimensionne propor-
tionnellement le symbole à la valeur du champ ou de l’expression.

Si nécessaire, utilisez l’option Assistant. . . du menu pour appliquer une transformation (exponentielle,
flannery. . . ) à la mise à l’échelle de la taille du symbole (voir Using the data-defined assistant interface
pour plus de détails).

Vous pouvez choisir d’afficher les symboles proportionnels dans le Panneau des couches et dans la Légende
de mise en page: déplier la liste déroulante Avancé en bas de la fenêtre principale de l’onglet Symbologie et
sélectionner Légende définie par la taille des données pour configurer les objets légende (voir Légende définie
par la taille des données pour plus de détails).

Créer une analyse multivariée

Un rendu d’analyse multivariée vous aide à évaluer la relation entre deux ou plusieurs variables, par exemple,
l’une peut être représenté par une palette de couleurs alors que l’autre est représentée par une variation de taille.

La façon la plus simple de créer une analyse multivariée dans QGIS est de :

1. Appliquer d’abord une symbologie catégorisée ou graduée sur une couche, en utilisant le même type de
symbole pour toutes les classes.

2. Appliquez ensuite une symbologie proportionnelle sur les classes :

(a) Cliquez sur le bouton Modifier au-dessus du cadre de classification : vous obtenez la boîte de dialogue
The Symbol Selector.

(b) Redimensionnez la taille ou la largeur de la couche de symbole à l’aide du widget définition de
données imposée comme expliqué au-dessus.

Comme pour les symboles proportionnels, la symbologie mise à l’échelle peut être ajoutée à l’arborescence des
couches, au dessus des symboles de classes catégorisées ou graduées en utilisant la fonction data defined size
legend . Les deux représentations sont également disponibles dans la légende de la mise en page d’impression.
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Figure 13.13: Mise à l’échelle de la taille des aéroports en fonction de l’altitude de l’aéroport

Figure 13.14: Exemple d’analyse multivariée avec légende des symboles proportionnels.
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Ensemble de règles

Le moteur de rendu Ensemble de règles est utilisé pour afficher toutes les entités d’une couche en utilisant
un ensemble de règles prédéfinies dont l’aspect reflète la manière dont une entité a été classée en fonction de
ses attributs. Les règles sont définies par des expressions SQL et peuvent être imbriquées. La fenêtre permet de
regrouper les règles par type de filtre ou échelle de validité et vous pouvez activer le rendu selon les niveaux de
symboles ou arrêter le rendu à la première règle validée pour chaque entité.

Pour créer une règle:

1. Utilisez une ligne existante en double-cliquant dessus (par défaut, QGIS ajoute un symbole sans règle

lorsque le mode de rendu est activé) ou cliquez sur le bouton Éditer la règle courante ou :sup:‘ Ajouter
une règle‘.

2. Dans la boîte de dialogue Edit Rule qui s’ouvre, vous pouvez définir un libellé pour vous aider à identifier
chaque règle. C’est l’étiquette qui sera affichée dans le Panneau des couches et aussi dans la légende du
composeur d’impression.

3. Entrez une expression dans la zone de texte à côté de l’option Filtre ou appuyez sur le bouton à
côté pour ouvrir la boîte de dialogue du Constructeur de Chaîne d’Expression.

4. Utilisez les fonctions fournies et les attributs de couche pour construire une expression pour filtrer les entités
que vous souhaitez récupérer. Appuyez sur le bouton Test pour vérifier le résultat de la requête.

5. Vous pouvez saisir un libellé plus long pour compléter la description de la règle.

6. Vous pouvez utiliser l’option Échelle de visualisation pour définir les échelles auxquelles la règle doit
être visible.

7. Vous pouvez enfin configurer le Symbole pour afficher pour ces entités.

8. Cliquez sur OK.

Une nouvelle ligne résumant la règle est ajoutée à la boîte de dialogue Propriétés de la couche. Vous pouvez créer
autant de règles que nécessaire en suivant les étapes ci-dessus ou copier-coller une règle existante. Glissez-déposez
les règles pour les imbriquer les unes par rapport aux autres et affiner les caractéristiques des règles supérieures
dans des sous-catégories.

En sélectionnant une règle, vous pouvez également organiser ses caractéristiques en sous-classes en utilisant le
menu déroulant Affiner les règles sélectionnées. L’affinement automatisé des règles peut être basé sur :

• Les échelles;

• Les catégories: en appliquant un rendu catégorisé;

• ou des intervalles: en appliquant un rendu gradué.

Les classes affinées apparaissent dans l’arborescence comme des sous-éléments de la règle et vous pouvez définir
une symbologie pour chaque classe, comme vu au dessus.

Dans la boîte de dialogue Éditer une règle, vous pouvez éviter d’écrire toutes les règles et utiliser l’option
Sinon pour récupérer toutes les entités qui ne correspondent à aucune des autres règles de même niveau. Ceci
peut aussi être réalisé en écrivant Else dans la colonne Règle de la boîte de dialogue Propriétés de la couche →
Symbologie → Ensemble de règles.

Les règles créées apparaissent également dans la légende de la carte. Double-cliquez sur les règles dans la légende
de la carte pour que l’onglet Symbologie des propriétés de la couche affiche la règle qui gère l’affichage du
symbole.

L’exemple de la figure figure_rule_based_symbology montre le rendu basé sur des règles pour la couche des
rivières de l’échantillon de données de QGIS.
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Figure 13.15: Options du mode de rendu par Ensemble de Règles

Rendu Déplacement de point

Le rendu de Déplacement de point permet une visualisation de tous les points d’une couche, même si ceux-ci
se superposent. Pour ce faire, le moteur de rendu sélectionne les points se trouvant dans une Distance donnée et
les place autour de leur barycentre en suivant différentes Méthodes de placement :

• Anneau : place tous les éléments sur un cercle dont le rayon dépend du nombre d’éléments à afficher.

• Anneaux concentriques : utilise un ensemble de cercles concentriques pour montrer les entités.

• Grille : génère une grille régulière avec un symbole de point à chaque intersection.

Le bouton Symbole du centre vous permet de personnaliser le symbole et la couleur du point central. Pour les sym-
boles de points distribués, vous pouvez appliquer n’importe laquelle des options Aucun symbole, Symbole unique,
Catégorisé, Gradué ou Ensemble de règles en utilisant la liste déroulante Moteur de rendu et les personnaliser en
utilisant le bouton Paramètres du moteur de rendu.

Bien que l’espacement minimal du Displacement lines dépende de celui du moteur de rendu des symboles de
points, vous pouvez toujours personnaliser certains de ses paramètres tels que le Largeur de trait, Couleur de trait
et Réglage taille (pour ajouter plus de distance entre les points rendus, par exemple).

Utilisez les options du groupe Étiquettes pour effectuer l’étiquetage des points : les étiquettes sont placées à une
position décalée du symbole, et non à la position réelle de l’élément. Outre l’option Attribut de l’étiquette, Police
de l’étiquette et Couleur de l’étiquette, vous pouvez définir la commande Utiliser un étiquetage dépendant de
l’échelle pour afficher les étiquettes.

Note: Le rendu de déplacement de points ne modifie pas la géométrie des entités, ce qui signifie que les points
ne sont pas déplacés de leur position. Ils sont toujours situés à leur emplacement initial. Les modifications ne sont
que visuelles, à des fins de rendu. Utilisez plutôt l’algorithme de traitement Déplacement de points si vous voulez
déplacer les points.
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Figure 13.16: Fenêtre Déplacement de points

Rendu Groupe de points

Contrairement au rendu Déplacement de points qui répartit les points les plus proches ou superposés, le rendu

Groupe de points regroupe les points proches dans un seul symbole. Sur la base d’une Distance spécifiée, les
points qui se trouvent à l’intérieur du rayon sont fusionnés en un seul symbole. L’agrégation des points est faite en
fonction du groupe le plus proche pouvant être formé, plutôt que de simplement leur assigner le premier groupe à
l’intérieur de la distance de recherche.

A partir de la fenêtre principale, vous pouvez :

• définir le symbole pour représenter le groupe de points dans le Symbole du cluster; le rendu par défaut
affiche le nombre d’éléments agrégés grâce à la variable @cluster_size définie dans la « définition de
données imposée » du symbole de police.

• utilisez la liste déroulante Moteur du rendu pour appliquer n’importe quel autre type de rendu à la couche
(unique, catégorisé, basé sur des règles. . . ). Ensuite, appuyez sur le bouton Paramètres du moteur de
rendu. . . pour configurer la symbologie comme d’habitude. Notez que ce moteur de rendu n’est visible que
sur les éléments qui ne sont pas regroupés. De plus, lorsque la couleur du symbole est la même pour tous
les points à l’intérieur d’un cluster, cette couleur définit la variable @cluster_color du groupe.

Note: Le rendu de déplacement de points ne modifie pas la géométrie des entités, ce qui signifie que les points
ne sont pas déplacés de leur position. Ils sont toujours situés à leur emplacement initial. Les modifications ne sont
que visuelles, à des fins de rendu. Utilisez plutôt l’algorithme de traitement Déplacement de points si vous voulez
déplacer les points.

Rendu Polygones inversés

Le rendu en Polygones inversés permet de définir un symbole à appliquer à l’extérieur des polygones de la
couche. Comme précédemment, vous pouvez alors choisir parmi des sous-modes de rendu : Symbole unique,
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Figure 13.17: Fenêtre groupe de points

Gradué, Catégorisé, Ensemble de règles ou 2.5 D.

Figure 13.18: Fenêtre du mode de rendu en Polygones Inversés

Rendu de Carte de chaleur

Avec le rendu de Carte de chaleur vous pouvez créer des cartes de chaleur en temps réel et dynamiques
pour des couches (multi-)points. Vous pouvez définir le rayon de la carte de chaleur en millimètres, points, pixels,
unités cartographiques ou pouces, choisir et éditer une palette de couleur pour le style de carte de chaleur et utiliser
une jauge pour choisir entre la vitesse de rendu et la qualité. Vous pouvez également définir une valeur maximale
limite et attribuer une pondération à chaque point via un champ ou une expression. Lorsqu’une entité est ajoutée
ou retirée, le rendu de carte de chaleur met automatiquement à jour le style de carte de chaleur.
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Figure 13.19: Fenêtre Carte de chaleur

Rendu 2.5D

L’utilisation du rendu 2.5D permet de créer un effet 2.5D sur les entités de votre couche. Commencez par
choisir une valeur de Hauteur (en unités cartographiques). Vous pouvez utiliser une valeur fixe, l’un des champs
de votre calque ou une expression. Vous devez également choisir un Angle (en degrés) pour recréer la position
du spectateur (0° à l’ouest, sens croissant dans le sens inverse des aiguilles d’une montre). Utilisez les options
de configuration avancées pour définir la Couleur du toît et la Couleur de mur. Si vous souhaitez simuler le

rayonnement solaire sur les entités de murs, cocher la case Ombrager les murs en se basant sur leur aspect.
Vous pouvez également simuler une ombre en définissant une Couleur et une Taille (en unités cartographiques).

Figure 13.20: Fenêtre 2.5D

Astuce: Utilisation de l’effet 2.5D avec d’autres styles de rendu
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Quand vous avez terminé de définir le style rendu 2.5D, vous pouvez le convertir en un autre rendu (symbole
unique, catégorisé, gradué). Les effets 2.5D seront conservés et toutes les autres options spécifiques au rendu
seront disponibles (de cette façon, vous pouvez par exemple catégoriser des symboles avec une belle représentation
2.5D ou ajouter un style complémentaire à vos symboles 2.5D). Pour vous assurer que l’ombre et le «bâtiment»
lui-même n’interfèrent pas avec d’autres entités voisines, vous pouvez activer les niveaux de symboles (Avancé
-> Niveaux de symbole. . . ). Les valeurs de hauteur et d’angle du 2,5D sont enregistrées dans les variables de la
couche, vous pouvez donc les éditer dans l’onglet variables de la fenêtre de propriétés de la couche.

Rendu de couche

Dans l’onglet Symbologie, vous pouvez également définir des options qui agissent sur toutes les entités de la
couche :

• Opacity : You can make the underlying layer in the map canvas visible with this tool.
Use the slider to adapt the visibility of your vector layer to your needs. You can also make a precise
definition of the percentage of visibility in the menu beside the slider.

• Blending mode at the Layer and Feature levels: You can achieve special rendering effects with these tools
that you may previously only know from graphics programs. The pixels of your overlaying and underlaying
layers are mixed through the settings described in Modes de fusion.

• Appliquer les effets sur les entités de la couche avec le bouton Effets.

• Le Contrôle de l’ordre de rendu des couches vous permet de définir l’index z qui déterminera l’ordre de

rendu des entités, à partir de leurs attributs. Activez la case à cocher et cliquez sur le bouton sur le côté.
Vous obtiendrez une boîte de dialogue Définir l’ordre dans laquelle vous:

1. choisissez un champ ou construisez une expression à appliquer aux entités de la couche.

2. Définissez l’ordre de rendu des entités correspondantes, c’est-à-dire si vous choisissez l’ordre Ascen-
dant, les entités renvoyant une plus petite valeur à votre requête sont affichées en premier et placées
sous les autres.

3. Définissez l’ordre de rendu des entités ayant la valeur NULL: en premier ou en dernier.

4. Répétez les étapes ci-dessus autant de fois que nécessaire.

Les règles sont appliquées de haut en bas; les entités sont rangées selon la première règle puis, pour chaque
groupe d’entités ayant la même valeur (y compris celles avec la valeur NULL) et donc de même niveau z
d’empilement (z-level), la règle suivante est appliquée pour ordonner leur placement. Et ainsi de suite. . .

Figure 13.21: Options de rendu de couche

Autres Paramètres

Niveaux de symbole

Pour les moteurs de rendu qui permettent l’empilement des couches de symbole (seul carte de chaleur ne le permet
pas), il existe une option pour contrôler l’ordre de rendu de chaque niveau de symbole.

Pour la plupart des moteurs de rendu, vous pouvez accéder à l’option des niveaux de symbole en cliquant sur
le bouton Avancé situé sous les liste des symboles enregistrés puis en choisissant Niveaux de symboles. Pour le
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moteur de rendu Ensemble de règles l’option est directement activée par le bouton Niveaux de symboles alors que
pour le moteur de rendu de Rendu Déplacement de point, le même bouton est à l’intérieur de la boîte de dialogue
Paramètres du moteur de rendu.

Pour activer les niveaux de symbole, sélectionnez Niveaux de symboles. . . . Chaque ligne représentera un
exemple de symbole combiné avec son étiquette et la couche de symbole divisée en colonnes avec numéro dans
chacune d’elles. Ces nombres représentent l’ordre de représentation de la couche. Les valeurs faibles sont dess-
inées en premier, en restant vers le bas alors que les valeurs les plus importantes sont dessinées plus tard, au dessus
des autres.

Figure 13.22: Fenêtre Niveaux de symbole

Note: Si les niveaux de symbole sont désactivés, les symboles complets seront dessinés en fonction de l’ordre
des entités. Les symboles situés au dessus masqueront ceux situés en dessous. Des symboles de même niveau ne
seront pas « fusionnés » ensemble.

Figure 13.23: Différence de rendu selon que les niveaux de symboles sont activés (A) ou non (B)
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Légende définie par la taille des données

Lorsqu’une couche est rendue en symboles proportionnels ou analyse multivariée ou lorsqu’un diagramme de
taille variable est appliqué à la couche, vous pouvez autoriser l’affichage des symboles mis à l’échelle à la fois
dans le panneau des couches et la légende de mise en page.

Pour activer la boîte de dialogue Légende définie par la taille des données pour le rendu des symboles, sélectionnez
l’option éponyme dans le bouton Avancé sous la liste des symboles enregistrés. Pour les diagrammes, l’option est
disponible sous l’onglet Légende. La boîte de dialogue fournit les options suivantes pour :

• sélectionnez le type de légende : Légende non activée, Eléments de légende séparés et Légendé
repliée. Pour cette dernière option, vous pouvez sélectionner si les éléments de légende seront alignés en
Bas ou au Centre ;

• définir le symbole à utiliser pour la représentation des légendes ;

• Saisir le titre de la légende.

• redimensionner les classes à utiliser : par défaut, QGIS vous fournit une légende de cinq classes (basée sur

de jolies ruptures ) mais vous pouvez appliquer votre propre classification en utilisant l’option Taille

manuelle des classes. Utilisez les boutons et pour définir vos valeurs et étiquettes de classes
personnalisées.

Un aperçu de la légende est affiché dans le panneau droit de la boîte de dialogue et mis à jour au fur et à mesure
que vous réglez les paramètres. Pour la légende repliée, une ligne de repère horizontale est tracée entre le bord
supérieur du symbole et le texte de légende correspondant.

Figure 13.24: Options de la Légende définie par la taille des données

Note: Actuellement, la légende définie par la taille les données ne peut être appliquée à la couche de points qu’à
l’aide d’une symbologie unique, catégorisée ou graduée.
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Effets

Pour améliorer le rendu de la couche et éviter (ou au moins réduire) d’utiliser un autre logiciel pour l’édition

finale des cartes, QGIS fournit une autre fonctionnalité puissante: les options d” Effets qui ajoute des effets
d’affichage afin de personnaliser la visualisation des couches vecteur.

L’option est disponible dans la boîte de dialogue Propriétés de la couche → Symbologie, sous le groupe Rendu de
couche (s’applique à la couche entière) ou dans les Propriétés du symbole (s’applique aux catégories correspon-
dantes). Vous pouvez combiner les deux utilisations.

Les effets peuvent être activés en cochant l’option Effets et en cliquant sur le bouton Personnalisez les effets qui
ouvrira la boîte de dialogue Propriétés des effets (voir figure_effects_source). Les types d’effet suivants avec leurs
options personnalisées sont disponibles:

• Source: Dessine l’entité dans son style originel selon la configuration des propriétés de la couche. La
transparence de ce style peut être ajustée.

Figure 13.25: Effets: boîte de dialogue Source

• Flou: Ajoute un effet de flou à la couche vectorielle. Les options modifiables sont Type de flou (Flou par
empilement or Flou gaussien), la force et la transparence de l’effet de flou.

Figure 13.26: Effets: boîte de dialogue Flou
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• Coloriser : Cet effet peut être utilisé pour créer une version du style en utilisant une seule teinte. La base
sera toujours une version en niveaux de gris du symbole et vous pouvez :

– Utilisez Niveau de gris pour sélectionner comment le créer : les options sont “Par clarté”, “Par
luminosité”,”En moyenne” et “Off”.

– Si Coloriser est sélectionné, il sera possible de mélanger une autre couleur et de choisir sa puis-
sance.

– Contrôler les niveaux de Luminosité, Contraste et Saturation du symbole .

Figure 13.27: Effets: boîte de dialogue Coloriser

• Ombre portée : L’utilisation de cet effet ajoute une ombre sur l’entité, ce qui ressemble à l’ajout d’une di-
mension supplémentaire. Cet effet peut être personnalisé en changeant l’angle et la distance du Décalage, en
déterminant la direction et la distance de l’ombre depuis l’objet source. Ombre portée a aussi la possibilité
de changer le rayon de floutage et le Couleur de l’ombre.

• Ombre intérieure: Cet effet est semblable à l’effet Ombre portée mais il ajoute l’effet d’ombre à l’intérieur
des limites de l’entité. Les options disponibles pour la personnalisation sont identiques à celles de l’effet
Ombre portée.

• Luminescence interne: Ajoute un effet de luminescence à l’intérieur de l’entité. Cet effet peut être per-
sonnalisé en ajustant la diffusion (Rayon) de la luminescence ou le Rayon de floutage. Le dernier indique
la proximité depuis la limite de l’entité où vous souhaitez ajouter le floutage. De plus, il existe des options
pour personnaliser la couleur du floutage à l’aide d’une couleur simple ou d’une palette.

• Luminescence externe: Cet effet est semblable à l’effet Luminescence interne mais il ajoute l’effet de
luminescence à l’extérieur des limites de l’entité. Les options disponibles pour la personnalisation sont
identiques à celles de l’effet Luminescence interne.

• Transformer: Ajoute la possibilité de transformer la forme du symbole. Les premières options disponibles
sont les Mirroir horizontal and Mirroir vertical qui créé une réflexion sur les axes horizontal et/ou vertical.
Les 4 autres options sont:

– Cisaille: déforme l’entité le long de l’axe x et/ou y.

– Échelle: grossit ou réduit l’entité le long des axes x et/ou y d’un pourcentage donné.
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Figure 13.28: Effets: boîte de dialogue de l’ombre portée.
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Figure 13.29: Effets: boîte de dialogue de l’ombre intérieure.

Figure 13.30: Effets: boîte de dialogue de luminescence interne.
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Figure 13.31: Effets: boîte de dialogue de luminescence externe.

– Rotation: tourne l’entité autour de son centre.

– et Translation qui déplace l’objet d’une distance donnée sur l’axe x et/ou l’axe y.

Plusieurs effets peuvent être utilisés simultanément. Vous pouvez activer/désactiver un effet en cochant sa case
dans la liste des effets. Vous pouvez modifier le type d’effet en utilisant l’option Type d’effet. Vous pouvez

modifier l’ordre des effets en utilisant les boutons Monter et Descendre et également ajouter/supprimer des

effets en utilisant les boutons Ajouter un nouvel effet and Supprimer l’effet.

Il existe des options communes à tous les type d’effets. Les options Opacité et Mode de fusion fonctionnent de
la même manière que celles décrites dans Rendu de couche et elles peuvent être utilisées dans tous les effets à

l’exception de Transformer. Il y a aussi une option Mode dessin disponible pour chaque effet, et vous
pouvez choisir de rendre et/ou modifier le symbole, en suivant certaines règles :

• Les effets sont rendus de haut en bas.

• Rendu uniquement signifie que l’effet sera visible.

• Modifier uniquement signifie que l’effet ne sera pas visible mais la modifications qu’il applique seront
transmises à l’effet suivant (celui qui suit immédiatement).

• Le mode Effectuer le rendu et modifier rendra l’effet visible et passera tout changement à l’effet suivant.
Si l’effet se trouve en haut de la liste des effets ou si l’effet immédiatement au dessus n’est pas en mode
modification, alors il utilisera le symbole source des propriétés de la couche (similaire à celui de la source).

13.2.4 Propriétés d’Étiquetage

L’onglet Étiquettes fournit tous les paramètres de configuration nécessaires pour créer des étiquettes intelli-
gentes sur vos couches vectorielles. Cette fenêtre est également accessible depuis le panneau Layer Styling ou en
cliquant sur le bouton Paramètres d’étiquetage de la couche de la Barre d’outils des Étiquettes.

La première étape consiste à choisir la méthode d’étiquetage dans la liste déroulante. Les méthodes disponibles
sont :
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Figure 13.32: Effets: boîte de dialogue Transformer.

• pas d’étiquette : la valeur par défaut, n’affichant aucune étiquette de la couche.

• Étiquettes simples, décrit plus loin

• Etiquettes basées sur des règles

• et Bloquant: n’affiche pas d’étiquette mais définit la couche comme un obstacle pour les étiquettes des
autres couches.

Paramétrer une étiquette

Les étapes qui suivent présupposent que vous avez sélectionné l’option Étiquettes simples, permettant
l’activation des onglets suivants nécessaires à l’étiquetage :

• Texte

• Formatage

• Tampon

• Arrière-plan

• Ombre

• Placement

• Rendu

Activer également la liste déroulante Étiqueter avec, dans laquelle vous pouvez sélectionner un champ à utiliser.

Cliquez sur si vous voulez définir des étiquettes basées sur des expressions - Voir Définir des étiquettes basées
sur des expressions.

Les étapes présentées ci-dessous décrivent un étiquetage simple, sans utilisation des fonctions de Valeurs définies
par les données, situées à droite des paramètres à définir. Voir Utiliser des valeurs de paramètres définies par les
données pour l’étiquetage pour un cas d’utilisation.
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Figure 13.33: Paramètres d’étiquetage de la couche - Onglet texte

Onglet Texte

Dans l’onglet Texte, vous pouvez définir les Police, Style, et Taille du texte de vos étiquettes (voir Fig-
ure_labels) ainsi que les options Couleur et Opacité. Utilisez l’option Type de casse pour changer le style de
capitalisation du texte. Vous avez la possibilité de passer le texte en “Majuscules”, “Minuscules” ou “Première
lettre en majuscule”. Dans Espacement, vous pouvez changer l’espace entre les mots et entre les lettres. Enfin,
utilisez l’option Mode de fusion pour déterminer comment vos étiquettes se fusionneront avec les éléments de la
carte en dessous d’elles (voir plus à ce sujet dans Modes de fusion).

L’option Appliquer un texte de substitution vous permet de spécifier une liste de textes à substituer aux textes
des étiquettes des entités (par exemple, en abrégeant les types de rues). Les textes de remplacement sont donc
utilisés pour afficher les étiquettes sur la carte. Les utilisateurs peuvent également exporter et importer des listes
de substitution pour faciliter leur réutilisation et leur partage.

Onglet Formatage

Dans le menu Formatage, vous pouvez définir un caractère de retour à la ligne dans les étiquettes avec l’option
Découper sur le caractère. Vous pouvez formater la Hauteur de ligne et l”alignement. Pour ce dernier, les valeurs
courantes sont disponibles (À gauche, À droite, Centré) ainsi que l’option Suivre le placement des étiquettes pour
les couches ponctuelles. Dans ce mode, l’alignement du texte des étiquettes est dépendant du placement final de
l’étiquette par rapport au point. Ex: si l’étiquette est placée à gauche du point alors l’étiquette sera alignée à droite
et inversement.

Pour les couches linéaires, vous pouvez utiliser symbole de direction de ligne pour indiquer la direction des lignes.
Ils fonctionnent particulièrement bien lorsqu’ils sont utilisés avec les options de placement Incurvé ou Parallèle de
l’onglet Position. Les autres options permettent de régler la position des symboles ainsi que d’afficher le symbole
en Direction inverse.

Utilisez l’option Nombres formatés pour les étiquettes numériques. Vous pouvez définir le nombre de déci-

males. Par défaut, 3 décimales seront utilisées. Utilisez la case à cocher Afficher le signe + si vous voulez
afficher + avec les chiffres positifs.
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Onglet Tampon

Pour créer un tampon autour des étiquettes, activez la case Afficher un tampon dans l’onglet Tampon. Vous
pouvez définir les Taille, Couleur, et opacité du tampon. Le tampon démarre à partir du bord de l’étiquette, donc,

si la case à cocher Couleur de remplissage du tampon est activée, l’intérieur du tampon est totalement rempli.
Ceci peut s’avérer utile lors de l’utilisation d’étiquettes partiellement transparentes ou avec des modes de fusion

non normaux, ce qui permettra de voir derrière le texte de l’étiquette. Désactiver la case à cocher Couleur
de remplissage du tampon (tout en utilisant des étiquettes totalement transparentes) vous permettra de créer des
étiquettes texte contournées.

Onglet Arrière-plan

Dans l’onglet Fond, vous pouvez définir avec Taille X et Taille Y la forme de votre fond. Utilisez Type de
taille pour insérer un “tampon” supplémentaire dans votre arrière-plan. La taille du tampon est définie par défaut
ici. Les Taille X et Taille Y représentent alors l’ensemble fond et tampon. Vous pouvez définir une Rotation
dans laquelle vous pouvez choisir entre “Synchroniser avec l’étiquette”, “Décalage de l’étiquette” et “Fixé”. En
utilisant “Décalage de l’étiquette” ou “Fixé”, vous pouvez faire pivoter l’arrière-plan. Définissez un Décalage X,Y
avec les valeurs X et Y, et le fond sera décalé. Lors de l’application de Rayon X,Y, l’arrière-plan aura des coins
arrondis. Encore une fois, il est possible de mélanger l’arrière-plan avec les couches sous-jacentes dans la carte
en utilisant le Mode de fusion (voir Modes de fusion).

Onglet Ombre

Utilisez l’onglet Ombre pour une Ombre portée définie par l’utilisateur. Le dessin de l’arrière plan est très
variable. Choisissez entre “Plus petit composant de l’étiquette”, “Texte”, “Tampon” et” Arrière-plan”. L’angle

Décalage dépend de l’orientation de l’étiquette. Si vous choisissez la case à cocher Utiliser l’ombre globale,
alors le point zéro de l’angle est toujours orienté vers le nord et ne dépend pas de l’orientation de l’étiquette. Vous
pouvez influencer l’apparence de l’ombre avec le Rayon de floutage. Plus le chiffre est élevé, plus les ombres sont
douces. L’apparence de l’ombre portée peut également être modifiée en choisissant un mode de fusion.

Onglet Position

Choisissez l’onglet Placement pour configurer l’emplacement et la priorité des étiquettes. Notez que les
options de placement diffèrent selon le type de couche vectorielle, à savoir point, ligne ou polygone, et sont
affectées par le paramètre global PAL setting.

Emplacement pour les couches de points

Avec le mode de placement Cartographique, les étiquettes ponctuelles sont générées avec la meilleure relation
visuelle avec le point de l’entité, suivant des règles de placement cartographiques idéales. Les étiquettes peuvent
être placées à une Distance du point de l’entité ou par rapport à l’enveloppe du symbole utilisé pour représenté
l’entité. La dernière option est particulièrement utile lorsque la taille du symbole n’est pas fixe, ex: si elle est
définie par des données ou lors de l’utilisation de symboles différents dans un rendu catégorisé.

Par défaut, les placements sont priorisés selon l’ordre suivant:

1. en haut à droite

2. en haut à gauche

3. coin inférieur droit

4. coin inférieur gauche
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5. au centre à droite

6. au centre à gauche

7. en haut, décalé légèrement à droite

8. en bas, décalé légèrement à gauche.

La priorité de placement peut cependant être paramétrée pour une entité donnée en utilisant une liste des priorités
définie par les données. Cela ne permet d’utiliser que certains emplacements, par exemple : pour les entités
représentant la côte, vous pouvez empêcher les étiquettes de s’afficher sur les terres.

Le paramètre Autour du point place l’étiquette dans un cercle de rayon fixe autour de l’entité (défini dans
Distance). Le placement de l’étiquette peut également être contraint en utilisant l’option Quadrant.

Avec l’option Décalage par rapport au point, les étiquettes sont placées à une distance fixe du point de l’entité.
Vous pouvez sélectionner le Quadrant dans lequel sera placée l’étiquette. Vous pouvez également paramétrer les
distances X et Y entre les points et leurs étiquettes ainsi que l’angle de l’étiquette avec le paramètre Rotation.
Ainsi, l’étiquette sera placée dans le quadrant sélectionné avec une rotation définie.

Emplacement pour les couches de lignes

Les options d’étiquette pour les couches linéaires permettent un placement Parallèle, Incurvé ou

Horizontal. Avec les options Parallèle et Incurvé, vous pouvez définir la position Au-dessus de la

ligne, Sur la ligne ou En-dessous de la ligne. Il est possible de sélectionner plusieurs options à la fois.
Dans ce cas, QGIS recherchera la position optimale pour l’étiquette. Pour les placements parallèle et incurvé,
vous pouvez également utiliser l’orientation de la ligne pour positionner l’étiquette. En outre, vous pouvez définir

un Angle maximal des lettres lorsque vous optez pour un emplacement Incurvé (voir Figure_labels_2_ ).

Figure 13.34: Exemples d’emplacements d’étiquettes pour une ligne

Pour les trois options d’emplacement, vous pouvez Répéter les étiquettes en spécifiant une distance minimale
entre les étiquettes. Cette distance peut être en millimètres ou en Unités de la carte.

Emplacement pour les couches de polygones

Vous pouvez choisir parmi les options suivantes pour l’emplacement des étiquettes sur une couche de polygones
(voir figure_labels_placement_polygon) :

• Décalé du centroide,

• Horizontal (lent),
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• Autour du centroïde,

• Libre (lent),

• Utilisation du périmètre,

• Selon le périmètre (incurvé).

Dans les paramètres Décalé du centroïde, vous pouvez définir si le centroïde est celui du polygone visible

ou du polygone complet. Cela signifie que soit le centroïde utilisé correspond à celui de la portion de polygone
qui apparaît dans votre carte, soit il est défini par rapport au polygone en entier, que vous l’ayez entièrement affiché
dans votre carte ou pas. Vous pouvez placer l’étiquette selon les quadrants et définir un décalage et une rotation.

L’option Autour du centroïde permet de placer l’étiquette à une certaine distance autour du centroïde . Là

encore, il y a la possibilité d’utiliser l’option polygone visible ou polygone complet pour la gestion du
centroïde.

Avec les options Horizontal (lent) ou Libre (lent), QGIS place à la meilleure position soit une étiquette horizontale
soit une étiquette inclinée à l’intérieur du polygone.

Avec l’option Utiisation du périmètre, l’étiquette sera dessinée à côté de la limite du polygone. L’étiquette
se comportera comme l’option parallèle pour les lignes. Vous pouvez définir une position et une distance pour

l’étiquette. Les positions possibles sont Au-dessus de la ligne, Sur la ligne, En-dessous de la ligne et

Orientation de la ligne suivant la position. Vous pouvez indiquer la distance entre l’étiquette et la limite du
polygone ainsi qu’un intervalle de répétition pour l’étiquette.

L’option Selon le périmètre (incurvé) place l’étiquette le long de la limite du polygone, en utilisant une étiquette
courbe. En plus des paramètres disponibles dans l’onglet Utilisation du périmètre, vous pouvez définir l”angle
maximum entre les caractères incurvés, à l’intérieur ou à l’extérieur.

Figure 13.35: Exemples d’emplacements d’étiquettes pour un polygone
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Dans la section priorité, vous pouvez indiquer la priorité avec laquelle les étiquettes sont générées pour les trois
types de couches vecteurs (point, ligne, polygone). Cette option de placement interagit avec les étiquettes des
autres couches vecteurs dans la carte. S’il existe des étiquettes d’autres couches au même emplacement, l’étiquette
avec la priorité la plus élevée sera affichée et les autres seront écartées.

Onglet Rendu

Dans l’onglet Rendu, vous pouvez affiner le paramétrage du rendu des étiquettes et leurs interactions avec les
autres étiquettes et les autres entités.

Sous les Options des étiquettes, vous trouverez les paramètres de visibilité selon l’échelle et de visibilité basée sur
la taille des pixels.

L”index z des étiquettes détermine l’ordre dans lequel les étiquettes sont générées ainsi que la relation avec les
autres étiquettes dans la couche (en utilisant une expression basée sur des données) et avec les étiquettes des autres
couches. Les étiquettes avec un index z élevé sont affichées au dessus des étiquettes (de n’importe qu’elle autre
couche) avec une valeur d’index plus faible.

De plus, la logique a été affinée pour gérer les cas où 2 étiquettes ont un index z identique :

• Si elles sont dans la même couche, une étiquette plus petite sera toujours tracée au dessus de l’étiquette plus
large.

• Si elles sont issues de couches différentes, les étiquettes sont tracées dans le même ordre que les couches
(pour respecter l’ordre des couches dans la légende).

À noter que ce paramètre ne définit par comment sont tracées les étiquettes par rapport aux entités d’autres
couches, il contrôle uniquement l’ordre dans lequel les étiquettes sont tracées au dessus des entités de la couche.

Lors de la génération des étiquettes et pour pouvoir afficher des étiquettes lisibles, QGIS évalue automatiquement
la position des étiquettes et peut masquer certaines d’entre elles en cas de collision. Vous pouvez néanmoins choisir

d” Afficher toutes les étiquettes pour cette couche (même celles en collision) pour pouvoir gérer manuellement
leur placement.

Vous pouvez affiner quelles étiquettes seront générées en utilisant des expressions de valeurs définies par les
données pour les options Afficher l’étiquette et Toujours afficher.

Sous les Options des entités, vous pouvez choisir d”Étiqueter toutes les parties d’une entité multi-parties et vous
pouvez paramétrer une de Limite du nombre d’étiquettes à afficher. Les couches de polygones et de lignes per-
mettent d’indiquer une taille minimum d’entité pour afficher les étiquettes en utilisant Ne pas afficher d’étiquette
pour les entités plus petites que. Pour les entités polygones, vous pouvez également filtrer les étiquettes à afficher
selon qu’elles sont situées complètement dans l’entité ou non. Pour les entités linéaires, vous pouvez choisir
de Fusionner les lignes connectées pour éviter la duplication d’étiquettes, ce qui permettra un rendu plus aéré,
lorsque conjugué avec les options Distance ou Répéter de l’onglet Emplacement.

Dans la groupe Obstacles, vous pouvez gérer la manière dont les étiquettes et les entités se recouvrent. Activez

l’option Éviter que les étiquettes ne recouvrent des entités pour faire en sorte que les entités de la couche
agissent comme obstacle pour toute étiquette (en incluant les étiquettes des autres entités de la même couche). Un
obstacle est une entité au dessus de laquelle QGIS essaye, dans la mesure du possible, de ne pas placer d’étiquette.
Au lieu d’une couche tout entière, vous pouvez définir un sous-ensemble d’entités comme obstacle en utilisant le

contrôle de valeurs définies par les données sur le côté de l’option.

La jauge de priorité des obstacles vous permet de modifier les préférences de recouvrement
de vos étiquettes par rapport aux entités de certaines couches plutôt qu’à d’autres. Un obstacle de Poids faible
signifie que les entités de la couche sont moins considérées comme des obstacles et ont plus de chances d’être
recouvertes par des étiquettes. Cette priorité peut être définie par des données de telle manière qu’au sein de la
même couche, certaines entités auront plus de chances d’être recouvertes que d’autres.

Pour les couches de polygones, vous pouvez choisir le type d’obstacle que les étiquettes chercheront à éviter :

• Au-dessus de l’entité : évite de placer les étiquettes à l’intérieur du polygone (les étiquettes seront placées
de préférence totalement en dehors ou légèrement à l’intérieur du polygone).
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• Au-dessus des limites de l’entité : évite de placer les étiquettes sur la limite du polygone (les étiquettes
seront placées de préférence en dehors ou complètement à l’intérieur du polygone). Cela peut être utile pour
les limites de régions où les entités recouvrent complètement une surface. Dans ce cas, il est impossible
d’éviter de placer des étiquettes à l’intérieur de ces entités et l’affichage sera meilleur si on évite de placer
les étiquettes sur les limites entre les entités.

Réglage du moteur de placement automatisé

Dans le coin supérieur droit de l’onglet Étiquettes”, vous pouvez utiliser les paramètres |autoPlacement|
:sup:‘Paramètres de placement automatisé (s’applique à toutes les couches) pour configurer un comportement

global et automatique des étiquettes. En cliquant sur le bouton vous disposez des options suivantes :

Figure 13.36: Réglage du moteur de placement automatisé

• La combobox Méthode de recherche vous offre différentes méthodes de placement pour trouver de bonnes
solutions de placement pour l’étiquetage par points, lignes et polygones. Plus de détails dans cet article.

• Les contrôles Nombre de possibilités définissent combien de positions possibles doivent être calculées pour
chaque type d’entité. Plus le nombre de possibilités est élevé, meilleur sera l’étiquetage, mais avec une
répercussion sur la rapidité de rendu. Plus le nombre de possibilités est petit, moins les étiquettes sont bien
placées, mais elles sont plus vite dessinées.

• Dessiner du texte sous forme de contours : contrôle si les étiquettes de texte sont dessinées (et exportées)
sous forme d’objets texte appropriés OU uniquement sous forme de contours. S’ils sont exportés en tant
qu’objets texte, ils peuvent être édités dans des applications externes (par ex. Inkscape) comme du texte
normal. MAIS l’effet secondaire est que la qualité du rendu est diminuée, ET il y a des problèmes avec
le rendu lorsque certains paramètres de texte comme les tampons sont en place. C’est pourquoi il est
recommandé de dessiner des contours. Notez que lorsque vous exportez un modèle vers svg il y a en fait
une priorité pour ce paramètre - donc vous pouvez laisser le rendu du projet sous forme de contours mais
pour un fichier:.svg exporter les étiquettes en texte.

• Autoriser les étiquettes tronquées en bordure de carte : contrôle si les étiquettes qui se trouvent en
bordure de la carte doivent être dessinées. Si cette case est cochée, ces étiquettes s’afficheront (lorsqu’il
n’y a aucun moyen de les afficher complètement dans la zone visible). Si cette case n’est pas cochée, les
étiquettes partiellement visibles seront ignorées.

• Afficher toutes les étiquettes de toutes les couches (y compris les étiquettes en collision). A noter que
cette option peut aussi être définie au niveau de la couche (voir Onglet Rendu)

• Montrer les candidats (pour le débogage) : contrôle si des cases doivent être dessinées sur la carte
montrant tous les candidats générés pour le placement des étiquettes. Il n’est utile que pour déboguer et
tester l’effet des différents paramètres. Ceci pourrait être pratique pour un meilleur placement manuel avec
les outils de la barre d’outils Étiquettes.

13.2. Fenêtre Propriétés d’une couche vecteur 207

https://www.ee.co.za/wp-content/uploads/legacy/PositionIT%202009/PAL_PositIT_Jul09_p56-61.pdf


QGIS User Guide, Version 3.4

Étiquettes basées sur des règles

Avec l’étiquetage basé sur des règles, plusieurs configurations d’étiquettes peuvent être définies et appliquées
sélectivement sur la base des filtres d’expression et de la plage d’échelle, comme dans Ensemble de règles.

Pour créer une règle, sélectionnez l’option Étiquettes basées sur des règles dans la liste déroulante principale

de l’onglet Etiquettes et cliquez sur le bouton en bas de la fenêtre de dialogue. Ensuite, remplissez le dialogue
avec une description et une expression pour filtrer les entités. Vous pouvez également définir une plage d’échelle
Échelle de visualisation dans laquelle la règle d’étiquette doit être appliquée. Les autres options disponibles dans
cette boîte de dialogue sont les options de Paramétrer une étiquette vues précédemment.

Figure 13.37: Paramètres des règles

Un résumé des règles existantes est affiché dans la boîte de dialogue principale (voir figure_labels_rule_based).
Vous pouvez ajouter plusieurs règles, les réorganiser ou les imbriquer par glisser-déposer. Vous pouvez également

les supprimer avec le bouton ou les éditer avec le bouton ou un double-clic.

Figure 13.38: Étiquetage basé sur des règles
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Définir des étiquettes basées sur des expressions

Que vous choisissiez un type d’étiquetage simple ou basé sur des règles, QGIS permet d’utiliser des expressions
pour étiqueter les entités.

En supposant que vous utilisez la méthode Étiquettes simples, cliquez sur l’icône à côté de la liste déroulante
Étiqueter avec de l’onglet Étiquettes des propriétés de la couche .

Dans la figure_labels_expression, il y a un exemple d’expression pour étiqueter la couche d’arbres d’Alaska avec
le type d’arbre et la surface en utilisant le champ “VEGDESC”, du texte descriptif, et la fonction $area en
combinaison avec format_number() pour afficher la surface de manière plus adaptée.

Figure 13.39: Utiliser des expressions pour l’étiquetage

Les Étiquettes basées sur des expressions sont faciles à utiliser. vous devez simplement faire attention aux points
suivants :

• Vous pouvez avoir besoin de combiner tous les éléments (chaînes, champs et fonctions) avec une fonction
de concaténation de chaînes de caractères telle que concat, + ou ||. Sachez que dans certaines situations
(lorsqu’il s’agit de valeurs nulles ou numériques), tous ces outils ne répondront pas de la même façon à vos
besoins.

• Les chaînes de caractères doivent être écrites en utilisant des “guillemets simples”.

• Les champs doivent être écrits avec des « guillemets doubles » ou sans guillemets.

Examinons quelques exemples :

1. Étiquette basée sur deux champs “nom” et” place” avec une virgule comme séparateur: :

"name" || ', ' || "place"

Renvoie

John Smith, Paris

2. Étiquette basée sur deux champs “nom” et “lieu” avec d’autres textes :

'My name is ' + "name" + 'and I live in ' + "place"
'My name is ' || "name" || 'and I live in ' || "place"
concat('My name is ', name, ' and I live in ', "place")

Renvoie

My name is John Smith and I live in Paris
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3. Étiquette basée sur deux champs “nom” et “lieu” avec d’autres textes combinant différentes fonctions de
concaténation :

concat('My name is ', name, ' and I live in ' || place)

Renvoie

My name is John Smith and I live in Paris

Ou, si le champ “lieu” est NULL, renvoie : :

My name is John Smith

4. Étiquette multi-ligne basée sur deux champs “nom” et “lieu” avec un texte descriptif :

concat('My name is ', "name", '\n' , 'I live in ' , "place")

Renvoie

My name is John Smith
I live in Paris

5. Étiquette basée sur un champ et la fonction $area pour afficher le nom du lieu et sa superficie arrondie dans
une unité de surface :

'The area of ' || "place" || ' has a size of '
|| round($area/10000) || ' ha'

Renvoie

The area of Paris has a size of 10500 ha

6. Créer une condition CASE ELSE. Si la valeur de la population dans le champ « population » est <== 50000
c’est une localité (town), sinon c’est une ville (city) :

concat('This place is a ',
CASE WHEN "population" <= 50000 THEN 'town' ELSE 'city' END)

Renvoie

This place is a town

7. Affiche le nom des villes et pas d’étiquette pour les autres entités (pour le contexte « ville », voir exemple
ci-dessus) :

CASE WHEN "population" > 50000 THEN "NAME" END

Renvoie

Paris

Comme vous pouvez le constater dans le constructeur d’expressions, vous avez à votre disposition une centaine
de fonctions pour créer des expressions simples ou très complexes afin d’étiqueter vos données avec QGIS. Voir
Expressions pour plus d’informations et des exemples d’expressions.

Utiliser des valeurs de paramètres définies par les données pour l’étiquetage

Avec la fonction Valeurs définies par des données, les réglages de l’étiquetage sont remplacés par des entrées dans la
table d’attributs ou des expressions basées sur celles-ci. Cette fonction peut être utilisée pour définir des valeurs
pour la plupart des options d’étiquetage décrites ci-dessus.
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Par exemple, en utilisant l’échantillon de données de QGIS sur l’Alaska, étiquetons la couche airports avec
leur nom, en fonction de leur USE militaire, c’est-à-dire si l’aéroport est accessible à :

• les militaires, puis l’afficher en gris, taille 8 ;

• les autres seront affichés en bleu, taille 10.

Pour ce faire, après avoir activé l’étiquetage sur le champ ‘‘NOM”” de calque (voir Paramétrer une étiquette) :

1. Activez l’onglet Texte.

2. Cliquez sur l’icône à droite de Taille.

3. Sélectionnez :guilabel:Editer ... et tapez: :

CASE
WHEN "USE" like '%Military%' THEN 8 -- because compatible values are

→˓'Military'
-- and 'Joint Military/Civilian'

ELSE 10
END

4. Appuyez sur OK pour valider. La boîte de dialogue se ferme et le bouton devient ce qui signifie
qu’une règle est exécutée.

5. Cliquez ensuite sur le bouton à côté de la propriété de couleur, tapez l’expression ci-dessous et validez: :

CASE
WHEN "USE" like '%Military%' THEN '150, 150, 150'
ELSE '0, 0, 255'

END

De même, vous pouvez personnaliser toute autre propriété de l’étiquette, comme vous le souhaitez. Voir plus de

détails sur la description et la manipulation du widget Valeur définie par les données dans la section Valeurs définies
par des données.

La barre d’outils des Étiquettes

La barre d’outils Étiquettes fournit des outils pour manipuler les étiquettes et |diagramme| diagrammes , mais
seulement si l’option correspondante est activée (sinon, les boutons sont désactivés). Il peut être nécessaire que la
couche soit en mode édition.

Pour plus de lisibilité, Etiquette a été utilisée ci-dessous pour décrire la barre d’outils, notez que lorsqu’ils
sont mentionnés par leur nom, les outils fonctionnent presque de la même manière avec les diagrammes :

• Pin/Unpin Labels And Diagrams that has data-defined position. By clicking or draging an area, you pin label(s).
If you click or drag an area holding Shift, label(s) are unpinned. Finally, you can also click or drag an
area holding Ctrl to toggle the pin status of label(s).

• Highlight Pinned Labels And Diagrams. If the vector layer of the label is editable, then the highlighting is green,
otherwise it’s blue.

• Move Label And Diagram that has data-defined position. You just have to drag the label to the desired place.

• Show/Hide Labels And Diagrams that has data-defined visbility. If you click or drag an area holding Shift,
then label(s) are hidden. When a label is hidden, you just have to click or drag an area around the feature’s
point to restore its visibility.

• Rotate Label. Click the label and move around and you get the text rotated.
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Figure 13.40: Les étiquettes des aéroports sont formatées en fonction de leurs attributs

Figure 13.41: La barre d’outils des Étiquettes
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• Change Label. It opens a dialog to change the clicked label properties; it can be the label itself, its coordi-
nates, angle, font, size. . . as long as this property has been mapped to a field.

Avertissement: Label tools overwrite current field values

Using the Label toolbar to customize the labeling actually writes the new value of the property in the mapped
field. Hence, be careful to not inadvertently replace data you may need later!

Note: The Auxiliary Storage Properties mechanism may be used to customize labeling (position, and so on)
without modifying the underlying data source.

Customize the labels from the map canvas

Combiné avec la Barre d’outils Étiquette, le paramètre Définition de données imposée vous aide à manipuler
les étiquettes dans la carte (déplacer, éditer, tourner). Nous décrivons maintenant un exemple utilisant l’option de

Définition de données imposée pour la fonction Déplacer les étiquettes (voir figure_labels_coordinate_data_defined).

1. Importez la couche lakes.shp depuis le jeu de données test de QGIS.

2. Double-cliquez la couche pour ouvrir la fenêtre des Propriétés. Sélectionnez Etiquettes puis Emplacement

et enfin Décalage par rapport au centroïde.

3. Dans le cadre Donnée définie, cliquez sur l’icône pour définir le champ correspondant aux coordonnées.
Choisissez xlabel pour X et ylabel pour Y. Les icônes prennent alors une surbrillance jaune.

Figure 13.42: Étiquetage d’une couche vectorielle de polygones avec l’option “Définition de données imposée”

4. Zoomez sur un lac.

5. Rendez la couche modifiable à l’aide du bouton Basculer en mode édition.

6. Sélectionnez l’outil de la barre d’outils des Étiquettes. Vous pouvez maintenant déplacer l’étiquette
manuellement vers une autre position (voir figure_labels_move). La nouvelle position est sauvegardée dans
les colonnes xlabel et ylabel de votre table attributaire.

7. En utilisant The Geometry Generator avec l’expression ci-dessous, vous pouvez également ajouter un sym-
bole de ligne pour relier chaque lac à son étiquette déplacée :

make_line( centroid( $geometry ), make_point( "xlabel", "ylabel" ) )

Note: The Auxiliary Storage Properties mechanism may be used with data-defined properties without having an
editable data source.
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Figure 13.43: Déplacement d’étiquettes

13.2.5 Propriétés des Diagrammes

L’onglet Diagrammes permet d’ajouter une couche de graphiques sur une couche vecteur (voir fig-
ure_diagrams_attributes).

Cet onglet permet de générer :

• Aucun diagramme: La valeur par défaut, pas de diagramme sur les entités de la couche;

• Diagramme en camembert,un graphique circulaire divisé en tranches pour illustrer les proportions. La
longueur de l’arc de chaque tranche est proportionnelle à la valeur qu’elle représente ;

• |Texte|Diagrammes de texte, un cercle divisé horizontalement montrant les valeurs statistiques à l’intérieur
;

• and Histogramme.

Dans le coin supérieur droit de l’onglet Diagrammes, le bouton Paramètre de placement automatisé (s’applique à toutes les couches)

permet de contrôler la position des diagrammes et étiquettes sur la carte.

Astuce: Basculer rapidement entre les types de diagrammes

Étant donné que les paramètres sont presque tous communs aux différents types de diagramme, lorsque vous
paramétrez votre diagramme, vous pouvez facilement modifier le type de diagramme et retenir celui qui est le plus
adapté à vos données sans perdre aucun paramètre.

Pour chaque type de diagramme, les propriétés sont divisées en plusieurs onglets:

• :ref:‘ Attributs <diagram_attributes>‘
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• Rendu

• Taille

• Position

• Options

• Légende

Attributs

L’onglet Attributs permet de définir les variables à afficher dans le diagramme. Utilisez le bouton
Ajouter un élément pour ajouter les champs sélectionnés dans le panneau Attributs utilisés. Les attributs générés avec
les Expressions peuvent également être utilisés.

Vous pouvez déplacer en haut et en bas n’importe quelle ligne avec un clic et un déplacement, pour trier l’affichage
des attributs. Vous pouvez également modifier l’étiquette dans la colonne “Légende” ou la couleur de l’attribut en
double-cliquant sur l’élément.

This label is the default text displayed in the legend of the print layout or of the layer tree.

Figure 13.44: Propriétés du Diagramme - onglet Attributs

Rendu

Rendering defines how the diagram looks like. It provides general settings that do not interfere with the statistic
values such as:

• the graphic’s opacity, its outline width and color;

• and, depending on the type of diagram:

– the width of the bar in case of histogram;

– the circle background color in case of text diagram, and the font used for texts;

– L’orientation de la ligne située à gauche du premier quartier affiché dans un camembert. Les quartiers
sont affichés dans le sens des aiguilles d’une montre.
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In this tab, you can also manage and fine tune the diagram visibility with different options:

• Diagram z-index: controls how diagrams are drawn on top of each other and on top of labels. A diagram
with a high index is drawn over diagrams and labels;

• Show all diagrams: shows all the diagrams even if they overlap each other;

• Show diagram: allows only specific diagrams to be rendered;

• Always Show: selects specific diagrams to always render, even when they overlap other diagrams or map
labels;

• setting the Scale dependent visibility;

• Discourage diagrams and labels from covering features: defines features to use as obstacles, ie QGIS will
try to not place diagrams nor labels over these features.

Figure 13.45: Diagram properties - Rendering tab

Taille

Size is the main tab to set how the selected statistics are represented. The diagram size units can be “Millimeter”,
“Points”, Pixels, “Map Units” or “Inches”. You can use :

• Une Taille fixe, une taille unique pour représenter les diagrammes de toutes les entités, à l’exception des
histogrammes.

• Ou une Taille pondérée, basée sur une expression utilisant les attributs de la couche.

Position

L’onglet Emplacement permet de définir la position du diagramme. Selon le type gémétrique de la couche, il
présente différentes options de placement:

• “Sur le point” ou “Autour du point” pour les géométries ponctuelles. La dernière variable impose de
paramétrer un rayon maximal.

• “Sur la ligne” ou “A côté de la ligne” pour les géométries linéaires. Comme pour les entités ponctuelles, la
dernière option impose une distance à respecter et l’utilisateur peut indiquer un placement du diagramme
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Figure 13.46: Propriétés du Diagramme - onglet Taille

relatif à l’entité (“au-dessus”, “sur” et/ou “en-dessous” de la ligne). Il est possible de sélectionner plusieurs
options à la fois. Dans ce cas, QGIS cherchera la position optimale du diagramme. Vous pouvez également
utiliser l’orientation de la ligne pour positionner le diagramme.

• “Sur le centroïde”, “Autour du centroïde” (avec une distance paramétrée), “Sur le périmètre” et n’importe
où “A l’intérieur du polygone” sont les options pour les entités polygones.

The diagram can also be placed using feature data to fill the coordinates X and Y fields.

The placement of the diagrams can interact with the labeling, so you can detect and solve position conflicts
between diagrams and labels by setting the Priority slider value.

Options

L’onglet Options offre des paramètres uniquement pour les histogrammes. Vous pouvez choisir si l’orientation de
la barre est de type “Monter”, “Descendre”, “Droite” ou “Gauche”.

Légende

From the Legend tab, you can choose to display items of the diagram in the Le panneau Couches, and in the print
layout legend, next to the layer symbology:

• check Show legend entries for diagram attributes to display in the legends the Color and Legend prop-
erties, as previously assigned in the Attributes tab;

• and, when a scaled size is being used for the diagrams, push the Legend Entries for Diagram Size. . . button
to configure the diagram symbol aspect in the legends. This opens the Data-defined Size Legend dialog
whose options are described in Légende définie par la taille des données.

When set, the diagram legend items (attributes with color and diagram size) are also displayed in the print layout
legend, next to the layer symbology.
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Figure 13.47: Onglet Diagrammes de la fenêtre de Propriétés d’une couche vecteur, sous-onglet Emplacement

Exemple d’utilisation

Nous allons vous montrer un exemple en superposant aux frontières de l’Alaska des données concernant la tem-
pérature issues d’une couche vecteur portant sur le climat. Toutes ces couches sont disponibles dans l’échantillon
de données QGIS (voir section Téléchargement des données exemple).

1. Tout d’abord, cliquez sur le bouton Ajouter une couche vecteur, naviguez jusqu’au jeu de données exemples de
QGIS et ajoutez les deux couches alaska.shp et climate.shp.

2. Double-cliquez sur la couche climate dans la légende pour ouvrir la fenêtre de Propriétés de la Couche.

3. Click on the Diagrams tab and from the Diagram type combo box, select “Text diagram”.

4. Dans l’onglet Apparence, nous choisissons le bleu clair comme couleur de fond et définissons une taille fixe
de 18 mm dans l’onglet Taille.

5. Dans l’onglet Position, l’emplacement défini est Autour du point.

6. Sur le diagramme, nous souhaiterions afficher les valeurs de trois colonnes T_F_JAN, T_F_JUL et

T_F_MEAN. Donc dans le sous-onglet Attributs, sélectionnez T_F_JAN et cliquez sur le bouton puis
faites de même avec les colonnes T_F_JUL et enfin T_F_MEAN.

7. Now click Apply to display the diagram in the QGIS main window.

8. Vous pouvez adapter la taille du graphique dans l’onglet Taille. Activez l’option Taille variable et
définissez la taille des diagrammes en fonction de la Valeur maximale d’un attribut et de l’option Taille. Si

les diagrammes apparaissent trop petits à l’écran, vous pouvez cocher la case Augmenter la taille des
petits diagrammes et définir la Taille minimale des diagrammes.

9. Changez les couleurs des attributs en double-cliquant sur les rectangles colorés dans le champ Attributs
utilisés. Figure_diagrams_mapped donne un aperçu du résultat.

10. Pour finir, cliquez sur OK.

N’oubliez pas que, dans l’onglet Position, en cochant la case Source de définition de la position, vous pouvez
utiliser des valeurs d’attributs pour choisir l’emplacement des diagrammes. Par ailleurs, dans l’onglet Apparence,
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Figure 13.48: Diagrammes issus de données de températures sur une carte

vous pouvez définir la visibilité en fonction de l’échelle.

La taille et les attributs peuvent aussi être une expression. Utilisez le bouton pour ajouter une expression. Voir
Expressions pour plus d’informations et des exemples.

Utiliser des valeurs de paramètres définies par les données

Comme mentionné ci-dessus, vous pouvez utiliser des paramètres définis par les données pour améliorer le rendu
de vos diagrammes :

• la position dans le sous-onglet Emplacement en renseignant les champs X et Y.

• la visibilité dans le sous-onglet Apparence en renseignant le champ Visibilité.

Voir Utiliser des valeurs de paramètres définies par les données pour l’étiquetage pour plus d’informations.

13.2.6 Source Fields Properties

The Source Fields tab provides information on fields related to the layer and helps you organize them.

The layer can be made editable using the Toggle editing mode. At this moment, you can modify its structure using

the New field and Delete field buttons.

You can also rename fields by double-clicking its name. This is only supported for data providers like PostgreSQL,
Oracle, Memory layer and some OGR layer depending on the OGR data format and version.

If set in the underlying data source or in the forms properties, the field’s alias is also displayed. An alias is a
human readable field name you can use in the feature form or the attribute table. Aliases are saved in the project
file.

Depending on the data provider, you can associate a comment with a field, for example at its creation. This
information is retrieved and shown in the Comment column and is later displayed when hovering over the field
label in a feature form.

Other than the fields contained in the dataset, virtual fields and Auxiliary Storage included, the Source Fields tab
also lists fields from any joined layers. Depending on the origin of the field, a different background color is applied
to it.
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For each listed field, the dialog also lists read-only characteristics such as its type, type name, length and
precision. When serving the layer as WMS or WFS, you can also check here which fields could be retrieved.

Figure 13.49: Source Field properties tab

13.2.7 Attributes Form Properties

The Attributes Form tab helps you set up the form to display when creating new features or querying existing
one. You can define:

• the look and the behavior of each field in the feature form or the attribute table (label, widget, constraints. . . );

• the form’s structure (custom or autogenerated):

• extra logic in Python to handle interaction with the form or field widgets.

At the top right of the dialog, you can set whether the form is opened by default when creating new features. This
can be configured per layer or globally with the Suppress attribute form pop-up after feature creation option in
the Settings → Options → Digitizing menu.

Customizing a form for your data

By default, when you click on a feature with the Identify Features tool or switch the attribute table to the form
view mode, QGIS displays a basic form with predefined widgets (generally spinboxes and textboxes — each field
is represented on a dedicated row by its label next to the widget). If relations are set on the layer, fields from the
referencing layers are shown in an embedded frame at the bottom of the form, following the same basic structure.

This rendering is the result of the default Autogenerate value of the Attribute editor layout setting in the Layer
properties → Attributes Form tab. This property holds three different values:

• Autogenerate: keeps the basic structure of « one row - one field » for the form but allows to customize
each corresponding widget.

• Drag-and-drop designer: other than widget customization, the form structure can be made more
complex eg, with widgets embedded in groups and tabs.

• Provide ui file: allows to use a Qt designer file, hence a potentially more complex and fully featured
template, as feature form.
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The autogenerated form

When the Autogenerate option is on, the Available widgets panel shows lists of fields (from the layer and its
relations) that would be shown in the form. Select a field and you can configure its appearance and behavior in the
right panel:

• adding custom label and automated checks to the field;

• setting a particular widget to use.

The drag and drop designer

Choose Drag and drop designer from the Attribute editor layout combobox and you enable a Form Lay-
out panel next to the Available widgets one. From this panel you can create an editor form with several tabs and
named groups to present the attribute fields, as shown for example in figure_fields_form.

Figure 13.50: Formulaire intégré obtenu avec onglets et groupes nommés

To create the form, you can drag and drop fields from the Available Widgets panel to the Form Layout one to have
fields added to your custom form and drag and drop fields inside the Form Layout to reorder their position.

You can also use categories (tab or group frames) to better structure the form. The first step is to use the icon
to create a tab in which fields and groups will be displayed (see figure_fields_layout). You can create as many

categories as you want. Use button to remove any unwanted elements. The next step will be to assign to each
category the relevant fields, by simple drag and drop. You can use the same fields many times.

You can configure tabs or groups with a double-click. QGIS opens a form in which you can:

• choose to hide or show the item label;

• rename the category;

• set over how many columns the fields under the category should be distributed;
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Figure 13.51: Fenêtre de création de catégories avec la Mise en page de l’éditeur d’attribut

• enter an expression to control the category visibility. The expression will be re-evaluated everytime values
in the form change and the tab or groupbox shown/hidden accordingly;

• show the category as a group box (only available for tabs).

With a double-click on a field label, you can also specify whether the label of its widget should be visible or not
in the form.

In case the layer is involved in one or many to many relations (see Créer des relations un ou plusieurs
à plusieurs), referencing layers are listed in the Relations frame and their form can be embedded in the current
layer form by drag-and-drop. Like the other items, double-click the relation label to configure some options:

• choose to hide or show the item label;

• show the link button;

• show the unlink button.

Using custom ui-file

The Provide ui-file option allows you to use complex dialogs made with Qt-Designer. Using a UI-file
allows a great deal of freedom in creating a dialog. Note that, in order to link the graphical objects (textbox,
combobox. . . ) to the layer’s fields, you need to give them the same name.

Use the Edit UI to define the path to the file to use.

You’ll find some example in the Creating a new form lesson of the QGIS-training-
manual-index-reference. For more advanced information, see https://nathanw.net/2011/09/05/
qgis-tips-custom-feature-forms-with-python-logic/.
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Enhance your form with custom functions

QGIS forms can have a Python function that is called when the dialog is opened. Use this function to add extra
logic to your dialogs. The form code can be specified in three different ways:

• load from the environment: use a function, for example in startup.py or from an installed
plugin

• load from an external file: a file chooser will appear in that case to allow you to select a Python
file from your filesystem

• provide code in this dialog: a Python editor will appear where you can directly type the func-
tion to use.

In all cases you must enter the name of the function that will be called (open in the example below).

Un exemple (dans le module MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Reference in Python Init Function like so: open

Configure the field behavior

The main part of the Attributes Form tab helps you set the type of widget used to fill or display values of the field,
in the attribute table or the feature form: you can define how user interacts with each field and the values or range
of values that are allowed to be added to each.

Figure 13.52: Fenêtre d’édition d’une colonne attributaire
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Paramètres généraux

Regardless the type of widget applied to the field, there are some common properties you can set to control whether
and how a field can be edited.

General options

• Alias: a human readable name to use for fields. The alias will be displayed in the feature form, the attribute
table, or in the Identify results panel. It can also be used as field name replacement in the expression builder,
easing expressions understanding and reviews. Aliases are saved in project file.

• Comment: displays the field’s comment as shown in the Source Fields tab, in a read-only state. This
information is shown as tooltip when hovering over the field label in a feature form.

• Editable: uncheck this option to set the field read-only (not manually modifiable) even when the layer
is in edit mode. Note that checking this setting doesn’t override any edit limitation from the provider.

• Label on top: places the field name above or beside the widget in the feature form.

Valeurs par défaut

• Default value: for new features, automatically populates by default the field with a predefined value or an
expression-based one. For example, you can:

– use $x, $length, $area to automatically populate a field with the feature’s X coordinate, length,
area or any geometric information at its creation;

– increment a field by 1 for each new feature using maximum("field")+1;

– save the feature creation datetime using now();

– use variables in expressions, making it easier to e.g. insert the operator name (@user_full_name),
the project file path (@project_path), . . .

A preview of the resulting default value is displayed at the bottom of the widget.

Note: The Default value option is not aware of the values in any other field of the feature being
created so it won’t be possible to use an expression combining any of those values i.e using an expression
like concat(field1, field2) may not work.

• Apply default value on update: whenever the feature attribute or geometry is changed, the default value is
recalculated. This could be handy to save values like last user that modifies data, last time it was changed. . .

Constraints

You can constrain the value to insert in the field. This constraint can be:

• Not null: requires the user to provide a value;

• Unique: guarantee the inserted value to be unique throughout the field;

• based on a custom expression: e.g. regexp_match(col0,'A-Za-z') to ensure that the value of the
field col0 has only alphabetical letter. A short description can be added to help you remember the constraint.

Whenever a value is added or edited in a field, it’s submitted to the existing constraints and:

• if it meets all the requirements, a green check is shown beside the field in the form;
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• if it does not meet all the requirements, then a yellow or red cross is displayed near the field. You can hover
over the cross to remind which constraints are applied to the field and fix the value:

– A yellow cross appears when the unmet constraint is an unenforced one and it does not prevent you to
save the changes with the « wrong » values;

– A red cross can not be ignored and does not allow you to save your modifications until they meet the

constraints. It appears when the Enforce constraint option is checked.

Edit widgets

Based on the field type, QGIS automatically determines and assigns a default widget type to it. You can then
replace the widget with any other compatible with the field type. The available widgets are:

• Checkbox: Displays a checkbox whose state defines the value to insert.

• Classification: Only available when a categorized symbology is applied to the layer, displays a combo box
with the values of the classes.

• Color: Displays a color widget allowing to select a color; the color value is stored as a html notation in the
attribute table.

• Date/Heure : Affiche un champ de type date/heure qui peut ouvrir un calendrier permettant de choisir une
date, une heure ou les deux. Le champ doit être de type texte. Vous pouvez choisir un format personnalisé,
l’affichage d’un calendrier, etc.

• Enumeration: Opens a combo box with predefined values fetched from the database. This is currently only
supported by the PostgreSQL provider, for fields of enum type.

• Attachment: Uses a « Open file » dialog to store file path in a relative or absolute mode. It can also be used
to display a hyperlink (to document path), a picture or a web page.

• Cachée : Un attribut caché sera invisible. L’utilisateur ne pourra pas visualiser son contenu.

• Key/Value: Displays a two-columns table to store sets of key/value pairs within a single field. This is
currently supported by the PostgreSQL provider, for fields of hstore type.

• List: Displays a single column table to add different values within a single field. This is currently supported
by the PostgreSQL provider, for fields of array type.

• Plage : Vous permet de spécifier une plage de valeurs numériques disponibles. Il peut s’agir d’une barre
coulissante ou d’une zone de texte éditable.

• Relation Reference: This widget lets you embed the feature form of the referenced layer on the feature
form of the actual layer. See Créer des relations un ou plusieurs à plusieurs.

• Text Edit (default): This opens a text edit field that allows simple text or multiple lines to be used. If you
choose multiple lines you can also choose html content.

• Unique Values: You can select one of the values already used in the attribute table. If “Editable” is activated,
a line edit is shown with autocompletion support, otherwise a combo box is used.

• Uuid Generator: Generates a read-only UUID (Universally Unique Identifiers) field, if empty.

• Value Map: A combo box with predefined items. The value is stored in the attribute, the description is
shown in the combo box. You can define values manually or load them from a layer or a CSV file.

• Value Relation: Offers values from a related table in a combobox. You can select layer, key column and
value column. Several options are available to change the standard behaviors: allow null value, order by
value, allow multiple selections and use of auto-completer. The forms will display either a drop-down list
or a line edit field when completer checkbox is enabled.

Astuce: Relative Path in Attachment widget
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If the path which is selected with the file browser is located in the same directory as the .qgs project file or below,
paths are converted to relative paths. This increases portability of a .qgs project with multimedia information
attached.

13.2.8 Propriétés des Jointures

L’onglet Jointures permet de joindre une table attributaire chargée à une couche vecteur chargée. Après

avoir cliqué sur le bouton , la fenêtre Ajouter une jointure vectorielle apparaît. Vous devez définir une couche
de jointure à connecter à la couche cible. Ensuite, vous devez définir un champ de jointure qui sera commun à la
table à joindre et à la table attributaire de la couche cible. Vous pouvez enfin spécifier la liste des champs à joindre

en cochant la case Choisir les champs à joindre. Il en résulte que toutes les informations de la table à joindre
seront affichés en plus des champs de la table cible. Si vous avez spécifié une liste de champs à joindre, seuls
ceux-ci apparaîtront dans la table attributaire de la couche cible.

If the target layer is editable, then some icons will be displayed in the attribute table next to fields, in order to
inform their status:

• : the join layer is not configured to be editable. If you want to be able to edit join features from the target

attribute table, then you have to check the option Editable join layer.

• : the join layer is well configured to be editable, but its current status is read only.

• : the join layer is editable but synchronization mechanisms are not activated. If you want to automati-
cally add a feature in the join layer when a feature is created in the target layer, then you have to check the

option Upsert on edit. Symmetrically, the option Delete cascade may be activated if you want to
automatically delete join features.

Moreover, the Dynamic form option helps to synchronize join fields on the fly, according to the Target field.
This way, constraints for join fields are also correctly updated. Note that it’s deactivated by default because it may
be very time consuming if you have a lot of features or a myriad of joins.

Otherwise, the Cache join layer in virtual memory option allows to cache values in memory (without geome-
tries) from the joined layer in order to speed up lookups.

Actuellement, QGIS gère les jointures de tables non spatiales aux formats pris en charge par OGR (par exemple
CSV, DBF, Excel), au format texte délimité et issues de PostgreSQL (voir figure_joins).

De plus, la fenêtre de jointure vous permet de :

• Créer un index des attributs joins

• Choisir les champs à joindre

• Personnaliser le préfixe du champ

13.2.9 Auxiliary Storage Properties

The regular way to customize styling and labeling is to use data-defined properties as described in Valeurs définies
par des données. However, it may not be possible if the underlying data is read only. Moreover, configuring these
data-defined properties may be very time consuming or not desirable! For example, if you want to fully use map
tools coming with La barre d’outils des Étiquettes, then you need to add and configure more than 20 fields in your
original data source (X and Y positions, rotation angle, font style, color and so on).

The Auxiliary Storage mechanism provides the solution to these limitations and awkward configurations. Auxil-
iary fields are a roundabout way to automatically manage and store these data-defined properties (labels, diagram,
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Figure 13.53: Joindre une table attributaire à une couche vectorielle existante

symbology. . . ) in a SQLite database thanks to editable joins. This allows you to store properties for layers that
aren’t editable.

A tab is available in vector layer properties dialog to manage auxiliary storage:

Labeling

Considering that the data source may be customized thanks to data-defined properties without being editable, la-
beling map tools described in La barre d’outils des Étiquettes are always available as soon as labeling is activated.

Actually, the auxiliary storage system needs an auxiliary layer to store these properties in a SQLite database (see
Auxiliary storage database). Its creation process is run the first time you click on the map while a labeling map
tool is currently activated. Then, a window is displayed, allowing you to select the primary key to use for joining
(to ensure that features are uniquely identified):

As soon as an auxiliary layer is configured for the current data source, you can retrieve its information in the tab:

The auxiliary layer now has these characteristics:

• the primary key is ID,

• there are 0 features using an auxiliary field,

• there are 0 auxiliary fields.

Now that the auxiliary layer is created, you can edit the layer labels. Click on a label while the Change Label

map tool is activated, then you can update styling properties like sizes, colors, and so on. The corresponding
data-defined properties are created and can be retrieved:

As you can see in the figure above, 21 fields are automatically created and configured for labeling. For example,
the FontStyle auxiliary field type is a String and is named labeling_fontstyle in the underlying
SQLite database. There is also 1 feature which is currently using these auxiliary fields.
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Figure 13.54: Auxiliary Storage tab

Figure 13.55: Auxiliary Layer creation dialog
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Figure 13.56: Auxiliary Layer key

Notice that the icon is displayed in the Labels properties tab indicating that the data-defined override options
are set correctly:

Otherwise, there’s another way to create an auxiliary field for a specific property thanks to the data-defined override

button. By clicking on Store data in the project, an auxiliary field is automatically created for the Opacity field. If
you click on this button whereas the auxiliary layer is not created yet, then the window Auxiliary Layer creation
dialog is first displayed to select the primary key to use for joining.

Style

Like the method described above for customizing labels, auxiliary fields can also be used to stylize symbols and

diagrams. To do this, click on Data-defined override and select Store data in the project for a specific property. For
example, the Fill color field:

There are different attributes for each symbol (e.g. fill style, fill color, stroke color, etc. . . ), so each auxiliary field
representing an attribute requires a unique name to avoid conflicts. After selecting Store data in the project, a
window opens and displays the Type of the field and prompts you to enter a unique name for the auxiliary field.
For example, when creating a Fill color auxiliary field the following window opens:

Once created, the auxiliary field can be retrieved in the auxiliary storage tab:

Attribute table and widgets

Auxiliary fields can be edited using the attribute table. However, not all auxiliary fields are initially visible in the
attribute table.

Auxiliary fields representing attributes of a layer’s symbology, labeling, appearance, or diagrams will appear
automatically in the attribute table. The exception are attributes that can be modified using the Label Toolbar
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Figure 13.57: Auxiliary Fields

230 Chapter 13. Les données vectorielles



QGIS User Guide, Version 3.4

Figure 13.58: Data-defined properties automatically created

Figure 13.59: Data-defined property menu for symbol
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Figure 13.60: Name of the auxiliary field for a symbol

Figure 13.61: Auxiliary field symbol
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which are hidden by default. Auxiliary fields representing a Color have a widget Color set by default, otherwise
auxiliary fields default to the Text Edit widget.

Auxiliary fields that represent attributes that can be modified using the Label toolbar are Hidden in the at-
tribute table by default. To make a field visible, open the Attribute Form properties tab and change the value
of an auxiliary field Widget Type from Hidden to another relevant value. For example, change the auxil-
iary_storage_labeling_size to Text Edit or change auxiliary_storage_labeling_color to the Color widget.
Those fields will now be visible in the attribute table.

Auxiliary fields in the attribute table will appear like the following image:

Figure 13.62: Form with auxiliary fields

Management

The Auxiliary Layer menu allows you to manage the auxiliary fields:

The first item Create is disabled in this case because the auxiliary layer is already created. But in case of a fresh
work, you can use this action to create an auxiliary layer. As explained in Labeling, a primary key will be needed
then.

The Clear action allows to keep all auxiliary fields, but remove their contents. This way, the number of features
using these fields will fall to 0.

The Delete action completely removes the auxiliary layer. In other words, the corresponding table is deleted from
the underlying SQLite database and properties customization are lost.

Finally, the Export action allows to save the auxiliary layer as a new vector layer. Note that geometries are not
stored in auxiliary storage. However, in this case, geometries are exported from the original data source too.

Auxiliary storage database

When you save your project with the .qgs format, the SQLite database used for auxiliary storage is saved at the
same place but with the extension .qgd.
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Figure 13.63: Auxiliary layer management

For convenience, an archive may be used instead thanks to the .qgz format. In this case, .qgd and .qgs files
are both embedded in the archive.

13.2.10 Propriétés des Actions

QGIS est capable d’effectuer des actions basées sur les attributs d’une entité. Il peut s’agir de nombreuses
actions, par exemple exécuter un programme avec des arguments construits à partir des attributs d’une entité, ou
encore, passer des paramètres à un outil de publication de rapports sur internet.

Les actions sont utiles si vous voulez exécuter fréquemment une application externe ou charger une page web
basée sur une ou plusieurs valeurs de votre couche vecteur. Il en existe six types qui peuvent être utilisés de la
sorte :

• Les actions de type Générique, Mac, Windows et Unix lancent un processus externe.

• Les actions Python lancent un code Python.

• Les actions de type Générique et Python sont disponibles quel que soit le système d’exploitation.

• Les actions Mac, Windows et Unix sont disponibles uniquement depuis les systèmes d’exploitation corre-
spondants (c’est à dire que vous pouvez définir trois actions “Éditer” qui ouvrent un éditeur et les utilisateurs
ne verront que l’action correspondant à leur système d’exploitation).

There are several examples included in the dialog. You can load them by clicking on Create Default Actions. To
edit any of the examples, double-click its row. One example is performing a search based on an attribute value.
This concept is used in the following discussion.

The Show in Attribute Table allows you to display in the attribute table dialog the checked feature-scoped
actions, either as Combo Box or as Separate Buttons (see Configuring the columns).

234 Chapter 13. Les données vectorielles



QGIS User Guide, Version 3.4

Figure 13.64: Vue d’ensemble de la fenêtre Actions avec quelques exemples d’actions

Définir des Actions

To define an attribute action, open the vector Layer Properties dialog and click on the Actions tab. In the Actions

tab, click the Add a new action to open the Edit Action dialog.

Select the action Type and provide a descriptive name for the action. The action itself must contain the name of
the application that will be executed when the action is invoked. You can add one or more attribute field values as
arguments to the application. When the action is invoked, any set of characters that start with a % followed by the
name of a field will be replaced by the value of that field. The special characters %% will be replaced by the value
of the field that was selected from the identify results or attribute table (see using_actions below). Double quote
marks can be used to group text into a single argument to the program, script or command. Double quotes will be
ignored if preceded by a backslash.

The Action Scopes allows you to define where the action should be available. You have 4 different choices:

1. Feature Scope: action is available when right click in the cell within the attribute table.

2. Field Scope: action is available when right click in the cell within the attribute table, in the feature form and
in the default action button of the main toolbar.

3. Layer Scope: action is available in the action button in the attribute table toolbar. Be aware that this type of
action involves the entire layer and not the single features.

4. Canvas: action is available in the main action button in the toolbar.

Si vous avez des noms de champs qui sont contenus dans d’autres noms de champs (par exemple, col1 et col10),
vous devez l’indiquer en entourant le nom de champ (le caractère %) par des crochets (par exemple [%col10]).
Ceci évitera de prendre le nom de champ %col10 pour %col1 avec un 0 à la fin. Les crochets seront retirés
quand QGIS substituera le nom par la valeur du champ. Si vous voulez que le champ à substituer soit entouré de
crochets, utilisez un deuxième jeu de crochets comme ceci : [[%col10]].

En utilisant l’outil Identifier les entités, vous ouvrez la fenêtre Identifier les résultats. Elle inclut une entrée
(Dérivé) qui contient des informations pertinentes selon le type de couche. Les valeurs de cette entrée sont acces-
sibles de la même manière que les autres champs en ajoutant (Derived). avant le nom du champ. Par exemple,
une couche de points a un champ X et Y et leurs valeurs peuvent être utilisées dans l’action avec %(Derived).X
et %(Derived).Y. Les attributs dérivés sont disponibles uniquement depuis la fenêtre Identifier les résultats
mais pas par la Table d’attributs.

Deux exemples d’action sont proposés ci-dessous :
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• konqueror https://www.google.com/search?q=%nam

• konqueror https://www.google.com/search?q=%%

In the first example, the web browser konqueror is invoked and passed a URL to open. The URL performs a
Google search on the value of the nam field from our vector layer. Note that the application or script called by the
action must be in the path, or you must provide the full path. To be certain, we could rewrite the first example as:
/opt/kde3/bin/konqueror https://www.google.com/search?q=%nam. This will ensure that
the konqueror application will be executed when the action is invoked.

Le deuxième exemple utilise la notation %% dont la valeur ne dépend pas d’un champ en particulier. Quand
l’action est invoquée, %% sera remplacé par la valeur du champ sélectionné dans les résultats de l’identification
ou dans la table d’attributs.

Utiliser des Actions

QGIS offers many ways to execute actions you enabled on a layer. Depending on their settings, they can be
available:

• in the drop-down menu of Run Feature Action button from the Attributes toolbar or Attribute table dialog;

• when right-clicking a feature with the Identify Features tool (see Identifying Features for more information);

• from the Identify Results panel, under the Actions section;

• as items of an Actions column in the Attribute Table dialog.

Si vous faites appel à une action qui utilise la notation %%, faites un clic droit sur la valeur du champ que vous
souhaitez passer à l’application ou au script, dans la fenêtre Identifier les résultats ou dans la Table attributaire.

Voici un autre exemple qui récupère des données d’une couche vecteur et qui les insère dans un fichier utilisant

bash et la commande echo (cela ne marchera que sur et peut-être ). La couche en question a des champs
pour le nom d’espèce taxon_name, la latitude lat et la longitude long. Nous souhaiterions faire une sélec-
tion spatiale de localisations et exporter les valeurs des enregistrements sélectionnés dans un fichier texte (ils
apparaissent en jaune sur la carte dans QGIS). Voici l’action qui permettra de le faire :

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Après avoir sélectionné quelques localités et lancé l’action sur chacune d’entre elles, le fichier de destination
ressemblera à ceci :

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

As an exercise, we can create an action that does a Google search on the lakes layer. First, we need to determine
the URL required to perform a search on a keyword. This is easily done by just going to Google and doing a
simple search, then grabbing the URL from the address bar in your browser. From this little effort, we see that the
format is https://www.google.com//search?q=QGIS, where QGIS is the search term. Armed with this information,
we can proceed:

1. Assurez-vous que la couche lakes est chargée.

2. Ouvrez la fenêtre Propriétés de la couche en double cliquant sur la couche dans la légende ou en faisant un
clic droit et en choisissant Propriétés dans le menu qui apparaît.

3. Cliquez sur l’onglet Actions

4. Click Add a new action.

5. Choose the Open action type,

6. Entrez un nom pour l’action, par exemple Recherche Google.
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7. Additionally you can add a Short Name or even an Icon.

8. Choose the action Scope. See Définir des Actions for further information. Leave the default settings for this
example.

9. Pour l’action, nous devons fournir le nom du programme externe à lancer. Dans ce cas, nous allons utiliser
Firefox. Si le programme n’est pas dans votre path, vous devez fournir le chemin complet.

10. Following the name of the external application, add the URL used for doing a Google search, up to but not
including the search term: https://www.google.com//search?q=

11. The text in the Action field should now look like this: https://www.google.com//search?q=

12. Click on the drop-down box containing the field names for the lakes layer. It’s located just to the left of
the Insert button.

13. From the drop-down box, select “NAMES” and click Insert.

14. Votre texte Action ressemble maintenant à :

https://www.google.com//search?q=[%NAMES%]

15. To finalize and add the action, click the OK button.

Figure 13.65: Fenêtre de création de l’action décrite dans l’exemple

L’action est donc entièrement définie et prête à être utilisée. Le texte final de l’action devrait correspondre à ça :

https://www.google.com//search?q=[%NAMES%]

Nous pouvons maintenant utiliser l’action. Fermez la fenêtre Propriétés de la couche et zoomez sur une zone
d’intérêt. Assurez-vous que la couche lakes est active puis identifiez un lac. Dans la fenêtre de résultats, vous
constatez que notre action est maintenant visible :
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Figure 13.66: Sélection de l’entité et choix de l’action

When we click on the action, it brings up Firefox and navigates to the URL https://www.google.com/search?q=
Tustumena. It is also possible to add further attribute fields to the action. Therefore, you can add a + to the end of
the action text, select another field and click on Insert Field. In this example, there is just no other field available
that would make sense to search for.

Vous pouvez définir de multiples actions pour une couche et chacune apparaitra dans la fenêtre Identifier les
résultats.

Depuis la table attributaire, vous pouvez aussi faire appel à des actions via un simple clic droit sur une cellule et
sélection de l’action dans la fenêtre qui s’ouvre.

Vous pouvez imaginer toutes sortes d’utilisations pour ces actions. Par exemple, si vous avez une couche de
points contenant la localisation d’images ou de photos ainsi qu’un nom de fichier, vous pouvez créer une action
qui lancera un visualiseur pour afficher les images. Vous pouvez également utiliser les actions pour lancer des
rapports sur internet pour un champ attributaire ou une combinaison de champs, en les spécifiant de la même
manière que dans l’exemple d’une recherche Google.

Nous pouvons également fournir des exemples plus complexes, notamment sur la manière d’utiliser des actions
Python.

Usually, when we create an action to open a file with an external application, we can use absolute paths, or
eventually relative paths. In the second case, the path is relative to the location of the external program executable
file. But what about if we need to use relative paths, relative to the selected layer (a file-based one, like Shapefile
or SpatiaLite)? The following code will do the trick:

command = "firefox"
imagerelpath = "images_test/test_image.jpg"
layer = qgis.utils.iface.activeLayer()
import os.path
layerpath = layer.source() if layer.providerType() == 'ogr'

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == 'spatialite' else None)

path = os.path.dirname(str(layerpath))
image = os.path.join(path,imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )
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Il faut simplement se rappeler qu’il s’agit d’une action Python et qu’il faut modifier les variables command et
imagerelpath selon vos besoins.

Et si le chemin relatif doit dépendre du fichier de projet (sauvegardé) ? Le code de l’action Python deviendra :

command = "firefox"
imagerelpath = "images/test_image.jpg"
projectpath = qgis.core.QgsProject.instance().fileName()
import os.path
path = os.path.dirname(str(projectpath)) if projectpath != '' else None
image = os.path.join(path, imagerelpath)
import subprocess
subprocess.Popen( [command, image ] )

Un autre exemple d’action Python consiste à ajouter de nouvelles couche au projet. L’exemple qui suit montre
comment ajouter une couche vecteur et un raster. Les noms des fichiers à ajouter au projet et les noms à donner
aux couches dépendent de données attributaires (filename et layername sont deux champs de la table attributaire
de la couche sur laquelle l’action est créée) :

qgis.utils.iface.addVectorLayer('/yourpath/[% "filename" %].shp',
'[% "layername" %]', 'ogr')

Pour ajouter un raster (ici une image TIF), cela devient :

qgis.utils.iface.addRasterLayer('/yourpath/[% "filename" %].tif',
'[% "layername" %]')

13.2.11 Propriétés des Infobulles

The Display tab helps you configure fields to use for feature identification:

• The Display name: based on a field or an expression. This is:

– the label shown on top of the feature information in the Identify tool results;

– the field used in the locator bar when looking for features in all layers;

– the feature identifier in the attribute table form view;

– the map tip information, i.e. the message displayed in the map canvas when hovering over a feature of

the active layer with the Show Map Tips icon pressed. Applicable when no HTML Map Tip is set.

• The HTML Map Tip is specifically created for the map tips: it’s a more complex and full HTML text mixing
fields, expressions and html tags (multiline, fonts, images, hyperlink. . . ).

To activate map tips, select the menu option View → Show Map Tips or click on the Show Map Tips icon of the
Attributes Toolbar. Map tip is a cross-session feature meaning that once activated, it stays on and apply to any
layer in any project, even in future QGIS sessions until it’s toggled off.

13.2.12 Propriétés de Rendu

Visibilité dépendante de l’échelle

Vous pouvez définir une échelle Maximum (inclusive) et Minimum (exclusive), correspondant à une plage
d’échelles pour lesquelles les entités sont visibles. En dehors de cette plage, elles sont cachées. Le bouton

Mettre à l’échelle actuelle du canevas permet d’utiliser l’échelle actuelle pour l’une ou l’autre des limites de la plage de
visibilité. Voir Rendu dépendant de l’échelle pour plus d’informations.
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Figure 13.67: Code HTML pour les infobulles

Figure 13.68: Infobulles basées sur du code HTML
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Simplify geometry

QGIS offers support for on-the-fly feature generalisation. This can improve rendering times when drawing many

complex features at small scales. This feature can be enabled or disabled in the layer settings using the Simplify
geometry option. There is also a global setting that enables generalisation by default for newly added layers (see
global simplification for more information).

Figure 13.69: Fenêtre de simplification de la géométrie d’une couche

Note: La simplification d’entité peut engendrer des artefacts dans les sorties d’affichage dans certains cas. Il peut
s’agir de trous entre les polygones et d’affichage imprécis lors de l’utilisation de couches de symboles basées sur
des décalages.

While rendering extremely detailed layers (e.g. polygon layers with a huge number of nodes), this can cause
layout exports in PDF/SVG format to be huge as all nodes are included in the exported file. This can also make
the resultant file very slow to work with/open in other programs.

En cochant la case Force l’affichage de la couche en tant que raster, les couches sont rasterisées de manière
à ce que les fichiers exportés n’incluent pas l’ensemble des noeuds des couches et que le rendu se fasse plus
rapidement.

You can also do this by forcing the layout to export as a raster, but that is an all-or-nothing solution, given that the
rasterisation is applied to all layers.

Refresh layer at interval (seconds): set a timer to automatically refresh individual layers at a matching interval.
Canvas updates are deferred in order to avoid refreshing multiple times if more than one layer has an auto update
interval set.

Depending on the data provider (e.g. PostgreSQL), notifications can be sent to QGIS when changes are applied to

the data source, out of QGIS. Use the Refresh layer on notification option to trigger an update. You can also

limit the layer refresh to a specific message set in the Only if message is text box.
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13.2.13 Propriétés des Variables

The Variables tab lists all the variables available at the layer’s level (which includes all global and project’s
variables).

It also allows the user to manage layer-level variables. Click the button to add a new custom layer-level

variable. Likewise, select a custom layer-level variable from the list and click the button to remove it.

More information on variables usage in the General Tools Storing values in Variables section.

13.2.14 Propriétés des Métadonnées

The Metadata tab provides you with options to create and edit a metadata report on your layer. Information to
fill concern:

• the data Identification: basic attribution of the dataset (parent, identifier, title, abstract, language. . . );

• the Categories the data belongs to. Alongside the ISO categories, you can add custom ones;

• the Keywords to retrieve the data and associated concepts following a standard based vocabulary;

• the Access to the dataset (licenses, rights, fees, and constraints);

• the Extent of the dataset, either spatial one (CRS, map extent, altitudes) or temporal;

• the Contact of the owner(s) of the dataset;

• the Links to ancillary resources and related information;

• the History of the dataset.

A summary of the filled information is provided in the Validation tab and helps you identify potential issues related
to the form. You can then either fix them or ignore them.

Metadata are currently saved in the project file. It can also be saved as an .XML file alongside file based layers or
in a local .sqlite database for remote layers (e.g. PostGIS).

13.2.15 Dependencies Properties

The Dependencies tab allows to declare data dependencies between layers. A data dependency occurs when a
data modification in a layer, not by direct user manipulation, may modify data of other layers. This is the case for
instance when geometry of a layer is updated by a database trigger or custom PyQGIS scripting after modification
of another layer’s geometry.

In the Dependencies tab, you can select any layers which may externally alter the data in the current layer. Cor-
rectly specifying dependent layers allows QGIS to invalidate caches for this layer when the dependent layers are
altered.

13.2.16 Propriétés de la Légende

The Legend properties tab provides you with advanced settings for the Layers panel and/or the print layout
legend. These options include:

• Text on symbols: In some cases it can be useful to add extra information to the symbols in the legend.
With this frame, you can affect to any of the symbols used in the layer symbology a text that is displayed
over the symbol, in both Layers panel and print layout legend. This mapping is done by typing each text
next to the symbol in the table widget or filling the table using the Set Labels from Expression button. Text
appearance is handled through the font and color selector widgets of the Text Format button.
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Figure 13.70: Setting text on symbols (left) and its rendering in the Layers panel (right)

• a list of widgets you can embed within the layer tree in the Layers panel. The idea is to have a way to
quickly access some actions that are often used with the layer (setup transparency, filtering, selection, style
or other stuff. . . ).

By default, QGIS provides transparency widget but this can be extended by plugins registering their own
widgets and assign custom actions to layers they manage.

13.2.17 QGIS Server Properties

The QGIS Server tab consists of Description, Attribution, MetadataURL, and LegendUrl sections.

You can add or edit a title and abstract for the layer in the Description section. It’s also possible to define a
Keyword list here. These keyword lists can be used in a metadata catalog. If you want to use a title from an XML
metadata file, you have to fill in a link in the DataUrl field.

Utilisez le groupe Attribution pour récupérer les données d’attributs depuis un catalogue de métadonnées XML.

Dans le groupe URL Métadonnées, vous pouvez définir le chemin général d’accès au catalogue de métadonnées
XML. Cette information sera stockée dans le fichier de projet QGIS pour les sessions à venir et sera utilisée par
QGIS Server.

Dans la section LegendUrl, vous pouvez renseigner l’URL d’une image de légende dans le champ approprié. Vous
pouvez utiliser l’option de liste déroulante pour choisir le format de l’image. Pour le moment, seuls les formats
png, jpg et jpeg sont pris en compte.

13.2.18 Digitizing Properties

The Digitizing tab gives access to options that help to ensure the quality of digitized geometries.

Automatic Fixes

Options in the Automatic Fixes section will directly affect the vertices of any geometry which is added or mod-

ified. If the Remove duplicate nodes option is checked, any two subsequent vertices with exactly the same
coordinates will be removed. If the Geometry precision is set, all vertices will be rounded to the closest multiple
of the configured geometry precision. The rounding will happen in the layer coordinate reference system. Z and
M values are not rounded. With many map tools, a grid is shown on the canvas while digitizing.
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Figure 13.71: QGIS Server tab in vector layers properties dialog

Geometry Checks

In the Geometry checks section, additional validations on a per geometry basis can be activated. Immediately after
any geometry modification, failures in these checks are reported to the user in the geometry validation panel. As

long as a check is failing, it is not possible to save the layer. The Is valid check will run basic validity checks
like self intersection on geometries.

Topology Checks

In the Topology checks section, additional topology validation checks can be activated. Topology checks will be
executed when the user saves the layer. Check errors will be reported in the geometry validation panel. As long as
validation errors are present, the layer can not be saved. Topology checks are executed in the area of the bounding
box of the modified features. Since other features may be present in the same area, topological errors concerning
these features are reported as well as errors introduced in the current edit session.
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Figure 13.72: The QGIS Digitizing tab in the vector layers properties dialog
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Topology check option Illustration

The Gap check will check for gaps between neighbouring polygons.

The Overlap check will check for overlaps between neighbouring polygons.

The Missing vertex check will check for shared boundaries of neighbouring poly-
gons where one border misses a vertex which is present on the other one.

13.3 Expressions

Basées sur les données des couches et les fonctions par défaut ou celles définies par l’utilisateur, les Expressions
constituent un moyen efficace de manipuler la valeur d’un attribut, d’une géométrie ou d’une variable afin de mod-
ifier dynamiquement le style d’une géométrie, le contenu ou la position d’une étiquette, la valeur d’un diagramme,
la hauteur d’un objet de mise en page, de sélectionner des entités ou créer des champs virtuels. . .

13.3.1 Le constructeur de chaîne d’expression

Le Constructeur de chaîne d’expression, principale fenêtre de création des expressions, est accessible en maints
endroits dans QGIS, et particulièrement:

• en cliquant sur le bouton ;

• en sélectionnant des entités à l’aide de l’outil Sélectionner les entités en utilisant une expression. . . ;

• en éditant les attributs à l’aide par exemple de l’outil Calculatrice de champ;

• en manipulant la symbologie, l’étiquette, les propriétés des éléments du composeur avec l’outil
Valeurs définies par des données (voir Valeurs définies par des données);

• en paramétrant un symbole de couche de type générateur de géométrie ;

• lors de certains géotraitements.

Le constructeur d’expression vous donne accès à:

• l’onglet Expression qui, grâce à un large panel de fonctions prédéfinies, vous permet d’écrire et vérifier
l’expression à utiliser;

• l’onglet Éditeur de fonctions qui permet d’étendre cette liste par la création de vos propres fonctions.

Exemples d’utilisation des expressions:
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• A partir de la Calculatrice de champ, calculer le champ « pop_density » en utilisant les champs « total_pop »
et « area_km2 »:

"total_pop" / "area_km2"

• Mettre à jour le champ « density_level » avec les catégories basées sur les valeurs de « pop_density »:

CASE WHEN "pop_density" < 50 THEN 'Low population density'
WHEN "pop_density" >= 50 and "pop_density" < 150 THEN 'Medium population

→˓density'
WHEN "pop_density" >= 150 THEN 'High population density'

END

• Appliquer un style catégorisé à l’ensemble des entités selon que le prix moyen des maisons est inférieur ou
non à 10000C le mètre carré:

"price_m2" > 10000

• En utilisant l’outil « Sélectionner à l’aide d’une expression. . . », sélectionner toutes les entités qui représen-
tent des surfaces avec une « grande densité de population » et dont le prix moyen des maisons est supérieur
à 10000C le mètre carré:

"density_level" = 'High population density' and "price_m2" > 10000

De la même manière, l’expression précédente peut également être employée pour définir quelles entités
doivent être étiquetées ou affichées sur la carte.

L’utilisation des expressions vous offre de nombreuses possibilités.

Astuce: Utiliser des paramètres nommés pour améliorer la lecture des expressions

Certaines fonctions ont besoin de définir de nombreux paramètres. Le moteur d’expression permet l’utilisation
de paramètres nommés. Cela signifie qu’au lieu d’écrire une expression cryptique du style clamp( 1, 2,
9), vous pouvez écrire clamp( min:=1, value:=2, max:=9). Cela permet également d’interchanger
l’ordre dans lequel vous indiquez les paramètres, par exemple clamp( value:=2, max:=9, min:=1).
Utiliser des paramètres nommés aide à clarifier quels arguments se réfèrent à quelle fonction, ce qui est utile si
vous relisez cette expression à une date ultérieure !

13.3.2 Liste des fonctions

L’onglet Expression fournit l’interface principale pour écrire des expressions à l’aide de fonctions, attributs de
couche et valeurs. Il contient les gadgets suivants :

• Une surface d’éditeur d’expression pour écrire ou coller des expressions. L’autocomplétion est disponible
pour écrire vos expressions plus rapidement :

– Les noms de variables, de fonctions ou d’attributs correspondants au text d’entrée sont indiqués en-
dessous : utiliser les touches de flèches Up et Down de votre clavier pour naviguer entre les éléments
proposés et appuyer sur la touche Tab pour insérer l’élément dans l’expression ou bien cliquer sur
l’élément souhaité.

– Les paramètres des fonctions sont affichés lors de leur complétion.

QGIS vérifie également la validité de votre expression et met en valeur les erreurs avec :

– Un soulignement : pour les fonctions inconnues, fausses ou des arguments invalides ;

– Un surlignage : pour toutes les autres erreurs (par exemple une parenthèse manquante, un caractère
inattendu) à une position unique.
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Astuce: Document your expression with comments

When using complex expression, it is good practice to add text either as a multiline comment or inline
comments to help you remember.

/*
Labels each region with its highest (in altitude) airport(s)
and altitude, eg 'AMBLER : 264m' for the 'Northwest Artic' region

*/
with_variable(
'airport_alti', -- stores the highest altitude of the region
aggregate(

'airports',
'max',
"ELEV", -- the field containing the altitude
-- and limit the airports to the region they are within
filter := within( $geometry, geometry( @parent ) )

),
aggregate( -- finds airports at the same altitude in the region

'airports',
'concatenate',
"NAME",
filter := within( $geometry, geometry( @parent ) )
and "ELEV" = @airport_alti

)
|| ' : ' || @airport_alti || 'm'
-- using || allows regions without airports to be skipped

)

• Sous la zone l’éditeur d’expression, un Aperçu du résultat vous permet de visualiser le résultat de
l’expression évaluée sur la première entité de la couche. En cas d’erreur, cela l’indique et vous pouvez
accéder aux détails qui vous sont fournis par un hyperlien.

• Un sélecteur de fonctions affiche la liste des fonctions, des variables, des champs. . . organisés par groupes.
Une boîte de recherche est disponible pour filtrer la liste et trouver rapidement une fonction particulière ou
un champ. Double-cliquer sur le nom d’un objet l’ajoute au texte de l’expression en cours de rédaction dans
la zone d’éditeur.

• Un onglet d’aide affiche l’aide pour chaque objet sélectionné dans le sélecteur de fonction.

Astuce: Press Ctrl+Click when hovering a function name in an expression to automatically display its
help in the dialog.

• Un onglet des valeurs de champs s’affiche lorsqu’un champ est sélectionné, un échantillon de ses valeurs
est proposé pour aider à insérer des valeurs d’attributs d’une couche. Double-cliquer sur une valeur l’ajoute
dans le texte de l’expression.

Astuce: The right panel, showing functions help or field values, can be collapsed (invisible) in the dialog. Press
the Show Values or Show Help button to get it back.

Fonctions d’agrégats

Ce groupe contient des fonctions pour agréger des valeurs sur des couches et des champs.
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Figure 13.73: L’onglet Expression

Fonction Description
aggregate Renvoie une valeur agrégée calculée en utilisant les entités d’une autre couche
array_agg Renvoie un tableau de valeurs agrégées à partir d’un champ ou d’une expression.
collect Renvoie la géométrie multipartie des géométries agrégées à partir d’une expression
concatenate Renvoie toutes les chaînes de caractères agrégées d’un champ ou d’une expression, jointes

par un délimiteur
count Renvoie le décompte des entités correspondantes
count_distinct Renvoie le décompte des valeurs distinctes
count_missing Renvoie le décompte des valeurs manquantes (null)
iqr Renvoie la plage inter-quartiles d’un champ ou d’une expression
majority Renvoie les valeurs majoritaires (les valeurs les plus fréquentes) d’un champ ou d’une ex-

pression
max_length Renvoie la longueur maximale des chaînes de caractères d’un champ ou d’une expression
maximum Renvoie la valeur maximale d’un champ ou d’une expression.
mean Renvoie la valeur moyenne d’un champ ou d’une expression.
median Renvoie la valeur médiane d’un champ ou d’une expression.
min_length Renvoie la longueur minimale des chaînes de caractères d’un champ ou d’une expression.
minimum Renvoie la valeur minimale d’un champ ou d’une expression.
minority Renvoie la valeur minoritaire (la moins fréquente) d’un champ ou d’une expression.
q1 Renvoie le premier quartile d’un champ ou d’une expression.
q3 Renvoie le troisième quartile d’un champ ou d’une expression.
range Renvoie la plage de valeur (maximum - minimum) d’un champ ou d’une expression.
rela-
tion_aggregate

Renvoie une valeur agrégée, calculée à partir de toutes les entités enfants correspondantes
dans la couche en relation.

stdev Renvoie l’aggrégat de l’écart-type des valeurs d’un champ ou d’une expression.
sum Renvoie l’aggrégat des sommes de valeurs d’un champ ou d’une expression.

Exemples:

• Retourner le maximum du champ « passengers » depuis les entités groupées sur l’attribut « station_class »
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maximum("passengers", group_by:="station_class")

• Calculer le nombre de total de passagers pour toutes les stations contenues à l’intérieur de l’entité sélection-
née par l’atlas

aggregate('rail_stations','sum',"passengers",
intersects(@atlas_geometry, $geometry))

• Retourner la moyenne du champ « field_from_related_table » pour tous les entités enfants correspondants
à l’aide de la relation “my_relation” depuis la couche

relation_aggregate('my_relation', 'mean', "field_from_related_table")

ou

relation_aggregate(relation:='my_relation', aggregate := 'mean',
expression := "field_from_related_table")

Fonctions Listes

pour la création et la manipulation de listes (également appelés structures de données de liste). L’ordre des valeurs
dans la liste importe, contrairement à la structure de données «carte» <maps_functions>‘, où l’ordre des paires de
clés-valeurs n’est pas pertinent et les valeurs sont identifiées par leurs clés.
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Fonc-
tion

Description

array Renvoie une liste contenant toutes les valeurs passées comme paramètre.
ar-
ray_append

Renvoie une liste avec la valeur donnée ajoutée à la fin.

ar-
ray_cat

Renvoie une liste contenant tous les listes données concaténées.

ar-
ray_contains

Renvoie vrai si une liste contient la valeur donnée.

ar-
ray_distinct

Renvoie une liste contenant les valeurs distinctes de la liste donnée.

ar-
ray_filter

Retourne une liste avec seulement les éléments pour lesquels l’expression est vraie.

ar-
ray_find

Renvoie l’index (0 pour le premier) d’une valeur dans une liste. Renvoie -1 si la valeur n’est pas
trouvée.

ar-
ray_first

Retourne la première valeur d’une liste.

ar-
ray_foreach

Retourne une liste avec l’expression évaluée pour chaque élément.

ar-
ray_get

Renvoie la Nième (0 correspondant à la première) valeur d’une liste.

ar-
ray_insert

Renvoie une liste avec la valeur ajoutée donnée à la position donnée.

ar-
ray_intersect

Renvoie true si tous les éléments de array_1 sont présents dans array_2

ar-
ray_last

Renvoie la dernière valeur d’une liste.

ar-
ray_length

Renvoie le nombre d’éléments d’une liste.

ar-
ray_prepend

Renvoie une liste avec la valeur donnée ajoutée à son début.

ar-
ray_remove_all

Renvoie une liste dont les entrées correspondantes à la valeur donnée ont été supprimées.

ar-
ray_remove_at

Renvoie une liste dont les index donnés ont été supprimés.

ar-
ray_reverse

Renvoie la liste donnée avec des valeurs dans l’ordre inverse.

ar-
ray_slice

Renvoie les valeurs de la liste depuis l’argument index start_pos jusqu’à et en l’incluant l’argument
index end_pos.

ar-
ray_to_string

Concatène les éléments d’une liste en une chaîne de caractères séparée par un délimiteur et utilisant
en option une chaîne de caractères pour les valeurs vides.

gener-
ate_series

Crée une liste contenant une suite de chiffres.

reg-
exp_matches

Renvoie une liste de toutes les chaînes capturées par des groupes de capture, dans l’ordre dans
lequel les groupes eux-mêmes apparaissent dans l’expression régulière fournie par une chaîne.

string_to_arrayDécoupe une chaîne de caractères en une liste en utilisant le délimiteur et l’éventuelle chaîne de
remplacement pour les valeurs vides.

Fonctions de Couleur

Ce groupe contient des fonctions pour manipuler les couleurs.
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Fonction Description
color_cmyk Renvoie une chaîne de caractères représentant une couleur basée sur ses composantes cyan,

magenta, jaune et noire
color_cmyka Renvoie une chaîne de caractères représentant une couleur basée sur ses composantes cyan,

magenta, jaune et noire et alpha (transparence)
color_grayscale_averageApplique un filtre par niveau de gris et renvoie une valeur littérale (en chaîne de caractères)

depuis une couleur en entrée.
color_hsl Renvoie une chaîne de caractères représentant une couleur basée sur ses attributs de teinte,

de saturation et de luminosité
color_hsla Renvoie une chaîne de caractères représentant une couleur basée sur ses attributs de teinte,

de saturation, de luminosité et alpha (transparence).
color_hsv Renvoie une chaîne de caractères représentant une couleur basée sur ses attributs de teinte,

de saturation et de valeur
color_hsva Renvoie une chaîne de caractères représentant une couleur basée sur ses attributs de teinte,

de saturation, de valeur et alpha (transparence)
color_mix_rgb Renvoie une chaîne de caractères représentant une couleur basée sur ses composantes rouge,

verte, bleue et sur la valeur alpha (transparence).
color_part Renvoie une composante spécifique d’une chaîne de caractères de couleur, ex: la com-

posante rouge ou la composante alpha
color_rgb Renvoie une chaîne de caractères représentant une couleur basée sur ses composantes rouge,

verte, bleue
color_rgba Renvoie une chaîne de caractères représentant une couleur basée sur ses composantes rouge,

verte, bleue et sur la valeur alpha (transparence)
create_ramp Renvoie une rampe de dégradé à partir d’une carte de chaînes de couleurs et d’étapes.
darker Renvoie une chaîne de caractères de couleur plus sombre (ou plus claire)
lighter Renvoie une chaîne de caractères de couleur plus claire (ou plus sombre)
project_color Renvoie une couleur du jeu de couleurs du projet
ramp_color Renvoie une chaîne de caractères représentant la couleur d’une rampe de couleur
set_color_part Définit une composante spécifique d’une chaîne de caractères de couleur, ex: la composante

rouge ou la composante alpha

Fonctions conditionnelles

Ce groupe contient des fonctions permettant de gérer des conditions dans les expressions.

Fonction Description
CASE WHEN . . . THEN . . .
END

Évalue une expression et renvoie un résultat si vrai. Vous pouvez tester
plusieurs conditions

CASE WHEN . . . THEN . . .
ELSE . . . END

Évalue une expression et renvoie un résultat différent selon qu’elle est vraie ou
fausse. Vous pouvez tester plusieurs conditions

coalesce Renvoie la première valeur non NULL de la liste en expression.
if Teste une condition et renvoie un résultat selon la condition de vérification

Quelques exemples:

• Envoie une valeur en retour si la première condition est vraie, sinon une autre valeur:

CASE WHEN "software" LIKE '%QGIS%' THEN 'QGIS' ELSE 'Other' END
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Fonctions de conversion

Ce groupe contient des fonctions pour convertir un type de données en un autre (par ex. chaîne à entier, entier à
chaîne).

Fonc-
tion

Description

to_date Convertit une chaîne de caractère en objet date
to_datetimeConvertit une chaîne de caractères en objet de date et de temps
to_dm Convertit une coordonnée en degrés, minutes.
to_dms Convertit une coordonnée en degrés, minutes, secondes.
to_int Convertit une chaîne de caractères en nombre entier
to_interval Convertit une chaîne de caractère en objet d’intervalle de temps (peut être utilisée pour récupérer

les jours, heures, mois, etc. d’une date)
to_real Convertit une chaîne de caractères en nombre réel
to_string Convertit un nombre en chaîne de caractères
to_time Convertit une chaîne de caractères en objet de temps

Fonctions personnalisées

Ce groupe contient les fonctions créées par l’utilisateur. Consultez Éditeur de fonction pour plus de détails.

Fonctions de Date et Heure

Ce groupe contient des fonctions permettant de gérer des données de date et d’heure.

Fonction Description
age Renvoie sous forme d’intervalle la différence entre deux dates ou deux heures.
day Extrait le jour d’une date, ou d’un objet datetime, ou un nombre de jours depuis un intervalle
day_of_week Renvoie le nombre correspondant au jour de la semaine pour une date ou une date et heure

spécifique.
epoch Retourne l’intervale en millisecondes entre l’epoch unix et une date donnée.
hour Extrait l’heure à partir d’une valeur de temps ou de date et de temps ou extrait e nombre d’heures

dans un intervalle
minute Extrait les minutes composant un temps ou une date ainsi que le nombre de minutes dans un

intervalle
month Extrait le mois depuis une date ou une date et heure, ou le nombre de mois dans un intervalle.
now Renvoie la date et le temps actuels
second Extrait les secondes d’un temps ou d’une date et d’un temps ou extrait le nombre de secondes

dans un intervalle de temps.
week Extrait le numéro de semaine d’une date ou d’une date et heure, ou le nombre de semaines dans

un intervalle de temps.
year Extrait l’année d’une date ou d’une date et heure, ou le nombre d’années d’un intervalle de temps.

Ce groupe partage également plusieurs fonctions avec le groupe Fonctions de conversion (to_date, to_time,
to_datetime, to_interval) et avec le groupe Fonctions de Chaîne (format_date).

Quelques exemples :

• Obtenir pour ce jour le mois et l’année en format « numéro_du_mois/année » :
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format_date(now(),'MM/yyyy')
-- Returns '03/2017'

Hormis ces fonctions, soustraire des dates, dates-horaires ou temps avec l’opérateur - (moins) va retourner un
intervalle de temps.

Ajouter ou soustraire un intervalle de temps à une date, une date-horaire ou un temps en utilisant les opérateurs +
(plus) ou - (moins) va retourner une date-horaire.

• Obtenir le nombre de jours depuis la sortie de QGIS 3.0 :

to_date('2017-09-29') - to_date(now())
-- Returns <interval: 203 days>

• La même chose avec le temps :

to_datetime('2017-09-29 12:00:00') - to_datetime(now())
-- Returns <interval: 202.49 days>

• Obtenir la date-horaire de 100 jours à partir de maintenant :

now() + to_interval('100 days')
-- Returns <datetime: 2017-06-18 01:00:00>

Note: Sauvegarder des dates, dates-horaires et intervalles de temps dans des champs

La possibilité de stocker les valeurs date, temps et date-horaire directement dans des champs peut dépendre du
fournisseur de la source de données (par exemple, un Shapefile accepte le format date, mais pas le format date-
horaire ou temps). Voici quelques suggestions pour passer outre cette limitation :

• Les dates, date-horaires et temps peuvent être stockées dans des attributs en format texte avec l’utilisation
de la fonction to_format().

• Les intervalles de temps peuvent être sauvegardés en format de nombre Entier ou Décimal avec l’utilisation
d’une des fonctions d’extraction de date (par exemple day() pour avoir la durée exprimée en jours).

Champs et Valeurs

Contient la liste des champs de la couche.

Double-cliquer sur le nom d’un champ pour l’ajouter à votre expression. Vous pouvez aussi taper le nom de votre
champ entre guillemets ou son :ref:‘alias ‘<configure_field>.

Pour retrouver les valeurs des champs à utiliser dans une expression, sélectionner le champ et dans l’onglet de
champ qui s’affiche choisir entre 10 Samples et All Unique. Les valeurs voulues sont alors affichées et vous
pouvez utiliser la boîte Search au sommet de l’onglet pour filtrer le résultat. Des valeurs échantillonnées peuvent
également être obtenues avec un clic-droit sur un champ.

Pour ajouter une valeur à une expression que vous êtes en train d’écrire, double-cliquez dessus dans la liste pro-
posée. Si la valeur n’est pas une chaîne de caractères, elle sera mise entre apostrophes, sinon, aucune apostrophe
n’est nécessaire.

Fonctions de correspondance floue

Ce groupe contient des fonctions destinées à réaliser des comparaisons floues entre les valeurs.
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Fonction Description
ham-
ming_distance

Renvoie le nombre de caractères situés à des positions correspondantes aux chaînes de caractères
en entrée, où les caractères sont différents.

levensheim Renvoie le nombre minimum d’opérations d’édition de caractère (insertions, suppressions, sub-
stitutions) requis pour transformer une chaîne de caractères en une autre. Mesure la similitude
entre deux chaînes de caractères.

longest_common_substringRenvoie la longueur de la sous-chaîne de caractères commune la plus longue entre deux chaînes
de caractères.

soundex Renvoie la représentation Soundex d’une chaîne de caractères.

Fonctions Générales

Ce groupe contient des fonctions génériques.

Fonc-
tion

Description

env Retourne le contenu d’une variable d’environnement en tant que chaîne de caractères. Si la variable
n’est pas trouvée, NULL sera renvoyé.

eval Évalue une expression passée en chaîne de caractères. Cette fonction est utilisée pour produire les
paramètres dynamiques tels que les variables de contexte ou les champs

is_layer_visibleRenvoie «vrai» si la couche spécifiée est visible.
layer_propertyRenvoie une propriété de couche ou la valeur de ses métadonnées. Il peut s’agir du nom de la couche,

son SCR, son type géométrique, son nombre d’entités. . .
var Renvoie la valeur stockée dans une variable. Voir les fonctions « Variables » plus bas.
with_variableCrée et définit une variable pour tout code d’expression qui sera fourni comme troisième argument.

Ceci n’est utile que pour des expressions compliquées, où la même valeur calculée doit être utilisée
dans différents endroits.

Fonctions de Géométrie

Ce groupe contient des fonctions qui opèrent sur des objets géométriques (par ex. longueur, aire).

Fonction Description
$area Renvoie la surface de l’entité courante
$geometry Renvoie la géométrie de l’entité courante (peut être utilisée en combinaison avec d’autres fonctions)
$length Renvoie la longueur de l’entité courante
$perimeter Renvoie le périmètre de l’entité actuelle
$x Renvoie la coordonnée X de l’entité actuelle.
$x_at(n) Renvoie la coordonnée X du nième noeud de la géométrie de l’entité actuelle.
$y Renvoie la coordonnée Y de l’entité actuelle.
$y_at(n) Renvoie la coordonnée Y du nième noeud de la géométrie de l’entité actuelle.
angle_at_vertex Renvoie la bissectrice de l’angle (angle moyen) de la géométrie pour un sommet spécifique d’une géométrie de polyligne. Les angles sont en degrés dans le sens des aiguilles d’une montre à partir du nord.
area Renvoie la surface d’un objet géométrique polygonal. Les calculs sont effectués dans le Système Spatial de Référence de cette géométrie.
azimuth Renvoie l’azimut par rapport au nord sous forme d’angle en radians mesuré dans le sens des aiguilles d’une montre à partir de la verticale entre point_a et point_b.
boundary Renvoie pour chaque entité la ou les limites de celle ci (c’est-à-dire la limite topologique de la géométrie, voir aussi qgisboundary).
bounds Renvoie une géométrie représentant l’emprise d’une géométrie en entrée. Les calculs sont effectués dans le Système de Coordonnées de Référence de cette géométrie (voir aussi qgisboundingboxes).
bounds_height Renvoie la hauteur de l’emprise d’une géométrie. Les calculs sont effectués dans le Système de Coordonnées de Référence de cette géométrie.
bounds_width Renvoie la largeur de l’emprise d’une géométrie. Les calculs sont effectués dans le Système de Coordonnées de Référence de cette géométrie.
buffer Renvoie une géométrie qui représente l’ensemble des points dont la distance à la géométrie en entrée est inférieure ou égale à une certaine distance. Les calculs sont effectués dans le Système de Coordonnées de Référence de cette géométrie (voir aussi qgisbuffer).
buffer_by_m Crée autour d’une ligne une zone tampon dont le diamètre varie en fonction des mesures « M » à chaque nœud (voir aussi qgisbufferbym).
centroid Renvoie le centre géométrique d’une géométrie (voir aussi qgiscentroids).
closest_point Renvoie le point d’une géométrie qui est le plus proche d’une deuxième géométrie
combine Renvoie la combinaison de deux géométries

Continued on next page
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Table 13.1 – continued from previous page
Fonction Description
contains(a,b) Renvoie 1 (vrai) si et seulement si aucun point de la géométrie b ne se situe à l’extérieur de la géométrie a et qu’au moins un point de l’intérieur de b est situé à l’intérieur de a.
convex_hull Renvoie l’enveloppe convexe d’une géométrie (elle représente la géométrie convexe minimale qui entoure toutes les géométries du jeu de données, voir aussi qgisconvexhull).
crosses Renvoie 1 (vrai) si les géométries fournies contiennent quelques points intérieurs en commun, sans que tous les points ne le soient.
difference(a,b) Renvoie une géométrie qui représente la partie de la géométrie A qui ne s’intersecte pas avec la géométrie B (voir aussi qgisdifference).
disjoint Renvoie 1 (vrai) si les géométries ne partagent aucun espace ensemble.
distance Renvoie la distance minimale (basée sur le Système de Coordonnée de Référence) entre deux géométries dans les unités de la projection.
distance_to_vertex Renvoie la distance le long de la géométrie à un sommet spécifié
end_point Renvoie le dernier nœud d’une géométrie (voir aussi qgisextractspecificvertices).
extend Prolonge le départ et l’arrivée d’une géométrie polyligne d’une valeur spécifiée (voir aussi qgisextendlines)
exterior_ring Renvoie une ligne représentant l’anneau extérieur d’une géométrie de polygone. Si la géométrie n’est pas un polygone alors le résultat sera NULL.
extrude(geom,x,y) Renvoie une version extrudée d’une géométrie (Multi-)Courbe ou d’une (Multi-)Polyligne avec une extension indiquée par X et Y.
flip_coordinates Retourne une copie de la géométrie avec les valeurs de coordonnées X et Y inversées. Il peut être utilisé pour réparer des géométries dont les valeurs de latitude et de longitude ont été inversées (voir aussi qgisswapxy).
geom_from_gml Renvoie une géométrie créée à partir d’une représentation géométrique GML
geom_from_wkt Renvoie une géométrie créée à partir d’une représentation well-known text (WKT)
geom_to_wkt Renvoie la représentation well-known text (WKT) d’une géométrie sans les métadonnées de SRID
geometry Renvoie la géométrie d’une entité
geometry_n Renvoie la nième géométrie d’une collection de géométrie ou NULL si la géométrie en entrée n’est pas une collection.
hausdorff_distance Renvoie la distance de Hausdorff entre les deux géométries. C’est une mesure de la dissimilarité entre deux géométries, une petite distance indiquant que les géométries sont assez similaires.
inclination Renvoie l’inclinaison mesurée du zénith (0) au nadir (180) du point_a au point_b.
interior_ring_n Renvoie la géométrie du nième anneau intérieur d’une géométrie polygonale ou NULL si la géométrie n’est pas un polygone.
intersection Renvoie une géométrie qui représente la portion commune de deux géométries (voir aussi qgisintersection).
intersects Teste si une géométrie en intersecte une autre. Renvoie 1 (vrai) si les géométries s’intersectent (partage n’importe quelle portion de leur surface) et 0 dans le cas contraire.
intersects_bbox Teste si une emprise de géométrie en chevauche une autre. Renvoie 1 (vrai) si les géométries intersectent (partage au moins un espace commun) leurs emprises respectives et 0 dans le cas contraire.
is_closed Renvoie TRUE si une ligne est fermée (si le point de début et le point de fin sont identiques) ou FALSE si une ligne n’est pas fermée. Si la géométrie n’est pas une ligne, le résultat sera NULL.
length Renvoie la longueur d’une entité ayant une géométrie linéaire (ou la longueur d’une chaîne de caractères).
line_interpolate_angle Renvoie l’angle parallèle à la géométrie à une distance spécifiée le long d’une polyligne. Les angles sont en degrés dans le sens des aiguilles d’une montre par rapport au nord.
line_interpolate_point Renvoie l’interpolation d’un point situé à une certaine distance le long d’une géométrie de type polyligne (voir aussi qgisinterpolatepoint).
line_locate_point Renvoie la distance le long d’une géométrie de type polyligne correspondant à la longueur de cette ligne à la plus proche position d’un point spécifié.
line_substring Renvoie la partie d’une ligne (ou courbe) comprise entre les distances de début et de fin spécifiées (mesurées à partir du début de la ligne, voir aussi qgislinesubstring).
line_merge Renvoie une géométrie de type (multi)polyligne dans laquelle toutes les polylignes connectées de la geométrie en entrée ont été fusionnées en une seule polyligne.
m Renvoie la valeur M d’une géométrie de type point.
make_circle Crée une géométrie circulaire basée sur un point central et un rayon.
make_ellipse Crée une géométrie elliptique basée sur un point central, des axes et un azimut.
make_line Créé une géométrie linéaire à partir d’une série de géométries ponctuelles
make_point(x,y,z,m) Renvoie une géométrie ponctuelle à partir des valeurs X et Y (et optionnellement des valeurs Z et M).
make_point_m(x,y,m) Renvoie une géométrie ponctuelle à partir de coordonnées X et Y et d’une valeur M.
make_polygon Créé une géométrie polygonale à partir d’un anneau externe et de séries optionnelles de géométries d’anneaux internes
make_regular_polygon Crée un polygone régulier.
make_triangle Crée un triangle.
minimal_circle Retourne le plus petit cercle contenant une géométrie donnée (voir aussi qgisminimumenclosingcircle).
nodes_to_points Renvoie une géométrie multi-point composée de chaque nœud de la géométrie en entrée (voir aussi qgisextractvertices).
num_geometries Renvoie le nombre de géométries dans une collection de géométrie ou NULL si la géométrie en entrée n’est pas une collection
num_interior_rings Renvoie le nombre d’anneaux intérieurs dans un polygone ou dans une collection de géométrie ou NULL si la géométrie en entrée n’est pas un polygone ou une collection
num_points Renvoie le nombre de sommets d’une géométrie
num_rings Renvoie le nombre d’anneaux (incluant les anneaux extérieurs) d’un polygone ou d’une collection de géométrie ou bien NULL si la géométrie en entrée n’est pas un polygone ou une collection
offset_curve Renvoie une géométrie formée en décalant sur un côté une géométrie de type polyligne. Les distances sont exprimées dans le Système de Coordonnées de Référence de cette géométrie (voir aussi qgisoffsetline).
order_parts Ré-arrange les parties d’une géométrie multiple selon le critère donné
oriented_bbox Renvoie une géométrie qui représente la zone de délimitation orientée minimale d’une géométrie en entrée (voir aussi qgisorientedminimumboundingbox).
overlaps Teste si une géométrie recouvre totalement une autre. Renvoie 1 (vrai) si les géométries partagent la même surface, sont de même dimension mais ne sont pas complètement contenues l’une dans l’autre.
perimeter Renvoie le périmètre d’un objet géométrique polygonal. Les calculs sont effectués dans le Système Spatial de Référence de cette géométrie.
point_n Renvoie un nœud spécifique d’une géométrie (voir aussi qgisextractspecificvertices).
point_on_surface Renvoie un point qui est certainement situé à la surface d’une géométrie (voir aussi qgispointonsurface).
pole_of_inaccessibility Calcule une approximation du pôle d’inaccessibilité pour une surface, qui est le point de la surface le plus éloigné de ses bords (voir aussi qgispoleofinaccessibility).

Continued on next page
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Table 13.1 – continued from previous page
Fonction Description
project Renvoie un point projeté depuis un point de départ en utilisant une distance et une direction (azimut) en radians (voir aussi qgisprojectpointcartesian).
relate Teste ou renvoie la représentation du Modèle Dimensionnel Étendu à 9 Intersections (DE-9IM en anglais) de la relation entre deux géométries.
reverse Inverse la direction d’une géométrie linéaire en inversant l’ordre de ses sommets (voir aussi qgisreverselinedirection).
segments_to_lines Renvoie une géométrie multi-ligne composée d’une ligne pour chaque segment de la géométrie en entrée (voir aussi qgisexplodelines).
shortest_line Renvoie la plus courte ligne joignant deux géométries. La ligne résultante commencera sur la géométrie 1 et se terminera sur la géométrie 2
simplify Simplifie la géométrie en retirant des nœuds selon une distance-seuil (voir aussi qgissimplifygeometries).
simplify_vw Simplifie la géométrie en retirant des nœuds selon une surface-seuil (voir aussi qgissimplifygeometries).
single_sided_buffer Renvoie une géométrie formée par un tampon appliqué sur un seul côté d’une géométrie de type polyligne. Les distances sont exprimées dans le Système de Coordonnées de Référence de cette géométrie (voir aussi qgissinglesidedbuffer).
smooth Lisse une géométrie en ajoutant des nœuds supplémentaires qui arrondissent les coins de la géométrie (voir aussi qgissmoothgeometry).
start_point Renvoie le premier nœud d’une géométrie (voir aussi qgisextractspecificvertices).
sym_difference Renvoie une géométrie qui représente les portions non superposées de deux géométries (voir aussi qgissymmetricaldifference).
tapered_buffer Crée autour d’une ligne une zone tampon dont le diamètre varie uniformément du début jusqu’à la fin de la ligne (voir aussi qgistaperedbuffer).
touches Teste si deux géométries se touchent. Renvoie 1 (vrai) si les géométries ont au moins un point en commun mais que leurs surfaces intérieures ne s’intersectent pas
transform Renvoie la géométrie transformée d’un SCR source vers un SCR cible (voir aussi qgisreprojectlayer).
translate Renvoie une version translatée d’une géométrie. Les calculs sont effectués dans le Système de Coordonnées de Référence de cette géométrie (voir aussi qgistranslategeometry).
union Renvoie une géométrie qui représente l’ensemble de points unis des géométries
wedge_buffer Renvoie un tampon avec angles depuis une géométrie de point selon un angle et un rayon (voir aussi qgiswedgebuffers).
within (a,b) Teste si une géométrie est située complètement à l’intérieur d’une autre. Renvoie 1 (vrai) si la géométrie a est contenue complètement dans la géométrie b
x Renvoie la coordonnée X d’une géométrie ponctuelle ou la coordonnée X du centroïde d’une géométrie non ponctuelle
x_min Renvoie la coordonnée X minimale d’une géométrie. Les calculs sont effectués dans le Système de Coordonnées de Référence de la géométrie.
x_max Renvoie la coordonnée Y maximale d’une géométrie. Les calculs sont effectués dans le Système de Coordonnées de Référence de la géométrie.
y Renvoie la coordonnée Y d’une géométrie ponctuelle ou la coordonnée Y du centroïde d’une géométrie non ponctuelle
y_min Renvoie la coordonnée Y minimale d’une géométrie. Les calculs sont effectués dans le Système de Coordonnées de Référence de la géométrie.
y_max Renvoie la coordonnée Y maximale d’une géométrie. Les calculs sont effectués dans le Système de Coordonnées de Référence de la géométrie.
z Renvoie la coordonnée Z d’une géométrie de type point

Quelques exemples :

• Vous pouvez manipuler la géométrie de l’entité avec la variable $geometry afin de créer une zone tampon
ou représenter le centroïde:

buffer( $geometry, 10 )
point_on_surface( $geometry )

• Renvoie la coordonnée X du centroïde de l’entité courante:

x( $geometry )

• Renvoie une valeur selon la surface de l’entité:

CASE WHEN $area > 10 000 THEN 'Larger' ELSE 'Smaller' END

Fonctions de Mise en Page

Ce groupe contient des fonctions pour manipuler les propriétés des objets des mises en pages.

Fonction Description
item_variablesRenvoie une table de correspondance des variables d’un élément de la mise en page à l’intérieur

de cette mise en page.
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Quelques exemples:

• Obtenir l’échelle de la « Map 0 » dans la mise en page courante:

map_get( item_variables('Map 0'), 'map_scale')

Couches

Ce groupe contient une liste des couches disponibles dans le projet courant. Il propose ainsi une façon simple de
se référer à des couches dans une expression, par exemple pour exécuter des requêtes d’agrégation, attributaires
ou spatiales.

Maps Functions

This group contains functions to create or manipulate keys and values of map data structures (also known as
dictionary objects, key-value pairs, or associative arrays). Unlike the list data structure where values order matters,
the order of the key-value pairs in the map object is not relevant and values are identified by their keys.

Fonction Description
hstore_to_mapCreates a map from a hstore-formatted string
json_to_map Creates a map from a json-formatted string
map Returns a map containing all the keys and values passed as pair of parameters
map_akeys Returns all the keys of a map as an array
map_avals Returns all the values of a map as an array
map_concat Returns a map containing all the entries of the given maps. If two maps contain the same key,

the value of the second map is taken.
map_delete Returns a map with the given key and its corresponding value deleted
map_exist Returns true if the given key exists in the map
map_get Returns the value of a map, given it’s key
map_insert Returns a map with an added key/value
map_to_hstoreMerges map elements into a hstore-formatted string
map_to_json Merges map elements into a json-formatted string

Fonctions mathématiques

Ce groupe contient des fonctions mathématiques (par ex. racine carré, sin et cos).
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Fonc-
tion

Description

abs Renvoie la valeur absolue d’un nombre
acos Renvoie le cosinus inverse d’une valeur en radians
asin Renvoie le sinus inverse d’une valeur en radians
atan Returns the inverse tangent of a value in radians
atan2(y,x) Returns the inverse tangent of Y/X by using the signs of the two arguments to determine the quadrant

of the result
az-
imuth(a,b)

Renvoie l’azimut par rapport au nord sous forme d’angle en radians mesuré dans le sens des aiguilles
d’une montre à partir de la verticale entre le point a et le point b.

ceil Arrondi un nombre vers le haut
clamp Restreint une valeur d’entrée à une plage spécifique
cos Renvoie le cosinus d’une valeur en radians
degrees Convertit des angles en radians vers des degrés
exp Renvoie l’exponentiel d’une valeur
floor Arrondit un nombre vers le bas
inclina-
tion

Returns the inclination measured from the zenith (0) to the nadir (180) on point_a to point_b.

ln Renvoie la valeur du logarithme népérien de l’expression en argument
log Renvoie la valeur du logarithme selon la valeur et la base en arguments
log10 Renvoie la valeur du logarithme en base 10 de l’expression en argument
max Returns the largest not null value in a set of values
min Returns the smallest not null value in a set of values
pi Renvoie la valeur de Pi pour utilisation dans d’autres calculs
radians Convertit des angles en degrés vers des radians
rand Renvoie un entier aléatoire selon la plage spécifiée entre les valeurs minimale et maximale (inclu-

sives)
randf Renvoie un nombre décimal aléatoire selon la plage spécifiée entres les valeurs minimale et maxi-

male (inclusives)
round Arrondi au nombre de décimales indiqué
scale_exp Transforme une valeur donnée d’un domaine d’entrée à une plage de sortie en utilisant une courbe

exponentielle
scale_linearTransforme une valeur donnée d’un domaine d’entrée à une plage de sortie en utilisant une interpo-

lation linéaire
sin Renvoie le sinus d’un angle
sqrt Renvoie la racine carrée d’une valeur
tan Renvoie la tangente d’un angle

Opérateurs

Ce groupe contient des opérateurs (ex: +, -, *). Merci de noter que pour la majorité des fonctions mathématiques
ci-dessous, si l’une des entrées est NULL alors le résultat vaudra NULL.
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Fonction Description
a + b Addition de deux valeurs (a plus b)
a - b Soustraction de deux valeurs (a moins b)
a * b Multiplication de deux valeurs ( a multiplié par b)
a / b Division de deux valeurs ( a divisé par b)
a % b Reste de la division de a par b (par ex. 7 % 2 = 1 car 2 est présent trois fois dans 7 et il

reste 1)
a ^ b Puissance de deux valeurs (par ex. 2^2=4 ou 2^3=8)
a < b Compare deux valeurs et renvoie 1 si la valeur de gauche est moins grande que la valeur

de droite (a inférieur à b)
a <= b Compare deux valeurs et renvoie 1 si la valeur de gauche est moins grande ou égale à la

valeur de droite
a <> b Compare deux valeurs et renvoie 1 si elle ne sont pas égales
a = b Compare deux valeurs et renvoie 1 si elles sont égales
a != b Compare deux valeurs et renvoie 1 si elle ne sont pas égales
a > b Compare deux valeurs et renvoie 1 si la valeur de gauche est plus grande que la valeur de

droite (a supérieur à b)
a >= b Compare deux valeurs et renvoie 1 si la valeur de gauche est plus grande ou égale à la

valeur de droite
a ~ b Teste si a correspond à l’expression régulière b
|| Fusionne deux valeurs ensemble dans une chaîne de caractères. Si l’une des valeurs vaut

NULL, le résultat sera NULL.
“\n” Insère un retour à la ligne dans une chaîne de caractères
LIKE Renvoie 1 si le premier paramètre correspond au motif défini
ILIKE Renvoie 1 si le premier paramètre correspond au motif fourni de manière non sensible à la

casse (ILIKE peut être utilisé à la place d’LIKE pour rendre la correspondance sensible à
la casse)

a IS b Teste si deux valeurs sont identiques. Renvoie 1 si a est identique à b
a OR b Renvoie 1 lorsque la condition a ou b est vraie
a AND b Renvoie 1 lorsque les conditions a et b sont vraies
NOT Inverse une condition
nom de colonne
« nom de
colonne »

Valeur de la colonne « nom de la colonne ». Attention à ne pas confondre avec les
guillemets simples, voir ci-dessous

“texte” Une chaîne de caractère. Attention à ne pas confondre avec les guillemets doubles, voir
ci-dessus

NULL valeur nulle
a IS NULL a n’a pas de valeur
a IS NOT NULL a a une valeur
a IN
(valeur[,valeur])

a fait partie des valeurs listées

a NOT IN
(valeur[,valeur])

a ne fait pas partie des valeurs listées

Note: Au sujet de l’agrégation de champs

Vous pouvez concaténer du texte à l’aide des opérateurs || ou +. Le dernier correspondant aussi à la fonction
d’addition, si vous avez un nombre (que ce soit comme valeur de champ ou valeur saisie), votre formule peut être
sujette à erreur. Préférez dans ce cas l’usage de ||. Si vous concaténez deux textes, alors vous pouvez utiliser
n’importe lequel.
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Quelques exemples :

• Concatène une chaîne et une valeur depuis un nom de colonne:

'My feature''s id is: ' || "gid"
'My feature''s id is: ' + "gid" => triggers an error as gid is an integer
"country_name" + '(' + "country_code" + ')'
"country_name" || '(' || "country_code" || ')'

• Teste si la « description » du champ d’attribut commence avec la chaîne “Hello” dans la valeur (notez la
position du caractère %):

"description" LIKE 'Hello%'

Rasters Functions

This group contains functions to operate on raster layer.

Fonction Description
raster_statistic Returns statistics from a raster layer
raster_value Returns the raster band value at the provided point

Record and Attributes Functions

Ce groupe contient des fonctions qui permettent d’accéder aux identifiants des enregistrements.

Fonction Description
$current-
feature

Renvoie l’entité courante évaluée. Cette fonction peut être utilisée en combinaison avec la fonc-
tion “attribute” pour renvoyer les valeurs d’attribut de l’entité courante.

$id Renvoie l’identifiant de l’entité de la ligne actuelle
attribute Returns the value of a specified attribute from a feature
get_feature Returns the first feature of a layer matching a given attribute value
get_feature_by_idReturns the feature of a layer matching the given feature ID
is_selected Returns if a feature is selected
num_selectedReturns the number of selected features on a given layer
repre-
sent_value

Returns the configured representation value for a field value (convenient with some widget types)

uuid Génère un Identifiant Universel Unique (UUID) pour chaque ligne. Chaque UUID occupe 38
caractères

Quelques exemples :

• Renvoie la première entité d’une couche « Layer A » dont le champ « id » a la même valeur que le champ
« name » de l’entité courante (une sorte de jointure):

get_feature( 'layerA', 'id', attribute( $currentfeature, 'name') )

• Calcule la surface de l’entité jointe à partir de l’exemple précédent:

area( geometry( get_feature( 'layerA', 'id', attribute( $currentfeature, 'name
→˓') ) ) )
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Fonctions de Chaîne

Ce groupe contient des fonctions qui opèrent sur des chaînes (par ex. qui remplace, convertit en majuscule).

Fonction Description
char Renvoie le caractère associé à un code Unicode.
concat Concatène plusieurs chaînes de caractères dans une seule.
format Formatte une chaîne de caractères en utilisant les arguments fournis.
for-
mat_date

Formatte une date ou une chaîne de caractères dans un format de chaîne personnalisé.

for-
mat_number

Renvoie un nombre formaté selon le séparateur de milliers de la langue courante (tronque égale-
ment le nombre selon le nombre de chiffres indiqués).

left(string,
n)

Renvoie un extrait de chaîne de caractères contenant les n caractères les plus à gauche de la chaîne
initiale

length Renvoie la longueur d’une chaîne de caractères (ou la longueur d’une entité géométrique linéaire).
lower Convertit une chaîne de caractères en minuscules.
lpad Returns a string padded on the left to the specified width, using the fill character
reg-
exp_match

Returns the first matching position matching a regular expression within a string, or 0 if the sub-
string is not found

reg-
exp_replace

Renvoie une chaîne de caractères en utilisant une expression rationnelle de substitution

reg-
exp_substr

Renvoie la portion d’une chaîne de caractères qui correspond à une expression rationnelle fournie

replace Returns a string with the supplied string, array, or map of strings replaced by a string, an array of
strings or paired values

right(string,
n)

Renvoie un extrait de chaîne de caractères contenant les n caractères les plus à droite de la chaîne
initiale

rpad Returns a string padded on the right to the specified width, using the fill character
strpos Returns the first matching position of a substring within another string, or 0 if the substring is not

found
substr Renvoie une partie de chaîne de caractères
title Convertit l’ensemble des mots d’une chaîne de caractères en casse de titre (tous les mots sont en

minuscule sauf la première lettre du mot qui est en majuscule)
trim Supprime tous les caractères d’espace (espaces, tabs, etc.) situés au début ou à la fin d’une chaîne

de caractères.
upper Convertit une chaîne de caractères en majuscules.
word-
wrap

Renvoie une chaîne de caractères découpée par les caractères espace, selon un nombre minimum
ou maximum de caractères

Fonctions de variables

Ce groupe contient les variables dynamiques liées à l’application, le fichier de projet et les autres paramètres. Cela
implique que certaines fonctions peuvent ne pas être disponibles selon le contexte:

• à partir de la boîte de dialogue Sélection les entités en utilisant une expression.

• à partir de la boîte de dialogue Calculatrice de champs.

• à partir de la boîte de dialogue des propriétés de la couche.

• from the print layout

Pour utiliser ces fonctions dans une expression, elles doivent être précédées par le caractère @ (ex:
@row_number). Sont concernées:
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Fonction Description
algorithm_id Returns the unique ID of an algorithm
atlas_feature Renvoie l’entité courante de l’atlas (sous forme d’objet entité).
atlas_featureid Renvoie l’ID de l’entité courante de l’atlas.
atlas_featurenumber Returns the current atlas feature number in the layout
atlas_filename Renvoie le nom de fichier de l’atlas courant.
atlas_geometry Renvoie la géométrie de l’entité courante de l’atlas.
atlas_layerid Returns the current atlas coverage layer ID
atlas_layername Returns the current atlas coverage layer name
atlas_pagename Renvoie le nom de la page courante de l’atlas.
atlas_totalfeatures Renvoie le nombre total d’entités de l’atlas.
canvas_cursor_point Returns the last cursor position on the canvas in the project’s geographical coordinates
cluster_color Returns the color of symbols within a cluster, or NULL if symbols have mixed colors
cluster_size Returns the number of symbols contained within a cluster
current_feature Returns the feature currently being edited in the attribute form or table row
current_geometry Returns the geometry of the feature currently being edited in the form or the table row
geometry_part_count Returns the number of parts in rendered feature’s geometry
geometry_part_num Returns the current geometry part number for feature being rendered
geometry_point_count Returns the number of points in the rendered geometry’s part
geometry_point_num Returns the current point number in the rendered geometry’s part
grid_axis Renvoie l’annotation des axes de la grille courante (ex: “x” pour la longitude et “y” pour la latitude).
grid_number Renvoie la valeur d’annotation de la grille courante.
item_id Returns the layout item user ID (not necessarily unique)
item_uuid Returns the layout item unique ID
layer Returns the current layer
layer_id Renvoie l’ID de la couche actuelle.
layer_name Retourne le nom de la couche actuelle
layout_dpi Renvoie la résolution de la composition (DPI).
layout_name Returns the layout name
layout_numpages Returns the number of pages in the layout
layout_page Returns the page number of the current item in the layout
layout_pageheight Returns the active page height in the layout (in mm)
layout_pagewidth Returns the active page width in the layout (in mm)
map_crs Returns the Coordinate reference system of the current map
map_crs_definition Returns the full definition of the Coordinate reference system of the current map
map_extent Returns the geometry representing the current extent of the map
map_extent_center Renvoie l’entité ponctuelle située au centre de la carte.
map_extent_height Retourne la hauteur actuelle de la carte
map_extent_width Retourne la largeur actuelle de la carte
map_id Returns the ID of current map destination. This will be “canvas” for canvas renders, and the item ID for layout map renders
map_layer_ids Returns the list of map layer IDs visible in the map
map_layers Returns the list of map layers visible in the map
map_rotation Retourne la rotation actuelle de la carte
map_scale Renvoie l’échelle actuelle de la carte.
map_units Returns the units of map measurements
notification_message Content of the notification message sent by the provider (available only for actions triggered by provider notifications).
parent Refers to the current feature in the parent layer, providing access to its attributes and geometry when filtering an aggregate function
project_abstract Returns the project abstract, taken from project metadata
project_author Returns the project author, taken from project metadata
project_basename Returns the basename of current project’s filename (without path and extension)
project_creation_date Returns the project creation date, taken from project metadata
project_crs Returns the Coordinate reference system of the project
project_crs_definition Returns the full definition of the Coordinate reference system of the project
project_filename Returns the filename of the current project
project_folder Returns the folder of the current project

Continued on next page
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Table 13.2 – continued from previous page
Fonction Description
project_home Returns the home path of the current project
project_identifier Returns the project identifier, taken from the project’s metadata
project_keywords Returns the project keywords, taken from the project’s metadata
project_path Returns the full path (including file name) of the current project
project_title Renvoie le titre du projet actuel
qgis_locale Returns the current language of QGIS
qgis_os_name Renvoie le nom du système d’exploitation : “windows”, “linux” ou “osx”
qgis_platform Renvoie la plate-forme QGIS, par exemple “desktop” ou “server”
qgis_release_name Renvoie le nom de la version de QGiS utilisée
qgis_short_version Returns current QGIS version short string
qgis_version Renvoie la version de QGIS utilisée
qgis_version_no Renvoie le numéro de version de QGIS
snapping_results Gives access to snapping results while digitizing a feature (only available in add feature)
symbol_angle Renvoie l’angle du symbole utilisé pour le rendu de l’entité (valide uniquement pour les marqueurs de symboles).
symbol_color Renvoie la couleur du symbole utilisé pour le rendu de l’entité.
user_account_name Renvoie le nom d’utilisateur du système d’exploitation.
user_full_name Retourne le nom d’utilisateur de l’utilisateur du système d’exploitation actuel
row_number Enregistre le numéro de la ligne actuelle
value Renvoie la valeur en cours
with_variable Allows setting a variable for usage within an expression and avoid recalculating the same value repeatedly

Quelques exemples :

• Return the X coordinate of a map item center to insert into a label in layout:

x( map_get( item_variables( 'map1'), 'map_extent_center' ) )

• Return for each feature in the current layer the number of overlapping airports features:

aggregate( layer:='airport', aggregate:='count', expression:="code",
filter:=intersects( $geometry, geometry( @parent ) ) )

• Get the object_id of the first snapped point of a line:

with_variable(
'first_snapped_point',
array_first( @snapping_results ),
attribute(

get_feature_by_id(
map_get( @first_snapped_point, 'layer' ),
map_get( @first_snapped_point, 'feature_id' )

),
'object_id'

)
)

Fonctions récentes

This group contains recently used functions. Depending on the context of its usage (feature selection, field calcu-
lator, generic), any applied expression is added to the corresponding list (up to ten expressions), sorted from the
more recent to the less one. This helps to quickly retrieve and reapply any previously used expression.
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13.3.3 Éditeur de fonction

With the Function Editor tab, you are able to write your own functions in Python language. This provides a handy
and comfortable way to address particular needs that would not be covered by the predefined functions.

Figure 13.74: L’onglet Éditeur de fonction

Pour créer une nouvelle fonction :

1. Appuyez sur le bouton Nouveau Fichier.

2. Enter a name to use in the form that pops up and press OK.

A new item of the name you provide is added in the left panel of the Function Editor tab; this is a Python
.py file based on QGIS template file and stored in the /python/expressions folder under the active
user profile directory.

3. The right panel displays the content of the file: a python script template. Update the code and its help
according to your needs.

4. Press the Save and Load Functions button. The function you wrote is added to the functions tree in the
Expression tab, by default under the Custom group.

5. Profitez donc de votre nouvelle fonction.

6. If the function requires improvements, enable the Function Editor tab, do the changes and press again the

Save and Load Functions button to make them available in the file, hence in any expression tab.

Custom Python functions are stored under the user profile directory, meaning that at each QGIS startup, it will
auto load all the functions defined with the current user profile. Be aware that new functions are only saved in the
/python/expressions folder and not in the project file. If you share a project that uses one of your custom
functions you will need to also share the .py file in the /python/expressions folder.
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Voici un court exemple de comment créer vos propres fonctions :

from qgis.core import *
from qgis.gui import *

@qgsfunction(args='auto', group='Custom')
def my_sum(value1, value2, feature, parent):

"""
Calculates the sum of the two parameters value1 and value2.
<h2>Example usage:</h2>
<ul>

<li>my_sum(5, 8) -> 13</li>
<li>my_sum("field1", "field2") -> 42</li>

</ul>
"""
return value1 + value2

Ce court exemple crée la fonction my_sum qui vous donnera une fonction avec deux valeurs. Quand vous utilisez
l’argument de fonction args='auto' le nombre d’arguments de la fonction requis sera calculé selon le nombre
d’arguments définis en Python (moins 2 - feature, et parent).

Cette fonction peut dès lors être utilisée dans des expressions :

Figure 13.75: Fonction personnalisée ajoutée à l’onglet Expression

Plus d’informations sur la création de code Python peuvent être trouvées dans PyQGIS-Developer-Cookbook.

13.4 Travailler avec la table d’attributs

La table d’attributs affiche des informations sur les entités d’un calque sélectionné. Chaque ligne du tableau
représente une entité (avec ou sans géométrie) et chaque colonne contient une information particulière sur cette
entité. Les entités du tableau peuvent être recherchées, sélectionnées, déplacées ou même modifiées.

13.4.1 Avant-propos : Tables spatiale et non spatiale

QGIS vous permet de charger des couches spatiales et non spatiales. Ceci inclut actuellement les tables supportées
par OGR et les fichiers de texte délimité, ainsi que les fournisseurs PostgreSQL, MSSQL, SpatiaLite, DB2 et
Oracle. Toutes les couches chargées sont listées dans le panneau Couches. Le fait qu’une couche soit spatiale ou
non détermine si vous pouvez interagir avec elle sur la carte.
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Les tables non spatiales peuvent être parcourues et modifiées à l’aide de la vue de la table d’attributs. De plus,
elles peuvent être utilisées pour des requêtes sur les champs. Par exemple, vous pouvez utiliser les colonnes
d’une table non spatiale pour définir des valeurs d’attributs, ou une plage de valeurs qui peut être ajoutées à une
couche vectorielle spécifique pendant la numérisation. Regardez le widget d’édition dans la section Attributes
Form Properties pour en savoir plus.

13.4.2 Présentation de l’interface de la table d’attributs

Pour ouvrir la table attributaire d’une couche vectoriel, activez la couche en cliquant dessus depuis la Le panneau

Couches. Puis dans le menu Couche, cliquez sur Ouvrir la table d’attributs. Vous pouvez aussi y accéder

avec un clic droit sur la couche puis en sélectionnant Ouvrir la table d’attributs ou en cliquant sur le bouton

Ouvrir la table d’attributs dans la barre d’outils des Attributs. Si vous préférez les raccourcis, F6 ouvrira la
table d’attributs. Shift+F6 ouvrira la table d’attributs filtrée vers les entités sélectionnées et Ctrl+F6 ouvrira
la table d’attributs filtrée vers les entités visibles.

Cela ouvrira une nouvelle fenêtre qui affiche les attributs de toutes les entités de la couche (voir fig-
ure_attributes_table). Selon le paramétrage effectué dans le menu Préférences → Options → Sources de données
, la fenêtre s’ouvrira en mode ancré ou pas. Le nombre total des entités et le nombre d’entités sélectionnées ou
filtrés sont affichés dans la barre de titre de la table d’attributs. De même, si un filtrage spatial est appliqué à la
table, cette information y figure.

Figure 13.76: Table d’attributs de la couche “regions”

Les boutons situés au-dessus de la table d’attributs apportent les fonctionnalités suivantes :
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Icône Étiquette Fonction Raccourci par
Défaut

Basculer en mode édition Activer les fonctions d’édition Ctrl+E

Basculer en mode édition multiple Mettre à jour plusieurs champs de plusieurs
entités

Enregistrer les modifications Enregistrer les modifications en cours Ctrl+S

Recharger la table

Ajouter une entité Ajouter une entité non géométrique

Supprimer les entités sélectionnées Supprimer les entités sélectionnées de la
couche

Couper les entités sélectionnées dans
le presse-papiers

Ctrl+X

Copier les entités sélectionnées dans
le presse-papiers

Ctrl+C

Coller les entités à partir du presse-
papier

Insérer de nouvelles entités à partir de
celles qui ont été copiées

Ctrl+V

Sélectionner les entités en utilisant
une expression

Tout sélectionner Sélectionner toutes les entités de la couche Ctrl+A

Inverser la sélection Inverser la sélection en cours dans la
couche

Ctrl+R

Tout désélectionner Désélectionner toutes les entités de la
couche courante

Ctrl+Shift+A

Filtrer/Sélectionner les entités en util-
isant le formulaire

Ctrl+F

Déplacer la sélection au sommet Regrouper les objets sélectionnés au début
de la table

Centrer la carte sur les lignes sélec-
tionnées

Ctrl+P

Zoomer la carte sur les lignes sélec-
tionnées

Ctrl+J

Nouveau champ Ajouter un nouveau champ à la source de
données

Ctrl+W

Supprimer le champ Supprimer un champ de la source de don-
nées

Ctrl+L

Ouvrir la calculatrice de champ Mise à jour de champs pour de nombreuses
entités.

Ctrl+I

Mise en forme conditionnelle Enable table formatting

Dock attribute table Allows to dock/undock the attribute table

Actions Lists the actions related to the layer

Table d’attributs 1 : Les outils disponibles
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Note: Selon le format des données et la version de la bibliothèque OGR compilée avec votre version de QGIS,
certains outils pourraient manquer.

Below these buttons is the Quick Field Calculation bar (enabled only in edit mode), which allows to quickly apply

calculations to all or part of the features in the layer. This bar uses the same expressions as the Field Calculator

(see Editer les valeurs d’attributs).

Table view vs Form view

QGIS provides two view modes to easily manipulate data in the attribute table:

• The Table view, displays values of multiple features in a tabular mode, each row representing a feature and
each column a field.

• And the Form view shows feature identifiers in a first panel and displays only the attributes of the clicked
identifier in the second one. Form view uses the layer fields configuration (see Attributes Form Properties).

You can switch from one mode to the other by clicking the corresponding icon at the bottom right of the dialog.

You can also specify the Default view mode at the opening of the attribute table in Settings → Options → Data
Sources menu. It can be “Remember last view”, “Table view” or “Form view”.

Configuring the columns

Right-click in a column header when in table view to have access to tools that help you configure what can be
displayed in the attribute table and how.

Hiding and organizing columns and enabling actions

By right-clicking in a column header, you can choose to hide it from the attribute table. To change several columns
behavior at once, unhide a column or change the order of the columns, choose Organize columns . . . . In the new
dialog, you can:

• check/uncheck columns you want to show or hide

• drag-and-drop items to reorder the columns in the attribute table. Note that this change is for the table
rendering and does not alter the fields order in the layer datasource

• enable a new virtual Actions column that displays in each row a drop-down box or button list of actions for
each row, see Propriétés des Actions for more information about actions.

Resizing columns widths

Columns width can be set through a right-click on the column header and select either:

• Set width. . . to enter the desired value. By default, the current value is displayed in the widget

• Autosize to resize at the best fit the column.

It can also be changed by dragging the boundary on the right of the column heading. The new size of the column
is maintained for the layer, and restored at the next opening of the attribute table.
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Figure 13.77: Attribute table in form view (top) vs table view (bottom)
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Sorting columns

The table can be sorted by any column, by clicking on the column header. A small arrow indicates the sort
order (downward pointing means descending values from the top row down, upward pointing means ascending
values from the top row down). You can also choose to sort the rows with the sort option of the column header
context menu and write an expression, e.g. to sort the row using multiple columns you can write concat(col0,
col1).

In form view, features identifier can be sorted using the Sort by preview expression option.

Astuce: Sorting based on columns of different types

Trying to sort an attribute table based on columns of string and numeric types may lead to unexpected re-
sult because of the concat("USE", "ID") expression returning string values (ie, 'Borough105' <
'Borough6'). You can workaround this by using eg concat("USE", lpad("ID", 3, 0)) which re-
turns 'Borough105' > 'Borough006'.

Formatting of table cells using conditions

Conditional formatting settings can be used to highlight in the attribute table features you may want to put a
particular focus on, using custom conditions on feature’s:

• geometry (e.g., identifying multi-parts features, small area ones or in a defined map extent. . . );

• or field value (e.g., comparing values to a threshold, identifying empty cells. . . ).

You can enable the conditional formatting panel clicking on at the top right of the attributes window in table
view (not available in form view).

The new panel allows user to add new rules to format rendering of Field or Full row. Adding new rule
opens a form to define:

• the name of the rule;

• a condition using any of the expression builder functions;

• the formatting: it can be choosen from a list of predefined formats or created based on properties like:

– couleurs d’arrière-plan et du texte;

– utilisation d’une Icône;

– texte en gras, italique, souligné ou barré;

– police.

13.4.3 Interacting with features in an attribute table

Sélectionner des entités

In table view, each row in the attribute table displays the attributes of a unique feature in the layer. Selecting a row
selects the feature and likewise, selecting a feature in the map canvas (in case of geometry enabled layer) selects
the row in the attribute table. If the set of features selected in the map canvas (or attribute table) is changed, then
the selection is also updated in the attribute table (or map canvas) accordingly.

Les lignes peuvent être sélectionnées en cliquant sur le numéro de ligne placé tout à gauche. Plusieurs lignes
peuvent être sélectionnées en maintenant la touche Ctrl. Une sélection continue s’effectue en gardant appuyée
la touche Shift et en cliquant sur une nouvelle ligne, toutes les lignes entre la première sélection et la dernière
seront sélectionnées. Déplacer la position du curseur dans la table d’attributs en cliquant sur une cellule ne modifie
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Figure 13.78: Mise en forme conditionnelle des cellules de la table d’attributs

pas la sélection des lignes. Modifier les entités sélectionnées depuis la carte ne modifie pas la position du curseur
dans la table.

In form view of the attribute table, features are by default identified in the left panel by the value of their displayed
field (see Propriétés des Infobulles). This identifier can be replaced using the drop-down list at the top of the
panel, either by selecting an existing field or using a custom expression. You can also choose to sort the list of
features from the drop-down menu.

Click a value in the left panel to display the feature’s attributes in the right one. To select a feature, you need to
click inside the square symbol at the left of the identifier. By default, the symbol turns into yellow. Like in the
table view, you can perform multiple feature selection using the keyboard combinations previously exposed.

Beyond selecting features with the mouse, you can perform automatic selection based on feature’s attribute using
tools available in the attribute table toolbar, such as (see section Automatic selection and following one for more
information and use case):

• Sélectionner à l’aide d’une expression. . .

• Sélectionner des entités par valeur. . .

• :guilabel:‘ Désélectionner toutes les entités‘

• Sélectionner toutes les entités

• Inverser la sélection des entités.

It is also possible to select features using the Filtering and selecting features using forms.
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Filtrer les entités

Once you have selected features in the attribute table, you may want to display only these records in the table.
This can be easily done using the Show Selected Features item from the drop-down list at the bottom left of the
attribute table dialog. This list offers the following filters:

• :guilabel:‘ Montrer toutes les entités‘

• :guilabel:‘ Ne montrer que les entités sélectionnées‘

• :guilabel:‘ Ne montrer que les entités visibles sur la carte‘

• :guilabel:‘ Ne montrer que les entités nouvelles ou éditées‘

• Field Filter - allows the user to filter based on value of a field: choose a column from a list, type a value and
press Enter to filter. Then, only the matching features are shown in the attribute table.

• Advanced filter (Expression) - Opens the expression builder dialog. Within it, you can create complex
expressions to match table rows. For example, you can filter the table using more than one field. When
applied, the filter expression will show up at the bottom of the form.

It is also possible to filter features using forms.

Note: Filtering records out of the attribute table does not filter features out of the layer; they are simply momen-
taneously hidden from the table and can be accessed from the map canvas or by removing the filter. For filters that
do hide features from the layer, use the Query Builder.

Astuce: Update datasource filtering with Show Features Visible on Map

When for performance reasons, features shown in attribute table are spatially limited to the canvas extent at its
opening (see Data Source Options for a how-to), selecting Show Features Visible on Map on a new canvas extent
updates the spatial restriction.

Filtering and selecting features using forms

Clicking the Filter/Select features using form or pressing Ctrl+F will make the attribute table dialog switch to form
view and replace each widget with its search variant.

From this point onwards, this tool functionality is similar to the one described in Sélectionner des Entités par
Valeur, where you can find descriptions of all operators and selecting modes.

Figure 13.79: Attribute table filtered by the filter form
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When selecting / filtering features from the attribute table, there is a Filter features button that allows defining
and refining filters. Its use triggers the Advanced filter (Expression) option and displays the corresponding filter
expression in an editable text widget at the bottom of the form.

If there are already filtered features, you can refine the filter using the drop-down list next to the Filter features
button. The options are:

• Filtre incluant (« AND »)

• Filtre exclusif (« OR »)

To clear the filter, either select the Show all features option from the bottom left pull-down menu, or clear the
expression and click Apply or press Enter.

13.4.4 Using action on features

Users have several possibilities to manipulate feature with the contextual menu like:

• Select all (Ctrl+A) the features;

• Copy the content of a cell in the clipboard with Copy cell content;

• Zoom to feature without having to select it beforehand;

• Pan to feature without having to select it beforehand;

• Flash feature, to highlight it in the map canvas;

• Open form: it toggles attribute table into form view with a focus on the clicked feature.

Figure 13.80: Copy cell content button

If you want to use attribute data in external programs (such as Excel, LibreOffice, QGIS or a custom web applica-

tion), select one or more row(s) and use the Copy selected rows to clipboard button or press Ctrl+C. In Settings →
Options → Data Sources menu you can define the format to paste to with Copy features as dropdown list:

• Plain text, no geometry,
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• Plain text, WKT geometry,

• GeoJSON

You can also display a list of actions in this contextual menu. This is enabled in the Layer properties → Actions
tab. See Propriétés des Actions for more information on actions.

Saving selected features as new layer

The selected features can be saved as any OGR-supported vector format and also transformed into another coordi-
nate reference system (CRS). In the contextual menu of the layer, from the Layers panel, click on Export → Save
selected features as. . . to define the name of the output dataset, its format and CRS (see section Creating new

layers from an existing layer). You’ll notice that Save only selected features is checked. It is also possible to
specify OGR creation options within the dialog.

13.4.5 Editer les valeurs d’attributs

Editing attribute values can be done by:

• typing the new value directly in the cell, whether the attribute table is in table or form view. Changes are
hence done cell by cell, feature by feature;

• using the field calculator: update in a row a field that may already exist or to be created but for multiple
features. It can be used to create virtual fields;

• using the quick field calculation bar: same as above but for only existing field;

• or using the multi edit mode: update in a row multiple fields for multiple features.

Using the Field Calculator

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing attribute
values or defined functions, for instance, to calculate length or area of geometry features. The results can be used
to update an existing field, or written to a new field (that can be a virtual one).

La calculatrice de champ fonctionne avec toutes les couches qui gèrent le mode édition. Lorsque vous cliquez sur
le bouton de la calculatrice de champ, la fenêtre s’ouvre (voir figure_field_calculator). Si la couche n’est pas en
mode édition, un avertissement s’affiche et l’utilisation de la calculatrice de champ basculera automatiquement la
couche en édition avant d’effectuer le calcul.

Based on the Expression Builder dialog, the field calculator dialog offers a complete interface to define an expres-
sion and apply it to an existing or a newly created field. To use the field calculator dialog, you must select whether
you want to:

1. apply calculation on the whole layer or on selected features only

2. create a new field for the calculation or update an existing one.

If you choose to add a new field, you need to enter a field name, a field type (integer, real, date or string) and if
needed, the total field length and the field precision. For example, if you choose a field length of 10 and a field
precision of 3, it means you have 7 digits before the dot, and 3 digits for the decimal part.

L’exemple suivant montre comment la calculatrice de champs fonctionne. Il s’agit de calculer la longueur en km
de la couche railroads issue de l’échantillon de données QGIS.

1. Chargez le fichier shapefile railroads.shp dans QGIS et ouvrez sa Table d’Attributs.

2. Cliquez sur Basculer en mode édition et ouvrez la Calculatrice de champs.

3. Cochez la case Créer un nouveau champ pour enregistrer le résultat des calculs dans un nouveau champ.

4. Set Output field name to length_km
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Figure 13.81: Calculatrice de champ

5. Select Decimal number (real) as Output field type

6. Set the Output field length to 10 and the Precision to 3

7. Double click on $length in the Geometry group to add the length of the geometry into the Field calculator
expression box.

8. Complete the expression by typing / 1000 in the Field calculator expression box and click OK.

9. You can now find a new length_km field in the attribute table.

Creating a Virtual Field

A virtual field is a field based on an expression calculated on the fly, meaning that its value is automatically updated
as soon as an underlying parameter changes. The expression is set once; you no longer need to recalculate the
field each time underlying values change. For example, you may want to use a virtual field if you need area to
be evaluated as you digitize features or to automatically calculate a duration between dates that may change (e.g.,
using now() function).

Note: Utilisation des Champs Virtuels

• Les champs virtuels ne sont pas des attributs permanents, ils ne sont sauvegardés et disponibles que dans le
projet dans lequel ils ont été créés.

• Un champ est défini comme virtuel uniquement à sa création et l’expression utilisée pour le générer ne peut
pas être modifiée par la suite : pour le faire, vous devez supprimer et recréer le champ.
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Using the Quick Field Calculation Bar

While Field calculator is always available, the quick field calculation bar on top of the attribute table is only visible
if the layer is in edit mode. Thanks to the expression engine, it offers a quicker access to edit an already existing
field:

1. Select the field to update in the drop-down list.

2. Fill the textbox with a value, an expression you directly write or build using the expression button.

3. Click on Update All, Update Selected or Update Filtered button according to your need.

Figure 13.82: Quick Field Calculation Bar

Editing multiple fields

Contrairement aux outils précédents, le mode d’édition multiple permet d’éditer simultanément plusieurs champs
de plusieurs entités. Une fois la couche basculée en mode édition, les options d’édition multiple sont accessibles:

• using the Toggle multi edit mode button from the toolbar inside the attribute table dialog;

• soit en sélectionnant depuis le menu Edition → Modifier les attributs des entités sélectionnées.

Note: Unlike the tool from the attribute table, hitting the Edit → Modify Attributes of Selected Features option
provides you with a modal dialog to fill attributes changes. Hence, features selection is required before execution.

Afin de modifier d’une traite plusieurs champs:

1. Select the features you want to edit.

2. From the attribute table toolbar, click the button. This will toggle the dialog to its form view. Feature
selection could also be made at this step.

3. At the right side of the attribute table, fields (and values) of selected features are shown. New widgets
appear next to each field allowing for display of the current multi edit state:

• The field contains different values for selected features. It’s shown empty and each feature will
keep its original value. You can reset the value of the field from the drop-down list of the widget.

• All selected features have the same value for this field and the value displayed in the form will be
kept.
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• The field has been edited and the entered value will be applied to all the selected features. A
message appears at the top of the dialog, inviting you to either apply or reset your modification.

Clicking any of these widgets allows you to either set the current value for the field or reset to original value,
meaning that you can roll back changes on a field-by-field basis.

Figure 13.83: Mettre à jour des champs de plusieurs entités

4. Make the changes to the fields you want.

5. Click on Apply changes in the upper message text or any other feature in the left panel.

Changes will apply to all selected features. If no feature is selected, the whole table is updated with your changes.

Modifications are made as a single edit command. So pressing Undo will rollback the attribute changes for all
selected features at once.

Note: Le mode d’édition multiple n’est disponible que pour les formulaires auto-générés ou en conception par
glisser/déposer (voir Customizing a form for your data); il n’est pas disponible pour les formulaires par fichiers ui
personnalisés.

13.4.6 Créer des relations un ou plusieurs à plusieurs

Utiliser des relations est courant dans les bases de données. L’idée est que des entités (lignes) de différentes
couches (tables) peuvent être liées les unes aux autres.

Introducing 1-N relations

Comme exemple, nous prendrons une couche contenant toutes les régions de l’Alaska (des polygones) qui fournit
quelques attributs sur le nom, le type de région et un identifiant unique (qui jouera le rôle de clé primaire).
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Nous prenons ensuite une autre couche de point ou une table contenant des informations sur les aéroports localisés
dans les régions. Si vous souhaitez accéder, depuis la couche des régions, vous devez créer une relation “un à
plusieurs”, en utilisant des clés étrangères, car il y a plusieurs aéroports dans la plupart des régions.

Figure 13.84: Les régions d’Alaska contenant des aéroports

Layers in 1-N relations

QGIS makes no difference between a table and a vector layer. Basically, a vector layer is a table with a geometry.
So you can add your table as a vector layer. To demonstrate the 1-n relation, you can load the regions shapefile
and the airports shapefile which has a foreign key field (fk_region) to the layer regions. This means, that
each airport belongs to exactly one region while each region can have any number of airports (a typical one to
many relation).

Foreign keys in 1-N relations

En plus des attributs existants dans la table des aéroports, un autre champ, fk_region, va jouer le rôle de clé
étrangère (si la table est stockée dans une base de données, vous allez sans doute définir une contrainte sur ce
champ).

Ce champ fk_region contiendra toujours un identifiant de région. Il peut être vu comme un pointeur vers la région
à laquelle l’aéroport appartient. Et vous pouvez créer un formulaire personnalisé d’édition pour la saisie. Cela
fonctionne avec différents fournisseurs (vous pouvez vous en servir également avec des shapefiles ou des fichiers
csv) et la seule chose que vous avez à faire est de dire à QGIS qu’il y a une relation entre les tables.

Defining 1-N relations (Relation Manager)

The first thing we are going to do is to let QGIS know about the relations between the layers. This is done in
Project → Project Properties. . . . Open the Relations tab and click on Add Relation.

• Name is going to be used as a title. It should be a human readable string, describing, what the relation is
used for. We will just call say Airports in this case.

• Referenced Layer (Parent) also considered as parent layer, is the one with the primary key, pointed to, so
here it is the regions layer

• Referenced Field is the primary key of the referenced layer so it is ID

• Referencing Layer (Child) also considered as child layer, is the one with the foreign key field on it. In our
case, this is the airports layer
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• Referencing Field will say, which field points to the other layer so this is fk_region in this case

• Id will be used for internal purposes and has to be unique. You may need it to build custom forms. If you
leave it empty, one will be generated for you but you can assign one yourself to get one that is easier to
handle

• Relationship strength sets the strength of the relation between the parent and the child layer. The default
Association type means that the parent layer is simply linked to the child one while the Composition type
allows you to duplicate also the child features when duplicating the parent ones.

Figure 13.85: Gestionnaire de Relations

Forms for 1-N relations

Maintenant que QGIS a bien généré la relation, le formulaire d’édition va être amélioré. Nous n’avons pas mod-
ifié le formulaire d’édition par défaut (généré automatiquement), une nouvelle zone va simplement être ajoutée
au formulaire. Sélectionnez la couche de régions dans la légende et utilisez l’outil d’identification. Selon vos
préférences, le formulaire s’ouvre directement ou vous devez le faire via la zone d’identification qui s’affiche.

As you can see, the airports assigned to this particular region are all shown in a table. And there are also some
buttons available. Let’s review them shortly:

• Le bouton permet de passer en mode édition. Soyez conscients qu’il active le mode édition de la couche
des aéroports bien qu’il soit situé dans le formulaire de la couche des régions. La table affiche bien les entités
de la couche des aéroports.

• The button is for saving all the edits.
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Figure 13.86: Formulaire de la couche des régions affichant la relation avec les aéroports

• The button will add a new record to the airport layer attribute table. And it will assign the new airport
to the current region by default.

• The button allows you to copy one or more child features.

• The button will delete the selected airport permanently.

• Le bouton ouvre une nouvelle fenêtre où vous pouvez sélectionner des aéroports existants et qui seront
ensuite attribués à la région identifiée. Ceci est pratique lorsque vous assignez par erreur la mauvaise région
à un aéroport.

• Le bouton permet de supprimer le lien entre l’aéroport sélectionné et la région identifiée, le laissant non
assigné (la clé étrangère devient alors NULL).

• With the button you can zoom the map to the selected child features.

• The two buttons and to the right switch between table view and form view where the later let’s you
view all the airports in their respective form.

In the above example the referencing layer has geometries (so it isn’t just an alphanumeric table) so the above steps
will create an entry in the layer attribute table that has no corresponding geometric feature. To add the geometry:

1. Choose Open Attribute Table for the referencing layer.

2. Select the record that has been added previously within the feature form of the referenced layer.

3. Use the Add Part digitizing tool to attach a geometry to the selected attributes table record.

If you work on the airport table, the widget Relation Reference is automatically set up for the fk_region field
(the one used to create the relation), see Relation Reference widget.

In the airport form you will see the button at the right side of the fk_region field: if you click on the button
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the form of the region layer will be opened. This widget allows you to easily and quickly open the forms of the
linked parent features.

Figure 13.87: Formulaire d’identification d’un aéroport et de sa région associée

The Relation Reference widget has also an option to embed the form of the parent layer within the child one. It is
available in the Properties → Attributes Form menu of the airport layer: select the fk_region field and check
the Show embedded form option.

Vous devriez ainsi voir que le formulaire de la région est inclus dans celui d’un aéroport et il vous permet de
modifier la région assignée à l’aéroport.

Moreover if you toggle the editing mode of the airport layer, the fk_region field has also an autocompleter
function: while typing you will see all the values of the id field of the region layer.

Introducing many-to-many (N-M) relations

N-M relations are many-to-many relations between two tables. For instance, the airports and airlines
layers: an airport receives several airline companies and an airline company flies to several airports.

This SQL code creates the three tables we need for an N-M relationship in a PostgreSQL/PostGIS schema named
locations. You can run the code using the Database → DB Manager. . . for PostGIS or external tools such as
pgAdmin. The airports table stores the airports layer and the airlines table stores the airlines layer. In
both tables few fields are used for clarity. The tricky part is the airports_airlines table. We need it to list
all airlines for all airports (or vice versa). This kind of table is known as a pivot table. The constraints in this table
force that an airport can be associated with an airline only if both already exist in their layers.

CREATE SCHEMA locations;

CREATE TABLE locations.airports
(

id serial NOT NULL,
geom geometry(Point, 4326) NOT NULL,
airport_name text NOT NULL,
CONSTRAINT airports_pkey PRIMARY KEY (id)

);

CREATE INDEX airports_geom_idx ON locations.airports USING gist (geom);

CREATE TABLE locations.airlines
(
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id serial NOT NULL,
geom geometry(Point, 4326) NOT NULL,
airline_name text NOT NULL,
CONSTRAINT airlines_pkey PRIMARY KEY (id)

);

CREATE INDEX airlines_geom_idx ON locations.airlines USING gist (geom);

CREATE TABLE locations.airports_airlines
(

id serial NOT NULL,
airport_fk integer NOT NULL,
airline_fk integer NOT NULL,
CONSTRAINT airports_airlines_pkey PRIMARY KEY (id),
CONSTRAINT airports_airlines_airport_fk_fkey FOREIGN KEY (airport_fk)

REFERENCES locations.airports (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED,

CONSTRAINT airports_airlines_airline_fk_fkey FOREIGN KEY (airline_fk)
REFERENCES locations.airlines (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED

);

Instead of PostgreSQL you can also use GeoPackage. In this case, the three tables can be created manually using
the Database → DB Manager. . . . In GeoPackage there are no schemas so the locations prefix is not needed.

Foreign key constraints in airports_airlines table can´t be created using Table → Create Table. . . or Table
→ Edit Table. . . so they should be created using Database → SQL Window. . . . GeoPackage doesn’t support ADD
CONSTRAINT statements so the airports_airlines table should be created in two steps:
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1. Set up the table only with the id field using Table → Create Table. . .

2. Using Database → SQL Window. . . , type and execute this SQL code:

ALTER TABLE airports_airlines
ADD COLUMN airport_fk INTEGER
REFERENCES airports (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED;

ALTER TABLE airports_airlines
ADD COLUMN airline_fk INTEGER
REFERENCES airlines (id)
ON DELETE CASCADE
ON UPDATE CASCADE
DEFERRABLE INITIALLY DEFERRED;

Then in QGIS, you should set up two one-to-many relations as explained above:

• a relation between airlines table and the pivot table;

• and a second one between airports table and the pivot table.

An easier way to do it (only for PostgreSQL) is using the Discover Relations in Project → Properties → Rela-
tions. QGIS will automatically read all relations in your database and you only have to select the two you need.
Remember to load the three tables in the QGIS project first.

Figure 13.88: Relations and autodiscover

In case you want to remove an airport or an airline, QGIS won’t remove the associated record(s) in
airports_airlines table. This task will be made by the database if we specify the right constraints in
the pivot table creation as in the current example.

Note: Combining N-M relation with automatic transaction group

You should enable the transaction mode in Project Properties → Data Sources → when working on such context.
QGIS should be able to add or update row(s) in all tables (airlines, airports and the pivot tables).

Finally we have to select the right cardinalilty in the Layer Properties → Attributes Form for the airports and
airlines layers. For the first one we should choose the airlines (id) option and for the second one the airports
(id) option.
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Figure 13.89: Set relationship cardinality

Now you can associate an airport with an airline (or an airline with an airport) using Add child feature or Link
existing child feature in the subforms. A record will automatically be inserted in the airports_airlines
table.

Note: Using Many to one relation cardinality

Sometimes hiding the pivot table in an N-M relationship is not desirable. Mainly because there are attributes in the
relationship that can only have values when a relationship is established. If your tables are layers (have a geometry
field) it could be interesting to activate the On map identification option (Layer Properties → Attributes Form →
Available widgets → Fields) for the foreign key fields in the pivot table.

Note: Pivot table primary key

Avoid using multiple fields in the primary key in a pivot table. QGIS assumes a single primary
key so a constraint like constraint airports_airlines_pkey primary key (airport_fk,
airline_fk) will not work.

13.5 Éditer

QGIS prend en charge diverses fonctionnalités d’édition de tables et de couches vectorielles OGR, SpatiaLite,
PostGIS, MSSQL Spatial et Oracle Spatial.

Note: La procédure pour éditer des couches GRASS est différente - voir section Numérisation et édition de
couche vectorielle GRASS pour plus de détails.

Astuce: Éditions simultanées

Cette version de QGIS ne vérifie pas si quelqu’un d’autre est en train d’éditer une entité en même temps que vous,
la dernière personne qui enregistre sa modification gagne !

13.5.1 Définir le rayon de tolérance d’accrochage et de recherche

Pour une édition optimale et précise des géométries des couches vectorielles, il est nécessaire de définir une valeur
appropriée du rayon de tolérance d’accrochage et de recherche sur les sommets des entités.
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Figure 13.90: N-M relationship between airports and airlines
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Tolérance d’accrochage

When you add a new vertex or move an existing one, snapping tolerance is the distance QGIS uses to search for
the closest vertex or segment you are trying to connect to. If you aren’t within the snapping tolerance, QGIS will
leave the vertex where you release the mouse button, instead of snapping it to an existing vertex or segment.

The snapping tolerance setting affects all tools that work with tolerance.

You can enable or disable snapping by using the Enable snapping button on the Snapping Toolbar or pressing S
at any time while you’re on the map view. This toolbar is also very convenient to quickly configure the snapping
mode, tolerance value, and units. The snapping configuration can also be set in Project → Snapping Options. . . .

There are three options to select the layer(s) to snap to:

• All layers: quick setting for all visible layers in the project so that the pointer snaps to all vertices and/or
segments. In most cases, it is sufficient to use this snapping mode, but beware when using it on projects
with many vector layers, as it may cause slowness.

• Current layer: only the active layer is used, a convenient way to ensure topology within the layer being
edited.

• Advanced Configuration: allows you to enable and adjust snapping mode and tolerance on a layer basis (see
figure_edit_snapping). If you need to edit a layer and snap its vertices to another, ensure the target layer is
checked and increase the snapping tolerance to a higher value. Snapping will not occur to a layer that is not
checked in the snapping options dialog.

As for snapping mode, you can select between To vertex, To segment, and To vertex and segment.

The tolerance values can be set either in the project’s map units or in pixels. The advantage of choosing
pixels is that it keeps the snapping constant at different map scales. 10 to 12 pixels is normally a good value, but
it depends on the DPI of your screen. Using map units allows the tolerance to be related to real ground distances.
For example, if you have a minimum distance between elements, this option can be useful to ensure that you don’t
add vertexes too close to each other.

Figure 13.91: Snapping options (Advanced Configuration mode)

Note: By default, only visible features (the features whose style is displayed, except for layers where the sym-

bology is « No symbols ») can be snapped. You can enable the snapping on invisible features by checking
Enable snapping on invisible features under the Settings → Options → Digitizing tab.

Astuce: Enable snapping by default

You can set snapping to be enabled by default on all new projects in the Settings → Options → Digitizing tab.
You can also set the default snapping mode, tolerance value, and units, which will populate the Snapping Options
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dialog.

Activer l’accrochage sur les intersections

Another available option is to use snapping on intersection, which allows you to snap to geometry intersec-
tions of snapping enabled layers, even if there are no vertices at the intersections.

Rayon de recherche

Search radius is the distance QGIS uses to search for the closest vertex you are trying to select when you click
on the map. If you aren’t within the search radius, QGIS won’t find and select any vertex for editing. The search
radius for vertex edits can be defined under the Settings → Options → Digitizing tab. This is the same place
where you define the snapping default values.

Snap tolerance and search radius are set in map units or pixels, so you may find you need to experiment to
get them set right. If you specify too big of a tolerance, QGIS may snap to the wrong vertex, especially if you
are dealing with a large number of vertices in close proximity. Set the search radius too small, and it won’t find
anything to move.

13.5.2 Édition topologique

Apart from snapping options, the Snapping options. . . ‘ dialog (Project → Snapping options) and the Snapping
toolbar allow you to enable and disable some topological functionalities.

Activer l’édition topologique

The Topological editing button helps when editing and maintaining features with common boundaries. With
this option enabled, QGIS “detects” boundaries that are shared by the features; When you move common ver-
tices/segments, QGIS will also move them in the geometries of the neighboring features.

Topological editing works with features from different layers, as long as the layers are visible and in editing mode.

Éviter les intersections de nouveaux polygones

When the snapping mode is set to Advanced configuration, for polygon layers, there’s an option called

Avoid intersections. This option prevents you from drawing new features that overlap existing ones in the
selected layer, speeding up digitizing of adjacent polygons.

With avoid intersections enabled, if you already have one polygon, you can digitize a second one such that both
intersect. QGIS will cut the second polygon to the boundary of the existing one. The advantage is that you don’t
have to digitize all vertices of the common boundary.

Note: If the new geometry is totally covered by existing ones, it gets cleared, and QGIS will show an error
message.

Avertissement: Use cautiously the Avoid overlap option

Since this option will cut new overlapping geometries of any polygon layer, you can get unexpected geometries
if you forget to uncheck it when no longer needed.
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Vérificateur de géométrie

Une extension principale peut aider l’utilisateur à trouver les géométries invalides. Vous trouverez plus
d’informations sur cette extension sur Geometry Checker Plugin.

Tracé automatique

Usually, when using capturing map tools (add feature, add part, add ring, reshape and split), you need to click
each vertex of the feature. With the automatic tracing mode, you can speed up the digitization process as you no
longer need to manually place all the vertices during digitization:

1. Enable the Tracing tool by pushing the icon or pressing T key.

2. Snap to a vertex or segment of a feature you want to trace along.

3. Move the mouse over another vertex or segment you’d like to snap and, instead of the usual straight line,
the digitizing rubber band represents a path from the last point you snapped to the current position.

QGIS actually uses the underlying features topology to build the shortest path between the two points.
Tracing requires snapping to be activated in traceable layers to build the path. You should also snap to
an existing vertex or segment while digitizing and ensure that the two nodes are topologically connectable
through existing features edges, otherwise QGIS is unable to connect them and thus traces a single straight
line.

4. Click and QGIS places the intermediate vertices following the displayed path.

Unfold the Enable Tracing icon and set the Offset option to digitize a path parallel to the features instead of tracing
along them; a positive value shifts the new drawing to the left side of the tracing direction and a negative value
does the opposite.

Note: Ajustez l’échelle de la carte ou les paramètres d’accrochage pour un traçage optimal

S’il y a trop d’entités dans le canevas de la carte, le traçage est désactivé pour éviter une préparation de la structure
de traçage potentiellement longue et une surcharge de mémoire importante. Après avoir zoomé ou désactivé
certaines couches, le traçage est de nouveau activé.

Note: Does not add topological points

This tool does not add points to existing polygon geometries even if Topological editing is enabled. If geometry
precision is activated on the edited layer, the resulting geometry might not exactly follow an existing geometry.

Astuce: Quickly enable or disable automatic tracing by pressing the T key

By pressing the T key, tracing can be enabled/disabled anytime even while digitizing one feature, so it is possible
to digitize some parts of the feature with tracing enabled and other parts with tracing disabled. Tools behave as
usual when tracing is disabled.

13.5.3 Numériser une couche existante

Par défaut, QGIS charge les couches en lecture seule : c’est une sécurité pour éviter d’éditer accidentellement une
couche. Cependant, vous pouvez choisir d’éditer une couche du moment que le fournisseur de données le gère
(voir Découvrir les formats de données et de champs) et que la source de données est éditable (c’est-à-dire des
fichiers qui ne sont pas en lecture seule).

Astuce: Restreindre les droits d’édition de certaines couches dans le projet
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From the Project → Properties. . . → Data Sources → Layers Capabilities table, You can choose to set any layer
read-only regardless the provider permission. This can be a handy way, in a multi-users environment to avoid
unauthorized users to mistakenly edit layers (e.g., Shapefile), hence potentially corrupt data. Note that this setting
only applies inside the current project.

Les outils d’édition des couches vectorielles sont répartis dans les barres d’outils de numérisation et de numéri-
sation avancée telles que décrites dans la section Numérisation avancée. Vous pouvez afficher les deux depuis
le menu Vue→ Barres d’Outils →. En utilisant les outils basiques de numérisation, vous pouvez accomplir les
actions suivantes :

Bou-
ton

Fonction Bou-
ton

Fonction

Éditions en cours Basculer en mode édition

Enregistrer les modifications de la couche

Add new record Ajouter une entité : Créer un point

Ajouter une entité : Créer une Ligne Ajouter une entité : Créer un poly-
gone

Vertex Tool (All Layers) Vertex Tool (Current Layer)

Modify the attributes of all selected features simulta-
neously

Supprimer les entités sélectionnées Couper les entités

Copier les entités Coller les entités

Annuler Refaire

Tableau Numérisation : barre d’outils basiques de numérisation pour les couches vectorielles

Notez que lorsque vous utilisez l’un des outils de numérisation, vous pouvez toujours zoomer ou vous déplaçer
dans le canevas de la carte sans perdre le focus de l’outil.

Toutes les sessions d’édition commencent par le choix de l’option Basculer en mode édition que l’on trouve dans le
menu contextuel de la couche en question, dans la boîte de dialogue de la table d’attributs, dans la barre d’outils
de numérisation ou encore dans le menu Éditer.

Une fois que la couche est en mode d’édition, des boutons d’outils supplémentaires dans la barre d’outils d’édition
sont disponibles et des symboles apparaissent aux sommets de toutes les entités à moins que afficher les symboles
uniquement pour les entités sélectionnées dans le menu Préférences - Options . . . → Numérisation soit coché.

Astuce: Sauvegardez régulièrement

N’oubliez pas d” Enregistrer les modifications de la couche régulièrement. Cette action vérifiera aussi que les modifica-
tions apportées peuvent être intégrées dans votre source de données.

Ajouter des entités

Depending on the layer type, you can use the Add Record, Add Point Feature, Add Line Feature or
Add Polygon Feature icons on the toolbar to add new features into the current layer.

To add a geometryless feature, click on the Add Record button and you can enter attributes in the feature form that
opens. To create features with the spatially enabled tools, you first digitize the geometry then enter its attributes.
To digitize the geometry:
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1. Left-click on the map area to create the first point of your new feature. For point features, this should be
enough and trigger, if required, the feature form to fill in their attributes. Having set the geometry precision
in the layer properties you can use snap to grid here to create features based on a regular distance.

2. For line or polygon geometries, keep on left-clicking for each additional point you wish to capture or
use automatic tracing capability to accelerate the digitization. This will create consecutive straight lines
between the vertices you place.

Note: Pressing Delete or Backspace key reverts the last node you add.

3. When you have finished adding points, right-click anywhere on the map area to confirm you have finished
entering the geometry of that feature.

Note: While digitizing line or polygon geometries, you can switch back and forth between the linear Add
feature tools and circular string tools to create compound curved geometries.

Astuce: Personnaliser le contour d’édition

Pendant la saisie d’un polygone, le contour d’édition élastique rouge par défaut peut masquer les entités
sous-jacentes ou les endroits où vous souhaitez numériser un point. Cela peut être contourné en définissant
une opacité inférieure (ou canal alpha) à la Couleur de remplissage dans le menu Préférences → Options
→ Numérisation. Vous pouvez également éviter l’utilisation du contour d’édition en cochant Ne pas mettre
à jour le contour d’édition lors de l’édition.

4. Le formulaire d’attributs apparaît, vous permettant d’entrer les informations pour la nouvelle entité. Fig-
ure_edit_values montre les attributs d’une nouvelle rivière fictive en Alaska. Toutefois, dans l’onglet
Numérisation du menu Paramètres → Options, vous pouvez également activer:

• Suppress attributes pop-up windows after each created feature to avoid the form opening;

• Ou Réutiliser la dernière valeur attributaire saisie pour que les champs soient remplis automa-
tiquement à l’ouverture du formulaire. il suffit de taper les valeurs modifiées.

Figure 13.92: Fenêtre de saisie des attributs après avoir numérisé une nouvelle entité vecteur

Vertex tool

Note: QGIS 3 major changes

In QGIS 3, the node tool has been fully redesigned and renamed. It was previously working with « click and
drag » ergonomy, and now uses a « click - click » workflow. This allows major improvements like taking profit of
the advanced digitizing panel with the vertex tool while digitizing or editing objects of multiple layers at the same
time.
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For any editable vector layer, the Vertex tool (Current Layer) provides manipulation capabilities of feature vertices
similar to CAD programs. It is possible to simply select multiple vertices at once and to move, add or delete them
altogether. The vertex tool also works with “on the fly” projection turned on and supports the topological editing
feature. This tool is selection persistent, so when some operation is done, selection stays active for this feature
and tool.

Il est important de régler dans Préférences → Options → Numérisation → le Rayon de recherche
à un nombre supérieur à zéro. Sinon, QGIS ne sera pas capable de dire quel sommet est édité et affichera un
avertissement.

Astuce: Marqueurs de sommets

La version actuelle de QGIS propose trois types de marqueurs - un “Cercle semi-transparent”, une “Croix” ou
“Aucun”. Pour changer de style de marqueurs, allez dans Options depuis le menu Préférences, cliquez sur
l’onget Numérisation et sélectionnez le symbole voulu dans la liste déroulante.

Opérations basiques

Start by activating the Vertex Tool (Current Layer). Red circles will appear when hovering vertices.

• Selecting vertices: You can select vertices by clicking on them one at a time holding Shift key pressed,
or by clicking and dragging a rectangle around some vertices. When a vertex is selected, its color changes
to blue. To add more vertices to the current selection, hold down the Shift key while clicking. To remove
vertices from the selection, hold down Ctrl.

• Batch vertex selection mode: The batch selection mode can be activated by pressing Shift+R. Select
a first node with one single click, and then hover without clicking another vertex. This will dynamically
select all the nodes in between using the shortest path (for polygons).

Figure 13.93: Batch vertex selection using Shift+R

Press Ctrl will invert the selection, selecting the longest path along the feature boundary. Ending your
node selection with a second click, or pressing Esc will escape the batch mode.
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• Adding vertices: To add a vertex, a virtual new node appears on the segment center. Simply grab it to add a
new vertex. Double click on any location of the boundary also creates a new node. For lines, a virtual node
is also proposed at both extremities of a line to extend it.

Figure 13.94: Virtual nodes for adding vertices

• Suppression de sommets: Sélectionnez les sommets et cliquez sur la touche Suppr. La suppression de
tous les sommets d’une entité génère, si elle est compatible avec la source de données, une entité sans
géométrie. Notez que cela ne supprime pas complètement l’entité, mais juste la partie géométrique; pour

supprimer une entité, utilisez l’outil Supprimer les entités sélectionnées.

• Moving vertices: Select all the vertices you want to move, click on a selected vertex or edge, and click
again on the desired new location. All the selected vertices will move together. If snapping is enabled, the
whole selection can jump to the nearest vertex or line. You can use Advanced Digitizing Panel constraints
for distance, angles, exact X Y location before the second click. Here you can use the snap-to-grid
feature. Having set a value for the geometry precision in the layer properties, a grid appears on a zoom level
according to the Geometry precision.

Figure 13.95: Selecting a vertex and moving the vertices to grid

Each change made with the vertex is stored as a separate entry in the Undo dialog. Remember that all operations
support topological editing when this is turned on. On-the-fly projection is also supported, and the node tool
provides tooltips to identify a vertex by hovering the pointer over it.
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The Vertex Editor Panel

When using the Vertex tool on a feature, it is possible to right click to open the Vertex Editor panel listing all
the vertices of the feature with their x, y (z, m if applicable) coordinates and r (for the radius, in case of circular
geometry). Simply select a row in the table does select the corresponding vertex in the map canvas, and vice versa.
Simply change a coordinate in the table and your vertex position is updated. You can also select multiple rows
and delete them altogether.

Note: Changed behavior in QGIS 3.4

Right click on a feature will immediately show the vertex editor and lock this feature, thus disabling the editing
of any other features. While being locked, a feature is exclusive for editing: Selecting and moving of vertices
and segments by clicking or dragging is only possible for this feature. New vertices can only be added to the
locked feature. Also, the vertex editor panel now opens itself automatically upon activating the vertex tool, and its
position/docked state remembered across uses.

Figure 13.96: L’éditeur de sommets avec les nœuds sélectionnés

Couper, Copier et Coller des entités

Les entités sélectionnées peuvent être coupées, copiées et collées entre des couches d’un même projet QGIS, du

moment que les couches de destination sont Basculées en mode édition au préalable.

Astuce: Transformer un polygone en ligne et vice-versa avec copier/coller

Copier une polyligne et la coller dans une couche de polygone: QGIS colle dans la couche cible un polygone dont
la limite correspond à la géométrie fermée de l’entité polyligne. C’est un moyen rapide de générer des géométries
différentes pour une même donnée.

Les entités peuvent également être collées dans des applications externes en tant que texte. C’est-à-dire que les
attributs sont au format CSV et les géométries au format OGC Well-Known Text (WKT). QGIS autorise aussi
le collage d’entités WKT et GeoJSON provenant d’une application externe à l’intérieur une couche ouverte dans
QGIS.

Comment utiliser copier-coller ? En fait, vous pouvez modifier plus d’une couche à la fois et copier / coller des
entités entre les couches. Pourquoi faire cela? Imaginons que devions créer une nouvelle couche, mais avec
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seulement un ou deux lacs, et non les 5 000 de notre couche big_lakes. Nous pouvons créer un nouvelle
couche et utiliser copier / coller pour générer les lacs dans cette nouvelle couche.

Comme exemple, nous allons copier quelques lacs dans une nouvelle couche :

1. Chargez la couche dont vous voulez copier des entités (couche source)

2. Chargez ou créez la couche sur laquelle vous voulez coller des entités (couche cible)

3. Lancez l’édition pour la couche cible

4. Assurez-vous que la couche source est active en cliquant dessus dans la légende

5. Utilisez l’outil Sélectionner les entités par zone ou un simple clic pour sélectionner la ou les entités de la couche source

6. Cliquez sur l’outil Copier les entités

7. Assurez-vous que la couche cible est active en cliquant dessus dans la légende

8. Cliquez sur l’outil Coller les entités

9. Stoppez l’édition et sauvegardez les changements

Qu’arrive-t-il si les couches sources et cibles ont différents schémas de données (noms et type des champs dif-
férents) ? QGIS remplit ceux qui correspondent et ignore les autres. Si la copie des attributs ne vous intéresse pas,
la façon dont vous définissez les champs et les types de données n’a pas d’importance. Si vous voulez être sûr que
tout - l’entité et ses attributs - soit copié, assurez-vous que les schémas de données correspondent.

Note: Conformité des entités copiées

Si vos couches source et cible utilisent la même projection, les entités collées auront la même géométrie que
dans la couche source. Cependant, si la couche cible n’a pas la même projection, QGIS ne peut garantir que les
géométries seront identiques. Cela est simplement dû aux erreurs d’arrondissement faites lors de la conversion de
projection.

Astuce: Copier une chaîne d’attribut dans une autre

Si vous avez créé une nouvelle colonne dans votre table attributaire avec un type “chaîne” et que vous souhaitez
copier les valeurs d’une autre colonne d’attribut qui a une longueur plus grande que la taille de la colonne, celle-ci
sera étendue à la même longueur. Ceci est possible parce que le pilote GDAL Shapefile à partir de GDAL/OGR
1.10 sait auto-étendre des champs de type chaîne et entier pour s’adapter dynamiquement à la longueur des don-
nées insérées.

Supprimer les entités sélectionnées

Si nous voulons supprimer totalement une entité (attribut et géométrie), nous pouvons le faire en sélectionnant

d’abord la géométrie à l’aide de la commande Sélectionner les entités avec un rectangle ou un simple clic. La sélection peut
également être effectuée à partir de la table des attributs. Une fois que vous avez fait la sélection, appuyez sur

la touche Suppr ou Backspace ou utilisez l’outil Supprimer les entités sélectionnées pour supprimer les entités.
Plusieurs entités peuvent être supprimées à la fois.

L’outil Couper les entités de la barre d’outils numérisation peut également être utilisé pour supprimer des entités.
Ceci supprime effectivement les entités et les place également dans un « presse-papier spatial ». Donc nous

coupons les entités pour les supprimer et nous pouvons ensuite utiliser l’outil Coller les entités pour les récupérer,
nous donnant alors la capacité d’annuler une fois les changements. Couper, copier et coller fonctionnent sur les
entités sélectionnées ce qui signifie que nous pouvons travailler sur plus d’un objet à la fois.
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Annuler et refaire

Les outils Annuler et Refaire vous permettent d’annuler ou revenir sur un certain nombre d’opérations sur
les données vectorielles. La vue de base est une fenêtre où toutes les opérations sont répertoriées (voir Fig-
ure_edit_undo). Cette fenêtre n’est pas affichée par défaut, mais peut être affichée par un clic droit sur la barre
d’outils puis en cochant Annuler/Refaire parmi les panneaux. L’outil est actif même quand la fenêtre n’est pas
visible.

Figure 13.97: Outils Annuler et Refaire

Quand vous cliquez sur Annuler ou Ctrl+Z (ou Cmd+Z), l’état de toutes les entités et de leurs attributs retourne
à l’état connu avant que l’opération annulée ait été appliquée. Les changements autres que les modifications
classiques des vecteurs (par exemple des modifications effectuées par une extension) peuvent être ou ne pas être
annulés, selon la manière dont ils ont été effectués.

Pour utiliser l’historique Annuler/Refaire, cliquez simplement sur une opération dans la liste de l’historique.
Toutes les entités retrouveront leur état antérieur à cette opération.

Sauvegarder les couches éditées

Quand une couche est en mode édition, tous les changements sont stockés en mémoire par QGIS. Ils ne sont pas
sauvegardés immédiatement dans la source de données ou sur le disque. Si vous voulez enregistrer les modifica-

tions sans quitter le mode d’édition, il faut cliquer sur le bouton Enregistrer les modifications de la couche. Lorsque vous

déactivez le mode édition en cliquant sur Basculer en mode édition (ou en fermant QGIS), il vous est demandé si
vous souhaitez sauvegarder les changements ou les annuler.

Si les changements ne peuvent pas être sauvés (par exemple à cause d’un disque plein ou des valeurs d’attributs
dépassant la plage prévue), l’état de la mémoire de QGIS est préservé. Cela vous permet d’ajuster vos éditions et
réessayer.

Astuce: Intégrité des données

Il est toujours bon de sauvegarder vos données sources avant de les éditer. Bien que les auteurs de QGIS aient fait
tous les efforts possibles pour préserver l’intégrité de vos données, il n’y pas de garantie à cet égard.

Enregistrer plusieurs couches en même temps

Cette fonctionnalité permet la numérisation simultanée de plusieurs couches. Choisissez Enregistrer les
couches sélectionnées pour enregistrer toutes les modifications apportées dans plusieurs couches en même temps.

Vous avez aussi la possibilité de Retourner à l’étape précédente sur la couche sélectionnée afin d’annuler la
numérisation effectuée sur toutes les couches sélectionnées. Si vous souhaitez arrêter la modification des couches

sélectionnées, l’option Annuler sur la couche sélectionnée est le moyen le plus facile.
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Les mêmes fonctions sont disponibles pour l’édition de toutes les couches du projet.

Astuce: Use transaction group to edit, save or rollback multiple layers changes at once

When working with layers from the same PostGreSQL database, activate the Automatically create transaction
groups where possible option in Project → Properties. . . → Data Sources to sync their behavior (enter or exit the
edit mode, save or rollback changes at the same time).

13.5.4 Numérisation avancée

Bouton Fonction Bouton Fonction

Activer les outils de numérisation avancée Activer le tracé

Move Feature(s) Copy and Move Feature(s)

Pivoter l’entité Simplifier l’entité

Ajouter un anneau Ajouter une partie

Remplir l’anneau

Effacer un anneau Effacer une partie

Décalage X,Y Remodeler les entités

Séparer les parties Séparer les entités

Fusionner les attributs des entités sélection-
nées

Fusionner les entités sélection-
nées

Rotation des symboles de point Décaler le symbole ponctuel

Tableau Numérisation avancée : barre d’outils de numérisation avancée pour les couches vectorielles

Move Feature(s)

The Move Feature(s) tool allows you to move existing features:

1. Select the feature(s) to move.

2. Click on the map canvas to indicate the origin point of the displacement; you can rely on snapping capabil-
ities to select an accurate point.

You can also take advantages of the advanced digitizing constraints to accurately set the origin point coor-
dinates. In that case:

(a) First click on the button to enable the panel.

(b) Type x and enter the corresponding value for the origin point you’d like to use. Then press the
button next to the option to lock the value.

(c) Do the same for the y coordinate.

(d) Click on the map canvas and your origin point is placed at the indicated coordinates.

3. Move over the map canvas to indicate the destination point of the displacement, still using snapping mode or,
as above, use the advanced digitizing panel which would provide complementary distance and angle
placement constraints to place the end point of the translation.
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4. Click on the map canvas: the whole features are moved to new location.

Likewise, you can create a translated copy of the feature(s) using the Copy and Move Feature(s) tool.

Note: If no feature is selected when you first click on the map canvas with any of the Move Feature(s) or Copy
and Move Feature(s) tools, then only the feature under the mouse is affected by the action. So, if you want to
move several features, they should be selected first.

Pivoter l’entité

Use the Rotate Feature(s) tool to rotate one or multiple features in the map canvas:

1. Press the Rotate Feature(s) icon

2. Then click on the feature to rotate. The feature’s centroid is referenced as rotation center, a preview of the
rotated feature is displayed and a widget opens showing the current Rotation angle.

3. Click on the map canvas when you are satisfied with the new placement or manually enter the rotation angle
in the text box. You can also use the Snap to ° box to constrain the rotation values.

4. If you want to rotate several features at once, they shall be selected first, and the rotation is by default around
the centroid of their combined geometries.

You can also use an anchor point different from the default feature centroid: press the Ctrl button, click on the
map canvas and that point will be used as the new rotation center.

Si vous appuyez sur la touche Shift avant de cliquer sur la carte, la rotation appliquée suivra un pas de 45 degrés,
ce qui peut être modifié par la suite dans le gadget de saisie de l’utilisateur.

To abort feature rotation, press the ESC button or click on the Rotate Feature(s) icon.

Simplifier l’entité

The Simplify Feature tool allows you to interactively reshape a line or polygon geometry by reducing or densifying
the number of vertices, as long as the geometry remains valid:

1. Select the Simplify Feature tool.

2. Click on the feature or drag a rectangle over the features.

3. A dialog pops up allowing you to define the Method to apply, ie whether you would like to:

• simplify the geometry, meaning less vertices than the original. Available methods are
Simplify by distance, Simplify by snapping to grid or simplify by area
(Visvalingam). You’d then need to indicate the value of Tolerance in Layer units, Pixels
or map units to use for simplification. The higher the tolerance is the more vertices can be deleted.

• or densify the geometries with new vertices thanks to the Smooth option: for each existing vertex,
two vertices are placed on each of the segments originated from it, at an Offset distance representing
the percentage of the segment length. You can also set the number of Iterations the placement would
be processed: the more iterations, the more vertices and smoother is the feature.

Settings that you used will be saved when leaving a project or an edit session. So you can go back to the
same parameters the next time you simplify a feature.

4. A summary of the modifications that would apply is shown at the bottom of the dialog, listing number of
features and number of vertices (before and after the operation and the ratio the change represents). Also,
in the map canvas, the expected geometry is displayed over the existing one, using the rubberband color.
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5. When the expected geometry fits your needs, click OK to apply the modification. Otherwise, to abort the
operation, you can either press Cancel or right-click in the map canvas.

Note: Contrairement à l’option de simplification des entités dans Paramètres → Options → Rendering qui

simplifie la géométrie juste pour le rendu, L’outil Simplifier l’entité modifie définitivement la géométrie de l’entité
dans la source de données.

Ajouter une partie

Vous pouvez Ajouter une partie à l’entité sélectionnée pour générer un objet multipoint, multiligne ou multipoly-
gone. La nouvelle partie doit être numérisée en dehors de celle(s) existantes, à préalablement sélectionner.

Ajouter une partie peut également être utilisé pour ajouter une géométrie à une entité sans géométrie. Tout d’abord,

sélectionnez l’entité dans la table des attributs et numérisez la nouvelle géométrie avec l’outil Ajouter une partie.

Effacer une partie

L’outil Effacer une partie vous permet de supprimer une partie d’une entité multi-partie (par exemple, pour sup-
primer un polygone d’une entité multi-polygones). Cet outil fonctionne avec toutes les géométries multi-parties :
point, ligne et polygone. En outre, il peut être utilisé pour supprimer totalement la composante géométrique d’une
entité. Pour supprimer une partie, cliquez simplement dans la partie cible.

Ajouter un anneau

Vous pouvez créer des polygones à trou en utilisant l’icône Ajouter un anneau. Cela signifie qu’il est possible
de dessiner des polygones à l’intérieur d’une zone existante et d’en faire des trous, seule la zone entre les limites
externes des polygones sera conservée.

Remplir l’anneau

The Fill Ring tool helps you create polygon feature that totally falls within another one without any overlapping
area; that is the new feature covers a hole within the existing one. To create such a feature:

1. Select the Fill Ring tool.

2. Draw a new polygon over the existing feature: QGIS adds a ring to its geometry (like if you used the
Add Ring tool) and creates a new feature whose geometry matches the ring (like if you traced over the interior

boundaries with the Add polygon feature tool).

3. Or alternatively, if the ring already exists on the feature, place the mouse over the ring and left-click while
pressing Shift: a new feature filling the hole is drawn at that place.

The Feature Attributes form of the new feature opens, pre-filled with values of the « parent » feature and/or
fields constraints.
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Effacer un anneau

L’outil Effacer un anneau vous permet de supprimer des anneaux dans un polygone existant, en cliquant à
l’intérieur du trou. Cet outil ne fonctionne qu’avec des polygones et des multi-polygones. Il ne modifie rien
quand il est utilisé sur un anneau extérieur du polygone.

Remodeler les entités

You can reshape line and polygon features using the Reshape Features tool on the toolbar. For lines, it replaces the
line part from the first to the last intersection with the original line.

Figure 13.98: Remodeler une ligne

Astuce: Extension des géométries linéaires avec l’outil de remodelage

Use the Reshape Features tool to extend existing linestring geometries: snap to the first or last vertex of the line
and draw a new one. Validate and the feature’s geometry becomes the combination of the two lines.

For polygons, it will reshape the polygon’s boundary. For it to work, the reshape tool’s line must cross the
polygon’s boundary at least twice. To draw the line, click on the map canvas to add vertexes. To finish it, just
right-click. Like with the lines, only the segment between the first and the last intersections is considered. The
reshape line’s segments that are inside the polygon will result in cropping it, where the ones outside the polygon
will extend it.

With polygons, reshaping can sometimes lead to unintended results. It is mainly useful to replace smaller parts
of a polygon, not for major overhauls, and the reshape line is not allowed to cross several polygon rings, as this
would generate an invalid polygon.

Note: L’outil de remodelage peut altérer la position de départ d’un anneau polygonal ou d’une ligne close, le
point « double » ne sera plus le même. Ce n’est pas un problème pour la plupart des applications, mais c’est
quelque chose à considérer.

Décalage X,Y

L’outil Décalage X,Y crée des lignes parallèles décalées. L’outil peut être appliqué à la couche éditée (les
géométries sont modifiées) ou également aux couches d’arrière-plan (dans ce cas, il crée des copies des lignes
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Figure 13.99: Remodeler un polygone

/ anneaux et les ajoute à la couche éditée). Il est donc idéal pour la création de couches de lignes décalées. La
boîte de dialogue Entrée utilisateur s’affiche, indiquant la distance de déplacement.

Pour créer un décalage sur une couche de linéaires, vous devez activer le mode édition puis activer l’outil
Décalage X,Y. Cliquez alors sur une entité pour la déplacer. Déplacez la souris et cliquez quand vous le

souhaitez ou saisissez une distance. Vos modifications peuvent être sauvegardées en cliquant sur l’outil
Enregistrer les modifications de la couche.

La boîte de dialogue des options de QGIS (Préférences, onglet Numérisation puis section Outil de décalage de
courbe) vous permet de configurer les paramètres tels que Style de jointure, Segments de quadrant, Limite
d’angle droit.

Séparer les entités

Use the Split Features tool to split a feature into two or more new and independent features, ie. each geometry
corresponding to a new row in the attribute table.

To split line or polygon features:

1. Select the Split Features tool.

2. Draw a line across the feature(s) you want to split. If a selection is active, only selected features are split.
When set, default values or clauses are applied to corresponding fields and other attributes of the parent
feature are by default copied to the new features.

3. You can then as usually modify any of the attributes of any resulting feature.

Astuce: Split a polyline into new features in one-click

Using the Split Features tool, snap and click on an existing vertex of a polyline feature to split that feature into
two new features.

13.5. Éditer 301



QGIS User Guide, Version 3.4

Séparer les parties

Dans QGIS , il est possible de découper des parties d’une entité composée de plusieurs et donc d’en ajouter. Tracez

simplement une ligne à travers des parties que vous souhaitez découper en utilisant l’outil Séparer les parties.

Astuce: Split a polyline into new parts in one-click

Using the Split Parts tool, snap and click on an existing vertex of a polyline feature to split the feature into two
new polylines belonging to the same feature.

Fusionner les entités sélectionnées

L’outil Fusionner les entités sélectionnées permet de créer une nouvelle entité à partir d’entités existantes: sa géométrie
est le résultat de la fusion des géométries de départ. Si les entités n’ont pas de frontière commune alors un
multi-polygone/multiligne/multipoint sera créé.

1. First, select the features you’d like to combine.

2. Then press the Merge Selected Features button.

3. In the new dialog, the Merge line at the bottom of the table shows the attributes of the resulting feature. You
can alter any of these values either by:

• manually replacing the value in the corresponding cell;

• selecting a row in the table and pressing Take attributes from selected feature to use the values of this
initial feature;

• pressing Skip all fields to use empty attributes;

• or, expanding the drop down menu at the top of the table, select any of the above options to apply
to the corresponding field only. There, you can also choose to aggregate the initial features attributes
(Minimum, Maximum, Median, Sum, Count, Concatenation. . . depending on the type of the field. see
Panneau de résumé statistiques for the full list of functions).

Note: If the layer has default values or clauses present on fields, these are used as the initial value for the
merged feature.

4. Press OK to apply the modifications. A single (multi)feature is created in the layer, replacing the previously
selected ones.

Fusionner les attributs des entités sélectionnées

L’outil Fusionner les attributs des entités sélectionnées vous permet d’appliquer les mêmes attributs aux entités sans
fusionner leurs géométries. La fenêtre est semblable à celle de l’outil Fusionner les entités
sélectionnées à la différence qu’ici, les entités sont conservées avec leur géométrie de départ mais leurs
attributs sont rendus identiques.

Rotation des symboles de point

The Rotate Point Symbols allows you to change the rotation of point symbols in the map canvas.

1. First of all, apply to the symbol a data-defined rotation:

(a) In the Layer Properties → Symbology dialog, browse to the symbol editor dialog.
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(b) Click the Data-defined override widget near the Rotation option of the top Marker level (prefer-
ably) of the symbol layers.

(c) Choose a field in the Field Type combobox. Values of this field are hence used to rotate each feature’s
symbol accordingly.

Note: Make sure that the same field is assigned to all the symbol layers

Setting the data-defined rotation field at the topmost level of the symbol tree automatically propagates it
to all the symbol layers, a prerequisite to perform graphical symbol rotation with the Rotate Point Symbols
tool. Indeed, if a symbol layer does not have the same field attached to its rotation property, the tool will
not work.

Figure 13.100: Rotating a point symbol

2. Then click on a point feature in the map canvas with the Rotate Point Symbols and move the mouse
around, holding the left button pressed. A red arrow with the rotation value will be visualized (see Fig-
ure_rotate_point).

3. Release the left mouse button again, the symbol is defined with this new rotation and the rotation field is
updated in the layer’s attribute table.

Astuce: Si vous gardez la touche Ctrl enfoncée, la rotation se fera par palier de 15 degrés.

Décaler le symbole ponctuel

The Offset Point Symbols allows you to interactively change the rendered position of point symbols in the map

canvas. This tool behaves like the Rotate Point Symbols tool except that it requires you to connect a field to the
data-defined Offset (X,Y) property of the symbol, field which will then be populated with the offset coordinates
while moving the symbol in the map canvas.

Note: The Offset Point Symbols tool doesn’t move the point feature itself; you should use the
Vertex Tool (Current Layer) or Move Feature tool for this purpose.

13.5.5 Shape digitizing

The Shape Digitizing toolbar offers a set of tools to draw regular shapes and curved geometries.
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Add Circular string

The Add circular string or Add circular string by radius buttons allow users to add line or polygon features with a
circular geometry.

Creating features with these tools follow the same rule as of other digitizing tools: left-click to place vertices and
right-click to finish the geometry. While drawing the geometry, you can switch from one tool to the other as well
as to the linear geometry tools, creating some coumpound geometries.

Note: Les géométries courbes sont stockées comme telles uniquement avec les fournisseurs de données
compatibles

Although QGIS allows to digitize curved geometries within any editable data format, you need to be using a data
provider (e.g. PostGIS, memory layer, GML or WFS) that supports curves to have features stored as curved,
otherwise QGIS segmentizes the circular arcs.

13.5.6 Le panneau Numérisation avancée

Lors de la création, le remodelage ou encore la découpe de géométries, vous avez aussi la possibilité d’utiliser le
panneau de Numérisation avancée. Vous pouvez numériser des lignes exactement parallèles, perpendiculaires ou
suivant un angle spécifique. En outre, vous pouvez saisir directement les coordonnées des sommets et ainsi définir
de manière très précise votre géométrie.

Figure 13.101: Le panneau Numérisation avancée

The Advanced Digitizing panel can be open either with a right-click on the toolbar, from View → Panels → menu

or pressing Ctrl+4. Once the panel is visible, click the Enable advanced digitizing tools button to activate the set of
tools.

Note: Les outils ne sont pas disponibles si la vue de la carte est en coordonnées géographiques.

Concepts

The aim of the Advanced Digitizing tool is to lock coordinates, lengths, and angles when moving the mouse during
the digitalizing in the map canvas.

You can also create constraints with relative or absolute reference. Relative reference means that the next vertex
constraints” values will be relative to the previous vertex or segment.
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Paramètres d’accrochage

Click the button to set the Advanced Digitizing Tool snapping settings. You can make the tool snap to common
angles. The options are:

• Do not snap to common angles

• Snap to 30º angles

• Snap to 45º angles

• Snap to 90º angles

You can also control the snapping to features. The options are:

• Ne pas s’accrocher aux sommets ou aux segments

• Snap according to project configuration

• Snap to all layers

Raccourcis clavier

To speed up the use of Advanced Digitizing Panel, there are a couple of keyboard shortcuts available:

Key Simple Ctrl+ or Alt+ Shift+
D Set distance Lock distance
A Set angle Lock angle Toggle relative angle to last segment
X Set X coordinate Lock X coordinate Toggle relative X to last vertex
Y Set Y coordinate Lock Y coordinate Toggle relative Y to last vertex
C Toggle construction mode
P Toggle perpendicular and parallel modes

Absolute reference digitizing

When drawing a new geometry from scratch, it is very useful to have the possibility to start digitizing vertexes at
given coordinates.

For example, to add a new feature to a polygonal layer, click the button. You can choose the X and Y
coordinates where you want to start editing the feature, then:

• Click the x text box (or use the X keyboard shortcut).

• Type the X coordinate value you want and press Enter or click the button to their right to lock the
mouse to the X axis on the map canvas.

• Click the y text box (or use the Y keyboard shortcut).

• Type the Y coordinate value you want and press Enter or click the button to their right to lock the
mouse to the Y axis on the map canvas.

Two blue dotted lines and a green cross identify the exact coordinates you entered. Start digitizing by clicking on
the map canvas; the mouse position is locked at the green cross.

You can continue digitizing by free hand, adding a new pair of coordinates, or you can type the segment’s length
(distance) and angle.

If you want to draw a segment of a given length, click the d (distance) text box (keyboard shortcut D), type the

distance value (in map units) and press Enter or click the button on the right to lock the mouse in the map
canvas to the length of the segment. In the map canvas, the clicked point is surrounded by a circle whose radius is
the value entered in the distance text box.
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Figure 13.102: Start drawing at given coordinates

Figure 13.103: Fixed length segment
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Finally, you can also choose the angle of the segment. As described before , click the a (angle) text box (keyboard

shortcut A), type the angle value (in degrees), and press Enter or click the buttons on the right to lock it. In
this way the segment will follow the desired angle:

Figure 13.104: Fixed angle segment

Relative reference digitizing

Instead of using absolute values of angles or coordinates, you can also use values relative to the last digitized
vertex or segment.

For angles, you can click the button on the left of the a text box (or press Shift+A) to toggle relative angles
to the previous segment. With that option on, angles are measured between the last segment and the mouse pointer.

For coordinates, click the buttons to the left of the x or y text boxes (or press Shift+X or Shift+Y) to
toggle relative coordinates to the previous vertex. With these options on, coordinates measurement will consider
the last vertex to be the X and Y axes origin.

Continuous lock

Both in absolute or relative reference digitizing, angle, distance, X and Y constraints can be locked continuously

by clicking the Continuous lock buttons. Using continuous lock allows you to digitize several points or
vertexes using the same constraints.

Parallel and perpendicular lines

All the tools described above can be combined with the Perpendicular and Parallel tools. These two tools allow
drawing segments perfectly perpendicular or parallel to another segment.

To draw a perpendicular segment, during the editing click the Perpendicular icon (keyboard shortcut P) to ac-
tivate it. Before drawing the perpendicular line, click on the segment of an existing feature that you want to be
perpendicular to (the line of the existing feature will be colored in light orange); you should see a blue dotted line
where your feature will be snapped:

To draw a parallel feature, the steps are the same: click on the Parallel icon (keyboard shortcut P twice), click
on the segment you want to use as reference and start drawing your feature:
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Figure 13.105: Perpendicular digitizing

Figure 13.106: Parallel digitizing
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These two tools just find the right angle of the perpendicular and parallel angle and lock this parameter during
your editing.

Mode de construction

You can enable and disable construction mode by clicking on the Construction icon or with the C keyboard
shortcut. While in construction mode, clicking the map canvas won’t add new vertexes, but will capture the
clicks” positions so that you can use them as reference points to then lock distance, angle or X and Y relative
values.

As an example, the construction mode can be used to draw some point at an exact distance from an existing point.

With an existing point in the map canvas and the snapping mode correctly activated, you can easily draw other

points at given distances and angles from it. In addition to the button, you have to activate also the construction

mode by clicking the Construction icon or with the C keyboard shortcut.

Click next to the point from which you want to calculate the distance and click on the d box (D shortcut) type the
desired distance and press Enter to lock the mouse position in the map canvas:

Figure 13.107: Distance from point

Before adding the new point, press C to exit the construction mode. Now, you can click on the map canvas, and
the point will be placed at the distance entered.

You can also use the angle constraint to, for example, create another point at the same distance of the original one,

but at a particular angle from the newly added point. Click the Construction icon or with the C keyboard shortcut
to enter construction mode. Click the recently added point, and then the other one to set a direction segment. Then,
click on the d text box (D shortcut) type the desired distance and press Enter. Click the a text box (A shortcut)
type the angle you want and press Enter. The mouse position will be locked both in distance and angle.

Before adding the new point, press C to exit the construction mode. Now, you can click on the map canvas, and
the point will be placed at the distance and angle entered. Repeating the process, several points can be added.

13.5.7 The Processing in-place layer modifier

The Processing menu provides access to a large set of tools to analyze and create new features based on the
properties of the input features or their relations with other features (within the same layer or not). While the
common behavior is to create new layers as outputs, some algorithms also allow modifications to the input layer.
This is a handy way to automate multiple features modification using advanced and complex operations.
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Figure 13.108: Distance and angle from points

Figure 13.109: Points at given distance and angle
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To edit features in-place:

1. Select the layer to edit in the Layers panel.

2. Select the concerned features. You can skip this step, in which case the modification will apply to the whole
layer.

3. Press the Edit Features In-Place button at the top of the Processing toolbox. The list of algorithms is filtered,
showing only those compatible with in-place modifications, i.e.:

• They work at the feature source and not at the layer level.

• They do not change the layer structure, e.g. adding or removing fields.

• They do not change the geometry type, e.g. from line to point layer.

Figure 13.110: Processing algorithms: all (left) vs polygon in-place editors (right)

4. Find the algorithm you’d like to run and double-click it.

Note: If the algorithm does not need any additional user-set parameters (excluding the usual input and
output layer parameters), then the algorithm is run immediately without any dialog popup.

(a) If parameters other than the usual input or output layers are needed, the algorithm dialog pops up. Fill
in the required information.
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(b) Click Modify Selected Features or Modify All Features depending on whether there’s an active selec-
tion.

Changes are applied to the layer and placed in the edit buffer: the layer is indeed toggled to editing mode

with unsaved modification as indicated by the icon next to the layer name.

5. As usual, press Save layer edits to commit the changes in the layer. You can also press Undo to rollback
the whole modification.
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CHAPTER 14

Les données raster

14.1 Fenêtre Propriétés de la couche raster

To view and set the properties for a raster layer, double click on the layer name in the map legend, or right click on
the layer name and choose Properties from the context menu. This will open the Raster Layer Properties dialog.

Il y a plusieurs onglets dans cette fenêtre :

• Information

• Source

• Symbology

• Transparency

• Histogram

• Rendering

• Pyramids

• Metadata

• Legend

• QGIS Server

Astuce: Mise à jour du rendu en direct

Le: ref: layer_styling_panel vous fournit certaines des caractéristiques communes de la boîte de dialogue des
propriétés des calques et est un bon widget modélisé que vous pouvez utiliser pour accélérer la configuration des
styles de calque et afficher automatiquement vos modifications dans le canevas de la carte.

Note: Because properties (symbology, label, actions, default values, forms. . . ) of embedded layers (see Inclusion
de projets) are pulled from the original project file and to avoid changes that may break this behavior, the layer
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properties dialog is made unavailable for these layers.

14.1.1 Information Properties

The Information tab is read-only and represents an interesting place to quickly grab summarized information
and metadata on the current layer. Provided information are:

• based on the provider of the layer (format of storage, path, data type, extent, width/height, compression,
pixel size, statistics on bands, number of columns, rows and no-data values of the raster. . . );

• picked from the filled metadata: access, links, contacts, history. . . as well as data information (CRS, Extent,
bands. . . ).

14.1.2 Source Properties

The Source tab displays basic information about the selected raster, including:

• the Layer name to display in the Layers Panel;

• setting the Coordinate Reference System: Displays the layer’s Coordinate Reference System (CRS) as a
PROJ.4 string. You can change the layer’s CRS, selecting a recently used one in the drop-down list or

clicking on Select CRS button (see Sélectionneur de système de coordonnées de référence). Use this
process only if the CRS applied to the layer is a wrong one or if none was applied. If you wish to reproject
your data into another CRS, rather use layer reprojection algorithms from Processing or Save it into another
layer.

Figure 14.1: Raster Layers - Source Properties Dialog

14.1.3 Symbology Properties

Rendu des bandes raster

QGIS propose quatre Types de rendu. Le choix s’effectue en fonction du type de données.
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1. Multiband color - if the file comes as a multiband with several bands (e.g., used with a satellite image with
several bands).

2. Paletted/Unique values - for single band files that come with an indexed palette (e.g., used with a digital
topographic map) or for general use of palettes for rendering raster layers.

3. Singleband gray - (one band of) the image will be rendered as gray; QGIS will choose this renderer if the
file has neither multibands nor an indexed palette nor a continuous palette (e.g., used with a shaded relief
map).

4. Singleband pseudocolor - this renderer is possible for files with a continuous palette, or color map (e.g.,
used with an elevation map).

5. Hillshade - Creates hillshade from a band.

Multiband color

With the multiband color renderer, three selected bands from the image will be rendered, each band representing
the red, green or blue component that will be used to create a color image. QGIS automatically fetches Min and
Max values for each band of the raster and scales the coloring accordingly. You can control the value ranges with
the help of the Min/Max Value Settings section.

A Contrast enhancement method can also be applied to the values: “No enhancement”, “Stretch to MinMax”,
“Stretch and clip to MinMax” and “Clip to min max”.

Note: Amélioration de contraste

Lors de l’ajout d’une couche raster GRASS, l’option Amélioration de contraste sera automatiquement Étirer
jusqu’au MinMax, quelles que soient les options générales de QGIS définies pour cette option.

Figure 14.2: Raster Symbology - Multiband color rendering
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Astuce: Visualiser une seule bande d’un raster multibande

If you want to view a single band of a multiband image (for example, Red), you might think you would set the
Green and Blue bands to Not Set. But this is not the correct way. To display the Red band, set the image type to
Singleband gray, then select Red as the Gray band to use.

Paletted/Unique values

C’est l’option standard pour les fichiers à une seule bande qui incluent déjà une table de couleurs, où à chaque
valeur de pixel a été assignée une couleur. Dans ce cas, la palette est utilisée automatiquement. Si vous désirez
modifier l’assignement des couleurs pour certaines valeurs, double cliquez simplement sur la couleur et la boîte de
dialogue de Sélection de couleur apparaîtra. Il est possible d’assigner un label aux valeurs de couleur. L’étiquette
apparaîtra alors dans la légende de la couche raster.

This option can be used for rendering all raster bands using a palette, assigning a color to each unique raster value.

Figure 14.3: Raster Symbology - Paletted unique value rendering

Singleband gray

This renderer allows you to render a single band layer with a Color gradient: “Black to white” or “White to black”.
You can define a range of values to color other than the default Min and Max values of the whole raster, thanks to
the Min/Max Value Settings option.

Again, a Contrast enhancement method can be applied to the values: “No enhancement”, “Stretch to MinMax”,
“Stretch and clip to MinMax” and “Clip to min max”.
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Figure 14.4: Raster Symbology - Singleband gray rendering

Singleband pseudocolor

C’est une option de rendu pour les fichiers à bande unique, incluant une palette de couleurs continues. Vous
pouvez aussi créer des palettes de couleurs pour les fichiers à bande unique.

Figure 14.5: Raster Symbology - Singleband pseudocolor rendering

Using a Band of the layer and a values range, three types of color Interpolation are available:

• Discrete (a <= symbol appears in the value column)

• Linéaire

• Exact (an equal symbol appears in the Value column)
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The Color ramp drop down list lists the color ramp in your QGIS. You can add a new one, edit or save the one
you changed. The name of the color ramp will be saved in the configuration and in the QML files.

The Label unit suffix is a label added after the value in the legend.

For the classification Mode “Equal interval”, you only need to select the number of classes and press

the button Classify. In the case of the Mode “Continuous”, QGIS creates classes automatically depending
on the Min and Max.

The button Add values manually adds a value to the individual color table. The button Remove selected row deletes a
value from the individual color table. Double clicking on the value column lets you insert a specific value. Double
clicking on the color column opens the dialog Change color, where you can select a color to apply on that value.
Further, you can also add labels for each color, but this value won’t be displayed when you use the identify feature
tool.

You can use the buttons Load color map from file or Export color map to file to load an existing color table or to save
the defined color table for other sessions.

The Clip out of range values allows QGIS to not render pixel greater than the Max value.

Hillshade

Render a band of the raster layer using hillshading.

Figure 14.6: Raster Symbology - Hillshade rendering

Options:

• Band: The raster band to use.

• Altitude: The elevation angle of the light source (default is 45°).

• Azimuth: The azimuth of the light source (default is 315°).

• Z Factor: Scaling factor for the values of the raster band (default is 1).

• Multidirectional: Specify if multidirectional hillshading is to be used (default is off).
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Setting the min and max values

By default, QGIS reports the Min and Max values of the band(s) of the raster. A few very low and/or high values
can have a negative impact on the rendering of the raster. The Min/Max Value Settings menu helps you control the
values to render.

Figure 14.7: Raster Symbology - Min and Max Value Settings

Available options are:

• User defined: The default Min and Max values of the band(s) can be overridden

• Cumulative count cut: Removes outliers. The standard range of values is 2% to 98%, but can be adapted
manually.

• Min/max: Uses the whole range of values in the image band.

• Mean +/- standard deviation x: Creates a color table that only considers values within the standard devi-
ation or within multiple standard deviations. This is useful when you have one or two cells with abnormally
high values in a raster grid that are having a negative impact on the rendering of the raster.

Calculations of the min and max values of the bands are made based on the:

• Statistics extent: it can be Whole raster, Current canvas or Updated canvas

• and the Accuracy, which can be either Estimate (faster) or Actual (slower).

Note: For some settings, you may need to press the Apply button of the layer properties dialog in order to display
the actual min and max values in the widgets.

Rendu des couleurs

Pour chaque type de Rendu par bande, des options de Rendu de la couleur sont disponibles.

Vous pouvez réaliser des effets spéciaux sur le rendu de vos rasters en utilisant un des modes de fusion (voir Modes
de fusion).

D’autres paramètres permettent de modifier la Luminosité, la Saturation et le Contraste. Vous pouvez également
utiliser un Dégradé de gris et le faire “Par clarté”, “Par luminosité”, ou “Par moyenne”. Pour une teinte de couleur,
vous pouvez en modifier la “Force”

Ré-échantillonnage

Les options de Ré-échantillonnage déterminent l’apparence d’un raster quand vous zoomez ou dé-zoomez. Dif-
férents modes de ré-échantillonnage permettent d’optimiser l’apparence d’un raster. Ils calculent une nouvelle
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matrice de valeurs via une transformation géométrique.

Figure 14.8: Raster Symbology - Color rendering and Resampling settings

En appliquant la méthode “Plus proche voisin”, le raster peut apparaître pixelisé lorsque l’on zoome dessus.
Ce rendu peut être amélioré en choisissant les méthodes “Bilinéaire” ou “Cubique” qui adoucissent les angles.
L’image est alors lissée. Ces méthodes sont adaptées par exemple aux rasters d’élévation.

At the bottom of the Symbology tab, you can see a thumbnail of the layer, its legend symbol, and the palette.

14.1.4 Propriétés de transparence

QGIS has the ability to display each raster layer at a different transparency level. Use the transparency slider

to indicate to what extent the underlying layers (if any) should be visible through the current
raster layer. This is very useful if you like to overlay more than one raster layer (e.g., a shaded relief map overlayed
by a classified raster map). This will make the look of the map more three dimensional.

Figure 14.9: Raster Transparency

De plus, vous pouvez entrer une valeur raster qui sera traitée comme NODATA dans l’option Valeur nulle supplé-
mentaire.
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An even more flexible way to customize the transparency can be done in the Custom transparency options section:

• Use Transparency band to apply transparency on an entire band.

• Provide a list of pixels to make transparent with the corresponding level of transparency:

1. Cliquez sur le bouton Ajouter des valeurs manuellement. Une nouvelle ligne apparait dans la liste des pixels.

2. Enter the Red, Green and Blue values of the pixel and adjust the Percent Transparent to apply.

3. Alternatively, you can directly fetch the pixel values directly from the raster using the
Add values from display button. Then enter the transparency value.

4. Repeat the steps to adjust more values with custom transparency.

5. Press the Apply button and have a look at the map.

Comme vous pouvez le voir, il est assez facile de définir une transparence personnalisée, mais cela peut

prendre un peu de temps. Par conséquent, vous pouvez utiliser le bouton Exporter dans un fichier pour sauver

vos paramètres de transparence dans un fichier. Le bouton Importer depuis le fichier charge vos paramètres de
transparence et les applique à la couche raster actuelle.

14.1.5 Propriétés de l’Histogramme

The Histogram tab allows you to view the distribution of the bands or colors in your raster. The histogram is
generated when you press the Compute Histogram button. All existing bands will be displayed together. You can

save the histogram as an image with the button.

At the bottom of the histogram, you can select a raster band in the drop-down menu and Set min/max style for it.

The Prefs/Actions drop-down menu gives you advanced options to customize the histogram:

• With the Visibility option, you can display histograms of the individual bands. You will need to select the

option Show selected band.

• The Min/max options allow you to “Always show min/max markers”, to “Zoom to min/max” and to “Update
style to min/max”.

• The Actions option allows you to “Reset” or “Recompute histogram” after you changed the min or max
values of the band(s).

14.1.6 Rendering Properties

In the Rendering tab, it’s possible to:

• apply a Scale dependent visibility to the layer: You can set the Maximum (inclusive) and Minimum (exclu-
sive) scale, defining a range of scale in which the layer will be visible. Out of this range, it’s hidden. The

Set to current canvas scale button helps you use the current map canvas scale as boundary of the range visibility.
See Rendu dépendant de l’échelle for more information.

• Refresh layer at interval (seconds): set a timer to automatically refresh individual layers at a matching
interval. Canvas updates are deferred in order to avoid refreshing multiple times if more than one layer has
an auto update interval set.

Vous pouvez définir une échelle Maximum (inclusive) et Minimum (exclusive), correspondant à une plage
d’échelles pour lesquelles les couches sont visibles. En dehors de cette plage, elles sont cachées. Le bouton

Mettre à l’échelle actuelle du canevas permet d’utiliser l’échelle actuelle pour l’une ou l’autre des limites de la plage de
visibilité. Voir Rendu dépendant de l’échelle pour plus d’informations.
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Figure 14.10: Histogramme raster

Figure 14.11: Raster Rendering
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14.1.7 Propriétés des Pyramides

Les couches raster à haute résolution peuvent ralentir la navigation dans QGIS. En créant des copies des données
de plus basses résolutions (des pyramides), les performances peuvent être considérablement améliorées puisque
QGIS sélectionne la résolution la plus pertinente à utiliser en fonction du niveau de zoom.

Vous devez avoir accès en écriture dans le répertoire où les données originelles sont stockées pour construire les
pyramides.

From the Resolutions list, select resolutions for which you want to create pyramid by clicking on them.

If you choose Internal (if possible) from the Overview format drop-down menu, QGIS tries to build pyramids
internally.

Note: Notez que construire des pyramides peut altérer le fichier original et, une fois créées, elles ne peuvent
plus être supprimées. Si vous désirez préserver une version “sans pyramide” de vos raster, réalisez une copie de
sauvegarde avant de les construire.

If you choose External and External (Erdas Imagine) the pyramids will be created in a file next to the original
raster with the same name and a .ovr extension.

Several Resampling methods can be used to calculate the pyramids:

• Plus proche voisin

• Moyenne

• Gauss

• Cubique

• Cubic Spline

• Laczos

• Mode

• Aucune

Finally, click Build Pyramids to start the process.

Figure 14.12: Pyramides Raster
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14.1.8 Propriétés des Métadonnées

The Metadata tab provides you with options to create and edit a metadata report on your layer. See vector
layer metadata properties for more information.

14.1.9 Propriétés de la Légende

The Legend tab provides you with a list of widgets you can embed within the layer tree in the Layers panel.
The idea is to have a way to quickly access some actions that are often used with the layer (setup transparency,
filtering, selection, style or other stuff. . . ).

By default, QGIS provides transparency widget but this can be extended by plugins registering their own widgets
and assign custom actions to layers they manage.

14.1.10 QGIS Server Properties

The QGIS Server tab displays a wealth of information about the raster layer, including statistics about each
band in the current raster layer. From this tab, entries may be made for the Description, Attribution, MetadataUrl
and Properties. In Properties, statistics are gathered on a “need to know” basis, so it may well be that a given
layer’s statistics have not yet been collected.

Figure 14.13: QGIS Server in Raster Properties

14.2 Analyse Raster

14.2.1 Calculatrice Raster

La Calculatrice Raster du menu Raster vous permet d’effectuer des calculs sur la base des valeurs des pixels d’un
raster existant (voir figure_raster_calculator). Le résultat est écrit dans un nouveau raster dans un des formats
gérés par GDAL.

La liste Bandes raster contient toutes les couches rasters actuellement chargées pouvant être utilisées. Pour
ajouter un raster à la formule de calcul, faites un double-clic sur son nom dans la liste. Vous pouvez alors utiliser
les opérateurs pour construire une formule ou bien les taper directement dans la zone de saisie.
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Figure 14.14: Calculatrice Raster
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Dans la partie Couche de résultat, vous devez définir la couche en sortie. Vous pouvez préciser l’étendue de la
zone de calcul en vous basant sur une des couches raster utilisées ou en spécifiant des coordonnées X et Y ainsi
que les nombres de lignes et de colonnes pour indiquer la résolution. Si la couche en entrée a une résolution
différente, les valeurs seront interpolées avec l’algorithme du plus proche voisin.

La partie Opérateurs contient tous les opérateurs disponibles. Pour ajouter un opérateur à la formule, cliquez
sur le bouton approprié. Les opérateurs mathématiques (+, -, *, . . . ) et les fonctions trigonométriques (sin,
cos, tan, . . . ) sont disponibles. Les opérateur d’expression conditionnelle (=, !=, <, >=, . . . ) renvoient soit 0
pour faux soit 1 pour vrai et peuvent être utilisés en combinaison avec d’autres opérateurs ou fonctions. D’autres
opérateurs feront leur apparition !

Le fait de cocher Ajouter le résultat au projet chargera automatiquement le raster de résultat dans la légende
du projet courant et pourra être visualisé.

Exemples

Conversion en pieds de données d’élévation en mètres

Pour créer un raster d’élévation en pieds à partir d’un raster en mètres, vous devez utiliser le facteur de conversion
3,28. La formule est la suivante :

"elevation@1" * 3.28

Utilisation d’un masque

Si vous souhaitez masquer certaines zones d’un raster, par exemple si vous vous intéressez uniquement aux alti-
tudes supérieures à 0, vous pouvez utiliser la formule suivante qui crée un masque et l’applique au raster en une
seule étape.

("elevation@1" >= 0) * "elevation@1"

En d’autres termes, pour tous les pixels supérieurs ou égaux à 0, l’expression conditionnelle renvoie 1, ce qui
conserve la valeur originelle en la multipliant par 1. Sinon, l’expression conditionnelle renvoie 0, ce qui remplace
la valeur originelle par 0. Ceci permet de créer le masque à la volée.

Si vous souhaitez classer un raster, par exemple en deux classes d’altitudes, vous pouvez utiliser la formule suiv-
ante pour créer un raster contenant deux valeurs, 1 et 2, en une seule étape :

("elevation@1" < 50) * 1 + ("elevation@1" >= 50) * 2

En d’autres termes, les pixels de valeur inférieure à 50 prennent la valeur 1. Pour tous les pixels supérieurs ou égal
à 50 prennent la valeur 2.

14.2.2 Alignement de rasters

Cet outil permet de prendre plusieurs rasters en entrée et de les aligner exactement :

• reprojette dans le même SRC,

• échantillonne à la même taille de cellule et décale sur la même grille,

• découpe une région d’intérêt,

• rééchantillonne les valeurs lorsque cela est nécessaire.

Les rasters seront sauvegardés dans de nouveaux fichiers.

Tout d’abord, ouvrez les outils à partir de Raster → Aligner les Rasters. . . et cliquez sur Ajouter un nouveau raster

pour choisir un raster existant. Sélectionnez un fichier de sortie pour enregistrer le raster après l’alignement, la
méthode de ré-échantillonnage et si nécessaire Rééchelonner les valeurs en fonction de la taille de la cellule. La
méthode de ré-échantillonnage est à choisir parmi (voir figure_raster_align_edit) :

• Au plus proche voisin
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• Bilinéaire (noyau de 2x2)

• Cubic (4x4 kernel): Cubic Convolution Approximation

• Cubic B-Spline (4x4 kernel): Cubic B-Spline Approximation

• Lanczos (6x6 kernel): Lanczos windowed sinc interpolation

• Moyenne : calcule la moyenne de tous les pixels qui ne sont pas des NODATA

• Mode : sélectionne la valeur la plus fréquente parmi les pixels

• Maximum, Minimum, Médiane, Premier Quartile (Q1) or Troisième Quartile (Q3) de tous les pixels
qui ne sont pas des NODATA

Note: Les méthodes maximum, minimum, médiane, premier et troisième quartiles ne sont disponibles que si
QGIS est installé avec GDAL >= 2.0.

Figure 14.15: Sélection des options de ré-échantillonnage raster

Dans la fenêtre Aligner les raster, vous pouvez Modifier les paramètres de traitement d’un fichier ou
Supprimer un fichier existant de la liste des couches raster.Vous pouvez également choisir parmi les options suiv-
antes (voir figure_raster_align) :

• sélectionner une Couche de référence,

• reprojeter dans un nouveau SCR,

• choisir une Taille de cellule différente,

• choisir un Décalage de la grille,

• Découper selon l’emprise : elle peut être définie par l’utilisateur, basée sur une des couches ou sur l’emprise
de la carte.

• Taille de sortie,

• Ajouter les rasters alignés au canevas de la carte.
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Figure 14.16: Alignement de rasters
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Les données maillées (mesh)

15.1 Travailler avec des données maillées (mesh)

15.1.1 Qu’est-ce qu’un maillage ?

Un maillage est une grille non structurée qui contient usuellement des composantes temporelle ou d’autres types.
La composante spatiale contient une collection de sommets, d’arêtes et de faces en 2D ou en 3D :

• sommets : points XY(Z) (dans le système de coordonnées de la couche)

• arêtes : connecte des paires de sommets

• faces : une face est définie par une série d’arêtes formant une surface fermée, typiquement un triangle ou
un quadrilatère et, plus rarement, un polygone composé de plus de sommets

Figure 15.1: Différents types de maillage

QGIS est actuellement capable d’afficher des données maillées composées de triangles ou de quadrilatères.
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Le maillage fournit les information sur la structure spatiale. En plus, un maillage peut contenir des jeux de données
(des groupes) qui attribuent une valeur à chaque sommet. Voici un exemple avec un maillage triangulaire dont les
numéros de sommets apparaissent sur l’image ci-dessous :

Figure 15.2: Maillage triangulaire dont les sommets sont numérotés

Chaque sommet peut stocker plusieurs jeux de données (très souvent de grandes quantités) et ceux-ci peuvent avoir
également une dimension temporelle. Ainsi, un unique fichier peut contenir de très nombreux jeux de données.

Le tableau qui suit donne une idée des informations qui peuvent être stockées dans les jeux de données maillés.
Les colonnes correspondent aux numéros des sommets et chaque ligne représente un jeu de données. Les jeux
de données peuvent être de différents types. Dans cet exemple, il s’agit de la vitesse du vent à 10m à différents
moments (t1, t2, t3).

De la même manière, un jeu de données maillé peut stocké des vecteurs de valeurs pour chaque sommet. Par
exemple, la direction du vent à un moment donné :

Vent à 10m 1 2 3 . . .
Vitesse à 10m au temps t1 17251 24918 32858 . . .
Vitesse à 10m au temps t2 19168 23001 36418 . . .
Vitesse à 10m au temps t3 21085 30668 17251 . . .
. . . . . . . . . . . . . . .
Direction du vent à 10m au temps t1 [20,2] [20,3] [20,4.5] . . .
Direction du vent à 10m au temps t2 [21,3] [21,4] [21,5.5] . . .
Direction du vent à 10m au temps t3 [22,4] [22,5] [22,6.5] . . .
. . . . . . . . . . . . . . .
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Nous pouvons visualiser les données en attribuant des couleurs aux valeurs (de la même façon que pour les
rendus raster en Pseudo-couleur à bande unique) et en interpolant les données entre les sommets en fonction de
la topologie. Il est courant que les valeurs soient des vecteurs 2D plutôt que de simples valeurs scalaires (comme
pour la direction du vent). Pour de telles types de valeurs, il est préférable d’afficher des flèches indiquant les
directions.

Figure 15.3: Exemples de visualisation de données maillées

15.1.2 Formats de données gérés

QGIS accède aux données maillées via les pilotes MDAL. Ainsi, les formats gérés nativement sont :

• NetCDF: Format générique pour les données scientifiques

• GRIB: Format utilisé couramment en météorologie

• XMDF: Par exemple, des sorties du modèle hydraulique TUFLOW

• DAT: Format de sortie de nombreux modèles d’hydrodynamique (par ex. BASEMENT, HYDRO_AS-2D,
TUFLOW)

• 3Di: Format du modèle 3Di basé sur les Conventions « Climate and Forecast » (http://cfconventions.org/)

• Quelques exemples de jeux de données maillés se trouvent ici : https://apps.ecmwf.int/datasets/data/
interim-full-daily/levtype=sfc/

15.1.3 Charger une couche de maillage

Pour ajouter une couche de maillage à QGIS :

1. Open the Data Source Manager dialog, either by selecting it from the Layer → menu or clicking the
Open Data Source Manager button.

2. Then, enable the Mesh tab on the left panel

3. Press the . . . button to select the file and press Add. The layer will be added using the native mesh rendering.
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Figure 15.4: Mesh tab in Data Source Manager
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15.1.4 Mesh Dataset Properties

Information

Figure 15.5: Mesh Layer Properties

The Information tab is read-only and represents an interesting place to quickly grab summarized information and
metadata on the current layer. Provided information are (based on the provider of the layer) uri, vertex count, face
count and dataset groups count.

Source

The Source tab displays basic information about the selected mesh, including:

• the Layer name to display in the Layers panel

• setting the Coordinate Reference System: Displays the layer’s Coordinate Reference System (CRS) as a
PROJ.4 string. You can change the layer’s CRS by selecting a recently used one in the drop-down list or

clicking on Select CRS button (see Sélectionneur de système de coordonnées de référence). Use this
process only if the CRS applied to the layer is wrong or if none was applied.

Use the Assign Extra Dataset to Mesh button to add more groups to the current mesh layer.

Style

Click the Style button to activate the dialog as shown in the following image:

Style properties are divided in several tabs:

• General

• Contours Symbology

• Vectors Symbology

• Rendering

15.1. Travailler avec des données maillées (mesh) 333



QGIS User Guide, Version 3.4

Figure 15.6: Mesh Layer Style

General

The tab presents the following items:

• groups available in the mesh dataset

• dataset in the selected group(s), for example, if the layer has a temporal dimension

• metadata if available

• blending mode available for the selected dataset.

The slider , combo box and buttons allow to explore another dimension of the data,
if available. As the slider moves, the metadata is presented accordingly. See the figure Mesh groups below as an
example. The map canvas will display the selected dataset group as well.

Figure 15.7: Dataset in Selected Group(s)

You can apply symbology to each group using the tabs.
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Contours Symbology

Under Groups, click on to show contours with default visualization parameters.

In the tab you can see and change the current visualization options of contours for the selected group, as
shown in the image Styling contours in a mesh below:

Figure 15.8: Styling Contours in a Mesh Layer

Use the slide bar or combo box to set the opacity of the current group.

Use Load to adjust the min and max values of the current group.

The Interpolation list contains three options to render contours: Linear, Discrete and Exact.

The Color ramp widget opens the color ramp drop-down shortcut.

The Label unit suffix is a label added after the value in the legend.

By selecting Continuous in the classification Mode, QGIS creates classes automatically considering the Min and
Max values. With ‘Equal interval’, you only need to select the number of classes using the combo box Classes
and press the button Classify.

The button Add values manually adds a value to the individual color table. The button Remove selected row deletes a
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value from the individual color table. Double clicking on the value column lets you insert a specific value. Double
clicking on the color column opens the dialog Change color, where you can select a color to apply on that value.

Vectors Symbology

In the tab , click on to display vectors if available. The map canvas will display the vectors in the selected

group with default parameters. Click on the tab to change the visualization parameters for vectors as shown
in the image below:

Figure 15.9: Styling Vectors in a Mesh Layer

The line width can be set using the combo box or typing the value. The color widget opens the dialog Change
color, where you can select a color to apply to vectors.

Enter values for Min and Max to filter vectors according to their magnitude.

Check on the box Display Vectors on User Grid and specify the X spacing and the Y spacing, QGIS will render
the vector considering the given spacing.

With the Head Options Head Options, QGIS allows the shape of the arrow head to be set by specifying width and
length (in percentage).
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Vector’s Arrow length can be rendered in QGIS in three different ways:

• Defined by Min and Max: You specify the minimum and maximum length for the vectors, QGIS will adjust
their visualization accordingly

• Scale to magnitude: You specify the (multiplying) factor to use

• Fixed: all the vectors are shown with the same length

Rendering

In the tab , QGIS offers two possibilities to display the grid, as shown in the image Mesh rendering:

• Native Mesh Rendering that shows quadrants

• Triangular Mesh Rendering that display triangles

Figure 15.10: Mesh Rendering

The line width and color can be changed in this dialog, and both the grid renderings can be turned off.
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CHAPTER 16

Laying out the maps

With Print Layouts and Reports you can create maps and atlases, and print them or save them as image, PDF or
SVG files.

16.1 Overview of the Print Layout

The print layout provides growing layout and printing capabilities. It allows you to add elements such as the QGIS
map canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. You
can size, group, align, position and rotate each element and adjust their properties to create your layout. The layout
can be printed or exported to image formats, PostScript, PDF or to SVG (export to SVG is not working properly
with some recent Qt4 versions; you should try and check individually on your system). You can save the layout as
a template and load it again in another session. Finally, generating several maps based on a template can be done
through the atlas generator.

16.1.1 Exemple d’utilisation

Before you start to work with the print layout, you need to load some raster or vector layers in the QGIS map
canvas and adapt their properties to suit your own convenience. After everything is rendered and symbolized

to your liking, click the New Print Layout icon in the toolbar or choose File → New Print Layout. You will be
prompted to choose a title for the new layout.

Pour créer une carte, veuillez suivre les instructions suivantes.

1. Sur le côté gauche, sélectionnez le bouton de barre d’outils Ajouter une nouvelle carte et dessinez un rectangle.
A l’intérieur du rectangle dessiné, la carte de la vue QGIS est affichée .

2. Select the Add new scalebar toolbar button and click with the left mouse button on the print layout canvas.
A scalebar will be added to the canvas.

3. Sélectionnez le bouton de la barre d’outils Ajouter une nouvelle légende et dessinez un rectangle dans le canevas
en maintenant enfoncé le bouton gauche de la souris. À l’intérieur du rectangle dessiné, la légende sera
affichée.

4. Sélectionnez l’icône Sélectionner/Déplacer un objet pour sélectionner la carte sur le canevas et déplacez-le un
peu.
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5. Tant que l’élément de carte est encore sélectionné, vous pouvez également modifier la taille de l’élément
de carte. Cliquez tout en maintenant le bouton gauche de la souris enfoncé, dans un petit rectangle blanc
dans l’un des coins de l’élément de la carte et faites-le glisser vers un nouvel emplacement pour modifier sa
taille.

6. Cliquez sur le panneau Propriétés d’élément en bas à gauche et trouvez le réglage pour l’orientation.
Changez la valeur du paramètre Orientation de la carte en “15.00°”. Vous devriez voir l’orientation de
la carte changer.

7. Now, you can print or export your print layout to image formats, PDF or to SVG with the export tools in
Layout menu.

8. Finally, you can save your print layout within the project file with the Save Project button.

You can add multiple elements to the print layout. It is also possible to have more than one map view or legend or
scale bar in the print layout canvas, on one or several pages. Each element has its own properties and, in the case
of the map, its own extent. If you want to remove any elements from the layout canvas you can do that with the
Delete or the Backspace key.

16.1.2 The Layout Manager

The Layout Manager is the main window to manage print layouts in the project. It gives you an overview of
existing print layouts and reports in the project and offers tools to:

• add new print layout or new report from scratch, template or duplicating an existing one;

• rename or delete any of them;

• open them in the project.

To open the layout manager dialog:

• from the main QGIS dialog, select Project → Layout Manager. . . menu or click on the Layout Manager

button in the Project Toolbar;

• from a print layout or report dialog, select Layout → Layout Manager. . . menu or click on the
Layout Manager button in the Layout Toolbar.

Figure 16.1: The Print Layout Manager

The layout manager lists in its upper part all the available print layouts or reports in the project with tools to:

• show the selection: you can select multiple reports and/or print layout(s) and open them in one-click.
Double-click a name also opens it;
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• duplicate the selected print layout or report (available only if one item is selected): it creates a new dialog
using the selected one as template. You’ll be prompted to choose a new title for the new layout;

• rename the report or layout (available only if one item is selected): you’ll be prompted to choose a new title
for the layout;

• remove the layout: the selected print layout(s) will be deleted from the project.

In the lower part, it’s possible to create new print layouts or reports from scratch or a template. By default, QGIS
will look for templates in the user profile and the application template directories (accessible with the two buttons
at the bottom of the frame) but also in any folder declared as Path(s) to search for extra print templates in Settings
→ Options → Layouts. Found templates are listed in the combobox. Select an item and press the Create button
to generate a new report or print layout.

You can also use layout templates from a custom folder; in that case, select specific in the templates drop-down
list, browse to the template and press Create.

Astuce: Creating template-based print layouts from Browser panel

Drag-and-drop a print layout template .qpt file from any file browser onto the map canvas or double-click it in
the Browser panel generates a new print layout from the template.

16.1.3 Menus, tools and panels of the print layout

Opening the print layout provides you with a blank canvas that represents the paper surface when using the print
option. Initially you find buttons on the left beside the canvas to add print layout items: the current QGIS map
canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. In this
toolbar you also find buttons to navigate, zoom in on an area and pan the view on the layout a well as buttons to
select any layout item and to move the contents of the map item.

figure_layout_overview shows the initial view of the print layout before any elements are added.

Figure 16.2: Print Layout
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On the right beside the canvas you find two set of panels. The upper one holds the panels Items and Undo History
and the lower holds the panels Layout, Item properties and Atlas generation.

• The Items panel provides a list of all the print layout items added to the canvas and ways to globally interact
with them (see The Items Panel for more information).

• The Undo History panel displays a history of all changes applied to the layout. With a mouse click, it is
possible to undo and redo layout steps back and forth to a certain status.

• The Layout panel allows you to set general parameters to apply to the layout when exporting or working
within (see The Layout Panel for more details);

• The Item Properties panel displays the properties for the selected item. Click the Select/Move item icon
to select an item (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties panel and
customize the settings for the selected item (see Layout Items for detailed information on each item settings).

• The Atlas panel allows you to enable the generation of an atlas for the current layout and gives access to its
parameters (see Générer un Atlas for detailed information on atlas generation usage).

In the bottom part of the print layout window, you can find a status bar with mouse position, current page number,
a combo box to set the zoom level, the number of selected items if applicable and, in the case of atlas generation,
the number of features.

In the upper part of the print layout window, you can find menus and other toolbars. All print layout tools are
available in menus and as icons in a toolbar.

The toolbars and the panels can be switched off and on using the right mouse button over any toolbar or through
View → Toolbars → or View → Panels →.

Menus and Tools

Layout menu

The Layout provides action to manage the layout:

• Save the project file directly from the print layout window.

• Create a new and blank print layout with New Layout. . . .

• Duplicate Layout. . . : Create a new print layout by duplicating the current one.

• Remove the current layout with Delete Layout. . . .

• Open the Layout Manager. . . .

• Layouts → : Open an existing print layout.

Once the layout is designed, with Save as Template and Add Items from Template icons, you can save
the current state of a print layout session as a .qpt template file and load its items again in another session/print
layout.

In the Layout menu, there are also powerful ways to share geographical information produced with QGIS that can

be included in reports or published. These tools are Export as Image. . . , Export as PDF. . . , Export

as SVG. . . and Print. . . .

Below is a list of all the available tools in this menu with some convenient information.

342 Chapter 16. Laying out the maps



QGIS User Guide, Version 3.4

Tool Shortcut Toolbar Reference

Save Project Ctrl+S Layout Introducing QGIS projects

New Layout Ctrl+N Layout The Layout Manager

Duplicate Layout Layout The Layout Manager

Delete Layout

Layout Manager. . . Layout The Layout Manager
Layouts →
Layout Properties. . . The Layout Panel
Rename Layout. . .

Add Pages. . . Layout Working with the page properties

Add Items from Template Layout Creating a layout item

Save as Template. . . Layout The Layout Manager

Export as Image. . . Layout Exporter au format image

Export as SVG. . . Layout Exporter au format SVG

Export as PDF. . . Layout Exporter au format PDF
Page Setup. . . Ctrl+Shift+P

Print. . . Ctrl+P Layout Exporter des cartes
Close Ctrl+Q

Edit menu

The Edit menu offers tools to manipulate print layout items. It includes common actions like selection tools,
Copy/Cut/Paste and undo/redo (see The Undo History Panel: Revert and Restore actions) functionality for the
items in the layout.

When using the Paste action, the elements will be pasted according to the current mouse position. Using the
Edit → Paste in Place action or pressing Ctrl+Shift+V will paste the items into the current page, at the same
position they were in their initial page. It ensures to copy/paste items at the same place, from page to page.

Below is a list of all the available tools in this menu with some convenient information.
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Tool Shortcut Tool-
bar

Reference

Undo (last change) Ctrl+Z Layout The Undo History Panel: Revert and Restore ac-
tions

Redo (last reverted
change)

Ctrl+Y Layout The Undo History Panel: Revert and Restore ac-
tions

Delete Del

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V
Paste in place Ctrl+Shift+V

Select All Ctrl+A

Deselect all Ctrl+Shift+A

Invert Selection
Select Next Item Below Ctrl+Alt+[
Select Next Item above Ctrl+Alt+]

Pan Layout P Tool-
box

Zoom Z Tool-
box

Select/Move Item V Tool-
box

Interacting with layout items

Move Content C Tool-
box

L’élément Carte

Edit Nodes Item Tool-
box

Les formes basées sur des nœuds

View menu

The View menu gives access to navigation tools and helps to configure general behavior of the print layout. Beside
the common zoom tools, you have means to:

• Refresh view (if you find the view in an inconsistent state);

• enable a grid you could snap items to when moving or creating them. Grids setting is done in Settings →
Layout Options. . . or in the Layout Panel;

• enable guides you could snap items to when moving or creating them. Guides are red lines that you can
create by clicking in the ruler (above or at the left side of the layout) and drag and drop to the desired
location;

• Smart Guides: uses other layout items as guides to dynamically snap to as you move or reshape an item;

• Clear Guides to remove all current guides;

• Show Bounding box around the items to better identify your selection;

• Show Rules around the layout;

• Show Pages or set up pages to transparent. Often layout is used to create non-print layouts, e.g. for inclusion
in presentations or other documents, and it’s desirable to export the composition using a totally transparent
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background. It’s sometimes referred to as « infinite canvas » in other editing packages.

In the print layout, you can change the zoom level using the mouse wheel or the slider and combo box
in the status bar. If you need to switch to pan mode while working in the layout area, you can hold the
Spacebar or the mouse wheel. With Ctrl+Spacebar, you can temporarily switch to Zoom In mode, and
with Ctrl+Alt+Spacebar, to Zoom Out mode.

Panels and toolbars can be enabled from the View → menu. To maximise the space available to interact with a

composition you can check the View → Toggle Panel Visibility option or press Ctrl+Tab; all panels are
hidden and only previously visible panels are restored when unchecked.

It’s also possible to switch to a full screen mode to have more space to interact with by pressing F11 or using

View → Toggle Full Screen.

Tool Shortcut Toolbar Reference

Refresh F5 Navigation
Preview →

Zoom In Ctrl++ Navigation

Zoom Out Ctrl+- Navigation

Zoom to 100% Ctrl+1 Navigation

Zoom Full Ctrl+0 Navigation
Zoom to Width

Show Grid Ctrl+' Guides and Grid

Snap to Grid Ctrl+Shift+' Guides and Grid

Show Guides Ctrl+; Guides and Grid

Snap to Guides Ctrl+Shift+; Guides and Grid

Smart Guides Ctrl+Alt+;
Manage Guides. . . The Guides Panel
Clear Guides The Guides Panel

Show Rulers Ctrl+R

Show Bounding Boxes Ctrl+Shift+B

Show Pages
Toolbars → Panneaux et barres d’outils
Panels → Panneaux et barres d’outils

Toggle Full Screen F11 Affichage de la carte

Toggle Panel Visibility Ctrl+Tab Affichage de la carte

Items menu

The Items helps you configure items” position in the layout and the relations between them (see Interacting with
layout items).
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Tool Shortcut Toolbar Reference

Group Ctrl+G Actions Grouping items

Ungroup Ctrl+Shift+G Actions Grouping items

Raise Ctrl+] Actions Alignement

Lower Ctrl+[ Actions Alignement

Bring to Front Ctrl+Shift+] Actions Alignement

Send to Back Ctrl+Shift+[ Actions Alignement

Lock Selected Items Ctrl+L Actions Locking items

Unlock All Ctrl+Shift+L Actions Locking items
Align Items → Actions Alignement
Distribute Items → Actions Moving and resizing items
Resize → Actions Moving and resizing items

Add Item menu

These are tools to create layout items. Each of them is deeply described in Layout Items chapter.

Tool Toolbar Reference

Add Map Toolbox L’élément Carte

Add Picture Toolbox The Picture Item

Add Label Toolbox L’élément Étiquette

Add Legend Toolbox L’élément Légende

Add Scale Bar Toolbox L” échelle graphique

Add Shape → Toolbox The Regular Shape Item

Add Arrow Toolbox L’élément Flèche

Add Node Item → Toolbox Les formes basées sur des nœuds

Add HTML Toolbox L’élément cadre HTML

Add Attribute Table Toolbox L’élément Table Attributaire
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Atlas menu

Tool Shortcut Toolbar Reference

Preview Atlas Ctrl+ALt+/ Atlas Preview and generate an atlas

First Feature Ctrl+< Atlas Preview and generate an atlas

Previous Feature Ctrl+, Atlas Preview and generate an atlas

Next Feature Ctrl+. Atlas Preview and generate an atlas

Last feature Ctrl+> Atlas Preview and generate an atlas

Print Atlas. . . Atlas Preview and generate an atlas

Export Atlas as Images. . . Atlas Preview and generate an atlas

Export Atlas as SVG. . . Atlas Preview and generate an atlas

Export Atlas as PDF. . . Atlas Preview and generate an atlas

Atlas Settings Atlas Générer un Atlas

Menu Paramètres

The Settings → Layout Options. . . menu is a shortcut to Settings → Options → Layouts menu of QGIS main
canvas. Here, you can set some options that will be used as default on any new print layout:

• Layout defaults let you specify the default font to use;

• With Grid appearance, you can set the grid style and its color. There are three types of grid: Dots, Solid
lines and Crosses;

• Grid and guide defaults defines spacing, offset and tolerance of the grid (see Guides and Grid for more
details);

• Layout Paths: to manage list of custom paths to search print templates.

Contextual menus

Depending on where you right-click in the print layout dialog, you open a contextual menu with various features:

• Right-click on the menu bar or any toolbar and you get the list of layout panels and toolbars you can enable
or disable in one-click.

• Right-click over a ruler and you can Show Guides, Snap to Guides, Manage Guides. . . opening the
Guides panel or Clear Guides. It’s also possible to hide the rulers.

• Right-click in the print layout canvas and:

– You’ll be able to Undo and Redo recent changes, or Paste any copied item (only available if no item is
selected).

– If you click over a page, you can additionally access the current Page Properties panel or Remove
Page.

– If you click on a selected item then you can cut or copy it as well as open the Item Properties panel.

– If more than one item are selected, then you can either group them and/or ungroup if at least one group
is already in the selection.

• Right-click inside a text box or spinbox widget of any layout panel provides edit options to manipulate its
content.
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The Layout Panel

In the Layout panel, you can define the global settings of your print layout.

Figure 16.3: Layout Settings in the Print Layout

General settings

In a print layout, you can use more than one map item. The Reference map selects the map item to be used as the
layout’s master map. The layout will use this map in any properties and variable calculating units or scale. This
includes exporting the print layout to georeferenced formats.

Guides and Grid

You can put some reference marks on your paper sheet to help you accurately place some items. These marks can
be:

• simple horizontal or vertical lines (called Guides) put at the position you want (see The Guides Panel for
guides creation).

• or regular Grid: a network of horizontal and vertical lines superimposed over the layout.
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Settings like Grid spacing or Grid offset can be adjusted in this group as well as the Snap tolerance to use for
items. The tolerance is the maximum distance below which the mouse cursor is snapped to a grid or a guide, while
moving, resizing or creating an item.

Whether grid or guides should be shown is set in View menu. There, you can also decide if they might be used to
snap layout items. When both a grid line and a guide line are within tolerance of a point, guides will always take
precedence - since they have been manually set (hence, assumption that they have been explicitly placed at highly
desirable snapping locations, and should be selected over the general grid).

Note: In the Settings → Layout Options menu, you can also set the grid and guides parameters exposed above.
However, these options will only apply as defaults to new print layouts.

Paramètres d’export

You can define a resolution to use for all exported maps in Export resolution. This setting can then be overridden
each time you export a map.

Because of some advanced rendering options (blending mode, effects. . . ), a layout item may need rasterization
in order to be exported correctly. QGIS will individually rasterize it without forcing every other item to also be
rasterized. This allows printing or saving as PostScript or PDF to keep items as much as possible as vectors, e.g.
a map item with layer opacity won’t force labels, scale bars, etc to be rasterized too. You can however:

• force all the items to be rasterized checking the Print as raster box;

• or use the opposite option, i.e. Always export as vectors, to force the export to keep items as vectors when
exported to a compatible format. Note that in some cases, this could cause the output to look different to
layout.

Where the format makes it possible (e.g., .TIF, .PDF) exporting a print layout results by default in a georef-
erenced file (based on the Reference map item in the General settings group). For other formats, georeferenced

output requires you to generate a world file by checking Save world file. The world file is created beside
the exported map(s), has the name of the page output with the reference map item and contains information to
georeference it easily.

Resize layout to content

Using the Resize page tool in this group, you create a unique page composition whose extent covers the current
contents of the print layout (with some optional margins around the cropped bounds).

Note that this behavior is different from the crop to content option in that all the items are placed on a real and
unique page in replacement of all the existing pages.

Variables

The Variables lists all the variables available at the layout’s level (which includes all global and project’s variables).

It also allows the user to manage layout-level variables. Click the button to add a new custom layout-level

variable. Likewise, select a custom layout-level variable from the list and click the button to remove it.

More information on variables usage in the General Tools section.

Working with the page properties

A layout can be composed of several pages. For instance, a first page can show a map canvas, and a second page
can show the attribute table associated with a layer, while a third one shows an HTML frame linking to your
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Figure 16.4: Variables Editor in the Print Layout

organization website. Or you can add many types of items on each page.

Adding a new page

Futhermore, a layout can be made using different size and/or orientation of pages. To add a page, select the
Add Pages. . . tool from the Layout menu or Layout Toolbar. The Insert Pages dialog opens and you are asked to
fill:

• the number of pages to insert;

• the position of the page(s): before or after a given page or at the end of the print layout;

• The Page size: it could be of a preset format page (A4, B0, Legal, Letter, ANSI A, Arch A and their
derivatives as well as a resolution type, such as 1920x1080 or 1024x768) with associated Orientation
(Portrait or Landscape).

The page size can also be of a custom format; In that case, you’d need to enter its Width and Height (with
locked size ratio if needed) and select the unit to use among mm, cm, px, pt, in, ft. . . Conversion of
entered values is automatically applied when switching from one unit to another.

Figure 16.5: Creating a new page in the Print Layout
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Updating page properties

Any page can be later customized through the Page Item Properties panel. Right-click on a page and select Page
Properties. . . . The Item Properties panel opens with settings such as:

• the Page size frame described above. You can modify each property using the data defined override options
(see Explore Data-defined override buttons with atlas for a use case);

• the Exclude page from exports to control whether the current page with its content should be included
in the layout output;

• the Background using the color or symbol you want.

Figure 16.6: Page properties dialog

The Guides Panel

Guides are vertical or horizontal line references you can place on a layout page to assist you on items placement,
when creating, moving or resizing them. To be active, guides require the View → Show Guides and View → Snap
to Guides options to be checked. To create a guide, two ways:

• assuming View → Show Rulers option is set, drag out a ruler and release the mouse button within the page
area, at the desired position.

• more accurate and always available, use the Guides panel.

The Guides panel allows creation of snap lines at specific locations: click the Add new guide button and enter
coordinates of the horizontal or vertical line. Different units are available for setting. The panel also allows
adjusting position of existing guides to exact coordinates: double-click a guide coordinate and replace the value.

To delete a guide, select it and press Remove selected guide button. Use Clear All Guides to remove all the guides
in the panel.

Guides are single page only meaning that the Guides panel lists guides of the current page (whose number is
shown at the top of the dialog). Likewise, it allows creation or removal of guides only in the current page. The
Apply to All Pages button allows you to setup the guide configuration on a single page and easily transfer it to all
other pages in the layout.

Astuce: Snapping to existing layout items

Other than guides and grids, you can use existing items as snapping references when moving, resizing or creating
new items; these are called smart guides and require View → Smart Guides option to be checked. Anytime the
mouse pointer is close to an item’s bound, a snapping cross appears.
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Figure 16.7: The Guides panel

The Items Panel

The Items panel offers some options to manage selection and visibility of items. All the items added to the print
layout canvas (including items group) are shown in a list and selecting an item makes the corresponding row
selected in the list as well as selecting a row does select the corresponding item in the print layout canvas. This is
thus a handy way to select an item placed behind another one. Note that a selected row is shown as bold.

Pour tout élément sélectionné, vous pouvez:

• set it visible or not;

• lock or unlock its position;

• sort its Z position. You can move up and down each item in the list with a click and drag. The upper item
in the list will be brought to the foreground in the print layout canvas. By default, a newly created item is
placed in the foreground.

• change the item ID by double-clicking the text;

• right-click an item and copy or delete it or open its properties panel.

Une fois que vous avez trouvé la position correcte d’un élément, vous pouvez le verrouiller en cochant la case

dans la colonne . Les éléments verrouillés ne sont pas sélectionnables sur le canevas. Les éléments verrouillés
peuvent être déverrouillés en sélectionnant l’élément dans le panneau Eléments et en décochant la case à cocher
ou bien vous pouvez utiliser les icônes sur la barre d’outils.

The Undo History Panel: Revert and Restore actions

During the layout process, it is possible to revert and restore changes. This can be done with the revert and restore
tools available in the Edit menu, the Layout toolbar or the contextual menu any time you right-click in the print
layout area:
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• Annuler la dernière modification

• Restaurer la dernière modification

This can also be done by mouse click within the Undo history panel (see figure_layout). The History panel lists
the last actions done within the print layout. Just select the point you want to revert to and once you do new action
all the actions done after the selected one will be removed.

Figure 16.8: Undo History in the Print Layout

16.2 Layout Items

16.2.1 Layout Items Common Options

QGIS provides a large set of items to layout a map. They can be of map, legend, scale bar, picture, table, north
arrow, image type. . . They however share some common options and behavior that are exposed below.

Creating a layout item

Items can be created using different tools, either from scratch or based on existing items.

To create a layout item from scratch:

1. Select the corresponding tool either from the Add Item menu or the Toolbox bar.

2. Then:

• Click on the page and fill the size and placement information requested in the New Item Properties
dialog that pops up (for details, see Position and Size);

Figure 16.9: New Item properties dialog

• Or click-and-drag to define the initial size and placement of the item. You can rely on grids and guides
snapping for a better position.
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Note: Because they can have particular shapes, drawing node or arrow items does not work with one-click nor
click-and-drag methods; you need to click and place each node of the item. See Les formes basées sur des nœuds
for more details.

You can also:

1. Select an existing item with the Select/Move item button from the Toolbox toolbar

2. Use the contextual menu or the Edit menu tools to copy/cut the item and paste it at the mouse position as a
new item.

You can also use the Paste in Place (Ctrl+Shift+V) command to duplicate an item from one page to
another and place it in the new page at the same coordinates as the original.

Moreover, you can create items using a print layout template (for details, see The Layout Manager) through the
Layout → Add Items from Template. . . command.

Astuce: Add layout items using the file browser

From your file browser or using the Browser panel, drag-and-drop a print layout template (.qpt file) onto a print
layout dialog and QGIS automatically adds all items from that template to the layout.

Interacting with layout items

Each item inside the print layout can be moved and resized to create a perfect layout. For both operations the first

step is to activate the Select/Move item tool and click on the item.

You can select multiple items with the Select/Move item button: click and drag over the items or hold the Shift
button and click on each of the items you want. To deselect an item, click on it holding the Shift button.

Each time there’s a selection, count of selected items is displayed on the status bar. Inside the Edit menu, you can
find actions to select all the items, clear all selections, invert the current selection and more. . .

Moving and resizing items

Unless View → Show Bounding Boxes option is unchecked, a selected item will show squares on its boundaries ;
moving one of them with the mouse will resize the item in the corresponding direction. While resizing, holding
Shift will maintain the aspect ratio. Holding Alt will resize from the item center.

To move a layout item, select it with the mouse and move while holding the left button. If you need to constrain
the movements to the horizontal or vertical axis, just hold the Shift button on the keyboard while moving the
mouse. You can also move a selected item using the Arrow keys on the keyboard; if the movement is too
slow, you can speed it up by holding Shift. If you need better precision, use the Position and size properties, or
grid/guides snapping as explained above for item’s creation.

Resizing or moving several items at once is made the same way as for a single item. QGIS however provides some
advanced tools to automatically resize a selection of items following different rules:

• each item height matches the tallest or the shortest selected item;

• each item width matches the widest or the narrowest selected item;

• resizes items to squares: each item is enlarged to form a square.

Likewise, automated tools are available to organize multiple items position by distributing equidistantly:

• edges (left, right, top or bottom) of items;
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• centers of items either horizontally or vertically.

Grouping items

Grouping items allows you to manipulate a set of items like a single one: you can easily resize, move, delete, copy
the items as a whole.

To create a group of items, select more than one and press the Group button on the View menu or the Actions
toolbar or from the right-click menu. A row named Group is added to the Items panel and can be locked or hidden
like any other Items panel’s object. Grouped items are not individually selectable on the canvas; use the Items
panel for direct selection and access the item’s properties panel.

Locking items

Once you have found the correct position for an item, you can lock it by using the Lock selected items button
in the View menu or the Actions toolbar or ticking the box next to the item in the Items panel. Locked items are
not selectable on the canvas.

Les éléments verrouillés peuvent être déverrouillés en sélectionnant l’élément dans l’onglet Éléments et décochés
dans la case à cocher, ou vous pouvez utiliser les boutons dans la barre d’outils.

Alignement

Raising or lowering the visual hierarchy for elements are inside the Raise selected items pull-down menu. Choose
an element on the print layout canvas and select the matching functionality to raise or lower the selected element
compared to the other elements. This order is shown in the Items panel. You can also raise or lower objects in the
Items panel by clicking and dragging an object’s label in this list.

Figure 16.10: Alignment helper lines in the print layout
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There are several alignment options available within the Align selected items pull-down menu (see fig-
ure_layout_common_align). To use an alignment function, you first select the elements and then click on one
of the alignment icons:

• Align Left or Align Right;

• Align Top or Align Bottom;

• Align Center horizontally or Align Center Vertical.

All selected elements will then be aligned to their common bounding box. When moving items on the layout
canvas, alignment helper lines appear when borders, centers or corners are aligned.

Items Common Properties

Layout items have a set of common properties you will find at the bottom of the Item Properties panel: Position
and size, Rotation, Frame, Background, Item ID, Variables and Rendering (See figure_layout_common).

Figure 16.11: Common Item Properties groups

Note: The Data defined override icon next to most of the options means that you can associate that property with
a layer, features attributes, geometry or with any other layout item’s property, using expressions or variables. For
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more information see Valeurs définies par des données.

• The Position and size group lets you define the size and position of the frame which contains the item (see
Position and Size for more information).

• Rotation permet de définir un angle de rotation (en degrés) pour l’élément.

• The Frame shows or hides the frame around the item. Click on the Color and Thickness and Join style
widgets to adjust those properties.

• Use the Background color menu for setting a background color. Click on the [Color. . . ] button to display a
dialog where you can pick a color or choose from a custom setting. Transparency can be adjusted through
altering the alpha field settings.

• Use the Item ID to create a relationship to other print layout items. This is used with QGIS server and other
potential web clients. You can set an ID on an item (for example, a map or a label), and then the web client
can send data to set a property (e.g., label text) for that specific item. The GetProjectSettings command will
list the items and IDs which are available in a layout.

• Rendering mode helps you set whether and how the item can be displayed: you can, for instance, apply
blending mode, adjust the opacity of the item or Exclude item from exports.

Position and Size

Extending the features of the New Item Properties dialog with data-defined capabilities, this group allows you to
place the items accurately.

Figure 16.12: New Item properties dialog

• the actual number of the page to place the item on;

• the reference point of the item;

• the X and Y coordinates of the Reference point of the item on the chosen page. The ratio between these

values can be locked by clicking on the button. Changes made to a value using the widget or the
Select/Move item tool will be reflected in both of them;

• the Width and Height of the item bounding box. As for coordinates, the ratio between width and height can
be locked.

Mode de rendu

QGIS allows advanced rendering for layout items just like vector and raster layers.
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Figure 16.13: Mode de rendu

• Mode de fusion : avec cet outil vous pouvez donner des effets qui, autrement, ne sont réalisables qu’avec
des logiciels de dessin. Les pixels des éléments situés au-dessous et au-dessus sont fusionnés selon le mode
choisi (voir Modes de fusion pour une description de chaque mode).

• Transparency : You can make the underlying item in the layout visible with this tool.
Use the slider to adapt the visibility of your item to your needs. You can also make a precise definition of
the percentage of visibility in the menu beside the slider.

• Exclure cet élément des exports : Vous pouvez décider de rendre un élément invisible dans tous les
exports. Après avoir activé cette option, l’élément ne sera pas inclus dans les exports PDF, impressions, etc.

Variables

The Variables lists all the variables available at the layout item’s level (which includes all global, project and
composition’s variables). Map items also include Map settings variables that provide easy access to values like
the map’s scale, extent, and so on.

Sous la section guilabel:Variables, il est aussi possible de gérer les variables liées à l’élément. Cliquez sur le bou-

ton afin d’ajouter une variable personnalisée. De même, sélectionnez n’importe quelle variable personnalisée

associée à l’élément en cours et cliquez sur le bouton pour le supprimer.

More information on variables usage in the Storing values in Variables section.

16.2.2 L’élément Carte

The map item is the main frame that displays the map you’ve designed in the map canvas. Use the Add Map
tool following items creation instructions to add a new map item that you can later manipulate the same way as
exposed in Interacting with layout items.

By default, a new map item shows the current status of the map canvas with its extent and visible layers. You
can customize it thanks to the Item Properties panel. Other than the items common properties, this feature has the
following functionalities:

Propriétés principales

In the Main properties group (see figure_layout_map) of the map Item Properties panel, available options are:

• The Update Preview button to refresh the map item rendering if the view in map canvas has been modified.
Note that most of the time, the map item refresh is automatically triggered by the changes;

• The Scale to manually set the map item scale;

• The Map rotation allows you to rotate the map item content clockwise in degrees. The rotation of the map
canvas can be imitated here;

• The CRS allows you to display the map item content in any CRS. It defaults to Use project CRS;
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Figure 16.14: Onglet Propriétés d’une carte

• Draw map canvas items lets you show in the print layout annotations that are placed on the main map
canvas.

Couches

By default, map item appearance is synced with the map canvas rendering meaning that toggling visibility of the
layers or modifying their style in the Layers Panel is automatically applied to the map item. Because, like any
other item, you may want to add multiple map items to a print layout, there’s a need to break this synchronization
in order to allow showing different areas, layer combinations, at different scales. . . The Layers properties group
(see figure_layout_map_layers) helps you do that.

Figure 16.15: Map Layers group

If you want to keep the map item consistent with an existing map theme, check Follow map theme and select
the desired theme in the drop-down list. Any changes applied to the theme in QGIS” main window (using the
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replace theme function) will automatically affect the map item. If a map theme is selected, the Lock styles for
layers option is disabled because Follow map theme also updates the style (symbology, labels, diagrams) of the
layers.

To lock the layers shown in a map item to the current map canvas visibility, check Lock layers. When this
option is enabled, any changes on the layers” visibility in QGIS” main window will not affect the layout’s map
item. Nevertheless, style and labels of locked layers are still refreshed according to QGIS” main window. You can
prevent this by using Lock styles for layers.

Instead of using the current map canvas, you can also lock the layers of the map item to those of an existing

map theme: select a map theme from the Set layer list from a map theme drop-down button, and the Lock layers is
activated. The set of visible layers in the map theme is from now on used for the map item until you select another

map theme or uncheck the Lock layers option. You then may need to refresh the view using the Refresh view

button of the Navigation toolbar or the Update Preview button seen above.

Note that, unlike the Follow map theme option, if the Lock layers option is enabled and set to a map theme, the
layers in the map item will not be refreshed even if the map theme is updated (using the replace theme function)
in QGIS” main window.

Locked layers in the map item can also be data-defined, using the icon beside the option. When used, this
overrides the selection set in the drop-down list. You need to pass a list of layers separated by | character. The
following example locks the map item to use only layers layer 1 and layer 2:

concat ('layer 1', '|', 'layer 2')

Emprise

The Extents group of the map item properties panel provides the following functionalities (see fig-
ure_layout_map_extents):

Figure 16.16: Map Extents group

The Extents area displays X and Y coordinates of the area shown in the map item. Each of these values can
be manually replaced, modifying the map canvas area displayed and/or map item size. Clicking the Set to Map
Canvas Extent button sets the extent of the layout map item to the extent of the main map canvas. The button View
Extent in Map Canvas does exactly the opposite; it updates the extent of the main map canvas to the extent of the
layout map item.

You can also alter a map item extent using the Move item content tool: click-and-drag within the map item to

modify its current view, keeping the same scale. With the tool enabled, use the mouse wheel to zoom in or
out, modifying the scale of the shown map. Combine the movement with Ctrl key pressed to have a smaller
zoom.
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Controlled by atlas

The Controlled by atlas group properties is available only if an atlas is active in the print layout. Check this
option if you want the map item being ruled by the atlas; when iterating over the coverage layer, the map item
extent is panned/zoomed to the atlas feature following:

• Margin around features: zooms to the feature at the best scale, keeping around each a margin repre-
senting a percentage of the map item width or height. The margin can be the same for all features or set
variable, e.g., depending on map scale;

• Predefined scale (best fit): zooms to the feature at the project predefined scale where the atlas feature
best fits;

• Fixed scale: atlas features are panned from one to another, keeping the same scale of the map item.
Ideal when working with features of same size (e.g., a grid) or willing to highlight size differences among
atlas features.

Graticules

With grids, you can add, over your map, information relative to its extent or coordinates, either in the map item
projection or a different one. The Grids group provides the possibility to add several grids to a map item.

• With the and buttons you can add or remove a selected grid;

• With the and buttons you can move up and down a grid in the list, hence move it on top or bottom
of another one, over the map item.

Double-click the added grid to rename it.

Figure 16.17: Fenêtre des Graticules de Carte

After you add a grid, you can activate the checkbox Draw grid to allow overlaying the grid onto the map item.
Press the Modify Grid. . . button to access configuration options.

Grid Appearance

As grid type, you can specify to use a:

• Solid: shows a line across the grid frame. The Line style can be customized using color and symbol selector
widget;

• Cross: displays segment at the grid lines intersection for which you can set the Line style and the Cross
width;

• Markers: only displays customizable markers symbol at grid lines intersection;

• or Frame and annotations only.

Other than the grid type, you can define:

16.2. Layout Items 361



QGIS User Guide, Version 3.4

• the CRS which could not be the same as the map item’s;

• the Interval between two consecutive grid references in X and Y directions;

• the Interval Units to use for the grid references, in Map units, Millimeters or Centimeters;

• an Offset from the map item edges, in X and Y directions;

• and the Blend mode of the grid (see Modes de fusion) when compatible.

Figure 16.18: Paramètres d’affichage des graticules

Grid Frame

There are different options to style the frame that holds the map. Following options are available: No
Frame, Zebra, Interior ticks, Exterior ticks, Interior and Exterior ticks and Line
border. Also you can choose to set visible or not each side of the grid frame.

When compatible, it’s possible to set the Frame size, Frame line thickness, Frame fill colors. With Latitude/Y
only and Longitude/X only settings in the divisions section you have the possibility to prevent a mix of
latitude/Y and longitude/X coordinates showing on a side when working with rotated maps or reprojected grids.

Figure 16.19: Fenêtre du Cadre du Graticule
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Coordinates

The Draw coordinates checkbox allows you to add coordinates to the map frame. You can choose the an-
notation numeric format, the options range from decimal to degrees, minute and seconds, with or without suffix,
aligned or not and a custom format using the expression dialog.

You can choose which annotation to show. The options are: show all, latitude only, longitude only, or dis-
able(none). This is useful when the map is rotated. The annotation can be drawn inside or outside the map frame.
The annotation direction can be defined as horizontal, vertical ascending or vertical descending.

Finally, you can define the annotation font, font color, distance from the map frame and the precision of the drawn
coordinates.

Figure 16.20: Fenêtre des Coordonnées d’affichage du graticule

Aperçus

Sometimes you may have more than one map in the print layout and would like to locate the study area of one map
item on another one. This could be for example to help map readers identify the area in relation with its larger
geographic context shown in the second map.

The Overviews group of the map panel helps you create the link between two different maps extent and provides
the following functionalities:

To create an overview, select the map item on which you want to show the other map item’s extent and expand the

Overviews option in the Item Properties panel. Then press the button to add an overview.

Initially this overview is named “Overview 1” (see Figure_layout_map_overview). You can:

• Rename it with a double-click;
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Figure 16.21: Map Overviews group

• With the and buttons, add or remove overviews;

• With the and buttons, move up and down an overview in the list, hence move it on top or bottom of
another one, over the map item.

Then select the overview item in the list and check the Draw « <name_overview> » overview to enable the
overview drawing over the selected map frame. You can customize it with:

• La liste combo Cadre de carte peut être utilisée pour sélectionner l’élément carte dont les extensions seront
affichées sur l’élément carte présent.

• Le Style du cadre vous permet de changer le style du cadre de l’aperçu.

• Le Mode de fusion vous permet de définir différents modes de fusion pour créer une transparence.

• L’option Inverser l’aperçu crée un masque sur l’emprise de l’autre zone de carte qui apparaît clairement
tandis que le reste de la carte est mis en transparence en utilisant le mode de fusion choisi.

• L’option Centrer sur l’aperçu paramètre l’emprise du cadre d’aperçu au centre de la carte d’aperçu.
Vous pouvez activer uniquement un seul élément d’aperçu au centre lorsque vous avez plusieurs aperçus.

16.2.3 L’élément Étiquette

The Label item is a tool that helps decorate your map with texts that would help to understand it; it can be the title,

author, data sources or any other information. . . You can add a label with the Add Label tool following items
creation instructions and manipulate it the same way as exposed in Interacting with layout items.

By default, the label item provides a default text that you can customize using its Item Properties panel. Other
than the items common properties, this feature has the following functionalities (see figure_layout_label):

Propriétés principales

The Main properties group is the place to provide the text (it can be in HTML) or the expression to build the label.
Expressions need to be surrounded by [% and %] in order to be interpreted as such.

• Le texte saisi peut être interprété comme du code HTML si vous cochez la case Afficher en HTML.
Vous pouvez ainsi insérer une URL, une image cliquable qui renvoie à une page web ou tout autre code plus
complexe.
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Figure 16.22: Panneau Propriétés d’une étiquette

• You can also use expressions: click on Insert an expression button, write your formula as usual and when
the dialog is applied, QGIS automatically adds the surrounding characters.

Note: Clicking the Insert an Expression button when no selection is made in the textbox will append the new
expression to the existing text. If you want to update an existing text, you need to select it the part of interest
beforehand.

You can combine HTML rendering and expressions, leading to e.g. a text like:

[% '<b>Check out the new logo for ' || '<a href="https://www.qgis.org" title="Nice
→˓logo" target="_blank">QGIS ' ||@qgis_short_version || '</a>' || ' : <img src=
→˓"https://qgis.org/en/_downloads/qgis-icon128.png" alt="QGIS icon"/>' %]

which will render: Check out the new logo for QGIS 3.0 :

Apparence

• Define Font by clicking on the Font. . . button or a Font color by pushing the color widget.

• You can specify different horizontal and vertical margins in mm. This is the margin from the edge of the
layout item. The label can be positioned outside the bounds of the label e.g. to align label items with other
items. In this case you have to use negative values for the margin.

• Using the text alignment is another way to position your label. It can be:

– Left, Center, Right or Justify for Horizontal alignment

– and Top, Middle, Bottom for Vertical alignment.

Exploring expressions in a label item

Below some examples of expressions you can use to populate the label item with interesting information - re-
member that the code, or at least the calculated part, should be surrounded by [% and %] in the Main properties
frame:
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• Display a title with the current atlas feature value in « field1 »:

'This is the map for ' || "field1"

or, written in the Main properties section:

This is the map for [% "field1" %]

• Add a pagination for processed atlas features (eg, Page 1/10):

concat( 'Page ', @atlas_featurenumber, '/', @atlas_totalfeatures )

• Return the X coordinate of the bottom left corner of a map canvas:

x_min( map_get( item_variables( 'Map 1' ), 'map_extent' ) )

• Retrieve the name of the layers in the current layout “Map 1” item, and formats in one name by line:

array_to_string(
array_foreach(

map_get( item_variables( 'Map 1' ), 'map_layers' ), -- retrieve the layers
→˓list

layer_property( @element, 'name' ) -- retrieve each layer name
),
'\n' -- converts the list to string separated by breaklines

)

16.2.4 L’élément Légende

The Legend item is a box or a table that explains the meanings of the symbols used on the map. A legend is

then bound to a map item. You can add a legend item with the Add Legend tool following items creation
instructions and manipulate it the same way as exposed in Interacting with layout items.

By default, the legend item displays all available layers and can be refined using its Item Properties panel. Other
than the items common properties, this feature has the following functionalities (see figure_layout_legend):

Figure 16.23: Legend Item Properties Panel

366 Chapter 16. Laying out the maps



QGIS User Guide, Version 3.4

Propriétés principales

The Main properties group of the legend Item Properties panel provides the following functionalities (see fig-
ure_layout_legend_ppt):

Figure 16.24: Legend Main properties group

Dans les Propriétés Principales vous pouvez :

• change the title of the legend. It can be made dynamic using the data-defined override setting, useful for
example when generating atlas;

• set the Title alignment to Left, Center or Right;

• choose which Map item the current legend will refer to;

• wrap the text of the legend on a given character: each time the character appears, it’s replaced by a line
break;

• use Resize to fit contents to control whether or not a legend should be automatically resized to fit its
contents. If unchecked, then the legend will never resize and instead just stick to whatever size the user has
set. Any content which doesn’t fit the size is cropped out.

Objets de légende

The Legend items group of the legend Item Properties panel provides the following functionalities (see fig-
ure_layout_legend_items):

Figure 16.25: Legend Items group

• La légende sera automatiquement mise à jour si Mise à jour auto est cochée. Lorsque Mise à jour auto
n’est pas cochée, cela vous donnera plus de contrôle sur les éléments de la légende. Les icônes en-dessous
de la liste des éléments de légende seront activés.
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• La fenêtre des éléments de légende répertorie tous les éléments de la légende et vous permet de changer
l’ordre des éléments, de grouper les couches, de supprimer ou de restaurer des éléments de la liste, de
modifier les noms des couche et d’ajouter un filtre.

– The item order can be changed using the and buttons or with “drag-and-drop” functionality.
The order can not be changed for WMS legend graphics.

– Use the button to add a legend group.

– Use the button to add layers and button to remove groups, layers or symbol classes.

– The button is used to edit the layer, group name or title. First you need to select the legend item.
Double-clicking the item also opens the text box to rename it.

– The button adds a feature count for each class of vector layer.

– With the Filter legend by map content button, only the legend items visible in the map will be listed in the

legend. This tool remains available when Auto-update is active.

– The Filter legend by expression helps you filter which of the legend items of a layer will be displayed, i.e.
using a layer that has different legend items (e.g., from a rule-based or categorized symbology), you
can specify a boolean expression to remove from the legend tree, styles that have no feature satisfying
a condition. Note that the features are nevertheless kept and shown in the layout map item.

While the default behavior of the legend item is to mimic the Layers panel tree, displaying the same groups,
layers and classes of symbology, right-click any item offers you options to hide layer’s name or raise it as a
group or subgroup. In case you have made some changes to a layer, you can revert them by choosing Reset
to defaults from the contextual menu.

After changing the symbology in the QGIS main window, you can click on Update All to adapt the changes
in the legend element of the print layout.

• While generating an atlas with polygon features, you can filter out legend items that lie outside the current

atlas feature. To do that, check the Only show items inside current atlas feature option.

Polices, Colonnes, Symbole et Espacement

The Fonts, Columns and Symbol groups of the legend Item Properties panel provide the following functionalities
(see figure_layout_legend_fonts):

• You can change the font of the legend title, group, subgroup and item (feature) in the legend item using the
font selector widget;

• You provide the labels with a Color using the color selector widget. The selected color will apply to all
font items in the legend;

• Legend items can be arranged over several columns. Set the number of columns in the Count field.
This value can be made dynamic e.g., following atlas features, legend contents, the frame size. . .

– La case Égaliser la largeur des colonnes permet d’ajuster la taille des colonnes de la légende.

– L’option Séparer les couches permet de présenter sur plusieurs colonnes les éléments de légende
d’une couche ayant un style catégorisé ou gradué.

• You can also change the width and height of the legend symbol, set a color and a thickness in case of raster
layer symbol.
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Figure 16.26: Legend Fonts, Columns and Symbol groups

Légende Graphique WMS et Espacement

The WMS LegendGraphic and Spacing groups of the legend Item Properties panel provide the following function-
alities (see figure_layout_legend_wms):

When you have added a WMS layer and you insert a legend item, a request will be sent to the WMS server to
provide a WMS legend. This Legend will only be shown if the WMS server provides the GetLegendGraphic
capability. The WMS legend content will be provided as a raster image.

La Légende WMS est utilisée pour ajuster la Largeur de la légende et la Hauteur de la légende pour la légende
WMS des images raster.

Spacing around title, group, subgroup, symbol, icon label, box, column or line can be customized through this
dialog.

16.2.5 L” échelle graphique

Scale bars provide a visual indication of the size of features, and distance between features, on the map item. A

scale bar item requires a map item. Use the Add Scale Bar tool following items creation instructions to add a
new scale bar item that you can later manipulate the same way as exposed in Interacting with layout items.

By default, a new scale bar item shows the scale of the most recently added map item. You can customize it thanks
to the Item Properties panel. Other than the items common properties, this feature has the following functionalities
(see figure_layout_scalebar):

Propriétés principales

The Main properties group of the scale bar Item Properties panel provides the following functionalities (see
figure_layout_scalebar_ppt):

• Choisissez tout d’abord à quelle carte la barre d’échelle sera associée.
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Figure 16.27: WMS LegendGraphic and Spacing groups

Figure 16.28: Panneau Propriétés d’une barre d’échelle

Figure 16.29: Scale Bar Main properties group
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• Ensuite, choisissez le style de la barre d’échelle. Six sont disponibles :

– Single box and Double box styles, which contain one or two lines of boxes alternating colors;

– Middle, Up or Down line ticks;

– Numérique : le ratio d’échelle est affiché (par exemple, 1:50000).

Unités et Segments

The Units and Segments groups of the scale bar Item Properties panel provide the following functionalities (see
figure_layout_scalebar_units):

Figure 16.30: Scale Bar Units and Segments groups

In these two groups, you can set how the scale bar will be represented.

• Select the units you want to use with Scalebar units. There are many possible choices: Map Units (the
default one), Meters, Feet, Miles or Nautical Miles. . . which may force unit conversions.

• The Label unit multiplier specifies how many scale bar units per labeled unit. Eg, if your scale bar units are
set to « meters », a multiplier of 1000 will result in the scale bar labels in « kilometers ».

• The Label for units field defines the text used to describe the units of the scale bar, eg m or km. This should
be matched to reflect the multiplier above.

• Vous pouvez définir combien de Segments seront dessinés à gauche et / ou à droite de la barre d’échelle.

• You can set how long each segment will be (Fixed width), or limit the scale bar size in mm with Fit segment
width option. In the latter case, each time the map scale changes, the scale bar is resized (and its label
updated) to fit the range set.

• Le champ Hauteur permet de définir la hauteur des barres.

Affichage

The Display group of the scale bar Item Properties panel provides the following functionalities (see fig-
ure_layout_scalebar_display):

Vous pouvez définir comment l’échelle graphique sera affichée dans son cadre.

• Marge de la boîte : espace entre le texte et les bords du cadre

• Labels margin : space between text and scale bar drawing

• Largeur de ligne : largeur de ligne de l’échelle graphique dessinée
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Figure 16.31: Scale Bar Display group

• Join style : Corners at the end of scale bar in Bevel, Miter or Round style (only available for Scale bar style
Single Box & Double Box)

• guilabel:Style d’extrémités : Fin de toutes les lignes dans le style Carré, Rond ou Plat (seulement disponible
pour les styles Repères en-dessus, en-dessous et au milieu de la ligne)

• Alignement : Met le texte sur la gauche, au milieu ou à droite du cadre (fonctionne uniquement pour le style
Numérique)

Polices et couleurs

The Fonts and colors group of the scale bar Item Properties panel provides the following functionalities (see
figure_layout_scalebar_fonts):

Figure 16.32: Scale Bar Fonts and colors groups

You can define the fonts and colors used for the scale bar.

• Use the Font button to set the font of scale bar label

• Couleur de police: configure la couleur de police

• Couleur de remplissage: configure la première couleur de remplissage

• Couleur de remplissage secondaire : configure la seconde couleur de remplissage

• Line color: set the color of the lines of the Scale Bar

Fill colors are only used for Single Box and Double Box styles.

16.2.6 L’élément Table Attributaire

Any layer in the project can have its attributes shown in the print layout. You can use this to decorate and explain

your map with information about underlying data. Use the Add Attribute Table tool following items creation
instructions to add a new map item that you can later manipulate the same way as exposed in Interacting with
layout items.
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By default, a new attribute table item loads first rows of the first (alphabetically sorted) layer, with all the fields.
You can however customize the table thanks to its Item Properties panel. Other than the items common properties,
this feature has the following functionalities (see figure_layout_table):

Figure 16.33: Attribute table Item Properties Panel

Propriétés principales

The Main properties group of the attribute table provides the following functionalities (see fig-
ure_layout_table_ppt):

Figure 16.34: Attribute table Main properties Group

• For Source you can by default only select Layer features allowing you to select a Layer from the vector
layers loaded in the project.

The data-defined override button near the layer list allows you to dynamically change the layer which is used
to populate the table, e.g. you could fill the attribute table with different layer attributes per atlas page. Note
that the table structure used (column settings) is the one of the layer shown in the Layer drop-down list and
it is left intact, meaning that setting a data defined table to a layer with different field(s) will result in empty
column(s) in the table.

In case you activate the Generate an atlas option in the Atlas panel (see Générer un Atlas), there are two
additional Source possible:

– Current atlas feature (see figure_layout_table_atlas): you won’t see any option to choose the layer,
and the table item will only show a row with the attributes from the current feature of the atlas coverage
layer.

– and Relation children (see figure_layout_table_relation): an option with the relation names will show
up. This feature can only be used if you have defined a relation using your atlas coverage layer as
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parent, and the table will show the children rows of the atlas coverage layer’s current feature.

• The button Refresh Table Data can be used to refresh the table when the actual contents of the table has
changed.

Figure 16.35: Attribute table Main properties for “Current atlas feature”

Figure 16.36: Attribute table Main properties for “Relation children”

• The button Attributes. . . starts the Select Attributes dialog, (see figure_layout_table_select) that can be used
to change the visible contents of the table. The upper part of the window shows the list of the attributes to
display and the lower part helps you sort the data.

Dans la section Colonnes, vous pouvez :

– Move attributes up or down the list by selecting the rows and then using the and buttons to
shift the rows. Multiple rows can be selected and moved at any one time.

– Add an attribute with the button. This will add an empty row at the bottom of the table where you
can select a field to be the attribute value or create an attribute via a regular expression.

– Remove an attribute with the button. Multiple rows can be selected and removed at any one time.

– Reset the attribute table back to its default state with the Reset button.

– Clear the table using the Clear button. This is useful when you have a large table but only want to
show a small number of attributes. Instead of manually removing each row, it may be quicker to clear
the table and add the rows needed.

– Cell headings can be altered by adding the custom text in the Heading column.

– Cell alignment can be managed with the Alignment column which will dictate the texts position within
the table cell.

– Cell width can be manually managed by adding custom values to the width column.

Dans la section Trier, vous pouvez :

– Add an attribute to sort the table with. Select an attribute and set the sorting order to Ascending or

Descending and press the button. A new line is added to the sort order list.

– select a row in the list and use the and buttons to change the sort priority on attribute level.
Selecting a cell in the Sort Order column helps you change the sorting order of the attribute field.

– use the button to remove an attribute from the sort order list.
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Figure 16.37: Attribute table Select attributes Dialog

Filtrage des entités

The Feature filtering group of the attribute table provides the following functionalities (see fig-
ure_layout_table_filter):

Figure 16.38: Attribute table Feature filtering Group

Vous pouvez :

• Définir un nombre de Lignes maximales à afficher.

• Activer Supprimer les lignes en double de la table pour ne montrer que les enregistrements uniques.

• Activate Show only visible features within a map and select the corresponding Linked map whose visible
features attributes will be displayed.

• Activate Show only features intersecting Atlas feature is only available when Generate an atlas is
activated. When activated it will show a table with only the features which intersect the current atlas feature.

• Activer Filtrer avec et fournir un filtre en tapant dans la ligne d’entrée ou insérer une expression régulière

en utilisant le bouton d’expression . Voici quelques exemples de déclarations de filtrage que vous pouvez
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utiliser lorsque vous avez chargé la couche des aéroports à partir du jeu de données exemples :

– ELEV > 500

– NAME = 'ANIAK'

– NAME NOT LIKE 'AN%'

– regexp_match( attribute( $currentfeature, 'USE' ) , '[i]')

La dernière expression régulière inclura seulement les aéroports qui ont une lettre “i” dans le champ
d’attribut “USE”.

Apparence

The Appearance group of the attribute table provides the following functionalities (see fig-
ure_layout_table_appearance):

Figure 16.39: Attribute table appearance Group

• Cocher Afficher des lignes vides remplira la table attributaire avec des cellules vides; cette option peut
aussi être utilisée pour proposer des cellules vides supplémentaires lorsque vous avez un résultat à montrer
!

• Avec les Marges de cellule, vous pouvez définir les marges autour du texte dans chaque cellule de la table.

• Avec Afficher l’en-tête, vous pouvez sélectionner à partir d’une liste une des options par défaut “Sur le
premier cadre”, “Sur tous les cadres”, ou “Pas d’en-tête”.

• L’option Tables vides contrôle ce qui sera affiché lorsque la sélection des résultats est vide.

– N’afficher que les en-têtes affichera seulement l’en-tête, excepté si vous avez choisi “Pas d’en-tête”
pour Afficher l’en-tête.

– Masquer la table entière affichera seulement le fond de la table. Vous pouvez activer Ne pas
afficher le fond si le cadre est vide dans Cadres pour cacher complètement la table.

– Afficher le message défini affichera l’en-tête et ajoutera une cellule couvrant toutes les colonnes et
affichera un message comme “Pas de résultat” qui peut être proposé dans l’option Message à afficher

• L’option Message à afficher est seulement activée lorsque vous avez sélectionné Afficher le message défini
pour Table vide. Le message proposé sera affiché dans la table sur la première ligne, lorsque le résultat est
une table vide.

• With Background color you can set the background color of the table using the color selector widget.
The Advanced customization option helps you define different background colors for each cell (see fig-
ure_layout_table_background)
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Figure 16.40: Attribute table Advanced Background Dialog

• Avec l’option Activer le retour à la ligne après , vous pouvez indiquer un caractère qui servira de retour à
la ligne pour le contenu de chaque cellule.

• With Oversized text you define the behavior when the width set for a column is smaller than its content’s
length. It can be Wrap text or Truncate text.

Afficher les bordures

The Show grid group of the attribute table provides the following functionalities (see figure_layout_table_grid):

Figure 16.41: Attribute table Show grid Group

• Activate Show grid when you want to display the grid, the outlines of the table cells. You can also select
to either Draw horizontal lines or Draw vertical lines or both.

• Avec Épaisseur du trait vous pouvez définir l’épaisseur des lignes utilisées pour les bordures.

• The Color of the grid can be set using the color selection widget.

Styles de polices et textes

The Fonts and text styling group of the attribute table provides the following functionalities (see fig-
ure_layout_table_fonts):

• You can define Font and Color for Table heading and Table contents, using font and color selector widgets.
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Figure 16.42: Attribute table Fonts and text styling Group

• For Table heading you can additionally set the Alignment to Follow column alignment or override
this setting by choosing Left, Center or Right. The column alignment is set using the Select Attributes
dialog (see figure_layout_table_select ).

Cadres

The Frames group of the attribute table properties provides the following functionalities (see fig-
ure_layout_table_frames):

Figure 16.43: Attribute table Frames Group

• Avec le Mode de redimensionnement vous pouvez sélectionner la façon de rendre le contenu de la table
attributaire :

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to
display the full selection of attribute table. Each frame can be moved around on the layout. If you
resize a frame, the resulting table will be divided up between the other frames. The last frame will be
trimmed to fit the table.

– Repeat until finished will also create as many frames as the Extend to next page option,
except all frames will have the same size.

• Use the Add Frame button to add another frame with the same size as selected frame. The result of the
table that will not fit in the first frame will continue in the next frame when you use the Resize mode Use
existing frames.

• Activate Don’t export page if frame is empty prevents the page to be exported when the table frame has
no contents. This means all other layout items, maps, scalebars, legends etc. will not be visible in the result.

• Activer Ne pas afficher le fond si le cadre est vide empêche le fond d’être affiché lorsque le cadre de la
table n’a pas de contenu.
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16.2.7 The Picture Item

The Picture item is a tool that helps decorate your map with pictures, logos. . . It’s also the one that provides

the in-built north arrows. You can add a picture with the Add Picture following items creation instructions and
manipulate it the same way as exposed in Interacting with layout items.

By default, the picture item is a blank frame that you can customize using its Item Properties panel. Other than
the items common properties, this feature has the following functionalities (see figure_layout_image):

Figure 16.44: Picture Item Properties panel

You first have to select the image you want to display. There are several ways to set the Image source:

1. In the Main properties group, use the . . . Browse button of image source to select a file on your computer. The
browser will start in the SVG-libraries provided with QGIS. Besides SVG, you can also select other image
formats like .png or .jpg.

2. You can enter the source directly in the Image source text field. You can even provide a remote URL-address
to a picture.

3. From the Search directories area you can also select an image from the loaded previews to set the image
source. These images are by default provided by folders set in Settings → Options → System → SVG Paths.

4. Use the data defined override button to set the image source from a feature attribute or using a regular expres-
sion.

Note: In the Search directories group, you can use the Add and Remove buttons in the group to customize the list
of folders to fetch and preview images from.

With the Resize mode option, you can set how the image is displayed when the frame is resized:

• Zoom: enlarges/reduces the image to the frame while maintaining aspect ratio of picture;

• Stretch: stretches image to fit inside the frame, ignores aspect ratio;
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• Clip: use this mode for raster images only, it sets the size of the image to original image size without
scaling and the frame is used to clip the image, so only the part of the image inside the frame is visible;

• Zoom and resize frame: enlarges image to fit frame, then resizes frame to fit resultant image;

• Resize frame to image size: sets size of frame to match original size of image without scaling.

Depending on the selected Resize mode, the Placement and Image rotation options are disabled or not. With
Placement you can select the position of the image inside its frame. QGIS default provided .SVG files are
customizable, meaning that you can easily apply different Fill color, Stroke color (including opacity) and Stroke
width than the original, using their corresponding feature in the SVG Parameters group. These properties can as
well be data-defined.

If you add a .SVG file that does not enable these properties, you may need to add the following tags to the file in
order to add support e.g. for transparency:

• fill-opacity= »param(fill-opacity) »

• stroke-opacity= »param(outline-opacity) »

You can read this blog post to see an example.

Images can be rotated with the Image rotation field. Activating the Sync with map checkbox synchronizes the
rotation of the image with the rotation applied to a selected map item; this is a convenient feature for north arrows
that you can align with either:

• the Grid north: direction of a grid line which is parallel to the central meridian on the national/local grid;

• or the True north: direction of a meridian of longitude which converges on the North Pole.

You can also apply a declination Offset to the picture rotation.

Note: Beaucoup de flèches Nord n’ont pas un “N” ajouté à la flèche Nord, cela est fait exprès pour les langues
qui n’utilisent pas un “N” pour le Nord, de sorte qu’elles puissent utiliser une autre lettre.

Figure 16.45: Flèches Nord disponibles pour la sélection dans la bibliothèque SVG fournie
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16.2.8 L’élément cadre HTML

It is possible to add a frame that displays the contents of a website or even create and style your own HTML

page and display it! You can add a picture with the Add HTML following items creation instructions and
manipulate it the same way as exposed in Interacting with layout items.

The HTML item can be customized using its Item Properties panel. Other than the items common properties, this
feature has the following functionalities (see figure_layout_html):

Figure 16.46: Cadre HTML, panneau propriétés de l’objet

Source du HTML

The HTML Source group of the HTML frame Item Properties panel provides the following functionalities (see
figure_layout_html_ppt):

Figure 16.47: Cadre HTML, propriétés de la Source du HTML

• In URL you can enter the URL of a webpage you copied from your Internet browser or select an HTML file

using the . . . Browse button. There is also the option to use the Data-defined override button, to provide a URL
from the contents of an attribute field of a table or using a regular expression.

• Dans Source, vous pouvez entrer un texte dans la zone de texte avec quelques balises HTML ou proposer
une page HTML entière.

• The Insert an Expression button can be used to insert an expression like [%Year($now)%] in the Source
textbox to display the current year. This button is only activated when radiobutton Source is selected. After
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inserting the expression click somewhere in the textbox before refreshing the HTML frame, otherwise you
will lose the expression.

• Activez Évaluer l’expression QGIS dans la source du HTML pour voir le résultat de l’expression que
vous avez incluse, autrement vous verrez l’expression à la place.

• Use the Refresh HTML button to refresh the HTML frame(s) and see the result of changes.

Cadres

The Frames group of the HTML frame Item Properties panel provides the following functionalities (see fig-
ure_layout_html_frames):

Figure 16.48: Cadre HTML, propriétés des Cadres

• Avec Mode de redimensionnement, vous pouvez sélectionner la façon de rendre le contenu HTML :

– Use existing frames displays the result in the first frame and added frames only.

– Extend to next page will create as many frames (and corresponding pages) as necessary to
render the height of the web page. Each frame can be moved around on the layout. If you resize a
frame, the webpage will be divided up between the other frames. The last frame will be trimmed to fit
the web page.

– Repeat on every page will repeat the upper left of the web page on every page in frames of
the same size.

– Repeat until finished will also create as many frames as the Extend to next page
option, except all frames will have the same size.

• Use the Add Frame button to add another frame with the same size as selected frame. If the HTML page
does not fit in the first frame it will continue in the next frame when you use Resize mode or Use existing
frames.

• Activate Don’t export page if frame is empty prevents the page from being exported when the frame has
no HTML contents. This means all other layout items, maps, scale bars, legends etc. will not be visible in
the result.

• Activez Ne pas afficher le fond si le cadre est vide empêche que le cadre HTML soit affiché si le cadre
est vide.

Utiliser des sauts de page intelligents

The Use smart page breaks dialog and User style sheet dialog of the HTML frame Item Properties panel provides
the following functionalities (see figure_layout_html_breaks):

• Activez Utiliser des sauts de pages intelligents pour empêcher le contenu du cadre html de se casser à
mi-chemin d’une ligne de texte afin qu’il continue bien dans le cadre suivant.

• Paramètre la Distance maximale autorisée lors du calcul de l’emplacement du saut de page dans le
html. Cette distance est la quantité maximale d’espace vide autorisé dans le bas du cadre après cal-
cul de l’emplacement optimal du saut de page. Indiquer une grande valeur permettra de mieux définir
l’emplacement du saut de page mais une plus grande quantité d’espace vide sera présent dans le bas des
cadres. Cette valeur est utilisée uniquement lorsque Utiliser des sauts de page intelligents est activé.
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Figure 16.49: HTML frame, Use smart page breaks and User style sheet properties

• Activate User style sheet to apply HTML styles that often is provided in cascading style sheets. An
example of style code is provided below to set the color of <h1> header tag to green and set the font and
font size of text included in paragraph tags <p>.

h1 {color: #00ff00;
}
p {font-family: "Times New Roman", Times, serif;

font-size: 20px;
}

• Use the Update HTML button to see the result of the style sheet settings.

16.2.9 The Shape Items

QGIS provides a couple of tools to draw regular or more complex shapes over the print layout.

Note: Unlike other print layout items, you can not style the frame nor the background color of the shapes
bounding frame (set to transparent by default).

The Regular Shape Item

The Shape item is a tool that helps to decorate your map with regular shapes like triangle, rectangle, ellipse. . .

You can add a regular shape using the Add Shape tool which gives access to particular tools like Add Rectangle,
Add Ellipse and Add Triangle. Once you have selected the appropriate tool, you can draw the item following

items creation instructions. Like other layout items, a regular shape can be manipulated the same way as exposed
in Interacting with layout items.

Note: Holding down the Shift key while drawing the basic shape with the click and drag method helps you
create a perfect square, circle or triangle.

The default shape item can be customized using its Item Properties panel. Other than the items common properties,
this feature has the following functionalities (see figure_layout_label):

The Main properties group shows and allows you to switch the type of the shape item (Ellipse, Rectangle or
Triangle) inside the given frame.

You can set the style of the shape using the advanced symbol and color selector widget. . .

For the rectangle shape, you can set in different units the value of the Corner radius to round of the corners.
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Figure 16.50: Onglet Propriétés d’une forme

Les formes basées sur des nœuds

While the Add Shape tool provides way to create simple and predefined geometric item, the Add Node
Item tool helps you create a custom and more advanced geometric item. For polylines or polygons, you can draw
as many lines or sides as you want and vertices of the items can be independently and directly manipulated using

the Edit Nodes Item. The item itself can be manipulated as exposed in Interacting with layout items.

To add a node-based shape:

1. Click the Add Node Item icon

2. Select either Add Polygon or Add Polyline tool

3. Perform consecutive left clicks to add nodes of your item. If you hold down the Shift key while drawing
a segment, it is constrained to follow an orientation multiple of 45°.

4. When you’re done, right-click to terminate the shape.

You can customize the appearance of the shape in the Item Properties panel.

Figure 16.51: Polygon Node Shape Item Properties Panel

In the Main properties, you can set the style of the shape using the advanced symbol and color selector widget. . .

For polyline node items, you can also parameterize the Line markers i.e. add:

• start and/or end markers with options:

– None: draws a simple polyline.

– Arrow: adds a regular triangular arrow head that you can customize.

– SVG marker: uses an SVG file as arrow head of the item.
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• customize the arrow head:

– Arrow stroke color: sets the stroke color of the arrow head.

– Arrow fill color: sets the fill color of the arrow head.

– Arrow stroke width: sets the stroke width of the arrow head.

– Arrow head width: sets the size of the arrow head.

SVG images are automatically rotated with the line. Stroke and fill colors of QGIS predefined SVG images can
be changed using the corresponding options. Custom SVG may require some tags following this instruction.

Figure 16.52: Polyline Node Shape Item Properties Panel

L’élément Flèche

The Add Arrow tool is a shortcut to create an arrow-enabled polyline by default and thus has the same properties
and behavior as a polyline node item.

Actually, the arrow item can be used to add a simple arrow, for example, to show the relation between two different
print layout items. However, to create a north arrow, the image item should be considered first as it gives access to
a set of north arrows in .SVG format that you can sync with a map item so that it rotates automatically with it.

Editing a node item geometry

A specific tool is provided to edit node-based shapes through Edit Nodes Item. Within this mode, you can select
a node by clicking on it (a marker is displayed on the selected node). A selected node can be moved either by
dragging it or by using the arrow keys. Moreover, in this mode, you are able to add nodes to an existing shape:
double-click on a segment and a node is added at the place you click. Finally, you can remove the currently
selected node by hitting the Del key.
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16.3 Exporter des cartes

The figure below shows an example of print layout including each type of layout items described in the previous
section.

Figure 16.53: Print Layout with map view, legend, image, scale bar, coordinates, text and HTML frame added

From the Layout menu or toolbar, you can output the print layout to different file formats, and it is possible to
modify the resolution (print quality) and paper size:

• Le bouton Imprimer vous permet d’imprimer la mise en page sur une imprimante ou dans un fichier
PostScript en fonction des pilotes d’imprimante installés.

• The Export as image icon exports the print layout in several image formats such as PNG, BMP, TIF, JPG,
and many others. . .

• The Export as SVG icon saves the print layout as an SVG (Scalable Vector Graphic).

• The Export as PDF icon saves the defined print layout directly as a PDF.

16.3.1 Export settings

Whenever you export a print layout, there are a selection of export settings QGIS needs to check in order to return
the most appropriate output. These configurations are:

• the Export settings of the Layout panel, such as Export resolution, Print as raster, Always export as vectors
or Save world file;

• the Exclude page from exports in the page item properties panel;

• the Exclude item from exports in the item properties panel.
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16.3.2 Exporter au format image

Clicking the Export as image icon will ask you to select the image format and enter the filename to use to export
the print layout: in the case of multi-page composition, each page will be exported to a file with the given name
appended with the page number.

In the next Image Export Options dialog, you can optionally override the print layout resolution and the exported
page dimensions (set in Layout panel).

By checking Crop to content option, the image output by the layout will include the minimal area enclosing
all the items (map, legend, scale bar, shapes, label, image. . . ) of each page of the composition:

• If the composition includes a single page, then the output is resized to include EVERYTHING on the
composition. The page can then be reduced or extended to all items depending on their position (on, above,
below, left or right of the page).

• In case of a multi-page layout, each page will be resized to include items in its area (left and right sides
for all pages, plus top for the first page and bottom for the last page). Each resized page is exported to a
separate file.

The Crop to content dialog also allows to add some margins around the cropped bounds.

Figure 16.54: Image Export Options, output is resized to items extent

Astuce: Use image formats that support transparency when items extend beyond the paper extent

Since layout items may be placed outside the paper extent, using the Crop to content option while exporting can
result in an image that extends beyond the paper extent. Since the background outside of the paper extent will be
transparent, for image formats that do not support transparency (eg, .BMP, .JPG) it will be rendered as full black,
« corrupting » the image.

Use transparency-compatible formats like .TIFF or .PNG in such a case.

If you need to export your layout as a georeferenced image (e.g., to share with other projects), check the
Generate world file option and a world file named like the page on which the map reference set in Layout panel is
placed will be created along the export(s). This option can also be checked by default in the layout panel.

When needed, images rendering can also be improved with the Enable antialiasing option.
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16.3.3 Exporter au format SVG

With Export as SVG, you also need to fill the filename (used as a basename for all files in case of multi-page

composition) and then can apply Crop to content option.

The SVG export options dialog also allows to override the layout default export and offers other settings:

• Export map layers as SVG groups: may affect label placement.

• Render map labels as outlines: unchecking this will allow you to edit labels as texts in vector illustration
software.

• Always export as vectors: some rendering options require items to be rasterized for a better rendering.
Check this option to keep the objects as vectors with the risk that the appearance of the output file may not
match the print layout preview (for more details, see Paramètres d’export).

• Export RDF metadata.

Figure 16.55: Options d’enregistrement SVG

Note: Actuellement le rendu SVG est très basique. Il ne s’agit pas d’un problème lié à QGIS mais à la biblio-
thèque Qt utilisée. Nous pouvons espérer que cela soit corrigé dans les versions futures.

16.3.4 Exporter au format PDF

The Export as PDF tool exports all the composition pages into a single PDF file you’d need to provide path and
name. Unlike the other formats, exporting to .PDF does not provide means to override the layout export settings.
So check these settings to ensure they are compatible with your needs.

Note: Exporting a print layout to formats like .PDF or .TIFF creates by default a georeferenced output (no
world file needed).
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Figure 16.56: PDF Export Options

16.3.5 Générer un Atlas

Atlas functions allow you to create map books in an automated way. Atlas uses the features of a vector or table
layer called coverage layer and creates an output for each atlas feature. The most common usage is to zoom a
map item to the current atlas feature. Further use cases include:

• a map item showing, for another layer, only features that share the same attribute as the atlas feature or are
within its geometry;

• a label or html item whose text is replaced as features are iterated over;

• a table item showing attributes of associated parent or children features of the current atlas feature. . .

For each feature, an output is processed for all pages and items according to their exports settings.

Astuce: Use variables for more flexibility

QGIS provides a large panel of functions and variables, including atlas related ones, that you can use to manipulate
the layout items but also the layers symbology according to atlas status. Combining these features gives you a lot
of flexibility and helps you easily produce advanced mappings.

To enable the generation of an atlas and access atlas parameters, refer to the Atlas panel. This panel contains the
following functionalities (see figure_layout_atlas):

Figure 16.57: Atlas Panel

• Generate an atlas, which enables or disables the atlas generation;
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• A Coverage layer combo box that allows you to choose the table or vector layer containing the
features to iterate over;

• An optional Hidden coverage layer that, if checked, will hide the coverage layer (but not the other
layers) during the generation;

• An optional Page name combo box to give a more explicit name to each feature page(s) when previewing
atlas. You can select a field of the coverage layer or set an expression. If this option is empty, QGIS will
use an internal ID, according to the filter and/or the sort order applied to the layer;

• An optional Filter with text area that allows you to specify an expression for filtering features from the
coverage layer. If the expression is not empty, only features that evaluate to True will be processed;

• An optional Sort by that allows you to sort features of the coverage layer, using a field of the coverage
layer or an expression. The sort order (either ascending or descending) is set by the two-state Sort direction
button that displays an up or a down arrow.

Vous disposez également les options pour paramétrer la sortie de l’atlas:

• An Output filename expression textbox that is used to generate a filename for each geometry if needed. It is
based on expressions. This field is meaningful only for rendering to multiple files;

• A Single file export when possible that allows you to force the generation of a single file if this is possible
with the chosen output format (PDF, for instance). If this field is checked, the value of the Output filename
expression field is meaningless;

• An Image export format drop-down list to select the output format when using the Export atlas as Images. . .

button.

Control map by atlas

The most common usage of atlas is with the map item, zooming to the current atlas feature, as iteration goes over
the coverage layer. This behavior is set in the Controlled by atlas group properties of the map item. See Controlled
by atlas for different settings you can apply on map item.

Customize labels with expression

In order to adapt labels to the feature the atlas iterates over, you can include expressions. What you should take
care of is to place expression part (including functions, fields or variables) between [% and %] (see L’élément
Étiquette for more details).

For example, for a city layer with fields CITY_NAME and ZIPCODE, you could insert this:

The area of [% concat( upper(CITY_NAME), ',', ZIPCODE, ' is ',
format_number($area/1000000, 2) ) %] km2

ou une autre combinaison:

The area of [% upper(CITY_NAME)%],[%ZIPCODE%] is
[%format_number($area/1000000,2) %] km2

The information [% concat( upper(CITY_NAME), ',', ZIPCODE, ' is ',
format_number($area/1000000, 2) ) %] is an expression used inside the label. Both expres-
sions would result in the generated atlas as:

The area of PARIS,75001 is 1.94 km2
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Explore Data-defined override buttons with atlas

There are several places where you can use a Data defined override button to override the selected setting. These
options are particularly useful with atlas generation. See Valeurs définies par des données for more details on this
widget.

For the following examples the Regions layer of the QGIS sample dataset is used and selected as coverage layer
for the atlas generation. We also assume it’s a single page layout containing a map and a label items.

When the height (north-south) of the extents of a region is greater than its width (east-west), you rather want to

use Portrait instead of Landscape orientation to optimize the use of paper. With a Data Defined Override button you
can dynamically set the paper orientation.

Right-click on the page and select Page Properties to open the panel. We want to set the orientation dynamically,

using an expression depending on the region geometry so press the button of field Orientation, select Edit. . .
to open the Expression string builder dialog and enter the following expression:

CASE WHEN bounds_width(@atlas_geometry) > bounds_height(@atlas_geometry)
THEN 'Landscape' ELSE 'Portrait' END

Now if you preview the atlas, the paper orients itself automatically but items placement may not be ideal. For

each Region you need to reposition the location of the layout items as well. For the map item you can use the
button of its Width property to set it dynamic using following expression:

@layout_pagewidth - 20

Likewise, use the button of the Height property to provide following expression and constrain map item size:

@layout_pageheight - 20

To ensure the map item is centered in the page, set its Reference point to the upper left radio button and enter 10
for its X and Y positions.

Let’s add a title above the map in the center of the page. Select the label item and set the horizontal alignment to

Center. Next move the label to the right position, activate from Reference point any of the middle buttons,
and provide the following expression for field X:

@layout_pagewidth / 2

For all other layout items you can set the position in a similar way so they are correctly positioned when the page
is automatically rotated in portrait or landscape. You can also do more tweaks such as customizing the title with
feature attributes (see Customize labels with expression example), updating images with atlas feature, resizing the
legend columns number according to page orientation. . .

Information provided is an update of the excellent blog (in English and Portuguese) on the Data Defined Override
options Multiple_format_map_series_using_QGIS_2.6 .

This is just one example of how you can use some advanced settings with atlas.

Preview and generate an atlas

Figure 16.58: Barre d’outils d’aperçu de l’atlas

Once the atlas settings have been configured and layout items (map, table, image. . . ) linked to it, you can create a

preview of all the pages by clicking Atlas → Preview Atlas or Preview Atlas icon. You can then use the arrows in
the same toolbar to navigate through all the features:

16.3. Exporter des cartes 391

https://sigsemgrilhetas.wordpress.com/2014/11/09/series-de-mapas-com-formatos-multiplos-em-qgis-2-6-parte-1-multiple-format-map-series-using-qgis-2-6-part-1


QGIS User Guide, Version 3.4

• Première entité

• Entité précédente

• Entité suivante

• Dernière entité

Vous pouvez également utiliser la liste déroulante pour sélectionner directement et prévisualiser une entité spéci-
fique. La liste déroulante affiche le nom des entités selon l’expression paramétrée dans l’option Nom de page.

As for simple compositions, an atlas can be generated in different ways (see Exporter des cartes for more infor-
mation). Instead of Layout menu, rather use tools from Atlas menu or toolbar.

This means that you can directly print your compositions with Atlas → Print Atlas. You can also create a PDF
using Atlas → Export Atlas as PDF. . . : You will be asked for a directory to save all the generated PDF files, except

if the Single file export when possible has been selected. In that case, you’ll be prompted to give a filename.

With Atlas → Export Atlas as Images. . . or Atlas → Export Atlas as SVG. . . tool, you’re also prompted to select
a folder. Each page of each atlas feature composition is exported to the image file format set in Atlas panel or to
SVG file.

Astuce: Imprimer une entité spécifique de l’atlas

If you want to print or export the composition of only one feature of the atlas, simply start the preview, select the
desired feature in the drop-down list and click on Layout → Print (or Export. . . to any supported file format).

16.4 Créer un Rapport

16.4.1 Qu’est-ce?

Cette section va vous aider à mettre en place une génération automatique de rapports dans QGIS. Par définition,
un rapport SIG est un document contenant des informations organisées dans des formulaires narratifs, graphiques,
cartographiques ou tabulaires préparés selon les besoins ou pour sur une base périodique, récurrente, régulière ou
au cas par cas. Les rapports peuvent se référer à des périodes spécifiques, des évènements, occurences ou à des
sujets, emplacements différents. Ils peuvent servir de supports de communication écrits pour des publications ou
des communications. Les rapports dans QGIS permettent aux utilisateurs d’extraire le contenu des SIG sous une
forme simple et rapide.

16.4.2 Se lancer

L’onglet Reports est une extension de l’outil de mise en page. Cette fonctionalité peut être trouvée sous Projet →
Nouveau Rapport ou à travers Projet → Gestionnaire de mise en page.

Dans la boîte de dialogue Gestionnaire de mise en page, le rapport peut être créé sous Nouveau depuis un modèle
et sélectionner l’option du menu déroulant Rapport vide et cliquer sur le bouton Créer. . .

Pour cet exemple, nous utilisons les limites administratives, endroits peuplés, ports et aéroports du jeu de données
Natural Earth.

En utilisant la commande Projet → Nouveau rapport. . . , créer un rapport vide. Au début, il n’y a pas beaucoup
de choses à voir. La boîte de dialogue ressemble fortement au composeur de mises en pages, à l’exception du
nouveau panneau Editeur de rapport sur la gauche :
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16.4.3 Espace de travail de mise en page du rapport

QGIS reports can consist of multiple, nested sections. In our new blank report we initially have only the main
report section. The only options present for this report section is Include report header or Include report footer.
If we enable these options, the header will be included as the very first page (or pages. . . — individual parts of
reports can be multi-page if desired) in the report, and the footer would be the last page. Let’s go ahead and enable
the header, and hit the Edit button next to it:

A few things happen as a result. Firstly, an edit pencil is now shown next to the Report section in the Report
Organizer, indicating that the report section is currently being edited in the designer. We also see a new blank
page shown in the designer itself, with the small Report Header title. In QGIS reports, every component of the
report is made up of individual layouts. They can be created and modified using the exact same tools as are
available for standard print layouts – so you can use any desired combination of labels, pictures, maps, tables, etc.
Let’s add some items to our report header to demonstrate:

We’ll also create a simple footer for the report, by checking the Include report footer option and hitting Edit.

Before proceeding further, let’s export this report and see what we get. Exporting is done from the Report menu
– in this case we select Export Report as PDF to render the whole report to a PDF file. Here’s the not-very-
impressive result – a two page PDF consisting of our header and footer:
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Let’s make things more interesting. By hitting the Add Static Layout Section button in the Report Organizer, we’re
given a choice of new sections to add to our report.

There are two options: Add Static Layout Section and a Field Group Section. The Add Static Layout Section is
a single, static body layout. This can be used to embed static layouts mid-way through a report. Alternatively, a
Field Group Section repeats its body layout for every feature in a layer. The features are sorted by the selected
grouping feature (with an option for ascending/descending sort). If a field group section has child sections (e.g.
another field group section with a different field, then only features with unique values for the group feature are
iterated over. This allows nested reports with different information.

For now we’ll add a Field Group to our report. At its most basic level, you can think of a Field Group Section as
the equivalent of a print atlas. You select a layer to iterate over, and the report will insert a section for each feature
found. Selecting the new Field Group Section reveals a number of new related settings:

In this case we’ve setup our Field Group so that we iterate over all the states from the Admin Level 1 layer, using
the values from the adm1name field. The same options for header and footer are present, together with a new
option to include a body for this section. We’ll do that, and edit the body:
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We’ve setup this body with a map (set to follow the current report feature – just like how a map item in an atlas
can follow the current atlas feature), and a label showing the state’s name. If we went ahead and exported our
report now, we’d get something like this:

First, the report header, then a page for each state, and finally the report footer. So more or less an atlas, but with a
header and footer page. Let’s make things more interesting by adding a subsection to our state group. We do this

by first selecting the state field group in the organizer, then hitting the Field Group Section button and adding a new
Field Group Section:

When a Field Group Section is iterating over its features, it will automatically filter these features to match the
feature attributes from its parent groups. In this case, the subsection we added will iterate over a Populated Places
layer, including a body section for each place encountered. The magic here is that the Populated Places layer has
an attribute named adm1name, tagging each place with the state it’s contained within (if you’re lucky your data
will already be structured like this – if not, run the Processing Join Attributes by Location algorithm and create
your own field). When we export this report, QGIS will grab the first state from the Admin Level 1 layer, and then
iterate over all the Populated Places with a matching adm1name value. Here’s what we get:

Here we created a basic body for the Populated Places group, including a map of the place and a table of some
place attributes. So our report is now a report header, a page for each state followed by a page for every populated
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place within that state, and finally the report footer. If we were to add a header for the Populated Places group, it
would be included just before listing the populated places for each state:

Similarly, a footer for the Populated Places group would be inserted after the final place for each state is included.

In addition to nested subsections, subsections in a report can also be included consecutively. If we add a second
subsection to the Admin Level 1 group for Airports, then our report will first list ALL the populated places for
each state, followed by all the airports within that state, before proceeding to the next state. In this case our report
would be structured like this:

16.4.4 Report Output

The key point here is that our Airports group is a subsection of the Admin Level 1 group – not the Populated Places
group. Here’s what our report could look like now:

Combining nested and consecutive sections, together with section headers and footers allows for tons of flexibility.
For instance, in the below report we add another field group as a child of the main report for the :guilabel‘Ports‘
layer. Now, after listing the states together with their populated places and airports, we’ll get a summary list of all
the ports in the region:

This results in the last part of our report exporting as:
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16.4.5 Export settings

Whenever you export a report, there is a selection of export settings QGIS needs to check in order to return the
most appropriate output. As you can start to imagine, reports in QGIS are extremely powerful and flexible!

Note: When you are exporting a report to the available formats please choose the options (Print, SVG, Image,
PDF) that have the labels saying Export Report as. . . otherwise you will print the current active map.

The current information was adapted from the blog of North Road, Exploring Reports in QGIS 3.0 - the Ultimate
Guide!
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CHAPTER 17

Les données OGC

17.1 QGIS comme client de données OGC

L’OGC (Open Geospatial Consortium) est une organisation internationale à laquelle participent plus de 300 or-
ganisations commerciales, gouvernementales, associatives et laboratoires de recherche à travers le monde. Ses
membres développent et implémentent des standards pour les services et le contenu géospatial, le traitement de
données SIG et les formats d’échange.

Describing a basic data model for geographic features, an increasing number of specifications are developed
by OGC to serve specific needs for interoperable location and geospatial technology, including GIS. Further
information can be found at https://www.opengeospatial.org/.

Les spécifications importantes de l’OGC prises en charge par QGIS sont :

• WMS — Web Map Service (Client WMS / WMTS)

• WMTS — Web Map Tile Service (Client WMS / WMTS)

• WFS — Web Feature Service (Client WFS et WFS-T)

• WFS-T — Web Feature Service - Transactional (Client WFS et WFS-T)

• WCS — Web Coverage Service (Client WCS)

• WPS — Web Processing Service

• CSW — Catalog Service for the Web

• SFS — Simple Features for SQL (Couches PostGIS)

• GML — Geography Markup Language

Les services OGC sont de plus en plus utilisés pour échanger des données géospatiales entre différentes implé-
mentations SIG et des fournisseurs de données. QGIS peut maintenant traiter les spécifications citées ci-dessus
dont le SFS (via PostgreSQL / PostGIS, voir section Couches PostGIS).

17.1.1 Client WMS / WMTS
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Aperçu de la gestion du WMS

QGIS peut actuellement agir comme client WMS pour les versions 1.1, 1.1.1 et 1.3 des serveurs WMS. Il a été
tout particulièrement testé avec des serveurs accessibles publiquement comme ceux de DEMIS.

Un serveur WMS agit en fonction des requêtes envoyées par le client (par exemple QGIS) pour une carte raster
avec une étendue donnée, un ensemble de couches, une sémiologie et une transparence. Le serveur WMS consulte
alors ses sources de données locales, rasterise la carte et la renvoie au client dans un format raster. Pour QGIS,
cela sera par exemple du JPEG ou du PNG.

Un WMS est de manière générale un service web mis en œuvre selon une architecture REST (Representational
State Transfer) plutôt qu’un service RPC (Remote Procedure Call) pleinement déployé. De cette façon, vous
pouvez copier les adresses générées par QGIS et les coller dans un navigateur internet pour retrouver les mêmes
images que dans QGIS. Cela peut être très pratique pour résoudre des problèmes, car de fait il y a plusieurs
modèles de serveur WMS sur le marché, chacun ayant son interprétation du standard WMS.

Des couches WMS peuvent être ajoutées assez simplement, du moment que vous connaissez l’URL pour accéder
au serveur WMS, vous avez une connexion sous forme de service sur ce serveur, et celui-ci comprend le protocole
HTTP comme mécanisme de transport.

Additionally, QGIS will cache your WMS responses (i.e. images) for 24h as long as the GetCapabilities request
is not triggered. The GetCapabilities request is triggered everytime the Connect button in the Add Layer(s) from
WMS(T) Server dialog is used to retrieve the WMS server capabilities. This is an automatic feature meant to
optimize project loading time. If a project is saved with a WMS layer, the corresponding WMS tiles will be
loaded from the cache the next time the project is opened as long as they are no older than 24H.

Aperçu du support WMTS

QGIS peut aussi agir comme client WMTS. WMTS est un standard OGC de diffusion des données cartographiques
sous formes de tuiles prédéfinies. C’est un moyen de diffusion plus rapide et plus efficient que le standard WMS
car les tuiles sont générées à l’avance et les requêtes clientes ne portent que sur la transmission des tuiles, non leur
production. A contrario, une requête WMS implique à la fois la génération des données et leur transmission. Un
exemple bien connu d’utilisation de données cartographiques tuilées, non conforme au standard OGC, est Google
Maps.

Afin d’afficher des données à différentes échelles proches de celles souhaitées par l’utilisateur, les dalles WMTS
sont produites à différents niveaux d’échelle et peuvent être demandées par une application SIG cliente.

Ce diagramme illustre le concept de tuiles prédéfinies:

Figure 17.1: Le concept de tuiles prédéfinies WMTS

Les deux types d’interfaces WMTS que QGIS gère sont les paires clef-valeurs (KVP) et RESTful. Ces deux
interfaces sont différentes et vous devrez les paramétrer de manière différente dans QGIS.

1. Pour accéder à un service WMTS KVP, l’utilisateur doit ouvrir l’interfaces WMS/WMTS et ajouter la
chaîne de caractères suivante à l’URL du service de tuile WMTS :
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"?SERVICE=WMTS&REQUEST=GetCapabilities"

Un exemple de ce type d’adresse est

https://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Pour les tests, la couche topo2 de ce WMTS fonctionne correctement. Ajouter cette chaîne indique que le
service web WMTS est utilisé à la place du service WMS.

2. Le service RESTful WMTS prend la forme différente d’une URL classique. Le format recommandé par
l’OGC est le suivant:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml

This format helps you to recognize that it is a RESTful address. A RESTful WMTS is accessed in QGIS by
simply adding its address in the WMS setup in the URL field of the form. An example of this type of address
for the case of an Austrian basemap is https://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Note: You can still find some old services called WMS-C. These services are quite similar to WMTS (i.e., same
purpose but working a little bit differently). You can manage them the same as you do WMTS services. Just add
?tiled=true at the end of the url. See https://wiki.osgeo.org/wiki/Tile_Map_Service_Specification for more
information about this specification.

Lorsque vous lisez WMTS, vous pouvez également penser WMS-C.

Sélection des serveurs WMS/WMTS

La première fois que vous utilisez la fonctionnalité de services WMS dans QGIS, il n’y a aucun serveur défini.

Commencez par cliquer sur le bouton Ajoutez une couche WMS dans la barre d’outils ou via le menu Couche →
Ajoutez une couche WMS. . . .

The dialog Add Layer(s) from a Server for adding layers from the WMS server appears. You can add some servers
to play with by clicking the Add Default Servers button. This will add two WMS demo servers for you to use: the
WMS servers of the DM Solutions Group and Lizardtech. To define a new WMS server in the Layers tab, select
the New button. Then enter the parameters to connect to your desired WMS server, as listed in table_OGC_wms:

Nom Un nom pour cette connexion. Ce nom sera utilisé dans la liste déroulante des connexions
aux serveurs afin que vous puissiez le distinguer des autres serveurs WMS.

URL URL du serveur fournissant les données. Cela doit être un nom d’hôte publique – le même
format que si vous l’utilisiez pour ouvrir une connexion Telnet ou pinguer un hôte (ou dans
un navigateur Internet).

Nom utilisa-
teur

Nom d’utilisateur pour accéder à un serveur WMS sécurisé. Ce paramètre est optionnel.

Mot de Passe Mot de passe pour une authentification basique à un serveur WMS. Ce paramètre est option-
nel.

Ignorer
l’adresse
GetMap

Ignorer l’adresse GetMap signalée : force l’utilisation de l’adresse précisée dans le
champ URL ci-dessus.

Ignorer
l’adresse Get-
FeatureInfo

Ignorer l’adresse GetFeatureInfo signalée : force l’utilisation de l’adresse précisée dans
le champ URL ci-dessus.

Table OGC 1 : Paramètres de connexion à un serveur WMS
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Si vous devez configurer un serveur proxy pour pouvoir recevoir des services WMS à partir d’Internet, vous
pouvez ajouter votre serveur proxy dans les options. Choisissez le menu Préférences → Options et cliquez sur

l’onglet Réseau. Vous pouvez alors ajouter votre configuration de proxy et l’activer en cochant la case Utiliser
un proxy pour l’accès Internet. Assurez-vous que vous avez sélectionné le type de proxy correct dans la liste

déroulante Type de proxy .

Une fois qu’une nouvelle connexion à un serveur WMS a été créée, elle sera sauvegardée pour les futures sessions
de QGIS.

Astuce: À propos des URL des serveurs WMS

Assurez-vous, lorsque vous entrez l’URL du serveur WMS, d’avoir uniquement l’URL de base. Par exemple,
vous ne devez pas avoir de paramètres tels que request=GetCapabilities ou version=1.0.0 dans
votre URL.

Avertissement: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Système d’authentification for more details.

Chargement des couches WMS/WMTS

Once you have successfully filled in your parameters, you can use the Connect button to retrieve the capabilities of
the selected server. This includes the image encoding, layers, layer styles and projections. Since this is a network
operation, the speed of the response depends on the quality of your network connection to the WMS server. While
downloading data from the WMS server, the download progress is visualized in the lower left of the WMS dialog.

Votre écran devrait maintenant ressembler à la figure_OGC_add_wms, qui montre la réponse fournie par le serveur
WMS du Portail Européen du Sol.

Format d’image

La section Format d’image liste les formats qui sont gérés à la fois par le client et leur serveur. Choisissez en
fonction de votre besoin de précision de l’image.

Astuce: Format d’image

Les serveurs WMS vous offriront typiquement le choix entre les formats d’image JPEG et PNG. Le JPEG est un
format de compression avec perte alors que le PNG reproduit fidèlement les données raster brutes.

Utilisez le JPEG si vous vous attendez à ce que les données WMS soient de nature photographiques et/ou si vous
acceptez une perte de qualité dans l’image. Ce compromis réduit généralement de cinq fois le temps de transfert
des données par rapport au PNG.

Utilisez le PNG si vous voulez une représentation précise des données d’origine, et vous acceptez des temps de
transfert des données plus longs.

Options

La zone Options de la fenêtre dispose d’un champ textuel où vous pouvez saisir le Nom de la couche WMS. Ce
nom sera affiché dans la légende après le chargement de la couche.

Sous le nom de la couche vous pouvez définir la Taille de tuile (par exemple 256x256), si vous souhaitez diviser
la requête WMS en plusieurs requêtes.

Limite d’entité de GetFeatureInfo permet de définir quelles entités requêter sur le serveur.
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Figure 17.2: Fenêtre d’ajout d’un serveur WMS, avec indication des couches disponibles
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If you select a WMS from the list, a field with the default projection provided by the mapserver appears. If the
Change. . . button is active, you can click on it and change the default projection of the WMS to another CRS
provided by the WMS server.

Enfin, vous pouvez activer Utiliser la légende WMS contextuelle si le serveur WMS prend en charge cette
fonctionnalité. Sera alors affichée une légende adaptée aux éléments présents dans l’extension courante de la
carte, les éléments de légende qui correspondent à des éléments non affichés ne seront pas inclus dans la légende.

Ordre des couches

L’onglet Ordre des couches liste les couches sélectionnées disponibles pour le serveur WMS actuellement con-
necté. Certaines couches seront peut-être dépliables, cela signifie que différents styles sont disponibles pour cette
couche.

Vous pouvez sélectionner plusieurs couches à la fois, mais seulement un style d’image par couche. Lorsque
plusieurs couches sont sélectionnées, celles-ci seront combinées par le serveur WMS et transmises à QGIS en une
seule fois.

Astuce: Ordonner les couches WMS

Les couches WMS sont superposées par le serveur dans l’ordre listé dans la section Couches, du haut vers le bas.
Si vous souhaitez changer cet ordre, utilisez l’onglet Ordre des couches.

Transparence

Dans cette version de QGIS, le paramètre de Transparence globale de la fenêtre de Propriétés de la couche est
codé en dur pour être toujours activé, si disponible.

Astuce: Transparence des couches WMS

La disponibilité de la transparence de l’image WMS dépend du format d’image utilisé : les formats PNG et GIF
gèrent la transparence, tandis que le format JPEG ne le gère pas.

Système de Coordonnées de Référence

Un Système de Coordonnées de Référence de (SCR) est la terminologie de l’OGC pour désigner une projection
QGIS.

Chaque couche WMS peut être représentée dans plusieurs projections (ou SCR), en fonction des possibilités du
serveur WMS.

To choose a CRS, select Change. . . and a dialog similar to Fenêtre de SCR personnalisé will appear. The main
difference with the WMS version of the dialog is that only those CRSs supported by the WMS server will be
shown.

Recherche de serveur

Dans QGIS vous pouvez rechercher directement des serveurs WMS. La figure Figure_OGC_search montre
l’onglet Recherche de serveurs de la fenêtre Ajouter des couches d’un serveur.

As you can see, it is possible to enter a search string in the text field and hit the Search button. After a short
while, the search result will be populated into the list below the text field. Browse the result list and inspect your
search results within the table. To visualize the results, select a table entry, press the Add Selected Row to WMS
List button and change back to the Layers tab. QGIS has automatically updated your server list, and the selected
search result is already enabled in the list of saved WMS servers in the Layers tab. You only need to request the
list of layers by clicking the Connect button. This option is quite handy when you want to search maps by specific
keywords.

Fondamentalement cette option est un front end à l’API de http://geopole.org.
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Figure 17.3: Fenêtre de recherche de serveurs WMS à partir de mots clés

Jeux de Tuiles

Lorsque vous utilisez des services WMTS (WMS en cache) tel que:

https://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Vous pouvez naviguer dans l’onglet Jeux de tuiles fourni par le serveur. Cette table liste d’autres informations
telles que la taille des tuiles, les formats et les SCR gérés. En combinaison avec cette fonctionnalité, vous pouvez
utiliser la jauge d’échelle de tuile en sélectionnant Vue→ Panneaux (sous KDE) ou Paramètres→ Panneaux et en
choisissant Échelle de tuile. Cela vous donne les échelles disponibles sur le serveur de tuile avec une jauge de
sélection.

Utiliser l’outil Identifier

Une fois que vous avez ajouté un serveur WMS et si une couche du serveur WMS est interrogeable, vous pouvez

utiliser l’outil Identifier pour sélectionner un pixel sur la carte. Une requête est envoyée au serveur WMS pour
chaque sélection effectuée. Les résultats de la requête sont renvoyés au format texte. Le formatage de ce texte
dépend du serveur WMS utilisé. Sélection du format

Si le serveur gère plusieurs formats de sortie, une liste déroulante des format gérés est automatiquement ajoutée à
la boîte de dialogue des résultats et le format sélectionné peut être stocké dans le fichier de projet pour la couche.
Support du format GML

L’outil d”identification gère les réponses des serveurs WMS (GetFeatureInfo) au format GML (intitulé Entité
dans l’interface graphique de QGIS). Si le format « Entité est géré par le serveur et qu’il est sélectionné, les
résultats de l’outil d’identification sont des entités vecteur, comme s’il s’agissait d’une couche vecteur normale.
Lorsqu’une seule entité est sélectionnée dans l’arbre, elle est mise en valeur dans la carte et elle peut être copié
dans le presse-papier et copiée dans une autre couche vecteur. Consultez l’exemple de gestion de GetFeatureInfor
au format GML pour UMN Mapserver ci-dessous.
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# in layer METADATA add which fields should be included and define geometry
→˓(example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains
→˓XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Visualiser les propriétés

Une fois que vous avez ajouté un serveur WMS, vous pouvez voir ses propriétés en faisant un clic-droit sur la
couche dans la légende et en sélectionnant Propriétés. Onglet Métadonnées

L’onglet Métadonnées affiche la richesse des informations du serveur WMS, généralement collectées à partir de
la requête capabilities renvoyée par le serveur. Beaucoup de définitions peuvent être obtenues par la lecture des
normes WMS (voir OPEN-GEOSPATIAL-CONSORTIUM Bibliographie), mais en voici quelques-unes :

• Propriétés du serveur

– Version du WMS — La version de WMS gérée par le serveur.

– Formats d’image — La liste des types MIME que le serveur peut renvoyer lors qu’il dessine la carte.
QGIS gère tous les formats pour lesquelles la bibliothèque Qt en sous-couche a été compilée, qui sont
à minima les types image/png et image/jpeg.

– Formats de l’outil Identitier — La liste des types MIME auxquels le serveur peut répondre quand
vous utilisez l’outil Identifier. Pour l’instant QGIS gère le type text-plain.

• Propriétés de la couche

– Selectionnée — Si la couche a été sélectionnée quand le serveur correspondant a été ajouté au projet.

– Visible — Si cette couche a été sélectionnée comme visible dans la légende (pas encore utilisé dans
cette version de QGIS).

– Peut identifier — Si cette couche retournera des résultats quand l’outil Identifier est utilisé sur celle-ci.

– Peut être transparente — Si cette couche peut être rendue avec une transparence. Cette version de
QGIS utilisera toujours la transparence si cette option est à Oui et que le format d’image gère la
transparence.

– Peut zoomer — Si on peut zoomer sur cette couche avec le serveur. Cette version de QGIS suppose
que toutes les couches WMS ont ce paramètre défini à Oui. Les couches déficientes seront peut-être
rendues d’une manière étrange.

– Décompte des cascades — Les serveurs WMS peuvent agir comme un proxy à d’autres serveurs
WMS pour obtenir des données pour une couche. Cette entrée affiche le nombre de fois où la requête
pour cette couche est redirigée vers un autre serveur WMS pour obtenir un résultat.
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– Largeur fixe, hauteur fixe — Si les pixels sources d’une couche ont des dimensions fixes. Cette ver-
sion de QGIS suppose que toutes les couches WMS ont ce paramètre non fixé. Les couches déficientes
seront peut-être rendues d’une manière étrange.

– Emprise en WGS 84 — La limite du contour de la couche, en coordonnées WGS 84. Certains
serveurs WMS ne définissent pas ceci correctement (par exemple, des coordonnées UTM sont util-
isées à la place). Si cela est le cas, alors la vue initiale sera rendue avec une vue très étendue. Le
webmaster du WMS doit être informé de cette erreur sur ce paramètre qui est certainement connu
en tant qu’éléments XML du WMS LatLonBoundingBox, EX_GeographicBoundingBox ou
the CRS:84 BoundingBox.

– Disponibilité des SCR — Les projections que l’on peut utiliser via le serveur WMS. Elles sont listées
dans le format natif du WMS.

– Disponibilité des styles — Les styles d’images que le serveur WMS peut utiliser pour le rendu de
cette couche.

Show WMS legend graphic in table of contents and layout

The QGIS WMS data provider is able to display a legend graphic in the table of contents” layer list and in the
print layout. The WMS legend will be shown only if the WMS server has GetLegendGraphic capability and the
layer has getCapability url specified, so you additionally have to select a styling for the layer.

Si une légende graphique est disponible, elle est affichée sous la couche. Elle est de faible taille et vous devez
cliquer dessus pour l’afficher complètement (dû à une limite d’architecture de QgsLegendInterface). Cliquer sur
la légende de la couche ouvrira une fenêtre avec la légende en pleine résolution.

In the print layout, the legend will be integrated at it’s original (downloaded) dimension. Resolution of the legend
graphic can be set in the item properties under Legend → WMS LegendGraphic to match your printing require-
ments.

La légende affichera une information contextuelle basée sur l’échelle courante. La légende WMS sera affichée
uniquement si le serveur WMS dispose de la fonction GetLegendGraphic et si la couche dispose d’une url getCa-
pability pour pouvoir choisir son style.

Limitations du client WMS

Toutes les fonctionnalités d’un client WMS n’ont pas été intégrées dans cette version de QGIS. Les exceptions les
plus notables sont présentées ci-après.

Éditer la configuration d’une couche WMS

Une fois que vous avez complété la procédure d” Ajout de couches WMS, il n’y aucun moyen de modifier la config-
uration. Une solution de contournement consiste à supprimer la couche et recommencer.

Serveurs WMS nécessitant une authentification

Actuellement les serveurs WMS publics et sécurisés sont gérés. Les serveurs sécurisés sont accessibles via authen-
tification publique. Vous pouvez ajouter ces informations d’authentification (optionnelles) au moment de l’ajout
d’un serveur WMS. Voir la section Sélection des serveurs WMS/WMTS pour les détails.

Astuce: Accéder à des couches OGC sécurisées

If you need to access secured layers with secured methods other than basic authentication, you can use InteProxy
as a transparent proxy, which does support several authentication methods. More information can be found in the
InteProxy manual at https://inteproxy.wald.intevation.org.

Astuce: QGIS WMS Mapserver
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Depuis la version 1.7.0, QGIS possède sa propre implémentation d’un Mapserver WMS 1.3.0. Référez vous à
QGIS comme serveur de données OGC pour en savoir plus.

17.1.2 Client WCS

Un service Web Coverage (WCS) fournit un accès à des données raster sous une forme qui permet le rendu
côté client, comme une entrée vers des modèles scientifiques. WCS peut être comparé à WFS et WMS. Comme ces
services, WCS permet aux clients de choisir des portions de données issues du serveur basées sur des contraintes
spatiales et d’autres critères de recherche.

QGIS dispose d’un fournisseur WCS natif qui gère les versions 1.0 et 1.1 (qui sont significativement différentes)
mais la version 1.0 est privilégiée car la version 1.1 pose beaucoup de problèmes (chaque serveur l’implémente
de manière différente avec beaucoup de particularités).

Le fournisseur WCS natif gère l’ensemble des requêtes réseau et utilise les paramètres réseau de QGIS (partic-
ulièrement le proxy). Il est également possible d’utiliser un mode cache (“toujours en cache”, “préférer le cache”,
“préférer le réseau”, “toujours le réseau”) et le fournisseur gère également la sélection dans le temps si un domaine
de temps est fourni par le serveur.

Avertissement: Entering username and password in the Authentication tab will keep unprotected credentials
in the connection configuration. Those credentials will be visible if, for instance, you shared the project file
with someone. Therefore, it’s advisable to save your credentials in a Authentication configuration instead
(configurations tab). See Système d’authentification for more details.

17.1.3 Client WFS et WFS-T

Dans QGIS, une couche WFS se comporte à peu près comme n’importe quelle autre couche vecteur. Vous pouvez
identifier et sélectionner des objets et voir la table attributaire. Depuis QGIS 1.6, l’édition (WFS-T) est prise en
charge si le serveur le propose.

Dans l’ensemble, l’ajout d’une couche WFS suit une procédure très similaire à celle des couches WMS. La
différence est qu’il n’y a pas de serveur défini par défaut, nous allons donc devoir en ajouter un.

Charger une couche WFS

As an example, we use the Gateway Geomatics WFS server and display a layer. https://demo.gatewaygeomatics.
com/cgi-bin/wfs_gateway?REQUEST=GetCapabilities&VERSION=1.0.0&SERVICE=WFS

To be able to load a WFS Layer we create a connection to the WFS server first.

1. Open the Data Source Manager dialog by pressing the Open Data Source Manager button

2. Enable the WFS tab

3. Click on New. . . to open the Create a New WFS Connection dialog

4. Enter Gateway Geomatics as name

5. Enter the URL (see above)

6. In the WFS settings dialog, you can:

• Indicate the WFS version of the server. If unknown, press the Detect button to automatically retrieve
it.

• Define the maximum number of features retrieved in a single GetFetFeature request. If empty, no limit
is set.

• Invert axis orientation.
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Figure 17.4: Creating a connection to a WFS server
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• And depending on the WFS version:

– Force to Ignore axis orientation (WFS 1.1/WFS 2.0)

– Enable feature paging and specify the maximum number of features to retrieve with Page size. If
no limit is defined, then the server default is applied.

Avertissement: Entering username and password in the Authentication tab will keep unprotected
credentials in the connection configuration. Those credentials will be visible if, for instance, you shared
the project file with someone. Therefore, it’s advisable to save your credentials in an Authentication
configuration instead (Configurations tab). See Système d’authentification for more details.

7. Press OK to create the connection.

Il est à noter que tous paramètres de proxy que vous auriez renseignés dans vos options sont également reconnus.

Now we are ready to load WFS layers from the above connection.

1. Choose “Gateway Geomatics” from the Server Connections drop-down list.

2. Click Connect

3. Select the Parks layer in the list

4. You can also choose whether to:

• Use title for layer name, showing the layer’s title as defined on the server in the Layers panel
instead of its Name

• Only request features overlapping the view extent

• Change the layer’s CRS

• or Build query to specify particular features to retrieve, by either using the corresponding button or
double-clicking the target layer.

5. Click Add to add the layer to the map.

You’ll notice the download progress is visualized in the lower left of the QGIS main window. Once the layer is
loaded, you can identify and select a couple of features and view the attribute table.

Note: QGIS supports different versions of the WFS protocol, with background download and progressive ren-
dering, on-disk caching of downloaded features and version autodetection.

Astuce: Trouver des serveurs WFS

Vous trouverez d’autres serveurs WFS en cherchant dans votre moteur de recherche favori. Il existe de nombreuses
listes d’URL publiques, plus ou moins à jour.

17.2 QGIS comme serveur de données OGC

QGIS Server est une implémentation open source WMS 1.3, WFS 1.0.0, WFS 1.1.0 et WCS 1.1.1, qui en plus,
propose des fonctionnalités cartographiques avancées pour le rendu thématique. QGIS Server est une application
FastCGI/CGI (Common Gateway Interface) écrite en C++ qui fonctionne avec un serveur web (tel que Apache,
Lighttpd). Il dispose d’une extension Python qui autorise un développement rapide et efficace et un déploiement
de nouvelles fonctionnalités. Il a été financé au départ par les projets de l’UE Orchestra, Sany et la ville d’Uster
en Suisse.
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Figure 17.5: Ajout d’une couche WFS
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QGIS Server utilise QGIS comme backend pour la logique des couches SIG et le rendu cartographique. La
bibliothèque Qt est utilisée pour l’interface et la programmation multiplateforme en C++. À la différence des
autres serveurs WMS, le Serveur QGIS utilise les règles de cartographie comme langage de configuration, à la
fois pour la configuration du serveur et pour les règles cartographiques définie par l’utilisateur.

Etant donné que QGIS Desktop et QGIS Server utilisent les mêmes bibliothèques de visualisation, les cartes
publiées sur le web ont le même aspect que sous le SIG Desktop.

Dans les sections qui suivent vous trouverez les instructions d’installation de QGIS Server sur Linux De-
bian/Ubuntu. Pour des instructions plus détaillées sur d’autres plateformes ou distributions et sur plus
d’informations sur QGIS Server, nous vous recommandons la lecture du manuel d’exercice sous QGIS Server
ou server_plugins.

17.2.1 Premiers Pas

Installation sur systèmes Debian

A ce stade, nous donnerons une courte et simple procédure d’installation pour une configuration de travail min-
imale sur système Debian . De nombreuses autres distributions et OS proposent aussi des paquets pour QGIS
Server.

La configuration et les étapes pour installer QGIS Server sur un système basé sur Debian sont fournies dans la
page installateurs QGIS. Veuillez vous référer à cette page.

Configuration d’un serveur HTTP

Apache

Apache and its mod_fcgid module may be used for executing QGIS Server.

Install Apache and mod_fcgid:

sudo apt install apache2 libapache2-mod-fcgid

Here we assume that an Apache VirtualHost is already set up. For example this is what a basic
VirtualHost configuration may look like:

<VirtualHost *:80>

ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/error.log
CustomLog ${APACHE_LOG_DIR}/access.log combined

</VirtualHost>

Note: On Debian systems, a default VirtualHost is available in /etc/apache2/sites-available/
000-default.conf.

Let’s now add mod_fcgid configuration directives for QGIS Server:

<VirtualHost *:80>

ServerAdmin webmaster@localhost
DocumentRoot /var/www/html

ErrorLog ${APACHE_LOG_DIR}/error.log
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CustomLog ${APACHE_LOG_DIR}/access.log combined

FcgidInitialEnv DISPLAY ":99"
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL "0"
FcgidInitialEnv QGIS_SERVER_LOG_STDERR "1"

<Location /qgisserver>
SetHandler fcgid-script
FcgidWrapper /usr/lib/cgi-bin/qgis_mapserv.fcgi virtual
Options +ExecCGI -MultiViews +FollowSymLinks
Require all granted

</Location>

</VirtualHost>

See the mod_fcgid documentation for more information on the Fcgid parameters used. And see below to
understand when and why the DISPLAY environment variable needs to be set.

Now restart Apache for the new configuration to be taken into account:

sudo service apache2 restart

QGIS Server est maintenant disponible sur http://localhost/qgisserver.

NGINX

Vous pouvez également utiliser QGIS Server avec NGINX. Contrairement à Apache, NGINX ne génère pas au-
tomatiquement des processus FastCGI. Les processus FastCGI doivent être démarrés autrement.

Sur les systèmes basés sur Debian, vous pouvez utiliser fcgiwrap ou spawn-fcgi pour démarrer et gérer les
processus QGIS Server. Les paquets Debian officiels existent pour les deux.

Note: fcgiwrap est plus facile à configurer que spawn-fcgi, car il est déjà intégré dans un service Systemd. Mais
cela conduit aussi à une solution beaucoup plus lente que l’utilisation de spawn-fcgi. Avec fcgiwrap, un nouveau
processus QGIS Server est créé à chaque requête, ce qui signifie que le processus d’initialisation de QGIS Server,
qui inclut la lecture et l’analyse du fichier projet QGIS, est effectué sur chaque requête. Avec spawn-fcgi, le
processus QGIS Server est conservé entre les requêtes, ce qui se traduit par de bien meilleures performances.
Pour cette raison, le spawn-fcgi est recommandé pour une utilisation en production.

Install NGINX:

sudo apt install nginx

fcgiwrap

Si vous voulez utiliser fcgiwrap pour exécuter QGIS Server, vous devez d’abord installer le paquet correspondant
:

sudo apt install fcgiwrap

Ensuite, introduisez le bloc suivant dans votre configuration de serveur NGINX :

1 location /qgisserver {
2 gzip off;
3 include fastcgi_params;
4 fastcgi_pass unix:/var/run/fcgiwrap.socket;
5 fastcgi_param SCRIPT_FILENAME /usr/lib/cgi-bin/qgis_mapserv.fcgi;
6 }
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Enfin, redémarrez NGINX et fcgiwrap pour prendre en compte la nouvelle configuration :

sudo service nginx restart
sudo service fcgiwrap restart

QGIS Server est maintenant disponible sur http://localhost/qgisserver.

spawn-fcgi

Si vous préférez utiliser spawn-fcgi au lieu de fcgiwrap, la première étape consiste à installer le paquet :

sudo apt install spawn-fcgi

Ensuite, introduisez le bloc suivant dans votre configuration de serveur NGINX :

location /qgisserver {
gzip off;
include fastcgi_params;
fastcgi_pass unix:/var/run/qgisserver.socket;

}

Et redémarrez NGINX pour prendre en compte la nouvelle configuration :

sudo service nginx restart

Enfin, étant donné qu’il n’y a pas de fichier de service par défaut pour spawn-fcgi, vous devez démarrer manuelle-
ment QGIS Server dans votre terminal :

sudo spawn-fcgi -s /var/run/qgisserver.socket \
-U www-data -G www-data -n \
/usr/lib/bin/cgi-bin/qgis_mapserv.fcgi

Bien sûr, vous pouvez écrire un script d’initialisation (comme un fichier ‘‘qgisserver.service‘‘avec Systemd) pour
lancer QGIS Server au démarrage ou quand vous voulez.

QGIS Server est maintenant disponible sur http://localhost/qgisserver.

Note: Avec la commande ci-dessus, spawn-fcgi ne génère qu’un seul processus QGIS Server. Pour utiliser
plus d’un processus QGIS Server, vous pouvez combiner spawn-fcgi avec l’outil multiwatch, qui est également
empaqueté dans Debian.

Configuration

La ligne include fastcgi_params; utilisée dans la configuration précédente est importante car elle ajoute les
paramètres de /etc/nginx/fastcgi_params :

fastcgi_param QUERY_STRING $query_string;
fastcgi_param REQUEST_METHOD $request_method;
fastcgi_param CONTENT_TYPE $content_type;
fastcgi_param CONTENT_LENGTH $content_length;

fastcgi_param SCRIPT_NAME $fastcgi_script_name;
fastcgi_param REQUEST_URI $request_uri;
fastcgi_param DOCUMENT_URI $document_uri;
fastcgi_param DOCUMENT_ROOT $document_root;
fastcgi_param SERVER_PROTOCOL $server_protocol;
fastcgi_param REQUEST_SCHEME $scheme;
fastcgi_param HTTPS $https if_not_empty;
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fastcgi_param GATEWAY_INTERFACE CGI/1.1;
fastcgi_param SERVER_SOFTWARE nginx/$nginx_version;

fastcgi_param REMOTE_ADDR $remote_addr;
fastcgi_param REMOTE_PORT $remote_port;
fastcgi_param SERVER_ADDR $server_addr;
fastcgi_param SERVER_PORT $server_port;
fastcgi_param SERVER_NAME $server_name;

# PHP only, required if PHP was built with --enable-force-cgi-redirect
fastcgi_param REDIRECT_STATUS 200;

Vous pouvez bien sûr, remplacer ces variables dans votre propre configuration. Par exemple :

include fastcgi_params;
fastcgi_param SERVER_NAME domain.name.eu;

De plus, vous pouvez utiliser certains Variables d’environnement pour configurer QGIS Server. Avec NGINX
comme serveur HTTP, vous devez utiliser fastcgi_param pour définir ces variables comme indiqué ci-dessous
:

fastcgi_param QGIS_DEBUG 1;
fastcgi_param QGIS_SERVER_LOG_FILE /tmp/qgis-000.log;
fastcgi_param QGIS_SERVER_LOG_LEVEL 0;

Note: Lors de l’utilisation de spawn-fcgi, vous pouvez définir directement les variables d’environnement avant
d’exécuter le serveur. Par exemple : `exporter QGIS_SERVER_LOG_LOG_FILE=/home/user/qgis.
log`.

Xvfb

QGIS Server needs a running X Server to be fully usable. But if you don’t have one, you may use xvfb to have a
virtual X environment.

To install the package:

sudo apt install xvfb

Then, according to your HTTP server, you should configure the DISPLAY parameter or directly use xvfb-run.

For example with NGINX and spawn-fcgi using xvfb-run:

xvfb-run /usr/bin/spawn-fcgi -f /usr/lib/bin/cgi-bin/qgis_mapserv.fcgi \
-s /tmp/qgisserver.socket \
-G www-data -U www-data -n

The other option is to start a virtual X server environment with a specific display number thanks to Xvfb:

/usr/bin/Xvfb :99 -screen 0 1024x768x24 -ac +extension GLX +render -noreset

Then we just have to set the DISPLAY environment variable in the HTTP server configuration. For example with
NGINX:

fastcgi_param DISPLAY ":99";

Or with Apache:
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FcgidInitialEnv DISPLAY ":99"

Installation on Windows

QGIS Server can also be installed on Windows systems. While the QGIS Server package is available in the 64 bit
version of the OSGeo4W network installer (https://qgis.org/en/site/forusers/download.html) there is no Apache
(or other web server) package available, so this must be installed by other means.

A simple procedure is the following:

• Download the XAMPP installer (https://www.apachefriends.org/download.html) for Windows and install
Apache

• Download the OSGeo4W installer, follow the « Advanced Install » and install both the QGIS Desktop and
QGIS Server packages

• Edit the httpd.conf file (C:\xampp\apache\httpd.conf if the default installation paths have been
used) and make the following changes:

From:

ScriptAlias /cgi-bin/ "C:/xampp/cgi-bin/"

To:

ScriptAlias /cgi-bin/ "c:/OSGeo4W64/apps/qgis/bin/"

From:

<Directory "C:/xampp/cgi-bin">
AllowOverride None
Options None
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Require all granted
</Directory>

To:

<Directory "c:/OSGeo4W64/apps/qgis/bin">
SetHandler cgi-script
AllowOverride None
Options ExecCGI
Order allow,deny
Allow from all
Require all granted
</Directory>

From:

AddHandler cgi-script .cgi .pl .asp

To:

AddHandler cgi-script .cgi .pl .asp .exe

Then at the bottom of httpd.conf add:

SetEnv GDAL_DATA "C:\OSGeo4W64\share\gdal"
SetEnv QGIS_AUTH_DB_DIR_PATH "C:\OSGeo4W64\apps\qgis\resources"
SetEnv PYTHONHOME "C:\OSGeo4W64\apps\Python36"
SetEnv PATH "C:\OSGeo4W64\bin;C:\OSGeo4W64\apps\qgis\bin;C:\OSGeo4W64\apps\Qt5\bin;
→˓C:\WINDOWS\system32;C:\WINDOWS;C:\WINDOWS\System32\Wbem"
SetEnv QGIS_PREFIX_PATH "C:\OSGeo4W64\apps\qgis"
SetEnv QT_PLUGIN_PATH "C:\OSGeo4W64\apps\qgis\qtplugins;
→˓C:\OSGeo4W64\apps\Qt5\plugins"

Restart the Apache web server from the XAMPP Control Panel and open browser window to testing a GetCapa-
bilities request to QGIS Server

http://localhost/cgi-bin/qgis_mapserv.fcgi.exe?SERVICE=WMS&VERSION=1.3.0&REQUEST=
GetCapabilities
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Serve a project

Now that QGIS Server is installed and running, we just have to use it.

Obviously, we need a QGIS project to work on. Of course, you can fully customize your project by defining
contact information, precise some restrictions on CRS or even exclude some layers. Everything you need to know
about that is described later in Configure your project.

But for now, we are going to use a simple project already configured. To retrieve the project:

cd /home/user/
wget https://github.com/qgis/QGIS-Training-Data/archive/QGIS-Training-Data-v2.0.
→˓zip -O qgis-server-tutorial.zip
unzip qgis-server-tutorial.zip
mv QGIS-Training-Data-QGIS-Training-Data-v2.0/training_manual_data/qgis-server-
→˓tutorial-data ~

The project file is qgis-server-tutorial-data-master/world.qgs. Of course, you can use your
favorite GIS software to open this file and take a look on the configuration and available layers.

By opening the project and taking a quick look on layers, we know that 4 layers are currently available:

• airports

• places

• countries

• countries_shapeburst

You don’t have to understand the full request for now but you may retrieve a map with some of the previous layers
thanks to QGIS Server by doing something like this in your web browser to retrieve the countries layer:

http://localhost/qgisserver?
MAP=/home/user/qgis-server-tutorial-data-master/world.qgs&
LAYERS=countries&
SERVICE=WMS&
REQUEST=GetMap&
CRS=EPSG:4326&
WIDTH=400&
HEIGHT=200

If you obtain the next image, then QGIS Server is running correctly:

Figure 17.6: Server response to a basic GetMap request

Note that you may define PROJECT_FILE environment variable to use a project by default instead of giving a
MAP parameter (see Variables d’environnement).

For example with spawn-fcgi:

428 Chapter 17. Les données OGC



QGIS User Guide, Version 3.4

export PROJECT_FILE=/home/user/qgis-server-tutorial-data-master/world.qgs
spawn-fcgi -f /usr/lib/bin/cgi-bin/qgis_mapserv.fcgi \

-s /var/run/qgisserver.socket \
-U www-data -G www-data -n

Configure your project

To provide a new QGIS Server WMS, WFS or WCS, you have to create a QGIS project file with some data or use
one of your current project. Define the colors and styles of the layers in QGIS and the project CRS, if not already
defined.

Figure 17.7: Définitions pour un projet WMS/WFS/WCS de QGIS Server

Then, go to the QGIS Server menu of the Project → Properties. . . dialog and provide some information about
the OWS in the fields under Service Capabilities. This will appear in the GetCapabilities response of the WMS,

WFS or WCS. If you don’t check Service capabilities, QGIS Server will use the information given in the
wms_metadata.xml file located in the cgi-bin folder.
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Capacités WMS

In the WMS capabilities section, you can define the extent advertised in the WMS GetCapabilities response by
entering the minimum and maximum X and Y values in the fields under Advertised extent. Clicking Use Current

Canvas Extent sets these values to the extent currently displayed in the QGIS map canvas. By checking CRS
restrictions, you can restrict in which coordinate reference systems (CRS) QGIS Server will offer to render maps.
It is recommended that you restrict the offered CRS as this reduces the size of the WMS GetCapabilities response.

Use the button below to select those CRSs from the Coordinate Reference System Selector, or click Used to
add the CRSs used in the QGIS project to the list.

If you have print layouts defined in your project, they will be listed in the GetProjectSettings response, and they
can be used by the GetPrint request to create prints, using one of the print layout layouts as a template. This is
a QGIS-specific extension to the WMS 1.3.0 specification. If you want to exclude any print layout from being

published by the WMS, check Exclude layouts and click the button below. Then, select a print layout
from the Select print layout dialog in order to add it to the excluded layouts list.

If you want to exclude any layer or layer group from being published by the WMS, check Exclude Layers

and click the button below. This opens the Select restricted layers and groups dialog, which allows you to
choose the layers and groups that you don’t want to be published. Use the Shift or Ctrl key if you want to
select multiple entries. It is recommended that you exclude from publishing the layers that you don’t need as this
reduces the size of the WMS GetCapabilities response which leads to faster loading times on the client side.

Vous pouvez recevoir la réponse GetFeatureInfo en texte simple, XML et GML. Le format par défaut est le XML.
Le texte simple et le GML dépendent du format de sortie choisi lors de la requête GetFeatureInfo.

If you wish, you can check Add geometry to feature response. This will include in the GetFeatureInfo response
the geometries of the features in a text format.

As many web clients can’t display circular arcs in geometries you have the option to segmentize the geometry
before sending it to the client in a GetFeatureInfo response. This allows such clients to still display a feature’s

geometry (e.g. for highlighting the feature). You need to check the Segmentize feature info geometry to activate
the option.

You can also use the GetFeatureInfo geometry precision option to set the precision of the GetFeatureInfo geometry.
This enables you to save bandwidth when you don’t need the full precision.

If you want QGIS Server to advertise specific request URLs in the WMS GetCapabilities response, enter the
corresponding URL in the Advertised URL field.

Furthermore, you can restrict the maximum size of the maps returned by the GetMap request by entering the
maximum width and height into the respective fields under Maximums for GetMap request.

Si une de vos couches utilise l’affichage d’indication de carte <maptips>‘(pour afficher du texte issu
d’expressions), cette dernière sera listée au sein de la sortie GetFeatureInfo. Si la couche utilise une Valeur
Relationnelle pour un de ses attributs, cette information sera également renvoyée par la sortie de GetFeatureInfo.

Capacités WFS

Dans la partie Capacités WFS, vous pouvez sélectionner les couches qui vous voulez publier en WFS et indiquer
si elle permettent les opérations de mise à jour, d’insertion et de suppression. Si vous ajoutez une URL dans
le champ URL publiée des Capacités WFS, QGIS Server annoncera cette URL spécifique dans la réponse WFS
GetCapabilities.

Capacités WMS

Dans la partie Capacités WCS, vous pouvez sélectionner les couches qui vous voulez publier en WCS. Si vous
indiquez une URL dans le champ URL publiée de la section Capacités WCS, QGIS Server annoncera cette URL
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spécifique dans la réponse WCS GetCapabilities.

Bien configurer votre OWS

Pour les couches vectorielles, le menu Champs de la fenêtre Couche → Propriétés vous permet de définir quels
attributs seront publiés. Par défaut, tous les attributs sont publiés par votre WMS et WFS. Si vous souhaitez ne
pas publier un attribut donné, décochez la case correspondante sous la colonne WMS ou WFS.

You can overlay watermarks over the maps produced by your WMS by adding text annotations or SVG annotations
to the project file. See the Outils d’annotation section for instructions on creating annotations. For annotations to
be displayed as watermarks on the WMS output, the Fixed map position checkbox in the Annotation text dialog
must be unchecked. This can be accessed by double clicking the annotation while one of the annotation tools is
active. For SVG annotations, you will need either to set the project to save absolute paths (in the General menu of
the Project → Properties. . . dialog) or to manually modify the path to the SVG image so that it represents a valid
relative path.

17.2.2 Services

QGIS Server is able to serve data according to standard protocols as described by the Open Geospatial Consor-
tium (OGC):

• WMS 1.1.0 et 1.3.0

• WFS 1.0.0 et 1.1.0

• WCS 1.1.1

• WMTS 1.0.0

Extra vendor parameters and requests are supported in addition to the original standard that greatly enhance the
possibilities of customizing its behavior thanks to the QGIS rendering engine.

Web Map Service (WMS)

The 1.1.0 and 1.3.0 WMS standards implemented in QGIS Server provide a HTTP interface to request map or
legend images generated from a QGIS project. A typical WMS request defines the QGIS project to use, the layers
to render as well as the image format to generate. Basic support is also available for the Styled Layer Descriptor
(SLD) standard.

Specifications document according to the version number of the service:

• WMS 1.1.0

• WMS 1.3.0

Requêtes standard fournies par QGIS Server:

Requête Description
GetCapabilities Return XML metadata with information about the server
GetMap Renvoie une carte
GetFeatureInfo Retrieves data (geometry and values) for a pixel location
GetLegendGraphics Renvoie les symboles de légende

Vendor requests provided by QGIS Server:
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Requête Description
GetPrint Returns a QGIS composition
GetProjectSettings Returns specific information about QGIS Server

GetMap

Standard parameters for the GetMap request according to the OGC WMS 1.1.0 and 1.3.0 specifications:

Paramètre Requis Description
SERVICE Oui Nom du service (WMS)
VERSION Non Version du service
REQUEST Oui Nom de la requête (GetMap)
LAYERS Non Couches à afficher
STYLES Non Style des couches
SRS / CRS Oui Système de coordonnées de référence
BBOX Non Emprise de la carte
WIDTH Oui Largeur de l’image en pixels
HEIGHT Oui Hauteur de l’image en pixels
FORMAT Non Format de l’image
TRANSPARENT Non Arrière-plan transparent

Outre les paramètres standard, QGIS prend en charge les paramètres suivants :
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Paramètre Requis Description
MAP Oui Specify the QGIS project file
BGCOLOR Non Specify the background color
DPI Non Specify the output resolution
IMAGE_QUALITY Non JPEG compression
OPACITIES Non Opacity for layer or group
FILTER Non Subset of features
SELECTION Non Highlight features
FILE_NAME Non Seulement pour

FORMAT=application/dxf
Nom du fichier téléchargé

FORMAT_OPTIONS Non Seulement pour
FORMAT=application/dxf
key:value pairs separated by semi-
colon.

• SCALE: to be used for
symbology rules, filters and
styles (not actual scaling of
the data - data remains in the
original scale).

•
MODE:NOSYMBOLOGY|FEATURESYMBOLOGY|SYMBOLLAYERSYMBOLOGY:
corresponds to the three ex-
port options offered in the
QGIS Desktop DXF export
dialog.

•
LAYERSATTRIBUTES:yourcolumn_with_values_to_be_used_for_dxf_layernames
if not specified, the original
QGIS layer names are used.

•
USE_TITLE_AS_LAYERNAME:
if enabled, the title of the
layer will be used as layer
name.

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&MAP=/home/user/project.qgs
&LAYERS=mylayer1,mylayer2,mylayer3
&STYLES=style1,default,style3
&OPACITIES=125,200,125
&CRS=EPSG:4326
&WIDTH=400
&HEIGHT=400
&FORMAT=image/png
&TRANSPARENT=TRUE
&DPI=300
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SERVICE

Ce paramètre doit être WMS en cas de requête GetMap.

VERSION

This parameter allows to specify the version of the service to use. Available values for the VERSION parameter
are:

• 1.1.0

• 1.3.0

Si aucune version n’est indiquée dans la requête, alors 1.3.0 est utilisée par défaut.

According to the version number, slight differences have to be expected as explained later for the next parameters:

• CRS / SRS

• BBOX

REQUEST

Ce paramètre est GetMap en cas de requête GetMap.

LAYERS

This parameter allows to specify the layers to display on the map. Names have to be separated by a comma.

In addition, QGIS Server introduced some options to select layers by:

• a short name

• the layer id

The short name of a layer may be configured through Properties → Metadata in layer menu. If the short name is
defined, then it’s used by default instead of the layer’s name:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mynickname1,mynickname2
&...

Moreover, there’s a project option allowing to select layers by their id in OWS Server → WMS capabilities menu
of the Project → Properties. . . dialog. To activate this option, the checkbox Use layer ids as names has to be
selected.

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mylayerid1,mylayerid2
&...

STYLES

This parameter can be used to specify a layer’s style for the rendering step. Styles have to be separated by a
comma. The name of the default style is default.
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SRS / CRS

This parameter allows to indicate the map output Spatial Reference System in WMS 1.1.0 and has to be formed
like EPSG:XXXX. Note that CRS is also supported if current version is 1.1.0.

For WMS 1.3.0, CRS parameter is preferable but SRS is also supported.

Note that if both CRS and SRS parameters are indicated in the request, then it’s the current version indicated in
VERSION parameter which is decisive.

In the next case, the SRS parameter is kept whatever the VERSION parameter because CRS is not indicated:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&SRS=EPSG:2854
&...

In the next case, the SRS parameter is kept instead of CRS because of the VERSION parameter:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.1.0
&CRS=EPSG:4326
&SRS=EPSG:2854
&...

In the next case, the CRS parameter is kept instead of SRS because of the VERSION parameter:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&CRS=EPSG:4326
&SRS=EPSG:2854
&...

BBOX

This parameter allows to specify the map extent with units according to the current CRS. Coordinates have to be
separated by a comma.

However, a slight difference has to be noticed according to the current VERSION parameter. Actually, in WMS
1.1.0, coordinates are formed like minx,miny,maxx,maxy or minlong,minlat,maxlong,maxlat.
For example:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.1.0
&SRS=epsg:4326
&BBOX=-180,-90,180,90
&...

But the axis is reversed in WMS 1.3.0, so coordinates are formed like: miny,minx,maxy,maxx or minlat,
minlong,maxlat,maxlong. For example:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
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&VERSION=1.3.0
&CRS=epsg:4326
&BBOX=-90,-180,90,180
&...

WIDTH

This parameter allows to specify the width in pixels of the output image.

HEIGHT

This parameter allows to specify the height in pixels of the output image.

FORMAT

This parameter may be used to specify the format of map image. Available values are:

• jpg

• jpeg

• image/jpeg

• image/png

• image/png; mode=1bit

• image/png; mode=8bit

• image/png; mode=16bit

• application/dxfOnly layers that have read access in the WFS service are exported in the DXF format.

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WMS&VERSION=1.3.0
&REQUEST=GetMap
&FORMAT=application/dxf
&LAYERS=Haltungen,Normschacht,Spezialbauwerke
&STYLES=
&CRS=EPSG%3A21781&BBOX=696136.28844801,245797.12108743,696318.91114315,245939.
→˓25832905
&WIDTH=1042
&HEIGHT=811
&FORMAT_OPTIONS=MODE:SYMBOLLAYERSYMBOLOGY;SCALE:250&FILE_NAME=plan.dxf

TRANSPARENT

This boolean parameter can be used to specify the background transparency. Available values are (not case sensi-
tive):

• TRUE

• FALSE

However, this parameter is ignored if the format of the map image indicated with FORMAT is different from PNG.
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MAP

This parameter allows to define the QGIS project file to use.

As mentioned in GetMap parameters table, MAP is mandatory because a request needs a QGIS project to actu-
ally work. However, the QGIS_PROJECT_FILE environment variable may be used to define a default QGIS
project. In this specific case, MAP is not longer a required parameter. For further information you may refer to
Configuration avancée.

BGCOLOR

This parameter allows to indicate a background color for the map image. However it cannot be combined with
TRANSPARENT parameter in case of PNG images (transparency takes priority). The colour may be literal or in
hexadecimal notation.

URL example with the literal notation:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&BGCOLOR=green
&...

URL example with the hexadecimal notation:

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&VERSION=1.3.0
&BGCOLOR=0x00FF00
&...

DPI

This parameter can be used to specify the requested output resolution.

IMAGE_QUALITY

This parameter is only used for JPEG images. By default, the JPEG compression is -1.

You can change the default per QGIS project in the OWS Server → WMS capabilities menu of the Project →
Properties. . . dialog. If you want to override it in a GetMap request you can do it using the IMAGE_QUALITY
parameter.

OPACITIES

Opacity can be set on layer or group level. Allowed values range from 0 (fully transparent) to 255 (fully opaque).

FILTER

A subset of layers can be selected with the FILTER parameter. Syntax is basically the same as for the QGIS
subset string. However, there are some restrictions to avoid SQL injections into databases via QGIS Server. If a
dangerous string is found in the parameter, QGIS Server will return the next error:
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Indeed, text strings need to be enclosed with quotes (single quotes for strings,
→˓double quotes for attributes). A space between each word / special character is
→˓mandatory. Allowed Keywords and special characters are 'AND','OR','IN','=','<','>
→˓=','>','>=','!=*,'(',')'. Semicolons in string expressions are not allowed

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mylayer1,mylayer2
&FILTER=mylayer1:"OBJECTID" = 3;mylayer2:'text' = 'blabla'
&...

Note: It is possible to make attribute searches via GetFeatureInfo and omit the X/Y parameter if a FILTER is
there. QGIS Server then returns info about the matching features and generates a combined bounding box in the
xml output.

SELECTION

The SELECTION parameter can highlight features from one or more layers. Vector features can be selected by
passing comma separated lists with feature ids.

http://localhost/qgis_server?
SERVICE=WMS
&REQUEST=GetMap
&LAYERS=mylayer1,mylayer2
&SELECTION=mylayer1:3,6,9;mylayer2:1,5,6
&...

The following image presents the response from a GetMap request using the SELECTION option e.g. http://
myserver.com/...&SELECTION=countries:171,65.

As those features id’s correspond in the source dataset to France and Romania they’re highlighted in yellow.

GetFeatureInfo

Standard parameters for the GetFeatureInfo request according to the OGC WMS 1.1.0 and 1.3.0 specifications:
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Figure 17.8: Server response to a GetMap request with SELECTION parameter
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Paramètre Requis Description
SERVICE Oui Nom du service (WMS)
VERSION Non See GetMap
REQUEST Oui See GetMap
LAYERS Non See GetMap
STYLES Non See GetMap
SRS / CRS Oui See GetMap
BBOX Non See GetMap
WIDTH Oui See GetMap
HEIGHT Oui See GetMap
TRANSPARENT Non See GetMap
INFO_FORMAT Non Output format
QUERY_LAYERS Oui Layers to query
FEATURE_COUNT Non Nombre maximum d’entités à renvoyer
I Non Pixel column of the point to query
X Non Same as I parameter, but in WMS 1.1.0
J Non Pixel row of the point to query
Y Non Same as J parameter, but in WMS 1.1.0

Outre les paramètres standard, QGIS prend en charge les paramètres suivants :

Paramètre Requis Description
MAP Oui See GetMap
FILTER Non See GetMap
FI_POINT_TOLERANCE Non Tolerance in pixels for point layers
FI_LINE_TOLERANCE Non Tolerance in pixels for line layers
FI_POLYGON_TOLERANCE Non Tolerance in pixels for polygon layers
FILTER_GEOM Non Geometry filtering
WITH_MAPTIP Non Add map tips to the output
WITH_GEOMETRY Non Add geometry to the output

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&MAP=/home/user/project.qgs
&LAYERS=mylayer1,mylayer2,mylayer3
&CRS=EPSG:4326
&WIDTH=400
&HEIGHT=400
&INFO_FORMAT=text/xml
&TRANSPARENT=TRUE
&QUERY_LAYERS=mylayer1
&FEATURE_COUNT=3
&I=250
&J=250
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INFO_FORMAT

This parameter may be used to specify the format of the result. Available values are:

• text/xml

• text/html

• text/plain

• application/vnd.ogc.gml

• application/json

QUERY_LAYERS

This parameter specifies the layers to display on the map. Names are separated by a comma.

In addition, QGIS Server introduces options to select layers by:

• short name

• layer id

See the LAYERS parameter defined in See GetMap for more information.

FEATURE_COUNT

This parameter specifies the maximum number of features per layer to return. For example if QUERY_LAYERS
is set to layer1,layer2 and FEATURE_COUNT is set to 3 then a maximum of 3 features from layer1 will be
returned. Likewise a maximun of 3 features from layer2 will be returned.

By default, only 1 feature per layer is returned.

I

This parameter, defined in WMS 1.3.0, allows you to specify the pixel column of the query point.

X

Same parameter as I, but defined in WMS 1.1.0.

J

This parameter, defined in WMS 1.3.0, allows you to specify the pixel row of the query point.

Y

Same parameter as J, but defined in WMS 1.1.0.

FI_POINT_TOLERANCE

This parameter specifies the tolerance in pixels for point layers.
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FI_LINE_TOLERANCE

This parameter specifies the tolerance in pixels for line layers.

FI_POLYGON_TOLERANCE

This parameter specifies the tolerance in pixels for polygon layers.

FILTER_GEOM

This parameter specifies a WKT geometry with which features have to intersect.

WITH_MAPTIP

This parameter specifies whether to add map tips to the output.

Available values are (not case sensitive):

• TRUE

• FALSE

WITH_GEOMETRY

This parameter specifies whether to add geometries to the output.

Available values are (not case sensitive):

• TRUE

• FALSE

GetPrint

QGIS Server has the capability to create print layout output in pdf or pixel format. Print layout windows in the
published project are used as templates. In the GetPrint request, the client has the possibility to specify parameters
of the contained layout maps and labels.

Parameters for the GetPrint request:
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Paramètre Requis Description
MAP Oui Specify the QGIS project file
SERVICE Oui Nom du service (WMS)
VERSION Non See GetMap
REQUEST Oui Name of the request (GetPrint)
LAYERS Non See GetMap
TEMPLATE Oui Layout template to use
SRS / CRS Oui See GetMap
FORMAT Oui Output format
STYLES Non See GetMap
TRANSPARENT Non See GetMap
OPACITIES Non See GetMap
SELECTION Non See GetMap
mapX:EXTENT Non Extent of the map “X”
mapX:LAYERS Non Layers of the map “X”
mapX:STYLES Non Layers” style of the map “X”
mapX:SCALE Non Layers” scale of the map “X”
mapX:ROTATION Non Rotation of the map “X”
mapX:GRID_INTERVAL_X Non Grid interval on x axis of the map “X”
mapX:GRID_INTERVAL_Y Non Grid interval on y axis of the map “X”

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetPrint
&MAP=/home/user/project.qgs
&CRS=EPSG:4326
&FORMAT=png
&map0:EXTENT=-180,-90,180,90
&map0:LAYERS=mylayer1,mylayer2,mylayer3
&map0:OPACITIES=125,200,125
&map0:ROTATION=45

Note that the layout template may contain more than one map. In this way, if you want to configure a specific
map, you have to use mapX: parameters where X is a positive number that you can retrieve thanks to the GetPro-
jectSettings request.

For example:

<WMS_Capabilities>
...
<ComposerTemplates xsi:type="wms:_ExtendedCapabilities">
<ComposerTemplate width="297" height="210" name="Druckzusammenstellung 1">
<ComposerMap width="171" height="133" name="map0"/>
<ComposerMap width="49" height="46" name="map1"/></ComposerTemplate>
</ComposerTemplates>
...
</WMS_Capabilities>

SERVICE

This parameter has to be WMS.
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REQUEST

This parameter has to be GetPrint for the GetPrint request.

TEMPLATE

This parameter can be used to specify the name of a layout template to use for printing.

FORMAT

This parameter specifies the format of map image. Available values are:

• jpg

• jpeg

• image/jpeg

• png

• image/png

• svg

• image/svg

• image/svg+xml

• pdf

• application/pdf

If the FORMAT parameter is different from one of these values, then an exception is returned.

mapX:EXTENT

This parameter specifies the extent for a layout map item as xmin,ymin,xmax,ymax.

mapX:ROTATION

This parameter specifies the map rotation in degrees.

mapX:GRID_INTERVAL_X

This parameter specifies the grid line density in the X direction.

mapX:GRID_INTERVAL_Y

This parameter specifies the grid line density in the Y direction.

mapX:SCALE

This parameter specifies the map scale for a layout map item. This is useful to ensure scale based visibility of
layers and labels even if client and server may have different algorithms to calculate the scale denominator.
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mapX:LAYERS

This parameter specifies the layers for a layout map item. See See GetMap for more information on this parameter.

mapX:STYLES

This parameter specifies the layers” styles defined in a specific layout map item. See See GetMap for more
information on this parameter.

GetLegendGraphics

Several additional parameters are available to change the size of the legend elements:

• BOXSPACE space between legend frame and content (mm)

• LAYERSPACE vertical space between layers (mm)

• LAYERTITLESPACE vertical space between layer title and items following (mm)

• SYMBOLSPACE vertical space between symbol and item following (mm)

• ICONLABELSPACE horizontal space between symbol and label text (mm)

• SYMBOLWIDTH width of the symbol preview (mm)

• SYMBOLHEIGHT height of the symbol preview (mm)

These parameters change the font properties for layer titles and item labels:

• LAYERFONTFAMILY / ITEMFONTFAMILY font family for layer title / item text

• LAYERFONTBOLD / ITEMFONTBOLD TRUE to use a bold font

• LAYERFONTSIZE / ITEMFONTSIZE Font size in point

• LAYERFONTITALIC / ITEMFONTITALIC TRUE to use italic font

• LAYERFONTCOLOR / ITEMFONTCOLOR Hex color code (e.g. #FF0000 for red)

• LAYERTITLE / RULELABEL set them to FALSE to get only the legend graphics without labels

Content based legend. These parameters let the client request a legend showing only the symbols for the features
falling into the requested area:

• BBOX the geographical area for which the legend should be built

• CRS / SRS the coordinate reference system adopted to define the BBOX coordinates

• WIDTH / HEIGHT if set these should match those defined for the GetMap request, to let QGIS Server
scale symbols according to the map view image size.

Content based legend features are based on the UMN MapServer implementation:

• SHOWFEATURECOUNT if set to TRUE adds in the legend the feature count of the features like in the
following image:

17.2. QGIS comme serveur de données OGC 445

http://www.mapserver.org/development/rfc/ms-rfc-101.html


QGIS User Guide, Version 3.4

GetProjectSettings

This request type works similar to GetCapabilities, but it is more specific to QGIS Server and allows a client to
read additional information which is not available in the GetCapabilities output:

• visibilité initiale des couches

• information sur les attributs des vecteurs et leur type d’éditeur

• information sur l’ordre des couches et de leur rendu

• liste des couches publiées en WFS

Web Feature Service (WFS)

The 1.0.0 and 1.1.0 WFS standards implemented in QGIS Server provide a HTTP interface to query geographic
features from a QGIS project. A typical WFS request defines the QGIS project to use and the layer to query.

Specifications document according to the version number of the service:

• WFS 1.0.0

• WFS 1.1.0

Requêtes standard fournies par QGIS Server:

Requête Description
GetCapabilities Returns XML metadata with information about the server
GetFeature Returns a selection of features
DescribeFeatureType Returns a description of feature types and properties
Transaction Allows features to be inserted, updated or deleted

GetFeature

Standard parameters for the GetFeature request according to the OGC WFS 1.0.0 and 1.1.0 specifications:

Paramètre Requis Description
SERVICE Oui Nom du service
VERSION Non Version du service
REQUEST Oui Nom de la requête
TYPENAME Non Nom des couches
OUTPUTFORMAT Non Format de sortie
RESULTTYPE Non Type de résultat
PROPERTYNAME Non Nom des propriétés à renvoyer
MAXFEATURES Non Nombre maximum d’entités à renvoyer
SRSNAME Non Système de coordonnées de référence
FEATUREID Non Filtre les entités par leur identifiant
FILTER Non OGC Filter Encoding
BBOX Non Emprise de la carte
SORTBY Non Trie les résultats

Outre les paramètres standard, QGIS prend en charge les paramètres suivants :
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Paramètre Requis Description
MAP Oui Specify the QGIS project file
STARTINDEX Non Paging
GEOMETRYNAME Non Type de géométrie à renvoyer
EXP_FILTER Non Expression de filtrage

SERVICE

Ce paramètre doit être WFS en cas de requête GetFeature.

For example:

http://localhost/qgis_server?
SERVICE=WFS
&...

VERSION

This parameter allows to specify the version of the service to use. Available values for the VERSION parameter
are:

• 1.0.0

• 1.1.0

Si aucune version n’est indiquée dans la requête, alors 1.1.0 est utilisée par défaut.

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WFS
&VERSION=1.1.0
&...

REQUEST

Ce paramètre est GetFeature en cas de requête GetFeature.

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&...

RESULTTYPE

Ce paramètre peut être utilisé pour indiquer le genre de résultat attendu. Les valeurs possibles sont :

• results: le comportement par défaut

• hits: renvoie seulement le décompte des entités

Exemple d’URL :
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http://localhost/qgis_server?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&RESULTTYPE=hits
&...

GEOMETRYNAME

Ce paramètre peut être utilisé pour indiquer le type de géométrie attendu pour les entités. Les valeurs possibles
sont :

• extent

• centroid

• none

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&GEOMETRYNAME=centroid
&...

STARTINDEX

This parameter is standard in WFS 2.0, but it’s an extension for WFS 1.0.0. Actually, it can be used to skip some
features in the result set and in combination with MAXFEATURES, it provides the ability to page through results.

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WFS
&VERSION=1.1.0
&REQUEST=GetFeature
&STARTINDEX=2
&...

Web Map Tile Service (WMTS)

The 1.0.0 WMTS standard implemented in QGIS Server provides a HTTP interface to request tiled map images
generated from a QGIS project. A typical WMTS request defined the QGIS project to use, some WMS parameters
like layers to render, as well as tile parameters.

Specifications document of the service:

• WMTS 1.0.0

Requêtes standard fournies par QGIS Server:

Requête Description
GetCapabilities Returns XML metadata with information about the server
GetTile Renvoie une tuile
GetFeatureInfo Retrieves data (geometry and values) for a pixel location
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GetCapabilities

Standard parameters for the GetCapabilities request according to the OGC WMTS 1.0.0 specifications:

Paramètre Requis Description
SERVICE Oui Nom du service (WMTS)
REQUEST Oui Nom de la requête (GetCapabilities)

Outre les paramètres standard, QGIS prend en charge les paramètres suivants :

Paramètre Requis Description
MAP Oui Specify the QGIS project file

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetCapabilities
&MAP=/home/user/project.qgs

SERVICE

Ce paramètre doit être WMTS en cas de requête GetCapabilities.

REQUEST

Ce paramètre est GetCapabilities en cas de requête GetCapabilities.

MAP

This parameter allows to define the QGIS project file to use.

GetTile

Standard parameters for the GetTile request according to the OGC WMTS 1.0.0 specifications:

Paramètre Requis Description
SERVICE Oui Nom du service (WMTS)
REQUEST Oui Nom de la requête (GetTile)
LAYER Oui Identifiant de la couche
FORMAT Oui Format de sortie de la tuile
TILEMATRIXSET Oui Nom de la pyramide
TILEMATRIX Oui Meshing
TILEROW Oui Row coordinate in the mesh
TILECOL Oui Column coordinate in the mesh
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Outre les paramètres standard, QGIS prend en charge les paramètres suivants :

Paramètre Requis Description
MAP Oui Specify the QGIS project file

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetTile
&MAP=/home/user/project.qgs
&LAYER=mylayer
&FORMAT=image/png
&TILEMATRIXSET=EPSG:4326
&TILEROW=0
&TILECOL=0

SERVICE

Ce paramètre doit être WMTS en cas de requête GetTile.

REQUEST

Ce paramètre est GetTile en cas de requête GetTile.

LAYER

This parameter allows to specify the layer to display on the tile.

In addition, QGIS Server introduced some options to select a layer by:

• a short name

• the layer id

The short name of a layer may be configured through Properties → Metadata in layer menu. If the short name is
defined, then it’s used by default instead of the layer’s name:

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetTile
&LAYER=mynickname
&...

Moreover, there’s a project option allowing to select layers by their id in OWS Server → WMS capabilities menu
of the Project → Project Properties dialog. To activate this option, the checkbox Use layer ids as names has to be
selected.
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http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetTile
&LAYER=mylayerid1
&...

FORMAT

This parameter may be used to specify the format of tile image. Available values are:

• jpg

• jpeg

• image/jpeg

• image/png

If the FORMAT parameter is different from one of these values, then the default format PNG is used instead.

TILEMATRIXSET

This parameter allows to define the CRS to use to compute the underlying pyramid and has to be formed like
EPSG:XXXX.

TILEMATRIX

This parameter allows to define the matrix to use for the output tile.

TILEROW

This parameter allows to select the row of the tile to get within the matrix.

TILECOL

This parameter allows to select the column of the tile to get within the matrix.

MAP

This parameter allows to define the QGIS project file to use.

As mentioned in GetMap parameters table, MAP is mandatory because a request needs a QGIS project to actu-
ally work. However, the QGIS_PROJECT_FILE environment variable may be used to define a default QGIS
project. In this specific case, MAP is not longer a required parameter. For further information you may refer to
Configuration avancée.

GetFeatureInfo

Standard parameters for the GetFeatureInfo request according to the OGC WMTS 1.0.0 specifications:

• WMS 1.1.0
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Paramètre Requis Description
SERVICE Oui Nom du service (WMTS)
REQUEST Oui Nom de la requête (GetFeatureInfo)
LAYER Oui Identifiant de la couche
INFOFORMAT Non Output format
I Non Coordonnée X d’un pixel
J Non Coordonnée Y d’un pixel
TILEMATRIXSET Oui voir GetTile
TILEMATRIX Oui voir GetTile
TILEROW Oui voir GetTile
TILECOL Oui voir GetTile

Outre les paramètres standard, QGIS prend en charge les paramètres suivants :

Paramètre Requis Description
MAP Oui Specify the QGIS project file

Exemple d’URL :

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetFeatureInfo
&MAP=/home/user/project.qgs
&LAYER=mylayer
&INFOFORMAT=image/html
&I=10
&J=5

SERVICE

Ce paramètre doit être WMTS en cas de requête GetFeatureInfo.

REQUEST

Ce paramètre est GetFeatureInfo en cas de requête GetFeatureInfo.

MAP

This parameter allows to define the QGIS project file to use.

As mentioned in GetMap parameters table, MAP is mandatory because a request needs a QGIS project to actu-
ally work. However, the QGIS_PROJECT_FILE environment variable may be used to define a default QGIS
project. In this specific case, MAP is not longer a required parameter. For further information you may refer to
Configuration avancée.
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LAYER

This parameter allows to specify the layer to display on the tile.

In addition, QGIS Server introduced some options to select a layer by:

• a short name

• the layer id

The short name of a layer may be configured through Properties → Metadata in layer menu. If the short name is
defined, then it’s used by default instead of the layer’s name:

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetFeatureInfo
&LAYER=mynickname
&...

Moreover, there’s a project option allowing to select layers by their id in OWS Server → WMS capabilities menu
of the Project → Project Properties dialog. To activate this option, the checkbox Use layer ids as names has to be
selected.

http://localhost/qgis_server?
SERVICE=WMTS
&REQUEST=GetFeatureInfo
&LAYER=mylayerid1
&...

INFOFORMAT

This parameter allows to define the output format of the result. Available values are:

• text/xml

• text/html

• text/plain

• application/vnd.ogc.gml

The default value is text/plain.

I

This parameter allows to define the X coordinate of the pixel for which we want to retrieve underlying information.

J

This parameter allows to define the Y coordinate of the pixel for which we want to retrieve underlying information.

Extra parameters supported by all request types

• FILE_NAME parameter: if set, the server response will be sent to the client as a file attachment with the
specified file name.

• MAP parameter: Similar to MapServer, the MAP parameter can be used to specify the path to the QGIS
project file. You can specify an absolute path or a path relative to the location of the server executable
(qgis_mapserv.fcgi). If not specified, QGIS Server searches for .qgs files in the directory where the
server executable is located.
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Exemple:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

Note: You can define a QGIS_PROJECT_FILE as an environment variable to tell the server executable where
to find the QGIS project file. This variable will be the location where QGIS will look for the project file. If not
defined it will use the MAP parameter in the request and finally look at the server executable directory.

REDLINING

This feature is available and can be used with GetMap and GetPrint requests.

The redlining feature can be used to pass geometries and labels in the request which are overlapped by the server
over the standard returned image (map). This permits the user to put emphasis or maybe add some comments
(labels) to some areas, locations etc. that are not in the standard map.

The request is in the format:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi?map=/world.qgs&SERVICE=WMS&
→˓VERSION=1.3.0&
REQUEST=GetMap
...
&HIGHLIGHT_GEOM=POLYGON((590000 5647000, 590000 6110620, 2500000 6110620, 2500000
→˓5647000, 590000 5647000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
→˓<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter
→˓name="stroke">%23ea1173</SvgParameter><SvgParameter name="stroke-opacity">1</
→˓SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
→˓LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=Write label here
&HIGHLIGHT_LABELSIZE=16
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=1.5

Here is the image outputed by the above request in which a polygon and a label are drawn on top of the normal
map:

You can see there are several parameters in this request:

• HIGHLIGHT_GEOM: You can add POINT, MULTILINESTRING, POLYGON etc. It supports multipart
geometries. Here is an example: HIGHLIGHT_GEOM=MULTILINESTRING((0 0, 0 1, 1 1)).
The coordinates should be in the CRS of the GetMap/GetPrint request.

• HIGHLIGHT_SYMBOL: This controls how the geometry is outlined and you can change the stroke width,
color and opacity.

• HIGHLIGHT_LABELSTRING: You can pass your labeling text to this parameter.

• HIGHLIGHT_LABELSIZE: This parameter controls the size of the label.

• HIGHLIGHT_LABELCOLOR: This parameter controls the label color.

• HIGHLIGHT_LABELBUFFERCOLOR: This parameter controls the label buffer color.

• HIGHLIGHT_LABELBUFFERSIZE: This parameter controls the label buffer size.

External WMS layers

QGIS Server allows including layers from external WMS servers in WMS GetMap and WMS GetPrint requests.
This is especially useful if a web client uses an external background layer in the web map. For performance
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Figure 17.9: Server response to a GetMap request with redlining parameters
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reasons, such layers should be directly requested by the web client (not cascaded via QGIS server). For printing
however, these layers should be cascaded via QGIS server in order to appear in the printed map.

External layers can be added to the LAYERS parameter as EXTERNAL_WMS:<layername>. The parameters for
the external WMS layers (e.g. url, format, dpiMode, crs, layers, styles) can later be given as service parameters
<layername>:<parameter>. In a GetMap request, this might look like this:

http://localhost/qgis_server?
SERVICE=WMS&REQUEST=GetMap
...
&LAYERS=EXTERNAL_WMS:basemap,layer1,layer2
&STYLES=,,
&basemap:url=http://externalserver.com/wms.fcgi
&basemap:format=image/jpeg
&basemap:dpiMode=7
&basemap:crs=EPSG:2056
&basemap:layers=orthofoto
&basemap:styles=default

Similarly, external layers can be used in GetPrint requests:

http://localhost/qgis_server?
SERVICE=WMS
...
&REQUEST=GetPrint&TEMPLATE=A4
&map0:layers=EXTERNAL_WMS:basemap,layer1,layer2
&map0:EXTENT=<minx,miny,maxx,maxy>
&basemap:url=http://externalserver.com/wms.fcgi
&basemap:format=image/jpeg
&basemap:dpiMode=7
&basemap:crs=EPSG:2056
&basemap:layers=orthofoto
&basemap:styles=default

17.2.3 Extensions

Installation

Pour installer par exemple l’extension HelloWorld pour tester les serveurs, vous devez tout d’abord créer un
répertoire pour accueillir les extensions serveur. Cela sera spécifié dans la configuration de l’hôte virtuel et passé
au serveur par le biais d’une variable d’environnement :

sudo mkdir -p /opt/qgis-server/plugins
cd /opt/qgis-server/plugins
sudo wget https://github.com/elpaso/qgis-helloserver/archive/master.zip
In case unzip was not installed before:
sudo apt install unzip
sudo unzip master.zip
sudo mv qgis-helloserver-master HelloServer

Configuration d’un serveur HTTP

Apache

Pour être en mesure d’utiliser une extension serveur, FastCGI doit savoir où regarder. Donc, nous devons modifier
le fichier de configuration Apache pour renseigner la variable d’environnement QGIS_PLUGINPATH à FastCGI
:
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FcgidInitialEnv QGIS_SERVER_LOG_FILE /tmp/qgis-000.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0
FcgidInitialEnv QGIS_PLUGINPATH "/opt/qgis-server/plugins"

Moreover, a basic HTTP authorization is necessary to play with the HelloWorld plugin previously introduced. So
we have to update the Apache configuration file a last time:

# Needed for QGIS HelloServer plugin HTTP BASIC auth
<IfModule mod_fcgid.c>

RewriteEngine on
RewriteCond %{HTTP:Authorization} .
RewriteRule .* - [E=HTTP_AUTHORIZATION:%{HTTP:Authorization}]

</IfModule>

Puis, redémarrez Apache :

sudo a2ensite 001-qgis-server
sudo service apache2 restart

Astuce: Si vous travaillez avec une entité qui a beaucoup de nœuds alors la modification ou l’ajout d’une nouvelle
entité échouera. Dans ce cas, il est possible d’insérer le code suivant dans le fichier 001-qgis-server.conf
:

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

Comment utilisez une extension ?

Testez le serveur avec l’extension HelloWorld :

wget -q -O - "http://localhost/cgi-bin/qgis_mapserv.fcgi?SERVICE=HELLO"
HelloServer!

Vous pouvez avoir un aperçu des GetCapabilities de QGIS server ici : http://localhost/cgi-bin/
qgis_mapserv.fcgi?SERVICE=WMS&VERSION=1.3.0&REQUEST=GetCapabilities

17.2.4 Configuration avancée

Journal

To log requests sent to the server, you have to set the following environment variables:

• QGIS_SERVER_LOG_LEVEL

• QGIS_SERVER_LOG_FILE

• QGIS_SERVER_LOG_STDERR

Take a look on Variables d’environnement to understand their meanings.

Variables d’environnement

You can configure some aspects of QGIS Server by setting environment variables.

According to the HTTP server and how you run QGIS Server, there are several ways to define these variables.
This is fully described in Configuration d’un serveur HTTP.
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QGIS_OPTIONS_PATH

Specifies the path to the directory with settings. It works the same way as QGIS application --optionspath
option. It is looking for settings file in <QGIS_OPTIONS_PATH>/QGIS/QGIS3.ini.

QUERY_STRING

The query string, normally passed by the web server. This variable can be useful while testing QGIS server binary
from the command line.

For example for testing a GetCapabilities request on the command line to a project that also requires a PostgreSQL
connection defined in a pg_service.conf file:

PGSERVICEFILE=/etc/pg_service.conf QUERY_STRING="MAP=/path/to/test.qgs&SERVICE=WMS&
→˓REQUEST=GetCapabilities" /path/to/qgis_mapserv.fcgi

The result should be either the content of the GetCapabilities response or, if something is wrong, an error message.

QGIS_PROJECT_FILE

The .qgs or .qgz project file, normally passed as a parameter in the query string (with MAP), you can also set
it as an environment variable (for example by using mod_rewrite Apache module).

Note that you may also indicate a project stored in PostgreSQL, e.g. postgresql://localhost:5432?
sslmode=disable&dbname=mydb&schema=myschema&project=myproject.

QGIS_SERVER_LOG_FILE

Specify path and filename. Make sure that server has proper permissions for writing to file. File should be created
automatically, just send some requests to server. If it’s not there, check permissions.

QGIS_SERVER_LOG_FILE is deprecated since QGIS 3.4. File logging support will be removed in QGIS 4.0.

QGIS_SERVER_LOG_STDERR

Activate logging to stderr. It’s disabled by default. This variable has no effect when QGIS_SERVER_LOG_FILE
is set.

• 0 or false (case insensitive)

• 1 or true (case insensitive)

MAX_CACHE_LAYERS

Specify the maximum number of cached layers (default: 100).

DISPLAY

This is used to pass (fake) X server display number (needed on Unix-like systems).

QGIS_PLUGINPATH

Useful if you are using Python plugins for the server, this sets the folder that is searched for Python plugins.
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QGIS_SERVER_LOG_LEVEL

Specify desired log level. Available values are:

• 0 or INFO (log all requests)

• 1 or WARNING

• 2 or CRITICAL (log just critical errors, suitable for production purposes)

QGIS_SERVER_PARALLEL_RENDERING

Activates parallel rendering for WMS GetMap requests. It’s disabled (false) by default. Available values are:

• 0 or false (case insensitive)

• 1 or true (case insensitive)

QGIS_SERVER_MAX_THREADS

Number of threads to use when parallel rendering is activated. Default value is -1 to use the number of processor
cores.

QGIS_SERVER_CACHE_DIRECTORY

Specifies the network cache directory on the filesystem. The default directory is named cache and located in the
profile directory.

QGIS_SERVER_CACHE_SIZE

Sets the network cache size in MB. The default value is 50 MB.

Settings summary

When QGIS Server is starting, you have a summary of all configurable parameters thanks to environment variables.
Moreover, the value currently used and the origin is also displayed.

For example with spawn-fcgi:

export QGIS_OPTIONS_PATH=/home/user/.local/share/QGIS/QGIS3/profiles/default/
export QGIS_SERVER_LOG_FILE=/home/user/qserv.log
export QGIS_SERVER_LOG_LEVEL=2
spawn-fcgi -f /usr/lib/cgi-bin/qgis_mapserv.fcgi -s /tmp/qgisserver.sock -U www-
→˓data -G www-data -n

QGIS Server Settings:

- QGIS_OPTIONS_PATH / '' (Override the default path for user configuration): '/
→˓home/user/.local/share/QGIS/QGIS3/profiles/default/' (read from ENVIRONMENT_
→˓VARIABLE)

- QGIS_SERVER_PARALLEL_RENDERING / '/qgis/parallel_rendering' (Activate/
→˓Deactivate parallel rendering for WMS getMap request): 'true' (read from INI_
→˓FILE)

- QGIS_SERVER_MAX_THREADS / '/qgis/max_threads' (Number of threads to use when
→˓parallel rendering is activated): '4' (read from INI_FILE)

17.2. QGIS comme serveur de données OGC 459



QGIS User Guide, Version 3.4

- QGIS_SERVER_LOG_LEVEL / '' (Log level): '2' (read from ENVIRONMENT_VARIABLE)

- QGIS_SERVER_LOG_FILE / '' (Log file): '/tmp/qserv.log' (read from ENVIRONMENT_
→˓VARIABLE)

- QGIS_PROJECT_FILE / '' (QGIS project file): '' (read from DEFAULT_VALUE)

- MAX_CACHE_LAYERS / '' (Specify the maximum number of cached layers): '100'
→˓(read from DEFAULT_VALUE)

- QGIS_SERVER_CACHE_DIRECTORY / '/cache/directory' (Specify the cache
→˓directory): '/root/.local/share/QGIS/QGIS3/profiles/default/cache' (read from
→˓DEFAULT_VALUE)

- QGIS_SERVER_CACHE_SIZE / '/cache/size' (Specify the cache size): '52428800'
→˓(read from INI_FILE)

Ini file used to initialize settings: /home/user/.local/share/QGIS/QGIS3/profiles/
→˓default/QGIS/QGIS3.ini

In this particular case, we know that QGIS_SERVER_MAX_THREADS and
QGIS_SERVER_PARALLEL_RENDERING values are read from the ini file found in
QGIS_OPTIONS_PATH directory (which is defined through an environment variable). The correspond-
ing entries in the ini file are /qgis/max_threads and /qgis/parallel_rendering and their values are true and 4
threads.

Nom court pour les couches, les groupes et le projet

Un certains nombre d’éléments disposent d’un <Name> dt d’un <Title>. Le nom est une chaîne de caractères
utilisée dans la communication de machine à machine alors que le titre est utilisé pour les êtres humains.

Par exemple, un jeu de données peut avoir un titre descriptif Température Atmosphérique Maximum et être
requêté par le nom abrégé ATMAX. L’utilisateur peut indiquer un titre pour les couches, les groupes et le projet.

Le nom OWS est basé sur le nom utilisé dans l’arbre des couches. Ce nom est plus une étiquette pour les être
humains qu’un nom utilisé dans la communication de machine à machine.

QGIS Server gère :

• Modification de la ligne de nom abrégé pour les propriétés des couches. Vous pouvez modifier cela en
cliquant avec le bouton droit de la souris sur un calque, choisissez Propriétés → Onglet Métadonnées →
Description → Nom court

• une boîte de dialogue WMS pour les groupes (permet de saisir le nom court du groupe, le titre et un résumé)

En faisant un clic-droit sur un groupe de couches et en sélectionnant l’option Définir un groupe de données
WMS, vous obtiendrez:

Figure 17.10: Définir la boîte de dialogue des données associées au groupe WMS

• l’édition de nom court dans les propriétés du projet et l’ajout d’un validateur d’expressions régulières
"^[A-Za-z][A-Za-z0-9\._-]*" pour les éditions de noms courts (via une méthode statique)
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• l’ajout d’un validateur de fonction rationnelles "^[A-Za-z][A-Za-z0-9\._-]*" pour les éditions de
noms courts (via une méthode statique)

Vous pouvez choisir un nom court pour la racine du projet en allant à : Propriétés du projet → Serveur OWS
→ Fonctionnalités du service → Nom court.

• l’ajout d’un élément TreeName dans les propriétés du projet (fullProjectSettings)

Si un nom court a été utilisé pour des couches, des groupes ou pour le projet, il sera utilisé par QGIS Server pour
définir le nom de la couche.

Connexion au fichier de service

Pour faire en sorte qu’Apache puisse accéder au fichier de service PostgreSQL (consultez la section ref:pg-service-
file), vous devez modifier vos fichiers *.conf de la manière suivante:

SetEnv PGSERVICEFILE /home/web/.pg_service.conf

<Directory "/home/web/apps2/bin/">
AllowOverride None

.....

Ajouter des polices à votre serveur Linux

Gardez à l’esprit que vous pouvez utiliser des projet QGIS qui utilisent des polices qui n’existent pas par défaut
sur les autres machines. Cela signifie que si vous partagez le projet, il pourra apparaître de manière différente sur
d’autres machines (si les polices n’existent pas sur la machine cible).

Pour s’assurer que cela n’arrive pas, vous devez simplement installer les polices manquantes sur la machine cible.
En règle général, le faire sur des systèmes bureautiques est relativement simple (double-cliquer sur des polices).

Sous Linux, si vous n’avez pas d’environnement de bureau d’installé (ou que vous préferrez la ligne de com-
mande), vous devrez:

• Sur les systèmes basés sur Debian:

sudo su
mkdir -p /usr/local/share/fonts/truetype/myfonts && cd /usr/local/share/fonts/
→˓truetype/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v

• Pour les systèmes basés sur Fedora:

sudo su
mkdir /usr/share/fonts/myfonts && cd /usr/share/fonts/myfonts

# copy the fonts from their location
cp /fonts_location/* .

chown root *
cd .. && fc-cache -f -v

17.2. QGIS comme serveur de données OGC 461



QGIS User Guide, Version 3.4

462 Chapter 17. Les données OGC



CHAPTER 18

Les données GPS

18.1 Extension GPS

18.1.1 Qu’est ce que le GPS ?

Le GPS, Global Positioning System, est un système basé sur des satellites qui permet à toute personne possédant un
récepteur GPS d’obtenir sa position exacte n’importe où dans le monde. Il est utilisé comme aide à la navigation,
par exemple pour les avions, dans les bateaux et par les voyageurs. Le récepteur GPS utilise les signaux des
satellites pour calculer la latitude, la longitude et (parfois) l’élévation. La plupart des récepteurs ont également
la possibilité de stocker la position (nommé points d’intérêt ou waypoints), des séquences de positions qui
constituent un itinéraire prévu et un journal de suivi ou track des déplacements du récepteur en fonction du
temps. Points d’intérêt, itinéraires et tracks sont les trois types d’objet basiques dans les données GPS. QGIS
affiche les points d’intérêt dans des couches points tandis que les itinéraires et les tracks sont affichés dans des
couches linéaires.

Note: QGIS gère aussi les récepteurs GNSS. Mais nous utiliserons le terme GPS tout au long de la documentation.

18.1.2 Charger des données GPS à partir d’un fichier

Il y a des dizaines de formats de fichier différent pour stocker des données GPS. Le format que QGIS utilise
est appelé GPX (GPS eXchange format), qui est un format d’échange standard qui peut contenir n’importe quel
nombre de waypoints, itinéraires et tracks dans un même fichier.

Pour charger un fichier GPX vous devez d’abord charger l’extension : allez dans Extension → Installer/

Gérer les extensions puis cochez la case Outils GPS. Quand l’extension est chargée, deux boutons avec un
petit périphérique GPS apparaissent dans la barre d’outils et dans Couche → Créer couche → :

• Outils GPS

• Créer une nouvelle couche GPS

Pour travailler sur des données GPS, nous utiliserons le fichier GPX fournit dans le jeu de données test de QGIS
: qgis_sample_data/gps/national_monuments.gpx. Référez-vous à la section Téléchargement des
données exemple pour plus d’informations sur le jeu de données test.
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1. Select Vector → GPS Tools or click the GPS Tools icon in the toolbar and open the Load GPX file tab (see
figure_GPS).

2. Browse to the folder qgis_sample_data/gps/, select the GPX file national_monuments.gpx
and click Open.

Figure 18.1: La fenêtre d”Outils GPS

Use the Browse. . . button to select the GPX file, then use the checkboxes to select the feature types you want
to load from that GPX file. Each feature type will be loaded in a separate layer when you click OK. The file
national_monuments.gpx only includes waypoints.

Note: GPS units allow you to store data in different coordinate systems. When downloading a GPX file (from
your GPS unit or a web site) and then loading it in QGIS, be sure that the data stored in the GPX file uses WGS 84
(latitude/longitude). QGIS expects this, and it is the official GPX specification. See https://www.topografix.com/
GPX/1/1/.

18.1.3 GPSBabel

Since QGIS uses GPX files, you need a way to convert other GPS file formats to GPX. This can be done for many
formats using the free program GPSBabel, which is available at https://www.gpsbabel.org. This program can also
transfer GPS data between your computer and a GPS device. QGIS uses GPSBabel to do these things, so it is
recommended that you install it. However, if you just want to load GPS data from GPX files you will not need it.
Version 1.2.3 of GPSBabel is known to work with QGIS, but you should be able to use later versions without any
problems.

18.1.4 Importer des données GPS

Pour importer des données d’un fichier qui n’est pas un fichier GPX, vous devez utiliser l’outil Importer un autre
fichier dans la fenêtre des outils GPS. Vous sélectionnez le fichier que vous voulez importer, le type de géométrie,
l’emplacement où stocker le fichier GPX converti et sous quel nom l’enregistrer. Tous les formats de données GPS
ne supportent pas les trois types d’entités, ne vous laissant le choix qu’entre un ou deux types.

18.1.5 Télécharger des données GPS à partir d’un périphérique

QGIS peut utiliser GPSBabel pour télécharger des données d’un périphérique GPS directement vers de nouvelles
couches vecteurs. Pour cela, utilisez l’onglet Télécharger depuis le récepteur GPS de la fenêtre Outils GPS (voir
Figure_GPS_download). Vous y choisissez votre type de périphérique GPS, le port auquel il est connecté (ou
USB si le GPS le permet), le type de géométrie que vous voulez télécharger, le fichier GPX où les données seront
stockées et le nom de la nouvelle couche.
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Figure 18.2: L’outil de téléchargement

Le type de périphérique que vous sélectionnez dans le menu périphérique GPS détermine comment GPSBabel
tente de communiquer avec votre périphérique GPS. Si aucun des types ne fonctionne avec votre périphérique
GPS, vous pouvez créer un nouveau type adapté (voir la section Définir de nouveaux types de périphériques).

Le port peut être un nom de fichier ou n’importe quel autre nom que votre système d’exploitation utilise comme
référence vers le port physique de votre ordinateur sur lequel est connecté le périphérique GPS. Cela peut aussi
être de l’USB, si votre périphérique GPS fonctionne dans ce mode.

• Sous Linux, il s’agit de quelque chose qui ressemble à /dev/ttyS0 ou /dev/ttyS1.

• Sous Windows, il s’agit de COM1 ou COM2.

When you click OK, the data will be downloaded from the device and appear as a layer in QGIS.

18.1.6 Envoyer des données GPS vers un appareil

Vous pouvez également envoyer directement vos données depuis une couche vecteur de QGIS vers un périphérique
GPS en utilisant l’onglet Uploader vers le GPS de la fenêtre des Outils GPS. Pour cela, vous devez sélectionner la
couche que vous voulez envoyer (qui doit être au format GPX), le type de votre périphérique GPS et le port (com
ou USB) auquel il est connecté. De la même manière que pour l’outil de téléchargement, vous pouvez définir de
nouveaux types de périphérique si le vôtre n’est pas dans la liste.

Cet outil est très utile lorsque combiné avec les capacités d’édition vectorielle de QGIS. Il permet de charger une
carte, créer des points et des itinéraires, puis de les envoyer pour les utiliser dans votre périphérique GPS.

18.1.7 Définir de nouveaux types de périphériques

There are lots of different types of GPS devices. The QGIS developers can’t test all of them, so if you have one
that does not work with any of the device types listed in the Download from GPS and Upload to GPS tools, you
can define your own device type for it. You do this by using the GPS device editor, which you start by clicking
the Edit Devices button in the download or the upload tab.

To define a new device, you simply click the New Device button, enter a name, enter download and upload
commands for your device, and click the Update Device button. The name will be listed in the device menus in
the upload and download windows – it can be any string. The download command is the command that is used to
download data from the device to a GPX file. This will probably be a GPSBabel command, but you can use any
other command line program that can create a GPX file. QGIS will replace the keywords %type, %in, and %out
when it runs the command.

%type sera remplacé par -w si vous téléchargez des waypoints, -r pour des routes et -t pour des tracks. Ce
sont des options de la ligne de commande qui précisent à GPSBabel quel type d’objet télécharger.
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%in sera remplacé par le port que vous avez choisi dans l’onglet de téléchargement et %out sera remplacé par le
nom choisi pour le fichier GPX où les données téléchargées doivent être stockées. Donc si vous créez un type de
périphérique avec la commande de téléchargement gpsbabel %type -i garmin -o gpx %in %out
(qui correspond à celle définie pour le type “Garmin serial”) et l’utilisez pour télécharger les waypoints depuis
le port /dev/ttyS0 vers le fichier output.gpx, QGIS remplacera les mots-clés et lancera la commande
gpsbabel -w -i garmin -o gpx /dev/ttyS0 output.gpx.

La commande de téléchargement est la commande qui est utilisée pour télécharger des données vers le pé-
riphérique. Les même mots-clés sont utilisés mais %in est maintenant remplacé par le nom du fichier GPX
pour la couche qui est à uploader et %out est remplacé par le nom du port.

You can learn more about GPSBabel and its available command line options at https://www.gpsbabel.org.

Une fois le nouveau type de périphérique créé, celui-ci apparaîtra dans les listes de périphériques des outils de
téléchargement et d’upload.

18.1.8 Chargement de points/traces depuis un périphérique GPS

As described in previous sections QGIS uses GPSBabel to download points/tracks directly in the project. QGIS
comes out of the box with a pre-defined profile to download from Garmin devices. Unfortunately there is a bug
#6318 that does not allow create other profiles, so downloading directly in QGIS using the GPS Tools is at the
moment limited to Garmin USB units.

Garmin GPSMAP 60cs

MS Windows

Install the Garmin USB drivers from https://www8.garmin.com/support/download_details.jsp?id=591

Connectez le périphérique. Ouvrez les Outils GPS et utilisez Périphérique GPS=Garmin serial et
Port=usb: Remplissez les champs Nom de la couche and Fichier en sortie. Quelquefois il semble y avoir
des problèmes avec certains répertoire, cela fonctionne en général en utilisant un répertoire du style c:\temp.

Ubuntu/Mint GNU/Linux

Il est d’abord nécessaire de régler un problème concernant les permissions du périphérique, comme cela est ex-
pliqué à cette adresse : https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. Vous pouvez essayer
de créer un fichier /etc/udev/rules.d/51-garmin.rules contenant cette règle

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

Après cela il est nécessaire de s’assurer que le module du noyau garmin_gps n’est pas chargé

rmmod garmin_gps

and then you can use the GPS Tools. Unfortunately there seems to be a bug #7182 and usually QGIS freezes
several times before the operation work fine.

BTGP-38KM datalogger (seulement Bluetooth)

MS Windows

Un bug connu ne permet pas de télécharger les données depuis QGIS, aussi il est nécessaire d’utiliser GPSBabel
depuis la ligne de commande ou à travers son interface dédiée. La commande qui fonctionne est

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx

Ubuntu/Mint GNU/Linux

Avec Windows, utilisez la même commande (ou les mêmes paramètres si vous utilisez l’interface de GPSBabel).
Sous Linux il est possible que vous obteniez un message du genre
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skytraq: Too many read errors on serial port

vous pouvez tenter d’allumer et d’éteindre le datalogger avant de réessayer.

BlueMax GPS-4044 datalogger (BT et USB)

MS Windows

Note: Il est nécessaire d’installer ses drivers avant l’utilisation dans Windows 7. Voir le site du fabricant pour le
téléchargement des drivers.

Télécharger avec GPSBabel, aussi bien en USB ou BT retourne toujours une erreur du genre

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can't create temporary file data.bin
Error running gpsbabel: Process exited unsuccessfully with code 1

Ubuntu/Mint GNU/Linux

Avec USB

Après avoir connecté le cable, utilisez la commande dmesg pour afficher le port qui est utilisé, par exemple /
dev/ttyACM3. Ensuite utilisez GPSBabel comme d’habitude depuis la ligne de commande ou son interface
dédiée.

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Avec Bluetooth

Utilisez le gestionnaire de périphériques Blueman (Blueman Device Manager) pour associer le périphérique et le
rendre accessible à travers un port du système, puis lancez GPSBabel

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

18.2 Suivi GPS en direct

To activate live GPS tracking in QGIS, you need to select View → Panels GPS Information Panel or press
Ctrl+0. You will get a new docked window on the left side of the canvas.

Cette fenêtre propose quatre écrans différents :

• GPS position coordinates and an interface for manually entering vertices and features

• Force des signaux GPS des satellites connectés

• Écran des options GPS (voir figure_gps_options)

With a plugged-in GPS receiver (has to be supported by your operating system), a simple click on Connect con-
nects the GPS to QGIS. A second click (now on Disconnect) disconnects the GPS receiver from your computer.
For GNU/Linux, gpsd support is integrated to support connection to most GPS receivers. Therefore, you first have
to configure gpsd properly to connect QGIS to it.

Avertissement: Si vous désirez enregistrer votre position sur la carte, vous devez au préalable, créer une
nouvelle couche et la passer en mode édition.
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18.2.1 Coordonnées de la position

If the GPS is receiving signals from satellites, you will see your position in latitude, longitude and altitude
together with additional attributes.

Figure 18.3: Coordonnées de la position GPS et autres attributs

18.2.2 Force du signal GPS

Cet écran affiche la force des signaux GPS des satellites connectés sous forme de barres.

Figure 18.4: Force du signal GPS

468 Chapter 18. Les données GPS



QGIS User Guide, Version 3.4

18.2.3 Configuration GPS

Si vous avez des problèmes de connexion, vous pouvez tester :

• Auto-détecter

• Interne

• Port Série

• gpsd (en indiquant l’Hôte, le Port et le Périphérique auquel le GPS est connecté)

A click on Connect again initiates the connection to the GPS receiver.

Figure 18.5: Configuration du suivi GPS

Vous pouvez activer Enregistrer automatiquement chaque entité ajoutée lorsque vous êtes en mode édition.

Ou vous pouvez activer Ajouter automatiquement des points en choisissant la largeur et la couleur.

En activant Curseur, utilisez le curseur pour augmenter ou diminuer la taille du curseur
marquant la position du GPS sur la carte.

You can also set an Acquisition interval (seconds) and a Distance threshold (meters) parameters to keep the cursor
still active when the receiver is in static conditions.

Centrer la carte vous permet de choisir comment mettre à jour l’emprise de la carte. Par exemple “toujours”
ou “lorsque l’on sort”, si les coordonnées enregistrées commencent à sortir de la carte, ou encore “jamais”.
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Enfin, vous pouvez activer le Fichier journal et définir un fichier pour enregistrer les messages du suivi GPS.

If you want to set a feature manually, you have to go back to Position and click on Add Point or Add Track Point.

18.2.4 Connexion à un GPS Bluetooth pour le suivi en direct

Avec QGIS, vous pouvez vous connecter à un GPS Bluetooth pour la récupération de données terrain. Pour réaliser
cette tâche, vous aurez besoin d’un GPS Bluetooth et d’un récepteur Bluetooth sur votre ordinateur.

Au démarrage, vous devez faire en sorte que votre GPS soit reconnu et appairé avec votre ordinateur. Allumer le
GPS, cliquer sur l’icône Bluetooth de votre barre de notification et rechercher un Nouveau Périphérique.

On the right side of the Device selection mask make sure that all devices are selected so your GPS unit will
probably appear among those available. In the next step a serial connection service should be available, select it
and click on Configure button.

Retenez le numéro du port COM affecté à la connexion GPS dans les propriétés Bluetooth.

Une fois que le GPS a été reconnu, faîtes l’appariement avec la connexion. Généralement, le code d’autorisation
est 0000.

Now open GPS information panel and switch to GPS options screen. Select the COM port assigned to the GPS
connection and click the Connect. After a while a cursor indicating your position should appear.

Si QGIS ne peut recevoir de données GPS, vous devriez alors redémarrer votre GPS, attendre 5-10 secondes
et réessayer de le connecter. Généralement, celle solution fonctionne. Si vous avez de nouveau une erreur de
connexion, assurez-vous que vous n’avez pas un autre capteur Bluetooth à proximité, apparairé avec le GPS.

18.2.5 Utiliser un Garmin GPSMAP 60cs

MS Windows

Easiest way to make it work is to use a middleware (freeware, not open) called GPSGate.

Launch the program, make it scan for GPS devices (works for both USB and BT ones) and then in QGIS just click

Connect in the Live tracking panel using the Autodetect mode.

Ubuntu/Mint GNU/Linux

Comme pour Windows le plus simple est d’utiliser un serveur intermédiaire, dans ce cas GPSD, donc

sudo apt install gpsd

Vous pouvez alors charger le module du noyau garmin_gps

sudo modprobe garmin_gps

Connectez ensuite l’unité. Vérifiez avec dmesg que le périphérique utilisé par l’unité, par exemple /dev/
ttyUSB0. Maintenant, vous pouvez lancer qpsd.

gpsd /dev/ttyUSB0

Connectez enfin avec l’outil de suivi en direct de QGIS.

18.2.6 Utiliser BTGP-38KM datalogger (seulement Bluetooth)

Utiliser GPSD (sous GNU/Linux) ou GPSGate (sous Windows) est très facile.
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18.2.7 Utiliser BlueMax GPS-4044 datalogger (BT et USB)

MS Windows

Le suivi en direct fonctionne pour les modes USB et BT en utilisant GPSGate ou même sans lui. Utilisez le mode

Auto-détection ou pointez l’outil dans le bon port.

Ubuntu/Mint GNU/Linux

Via USB

Le suivi en direct fonctionne avec les deux sous GPSD.

gpsd /dev/ttyACM3

ou sans lui en connectant l’outil de suivi en direct de QGIS directement au périphérique (par exemple /dev/
ttyACM3).

Via Bluetooth

Le suivi en direct fonctionne avec les deux sous GPSD.

gpsd /dev/rfcomm0

ou sans lui en connectant l’outil de suivi en direct de QGIS directement au périphérique (par exemple /dev/
rfcomm0).
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CHAPTER 19

Système d’authentification

19.1 Aperçu du Système d’authentification

Figure 19.1: Anatomie du Système d’authentification

19.1.1 Base de données d’authentification

Le nouveau système d’authentification stocke les configurations d’authentification dans un fichier de base de
données SQLite situé, par défaut, sous <user home>/.qgis3/qgis-auth.db.
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Cette base de données d’authentification peut être déplacée entre les différentes installations de QGIS sans affecter
les autres préférences utilisateur, car elle est complètement indépendante des paramètres de QGIS. Un ID de con-
figuration (une chaîne aléatoire de 7 caractères alphanumériques) est généré lors du stockage de la configuration
dans la base de données. Cela permet à l’ID d’être stocké dans des composants plein texte (tels que des projets,
des plugins ou des fichiers de paramètres), sans que les informations d’identification y figurent.

Note: Le dossier contenant la base qgis-auth.db peut être défini dans la variable d’environnement
QGIS_AUTH_DB_DIR_PATH, ou dans la ligne de commande utilisée lors du lancement avec l’option
--authdbdirectory .

19.1.2 Mot de passe principal

Pour stocker ou accéder à des informations sensibles dans la base de données, l’utilisateur doit renseigner un mot
de passe principal. Un nouveau mot de passe principal est requis et vérifié lors de la première écriture de toute
donnée cryptée dans la base de données. Ce n’est que lors de l’accès aux données sensibles que le mot de passe
principal est demandé à l’utilisateur, il est alors mis en cache pour le reste de la session (jusqu’à la fermeture de
l’application), sauf si l’utilisateur choisi délibérément d’effacer le mot de passe en cache. Certains cas d’utilisation
du système d’authentification ne nécessitent pas de saisir le mot de passe principal, comme par exemple lorsque
l’on sélectionne une configuration d’authentification existante, ou lorsque l’on applique une configuration à un
serveur (comme lors de l’ajout d’une couche WMS).

Figure 19.2: Entrer un nouveau mot de passe principal

Note: Un chemin vers un fichier contenant le mot de passe principal peut être paramétré au moyen de la variable
d’environnement suivante, QGIS_AUTH_PASSWORD_FILE.

Gestion du mot de passe principal

Une fois défini, le mot de passe principal peut être redéfini; le mot de passe courant sera demandé pour pouvoir
en définir un nouveau. Pendant cette procédure, une option permet de générer une sauvegarde complète de la base
de données.

Si l’utilisateur oublie le mot de passe principal, il n’existe aucun moyen de le retrouver ou de le contourner. Il
n’est pas non plus possible de retrouver des informations cryptées dans le mot de passe principal.

Si un utilisateur saisi sont mot de passe trois fois de manière incorrecte, l’interface propose d’effacer le contenu
de la base.

19.1.3 Configuration de l’authentification

Les configurations d’authentification peuvent être gérées dans Configurations de l’onglet Authentification du dia-
logue Options de QGIS (Paramètres → Options).
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Figure 19.3: Réinitialiser le mot de passe principal

Figure 19.4: Demande de mot de passe après trois tentatives invalides

Figure 19.5: Editeur de configurations

19.1. Aperçu du Système d’authentification 475



QGIS User Guide, Version 3.4

Utilisez le bouton pour ajouter une nouvelle configuration, le bouton pour supprimer des configurations,

et le bouton pour modifier des configurations existantes.

Figure 19.6: Ajouter une configuration avec l’éditeur de configuration

Les mêmes opérations que pour la gestion des configurations d’authentification (Ajouter, Modifier et Supprimer)
sont disponibles pour la configuration de la connexion à un service, comme par exemple la configuration de la
connexion à un service OWS. Des boutons dédiés à ces actions dans le sélecteur de configuration permettent de
gérer les configurations présentes dans la base d’authentification. Il n’est pas nécessaire de se rendre dans config-
urations de l’onglet Authentification des options de QGIS, sauf si vous avez besoin de gérer les configurations de
manière plus complète.

Lors de la création ou de la modification d’une configuration d’authentification, les informations à fournir sont
un nom, une méthode d’authentification et toute autre informatique requise par la méthode (Pour d’avantage
d’information sur les types d’authentification supportés, voir Méthodes d’authentification).

19.1.4 Méthodes d’authentification

Les authentifications disponibles sont fournies par les extensions C ++ de la même manière que les extensions de
fournisseur de données sont prises en charge par QGIS. Le procédé d’authentification qui peut être sélectionné
est relatif à l’accès à la ressource p. ex. HTTP(S) ou à la base de données par le provider, et s’il y a un support
dans le code QGIS et dans une extension. En tant que telles, certaines extensions d’authentification peuvent ne
pas être applicables partout où un sélecteur de configuration d’authentification est utilisé. Vous pouvez accéder à
la liste des extensions d’authentification disponibles et leurs ressources / fournisseurs compatibles, en allant dans
Préférences– > Options et, dans l’onglet Authentification, cliquez sur le bouton Extensions installées**.

Des extensions peuvent être créés pour les nouvelles méthodes d’authentification sans qu’il soit nécessitent de
recompiler QGIS. Puisque le support des extensions est actuellement en C ++ (depuis QGIS 2.12), seul QGIS
devra être redémarré pour que le nouveau plugin soit disponible. Assurez-vous que votre extension est compilée
avec la même version cible de QGIS .

Note: L’URL de la ressource est actuellement une fonctionnalité non implémentée qui permettra éventuellement
de choisir automatiquement une configuration particulière lors de la connexion aux ressources à une URL donnée.
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Figure 19.7: Fenêtre de connexion WMS avec les boutons de configuration de l’authentification Ajouter, Editer,
et Supprimer

Figure 19.8: Extensions d’authentification disponibles

Figure 19.9: Configuration Authentification basique HTTP
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Figure 19.10: ESRI Token authentication configs

478 Chapter 19. Système d’authentification



QGIS User Guide, Version 3.4

Figure 19.11: OAuth2 authentication configs
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Figure 19.12: Configuration Authentification par cheminement dans l’IGC

Figure 19.13: Configuration Authentification IGC PKCS#12

Figure 19.14: Configuration Certificat d’identité stocké dans une IGC
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19.1.5 Utilitaire et Mot de passe principal

A partir du menu Options (Préférences→ Options) , dans l’onglet Authentification , plusieurs actions permettent
de gérer le mot de passe principal, la base de données et les configurations d’authentification:

Figure 19.15: Menu du bouton Utilitaires

• Entrer le mot de passe principal :

– Opens the master password input dialog, independent of performing any authentication database com-
mand.

• Clear cached master password:

– Unsets the master password if it has been set via input dialog.

• Reset master password:

– Opens a dialog to change the master password (the current password must be known) and optionally
back up the current database.

• Effacer les configurations d’authentification mises en cache : Efface le cache interne des configurations
utilisées pour accélérer les connexions réseau. Cela n’efface pas le cache du gestionnaire d’accès au réseau
principal de QGIS, qui nécessite de relancer QGIS.

• Réinitialiser le mot de passe principal : Remplace le mot de passe principal actuel par un nouveau mot de
passe. Le mot de passe principal actuel sera nécessaire avant la réinitialisation et une sauvegarde de la base
de données pourra être effectuée.

• Supprimer toutes les configurations d’authentification : Efface de la base de données tous les enreg-
istrements de configuration, sans supprimer les autres enregistrements stockés.

• Effacer la base de données d’authentification : La sauvegarde de la base de données courante et la recon-
struction de la structure de tables de base de données ne seront réalisées que lorsque d’autres opérations,
comme le chargement du projet, ne provoquent pas d’erreurs en raison de l’absence temporaire de la base
de données. Dans ces cas, la sauvegarde et la reconstruction sont différées.

Figure 19.16: Menu d’effacement de la base de données

19.1.6 Utiliser les configurations d’authentification

En règle générale, une configuration d’authentification peut être sélectionnée par une boîte de dialogue de con-
figuration pour des services réseau (tels que WMS). Toutefois, le widget de sélection de configuration peut être

19.1. Aperçu du Système d’authentification 481



QGIS User Guide, Version 3.4

intégré à chaque fois que l’authentification est nécessaire dans QGIS ainsi que dans les les plugins PyQGIS ou C
++ tiers.

Lorsque vous utilisez le sélecteur, Pas d’authentification est affiché dans le menu contextuel lorsque rien n’est
sélectionné ainsi que lorsqu’il n’y a aucune configuration à choisir ou quand une configuration précédemment
affectée ne peut plus être trouvée dans la base de données. Lorsqu’une configuration est choisie, les champs
Méthode et Id sont en lecture seule et fournissent respectivement une description de la méthode d’authentification
et de l’ID de la configuration .

Figure 19.17: Authentication configuration selector with no authentication

Figure 19.18: Authentication configuration selector with selected config

19.1.7 Liaisons Python

Toutes les classes et les fonctions publiques ont des liaisons sip, sauf QgsAuthCrypto, car la gestion du
cryptage du mot de passe principal et du cryptage de la base de données auth doit se faire par l’application
principale, et non via Python. Voir Impératifs de sécurité concernant l’accès Python.

19.2 Processus d’authentification des utilisateurs

19.2.1 Authentification HTTP(S)

L’une des plus communes connexions à des ressources en ligne se fait via HTTP(S), par exemple pour des serveurs
cartographiques web, et les extensions de méthode d’authentification fonctionnent souvent pour ces types de con-
nexions. Ces extensions ont accès à la requête HTTP et peuvent manipuler aussi bien la requête que ses en-têtes.
Cela permet de disposer d’un grand nombre de méthodes d’authentification sur Internet. Lorsque la connexion se
fait via HTTP(S) en utilisant la méthode standard d’authentification avec nom utilisateur/mot de passe, la méthode
d’authentification lancera d’abord une authentification HTTP BASIC lors de la première connexion.

19.2.2 Authentification de la base de données

Connections to database resources are generally stored as key=value pairs, which will expose usernames and
(optionally) passwords, if not using an authentication configuration. When configuring with the new auth system,
the key=value will be an abstracted representation of the credentials, e.g. authfg=81t21b9.

19.2.3 Authentification PKI

Lors de la configuration des composants PKI dans le système d’authentification, vous pouvez soit importer les
composants dans la base de données, soit référencer les fichiers des composants stockés sur votre système de
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Figure 19.19: Processus pour l’utilisateur générique

Figure 19.20: Configuration d’une connexion WMS pour l’authentification HTTP BASIC
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Figure 19.21: Configuration d’une connexion SSL-avec-PKI pour Postgres

fichiers. Cette dernière option peut être utile si les composants changent fréquemment ou s’ils seront remplacés
par l’administrateur système. Dans tous les cas vous devrez sauver toute phrase clé nécessaire pour l’accès aux
clés privées dans la base de données.

All PKI components can be managed in separate editors within the Certificate Manager, which can be accessed
in the Authentication tab in QGIS Options dialog (Settings → Options) by clicking the Manage Certificates button.

In the Certificate Manager, there are editors for Identities, Servers and Authorities. Each of these are contained
in their own tabs, and are described below in the order they are encountered in the workflow chart above. The tab
order is relative to frequently accessed editors once you are accustomed to the workflow.

Note: Because all authentication system edits write immediately to the authentication database, there is no need
to click the Options dialog OK button for any changes to be saved. This is unlike other settings in the Options
dialog.

Autorités de certification

Vous pouvez gérer les Autorités de Certificats (AC) disponibles à partir de l’onglet Autorités du Gestionnaire de
certificats à partir de l’onglet Authentification du dialogue Options de QGIS.

Comme référencé dans le tableau de processus ci-dessus, la première étape est d’importer ou de référencer le
fichiers d’AC. Cette étape est optionnelle, est peut être inutile si votre chaîne de confiance PKI est originaire
d’AC racine déjà installés dans votre système d’exploitation (SE), tel qu’un certificat d’un vendeur commercial
de certificats. Si votre AC racine d’authentification n’est pas dans les AC racine reconnus par le SE, il devra être
importé ou avoir le chemin à son système de fichier référencé. (Contactez votre administrateur système en cas de
doute).

By default, the root CAs from your OS are available; however, their trust settings are not inherited. You should
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Figure 19.22: Processus de configuration PKI
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Figure 19.23: Ouvrir le gestionnaire de certificats

Figure 19.24: Éditeur d’Autorités de Certification
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review the certificate trust policy settings, especially if your OS root CAs have had their policies adjusted. Any
certificate that is expired will be set to untrusted and will not be used in secure server connections, unless you
specifically override its trust policy. To see the QGIS-discoverable trust chain for any certificate, select it and click

the Show information for certificate.

Figure 19.25: Boîte de dialogue d’information du Certificat

Vous pouvez modifier la politique de confiance de n’importe quel certificat de la chaîne. Toute modi-
fication dans la chaîne de confiance d’un certificat sélectionné ne sera pas enregistré dans la base de données

d’authentification tant que le bouton Enregistrer le changement de politique de confiance dans la base de données n’aura pas été
cliqué. Fermer la boîte de dialogue n’appliquera pas les changements de politique.

Figure 19.26: Sauvegarder les modifications dans les politiques de confiance

Vous pouvez analyser les AC filtrées, les certificats racine et intermédiaires qui seront reconnus de confiance pour

les connexions sécurisées ou modifier la politique de confiance par défaut en cliquant sur le bouton Options.

Avertissement: Modifier la politique de confiance par défaut peut engendrer des problèmes pour les connex-
ions sécurisées.

Vous pouvez importer des AC ou sauvegarder un chemin du système de fichier vers un fichier contenant plusieurs
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Figure 19.27: Menu des options d’autorités

AC ou importer chaque AC individuellement. Le format PEM standard pour les fichiers contenant plusieurs
chaîne de certification d’AC a le certificat racine à la fin du fichier et tous les certificats enfants signés, au dessus,
en remontant vers le début du fichier.

La boîte de dialogue d’import de certificat d’AC trouvera tous les certificats d’AC au sein du fichier, sans im-
portance d’ordre et offre également l’option d’importer des certificats considérés comme invalides (dans le cas
où vous souhaiteriez forcer leur politique de confiance). Vous pouvez modifier la politique de confiance lors de
l’import ou le faire plus tard à l’aide de l’éditeur des Autorités.

Figure 19.28: Dialogue d’import des certificats

Note: Si vous copiez les informations d’un certificat dans le champ Texte PEM, veuillez noter que les certificats
chiffrés ne sont pas gérés.

Identités

Vous pouvez gérer les paquets d’identité client depuis l’onglet Identités du Gestionnaire de certificat à partir de
l’onglet Authentification de la boîte de dialogue des Options de QGIS. Une identité est ce qui vous authentifie
auprès d’un service basé sur une IGC et consiste généralement en un certificat client et une clef privée, soit sous
forme de fichiers séparés, soit dans un seul fichier « empaqueté ». Le paquet ou la clef privée sont souvent protégés
par une phrase de passe.

Une fois que vous avez importé n’importe quelle Autorité de Certification (AC), vous pouvez importer n’importe
quel paquet d’identité dans la base de données d’authentification. Si vous ne voulez pas enregistrer les iden-
tités, vous pouvez référencer les chemins chemins de fichiers de leur composants au sein d’une configuration
d’authentification individuelle.
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Figure 19.29: Éditeur d’identités

Lorsque vous importez un paquet d’identité, il peut être protégé par une phrase de passe ou non protégé ou contenir
des certificats d’AC, formant ainsi une chaîne de confiance. Les chaînes de confiance ne seront pas importées ici;
elles peuvent être ajoutées séparément dans l’onglet Autorités

Une fois l’import réalisé, le certificat et la clef privée du paquet seront enregistrés dans la base de données chiffrée
à l’aide du mot de passe principal de QGIS. Les futurs utilisations du paquet enregistré depuis la base de données
nécésiteront alors uniquement l’entrée du mot de passe principal.

Les paquets d’identité personnelle gérés sont les formats PEM/DER (.pem/.der) et PKCS#12 (.p12/.pfx). Si une
clef ou un paquet est protégé par une passe de phrase, ce mot de passe est requis pour valider le composant avant
l’import. De même, si le certificat client du paquet est invalide (par exemple, sa date d’entrée en vigueur n’a pas
encore démaré ou le certificat est périmé), le paquet ne pourra pas être importé.

Figure 19.30: Import d’identité PEM/DER
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Figure 19.31: Import d’identité PKCS#12

19.2.4 Reprise des mauvaises couches

Occasionnellement, l’ID de configuration d’authentification qui est sauvegardée dans un projet peut ne plus être
valide, essentiellement parce que la base de données d’authentification est différente par rapport au moment où le
projet a été enregistré ou à cause de problème d’identifiants. Dans de tels cas, la boîte de dialogue Reprise des
mauvaises couches sera affichée lors du lancement de QGIS.

Figure 19.32: Reprise des mauvaises couches avec authentification

Si une source de données n’a pas d’ID de configuration d’authentification associée, vous pourrez l’éditer. Cela
permettra de mettre à jour automatiquement la chaîne de source de données, un peu comme ouvrir le fichier de
projet dans un éditeur de texte et de mettre à jour la chaîne de caractères correspondante.

19.2.5 Modification de l’ID de configuration d’authentification

Occasionally, you will need to change the authentication configuration ID that is associated with accessing a
resource. There are instances where this is useful:

• Resource auth config ID is no longer valid: This can occur when you have switched auth databases add
need to align a new configuration to the ID already associated with a resource.

• Shared project files: If you intended to share projects between users, e.g. via a shared file server, you can
predefine a 7-character (containing a-z and/or 0-9) that is associated with the resource. Then, individual
users change the ID of an authentication configuration that is specific to their credentials of the resource.
When the project is opened, the ID is found in the authentication database, but the credentials are different
per user.
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Figure 19.33: Édition de l’ID de configuration d’authentification pour une mauvaise couche

Figure 19.34: Modifier une ID de configuration d’authentification d’une couche (champ texte dévérouillé en
jaune).
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Avertissement: Modifier l’ID de configuration d’authentification est une opération avancée et ne doit être
employée qu’en pleine connaissance de sa nécessité. C’est pourquoi il y a un bouton de cadenas qui doit être
cliqué pour déverrouiller le champ de texte de l’ID avant de pouvoir la modifier.

19.2.6 Support Serveur QGIS

Lorsque vous utilisez un fichier de projet avec des couches disposant de configurations d’authentification, dans
une carte servie par QGIS Server, il faut ajouter certaines étapes supplémentaires pour que QGIS puisse charger
ces ressources:

• La base de données d’authentification doit être disponible.

• Le mot de passe principal de la base de données d’authentification doit être disponible.

Lors du lancement du système d’authentification, le serveur créera ou utilisera le fichier qgis-auth.
db situé dans le répertoire ~/.qgis2/ ou dans le répertoire défini par la variable d’environnement
QGIS_AUTH_DB_DIR_PATH. Dans le cas où le compte utilisateur utilisé par le serveur ne dispose pas d’un
répertoire HOME, utilisez la variable d’environnement pour indiquer un répertoire accessible en lecture/écriture
au compte utilisateur du serveur qui ne soit pas situé dans les répertoires accessibles par le web.

Pour indiquer un mot de passe principal au serveur, écrivez-le dans la première ligne d’un fichier lisible par les
processus du compte utilisateur du serveur et utilisez le chemin vers ce fichier dans la variable d’environnement
QGIS_AUTH_PASSWORD_FILE. Assurez-vous que ce fichier soit accessible uniquement en lecture par le
compte utilisateur du serveur et qu’il ne soit pas situé au sein des répertoires accessibles par le web.

Note: QGIS_AUTH_PASSWORD_FILE variable will be removed from the Server environment immediately
after accessing.

19.2.7 Exceptions du serveur SSL

Figure 19.35: Exception du serveur SSL

Vous pouvez gérer les configurations et exceptions du serveur SSL à partir de l’onglet Serveurs dans la section
Authentification de la boîte de dialogue Options de QGIS.

Quelque fois, lors de la connexion à un serveur SSL, des erreurs de « handshake » ou de certificat du serveur se
produisent. Vous pouvez ignorer ces erreurs ou créer une exception dans la configuration de serveur SSL. C’est
similaire au comportement des navigateurs internet qui vous permettent d’ignorer les erreurs SSL, mais avec plus
de contrôle granulaire.

Avertissement: Vous ne devriez pas créer une configuration de serveur SSL à moins que vous ayez une
parfaite connaissance de l’ensemble de la configuration SSL entre serveur et client. Vous devriez plutôt signaler
le problème au gestionnaire du serveur.
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Note: Certaines configurations PKI utilisent une chaîne de confiance AC totalement différente pour valider
l’identité des clients que la chaîne utilisée pour valider le certificat du serveur SSL. Dans de tels cas, toute con-
figuration créée pour la connexion au serveur ne résoudra pas nécessairement le problème de validation de votre
identité client, et ce n’est que l’émetteur de votre identité client ou le gestionnaire du serveur qui puisse résoudre
ce problème.

Vous pouvez pré-configurer la configuration d’un serveur SSL en cliquant sur le bouton . Ou, vous pouvez
ajouter une configuration lorsqu’une erreur SSL se produit durant la connexion et que le dialogue Erreur SSL
apparaît (lorsque l’erreur peut être temporairement ignorée ou alors sauvegardé dans la base de données et ignorée)
:

Figure 19.36: Ajouter manuellement une configuration

Une fois qu’une configuration SSL est enregistrée dans la base de données, elle peut être éditée ou effacée.

Si vous voulez pré-configurer une configuration SSL et que le dialogue d’import ne fonctionne pas avec la con-
nexion à votre serveur, vous pouvez activer manuellement une connexion dans la Console Python en utilisant le
code suivant (remplacer https://bugreports.qt-project.org par l’URL de votre serveur):

from PyQt4.QtNetwork import *
req = QNetworkRequest(QUrl('https://bugreports.qt-project.org'))
reply = QgsNetworkAccessManager.instance().get(req)

Cela ouvrira un dialogue d’erreur SSL si une erreur survient, où vous pourrez choisir de sauver la configuration
dans la base de données.
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Figure 19.37: Ajouter une configuration lors d’une erreur SSL

Figure 19.38: Configuration SSL existante
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Figure 19.39: Éditer une configuration SSL existante

19.3 Impératifs de sécurité

Lorsque le mot de passe principal est tapé, l’API est disponible pour accéder aux configurations d’authentification
de la base de données d’authentification, de façon similaire à ce que fait Firefox. Cependant, lors de la mise
en œuvre initiale, aucune protection contre l’accès à PyQGIS n’a été définie. Cela peut conduire à des prob-
lèmes lorsqu’un utilisateur télécharge/installe un plugin ou une application PyQGIS malicieux qui a accès aux
identifiants.

La solution rapide pour le déploiement initial de fonctionnalité est de ne pas inclure la plupart des liens pyQGIS
pour le système d’authentification.

Une autre solution simple, mais non robuste, est d’ajouter une liste déroulante dans Paramètres→ Options →
Authentification (défaut : « jamais ») :

"Allow Python access to authentication system"
Choices: [ confirm once per session | always confirm | always allow | never]

Un tel paramètre optionnel devra être sauvé dans un endroit dont Python n’a pas accès, par ex. la base de données
d’authentification, et encrypté avec le mot de passe principal.

• Une autre option serait de traquer quels sont les plugins que l’utilisateur utilise spécifiquement.

• autorisé à accéder au système d’authentification, bien qu’il puisse être compliqué de déduire quel est
l’extension qui passe l’appel.

• Isoler les extensions, peut être dans leurs propres environnements virtuels, réduirait le piratage « inter-
extension” des configurations d’authentification d’une extension qui est autorisée. Cela peut aussi vouloir
dire de limiter la communication entre extensions, mais peut être seulement entre les extensions de tiers.

• Une autre bonne solution est d’émettre des certificats pour signer le code des auteurs d’extensions approu-
vés. Puis de valider le certificat de l’extension lors du chargement. En cas de besoin, l’utilisateur pourrait
directement définir une politique de non-confiance pour le certificat associé à l’extension en utilisant les
dialogues de gestion des certificats.

• Alternativement, accès aux données sensitives du système d’authentification à partir de Python

• ne devrait jamais être permis, et seulement l’utilisation des gadgets de base de QGIS ou la duplication des in-
tégrations du système d’authentification, pourrait permettre à l’extension de fonctionner avec les ressources
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qui ont une configuration d’authentification, tout en ayant le mot de passe principal et la configuration
d’authentification chargés dans l’espace de l’application principale.

Les mêmes préoccupations de sécurité s’appliquent aux extensions C++, mais il sera plus difficile d’en restreindre
l’accès, car il n’y a pas de fonction de correspondance qui peut être retirée comme c’est le cas pour Python.

19.3.1 Contraintes

Les problèmes confus de licensing and exporting associés à OpenSSL s’appliquent. Pour que Qt puisse fonctionner
avec les certificats d’OpenSSL, il a besoin d’avoir accès aux librairies d’OpenSSL. Suivant la façon dont Qt est
compilé, le défaut est de se lier dynamiquement aux librairies d’OpenSSL lors de l’exécution (pour contourner les
limitations de l’export).

QCA suit une tactique similaire, où la liaison à QCA n’a aucune contrainte, parce que l’extension qca-ossl
(OpenSSL) est chargée lors de l’exécution. L’extension qca-ossl est directement liée aux librairies OpenSSL.
Les développeurs sont ceux qui doivent s’assurer que toutes les contraintes de liens d’OpenSSL soient satisfaites,
s’ils publient l’extension. Peut être, je n’en suis pas sûr, je ne suis pas un avocat.

Le système d’authentification se déactive sans risque lorsque qca-ossl n’est pas trouvé lors de l’exécution.
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CHAPTER 20

Intégration du SIG GRASS

L’intégration de GRASS fournit un accès aux bases de données et aux fonctionnalités du SIG GRASS (voir le
projet GRASS Bibliographie). L’intégration est formée de deux parties: le fournisseur de données et l’extension.
Le fournisseur de données permet de naviguer, de gérer et de visualiser des rasters et des couches vecteurs GRASS.
L’extension peut être utilisée pour créer de nouveaux secteurs GRASS ainsi que des jeux de données, modifier la
région GRASS, créer et mettre à jour des couches vecteurs et analyser des données GRASS en 2D ou 3D avec
l’aide des plus de 400 modules GRASS disponibles. Dans cette section, nous introduirons les fonctionnalités
du fournisseur et de l’extension et nous donnerons quelques exemples de gestion et de tâches réalisées avec des
données GRASS.

Le fournisseur gère les version 6 et 7 de GRASS, de même que l’extension (à partir de QGIS 2.12). La distribution
de QGIS peut contenir le fournisseur/extension soit pour GRASS 6, soit pour GRASS 7, soit pour les deux en
même temps (les binaires ont des noms différents). Neanmoins, seule une version du fournisseur/extension peut
être chargée lors du fonctionnement.

20.1 Jeu de données de démonstration

As an example, we will use the QGIS Alaska dataset (see section Téléchargement des données exemple). It
includes a small sample GRASS LOCATION with three vector layers and one raster elevation map. Create a
new folder called grassdata, download the QGIS “Alaska” dataset qgis_sample_data.zip from https:
//qgis.org/downloads/data/ and unzip the file into grassdata.

More sample GRASS LOCATIONs are available at the GRASS website at https://grass.osgeo.org/download/
sample-data/.

20.2 Charger des données GRASS raster et vecteur

If the provider is loaded in QGIS, the location item with GRASS icon is added in the browser tree under each
folder item which contains GRASS location. Go to the folder grassdata and expand location alaska and
mapset demo.

Vous pouvez charger un raster et des couches vecteur GRASS comme n’importe quelle autre couche depuis le
navigateur soit en double-cliquant sur en entrée de couche ou par un glisser-déposer dans le canevas de carte ou
dans la légende.
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Astuce: Charger des données GRASS

Si vous ne pouvez pas voir de secteur GRASS, vérifiez dans Aide → A propos → Fournisseurs si le fournisseur
de données vecteur est chargé.

20.3 Importer des données dans un SECTEUR GRASS par glisser-
déposer

Cette section donne un exemple de comment importer des données raster et vecteur dans un jeu de données
GRASS.

1. Dans le navigateur QGIS, déplacez-vous dans le jeu de données dans lequel vous souhaitez importer des
données.

2. Dans le navigateur QGIS, trouvez une couche que vous souhaitez importer dans GRASS; vous pouvez
ouvrir une autre instance du navigateur (Explorateur (2)) si la source de données est trop éloignée du jeu de
données dans l’arbre.

3. Faîtes un glisser-déposer dans le jeu de données cible. L’import peut prendre un certain temps pour les
couches volumineuses et vous verrez l’icône animée en face des nouvelles entrées de couches jusqu’à ce
que l’import soit terminé.

Lorsque les données raster sont dans ces SCR différents, elles peuvent être reprojetées en utilisant une transfor-
mation Approximée (rapide) ou Exacte (précise). Si un lien vers une source raster est créé (via r.external)
et que la donnée source est dans le même SCR et que le format est géré par GDAL alors le SCR de la source de
données sera utilisé. Vous pouvez paramétrer ces options dans l’onglet Explorateur dans

Si un raster source a plus d’une seule bande, une nouvelle carte GRASS est créée à partir de chaque couche avec

un suffixe .<numéro de bande> et un groupe de toutes les cartes avec l’icône est créé. Les rasters externes

ont une icône différente .

20.4 Gérer GRASS depuis l’Explorateur QGIS

• Copier des données: les cartes GRASS peuvent être copiées entre les jeux de données au sein du même
secteur par glisser-déposer.

• Supprimer des cartes: Faire un clic droit sur la carte GRASS et sélectionner Supprimer à partir du menu
contextuel.

• Renommer des cartes: Faire un clic-droit sur une carte GRASS et sélectionner Renommer depuis le menu
contextuel.

20.5 Options GRASS

Les options GRASS peuvent être paramétrées dans la boîte de dialogue Options GRASS qui peut être ouverte en
faisant un clic droit sur le secteur ou le jeu de données dans l’explorateur et en choisissant Options GRASS.

20.6 Lancer l’extension GRASS

To use GRASS functionalities in QGIS, you must select and load the GRASS plugin using the Plugin Manager.

To do this, go to the menu Plugins → Manage and Install Plugins. . . , select GRASS and click OK.
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Les fonctionnalités principales suivantes sont fournies par la barre d’outils (Extensions → GRASS) lorsque vous
lancez l’extension GRASS :

• Ouvrir le jeu de données

• Nouveau jeu de données

• Fermer le jeu de données

• Ouvrir les outils GRASS

• Afficher la région courante GRASS

• Options GRASS

20.7 Ouvrir un jeu de données GRASS

Un jeu de données GRASS doit être ouvert pour avoir accès aux outils GRASS dans l’extension (les outils sont
désactivés si aucun jeu de cartes n’est ouvert). Vous pouvez ouvrir un jeu de données à partir de l’explorateur:
faîtes un clic droit sur un jeu de données et choisissez Ouvrir le jeu de données à partir du menu contextuel.

20.8 Secteur et Jeu de données GRASS

Les données GRASS sont stockées dans un répertoire référencé sous le nom GISDBASE. Ce répertoire, souvent
appelé grassdata, doit être créé avant que vous commenciez à travailler avec l’extension GRASS dans QGIS.
Dans ce répertoire, les données GRASS sont organisées par projets et stockées dans des sous-répertoires appelés
SECTEUR ( LOCATION en Anglais). Chaque SECTEUR est défini par son système de coordonnées, sa projection
et son étendue géographique. Chaque SECTEUR peut contenir plusieurs Jeux de données (MAPSETs en
Anglais) (sous-répertoires du SECTEUR) qui sont utilisés pour subdiviser le projet en différents thèmes, sous
régions ou espaces de travail pour chaque membre d’une équipe (Neteler & Mitasova 2008 Bibliographie). Pour
pouvoir analyser des couches raster ou vecteur à l’aide des modules GRASS, vous devez les importer dans un
SECTEUR. (Ce n’est pas complètement vrai, car avec les modules GRASS r.external et v.external,
vous pouvez lier (en lecture seule) des données externes gérées par GDAL/OGR sans les importer. Comme il ne
s’agit pas d’une fonctionnalité courante pour les débutants sur GRASS, elle ne sera pas décrite ici).

20.9 Importer des données dans un SECTEUR GRASS

Consultez la section Importer des données dans un SECTEUR GRASS par glisser-déposer pour voir comment les
données peuvent être facilement importées par glisser-déposer dans l’explorateur.

Cette section donne un exemple d’importation de données raster et vecteur dans le SECTEUR GRASS “alaska”
fournit dans le jeu de données QGIS “Alaska”, de la manière la plus classique, en utilisant les modules GRASS de
base. Nous utiliserons la couche raster d’occupation du sol landcover.img et la couche vectorielle au format
GML lakes.gml, toutes deux présentes dans le jeu de données “Alaska” (voir Téléchargement des données
exemple).

1. Démarrez QGIS et assurez vous que l’extension GRASS est chargée.

2. Dans la barre d’outils GRASS, cliquez sur Ouvrir un jeu de données pour ouvrir l’assistant Jeu de données.

3. Select as GRASS database the folder grassdata in the QGIS Alaska dataset, as LOCATION “alaska”, as
MAPSET “demo” and click OK.

4. Maintenant cliquez sur Ouvrir les outils GRASS. La boîte à outils GRASS s’ouvre (voir section La Boîte à
outils GRASS).
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Figure 20.1: Données GRASS du SECTEUR Alaska

5. Pour importer la couche raster landcover.img, cliquez sur le module r.in.gdal dans l’onglet Ar-
borescence des modules. Ce module GRASS vous permet d’importer les fichiers raster gérés par la librairie
GDAL dans un SECTEUR GRASS. La fenêtre r.in.gdal apparaît.

6. Naviguer jusqu’au répertoire raster dans le jeu de données QGIS “Alaska” et sélectionnez le fichier
landcover.img.

7. As raster output name, define landcover_grass and click Run. In the Output tab, you see
the currently running GRASS command r.in.gdal -o input=/path/to/landcover.img
output=landcover_grass.

8. When it says Successfully finished, click View Output. The landcover_grass raster layer is now
imported into GRASS and will be visualized in the QGIS canvas.

9. Pour importer le fichier GML lakes.gml, cliquez sur le module v.in.ogr dans l’onglet Arbores-
cence des modules. Ce module vous permet d’importer des données vectorielles gérées par OGR dans un
SECTEUR GRASS. La fenêtre v.in.ogr apparaît.

10. Naviguer jusqu’au répertoire gml dans le jeu de données QGIS “Alaska” et sélectionnez le fichier lakes.
gml.

11. As vector output name, define lakes_grass and click Run. You don’t have to care about the other
options in this example. In the Output tab you see the currently running GRASS command v.in.ogr -o
dsn=/path/to/lakes.gml output=lakes\_grass.

12. When it says Succesfully finished, click View Output. The lakes_grass vector layer is now imported
into GRASS and will be visualized in the QGIS canvas.

20.9.1 Créer un nouveau SECTEUR GRASS

À titre d’exemple, voici le SECTEUR alaska GRASS, projeté en Albers Equal Area et ayant pour unité le pied.
Ce SECTEUR alaska sera utilisé pour tous les exemples et exercices GRASS qui suivent. Il est utile de le
télécharger et de l’installer sur votre ordinateur (voir Téléchargement des données exemple).

1. Démarrez QGIS et assurez vous que l’extension GRASS est chargée.
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2. Affichez le shapefile alaska.shp (voir section Charger une couche à partir d’un fichier) du jeu de don-
nées QGIS Alaska (voir Téléchargement des données exemple).

3. Dans la barre d’outils GRASS, cliquez sur Nouveau jeu de données pour ouvrir l’assistant de création de Jeux
de données.

4. Select an existing GRASS database (GISDBASE) folder grassdata, or create one for the new
LOCATION using a file manager on your computer. Then click Next.

5. Nous pouvons utiliser cet assistant à la fois pour créer un nouveau Jeu de données dans un SECTEUR
existant (voir section Ajouter un nouveau Jeu de données) et pour créer également un nouveau SECTEUR.

Cliquez sur le bouton radio Créez un nouveau secteur (voir figure_grass_new_location).

6. Enter a name for the LOCATION – we used “alaska” – and click Next.

7. Définissez la projection en cliquant sur le bouton radio Projection pour activer la liste des projections.

8. Nous utilisons la projection Albers Equal Area Alaska (pieds). Étant donné que nous savons qu’elle cor-
respond au code EPSG 2964, nous le saisissons dans le champ de recherche. (Note : Si vous souhaitez
reproduire la manipulation pour un autre SECTEUR et une autre projection dont vous ne connaissez pas le

code EPSG, cliquez sur Statut de la projection dans le coin inférieur droit de la barre d’état de QGIS (voir
section Utiliser les projections)).

9. Saisissez 2964 dans le Filtre pour sélectionner la projection.

10. Click Next.

11. To define the default region, we have to enter the LOCATION bounds in the north, south, east, and west
directions. Here, we simply click on the button Set Current QGIS Extent, to apply the extent of the loaded
layer alaska.shp as the GRASS default region extent.

12. Click Next.

13. Nous avons aussi besoin de définir un Jeu de données dans notre nouveau SECTEUR (étape indispens-
able lors de la création d’un nouveau SECTEUR). Vous pouvez l’appeler comme vous le souhaitez - nous
utiliserons “demo”. GRASS crée automatiquement un Jeu de données spécial appelé PERMANENT,
conçu pour stocker les données essentielles du projet, son emprise spatiale par défaut et la définition du
système de coordonnées (voir Neteler & Mitasova 2008 Bibliographie).

14. Check out the summary to make sure it’s correct and click Finish.

15. Le nouveau SECTEUR “alaska” et les deux Jeux de données “démo” et “PERMANENT” sont créés.
Le jeu de données ouvert à ce moment est “démo”, tel que vous l’avez défini.

16. Notez que certains outils de la barre d’outils GRASS qui n’étaient pas accessibles le sont maintenant.

Figure 20.2: Créer un nouveau SECTEUR ou Jeu de données GRASS dans QGIS

Si ce processus semble long, il s’agit en fait d’un moyen simple et rapide de créer un SECTEUR. Le SECTEUR
“alaska” est maintenant prêt pour l’importation de données (voir section Importer des données dans un SECTEUR
GRASS). Vous pouvez également utiliser des données raster ou vecteur existantes dans le SECTEUR “alaska”
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inclues dans le jeu de données QGIS “Alaska” Téléchargement des données exemple et continuez avec la section
Le modèle vecteur de GRASS.

20.9.2 Ajouter un nouveau Jeu de données

Un utilisateur a seulement des droits d’écriture sur le Jeu de données GRASS qu’il a créé. Cela veut dire,
qu’au-delà de l’accès à son propre Jeu de données GRASS, vous pouvez lire les Jeux de données des
autres utilisateurs (et ils peuvent lire le votre), mais vous ne pouvez modifier ou supprimer que les données de
votre propre Jeu de données.

Tous les Jeux de données incluent un fichier WIND qui stocke l’emprise et la résolution raster courante (voir
Neteler & Mitasova 2008 dans Bibliographie et section L’outil région GRASS).

1. Démarrez QGIS et assurez vous que l’extension GRASS est chargée.

2. Dans la barre d’outils GRASS, cliquez sur Nouveau jeu de données pour ouvrir l’assistant de création de Jeux
de données.

3. Sélectionnez le répertoire grassdata de la base de données GRASS (GISDBASE) qui contient déjà le
SECTEUR “alaska” et où nous voulons ajouter un autre SECTEUR nommé “test”.

4. Click Next.

5. We can use this wizard to create a new MAPSET within an existing LOCATION or to create a new

LOCATION altogether. Click on the radio button Select location (see figure_grass_new_location) and
click Next.

6. Entrez le texte du nom pour le nouveau Jeu de données. En dessous, dans l’assistant, vous pouvez
voir une liste des Jeux de données et de leurs propriétaires.

7. Click Next, check out the summary to make sure it’s all correct and click Finish.

20.10 Le modèle vecteur de GRASS

Il est important de comprendre le modèle de données vectorielles GRASS avant de se lancer dans la numérisation.
En général, GRASS utilise un modèle de données vectorielles topologique. Cela signifie que les surfaces ne sont
pas représentées par des polygones fermés et distincts, mais par une ou plusieurs limites. Une limite entre des
polygones adjacents n’est numérisée qu’une seule fois et est partagée par les deux surfaces. Les limites doivent
être connectées sans trous. Une surface est identifiée (et libellée) via le centroïde de la surface.

Outre les limites et centroïdes, une couche vectorielle peut également contenir des points et des lignes. Tous ces
éléments de géométrie peuvent être mélangés dans une couche vectorielle et seront représentés dans différentes
“sous-couches” dans une carte vectorielle GRASS. Ainsi, une couche GRASS n’est pas un vecteur ou un raster,
mais un niveau à l’intérieur d’une couche vectorielle. Il est important de bien distinguer ceci (même s’il est pos-
sible de mélanger des éléments de géométries différentes, c’est inhabituel et même dans GRASS, on l’utilise dans
des cas particuliers tel que l’analyse de réseau. Normalement, vous devriez stocker des éléments de géométries
différentes dans des couches différentes).

Il est possible de stocker plusieurs “sous-couches” dans une couche vectorielle. Par exemple, des champs, de la
forêt et des lacs peuvent être stockés dans une couche vectorielle. Des forêts et des lacs adjacents partagent les
mêmes limites, mais ils auront des tables attributaires différentes. Il est aussi possible de faire correspondre une
table attributaire aux limites. Par exemple, la limite entre un lac et une forêt peut être une route qui peut avoir une
table attributaire différente.

La “sous-couche” est définie dans GRASS par un chiffre. Ce chiffre définit s’il y a plusieurs sous-couches
à l’intérieur d’une couche vectorielle (par exemple, il définit s’il s’agit de lac ou de forêt). Pour l’instant, il
s’agit d’un nombre, mais dans des versions futures GRASS pourra utiliser des noms pour les sous-couches dans
l’interface utilisateur.

Les données attributaires peuvent être stockées dans le SECTEUR au format dBase, SQLite3 ou dans des tables
de bases de données externes comme par exemple : PostgreSQL, MySQL, Oracle, etc.
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Les données attributaires sont liées à la géométrie par le biais d’un champ “category”.

“Category” (clé, ID) est un entier attaché à la géométrie, et il est utilisé comme lien vers une colonne de clé dans
la table de base de données.

Astuce: Apprendre le modèle vecteur de GRASS

The best way to learn the GRASS vector model and its capabilities is to download one of the many GRASS
tutorials where the vector model is described more deeply. See https://grass.osgeo.org/documentation/manuals/
for more information, books and tutorials in several languages.

20.11 Création d’une nouvelle couche vectorielle GRASS

Pour créer un nouvelle couche vecteur GRASS, sélectionnez une des entrées suivantes dans le menu contextuel
d’un jeu de données:

• Nouvelle couche de points

• Nouvelle couche de lignes

• Nouvelle couche de polygones

et saisissez un nom dans la boîte de dialogue. Une nouvelle carte vecteur sera créée et la couche sera ajoutée
au canevas en mode édition. Sélectionner le type de couche ne restreint pas le type géométrique qui peut être
numérisé dans la couche vecteur. Dans GRASS, il est possible d’organiser toute sorte de type géométrique (point,
ligne et polygone) au sein d’une même couche. Le type est uniquement utilisé pour ajouter une couche au canevas
de cartes car QGIS impose qu’une couche ait un seul type géométrique.

Il est également possible d’ajouter les couches aux couches vecteurs existantes en sélectionnant une des entrées
décrites ci-dessus depuis le menu contextuel de la carte vecteur existante.

Dans GRASS, il est possible de gérer plusieurs types de géométrie (point, ligne et surface) dans une seule couche
d’information, car GRASS utilise un modèle vecteur topologique. Vous n’avez donc pas besoin de sélectionner
un type de géométrie quand vous créez une couche vectorielle GRASS. Ce comportement est différent de celui
de la création de shapefile avec QGIS, car les shapefiles utilisent un modèle vecteur d’entité simple (voir section
Creating new vector layers).

20.12 Numérisation et édition de couche vectorielle GRASS

Les couches vecteur GRASS peuvent être numérisées en utilisant les outils de numérisation standards de QGIS. Il
existe néanmoins quelques particularités dont vous devez avoir notion, dues

• au modèle topologique de GRASS comparé aux entités simples de QGIS.

• à la complexité du modèle GRASS.

– au couches multiples dans des cartes simples.

– à plusieurs types géométriques dans une seule carte.

– au partage de géométries par plusieurs entités de plusieurs couches.

Les particularités sont discutées dans les sections qui suivent.

Enregistrer, annuler les modifications, annuler, refaire

Avertissement: Toutes les modifications faites pendant l’édition sont immédiatement écrites dans la couche
vecteur et les tables attributaires associées.
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Les modifications sont écrites après chaque opération mais il est possible d’annuler / refaire une modification ou
toutes les modifications au moment de fermer l’édition. Si une annulation partielle ou complète est utilisée, l’état
d’origine est ré-écrit dans la couche vectorielle et ses tables attributaires associées.

Il y a deux raisons principales à ce comportement :

• Il est dans la nature de GRASS que l’utilisateur sait vraiment ce qu’il veut faire pour les couches vecteurs et
qu’il vaut mieux avoir sauvegardé les données lorsque le travail est soudainement interrompu (par exemple,
lors d’un plantage).

• La nécessité pour une édition correcte de données topologiques de disposer d’une information visuelle sur
le respect des règles topologiques, une telle information peut uniquement être acquise depuis une couche
vecteur GRASS si les changements sont écrits dans la couche.

Barre d’outils

La “barre d’outils de numérisation” dispose d’outils spécifiques lorsqu’une couche GRASS est en édition:

Icône Outil Fonction

Nouveau Point Numérise un nouveau point

Nouvelle Ligne Numérise une nouvelle ligne

Nouveau Contour Numériser une nouvelle enveloppe.

Nouveau Centroïde Numérise un nouveau centroïde (permet d’étiqueter un polygone exis-
tant)

Nouvelle enveloppe fer-
mée.

Numériser une nouvelle enveloppe fermée.

Table des outils d’édition GRASS

Astuce: Numérisation de polygones dans GRASS

Si vous voulez créer un polygone dans GRASS, vous devez numériser premièrement les limites du polygone.
Ensuite, vous ajoutez un centroïde (emplacement de l’étiquette) dans le polygone fermé. La raison en est, que
le modèle vectoriel topologique assure toujours le lien entre les informations d’attributs des polygones via le
centroïde et non via la limite.

Categorie

La catégorie, souvent appelée cat est une sorte d’identifiant. Le nom a pour origine l’époque où les vecteurs
GRASS avaient un seul attribut « catégorie ». La catégorie est utilisée comme lien entre les géométries et les
attributs. Une géométrie unique peut avoir plusieurs catégories et ainsi représenter plusieurs entités dans dif-
férentes couches. Pour le moment, il n’est possible d’assigner qu’une seule catégorie par couche en utilisant les
outils d’édition dans QGIS. Les nouvelles entités ont une nouvelle catégorie unique, à l’exception des enveloppes.
Les enveloppes forment généralement des surfaces et ne représentent pas des entités linéaires, il est néanmoins
possible de définir des attributs pour une enveloppe ultérieurement, par exemple dans une couche différente.

Les nouvelles catégories sont toujours créées uniquement dans la couche en cours d’édition.

Il n’est pas possible d’affecter plusierus catégories aux géométries en utilisant l’édition dans QGIS, ces don-
nées sont correctement représentées sous forme d’entités multiples et les entités individuelles, même issues de
différentes couches, peuvent être supprimées.

Attributs

Les attributs de la couche en cours d’édition peuvent seulement être modifiés. Si la carte vecteur contient plusieurs
couches, les entités des autres couches auront leurs attributs paramétrés sur “<non éditable (couche #)>” pour vous
prévenir que tel attribut n’est pas modifiable. La raison est que les autres couches peuvent avoir différents jeux
d’attributs alors que QGIS ne gère qu’un seul jeu de champs par couche.
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Si une primitive géométrique ne dispose pas de catégorie, une nouvelle catégorie unique est automatiquement
affectée et un nouvel enregistrement dans la table d’attribut est créé lorsqu’un attribut de cette géométrie est
modifié.

Astuce: Si vous voulez réaliser des mises à jour massives d’attributs dans la table, par exemple, à l’aide de
la “Calculatrice de Champs” (Using the Field Calculator), et qu’il existe des entités sans catégorie que vous ne
souhaitez pas mettre à jour (typiquement les enveloppes), vous pouvez les filtrer en paramétrant le “Filtre Avancé”
sur cat is not null.

Style d’édition

La symbologie topologique est indispensable à l’édition des données topologiques. Lorsque l’édition démarre, un
rendu spécifique “Édition GRASS” est automatiquement appliqué à la couche et le moteur de rendu originel est
restauré lorsque l’édition prend fin. Le style peut être modifié dans l’onglet “Style” des propriétés de la couche.
Le style peut également être enregistré dans le fichier de projet ou dans un fichier séparé comme tout autre style.
Si vous personnalisez le style, ne modifiez pas son nom car il est utilisé pour restaurer le style lorsque l’édition est
à nouveau effective.

Astuce: N’enregistrez pas le fichier de projet lorsque la couche est en cours d’édition; la couche serait alors
enregistrée avec le “Style d’édition” qui n’a aucun sens si la couche n’est pas en cours d’édition.

Le style est basé sur l’information topologique qui est temporairement ajoutée à la table des attributs dans le
champ “topo_symbol”. Ce champ est automatiquement supprimé lorsque l’édition prend fin.

Astuce: Ne supprimez pas le champ “topo_symbol” de la table d’attributs, cela rendrait les entités non visibles
car le moteur de rendu est basé sur le contenu de cette colonne.

Accrochage

Pour construire une surface, les sommets des enveloppes connectées doivent avoir exactement les mêmes co-
ordonnées. Cela peut se faire en utilisant l’outil d’accrochage uniquement si le canevas de carte et la couche
vecteur partagent le même SCR. Dans le cas contraire, la conversion des coordonnées de la couche au canevas
peut entraîner de légères différences dues aux transformations de SCR.

Astuce: Utilisez le SCR de la couche pour le canevas de cartes lors de l’édition.

Limites

Éditer plusieurs couches en même temps au sein du même jeu de données vecteur n’est pas géré. Cela est du à
l’impossibilité de gérer plusieurs piles d’annulation pour une seule source de données.

Sous Linux et macOS, une seule couche GRASS peut être modifiée à la fois. Cela est dû à un bug dans
GRASS qui ne permet pas de fermer les pilotes de base de données dans un ordre aléatoire. Cela sera corrigé par
les développeurs GRASS.

Astuce: Droits d’édition GRASS

Vous devez être propriétaire du Jeu de données que vous voulez éditer. Il est impossible de modifier des
informations d’un Jeu de données qui n’est pas à vous, même si vous avez des droits en écriture.
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20.13 L’outil région GRASS

La définition d’une région (définir une emprise spatiale de travail) dans GRASS est très importante pour travailler
avec des couches rasters. Le travail d’analyse vecteur n’est, par défaut, pas limitée à une région définie. Mais, tous
les rasters nouvellement créés auront l’emprise spatiale et la résolution de la région GRASS en cours d’utilisation,
indépendamment de leur emprise et résolution d’origine. La région courante GRASS est stockée dans le fichier
$LOCATION/$MAPSET/WIND, et celui-ci définit les limites Nord, Sud, Est et Ouest, le nombre de lignes et de
colonnes ainsi que la résolution spatiale horizontale et verticale.

Il est possible d’afficher ou de masquer l’emprise de la région GRASS dans QGIS à l’aide du bouton
Afficher la région courante GRASS.

The region can be modified in “Region” tab in “GRASS Tolls” dock widget. Type in the new region bounds and
resolution, and click Apply. If you click on Select the extent by dragging on canvas you can select a new region
interactively with your mouse on the QGIS canvas dragging a rectangle.

Le module GRASS g.region propose un grand nombre de paramètres pour définir de façon appropriée les
limites et la résolution d’une région pour faire de l’analyse raster. Vous pouvez vous servir de ces paramètres dans
la boîte à outils GRASS décrite dans la section La Boîte à outils GRASS.

20.14 La Boîte à outils GRASS

La fenêtre Ouvrir les outils GRASS donne accès aux fonctionnalités GRASS qui permettent de travailler sur les
données d’un SECTEUR et d’un Jeu de données. Pour utiliser la Boîte à outils GRASS, vous devez ouvrir
un SECTEUR et un Jeu de données sur lequel vous avez des droits d’écriture (que vous avez normalement si
vous avez créé le Jeu de données). Cela est nécessaire car les rasters et les vecteurs nouvellement créés lors
des analyses doivent être écrits dans le SECTEUR et Jeu de données courant.

Figure 20.3: Boîte à outils GRASS et arbre des modules.
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20.14.1 Travailler avec les modules GRASS

La console de la Boîte à outils GRASS vous donne accès à pratiquement tous les modules GRASS (plus de 300)
en ligne de commande. Afin d’offrir un environnement de travail plus agréable, environ 200 d’entre eux sont
disponibles via l’interface graphique de la Boîte à outils GRASS.

A complete list of GRASS modules available in the graphical Toolbox in QGIS version 3.4 is available in the
GRASS wiki at https://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

Il est aussi possible de personnaliser le contenu de la boîte à outils GRASS. Ceci est décrit dans la section
Paramètrer la boîte à outils GRASS.

Comme indiqué sur la figure figure_grass_toolbox, vous pouvez chercher le module GRASS approprié en utilisant
l’onglet Arborescence des modules ou en utilisant l’onglet Liste des Modules pour faire une recherche.

Lorsque vous cliquez sur un module, un nouvel onglet apparaît proposant trois sous-onglets : Options, Rendu et
Manuel.

Options

L’onglet Options propose une interface simplifiée où vous pouvez sélectionner un raster ou un vecteur en cours de
visualisation dans QGIS et saisir les paramètres spécifiques au module avant de le lancer.

Figure 20.4: Boîte à outils des modules GRASS: Options.

Tous les paramètres du module ne sont généralement pas fournis afin de simplifier les fenêtres. Pour utiliser des
paramètres qui ne se trouvent pas dans la fenêtre, vous devez utiliser la console GRASS et lancer les modules en
lignes de commande.

Une nouvelle fonctionnalité depuis QGIS 1.8.0 est l’ajout d’un bouton Afficher les options avancées >> en-
dessous de la fenêtre simplifiée de l’onglet Options. Pour l’instant seul le module v.in.ascii a été adapté afin
de servir d’exemple d’utilisation mais d’autres le seront dans les prochaines versions de QGIS. La finalité est de
pouvoir recourir à toutes les options de GRASS sans devoir ouvrir la console GRASS.

Rendu

The Output tab provides information about the output status of the module. When you click the Run button, the
module switches to the Output tab and you see information about the analysis process. If all works well, you will
finally see a Successfully finished message.

Manuel
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Figure 20.5: Boîte à outils des modules GRASS: Sortie.

Figure 20.6: Boîte à outils de module GRASS: Manuel.
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L’onglet Manuel montre la page HTML d’aide du module GRASS. Vous pouvez vous en servir pour voir les autres
paramètres du module et pour avoir une connaissance plus approfondie de l’objet du module. À la fin de chaque
page d’aide d’un module, vous avez des liens vers Main Help index (index principal), Thematic.index
(index par thème) et Full.index (index complet). Ces liens vous donnent les mêmes informations que si vous
utilisiez directement g.manual.

Astuce: Afficher les résultats immédiatement

Si vous voulez voir immédiatement dans votre fenêtre carte le résultat des calculs du module, vous pouvez utiliser
le bouton “Vue” au bas de l’onglet du module.

20.14.2 Exemples de modules GRASS

Les exemples suivants décrivent les possibilités de certains modules GRASS.

Création de courbes de niveau

Le premier exemple permet de créer une couche vectorielle de courbes de niveau à partir d’un modèle numérique
de terrain (MNT). Ici, nous considérerons que le SECTEUR Alaska a été installé comme décrit dans la section
Importer des données dans un SECTEUR GRASS.

• Premièrement, ouvrez le secteur en cliquant sur le bouton Ouvrir le jeu de données et choisissez le secteur
Alaska.

• Ouvrez la boite à outils à l’aide du bouton Ouvrir les outils GRASS.

• Dans la liste des outils double-cliquez sur Raster -> Gestion de surface -> Générer des lignes vectorielles
de contours.

• Maintenant, cliquez sur l’outil r.contour, cela ouvrira une fenêtre comme expliqué ci-dessus (voir Travailler
avec les modules GRASS).

• Dans le Nom de la couche raster en entrée saisissez gtopo30.

• Dans le champ Increment between Contour levels , saisissez la valeur 100. (Cela va créer des courbes
de niveau tous les 100 mètres)

• Saisisez dans le champ Nom de la couche vectorielle en sortie, le nom ctour_100.

• Click Run to start the process. Wait for several moments until the message Successfully finished
appears in the output window. Then click View Output and Close.

Comme il s’agit d’une grande région, cela prendra un certain temps à s’afficher. Une fois l’affichage terminé, vous
pouvez ouvrir la fenêtre de propriétés de la couche pour changer la couleur des courbes de niveau afin qu’elles
apparaissent clairement au dessus de la couche raster d’élévation comme décrit dans Fenêtre Propriétés d’une
couche vecteur.

Zoomez sur une petite région montagneuse du centre de l’Alaska. Avec un zoom important, vous constaterez
que les courbes de niveau sont constituées de lignes brisées avec des angles vifs. GRASS offre la possibilité de
généraliser les cartes vecteurs à l’aide de l’outil v.generalize, tout en conservant leur forme générale. L’outil utilise
différents algorithmes ayant différents objectifs. Certains de ces algorithmes (par exemple : Douglas Peucker et
Réduction de Vertex) simplifient les lignes en supprimant des sommets. La couche simplifiée se chargera plus
rapidement. Cette commande est utile lorsque vous avez une couche vectorielle très détaillée et que vous créez
une carte à petite échelle où les détails ne sont donc pas nécessaires.

Astuce: L’outil de simplification

Vous remarquerez que QGIS dispose de l’outil Vecteur → Outils de géométrie → Simplifier les géométries qui
fonctionne comme l’algorithme Douglas-Peucker de GRASS, v.generalize.
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Cependant, le but de cet exemple est différent. Les courbes de niveau créées avec r.contour ont des angles vifs
qui doivent être lissés. Parmi les algorithmes de v.generalize, il y a l’algorithme de Chaiken qui fait justement ça
(comme Hermite splines). Gardez à l’esprit que ces algorithmes peuvent ajouter des sommets supplémentaires
au vecteur, l’amenant à se charger encore plus lentement.

• Ouvrez la Boîte à outils GRASS et double cliquez sur Vecteur -> Développer la carte -> Généralisation.
Cliquez alors sur le module v.generalize pour ouvrir sa fenêtre d’options.

• rifier que la couche vectorielle “ctour_100” apparait dans le champ Nom de la couche vectorielle en entrée.

• From the list of algorithms, choose Chaiken’s. Leave all other options at their default, and scroll down to
the last row to enter in the field Name for output vector map “ctour_100_smooth”, and click Run.

• The process takes several moments. Once Successfully finished appears in the output windows,
click View Output and then Close.

• Vous pouvez changer la couleur de cette couche vectorielle pour qu’elle apparaisse clairement sur le raster
et qu’elle contraste aussi avec la couche de départ.Vous remarquerez que les nouvelles courbes de niveau
ont des angles plus arrondis que l’original tout en restant fidèle à la forme globale d’origine.

Figure 20.7: Module GRASS v.generalize utilisé pour adoucir une couche vectorielle.

Astuce: Autres utilisations de r.contour

La procédure décrite ci-dessus peut être utilisée dans d’autres cas similaires. Si vous disposez d’une couche
d’informations raster représentant des précipitations, par exemple, vous pouvez utiliser la même méthode pour
créer des isohyètes (lignes reliant des points d’égales quantités de précipitations).

Créer un ombrage avec effet 3D

Différentes méthodes sont utilisées pour afficher les modèles numérique de terrain et donner un effet 3D au carte.
L’utilisation de courbes de niveau comme décrit ci-dessus est un des moyens souvent utilisés pour produire des
cartes topographiques. Un autre moyen de rendre cet effet 3D est d’utiliser l’ombrage. L’ombrage est créé à
partir du modèle numérique de terrain (MNT) en calculant d’abord les pentes et les expositions puis en simulant
la position du soleil dans le ciel ce qui donne à chaque cellule une valeur de réflectance. Les pentes éclairées par
le soleil sont plus claires et les pentes à l’abri du soleil sont plus sombres.

• Commencez par ouvrir la couche raster gtopo30. Ouvrez la Boîte à outils GRASS et dans la catégorie
Raster double cliquez sur Analyse spatiale → Analyse de terrain.

• Cliquez ensuite sur r.shaded.relief pour lancer le module.

• Changer l” Azimuth du soleil par rapport au nord, en degrés et mettez 315 au lieu de 270.

• Enter gtopo30_shade for the new hillshade raster, and click Run.
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• Quand le calcul est terminé, ajoutez le raster d’ombrage à la fenêtre carte. Normalement, il devrait s’afficher
en niveau de gris.

• Pour voir les deux couches d’informations ombrage et gtopo30 en même temps, placez la couche ombrage
sous la couche gtopo30 dans le gestionnaire de couches et ouvrez la fenêtre Propriétés de la couche
gtopo30, allez sur l’onglet Transparence et fixez la transparence à environ 25%.

Vous devriez maintenant avoir la couche gtopo30 en couleur et en transparence, affiché au dessus de la
couche d’ombrage en niveau de gris. Pour bien visualiser l’effet d’ombrage, décochez puis recochez la couche
gtopo30_shade dans la légende.

Utiliser la console GRASS

L’extension Grass de QGIS est faite pour les utilisateurs ne connaissant pas GRASS et qui ne sont pas familiers
avec les modules et les options. Ainsi, certains modules dans la Boîte à outils n’apparaissent pas avec toutes les
options possibles et certains n’apparaissent pas du tout. La console GRASS donne accès à ces modules addition-
nels qui n’apparaissent pas dans la Boîte à outils et aux options supplémentaires des modules qui n’apparaissent
que de façon simplifiée dans la Boîte à outils. Cet exemple montre l’utilisation d’une option supplémentaire du
module r.shaded.relief utilisé ci-dessus.

Figure 20.8: La console GRASS utilisation du module r.shaded.relief.

Le module r.shaded.relief possède un paramètre zmult qui multiplie la valeur de l’altitude (exprimé dans la
même unité que les coordonnées X - Y) ce qui a pour effet d’accentuer le relief.

• Load the gtopo30 elevation raster as above, then start the GRASS Toolbox and click on the
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GRASS shell. In the shell window, type the command r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 and press Enter.

• Une fois le calcul terminé, allez sur l’onglet Parcourir et double-cliquez sur le nouveau raster
gtopo30_shade2 pour l’afficher dans QGIS.

• Comme expliqué ci-dessus, placez le raster d’ombrage sous le raster gtopo30 puis vérifiez la transparence
du raster gtopo30. Vous devriez constater que le relief apparaît plus marqué qu’avec le premier raster
d’ombrage.

Figure 20.9: Affichage du relief ombré créé avec le module GRASS r.shaded.relief.

Statistiques raster avec des couches vectorielles

L’exemple suivant comment un module GRASS peut aggréger des données raster et ajouter des colonnes de
statistiques pour chaque polygone d’une couche vectorielle.

• Again using the Alaska data, refer to Importer des données dans un SECTEUR GRASS to import the
shapefiles/trees.shp file into GRASS.

• Un étape intermédiaire est nécessaire : des centroïdes doivent importés afin d’avoir une couche GRASS
vecteur complète (qui inclue les contours et les centroïdes).

• Dans la Boîte à outils choisissez Vecteur -> Gestion des entités et ouvrez le module v.centroids.

• Entrez “forest_areas” comme nom de couche en sortie et lancez le module.

• Maintenant ouvrez la couche vectorielle forest_areas et affichez les types de forêts avec différentes
couleurs : caduques, persistentes, mélangées. Dans la fenêtre Propriétés, onglet symbologie , choisissez le

Type de légende “Valeur unique” et le champ “VEGDESC” comme champ de classification. (Re-
portez vous aux explications de l’onglet Symbologie Onglet Symbologie de la section vecteur).

• Réouvrez la Boîte à outils GRASS et ouvrez Vecteur -> Mise à jour vectorielle via d’autres cartes.

• Cliquez sur le module v.rast.stats. Saisissez gtopo30 et forest_areas.

• Only one additional parameter is needed: Enter column prefix elev, and click Run. This is a computation-
ally heavy operation, which will run for a long time (probably up to two hours).

• Pour finir, ouvrez la table attributaire de forest_areas, et vérifiez que plusieurs nouvelles colonnes ont
étés ajoutées dont elev_min, elev_max, elev_mean, etc., pour chaque polygone de forêt.
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20.14.3 Paramètrer la boîte à outils GRASS

Pratiquement tous les modules GRASS peuvent être ajoutés à la Boîte à outils. Une interface XML est fournie
pour analyser les fichiers XML très simples qui configurent l’apparence et les paramètres des modules dans la
boîte à outils.

Un exemple de fichier XML pour le module v.buffer (v.buffer.qgm) est donné ci-dessous :

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

The parser reads this definition and creates a new tab inside the Toolbox when you select the module. A more
detailed description for adding new modules, changing a module’s group, etc., can be found at https://qgis.org/en/
site/getinvolved/development/addinggrasstools.html.
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CHAPTER 21

Outils de traitement QGIS

21.1 Introduction

Ce chapitre présente le module de Traitements de QGIS, un environnement de géo-traitements qui permet
d’exécuter des algorithmes natifs ou d’applications tierces directement depuis QGIS, vous permettant d’effectuer
des tâches d’analyses spatiales rapidement et efficacement.

Dans les sections suivantes, seront exposés les éléments graphiques de ce module et comment les exploiter au
maximum.

There are four basic elements in the framework GUI, which are used to run algorithms for different purposes.
Choosing one tool or another will depend on the kind of analysis that is to be performed and the particular
characteristics of each user and project. All of them (except for the batch processing interface, which is called
from the toolbox or the algorithm execution dialog, as we will see) can be accessed from the Processing menu
item (you will see more entries; the remaining ones are not used to execute algorithms and will be explained later
in this chapter).

• The Toolbox: The main element of the GUI, it is used to execute a single algorithm or run a batch process
based on that algorithm.

• The Graphical Modeler: Several algorithms can be combined graphically using the modeler to define a
workflow, creating a single process that involves several subprocesses.

• The History manager: All actions performed using any of the aforementioned elements are stored in a
history file and can be later easily reproduced using the history manager.

• The Batch Processing interface: This interface allows you to execute batch processes and automate the
execution of a single algorithm on multiple datasets.

Dans les sections suivantes, chacun de ces éléments sera détaillé.

21.2 Configurer le Module de Traitements

Comme mentionné précédemment, le menu de configuration permet d’accéder à une nouvelle fenêtre dans laque-
lle vous pouvez paramétrer le fonctionnement des algorithmes. Les paramètres sont regroupés en blocs sélec-
tionnables sur la partie gauche.

A côté de l’entrée Dossier de sortie déjà exposée, le bloc Général contient les paramètres pour le style de rendu
par défaut des couches générées par les algorithmes. Créez ces styles à l’aide de QGIS, sauvegardez-les dans un
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Figure 21.1: Boîte à outils de Traitements

Figure 21.2: Modeleur de chaîne de traitement
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Figure 21.3: Historique des traitements

Figure 21.4: Interface de Traitements par lot
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fichier que vous indiquerez dans la configuration de l’algorithme. Une couche traitée par l’algorithme présentera
alors ce style dans le canevas de QGIS.

Le rendu des styles peut être configuré pour chaque algorithme et pour chacune de ses sorties. Cliquez avec le
bouton droit sur le nom de l’algorithme dans la boîte à outils et sélectionnez Éditer les styles de rendu par défaut.
Une fenêtre comme celle-ci apparaîtra.

Figure 21.5: Styles de rendu

Sélectionnez le fichier de style (.qml) que vous souhaitez appliquer à chaque résultat et appuyez sur OK.

Les autres paramètres de configuration du groupe Général sont les suivants :

• Utiliser le nom de fichier comme nom de couche. Le nom de chaque couche créée par un algorithme est
défini par l’algorithme lui-même. Dans certains cas, un nom fixe peut être utilisé, ce qui signifie que le
même nom sera utilisé, quelle que soit la couche utilisée en entrée. Dans d’autres cas, le nom peut dépendre
du nom de la couche d’entrée ou de certains des paramètres utilisés pour exécuter l’algorithme. Si cette case
est cochée, le nom sera plutôt issu de celui du fichier de sortie. Notez, que, si la sortie est enregistrée dans
un fichier temporaire, le nom de ce fichier temporaire est généralement long et créé de manière à éviter les
collisions avec d’autres noms de fichiers déjà existants.

• guilabel:Laisser la fenêtre ouverte après la fin de l’exécution de l’algorithme. Une fois que l’algorithme a
terminé son exécution et que ses couches de sorties sont chargées dans le projet QGIS, la boîte de dialogue
de l’algorithme est fermée. Si vous souhaitez la conserver ouverte (pour relancer l’algorithme avec des
paramètres différents ou pour mieux vérifier ce qui est produit dans l’onglet journal), cochez cette option.

• N’utiliser que les entités sélectionnées. Si cette option est sélectionnée, chaque fois qu’une couche vecteur
est utilisée comme entrée pour un algorithme, seules ses entités sélectionnées seront utilisées. Si aucune
entité de la couche n’est sélectionnée, toutes seront utilisées.

• Script Pré-exécution et Script Post-exécution. Ces paramètres font référence à des scripts écrits à l’aide des
fonctions du menu Traitements et sont expliqués dans la section abordant les algorithmes et la console.

Vous trouverez également un bloc Général pour chaque fournisseur d’algorithmes. Chaque bloc contient une
rubrique Activé pour le faire apparaître dans la boîte à outils. De plus, certains fournisseurs ont leurs propres
options de configuration. Cela sera détaillé dans la description de chaque fournisseur.

21.3 La boîte à outils

The Processing Toolbox is the main element of the processing GUI, and the one that you are more likely to use
in your daily work. It shows the list of all available algorithms grouped in different blocks called Providers, and
custom models and scripts you can add to extend the set of tools. Hence the toolbox is the access point to run
them, whether as a single process or as a batch process involving several executions of the same algorithm on
different sets of inputs.

Providers can be (de)activated in the Processing settings dialog. By default, only providers that do not rely on
third-party applications (that is, those that only require QGIS elements to be run) are active. Algorithms requiring
external applications might need additional configuration. Configuring providers is explained in a later chapter in
this manual.

En partie haute de la fenêtre de la boîte à outils, vous trouverez un ensemble d’outils pour :
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Figure 21.6: Boîte à outils de Traitements
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• work with Models: Create New Model. . . , Open Existing Model. . . and Add Model to Toolbox. . . ;

• work with Scripts: Create New Script. . . , Create New Script from Template. . . , Open Existing Script. . .
and Add Script to Toolbox. . . ;

• ouvrir le panneau Historique ;

• ouvrir le panneau Visualiseur de résultats ;

• toggle the toolbox to the in-place modification mode using the Edit Features In-Place button: only the algo-
rithms that are suitable to be executed on the active layer without outputting a new layer are displayed;

• ouvrir la fenêtre Options.

Below this toolbar is a Search. . . box to help you easily find the tools you need. You can enter any word
or phrase on the text box. Notice that, as you type, the number of algorithms, models or scripts in the toolbox is
reduced to just those that contain the text you have entered in their names or keywords.

Note: At the top of the list of algorithms are displayed the most recent used tools; handy if you want to reexecute
any.

Figure 21.7: Boîte à outils de traitements affichant les résultats de recherche

Pour exécuter un algorithme, double-cliquez simplement sur son nom dans la boîte à outils.

21.3.1 La fenêtre Algorithme

Une fois que vous avez double-cliqué sur le nom de l’algorithme à exécuter, une fenêtre semblable à la suivante
sera affichée (ici, il s’agit de la fenêtre de l’algorithme Centroïdes).

Cette fenêtre permet de définir les données d’entrée à l’algorithme. Elle présente ici la liste des données d’entrée
et des paramètres à fournir. Cette fenêtre différera selon les paramètres nécessaires à l’exécution de l’algorithme
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Figure 21.8: Fenêtre de paramètres

et sera créée automatiquement.

Les algorithmes différeront par le nombre et le type de paramètres, mais la structure sera la même pour tous. Les
paramètres présents dans la table pourront être un des types suivants.

• Une couche raster, à sélectionner dans la liste des couches de ce type disponibles (ouvertes) dans QGIS.
Le sélecteur contient également un bouton sur sa partie droite, pour choisir un fichier correspondant à une
couche non ouverte dans QGIS.

• Une couche vectorielle, à sélectionner dans la liste des couches disponibles dans QGIS. Tout comme pour
les couches raster, vous pouvez sélectionner une couche par son nom de fichier, mais à la condition que
l’algorithme ne nécessite pas un champ de cette couche vectorielle. Dans ce dernier cas, il est nécessaire de
charger au préalable la couche vectorielle, afin de pouvoir accéder à la liste des champs.

Vous verrez un bouton pour chaque sélecteur de couche de vecteur, comme le montre la figure ci-dessous.

Figure 21.9: Bouton d’itération sur les couches vecteur

Si l’algorithme propose plusieurs boutons d’itération, vous ne pourrez en activer qu’un seul. Si un bouton
correspondant à une couche vecteur est activé, l’algorithme s’exécutera successivement sur chacune des
entités de la couche plutôt que sur la couche en entier, produisant alors autant de sorties que de nombre
d’exécution de l’algorithme. Cela permet d’automatiser un traitement qui doit être réalisé sur chaque entité
d’une couche séparément.

Note: By default, the parameters dialog will show a description of the CRS of each layer along with its name.
If you do not want to see this additional information, you can disable this functionality in the Processing Settings
dialog, unchecking the General → Show layer CRS definition in selection boxes option.

• Une table, à sélectionner dans la liste des tables disponibles dans QGIS. Des tables non spatiales peu-
vent être chargées dans QGIS comme les couches vectorielles et sont en fait traitées de la même manière.
Actuellement, les seules tables utilisables par les algorithmes proviennent de fichiers dBase (.dbf) ou CSV
(.csv).

• Une option, à choisir dans une liste d’options possibles.

• A numerical value, to be introduced in a spin box. In some contexts (when the parameter applies at

the feature level and not at the layer’s), you will find a Data-defined override button by its side, allowing
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you to open the expression builder and enter a mathematical expression to generate variable values for the
parameter. Some useful variables related to data loaded into QGIS can be added to your expression, so you
can select a value derived from any of these variables, such as the cell size of a layer or the northernmost
coordinate of another one.

Figure 21.10: Entrée basée sur une expression

• Un intervalle, où doivent être remplies les valeurs minimales et maximales.

• Une chaîne de texte, à mettre dans le champ correspondant.

• Le nom d’un champ, à choisir dans la liste des attributs d’une couche vectorielle ou d’une table préalable-
ment sélectionnée.

• A coordinate reference system. You can select it among the recently used ones from the drop-down list or
from the CRS selection dialog that appears when you click on the button on the right-hand side.

• An extent, to be entered by four numbers representing its xmin, xmax, ymin, ymax limits. Clicking on
the button on the right-hand side of the value selector, a pop-up menu will appear, giving you options:

– to select the value from a layer or the current canvas extent;

– or to define it by dragging directly onto the map canvas.

Figure 21.11: Sélecteur d’emprise

Dans le premier cas s’affichera une fenêtre comme celle-ci.

Figure 21.12: Liste d’emprises
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Dans le second cas, la fenêtre de paramètres sera cachée afin de vous permettre de cliquer et glisser sur le
canevas. Une fois le rectangle délimité, la fenêtre réapparaîtra, contenant les valeurs de l’emprise choisie.

Figure 21.13: Sélection interactive d’une emprise

• A list of elements (whether raster or vector layers, tables, fields) to select from. Click on the . . . button
at the left of the option to see a dialog like the following one. Multiple selection is allowed and when the
dialog is closed, number of selected items is displayed in the parameter text box widget.

Figure 21.14: Sélection Multiple

• Une petite table, à éditer par l’utilisateur, pour définir certains paramètres tels que tables de recherche ou
le produit de convolution.

Cliquez sur le bouton sur le côté droit pour voir la table et éditer ses valeurs.

Selon l’algorithme, les lignes sont modifiables ou non, en utilisant les boutons situés à droite de la fenêtre.

Note: Some algorithms require many parameter to run, e.g. in the qgisrastercalculator you have to specify
manually the cell size, the extent and the CRS. You can avoid to choose all the parameters manually when the
algorithm has the Reference layers parameter. With this parameter you can choose the reference layer and
all its properties (cell size, extent, CRS) will be used.

En plus de l’onglet des paramètres, vous trouverez un autre onglet nommé Journal. L’information fournie par
l’algorithme au cours de son exécution est écrite dans cet onglet et vous permet de suivre l’exécution et d’avoir plus
de détails sur le déroulement en cours. Merci de prendre note que tous les algorithmes n’écrivent pas forcément
de l’information dans cet onglet et beaucoup d’entre eux peuvent s’exécuter de manière silencieuse sans produire
aucune sortie autre que les fichiers finaux.

Sur le côté droit de la boîte de dialogue, vous trouverez une courte description de l’algorithme ce qui vous aidera
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Figure 21.15: Table fixe

à comprendre son objectif et ses idées de base. Si une telle description n’est pas disponible, le panneau de
description ne sera pas affiché.

For a more detailed help file, which might include description of every parameter it uses, or examples, you will
find a Help button at the bottom of the dialog bringing you to the Processing algorithms documentation or to the
provider documentation (for some third-party providers).

A propos des projections

Processing algorithm execution are always performed in the input layer coordinate reference system (CRS). Due
to QGIS’s on-the-fly reprojecting capabilities, although two layers might seem to overlap and match, that might
not be true if their original coordinates are used without reprojecting them onto a common coordinate system.
Whenever you use more than one layer as input to a QGIS native algorithm, whether vector or raster, the layers
will all be reprojected to match the coordinate reference system of the first input layer.

This is however less true for most of the external applications whose algorithms are exposed through the processing
framework as they assume that all of the layers are already in a common coordinate system and ready to be
analyzed.

By default, the parameters dialog will show a description of the CRS of each layer along with its name, making it
easy to select layers that share the same CRS to be used as input layers. If you do not want to see this additional
information, you can disable this functionality in the Processing settings dialog, unchecking the Show layer CRS
definition in selection boxes option.

If you try to execute an algorithm using as input two or more layers with unmatching CRSs, a warning dialog will
be shown. This occurs thanks to the Warn before executing if layer CRS’s do not match option.

Vous pourrez toujours exécuter l’algorithme mais sachez que dans la plupart des cas, ceci générera des résultats
erronés, comme des couches vides du fait de couches en entrée qui ne se superposent pas.

Astuce: Use Processing algorithms to do intermediate reprojection

When an algorithm can not successfully perform on multiple input layers due to unmatching CRSs, use QGIS
internal algorithm such as qgisreprojectlayer to perform layers” reprojection to the same CRS before executing
the algorithm using these outputs.

21.3.2 Les données générées par les algorithmes

Les données générées par un algorithme peuvent être des types suivants :

• Une couche raster

• Une couche vectorielle

• Une table
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• Un fichier HTML (utilisé pour les sorties texte et graphiques)

These are all saved to disk, and the parameters table will contain a text box corresponding to each one of these
outputs, where you can type the output channel to use for saving it. An output channel contains the information
needed to save the resulting object somewhere. In the most usual case, you will save it to a file, but in the case of
vector layers, and when they are generated by native algorithms (algorithms not using external applications) you
can also save to a PostGIS, GeoPackage or SpatiaLite database, or a memory layer.

Pour sélectionner un chemin de destination, cliquez simplement sur le bouton à la droite de la boîte de texte et
vous verrez apparaître un menu contextuel avec les options disponibles.

Dans la majorité des cas, vous voudrez sélectionner l’enregistrement dans un fichier. Si vous sélectionnez cette
option, une boîte de dialogue de sélection de fichier sera affichée et vous pourrez y sélectionner le chemin de
fichier. Les extensions gérées sont affichées dans le sélecteur de format de fichier, en fonction du type de sortie et
l’algorithme.

The format of the output is defined by the filename extension. The supported formats depend on what is supported
by the algorithm itself. To select a format, just select the corresponding file extension (or add it, if you are directly
typing the file path instead). If the extension of the file path you entered does not match any of the supported
formats, a default extension will be appended to the file path, and the file format corresponding to that extension
will be used to save the layer or table. Default extensions are .dbf for tables, .tif for raster layers and .gpkg
for vector layers. These can be modified in the setting dialog, selecting any other of the formats supported by
QGIS.

If you do not enter any filename in the output text box (or select the corresponding option in the context menu),
the result will be saved as a temporary file in the corresponding default file format, and it will be deleted once you
exit QGIS (take care with that, in case you save your project and it contains temporary layers).

You can set a default folder for output data objects. Go to the settings dialog (you can open it from the Settings
→ Options → Processing menu), and in the General group, you will find a parameter named Output folder. This
output folder is used as the default path in case you type just a filename with no path (i.e., myfile.shp) when
executing an algorithm.

Lorsque vous lancez un algorithme qui utilise une couche vectorielle en mode itératif, le chemin de fichier entré
est pris comme chemin de base pour tous les fichiers de sortie, dont le nom correspondra au nom du fichier de
base suivi du numéro d’index d’itération. L’extension du fichier (et le format) sera la même pour tous les fichiers
générés.

Apart from raster layers and tables, algorithms also generate graphics and text as HTML files. These results are
shown at the end of the algorithm execution in a new dialog. This dialog will keep the results produced by any
algorithm during the current session, and can be shown at any time by selecting Processing → Results Viewer
from the QGIS main menu.

Certaines applications tierces peuvent créer des fichiers d’un type différent à ceux précédemment exposés. Ces
fichiers résultats ne seront pas gérés par QGIS (ouverts ou intégrés dans le projet courant) dans la mesure où le
format de fichier n’est pas reconnu par QGIS. C’est par exemple le cas de fichier LAS produits par LiDAR. Ces
fichiers sont créés, mais vous ne verrez rien de plus dans la session de travail QGIS.

Pour les autres types de résultat, vous pourrez choisir de les charger ou non à l’issue de l’exécution de l’algorithme
en cochant la case. Par défaut, tous les fichiers sont chargés.

Le Module de Traitements ne prend pas en charge de sorties optionnelles. Tous les résultats sont créés. Cependant
vous pouvez choisir de désactiver les sorties qui ne vous intéressent pas (ces fichiers seront créés dans des fichiers
temporaires qui seront supprimés en quittant QGIS).

21.4 Le gestionnaire d’historique

21.4.1 L’historique des traitements

A chaque exécution d’un algorithme, les informations du traitement, paramètres utilisés, date et heure d’exécution,
sont sauvegardées dans le gestionnaire d’historiques.
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Ainsi, il est possible de suivre et vérifier les tâches effectuées et de les reproduire facilement.

Le gestionnaire d’historiques est un ensemble d’entrées de registre, regroupées selon la date d’exécution, permet-
tant de retrouver facilement quel algorithme a été exécuté à un moment donné.

Figure 21.16: Historique

Les informations de traitement sont sauvegardées sous forme de ligne de commande, même si l’algorithme a
été exécuté depuis la boîte à outils. Cela permet également de comprendre l’interface en ligne de commande en
visualisant la commande effectivement lancée depuis la boîte à outils.

Apart from browsing the entries in the registry, you can also re-execute processes by simply double-clicking on
the corresponding entry: the algorithm dialog opens with parameters already filled; you can then change any of
them to fit your needs and re-run the algorithm.

The History dialog also provides a convenient way to contribute to the consolidation of the testing infrastructure of
QGIS Processing algorithms and scripts. Right-click on a command you previously executed and you can Create
Test. . . for the concerned algorithm, following instructions at https://github.com/qgis/QGIS/blob/release-3_4/
python/plugins/processing/tests/README.md.

21.4.2 Le journal des traitements

The history dialog only contains the execution calls, but not the information produced by the algorithm when
executed. That information is written to the QGIS log (View → Panels → Log Messages Panel), in a Processing
tab.

Third-party algorithms are usually executed by calling their command-line interfaces, which communicate with
the user via the console. Although that console is not shown, usually a full dump of it is written to the log each
time you run one of those algorithms. To avoid cluttering the log with that information, you can disable it for each
provider, looking for the corresponding option in the provider entry of the settings dialog.

Certains algorithmes génèrent des messages d’avertissements ou des commentaires dans le journal, même si le
traitement semble avoir réussi. Vérifiez ces messages si les résultats ne semblent pas cohérents.

21.5 Le modeleur graphique

Le modeleur graphique vous permet de créer des modèles complexes en utilisant une interface simple et facile
à utiliser. Dans un SIG, la plupart des opérations d’analyses ne sont pas simples mais font parties d’une chaîne
d’opérations. En utilisant le modeleur graphique, cette chaîne de traitements peut être regroupée dans une tâche,
qui est plus simple à exécuter et peut être réutilisée sur d’autres jeux de données. Peu importe le nombre d’étapes et
d’algorithmes impliqués, un modèle est exécuté comme un seul algorithme, permettant ainsi d’économiser temps
et effort, notamment sur de plus grands modèles.
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Le modeleur peut être ouvert à partir du menu Traitements.

Le modeleur possède un espace de travail où sont représentés la structure du modèle et le flux de traitement. Sur
la partie gauche se trouve un panneau avec deux onglets pour ajouter de nouveaux éléments au modèle.

Figure 21.17: Modeleur

Deux étapes sont nécessaires pour la création d’un modèle:

1. Définir les entrées nécessaires. Ces entrées seront ajoutées à la fenêtre des paramètres, afin que l’utilisateur
puisse y fixer les valeurs nécessaires à l’excéution du modèle. Le modèle en lui-même est un algorithme.
Ainsi la fenêtre des paramètres est générée automatiquement comme cela est le cas pour tous les algorithmes
fournis avec le Module de Traitements.

2. Définir le flux de traitements. A partir des données d’entrée du modèle, le flux de traitements est défini
en ajoutant des algorithmes et en sélectionnant comment ces derniers utiliseront les données ou d’autres
données générées par d’autres algorithmes déjà présents dans le modèle.

21.5.1 Définition des données d’entrée

La première étape pour créer un modèle est de définir les données d’entrées nécessaires. Vous trouverez les
éléments suivants dans l’onglet Entrées dans la partie gauche de la fenêtre du modeleur :

• Couche raster

• Couche vectorielle

• Chaîne de caractères

• Champ d’une table

• Table

• Etendue

• Nombre

• Booléen

• Fichier

Double cliquez sur ces éléments pour faire apparaître une fenêtre avec leurs détails. Selon le paramètre, cette
fenêtre peut contenir une simple description (que l’utilisateur verra à l’exécution du modèle) ou d’autres informa-
tions. Par exemple, à l’ajout d’une valeur numérique, à la description devront être définies la valeur par défaut
ainsi que la liste des valeurs valides. La figure suivante illustre cette fenêtre.
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Figure 21.18: Définition des Paramètres du Modèle

Pour chaque donnée d’entrée ajoutée, un nouvel élément apparaît dans l’espace de travail du modeleur.

Figure 21.19: Paramètres du modèle dans le canevas

Vous pouvez également ajouter des données d’entrée en faisant glisser le type choisi depuis la liste et en le déposant
dans le modèle à l’endroit souhaité.

21.5.2 Définition d’un flux de traitements

Une fois les données d’entrée définies, il faut à présent ajouter les algorithmes de traitement. Ces algorithmes se
situent dans l’onglet Algorithmes, regroupés par fournisseur comme dans la boîte à outils.

Pour ajouter un algorithme, double-cliquez sur son nom ou faites-le glisser comme pour les données d’entrée.
Une boîte d’exécution apparaît, semblable à celle qui apparaît lorsque l’on lance ce même algorithme à partir
de la boîte à outils. L’illustration suivante montre celle correspondant à l’algorithme “Index de convergence” de
SAGA.

Comme vous pouvez le voir, quelques différences existent entre les deux fenêtres. Ainsi, le nom de fichier en
sortie de l’algorithme est remplacé par un simple champ texte. Pour créer une couche temporaire en sortie pour
être utilisée par un autre algorithme et supprimée à la fin, laissez le champ texte vide. Dans le cas contraire, la
couche résultante sera un résultat final de l’algorithme et portera le nom défini dans le champ de texte. C’est ce
nom que verra l’utilisateur du modèle à son exécution.

La sélection des valeurs de chaque paramètre s’effectue également différemment, en raison de la différence de
contexte entre le modeleur et la boite à outils. Détaillons les valeurs pour chaque type de paramètre.

• Les couches raster et vectorielles et les tables. Elles sont à choisir dans une liste, non pas des couches ou
tables déjà chargées dans QGIS, mais soit des entrées du modèle, soit des couches et/ou tables générées par
les algorithmes déjà présents dans le modèle.

• Numerical values. Literal values can be introduced directly in the text box. Clicking on the button beside
the text box, expressions can be entered. Available variables for expressions include numerical inputs of the
model, and also statistical values from available raster layers within the model.
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Figure 21.20: Entrées du modèle

Figure 21.21: Paramètres du modèle de l’algorithme
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• String. Literal strings can be typed in the corresponding text box. Clicking on the button beside the text
box, expressions can be entered, as in the case of numerical values.

• Un champ de table. Les champs d’une table ou d’une couche ne sont pas connus au moment de la conception
du modèle, puisqu’ils seront définis à l’exécution du modèle. Pour remplir ce paramètre, entrez le nom du
champ directement dans le champ texte correspondant, ou sélectionnez-le dans la liste des champs des tables
déjà présentes dans le modèle. La validité du champ sélectionné sera vérifiée à l’exécution.

Dans tous les cas, vous trouverez un paramètre supplémentaire nommé Algorithme parent qui n’est pas disponible
lors de l’appel de l’algorithme via la boîte à outils. Ce paramètre vous permet de choisir dans quel ordre seront
exécutés les algorithmes, en définissant explicitement un algorithme qui sera parent d’un autre, son exécution sera
forcée en premier.

Lorsque vous utilisez les sorties d’un algorithme comme entrée de votre algorithme, le premier est implicitement
défini comme l’algorithme parent du votre (et ajoute la flèche correspondante sur le modèle). Cependant, dans
certains cas, un algorithme peut dépendre d’un autre même s’il n’en utilise pas les sorties (par exemple un algo-
rithme qui exécute une requête SQL sur une base de données PostGIS et un autre qui importe une couche dans
cette même base de données). Dans ce cas, sélectionnez le simplement dans le paramètre Algorithme parent et
l’exécution se fera dans le bon ordre.

Once all the parameters have been assigned valid values, click on OK and the algorithm will be added to the
canvas. It will be linked to all the other elements in the canvas, whether algorithms or inputs, that provide objects
that are used as inputs for that algorithm.

Les éléments peuvent être disposés et rangés en les glissant dans l’espace de travail. Cela améliore la lecture et
la compréhension du modèle. Les liens entre éléments sont mis à jour automatiquement. Vous pouvez zoomer et
dé-zoomer avec la molette de la souris.

You can run your algorithm any time by clicking on the Run button. However, in order to use the algorithm from
the toolbox, it has to be saved and the modeler dialog closed, to allow the toolbox to refresh its contents.

21.5.3 Sauvegarder et charger les modèles

Use the Save button to save the current model and the Open button to open any model previously saved. Models
are saved with the .model extension. If the model has been previously saved from the modeler window, you will
not be prompted for a filename. Since there is already a file associated with that model, the same file will be used
for any subsequent saves.

Avant de sauvegarder un modèle, il faudra définir son nom et le groupe auquel il appartient. Pour cela, remplissez
les deux champs texte situés sur la partie haute de la fenêtre.

Les modèles sauvegardés dans le répertoire models (le répertoire par défaut) apparaîtront dans la boîte à outils
dans le groupe correspondant. Lorsque la boîte à outils est ouverte, tous les fichiers portant l’extension .model
du répertoire models sont chargés. Comme le modèle fait maintenant partie des algorithmes, il peut être utilisé
comme tous les autres depuis la boite à outils ou depuis le modeleur.

Models can also be saved within the project file using the Save model in project button. Models saved with this
method won’t be written as .model files on the disk but will be embedded in the .qgz project file.

Project models are available in the Project models menu of the toolbox.

Le répertoire par défaut des modèles peut être défini dans les configurations du Module de Traitements, dans le
groupe Modeles.

Les modèles sauvegardés dans le répertoire models apparaîtront dans la boîte à outils dans le groupe correspon-
dant ainsi que dans la liste des Algorithmes proposés dans le modeleur. Cela signifie qu’il peut être utilisé comme
tous les autres depuis la boite à outils ou depuis le modeleur.

Models will show up in the Browser panel , and can be run from there.
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Exporting a model as an image, PDF or SVG

A model can also be exported as an image, SVG or PDF (for illustration purposes).

21.5.4 Editer un modèle

Vous pouvez éditer le modèle sur lequel vous travaillez, en redéfinissant le flux de traitements et les relations entre
algorithmes et données d’entrée.

Si vous cliquez avec le bouton droit sur un algorithme de l’espace de travail du modèle, le menu contextuel suivant
apparaîtra:

Figure 21.22: Clic droit du modeleur

Choisissez l’option Enlever pour supprimer l’algorithme sélectionné. Un algorithme ne peut être enlevé que si
aucun autre algorithme ne dépend de lui, c’est-à-dire si aucune de ses sorties n’est utilisée par ailleurs. Si vous
tentez de supprimer un algorithme utilisé par ailleurs, le message d’avertissement suivant s’affichera :

Figure 21.23: Impossible de supprimer l’algorithme

Choisissez l’option Éditer pour afficher la fenêtre des paramètres de l’algorithme, pour changer les données en
entrée et les paramètres. Tous les paramètres d’entrée ne seront pas systématiquement affichés. Les couches ou
les valeurs générées en amont dans le flux de traitement ne seront ainsi pas disponibles, pour éviter les références
circulaires.

Select the new values and then click on the OK button as usual. The connections between the model elements will
change accordingly in the modeler canvas.

Un modèle peut tourner partiellement en désactivant certains de ses algorithmes. Pour ce faire, sélectionnez
l’option Désactiver qui figure dans le menu contextuel qui apparaît en faisant un clic-droit sur un algorithme.
Celui-ci et tous les autres qui en dépendent figureront en gris et ne seront pas exécutés par le modèle.

Figure 21.24: Modèle dont un algorithme a été désactivé

Si vous faîtes un clic-droit sur un algorithme qui n’est pas actif, vous verrez alors l’option Activer du menu que
vous pouvez utiliser pour le rendre actif.
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21.5.5 Editer l’aide et les métadonnées

You can document your models from the modeler itself. Just click on the Edit Model Help button and a dialog like
the one shown next will appear.

Figure 21.25: Editeur d’aide

Sur la partie droite apparaîtra une simple page HTML, créée à partir de la description des paramètres d’entrées et
des sorties de l’algorithme, ainsi que d’autres éléments tels que description générale du modèle ou ses auteurs. A la
première ouverture de l’éditeur d’aide, ces champs seront vides, mais vous pouvez les éditer à partir des éléments
situés à gauche de la fenêtre. Sélectionnez un élément dans la partie supérieure puis remplissez sa description
dans la partie inférieure.

L’aide d’un modèle est enregistrée comme une partie intégrante du modèle.

21.5.6 A propos des algorithmes disponibles

Vous remarquerez que certains algorithmes présents dans la boîte à outils n’apparaissent pas dans la liste depuis
le modeleur. Pour pouvoir être utilisé dans un modèle, un algorithme doit présenter une syntaxe correcte pour
pouvoir être lié aux autres traitements. Si cela n’est pas le cas, par exemple si le nombre de couche en sortie n’est
pas connu à l’avance, alors il ne sera pas possible de l’utiliser au sein d’un modèle et n’apparaîtra donc pas dans
la liste du modeleur.

21.6 L’interface de traitement par lot

21.6.1 Introduction

All algorithms (including models) can be executed as a batch process. That is, they can be executed using not just
a single set of inputs, but several of them, executing the algorithm as many times as needed. This is useful when
processing large amounts of data, since it is not necessary to launch the algorithm many times from the toolbox.

Pour exécuter un algorithme en traitement par lots, cliquez avec le bouton droit sur son nom dans la boîte à outis
et sélectionnez l’option Exécution par lots dans le menu contextuel qui apparaît.
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Figure 21.26: Clic-droit pour ouvrir l’interface de Traitements par lot

Si vous avez déjà affiché la boîte de dialogue d’exécution de l’algorithme, vous pouvez également lancer l’interface
de traitement par lots directement, en cliquant sur le bouton Éxécuter comme processus de lot. . . .

Figure 21.27: Traitement par lot à partir de la boîte de dialogue de l’algorithme

21.6.2 La table des paramètres

L’exécution d’un traitement par lots est semblable à l’exécution simple d’un algorithme. Les valeurs des
paramètres peuvent être définies, mais dans le cas présent, il est nécessaire de définir les valeurs pour chaque
exécution de l’algorithme. Ces valeurs sont à donner dans la table suivante.

Chaque ligne de la table correspond à une itération de l’algorithme et chaque cellule contient la valeur de chaque
paramètre. Ce sont les mêmes paramètres que dans la boîte à outils, mais présentés différemment.

Par défaut, la table contient seulement deux lignes. Vous pouvez ajouter ou retirer des lignes en utilisant les
boutons situés en bas de la fenêtre.

Une fois le nombre de lignes souhaitées atteint, vous pouvez remplir les paramètres avec les valeurs correspon-
dantes.

21.6.3 Remplir la table de paramètres

Pour la plupart des paramètres, la valeur à fixer est triviale. Selon le type de paramètre, entrez simplement la
valeur ou sélectionnez l’option adéquate dans la liste de choix.

Filenames for input data objects are introduced directly typing or, more conveniently, clicking on the . . . button
on the right hand of the cell, which will show a context menu with two option: one for selecting from the layers
currently opened and another to select from the filesystem. This second option, when selected, shows a typical
file chooser dialog. Multiple files can be selected at once. If the input parameter represents a single data object
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Figure 21.28: Traitement par lot

and several files are selected, each one of them will be put in a separate row, adding new ones if needed. If the
parameter represents a multiple input, all the selected files will be added to a single cell, separated by semicolons
(;).

Les identifiants des couches peuvent être directement saisis dans la boîte de texte du paramètre. Vous pouvez saisir
le chemin complet vers un fichier ou le nom d’une couche actuellement ouverte dans le projet QGIS courant. Le
nom de la couche sera automatiquement résolu selon l’emplacement de la source. Veuillez noter que si plusieurs
couches partagent le même nom, cela peut entraîner des résultats imprévus à cause de cette ambiguïté.

Les données en sortie sont toujours sauvegardées dans un fichier et, contrairement à son exécution à partir de la
boîte à outils, la sauvegarde dans un fichier temporaire ou une base de données n’est pas permise. Vous pouvez
entrer le nom directement ou utiliser l’explorateur de fichiers en cliquant sur le bouton adéquat.

Une fois le fichier choisi, une nouvelle fenêtre apparaît permettant le remplissage automatique des autres cellules
d’une même colonne (même paramètre).

Figure 21.29: Remplissage automatique des paramètres de traitement par lot

Si la valeur par défaut (“Ne pas autocompléter”) est choisie, seule la cellule sélectionnée sera remplie, avec le
nom du fichier sélectionné. Dans le cas contraire, toutes les cellules sous la ligne sélectionnée seront remplies à
partir de la valeur choisie. Ainsi, il est aisée de remplir la table de paramètres et le traitement par lots s’en trouve
facilité.

Le remplissage automatique peut également effectué en concaténant un compteur au nom de fichier, ou en ajoutant
un champ à un autre dans la même ligne. Cela peut être utile pour nommer des résultats en fonction de la donnée
d’entrée.

21.6.4 Exécuter le traitement par lots

To execute the batch process once you have introduced all the necessary values, just click on OK. Progress of the
global batch task will be shown in the progress bar in the lower part of the dialog.
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Figure 21.30: Chemin vers les fichiers dans l’interface de Traitements par lot

21.7 Utiliser les algorithmes du module de traitements depuis la
console Python

La console permet aux utilisateurs confirmés d’accroître leur productivité en réalisant des opérations complexes
qui ne pourraient par être réalisées à partir de l’interface graphique du module de Traitements. Les modèles impli-
quant plusieurs algorithmes peuvent être définis à partir de l’interface en lignes de commandes et des opérations
additionnelles comme les boucles ou les branchements conditionnels permettent de créer des flux de traitements
plus puissants et plus flexibles.

Il n’y a pas de console spécifique au module de traitements de QGIS mais toutes les commandes du module sont
disponibles via la console Python de QGIS. Cela signifie que vous pouvez intégrer ces commandes dans votre
travail et les connecter aux autres fonctions accessibles depuis la console (dont les méthodes issues de l’API
QGIS).

Le code exécuté à partir de la console Python, même s’il n’utilise pas de méthodes de traitements particulières,
peut être converti en un nouveau algorithme pour être réutilisé dans la boîte à outils, le modeleur ou dans un autre
flux de traitements, comme tout autre algorithme. Ainsi certains algorithmes que vous pouvez trouver dans la
boîte à outils sont en fait de simples scripts.

Dans cette section, nous allons voir comme utiliser des algorithmes issus du module de Traitements à partir de la
console Python de QGIS et également comment écrire des algorithmes en Python.

21.7.1 Appeler des algorithmes depuis la console Python

La première chose à faire est d’importer les fonctions de traitement à l’aide de l’instruction suivante:

>>> import processing

Now, there is basically just one (interesting) thing you can do with that from the console: execute an algorithm.
That is done using the run method, which takes the name of the algorithm to execute as its first parameter,
and then a variable number of additional parameters depending on the requirements of the algorithm. So the
first thing you need to know is the name of the algorithm to execute. That is not the name you see in the
toolbox, but rather a unique command–line name. To find the right name for your algorithm, you can use the
processingRegistry. Type the following line in your console:

>>> for alg in QgsApplication.processingRegistry().algorithms():
print(alg.id(), "->", alg.displayName())

Vous obtiendrez quelque chose de ce genre (avec quelques tirets en plus pour la lisibilité).
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3d:tessellate --------------> Tessellate
gdal:aspect ----------------> Aspect
gdal:assignprojection ------> Assign projection
gdal:buffervectors ---------> Buffer vectors
gdal:buildvirtualraster ----> Build Virtual Raster
gdal:cliprasterbyextent ----> Clip raster by extent
gdal:cliprasterbymasklayer -> Clip raster by mask layer
gdal:clipvectorbyextent ----> Clip vector by extent
gdal:clipvectorbypolygon ---> Clip vector by mask layer
gdal:colorrelief -----------> Color relief
gdal:contour ---------------> Contour
gdal:convertformat ---------> Convert format
gdal:dissolve --------------> Dissolve
...

Il s’agit là de la liste des identifiants de tous les algorithmes disponibles, triés par le nom du fournisseur puis l’ID
de l’algorithme, accompagnés du nom littéral de l’algorithme.

Once you know the command-line name of the algorithm, the next thing to do is to determine the right syntax to
execute it. That means knowing which parameters are needed when calling the run() method.

There is a method to describe an algorithm in detail, which can be used to get a list of the parameters
that an algorithm requires and the outputs that it will generate. To get this information, you can use the
algorithmHelp(id_of_the_algorithm) method. Use the ID of the algorithm, not the full descriptive
name.

Calling the method with native:buffer as parameter (qgis:buffer is an alias for native:buffer and
will also work), you get the following description:

>>> processing.algorithmHelp("native:buffer")
Buffer (native:buffer)

This algorithm computes a buffer area for all the features in an
input layer, using a fixed or dynamic distance.

The segments parameter controls the number of line segments to
use to approximate a quarter circle when creating rounded
offsets.

The end cap style parameter controls how line endings are handled
in the buffer.

The join style parameter specifies whether round, miter or
beveled joins should be used when offsetting corners in a line.

The miter limit parameter is only applicable for miter join
styles, and controls the maximum distance from the offset curve
to use when creating a mitered join.

----------------
Input parameters
----------------

INPUT: Input layer

Parameter type: QgsProcessingParameterFeatureSource

Accepted data types:
- str: layer ID
- str: layer name
- str: layer source
- QgsProcessingFeatureSourceDefinition
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- QgsProperty
- QgsVectorLayer

DISTANCE: Distance

Parameter type: QgsProcessingParameterDistance

Accepted data types:
- int
- float
- QgsProperty

SEGMENTS: Segments

Parameter type: QgsProcessingParameterNumber

Accepted data types:
- int
- float
- QgsProperty

END_CAP_STYLE: End cap style

Parameter type: QgsProcessingParameterEnum

Available values:
- 0: Round
- 1: Flat
- 2: Square

Accepted data types:
- int
- str: as string representation of int, e.g. '1'
- QgsProperty

JOIN_STYLE: Join style

Parameter type: QgsProcessingParameterEnum

Available values:
- 0: Round
- 1: Miter
- 2: Bevel

Accepted data types:
- int
- str: as string representation of int, e.g. '1'
- QgsProperty

MITER_LIMIT: Miter limit

Parameter type: QgsProcessingParameterNumber

Accepted data types:
- int
- float
- QgsProperty

DISSOLVE: Dissolve result

Parameter type: QgsProcessingParameterBoolean

Accepted data types:
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- bool
- int
- str
- QgsProperty

OUTPUT: Buffered

Parameter type: QgsProcessingParameterFeatureSink

Accepted data types:
- str: destination vector file, e.g. 'd:/test.shp'
- str: 'memory:' to store result in temporary memory layer
- str: using vector provider ID prefix and destination URI,

e.g. 'postgres:...' to store result in PostGIS table
- QgsProcessingOutputLayerDefinition
- QgsProperty

----------------
Outputs
----------------

OUTPUT: <QgsProcessingOutputVectorLayer>
Buffered

Now you have everything you need to run any algorithm. As we have already mentioned, algorithms can be run
using: run(). Its syntax is as follows:

>>> processing.run(name_of_the_algorithm, parameters)

Where parameters is a dictionary of parameters that depend on the algorithm you want to run, and is exactly the
list that the algorithmHelp() method gives you.

>>> processing.run("native:buffer", {'INPUT': '/data/lines.shp',
'DISTANCE': 100.0,
'SEGMENTS': 10,
'DISSOLVE': True,
'END_CAP_STYLE': 0,
'JOIN_STYLE': 0,
'MITER_LIMIT': 10,
'OUTPUT': '/data/buffers.shp'})

Lorsqu’un paramètre est facultatif et que vous ne souhaitez pas l’utiliser, ne l’incluez pas dans le dictionnaire.

Lorsqu’un paramètre n’est pas indiqué, sa valeur par défaut est appliquée.

Selon le type de paramètre, les valeurs peuvent être fournies selon plusieurs manières. Une rapide description de
ces possibilités est donnée pour chaque type de paramètre d’entrée :

• Raster Layer, Vector Layer or Table. Simply use a string with the name that identifies the data object to use
(the name it has in the QGIS Table of Contents) or a filename (if the corresponding layer is not opened, it
will be opened but not added to the map canvas). If you have an instance of a QGIS object representing the
layer, you can also pass it as parameter.

• Enumeration. If an algorithm has an enumeration parameter, the value of that parameter should be entered
using an integer value. To know the available options, you can use the algorithmHelp() command, as
above. For instance, the « native.buffer » algorithm has an enumeration called JOIN_STYLE:

JOIN_STYLE: Join style

Parameter type: QgsProcessingParameterEnum

Available values:
- 0: Round
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- 1: Miter
- 2: Bevel

Accepted data types:
- int
- str: as string representation of int, e.g. '1'
- QgsProperty

In this case, the parameter has three options. Notice that ordering is zero-based.

• Boolean. Use True or False.

• Entrées multiples. La valeur est une chaîne de caractères, avec les entrées séparées par des points-virgules
(;). Comme pour les couches simples et les tables, chaque élément d’entrée peut être le nom d’une variable
objet ou un nom de fichier.

• Champ de la table XXX. Insérez une chaîne de caractère contenant le nom du champ à utiliser. Ce paramètre
est sensible à la casse.

• Table fixée. Entrez la liste de toutes les valeurs, séparées par des virgules (,) et entre guillemets ("). Les
valeurs commencent par la première ligne et se lisent de gauche à droite. Vous pouvez aussi utiliser un
tableau à deux dimensions pour représenter la table.

• SCR. Entrez le code EPSG du système de coordonnées désiré.

• Étendue. Vous devez fournir une chaîne de caractères avec les valeurs xmin, xmax, ymin et ymax séparées
par des virgules (,).

Booléen, fichier, chaîne de caractères et valeurs numériques ne nécessitent pas d’explications particulières.

Input parameters such as strings, booleans, or numerical values have default values. The default value is used if
the corresponding parameter entry is missing.

For output data objects, type the file path to be used to save it, just as it is done from the toolbox. If the output
object is not specified, the result is saved to a temporary file (or skipped if it is an optional output). The extension
of the file determines the file format. If you enter a file extension not supported by the algorithm, the default file
format for that output type will be used, and its corresponding extension appended to the given file path.

Unlike when an algorithm is executed from the toolbox, outputs are not added to the map canvas if you execute
that same algorithm from the Python console using run(), but runAndLoadResults() will do that.

The runmethod returns a dictionary with one or more output names (the ones shown in the algorithm description)
as keys and the file paths of those outputs as values:

>>> myresult = processing.run("native:buffer", {'INPUT': '/data/lines.shp',
'DISTANCE': 100.0,
'SEGMENTS': 10,
'DISSOLVE': True,
'END_CAP_STYLE': 0,
'JOIN_STYLE': 0,
'MITER_LIMIT': 10,
'OUTPUT': '/data/buffers.shp'})

>>> myresult['OUTPUT']
/data/buffers.shp

You can load feature output by passing the corresponding file paths to the load() method. Or you could use
runAndLoadResults() instead of run() to load them immediately.

21.7.2 Créer des scripts et les exécuter depuis la boîte à outils

You can create your own algorithms by writing Python code. Processing scripts extend
QgsProcessingAlgorithm, so you need to add some extra lines of code to implement mandatory
functions. You can find Create new script (clean sheet) and Create New Script from Template (template that
includes code for mandatory functions of QgsProcessingAlgorithm) under the Scripts dropdown menu on
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the top of the Processing toolbox. The Processing Script Editor will open, and that’s where you should type your
code. Saving the script from there in the scripts folder (the default folder when you open the save file dialog)
with a .py extension should create the corresponding algorithm.

The name of the algorithm (the one you will see in the toolbox) is defined within the code.

Let’s have a look at the following code, which defines a Processing algorithm that performs a buffer operation
with a user defined buffer distance on a vector layer that is specified by the user, after first smoothing the layer.

from qgis.core import (QgsProcessingAlgorithm,
QgsProcessingParameterNumber,
QgsProcessingParameterFeatureSource,
QgsProcessingParameterFeatureSink)

import processing

class algTest(QgsProcessingAlgorithm):
INPUT_BUFFERDIST = 'BUFFERDIST'
OUTPUT_BUFFER = 'OUTPUT_BUFFER'
INPUT_VECTOR = 'INPUT_VECTOR'

def __init__(self):
super().__init__()

def name(self):
return "algTest"

def displayName(self):
return "algTest script"

def createInstance(self):
return type(self)()

def initAlgorithm(self, config=None):
self.addParameter(QgsProcessingParameterFeatureSource(

self.INPUT_VECTOR, "Input vector"))
self.addParameter(QgsProcessingParameterNumber(

self.INPUT_BUFFERDIST, "Buffer distance",
QgsProcessingParameterNumber.Double,
100.0))

self.addParameter(QgsProcessingParameterFeatureSink(
self.OUTPUT_BUFFER, "Output buffer"))

def processAlgorithm(self, parameters, context, feedback):
#DO SOMETHING
algresult = processing.run("native:smoothgeometry",

{'INPUT': parameters[self.INPUT_VECTOR],
'ITERATIONS':2,
'OFFSET':0.25,
'MAX_ANGLE':180,
'OUTPUT': 'memory:'},

context=context, feedback=feedback, is_child_algorithm=True)
smoothed = algresult['OUTPUT']
algresult = processing.run('native:buffer',

{'INPUT': smoothed,
'DISTANCE': parameters[self.INPUT_BUFFERDIST],
'SEGMENTS': 5,
'END_CAP_STYLE': 0,
'JOIN_STYLE': 0,
'MITER_LIMIT': 10,
'DISSOLVE': True,
'OUTPUT': parameters[self.OUTPUT_BUFFER]},
context=context, feedback=feedback, is_child_algorithm=True)

buffered = algresult['OUTPUT']

540 Chapter 21. Outils de traitement QGIS



QGIS User Guide, Version 3.4

return {self.OUTPUT_BUFFER: buffered}

After doing the necessary imports, the following QgsProcessingAlgorithm functions are specified:

• name: The id of the algorithm (lowercase).

• displayName: A human readable name for the algorithm.

• createInstance: Create a new instance of the algorithm class.

• initAlgorithm: Configure the parameterDefinitions and outputDefinitions.

Here you describe the parameters and output of the algorithm. In this case, a feature source for the input, a
feature sink for the result and a number for the buffer distance.

• processAlgorithm: Do the work.

Here we first run the smoothgeometry algorithm to smooth the geometry, and then we run the buffer
algorithm on the smoothed output. To be able to run algorithms from within another algorithm we have
to define a dummy function for the onFinish parameter for run. This is the no_post_process
function. You can see how input and output parameters are used as parameters to the smoothgeometry
and buffer algorithms.

There are a number of different parameter types available for input and output. Below is an alphabetically sorted
list:

• QgsProcessingParameterBand

• QgsProcessingParameterBoolean

• QgsProcessingParameterCrs

• QgsProcessingParameterDistance

• QgsProcessingParameterEnum

• QgsProcessingParameterExpression

• QgsProcessingParameterExtent

• QgsProcessingParameterFeatureSink

• QgsProcessingParameterFeatureSource

• QgsProcessingParameterField - A field in the attributes table of a vector layer. The name of the
layer has to be specified.

• QgsProcessingParameterFile

• QgsProcessingParameterFileDestination

• QgsProcessingParameterFolderDestination

• QgsProcessingParameterMapLayer

• QgsProcessingParameterMatrix

• QgsProcessingParameterMultipleLayers

• QgsProcessingParameterNumber

• QgsProcessingParameterPoint

• QgsProcessingParameterRange

• QgsProcessingParameterRasterDestination

• QgsProcessingParameterRasterLayer

• QgsProcessingParameterString

• QgsProcessingParameterVectorDestination

• QgsProcessingParameterVectorLayer

21.7. Utiliser les algorithmes du module de traitements depuis la console Python 541

https://qgis.org/pyqgis/3.4/core/QgsProcessingAlgorithm.html#qgis.core.QgsProcessingAlgorithm
https://qgis.org/pyqgis/3.4/core/QgsProcessingAlgorithm.html#qgis.core.QgsProcessingAlgorithm.name
https://qgis.org/pyqgis/3.4/core/QgsProcessingAlgorithm.html#qgis.core.QgsProcessingAlgorithm.displayName
https://qgis.org/pyqgis/3.4/core/QgsProcessingAlgorithm.html#qgis.core.QgsProcessingAlgorithm.createInstance
https://qgis.org/pyqgis/3.4/core/QgsProcessingAlgorithm.html#qgis.core.QgsProcessingAlgorithm.initAlgorithm
https://qgis.org/pyqgis/3.4/core/QgsProcessingAlgorithm.html#qgis.core.QgsProcessingAlgorithm.processAlgorithm
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterBand.html#qgis.core.QgsProcessingParameterBand
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterBoolean.html#qgis.core.QgsProcessingParameterBoolean
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterCrs.html#qgis.core.QgsProcessingParameterCrs
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterDistance.html#qgis.core.QgsProcessingParameterDistance
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterEnum.html#qgis.core.QgsProcessingParameterEnum
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterExpression.html#qgis.core.QgsProcessingParameterExpression
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterExtent.html#qgis.core.QgsProcessingParameterExtent
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterFeatureSink.html#qgis.core.QgsProcessingParameterFeatureSink
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterFeatureSource.html#qgis.core.QgsProcessingParameterFeatureSource
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterField.html#qgis.core.QgsProcessingParameterField
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterFile.html#qgis.core.QgsProcessingParameterFile
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterFileDestination.html#qgis.core.QgsProcessingParameterFileDestination
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterFolderDestination.html#qgis.core.QgsProcessingParameterFolderDestination
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterMapLayer.html#qgis.core.QgsProcessingParameterMapLayer
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterMatrix.html#qgis.core.QgsProcessingParameterMatrix
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterMultipleLayers.html#qgis.core.QgsProcessingParameterMultipleLayers
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterNumber.html#qgis.core.QgsProcessingParameterNumber
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterPoint.html#qgis.core.QgsProcessingParameterPoint
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterRange.html#qgis.core.QgsProcessingParameterRange
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterRasterDestination.html#qgis.core.QgsProcessingParameterRasterDestination
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterRasterLayer.html#qgis.core.QgsProcessingParameterRasterLayer
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterString.html#qgis.core.QgsProcessingParameterString
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterVectorDestination.html#qgis.core.QgsProcessingParameterVectorDestination
https://qgis.org/pyqgis/3.4/core/QgsProcessingParameterVectorLayer.html#qgis.core.QgsProcessingParameterVectorLayer


QGIS User Guide, Version 3.4

The first parameter to the constructors is the name of the parameter, and the second is the description of the
parameter (for the user interface). The rest of the constructor parameters are parameter type specific.

The input can be turned into QGIS classes using the parameterAs functions of
QgsProcessingAlgorithm. For instance to get the number provided for the buffer distance as a
double:

self.parameterAsDouble(parameters, self.INPUT_BUFFERDIST, context)).

The processAlgorithm function should return a dictionary containing values for every output defined by the
algorithm. This allows access to these outputs from other algorithms, including other algorithms contained within
the same model.

Well behaved algorithms should define and return as many outputs as makes sense. Non-feature outputs, such as
numbers and strings, are very useful when running your algorithm as part of a larger model, as these values can be
used as input parameters for subsequent algorithms within the model. Consider adding numeric outputs for things
like the number of features processed, the number of invalid features encountered, the number of features output,
etc. The more outputs you return, the more useful your algorithm becomes!

Feedback

The feedback object passed to processAlgorithm should be used for user feedback / interaction. You can
use the setProgress function of the feedback object to update the progress bar (0 to 100) to inform the user
about the progress of the algorithm. This is very useful if your algorithm takes a long time to complete.

The feedback object provides an isCanceled method that should be monitored to enable cancelation of the
algorithm by the user. The pushInfo method of feedback can be used to send information to the user, and
reportError is handy for pushing non-fatal errors to users.

Algorithms should avoid using other forms of providing feedback to users, such as print statements or logging
to QgsMessageLog, and should always use the feedback object instead. This allows verbose logging for the
algorithm, and is also thread-safe (which is important, given that algorithms are typically run in a background
thread).

Handling errors

If your algorithm encounters an error which prevents it from executing, such as invalid input values or some other
condition from which it cannot or should not recover, then you should raise a QgsProcessingException.
E.g.:

if feature['value'] < 20:
raise QgsProcessingException('Invalid input value {}, must be >= 20'.

→˓format(feature['value']))

Try to avoid raising QgsProcessingException for non-fatal errors (e.g. when a feature has a null geometry),
and instead just report these errors via feedback.reportError() and skip the feature. This helps make your
algorithm « model-friendly », as it avoids halting the execution of an entire algorithm when a non-fatal error is
encountered.

Documenter ses scripts

As in the case of models, you can create additional documentation for your scripts, to explain what they do and
how to use them.

QgsProcessingAlgorithm provides the helpString, shortHelpString and helpUrl functions for
that purpose. Specify / override these to provide more help to the user.

shortDescription is used in the tooltip when hovering over the algorithm in the toolbox.
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21.7.3 Scripts de pré et post-exécution

Scripts can also be used as pre- and post-execution hooks that are run before and after an algorithm is run, respec-
tively. This can be used to automate tasks that should be performed whenever an algorithm is executed.

La syntaxe est identique à celle qui est expliquée plus haut mais une variable globale nommée alg est disponible.
Elle représente l’objet alogrithme qui vient (ou qui va) être lancé.

In the General group of the processing options dialog, you will find two entries named Pre-execution script and
Post-execution script where the filenames of the scripts to be run in each case can be entered.

21.8 Écrire de nouveaux algorithmes sous la forme de scripts
Python

In QGIS 3.4, the only way to write Processing algorithms using Python is to extend the
QgsProcessingAlgorithm class.

Within QGIS, you can use Create new script in the Scripts menu at the top of the Processing Toolbox to open
the Processing Script Editor where you can write your code. To simplify the task, you can start with a script
template by using Create new script from template from the same menu. This opens a template that extends
QgsProcessingAlgorithm.

If you save the script in the scripts folder (the default location) with a .py extension, the algorithm will
become available in the Processing Toolbox.

21.8.1 Extending QgsProcessingAlgorithm

The following code

1. takes a vector layer as input

2. counts the number of features

3. does a buffer operation

4. creates a raster layer from the result of the buffer operation

5. returns the buffer layer, raster layer and number of features

from qgis.PyQt.QtCore import QCoreApplication
from qgis.core import (QgsProcessing,

QgsProcessingAlgorithm,
QgsProcessingException,
QgsProcessingOutputNumber,
QgsProcessingParameterDistance,
QgsProcessingParameterFeatureSource,
QgsProcessingParameterVectorDestination,
QgsProcessingParameterRasterDestination)

import processing

class ExampleProcessingAlgorithm(QgsProcessingAlgorithm):
"""
This is an example algorithm that takes a vector layer,
creates some new layers and returns some results.
"""

def tr(self, string):
"""
Returns a translatable string with the self.tr() function.
"""
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return QCoreApplication.translate('Processing', string)

def createInstance(self):
# Must return a new copy of your algorithm.
return ExampleProcessingAlgorithm()

def name(self):
"""
Returns the unique algorithm name.
"""
return 'bufferrasterextend'

def displayName(self):
"""
Returns the translated algorithm name.
"""
return self.tr('Buffer and export to raster (extend)')

def group(self):
"""
Returns the name of the group this algorithm belongs to.
"""
return self.tr('Example scripts')

def groupId(self):
"""
Returns the unique ID of the group this algorithm belongs
to.
"""
return 'examplescripts'

def shortHelpString(self):
"""
Returns a localised short help string for the algorithm.
"""
return self.tr('Example algorithm short description')

def initAlgorithm(self, config=None):
"""
Here we define the inputs and outputs of the algorithm.
"""
# 'INPUT' is the recommended name for the main input
# parameter.
self.addParameter(

QgsProcessingParameterFeatureSource(
'INPUT',
self.tr('Input vector layer'),
types=[QgsProcessing.TypeVectorAnyGeometry]

)
)
self.addParameter(

QgsProcessingParameterVectorDestination(
'BUFFER_OUTPUT',
self.tr('Buffer output'),

)
)
# 'OUTPUT' is the recommended name for the main output
# parameter.
self.addParameter(

QgsProcessingParameterRasterDestination(
'OUTPUT',
self.tr('Raster output')

)
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)
self.addParameter(

QgsProcessingParameterDistance(
'BUFFERDIST',
self.tr('BUFFERDIST'),
defaultValue = 1.0,
# Make distance units match the INPUT layer units:
parentParameterName='INPUT'

)
)
self.addParameter(

QgsProcessingParameterDistance(
'CELLSIZE',
self.tr('CELLSIZE'),
defaultValue = 10.0,
parentParameterName='INPUT'

)
)
self.addOutput(

QgsProcessingOutputNumber(
'NUMBEROFFEATURES',
self.tr('Number of features processed')

)
)

def processAlgorithm(self, parameters, context, feedback):
"""
Here is where the processing itself takes place.
"""
# First, we get the count of features from the INPUT layer.
# This layer is defined as a QgsProcessingParameterFeatureSource
# parameter, so it is retrieved by calling
# self.parameterAsSource.
input_featuresource = self.parameterAsSource(parameters,

'INPUT',
context)

numfeatures = input_featuresource.featureCount()

# Retrieve the buffer distance and raster cell size numeric
# values. Since these are numeric values, they are retrieved
# using self.parameterAsDouble.
bufferdist = self.parameterAsDouble(parameters, 'BUFFERDIST',

context)
rastercellsize = self.parameterAsDouble(parameters, 'CELLSIZE',

context)
if feedback.isCanceled():

return {}
buffer_result = processing.run(

'native:buffer',
{

# Here we pass on the original parameter values of INPUT
# and BUFFER_OUTPUT to the buffer algorithm.
'INPUT': parameters['INPUT'],
'OUTPUT': parameters['BUFFER_OUTPUT'],
'DISTANCE': bufferdist,
'SEGMENTS': 10,
'DISSOLVE': True,
'END_CAP_STYLE': 0,
'JOIN_STYLE': 0,
'MITER_LIMIT': 10

},
# Because the buffer algorithm is being run as a step in
# another larger algorithm, the is_child_algorithm option
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# should be set to True
is_child_algorithm=True,
#
# It's important to pass on the context and feedback objects to
# child algorithms, so that they can properly give feedback to
# users and handle cancelation requests.
context=context,
feedback=feedback)

# Check for cancelation
if feedback.isCanceled():

return {}

# Run the separate rasterization algorithm using the buffer result
# as an input.
rasterized_result = processing.run(

'qgis:rasterize',
{

# Here we pass the 'OUTPUT' value from the buffer's result
# dictionary off to the rasterize child algorithm.
'LAYER': buffer_result['OUTPUT'],
'EXTENT': buffer_result['OUTPUT'],
'MAP_UNITS_PER_PIXEL': rastercellsize,
# Use the original parameter value.
'OUTPUT': parameters['OUTPUT']

},
is_child_algorithm=True,
context=context,
feedback=feedback)

if feedback.isCanceled():
return {}

# Return the results
return {'OUTPUT': rasterized_result['OUTPUT'],

'BUFFER_OUTPUT': buffer_result['OUTPUT'],
'NUMBEROFFEATURES': numfeatures}

Processing algorithm standard functions:

• createInstance (mandatory) Must return a new copy of your algorithm. If you change the name of the
class, make sure you also update the value returned here to match!

• name (mandatory) Returns the unique algorithm name, used for identifying the algorithm.

• displayName (mandatory) Returns the translated algorithm name.

• group Returns the name of the group this algorithm belongs to.

• groupId Returns the unique ID of the group this algorithm belongs to.

• shortHelpString Returns a localised short help string for the algorithm.

• initAlgorithm (mandatory) Here we define the inputs and outputs of the algorithm.

INPUT and OUTPUT are recommended names for the main input and main output parameters, respec-
tively.

If a parameter depends on another parameter, parentParameterName is used to specify this rela-
tionship (could be the field / band of a layer or the distance units of a layer).

• processAlgorithm (mandatory) This is where the processing takes place.

Parameters are retrieved using special purpose functions, for instance parameterAsSource and
parameterAsDouble.
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processing.run can be used to run other processing algorithms from a processing algorithm. The
first parameter is the name of the algorithm, the second is a dictionary of the parameters to the algo-
rithm. is_child_algorithm is normally set to True when running an algorithm from within
another algorithm. context and feedback inform the algorithm about the environment to run in
and the channel for communicating with the user (catching cancel request, reporting progress, pro-
viding textual feedback). When using the (parent) algorithm’s parameters as parameters to « child »
algorithms, the original parameter values should be used (e.g. parameters['OUTPUT']).

It is good practice to check the feedback object for cancelation as much as is sensibly possible! Doing
so allows for responsive cancelation, instead of forcing users to wait for unwanted processing to occur.

The algorithm should return values for all the output parameters it has defined as a dictionary. In this
case, that’s the buffer and rasterized output layers, and the count of features processed. The dictionary
keys must match the original parameter/output names.

21.8.2 Handing algorithm output

When you declare an output representing a layer (raster or vector), the algorithm will try to add it to QGIS once it
is finished.

• Raster layer output: QgsProcessingParameterRasterDestination.

• Vector layer output: QgsProcessingParameterVectorDestination.

So even if the processing.run() method does not add the layers it creates into the user’s current project, the
two output layers (buffer and raster buffer) will be loaded, since they are saved to the destinations entered by the
user (or to temporary destinations if the user does not specify a destination).

If a layer is created as output of an algorithm, it should be declared as such. Otherwise, you will not be able to
properly use the algorithm in the modeler, since what is declared will not match what the algorithm really creates.

You can return strings, numbers and more by specifying them in the result dictionary (as demonstrated for « NUM-
BEROFFEATURES »), but they should always be explicitly defined as outputs from your algorithm. We encour-
age algorithms to output as many useful values as possible, since these can be valuable for use in later algorithms
when your algorithm is used as part of a model.

21.8.3 Communiquer avec l’utilisateur

If your algorithm takes a long time to process, it is a good idea to inform the user about the progress. You can use
feedback (QgsProcessingFeedback) for this.

The progress text and progressbar can be updated using two methods: setProgressText(text) and
setProgress(percent).

You can provide more information to the user using pushCommandInfo(text), pushDebugInfo(text),
pushInfo(text) and reportError(text).

If your script has a problem, the correct way of handling it is to raise a QgsProcessingException. You
can pass a message as an argument to the constructor of the exception. Processing will take care of handling it
and communicating with the user, depending on where the algorithm is being executed from (toolbox, modeler,
Python console, . . . )

21.8.4 Documenter ses scripts

You can document your scripts by overloading the helpString() and helpUrl() methods of
QgsProcessingAlgorithm.
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21.8.5 Flags

You can override the flags method of QgsProcessingAlgorithm to tell QGIS more about your algorithm.
You can for instance tell QGIS that the script shall be hidden from the modeler, that it can be canceled, that it is
not thread safe, and more.

Astuce: By default, Processing runs algorithms in a separate thread in order to keep QGIS responsive while
the processing task runs. If your algorithm is regularly crashing, you are probably using API calls which are not
safe to do in a background thread. Try returning the QgsProcessingAlgorithm.FlagNoThreading flag from your
algorithm’s flags() method to force Processing to run your algorithm in the main thread instead.

21.8.6 Bonnes pratiques d’écriture de scripts d’algorithmes

Voici un rapide résumé des idées à retenir lorsque vous créez vos scripts d’algorithmes et que vous souhaitez les
partager avec d’autres utilisateurs QGIS. En suivant ces quelques règles, vous vous assurerez de fournir des élé-
ments constants sur toutes les interfaces du menu Traitements telles que la boîte à outils, le modeleur et l’interface
de commande.

• Ne chargez pas les couches de résultat. Laissez les Traitements gérer ces résultats et charger vos couches si
besoin.

• Always declare the outputs your algorithm creates.

• Do not show message boxes or use any GUI element from the script. If you want to communi-
cate with the user, use the methods of the feedback object (QgsProcessingFeedback) or throw a
QgsProcessingException.

There are already many processing algorithms available in QGIS. You can find code on https://github.com/qgis/
QGIS/blob/release-3_4/python/plugins/processing/algs/qgis.

21.9 Configuration des applications tierces

The processing framework can be extended using additional applications. Currently, SAGA, GRASS and R are
supported. Algorithms relying on an external applications are managed by their own algorithm provider. Addi-
tional providers can be found as separate plugins, and installed using the QGIS Plugin Manager.

This section will show you how to configure the Processing framework to include these additional applications,
and it will explain some particular features of the algorithms based on them. Once you have correctly configured
the system, you will be able to execute external algorithms from any component like the toolbox or the graphical
modeler, just like you do with any other geoalgorithm.

Par défaut, tous les algorithmes qui reposent sur une application tierce non fournie avec QGIS sont désactivés.
Vous pouvez les activer dans la fenêtre de configuration. Vérifiez que l’application correspondante est préalable-
ment installée sur votre ordinateur.

21.9.1 Note pour les utilisateurs de Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the standalone installer. That will
automatically install SAGA and GRASS in your system and configure them so they can be run from QGIS. All
the algorithms from these providers will be ready to be run without needing any further configuration. If installing
through OSGeo4W application, make sure you select for installation SAGA and GRASS as well.
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21.9.2 A propos des formats de fichiers

Le fait d’ouvrir un fichier dans QGIS ne garantit pas que ce fichier pourra être ouvert et traité par l’application
tierce. Dans la plupart des cas, celui-ci pourra lire ce que vous avez ouvert dans QGIS, mais parfois, cela ne sera
pas le cas. C’est particulièrement le cas des connections aux bases de données et les fichiers peu communs, aussi
bien raster que vectoriels, qui pourront présenter des problèmes. Si cela arrivait, essayez de convertir vos données
dans un format usuel reconnu par l’application tierce et vérifiez dans la console (historique et messages) le résultat
du traitement pour analyser l’origine des erreurs.

Si vous utilisez des couches raster GRASS, par exemple, vous allez peut-être rencontrer des problèmes et ne pas
pouvoir mener à bien votre travail si vous appelez des algorithmes externes ayant cette couche comme entrée.
C’est pour cette raison que ces couches ne seront pas disponibles pour les algorithmes.

You should, however, find no problems at all with vector layers, since QGIS automatically converts from the
original file format to one accepted by the external application before passing the layer to it. This adds extra
processing time, which might be significant if the layer has a large size, so do not be surprised if it takes more time
to process a layer from a DB connection than it process a layer from a Shapefile format dataset of similar size.

Les algorithmes n’utilisant pas d’application tierce peuvent traiter toutes les couches qui peuvent s’ouvrir dans
QGIS puisque qu’ils sont lancés depuis QGIS.

Concernant les formats de sortie, tous les formats gérés par QGIS peuvent être utilisés en sortie, à la fois pour
les couches raster et vecteur. Certains formats ne sont pas gérés par certaines applications tierces mais celles-ci
permettent toutes d’exporter dans des formats courants qui peuvent ensuite être convertis automatiquement par
QGIS. Comme pour les couches d’entrée, si une conversion est opérée, le temps de traitement peut être allongé.

21.9.3 A propos des sélections sur les couches vectorielles

Les applications tierces peuvent prendre en compte les sélections qui existent sur les couches vecteur dans QGIS.
Cependant, cela nécessite de réécrire toutes les couches vecteur d’entrée, comme si elles étaient dans un format
non géré par l’application tierce. Une couche peut être passée directement à une application tierce uniquement
lorsqu’il n’y a pas de sélection ou que l’option N’utiliser que les entités sélectionnées n” pas activée dans les
paramètres de configuration généraux du module de traitement.

Dans les cas où l’export de la sélection est nécessaire cela rallonge les temps d’exécution.

21.9.4 SAGA

Les algorithmes de SAGA peuvent être exécutés depuis QGIS si SAGA est installé sur votre ordinateur et que
le module de traitements QGIS est configuré correctement pour trouver les fichiers nécessaires. En particulier,
l’exécutable en ligne de commande de SAGE est nécessaire pour utiliser les algorithmes.

Si vous utilisez Windows, les installateurs indépendant et OSGeo4W incluent SAGA aux côtés de QGIS, et le
chemin d’accès est automatiquement configuré. Il n’y a donc rien à faire d’autre.

Si vous avez installé vous-même SAGA et que votre installeur QGIS ne l’inclut pas, le chemin vers l’exécutable
SAGA doit être configuré. pour cela, ouvrez la fenêtre de configuration. Dans le bloc SAGA, vous trouverez un
paramètre nommé Répertoire SAGA. Entrez le chemin du dossier d’installation de SAGA et fermez la fenêtre.
Vous êtes prêts à utiliser les algorithmes de SAGA depuis QGIS.

Si vous êtes sur Linux, les exécutables SAGA ne sont pas inclus dans le module de Traitements. Vous devez donc
télécharger et installer le logiciel vous-même. Référez au site web de SAGA pour plus d’informations.

Dans ce cas, il n’est pas nécessaire de configurer le chemin vers l’exécutable de SAGA et vous ne verrez pas ces
répertoires. Vérifiez que SAGA est correctement installé et que le chemin d’installation figure dans la variable
d’environnement PATH. Pour vérifier que les fichiers binaires de SAGA sont accessibles, ouvrez une console et
tapez saga_cmd.

21.9. Configuration des applications tierces 549



QGIS User Guide, Version 3.4

A propos des limitations du système de grille de SAGA

La plupart des algorithmes SAGA nécessitent habituellement des couches Raster en entrée sur la même emprise et
la même grille, couvrant la même emprise et ayant la même résolution. A l’appel d’un algorithme SAGA depuis
QGIS, vous pouvez cependant utiliser n’importe quelle couche, quelles que soient leur emprise et leur résolution.
Quand plusieurs couches raster son indiquées en entré d’un algorithme SAGA, QGIS les rééchantillonne sur une
grille commune avant de les transmettre à SAGA (à moins que l’algorithme SAGA manipule directement des
couches dans des grilles différentes).

La définition de cette grille commune est contrôlée par l’utilisateur et peut se faire selon plusieurs paramètres,
présents dans le groupe SAGA de la fenêtre de configuration. Deux façons de procéder existent:

• La configuration manuelle. Vous définissez l’emprise à l’aide des paramètres suivants:

– Rééchantillonner la valeur minimum de X

– Rééchantillonner la valeur maximum de X

– Rééchantillonner la valeur minimum de Y

– Rééchantillonner la valeur maximum de Y

– Rééchantillonner la taille de la cellule

Veuillez noter que QGIS rééchantillonnera les couches en entrées sur cette emprise, même si elles ne la
recoupent pas.

• La configuration automatique à partir des couches en entrée. Pour choisir cette option, activez l’option
Utiliser la grille minimale pour le rééchantillonnage. Toutes les autres options seront ignorées et l’emprise
minimum couvrant toutes les couches sera utilisée. La taille de la cellule de la couche cible sera la plus
grande des tailles de cellules des couches en entrée.

Pour les algorithmes qui n’utilisent pas plusieurs couches raster, ou pour ceux qui n’ont pas besoin d’une grille
unique, le rééchantillonnage n’est pas nécessaire et ces paramètres ne seront pas utilisés.

Limitations pour les couches multi-bandes

Contrairement à QGIS, SAGA ne gère pas les couches multi-bande. Si vous utilisez de telles couches (par exemple
une image RVB ou multispectrale), vous devez tout d’abord la séparer en couches mono-bande. Pour ce faire, vous
pouvez utilisez l’algorithme “SAGA/Grid - Tools/Split RGB image” (qui crée trois images à partir d’une image
RVB) ou l’algorithme “SAGA/Grid - Tools/Extract band” (qui extrait une bande en particulier).

Limitations dans la résolution

SAGA suppose que la couche raster possède la même résolution en X et en Y. Si vous travaillez sur une couche
avec des résolutions différentes entre les deux axes, les résultats peuvent être incohérents. Dans ce cas, un message
d’avertissement est ajouté au journal, indiquant que la couche n’est pas adaptée au traitement par SAGA.

Suivi du journal

Lorsque QGIS appelle SAGA, il le fait par son interface en lignes de commandes pour effectuer l’opération
demandée. SAGA transmet son état d’avancement dans la console ainsi que d’autres informations. Ces messages
sont filtrés et utilisés pour afficher la barre d’avancement pendant l’exécution de l’algorithme.

Les commandes envoyées par QGIS et les informations supplémentaires écrites par SAGA peuvent être consignées
dans le log comme pour tous les algorithmes. Il peut être utile de suivre en détail ce qu’il se passe lorsque QGIS
lance un algorithme SAGA. Vous avez deux options pour activer ce mécanisme : Log console output et Log
execution commands.

La plupart des autres fournisseurs tiers qui sont appelés par la ligne de commandes ont des options similaires, que
vous trouverez dans la rubrique configuration du module.
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21.9.5 R. Creating R scripts

To enable R in Processing you need to install the Processing R Provider plugin.

L’intégration de R est légèrement différente de celle de SAGA, dans la mesure où il n’y a pas d’ensemble prédéfini
d’algorithmes à exécuter, hormis quelques exemples. Au lieu de cela, c’est à vous d’écrire les scripts à transmettre
à R, comme vous le feriez depuis R. Un peu comme dans le chapitre sur les scripts. Ce chapitre va vous montrer
comment appeler les commandes R à partir de QGIS et comment leur transmettre les objets QGIS (couches et
tables).

La première chose à faire, comme nous l’avons vu pour SAGA, est de dire à QGIS où se situent les fichiers
exécutables de R. Paramétrez l’entrée Répertoire R dans la fenêtre de configuration du module de traitements.
Une fois cela fait, vous pouvez commencer à créer et exécuter vos propres scripts R.

Note: Pour les utilisateurs Windows, l’exécutable de R est situé dans le répertoire C:\Program
Files\R\R-3.2. Ajoutez uniquement le répertoire et NON le binaire !

Une fois encore, pour Linux, cela est légèrement différent : vous n’avez qu’à vérifier que le répertoire R est inclus
dans la variable d’environnement PATH. Si vous pouvez lancer R en tapant R dans un terminal, alors vous êtes
prêt pour la suite.

Pour ajouter un nouvel algorithme qui appelle une fonction R (ou un script R plus complexe que vous auriez
développé et que vous souhaiteriez utiliser dans QGIS), vous devez créer un fichier de script qui va indiquer au
module de traitements comment effectuer l’opération et les commandes R correspondantes.

Les fichiers de scripts R ont l’extension .rsx et leur création est relativement simple si vous connaissez la syntaxe
et le langage de script de R. Ils seront sauvegardés dans le répertoire de scripts de R. Vous pouvez configurer ce
répertoire dans le groupe de configuration de R (dans la fenêtre Options du module de traitements), comme vous
le feriez pour un script ordinaire.

Voyons un simple script, qui appelle la méthode spsample de R, pour créer une grille aléatoire à l’intérieur
de l’emprise d’un ensemble de polygones d’une couche donnée. Cette fonction appartient au paquet maptools.
Comme la plupart des algorithmes que vous aurez à intégrer dans QGIS utilisent ou génèrent des données spatiales,
la connaissance des paquets spatiaux comme maptools et surtout sp est un prérequis.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Les premières lignes, qui commencent avec un double signe de commentaire Python (##), indiquent à QGIS les
entrées de l’algorithme décrit dans le fichier ainsi que les sorties qu’il génère. Ces lignes fonctionnent exactement
avec la même syntaxe que les scripts du module de Traitements que nous avons déjà étudiés et elles ne seront pas
décrites davantage ici.

Merci de jeter un oeil sur les chapitres consacrés à l”Introduction à R et à la Syntaxe R pour avoir plus
d’informations sur la manière d’écrire vos propres scripts R.

Quand vous déclarez un paramètre d’entrée, QGIS utilise cette information pour deux choses : créer le formulaire
pour demander à l’utilisateur la valeur de ce paramètre et créer la variable R correspondante qui sera ensuite
utilisée dans les commandes R.

Dans l’exemple ci-dessus, nous avons déclaré une entrée de type vecteur appelée polyg. A l’exécution de
l’algorithme, QGIS ouvrira la couche sélectionnée par l’utilisateur dans R et la stockera dans une variable nommée
polyg. Ainsi le nom du paramètre est également le nom de la variable à utiliser dans R pour accéder à son contenu
(par conséquent, évitez d’utiliser des mots réservés R comme noms de paramètre).

Les éléments spatiaux telles que les couches vecteur et raster sont lues en utilisant les commandes readOGR() et
brick() (n’ajoutez pas ces commandes à votre description de fichier – QGIS s’en chargera). Elles sont stockées

21.9. Configuration des applications tierces 551



QGIS User Guide, Version 3.4

en tant qu’objets Spatial*DataFrame. Les champs des tables sont stockés en tant que chaînes de caractères
contenant le nom du champ sélectionné.

Les tables sont ouvertes par la commande read.csv(). Si la table à charger n’est pas au format CSV, il faudra
la convertir avant de l’importer dans R.

De plus, les couches raster peuvent être lues avec la commande readGDAL() au lieu de brick(), en utilisant
##usereadgdal.

Si vous êtes un utilisateur expert et que vous ne voulez pas que QGIS crée l’objet correspondant à une couche,
vous pouvez utiliser le paramètre ##passfilename qui indique que vous préférez une chaîne de caractères
contenant le nom du fichier à la place. Dans ce cas, c’est à vous d’ouvrir le fichier au préalable.

Avec l’information ci-dessus, nous pouvons maintenant comprendre la première ligne de notre premier exemple
de script (la première ligne qui n’est pas un commentaire Python).

pts=spsample(polyg,numpoints,type="random")

La variable polygon contient déjà un objet SpatialPolygonsDataFrame, l’appel de la méthode
spsample est donc simple. Il en est de même pour la méthode numpoints qui renvoit le nombre de points à
ajouter pour créer la grille.

Comme nous avons déclaré une sortie de type vecteur nommée out, nous devons créer cette variable out et lui
affecter un objet Spatial*DataFrame (dans notre cas, un SpatialPointsDataFrame). Vous pouvez
utiliser n’importe quel nom pour les variables intermédiaires. Assurez-vous simplement que la variable qui stocke
la valeur finale ait le même nom que la variable de sortie définie au début ainsi qu’une valeur compatible.

Dans notre exemple, le résultat de la méthode spsample doit être converti explicitement en objet
SpatialPointsDataFrame, dans la mesure où c’est un objet de la classe ppp qui ne peut être retransmis à
QGIS.

Si votre algorithme génère des couches raster, la façon dont elles sont enregistrées varie selon que vous ayez utilisé
l’option ##dontuserasterpackage ou pas. Si oui, les couches seront sauvegardées en utilisant la méthode
writeGDAL(). Si non, la méthode writeRaster() du paquet raster sera utilisée.

Si vous avez utilisé l’option #passfilenames, les sorties sont générées à l’aide du package raster (avec
writeRaster()), bien qu’il ne soit pas utilisé pour les entrées.

Si votre algorithme ne renvoie pas de couche mais plutôt un résultat texte dans la console, vous devez préciser
que la console doit s’afficher à la fin de son exécution. Pour cela, commencez les lignes qui doivent renvoyer
les résultats par le signe >. Les sorties des autres lignes seront masquées. Par exemple, voici la description d’un
algorithme qui réalise un test de normalisation sur un champ donné (ou une colonne) de la table d’attributs d’une
couche vectorielle :

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

La sortie de la dernière ligne est affichée, mais la sortie de la première ne l’est pas (ni celles des commandes
ajoutées automatiquement par QGIS).

Si votre algorithme crée des graphiques (par la méthode plot()), ajoutez la ligne suivante:

##showplots

Ceci va indiquer à QGIS de rediriger toutes les sorties graphiques de R vers un fichier temporaire qui sera chargé
une fois l’exécution de R terminée.

Les graphiques et les résultats dans la console seront affichés dans le gestionnaire de résultats.

Pour plus d’informations, veuillez vous référer aux scripts fournis avec le module de Traitements. Tous sont
relativement simples et pourront vous aider à construire vos propres scripts.
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Note: Les bibliothèques rgdal et raster sont chargées par défaut et vous n’avez donc pas besoin d’ajouter
les commandes library() correspondantes (vous devez uniquement vous assurer que les deux paquets sont
installés dans votre distribution de R). Néanmoins, d’autres bibliothèques additionnelles dont vous aurez besoin
doivent être spécifiquement chargées en tapant library(ggplot2). Si le paquet n’est pas encore installé sur
votre machine, Processing le téléchargera et l’installera. De cette manière, le paquet sera également disponible
pour R. Attention, si le paquet doit être téléchargé, le premier lancement du script pourra prendre longtemps.

21.9.6 GRASS

Configuring GRASS is not much different from configuring SAGA. First, the path to the GRASS folder has to be
defined, but only if you are running Windows.

By default, the Processing framework tries to configure its GRASS connector to use the GRASS distribution that
ships along with QGIS. This should work without problems in most systems, but if you experience problems, you
might have to configure the GRASS connector manually. Also, if you want to use a different GRASS installation,
you can change that setting and point to the folder where the other version is installed. GRASS 7 is needed for
algorithms to work correctly.

Sous Linux, assurez-vous simplement que GRASS est correctement installé et qu’il peut être lancé depuis un
terminal.

Les algorithmes GRASS nécessitent la définition d’une région. Cette région peut être définie manuellement,
en fournissant les valeurs, comme pour la configuration de SAGA, ou de manière automatique, correspondant
à l’emprise minimale des données d’entrée à l’exécution de l’algorithme. Si vous préférez ce dernier réglage,
cochez l’option Utiliser l’emprise minimale dans les paramètres de configuration de GRASS.
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CHAPTER 22

Extensions

22.1 Les Extensions de QGIS

QGIS repose sur un système d’extensions. Cela permet d’ajouter facilement de nouvelles fonctions au logiciel.
Certaines fonctions de QGIS sont de fait implémentées comme des extensions.

22.1.1 Extensions principales et complémentaires

Les extensions QGIS sont soit des Extensions principales soit des Extensions externes.

Core Plugins ‘ sont maintenues par l’équipe de développement de QGIS et font automatiquement partie de chaque
distribution de QGIS. Elles sont écrites soit en C++ soit en Python.

Actuellement, la plupart des extensions externes sont écrites en Python. Elles sont stockées soit dans le Dépôt
QGIS « Officiel » ici : https://plugins.qgis.org/plugins/ soit dans des dépôts externes maintenus individuellement
par les auteurs. Des informations détaillées sur l’utilisation, la version minimale de QGIS, la page principale,
les auteurs et d’autres informations importantes sont disponibles pour les extensions du dépôt Officiel. Pour les
dépôts externes, la documentation peut être disponible via les extensions elles-mêmes. De manière général, cette
documentation n’est pas incluse dans ce manuel d’utilisation.

To install or activate a plugin, go to Plugins menu and select Manage and install plugins. . . . Installed external
python plugins are placed under the python/plugins folder of the active user profile path.

Des chemins pointant sur les extensions C++ supplémentaires peuvent être ajoutés dans le menu Préférences →
Options → Système.

Note: According to the plugin manager settings, QGIS main interface can display an icon on the right of the
status bar to inform you that there are updates for your installed plugins or new plugins available.

22.1.2 La fenêtre des Extensions

Les onglets de la fenêtre des Extensions permettent à l’utilisateur d’installer, désinstaller et de mettre à jour les
extensions de différentes façons. Pour chaque extension, quelques métadonnées s’affichent sur la droite :

• l’information si l’extension est expérimentale
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• la description

• les votes (vous pouvez voter pour votre extension préférée !)

• les mots-clé

• quelques liens utiles tels que la page de l’extension, du suivi de bug et le dépot du code

• le ou les auteurs

• la version disponible

En haut de la fenêtre, une fonction Chercher vous aide à trouver n’importe quelle extension en basant la recherche
sur les Métadonnées des extensions (auteur, nom, description, mots clés. . . ). Ce bouton est disponible dans

pratiquement tous les onglets (à l’exception de :guilabel:‘Paramètres”)

L’onglet Paramètres

The Settings tab is the main place you can configure which plugins can be displayed in your application. You
can use the following options:

• Chercher des mises à jour au démarrage. Lorsqu’une nouvelle extension ou une mise à jour est
disponible, QGIS vous en informera “à chaque démarrage de QGIS”, “une fois par jour”, “tous les trois
jours”, “toutes les semaines”, “toutes les deux semaines” ou “tous les mois”.

• Afficher les extensions expérimentales. QGIS vous proposera les extensions encore en développement
qui ne sont généralement pas conseillées pour un usage en production.

• Afficher également les extensions obsolètes. Du fait qu’elles utilisent des fonctions qui ne sont plus
disponible dans les nouvelles version de QGIS, ces extensions sont obsolètes et déconseillées pour un usage
en production. Ces extensions vont apparaître comme étant invalides dans la liste des plugins

By default, QGIS provides you with its official plugin repository with the URL https://plugins.qgis.org/plugins/
plugins.xml?qgis=3.0 (in case of QGIS 3.0) in the Plugin repositories section. To add external author repositories,
click Add. . . and fill in the Repository Details form with a name and the URL. The URL can be of http:// or
file:// protocol type.

Le dépôt QGIS par défaut est un dépôt ouvert et vous n’avez pas besoin d’authentification pour y accéder. Vous
pouvez cependant déployer votre propre dépôt de plugins avec support d’authentification (authentification basique
PKI). Vous trouverez plus d’informations sur la gestion de l’authentification dans QGIS dans le chapitre Authen-
tification.

If you do not want one or more of the added repositories, they can be disabled from the Settings tab via the Edit. . .
button, or completely removed with the Delete button.

L’onglet Toutes

In the All tab, all the available plugins are listed, including both core and external plugins. Use Upgrade
All to look for new versions of the plugins. Furthermore, you can use Install Plugin if a plugin is listed but
not installed, Uninstall Plugin as well as Reinstall Plugin if a plugin is installed. An installed plugin can be
temporarily de/activated using the checkbox.

L’onglet Installées

In the Installed tab, you’ll find listed the Core plugins, that you can not uninstall. You can extend this list with
external plugins that can be uninstalled and reinstalled any time, using the Uninstall Plugin and Reinstall Plugin
buttons. You can Upgrade All the plugins here as well.
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Figure 22.1: L’onglet Paramètres

Figure 22.2: L’onglet Toutes
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Figure 22.3: L’onglet Installé

L’onglet Non installées

L’onglet Non installées liste toutes les extensions disponibles mais non installées. Vous pouvez utiliser le
bouton Installer l’extension pour ajouter une extension à QGIS.

L’onglet Mises à jour et Nouvelles

The Upgradeable and New tabs are enabled when new plugins are added to the repository or a new version

of an installed plugin is released. If you activated Show also experimental plugins in the Settings menu,
those also appear in the list giving you opportunity to early test upcoming tools.

Installation can be done with the Install Plugin, Upgrade Plugin or Upgrade All buttons.

l’onglet Invalides

The Invalid tab lists all installed plugins that are currently broken for any reason (missing dependency, errors
while loading, incompatible functions with QGIS version. . . ). You can try the Reinstall Plugin button to fix
an invalidated plugin but most of the times the fix will be elsewhere (install some libraries, look for another
compatible plugin or help to upgrade the broken one).

L’onglet Installer depuis un ZIP

L’onglet Installer depuis un ZIP propose un outil pour sélectionner un fichier au format zippé pour importer
une extension, par ex; des extensions téléchargées directement depuis leur dépôt.
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Figure 22.4: L’onglet Non installées

Figure 22.5: L’onglet Mises à jour disponibles
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Figure 22.6: L’onglet Invalide

Figure 22.7: L’onglet Installer depuis un ZIP
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22.2 Les extensions principales de QGIS

22.2.1 Coordinate Capture Plugin

The coordinate capture plugin is easy to use and provides the ability to display coordinates on the map canvas for
two selected coordinate reference systems (CRS).

Figure 22.8: Coordinate Capture Plugin

1. Start QGIS, select Properties. . . from the Project menu and click on the CRS tab. As an alternative, you

can also click on the CRS icon in the lower right-hand corner of the status bar.

2. Click on the Enable on the fly projection checkbox and select a projected coordinate system of your
choice (see also Utiliser les projections).

3. Activate the coordinate capture plugin in the Plugin Manager (see La fenêtre des Extensions) and ensure

that the dialog is visible by going to View → Panels and ensuring that Coordinate Capture is enabled.
The coordinate capture dialog appears as shown in Figure figure_coordinate_capture. Alternatively, you
can also look for Vector → Coordinate Capture.

4. Click on the Click to the select the CRS to use for coordinate display icon and select a different CRS from the one you
selected above.

5. To start capturing coordinates, click on Start Capture. You can now click anywhere on the map canvas and
the plugin will show the coordinates for both of your selected CRS.

6. To enable mouse coordinate tracking, click the mouse tracking icon.

7. You can also copy selected coordinates to the clipboard.

22.2.2 DB Manager Plugin

The DB Manager Plugin is officially part of the QGIS core and is intended to be the main tool to integrate and
manage spatial database formats supported by QGIS (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, Virtual

layers) in one user interface. The DB Manager Plugin provides several features. You can drag layers from the
QGIS Browser into the DB Manager, and it will import your layer into your spatial database. You can drag and
drop tables between spatial databases and they will get imported.

The Database menu allows you to connect to an existing database, to start the SQL window and to exit the DB
Manager Plugin. Once you are connected to an existing database, the menus Schema and Table additionally
appear.

The Schema menu includes tools to create and delete (empty) schemas and, if topology is available (e.g., PostGIS
2), to start a TopoViewer.

The Table menu allows you to create and edit tables and to delete tables and views. It is also possible to empty
tables and to move tables from one schema to another. As further functionality, you can perform a VACUUM
and then an ANALYZE for each selected table. Plain VACUUM simply reclaims space and makes it available
for reuse. ANALYZE updates statistics to determine the most efficient way to execute a query. Finally, you can
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Figure 22.9: DB Manager dialog
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import layers/files, if they are loaded in QGIS or exist in the file system. And you can export database tables to
shape with the Export File feature.

The Tree window lists all existing databases supported by QGIS. With a double-click, you can connect to the
database. With the right mouse button, you can rename and delete existing schemas and tables. Tables can also be
added to the QGIS canvas with the context menu.

If connected to a database, the main window of the DB Manager offers three tabs. The Info tab provides informa-
tion about the table and its geometry, as well as about existing fields, constraints and indexes. It also allows you
to run Vacuum Analyze and to create a spatial index on a selected table, if not already done. The Table tab shows
all attributes, and the Preview tab renders the geometries as preview.

Working with the SQL Window

You can also use the DB Manager to execute SQL queries against your spatial database and then view the spatial
output for queries by adding the results to QGIS as a query layer. It is possible to highlight a portion of the SQL
and only that portion will be executed when you press F5 or click the Execute (F5) button.

Figure 22.10: Executing SQL queries in the DB Manager SQL window

Note: The SQL Window can also be used to create Virtual Layers. In that case, instead of selecting a database,
select QGIS Layers under Virtual Layers before opening the SQL Window. See Creating virtual layers for
instructions on the SQL syntax to use.

22.2.3 eVis Plugin

(This section is derived from Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s Guide. American Museum
of Natural History, Center for Biodiversity and Conservation. Available from https://biodiversityinformatics.amnh.
org/, and released under the GNU FDL.)
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The Biodiversity Informatics Facility at the American Museum of Natural History’s (AMNH) Center for Biodi-
versity and Conservation (CBC) has developed the Event Visualization Tool (eVis), another software tool to add
to the suite of conservation monitoring and decision support tools for guiding protected area and landscape plan-
ning. This plugin enables users to easily link geocoded (i.e., referenced with latitude and longitude or X and Y
coordinates) photographs, and other supporting documents, to vector data in QGIS.

eVis is now automatically installed and enabled in new versions of QGIS, and as with all plugins, it can be disabled
and enabled using the Plugin Manager (see La fenêtre des Extensions).

The eVis plugin is made up of three modules: the “Database Connection tool”, “Event ID tool”, and the “Event
Browser”. These work together to allow viewing of geocoded photographs and other documents that are linked to
features stored in vector files, databases, or spreadsheets.

Event Browser

The Event Browser module provides the functionality to display geocoded photographs that are linked to vector
features displayed in the QGIS map window. Point data, for example, can be from a vector file that can be input
using QGIS or it can be from the result of a database query. The vector feature must have attribute information
associated with it to describe the location and name of the file containing the photograph and, optionally, the
compass direction the camera was pointed when the image was acquired. Your vector layer must be loaded into
QGIS before running the Event Browser.

Launch the Event Browser module

To launch the Event Browser module, click on Database → eVis → eVis Event Browser. This will open the
Generic Event Browser window.

The Event Browser window has three tabs displayed at the top of the window. The Display tab is used to view the
photograph and its associated attribute data. The Options tab provides a number of settings that can be adjusted to
control the behavior of the eVis plugin. Lastly, the Configure External Applications tab is used to maintain a table
of file extensions and their associated application to allow eVis to display documents other than images.

Understanding the Display window

To see the Display window, click on the Display tab in the Event Browser window. The Display window is used
to view geocoded photographs and their associated attribute data.

1. Display window: A window where the photograph will appear.

2. Zoom in button: Zoom in to see more detail. If the entire image cannot be displayed in the display window,
scroll bars will appear on the left and bottom sides of the window to allow you to pan around the image.

3. Zoom out button: Zoom out to see more area.

4. Zoom to full extent button: Displays the full extent of the photograph.

5. Attribute information window: All of the attribute information for the point associated with the photo-
graph being viewed is displayed here. If the file type being referenced in the displayed record is not an
image but is of a file type defined in the Configure External Applications tab, then when you double-click
on the value of the field containing the path to the file, the application to open the file will be launched to
view or hear the contents of the file. If the file extension is recognized, the attribute data will be displayed
in green.

6. Navigation buttons: Use the Previous and Next buttons to load the previous or next feature when more
than one feature is selected.
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Figure 22.11: The eVis display window
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Figure 22.12: The eVis Options window
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Understanding the Options window

1. File path: A drop-down list to specify the attribute field that contains the directory path or URL for the
photographs or other documents being displayed. If the location is a relative path, then the checkbox must
be clicked. The base path for a relative path can be entered in the Base Path text box below. Information
about the different options for specifying the file location are noted in the section Specifying the location
and name of a photograph below.

2. Compass bearing: A drop-down list to specify the attribute field that contains the compass bearing asso-
ciated with the photograph being displayed. If compass bearing information is available, it is necessary to
click the checkbox below the drop-down menu title.

3. Compass offset: Compass offsets can be used to compensate for declination (to adjust bearings collected

using magnetic bearings to true north bearings). Click the Manual radio button to enter the offset in

the text box or click the From Attribute radio button to select the attribute field containing the offsets.
For both of these options, east declinations should be entered using positive values, and west declinations
should use negative values.

4. Directory base path: The base path onto which the relative path defined in Figure_eVis_options (A) will
be appended.

5. Replace path: If this checkbox is checked, only the file name from A will be appended to the base path.

6. Apply rule to all documents: If checked, the same path rules that are defined for photographs will be used
for non-image documents such as movies, text documents, and sound files. If not checked, the path rules
will only apply to photographs, and other documents will ignore the base path parameter.

7. Remember settings: If the checkbox is checked, the values for the associated parameters will be saved for
the next session when the window is closed or when the Save button below is pressed.

8. Reset values: Resets the values on this line to the default setting.

9. Restore defaults: This will reset all of the fields to their default settings. It has the same effect as clicking
all of the Reset buttons.

10. Save: This will save the settings without closing the Options pane.

Understanding the Configure External Applications window

Figure 22.13: The eVis External Applications window

1. File reference table: A table containing file types that can be opened using eVis. Each file type needs a
file extension and the path to an application that can open that type of file. This provides the capability of
opening a broad range of files such as movies, sound recordings, and text documents instead of only images.

2. Add new file type: Add a new file type with a unique extension and the path for the application that can
open the file.

22.2. Les extensions principales de QGIS 567



QGIS User Guide, Version 3.4

3. Delete current row: Delete the file type highlighted in the table and defined by a file extension and a path
to an associated application.

Specifying the location and name of a photograph

The location and name of the photograph can be stored using an absolute or relative path, or a URL if the pho-
tograph is available on a web server. Examples of the different approaches are listed in Table evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 https://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:https://www.testsite.com/attachments.php?\

attachment_id-12 76

Specifying the location and name of other supporting documents

Supporting documents such as text documents, videos, and sound clips can also be displayed or played by eVis. To
do this, it is necessary to add an entry in the file reference table that can be accessed from the Configure External
Applications window in the Generic Event Browser that matches the file extension to an application that can be
used to open the file. It is also necessary to have the path or URL to the file in the attribute table for the vector
layer. One additional rule that can be used for URLs that don’t contain a file extension for the document you want
to open is to specify the file extension before the URL. The format is — file extension:URL. The URL
is preceded by the file extension and a colon; this is particularly useful for accessing documents from wikis and
other web sites that use a database to manage the web pages (see Table evis_examples).

Using the Event Browser

When the Event Browser window opens, a photograph will appear in the display window if the document refer-
enced in the vector file attribute table is an image and if the file location information in the Options window is
properly set. If a photograph is expected and it does not appear, it will be necessary to adjust the parameters in the
Options window.

If a supporting document (or an image that does not have a file extension recognized by eVis) is referenced in the
attribute table, the field containing the file path will be highlighted in green in the attribute information window if
that file extension is defined in the file reference table located in the Configure External Applications window. To
open the document, double-click on the green-highlighted line in the attribute information window. If a supporting
document is referenced in the attribute information window and the file path is not highlighted in green, then it
will be necessary to add an entry for the file’s filename extension in the Configure External Applications window.
If the file path is highlighted in green but does not open when double-clicked, it will be necessary to adjust the
parameters in the Options window so the file can be located by eVis.

If no compass bearing is provided in the Options window, a red asterisk will be displayed on top of the vector
feature that is associated with the photograph being displayed. If a compass bearing is provided, then an arrow will
appear pointing in the direction indicated by the value in the compass bearing display field in the Event Browser
window. The arrow will be centered over the point that is associated with the photograph or other document.

To close the Event Browser window, click on the Close button from the Display window.

Event ID Tool

The “Event ID” module allows you to display a photograph by clicking on a feature displayed in the QGIS map
window. The vector feature must have attribute information associated with it to describe the location and name of
the file containing the photograph and, optionally, the compass direction the camera was pointed when the image
was acquired. This layer must be loaded into QGIS before running the “Event ID” tool.
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Launch the Event ID module

To launch the “Event ID” module, either click on the Event ID icon or click on Database → eVis → Event ID
Tool. This will cause the cursor to change to an arrow with an “i” on top of it signifying that the ID tool is active.

To view the photographs linked to vector features in the active vector layer displayed in the QGIS map window,
move the Event ID cursor over the feature and then click the mouse. After clicking on the feature, the Event
Browser window is opened and the photographs on or near the clicked locality are available for display in the
browser. If more than one photograph is available, you can cycle through the different features using the Previous
and Next buttons. The other controls are described in the Event Browser section of this guide.

Database connection

The “Database Connection” module provides tools to connect to and query a database or other ODBC resource,
such as a spreadsheet.

eVis can directly connect to the following types of databases: PostgreSQL, MySQL, and SQLite; it can also
read from ODBC connections (e.g., MS Access). When reading from an ODBC database (such as an Excel
spreadsheet), it is necessary to configure your ODBC driver for the operating system you are using.

Launch the Database Connection module

To launch the “Database Connection” module, either click on the appropriate icon eVis Database Connection or click
on Database → eVis → Database Connection. This will launch the Database Connection window. The window
has three tabs: Predefined Queries, Database Connection, and SQL Query. The Output Console window at the
bottom of the window displays the status of actions initiated by the different sections of this module.

Connect to a database

Click on the Database Connection tab to open the database connection interface. Next, use the Database Type

combo box to select the type of database that you want to connect to. If a password or username is required,
that information can be entered in the Username and Password textboxes.

Enter the database host in the Database Host textbox. This option is not available if you selected “MS Access” as
the database type. If the database resides on your desktop, you should enter « localhost ».

Enter the name of the database in the Database Name textbox. If you selected “ODBC” as the database type, you
need to enter the data source name.

When all of the parameters are filled in, click on the Connect button. If the connection is successful, a message
will be written in the Output Console window stating that the connection was established. If a connection was not
established, you will need to check that the correct parameters were entered above.

1. Database Type: A drop-down list to specify the type of database that will be used.

2. Database Host: The name of the database host.

3. Port: The port number if a MySQL or PostgreSQL database type is selected.

4. Database Name: The name of the database.

5. Connect: A button to connect to the database using the parameters defined above.

6. Output Console: The console window where messages related to processing are displayed.

7. Username: Username for use when a database is password protected.

8. Password: Password for use when a database is password protected.

9. Predefined Queries: Tab to open the « Predefined Queries » window.
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Figure 22.14: The eVis Database connection window

10. Database Connection: Tab to open the « Database Connection » window.

11. SQL Query: Tab to open the « SQL Query » window.

12. Help: Displays the online help.

13. OK: Closes the main « Database Connection » window.

Running SQL queries

SQL queries are used to extract information from a database or ODBC resource. In eVis, the output from these
queries is a vector layer added to the QGIS map window. Click on the SQL Query tab to display the SQL query
interface. SQL commands can be entered in this text window. A helpful tutorial on SQL commands is available at
https://www.w3schools.com/sql. For example, to extract all of the data from a worksheet in an Excel file, select
* from [sheet1$] where sheet1 is the name of the worksheet.

Click on the Run Query button to execute the command. If the query is successful, a Database File Selection
window will be displayed. If the query is not successful, an error message will appear in the Output Console
window.

In the Database File Selection window, enter the name of the layer that will be created from the results of the
query in the Name of New Layer textbox.

1. SQL Query Text Window: A screen to type SQL queries.

2. Run Query: Button to execute the query entered in the SQL Query Window.

3. Console Window: The console window where messages related to processing are displayed.

4. Help: Displays the online help.

5. OK: Closes the main Database Connection window.
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Figure 22.15: The eVis SQL query tab

Use the X Coordinate and Y Coordinate combo boxes to select the fields from the database that stores
the X (or longitude) and Y (or latitude) coordinates. Clicking on the OK button causes the vector layer created
from the SQL query to be displayed in the QGIS map window.

To save this vector file for future use, you can use the QGIS “Save as. . . ” command that is accessed by right-
clicking on the layer name in the QGIS map legend and then selecting “Save as. . . ”

Astuce: Creating a vector layer from a Microsoft Excel Worksheet

When creating a vector layer from a Microsoft Excel Worksheet, you might see that unwanted zeros (« 0 ») have
been inserted in the attribute table rows beneath valid data. This can be caused by deleting the values for these
cells in Excel using the Backspace key. To correct this problem, you need to open the Excel file (you’ll need to
close QGIS if you are connected to the file, to allow you to edit the file) and then use Edit → Delete to remove the
blank rows from the file. To avoid this problem, you can simply delete several rows in the Excel Worksheet using
Edit → Delete before saving the file.

Running predefined queries

With predefined queries, you can select previously written queries stored in XML format in a file. This is par-
ticularly helpful if you are not familiar with SQL commands. Click on the Predefined Queries tab to display the
predefined query interface.

To load a set of predefined queries, click on the Open File icon. This opens the Open File window, which is used
to locate the file containing the SQL queries. When the queries are loaded, their titles as defined in the XML file
will appear in the drop-down menu located just below the Open File icon. The full description of the query is
displayed in the text window under the drop-down menu.
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Select the query you want to run from the drop-down menu and then click on the SQL Query tab to see that the
query has been loaded into the query window. If it is the first time you are running a predefined query or are
switching databases, you need to be sure to connect to the database.

Click on the Run Query button in the SQL Query tab to execute the command. If the query is successful, a
Database File Selection window will be displayed. If the query is not successful, an error message will appear in
the Output Console window.

Figure 22.16: The eVis Predefined Queries tab

1. Open File: Launches the « Open File » file browser to search for the XML file holding the predefined
queries.

2. Predefined Queries: A drop-down list with all of the queries defined by the predefined queries XML file.

3. Query description: A short description of the query. This description is from the predefined queries XML
file.

4. Console Window: The console window where messages related to processing are displayed.

5. Help: Displays the online help.

6. OK: Closes the main « Database Connection » window.

XML format for eVis predefined queries

The XML tags read by eVis
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Tag Description
query Defines the beginning and end of a query statement.
shortde-
scription

A short description of the query that appears in the eVis drop-down menu.

descrip-
tion

A more detailed description of the query displayed in the Predefined Query text window.

database-
type

The database type, defined in the Database Type drop-down menu in the Database Connection tab.

database-
port

The port as defined in the Port text box in the Database Connection tab.

database-
name

The database name as defined in the Database Name text box in the Database Connection tab.

databaseuser-
name

The database username as defined in the Username text box in the Database Connection tab.

databasep-
assword

The database password as defined in the Password text box in the Database Connection tab.

sqlstate-
ment

The SQL command.

autocon-
nect

A flag (« true » » or « false ») to specify if the above tags should be used to automatically connect
to the database without running the database connection routine in the Database Connection tab.

A complete sample XML file with three queries is displayed below:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to

→˓QGIS
</description>

<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</

→˓shortdescription>
<description>This command will import only points that have photographs

→˓"looking across
a valley" to QGIS</description>

<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS='Looking across
valley'</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>

<shortdescription>Import photograph points that mention "limestone"</
→˓shortdescription>
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<description>This command will import only points that have photographs that
→˓mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like '%limestone%'
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

22.2.4 Geometry Checker Plugin

Geometry Checker is a powerful core plugin to check and fix the geometry validity of a layer. It is available from

the Vector menu ( Check Geometries. . . ).

Configuring the checks

The Check Geometries dialog shows different grouped settings in the first tab (Setup):

• Input vector layers: to select the layers to check. A Only selected features checkbox can be used to
restrict the checking to the geometries of the selected features.

• Allowed geometry types: to allow only some geometry types like point, multipoint, line, multiline, polygon
and multipolygon.

• Geometry validity: depending on geometry types, the user can choose Self intersections, Duplicate

nodes, Self contacts and Polygon with less than 3 nodes.

• Geometry properties: depending on geometry types, the user can choose Polygons and multipolygons

may not contain any holes, Multipart objects must consist of more than one part and Lines must not
have dangles.

• Geometry conditions: user can add some condition to validate the geometries with a minimal segment
length, a minimum angle between segment, a minimal polygon area and sliver polygons detection.

• Topology checks: depending on geometry types, the user can choose Checks for duplicates, Checks

for features within other features, Checks for overlaps smaller than , Checks for gaps smaller

than , Points must be covered by lines, Points must properly lie inside a polygon, Lines

must not intersect any other lines, Lines must not intersect with features of layer , Polygons

must follow boundaries of layer .

• Tolerance: you can define the tolerance of the check in map layer units.

• Output vector layer gives the choice to the user how get the result between modify the current layer and
create a new layer.

When you are happy with the configuration, you can click on the Run button.

The Geometry Checker Plugin can find the following errors:

• Self intersections: a polygon with a self intersection;

• Duplicate nodes: two duplicates nodes in a segment;
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Figure 22.17: The Geometry Checker Plugin
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• Holes: hole in a polygon;

• Segment length: a segment length lower than a threshold;

• Minimum angle: two segments with an angle lower than a threshold;

• Minimum area: polygon area lower than a threshold;

• Silver polygon: this error come from very small polygon (with small area) with a large perimeter;

• Duplicates features;

• Feature within feature;

• Overlaps: polygon overlapping;

• Gaps: gaps between polygons.

The following figure shows the different checks made by the plugin.

Figure 22.18: Some checks supported by the plugin

Analysing the results

The results appear in the second tab (Result) and as an overview layer of the errors in the canvas (its name has the
default prefix checked_). A table lists the Geometry check result with one error per row and columns containing:
the layer name, an ID, the error type, then the coordinates of the error, a value (depending on the type of the error)
and finally the resolution column which indicates the resolution of the error. At the bottom of this table, you can
Export the error into different file formats. You also have a counter with the number of total errors and fixed ones.

You can select a row to see the location of the error. You can change this behavior by selecting another action

between Error (default), Feature, Don’t move, and Highlight contour of selected features.
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Below the zoom action when clicking on the table row, you can:

• Show selected features in attribute table;

• Fix selected errors using default resolution;

• Fix selected errors, prompt for resolution method. You will see a window to choose the resolution’s
method among which:

– Merge with neighboring polygon with longest shared edge;

– Merge with neighboring polygon with largest area;

– Merge with neighboring polygon with identical attribute value, if any, or leave as is;

– Delete feature;

– No action.

Astuce: Fix multiple errors

You can fix multiple errors by selecting more than one row in the table with the CTRL + click action.

The default action can be changed with the last icon Error resolution settings For some type of errors, you can
change the default action between some specific action or No action.

Finally, you can choose which attribute to use when merging features by attribute value.

22.2.5 Georeferencer Plugin

The Georeferencer Plugin is a tool for generating world files for rasters. It allows you to reference rasters to
geographic or projected coordinate systems by creating a new GeoTiff or by adding a world file to the existing
image. The basic approach to georeferencing a raster is to locate points on the raster for which you can accurately
determine coordinates.

Features

Icon Purpose Icon Purpose

Open raster Start georeferencing

Generate GDAL Script Load GCP Points

Save GCP Points As Transformation settings

Add Point Delete Point

Move GCP Point Pan

Zoom In Zoom Out

Zoom To Layer Zoom Last

Zoom Next Link Georeferencer to QGIS

Link QGIS to Georeferencer Full histogram stretch

Local histogram stretch

Table Georeferencer: Georeferencer Tools
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Usual procedure

As X and Y coordinates (DMS (dd mm ss.ss), DD (dd.dd) or projected coordinates (mmmm.mm)), which corre-
spond with the selected point on the image, two alternative procedures can be used:

• The raster itself sometimes provides crosses with coordinates « written » on the image. In this case, you can
enter the coordinates manually.

• Using already georeferenced layers. This can be either vector or raster data that contain the same ob-
jects/features that you have on the image that you want to georeference and with the projection that you
want for your image. In this case, you can enter the coordinates by clicking on the reference dataset loaded
in the QGIS map canvas.

The usual procedure for georeferencing an image involves selecting multiple points on the raster, specifying their
coordinates, and choosing a relevant transformation type. Based on the input parameters and data, the plugin will
compute the world file parameters. The more coordinates you provide, the better the result will be.

The first step is to start QGIS, load the Georeferencer Plugin (see La fenêtre des Extensions) and click on Raster

→ Georeferencer, which appears in the QGIS menu bar. The Georeferencer Plugin dialog appears as shown
in figure_georeferencer_dialog.

For this example, we are using a topo sheet of South Dakota from SDGS. It can later be visualized together with
the data from the GRASS spearfish60 location. You can download the topo sheet here: https://grass.osgeo.
org/sampledata/spearfish_toposheet.tar.gz.

Figure 22.19: Georeferencer Plugin Dialog

Entering ground control points (GCPs)

1. To start georeferencing an unreferenced raster, we must load it using the button. The raster will show
up in the main working area of the dialog. Once the raster is loaded, we can start to enter reference points.
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2. Using the Add Point button, add points to the main working area and enter their coordinates (see Figure
figure_georeferencer_add_points). For this procedure you have three options:

• Click on a point in the raster image and enter the X and Y coordinates manually.

• Click on a point in the raster image and choose the From map canvas button to add the X and Y
coordinates with the help of a georeferenced map already loaded in the QGIS map canvas.

• With the button, you can move the GCPs in both windows, if they are at the wrong place.

3. Continue entering points. You should have at least four points, and the more coordinates you can provide,
the better the result will be. There are additional tools on the plugin dialog to zoom and pan the working
area in order to locate a relevant set of GCP points.

Figure 22.20: Add points to the raster image

The points that are added to the map will be stored in a separate text file ([filename].points) usually
together with the raster image. This allows us to reopen the Georeferencer plugin at a later date and add new
points or delete existing ones to optimize the result. The points file contains values of the form: mapX, mapY,

pixelX, pixelY. You can use the Load GCP points and Save GCP points as buttons to manage the files.

Defining the transformation settings

After you have added your GCPs to the raster image, you need to define the transformation settings for the
georeferencing process.

Available Transformation algorithms

Depending on how many ground control points you have captured, you may want to use different transformation
algorithms. Choice of transformation algorithm is also dependent on the type and quality of input data and the
amount of geometric distortion that you are willing to introduce to the final result.

Currently, the following Transformation types are available:

• The Linear algorithm is used to create a world file and is different from the other algorithms, as it does
not actually transform the raster. This algorithm likely won’t be sufficient if you are dealing with scanned
material.

• The Helmert transformation performs simple scaling and rotation transformations.

• The Polynomial algorithms 1-3 are among the most widely used algorithms introduced to match source
and destination ground control points. The most widely used polynomial algorithm is the second-order
polynomial transformation, which allows some curvature. First-order polynomial transformation (affine)
preserves collinearity and allows scaling, translation and rotation only.

• The Thin Plate Spline (TPS) algorithm is a more modern georeferencing method, which is able to intro-
duce local deformations in the data. This algorithm is useful when very low quality originals are being
georeferenced.
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Figure 22.21: Defining the georeferencer transformation settings

• The Projective transformation is a linear rotation and translation of coordinates.

Define the Resampling method

The type of resampling you choose will likely depending on your input data and the ultimate objective of the
exercise. If you don’t want to change statistics of the image, you might want to choose “Nearest neighbour”,
whereas a “Cubic resampling” will likely provide a more smoothed result.

It is possible to choose between five different resampling methods:

1. Nearest neighbour

2. Linear

3. Cubic

4. Cubic Spline

5. Lanczos

Define the transformation settings

There are several options that need to be defined for the georeferenced output raster.

• The Create world file checkbox is only available if you decide to use the linear transformation type,
because this means that the raster image actually won’t be transformed. In this case, the Output raster field
is not activated, because only a new world file will be created.

• For all other transformation types, you have to define an Output raster. As default, a new file ([file-
name]_modified) will be created in the same folder together with the original raster image.
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• As a next step, you have to define the Target SRS (Spatial Reference System) for the georeferenced raster
(see Utiliser les projections).

• If you like, you can generate a pdf map and also a pdf report. The report includes information about the
used transformation parameters, an image of the residuals and a list with all GCPs and their RMS errors.

• Furthermore, you can activate the Set Target Resolution checkbox and define the pixel resolution of the
output raster. Default horizontal and vertical resolution is 1.

• The Use 0 for transparency when needed can be activated, if pixels with the value 0 shall be visualized
transparent. In our example toposheet, all white areas would be transparent.

• Finally, Load in QGIS when done loads the output raster automatically into the QGIS map canvas when
the transformation is done.

Show and adapt raster properties

Clicking on the Raster properties option in the Settings menu opens the Layer properties dialog of the raster file
that you want to georeference.

Configure the georeferencer

• You can define whether you want to show GCP coordinates and/or IDs.

• As residual units, pixels and map units can be chosen.

• For the PDF report, a left and right margin can be defined and you can also set the paper size for the PDF
map.

• Finally, you can activate to Show Georeferencer window docked.

Running the transformation

After all GCPs have been collected and all transformation settings are defined, just press the Start georeferencing

button to create the new georeferenced raster.

22.2.6 MetaSearch Catalog Client

Introduction

MetaSearch is a QGIS plugin to interact with metadata catalog services, supporting the OGC Catalog Service for
the Web (CSW) standard.

MetaSearch provides an easy and intuitive approach and user-friendly interface to searching metadata catalogs
within QGIS.

Installation

MetaSearch is included by default with QGIS 2.0 and higher. All dependencies are included within MetaSearch.

Install MetaSearch from the QGIS plugin manager, or manually from https://plugins.qgis.org/plugins/MetaSearch.
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Figure 22.22: Search and results of Services in MetaSearch

Working with Metadata Catalogs in QGIS

CSW (Catalog Service for the Web)

CSW (Catalog Service for the Web) is an OGC (Open Geospatial Consortium) specification that defines common
interfaces to discover, browse and query metadata about data, services, and other potential resources.

Startup

To start MetaSearch, click the icon or select Web → MetaSearch → MetaSearch via the QGIS main menu.
The MetaSearch dialog will appear. The main GUI consists of three tabs: Services, Search and Settings.

Managing Catalog Services

The Services tab allows the user to manage all available catalog services. MetaSearch provides a default list of
Catalog Services, which can be added by pressing Add Default Services button.

To all listed Catalog Service entries, click the dropdown select box.

To add a Catalog Service entry, click the New button, and enter a Name for the service, as well as the URL
(endpoint). Note that only the base URL is required (not a full GetCapabilities URL). If the CSW requires
authentication, enter the appropriate User name and Password credentials. Clicking OK will add the service to
the list of entries.

To edit an existing Catalog Service entry, select the entry you would like to edit and click the Edit button, and
modify the Name or URL values, then click OK.

To delete a Catalog Service entry, select the entry you would like to delete and click the Delete button. You will
be asked to confirm deleting the entry.
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Figure 22.23: Managing Catalog Services

22.2. Les extensions principales de QGIS 583



QGIS User Guide, Version 3.4

MetaSearch allows for loading and saving connections to an XML file. This is useful when you need to share
settings between applications. Below is an example of the XML file format.

<?xml version="1.0" encoding="UTF-8"?>
<qgsCSWConnections version="1.0">

<csw name="Data.gov CSW" url="https://catalog.data.gov/csw-all"/>
<csw name="Geonorge - National CSW service for Norway" url="https://www.

→˓geonorge.no/geonetwork/srv/eng/csw"/>
<csw name="Geoportale Nazionale - Servizio di ricerca Italiano" url="http://

→˓www.pcn.minambiente.it/geoportal/csw"/>
<csw name="LINZ Data Service" url="http://data.linz.govt.nz/feeds/csw"/>
<csw name="Nationaal Georegister (Nederland)" url="http://www.

→˓nationaalgeoregister.nl/geonetwork/srv/eng/csw"/>
<csw name="RNDT - Repertorio Nazionale dei Dati Territoriali - Servizio di

→˓ricerca" url="http://www.rndt.gov.it/RNDT/CSW"/>
<csw name="UK Location Catalogue Publishing Service" url="http://csw.data.gov.

→˓uk/geonetwork/srv/en/csw"/>
<csw name="UNEP/GRID-Geneva Metadata Catalog" url="http://metadata.grid.unep.

→˓ch:8080/geonetwork/srv/eng/csw"/>
</qgsCSWConnections>

To load a list of entries, click the Load button. A new window will appear; click the Browse button and navigate
to the XML file of entries you wish to load and click Open. The list of entries will be displayed. Select the entries
you wish to add from the list and click Load.

Click the Service Info button to displays information about the selected Catalog Service such as service identi-
fication, service provider and contact information. If you would like to view the raw XML response, click the
GetCapabilities Response button. A separate window will open displaying Capabilities XML.

Searching Catalog Services

The Search tab allows the user to query Catalog Services for data and services, set various search parameters and
view results.

The following search parameters are available:

• Keywords: free text search keywords;

• From: the Catalog Service to perform the query against;

• Bounding box: the spatial area of interest to filter on defined by Xmax, Xmin, Ymax, and Ymin. Click Set
Global to do a global search, click Map Extent to do a search on the visible area only or manually enter
custom values as desired.

Clicking the Search button will search the selected Metadata Catalog. Search results are displayed in a list and are
sortable by clicking on the column title. You can navigate through search results with the directional buttons below
the search results. Clicking the View Search Results as XML button opens a window with the service response in
raw XML format.

Clicking a result will provide the following options:

• if the metadata record has an associated bounding box, a footprint of the bounding box will be displayed on
the map;

• double-clicking the record displays the record metadata with any associated access links. Clicking the links
opens the link in the user’s web browser;

• if the record is a supported web service (WMS/WMTS, WFS, WCS, ArcGIS MapServer, ArcGIS Feature-
Server, etc.), the Add Data button will be enabled for the user to add to QGIS. When clicking this button,
MetaSearch will verify if this is a valid OWS. The service will then be added to the appropriate QGIS
connection list, and the appropriate connection dialog will then appear.
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Figure 22.24: Searching catalog services
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Figure 22.25: Metadata record display
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Settings

Figure 22.26: MetaSearch settings

You can fine tune MetaSearch with the following settings:

• Results paging: when searching metadata catalogs, the number of results to show per page. Default value is
10;

• Timeout: when searching metadata catalogs, the number of seconds for blocking connection attempt. De-
fault value is 10.

22.2.7 Offline Editing Plugin

For data collection, it is a common situation to work with a laptop or a cell phone offline in the field. Upon return-
ing to the network, the changes need to be synchronized with the master datasource (e.g., a PostGIS database). If
several persons are working simultaneously on the same datasets, it is difficult to merge the edits by hand, even if
people don’t change the same features.

The Offline Editing Plugin automates the synchronisation by copying the content of a datasource (usually PostGIS
or WFS-T) to a SpatiaLite or GeoPackage database and storing the offline edits to dedicated tables. After being
connected to the network again, it is possible to apply the offline edits to the master dataset.

To use the plugin:
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1. Open a project with some vector layers (e.g., from a PostGIS or WFS-T datasource).

2. Assuming you have already enabled the plugin (see Extensions principales et complémentaires) go to

Database → Offline Editing → Convert to offline project. The eponym dialog opens.

3. Select the Storage type. It can be of GeoPackage or SpatiaLite database type.

4. Use the Browse button to indicate the location of the database in which to store the Offline data. It can be
an existing file or one to create.

5. In the Select remote layers section, check the layers you’d like to save. The content of the layers is saved to
database tables.

6. You can check Only synchronize selected features if a selection is present allowing to only save and
work on a subset. It can be invaluable in case of large layers.

This is all!

7. Save your project and bring it on the field.

8. Edit the layers offline.

9. After being connected again, upload the changes using Database → Offline Editing → Synchronize.

Figure 22.27: Create an offline project

22.2.8 Topology Checker Plugin

Topology describes the relationships between points, lines and polygons that represent the features of a geographic
region. With the Topology Checker plugin, you can look over your vector files and check the topology with several
topology rules. These rules check with spatial relations whether your features “Equal”, “Contain”, “Cover”, are
“CoveredBy”, “Cross”, are “Disjoint”, “Intersect”, “Overlap”, “Touch” or are “Within” each other. It depends on
your individual questions which topology rules you apply to your vector data (e.g., normally you won’t accept
overshoots in line layers, but if they depict dead-end streets you won’t remove them from your vector layer).
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Figure 22.28: The Topology Checker Plugin

QGIS has a built-in topological editing feature, which is great for creating new features without errors. But existing
data errors and user-induced errors are hard to find. This plugin helps you find such errors through a list of rules.

It is very simple to create topology rules with the Topology Checker plugin.

On point layers the following rules are available:

• Must be covered by: Here you can choose a vector layer from your project. Points that aren’t covered by
the given vector layer occur in the “Error” field.

• Must be covered by endpoints of: Here you can choose a line layer from your project.

• Must be inside: Here you can choose a polygon layer from your project. The points must be inside a
polygon. Otherwise, QGIS writes an “Error” for the point.

• Must not have duplicates: Whenever a point is represented twice or more, it will occur in the “Error” field.

• Must not have invalid geometries: Checks whether the geometries are valid.

• Must not have multi-part-geometries: All multi-part points are written into the “Error” field.

On line layers, the following rules are available:

• End points must be covered by: Here you can select a point layer from your project.

• Must not have dangles: This will show the overshoots in the line layer.

• Must not have duplicates: Whenever a line feature is represented twice or more, it will occur in the “Error”
field.

• Must not have invalid geometries: Checks whether the geometries are valid.

• Must not have multi-part geometries: Sometimes, a geometry is actually a collection of simple (single-
part) geometries. Such a geometry is called multi-part geometry. If it contains just one type of simple
geometry, we call it multi-point, multi-linestring or multi-polygon. All multi-part lines are written into the
“Error” field.
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• Must not have pseudos: A line geometry’s endpoint should be connected to the endpoints of two other
geometries. If the endpoint is connected to only one other geometry’s endpoint, the endpoint is called a
pseudo node.

On polygon layers, the following rules are available:

• Must contain: Polygon layer must contain at least one point geometry from the second layer.

• Must not have duplicates: Polygons from the same layer must not have identical geometries. Whenever a
polygon feature is represented twice or more it will occur in the “Error” field.

• Must not have gaps: Adjacent polygons should not form gaps between them. Administrative boundaries
could be mentioned as an example (US state polygons do not have any gaps between them. . . ).

• Must not have invalid geometries: Checks whether the geometries are valid. Some of the rules that define
a valid geometry are:

– Polygon rings must close.

– Rings that define holes should be inside rings that define exterior boundaries.

– Rings may not self-intersect (they may neither touch nor cross one another).

– Rings may not touch other rings, except at a point.

• Must not have multi-part geometries: Sometimes, a geometry is actually a collection of simple (single-
part) geometries. Such a geometry is called multi-part geometry. If it contains just one type of simple
geometry, we call it multi-point, multi-linestring or multi-polygon. For example, a country consisting of
multiple islands can be represented as a multi-polygon.

• Must not overlap: Adjacent polygons should not share common area.

• Must not overlap with: Adjacent polygons from one layer should not share common area with polygons
from another layer.

Ci-dessous la liste des extensions principales fournies à l’installation de QGIS. Elles ne sont pas nécessairement
activées par défaut.
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Icône Extension Description Référence dans le
manuel

Saisie de coor-
données

Saisie des coordonnées de la souris dans des systèmes de
coordonnées différents

Coordinate Capture
Plugin

Gestionnaire BD Gestion de bases de données depuis QGIS DB Manager Plugin

eVis Visualisation d’événements eVis Plugin

Vérificateur de
géométrie

Vérification et réparation d’erreurs de géométrie dans les
couches vectorielles

Geometry Checker
Plugin

Géoréférenceur
GDAL

Géoréférencement de couches raster à l’aide de GDAL Georeferencer Plu-
gin

Outils GPS Chargement et import de données GPS Extension GPS

GRASS Fonctionnalités de GRASS Intégration du SIG
GRASS

MetaSearch Interaction avec des services de catalogage de métadon-
nées (CSW)

MetaSearch Catalog
Client

Édition hors-ligne Edition hors-ligne et synchronisation de base de données Offline Editing Plu-
gin

Traitement Outils de traitement de données spatiales Outils de traitement
QGIS

Vérificateur de
topologie

Recherche d’erreurs de topologie dans les couches vecto-
rielles

Topology Checker
Plugin

22.3 La Console Python de QGIS

As you will see later in this chapter, QGIS has been designed with a plugin architecture. Plugins can be written in
Python, a very famous language in the geospatial world.

QGIS brings a Python API (see PyQGIS Developer Cookbook for some code sample) to let the user interact with
its objects (layers, feature or interface). QGIS also has a Python console.

The QGIS Python Console is an interactive shell for the python command executions. It also has a python file
editor that allows you to edit and save your python scripts. Both console and editor are based on PyQScintilla2
package. To open the console go to Plugins → Python Console (Ctrl+Alt+P).

22.3.1 La console interactive

La console interactive est composée d’une barre d’outils, d’une zone d’entrée et de sortie.

Barre d’outils

La barre d’outil propose les outils suivant:

• Clear Console to wipe the output area;

• Run Command available in the input area: same as pressing Enter;

• Show Editor: toggles L’éditeur de code visibility;
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• Options. . . : opens a dialog to configure console properties (see Options);

• Help. . . : browses the current documentation.

Console

Les principales fonctionnalités de la console sont :

• Auto-complétion du code, coloration et rappels syntaxiques pour les APIs suivantes:

– Python

– PyQGIS

– PyQt5

– QScintilla2

– osgeo-gdal-ogr

• Ctrl+Alt+Space pour voir la liste d’auto-complétion si elle est activée dans Options;

• Exécutez des fragments de code depuis la zone de saisie en les tapant puis en appuyant sur Entrée ou
Exécuter la Commande;

• Execute code snippets from the output area using the Enter Selected from the contextual menu or pressing
Ctrl+E;

• Parcourez l’historique des commandes dans la zone de saisie en utilisant les touches directionnelles Haut
and Bas et exécutez la commande que vous voulez;

• Ctrl+Shift+Espace pour voir l’historique des commandes: un double clic sur une ligne exécutera
la commande. La boîte de dialogue Historique des Commandes peut aussi être ouverte depuis le menu
contextuel ou la zone de saisie;

• Sauvegardez et videz l’historique des commandes. L’historique sera sauvegardé dans le fichier ~/.qgis2/
console_history.txt;

• Open QGIS C++ API documentation by typing _api;

• Open QGIS Python API documentation by typing _pyqgis.

• Open PyQGIS Cookbook by typing _cookbook.

Astuce: Réutilisez des commandes déjà exécutées depuis la zone de sortie

Vous pouvez exécuter des fragments de code depuis la zone de sortie en les sélectionnant et en appuyant sur
Ctrl+E. Peu importe que le texte sélectionné contienne les caractères d’attente de l’interpréteur (>>>,‘‘. . . ‘‘).

22.3.2 L’éditeur de code

Use the Show Editor button to enable the editor widget. It allows editing and saving Python files and offers
advanced functionalities to manage your code (comment and uncomment code, check syntax, share the code via
codepad.org and much more). Main features are:

• Auto-complétion du code, coloration et rappels syntaxiques pour les APIs suivantes:

– Python

– PyQGIS

– PyQt5

– QScintilla2
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Figure 22.29: La console Python

– osgeo-gdal-ogr

• Ctrl+Space to view the auto-completion list.

• Sharing code snippets via codepad.org.

• Ctrl+4 Syntax check.

• Search bar (open it with the default Desktop Environment shortcut, usually Ctrl+F):

– Use the default Desktop Environment shortcut to find next/previous (Ctrl+G and Shift+Ctrl+G);

– Automatically find first match when typing in find box;

– Set initial find string to selection when opening find;

– Pressing Esc closes the find bar.

• Object inspector: a class and function browser;

• Go to an object definition with a mouse click (from Object inspector);

• Execute code snippets with the Run Selected command in contextual menu;

• Execute the whole script with the Run Script command (this creates a byte-compiled file with the
extension .pyc).

Note: Running partially or totally a script from the Code Editor outputs the result in the Console output area.

22.3.3 Options

Accessible from the Console toolbar and the contextual menus of the Console output panel and the Code Editor,
the Python Console Settings help manage and control the Python console behavior.

For both Console and Editor you can specify:

• Autocompletion: Enables code completion. You can get autocompletion from the current document, the
installed API files or both.

– Autocompletion threshold: Sets the threshold for displaying the autocompletion list (in characters)

• Typing

– Automatic parentheses insertion: Enables autoclosing for parentheses
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Figure 22.30: The Python Console editor

– Automatic insertion of the “import” string on “from xxx”: Enables insertion of “import” when speci-
fying imports

For Editor you can also specify:

• Run and Debug

– Enable Object Inspector (switching between tabs may be slow): Enable the object inspector.

– Auto-save script before running: Saves the script automatically when executed. This action will store
a temporary file (in the temporary system directory) that will be deleted automatically after running.

• Font and Colors: Here you can specify the font to use in the editor and the colors to use for highlighting

For APIs you can specify:

• Using preloaded APIs file: You can choose if you would like to use the preloaded API files. If this is not
checked you can add API files and you can also choose if you would like to use prepared API files (see next
option).

• Using prepared APIs file: If checked, the chosen *.pap file will be used for code completion. To generate
a prepared API file you have to load at least one *.api file and then compile it by clicking the Compile
APIs. . . button.

Astuce: Save the options

To save the state of console’s widgets you have to close the Python Console from the close button. This allows
you to save the geometry to be restored to the next start.
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CHAPTER 23

Aide et support

23.1 Listes de diffusion

QGIS est en cours de développement, par conséquent il ne fonctionne pas toujours comme prévu. La meilleure
manière d’obtenir de l’aide est de rejoindre la liste de diffusion qgis-users, vos questions toucheront une plus large
audience et les réponses profiteront à tous.

23.1.1 Utilisateurs QGIS

Cette liste est utilisée pour les discussions généralistes ainsi que pour des questions spécifiques en rapport avec
l’installation et l’utilisation de QGIS. Vous pouvez vous inscrire à la liste de diffusion qgis-users en allant sur la
page suivante : https://lists.osgeo.org/mailman/listinfo/qgis-user

23.1.2 Développeurs QGIS

Si vous êtes un développeur et que vous êtes face à un problème plus technique, il est préférable de rejoindre
la liste de diffusion qgis-developer. Cette liste est également un lieu ou les gens peuvent s’informer, collecter et
discuter de l’UX liée à QGIS (Expérience utilisateur) / problèmes d’utilisation. C’est ici: https://lists.osgeo.org/
mailman/listinfo/qgis-developer

23.1.3 Communauté QGIS

Cette liste reçoit les courriels des thématiques liés à la documentation, aux aides contextuelles, au guide utilisateur,
aux listes de diffusion, forums et efforts de traduction. Si vous voulez travailler sur le guide utilisateur, cette
liste est un bon point de départ pour poser vos questions. Vous pouvez vous inscrire à cette liste ici : https:
//lists.osgeo.org/mailman/listinfo/qgis-community-team

23.1.4 Traduction de QGIS

Cette liste se concentre sur l’effort de traduction. Si vous voulez travailler à la traduction du site web, du manuel
ou de l’interface, c’est un bon point de départ. Vous pouvez vous inscrire à cette liste ici : https://lists.osgeo.org/
mailman/listinfo/qgis-tr
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23.1.5 Comité de Direction du Projet QGIS (PSC)

Cette liste est utilisée pour les discussions du Steering Committee concernant la gestion générale et la direction
du projet QGIS. Vous pouvez vous inscrire à cette liste de diffusion en allant sur : https://lists.osgeo.org/mailman/
listinfo/qgis-psc

23.1.6 Groupes d’utilisateur QGIS

Afin de promouvoir localement QGIS et de contribuer à son développement, plusieurs communautés QGIS sont or-
ganisées dans des groupes d’utilisateurs QGIS. Ces groupes sont abilités à discuter de sujets locaux, d’organisation
de réunions régionales ou nationales des utilisateurs, d’organiser le parrainage de fonctionnalités . . . La liste des
groupes d’utilisateurs actuels est disponible sur https://qgis.org/en/site/forusers/usergroups.html

Vous êtes invités à vous inscrire à n’importe quelles listes. Contribuez également en répondant aux questions des
autres et en partageant votre expérience.

23.2 IRC

Nous maintenons une présence sur IRC - rejoignez-nous sur le canal #qgis sur irc.freenode.net. Faites preuve de
patience avant d’obtenir une réponse puisque la plupart des personnes font autre chose et cela peut leur prendre
un peu de temps avant de remarquer votre question. Si vous avez raté une discussion sur IRC, pas de soucis, nous
archivons tous les échanges ! Rendez-vous sur https://qgis.org/irclogs pour lire les logs IRC.

Un support commercial pour QGIS est disponible. Regardez la page du site https://qgis.org/en/
commercial-support.html pour plus d’informations.

23.3 BugTracker

Bien que la liste de diffusion utilisateur est utile pour des questions générales du type “Comment je fais ceci et
cela dans QGIS ?”, vous pouvez vouloir nous avertir de bugs dans QGIS. Vous pouvez soumettre un rapport de
bug en utilisant le suivi de bug sur https://issues.qgis.org/projects/qgis/issues. Lors de la création d’un ticket pour
un bug, veillez à fournir une adresse email valide via laquelle nous pouvons vous demander des informations
supplémentaires.

Garder en mémoire que votre bug peut ne pas avoir la priorité à laquelle vous vous attendiez (cela dépendra de sa
sévérité). Certains bugs peuvent nécessiter du travail supplémentaire de la part des développeurs pour y remédier
et la personne compétente n’est pas forcément disponible.

Les demandes de fonctionnalités supplémentaires peuvent être soumises également en utilisant le même système
de ticket que pour les bugs. Assurez-vous de sélectionner le type Feature.

Si vous avez trouvé un bug et l’avez corrigé vous même, vous pouvez soumettre une Pull Request sur le dépôt
GitHub du projet QGIS (option préférée) ou un patch. Encore une fois, le système de ticket redmine sur
https://issues.qgis.org/projects/qgis/issues dispose de cette fonctionnalité. Cochez Patch supplied dans le
formulaire et joignez votre patch avant de soumettre le rapport. Un des développeurs le vérifiera et l’appliquera
à QGIS. Ne vous alarmez pas si votre correctif n’est pas appliqué directement – les développeurs peuvent être
occupés sur d’autres tâches.

Notez que si vous soumettez une Pull Request, votre modification a plus de chances d’être rapidement intégrée
dans le code source!

23.4 Blog

La communauté QGIS tient également un blog sur https://planet.qgis.org/planet/ qui publie d’intéressants articles
à la fois pour les utilisateurs et les développeurs. Vos contributions sont les bienvenues !
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23.5 Extensions

Le site internet https://plugins.qgis.org sert de portail officiel pour les extensions QGIS. Il liste les extensions
officielles, stables et expérimentales, de QGIS disponibles depuis le dépôt “Official QGIS Plugin Repository”.

23.6 Wiki

Enfin, nous maintenons un site web wiki sur https://github.com/qgis/QGIS/wiki où vous pouvez trouver diverses
informations utiles liées au développement de QGIS, planning des versions, liens vers les sites de téléchargement,
astuces de traduction des messages et bien plus. Parcourez le, on y trouve mille choses intéressantes !
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CHAPTER 24

Contributeurs

QGIS est un projet open source développé par une équipe de volontaires d’organisations. Nous nous efforçons
d’être une communauté accueillante pour les personnes de toutes origines, genres et principes de vie. A tout
moment, vous pouvez vous impliquer.

24.1 Auteurs

Ci-dessous sont listés les personnes qui ont dédié leur temps et leur énergie pour écrire, réviser et mettre à jour
l’ensemble de la documentation QGIS.
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Tara Athan Radim Blazek K. Koy Godofredo Contr-
eras

Martin Dobias

Peter Ersts Anne Ghisla Stephan Holl
14. Horning

Magnus Homann

Werner Macho Denis Rouzaud Tyler Mitchell Claudia A. Engel Lars Luthman
Otto Dassau Brendan Morely David Willis Jürgen E. Fischer Yoichi Kayama
Alexander Bruy Anita Graser Victor Olaya Marco Hugentobler Gary E. Sherman
Tim Sutton Larissa Junek Raymond Nijssen Richard Duivenvo-

orde
Andreas Neumann

Astrid Emde Yves Jacolin Alexandre Neto Alessandro Pasotti Hien Tran-Quang
Andy Schmid Arnaud Morvan Akgar Gumbira Giovanni Allegri Diethard Jansen
Andy Allan Matthias Kuhn Chris Berkhout Carson J.Q. Farmer Steven Cordwell
Eric Goddard Frank Sokolic Luca Casagrande Harrissou Sant-

anna
Saber Razmjooei

Ilkka Rinne Jacob Lanstorp Ujaval Gandhi Jean-Roc Morreale Salvatore Larosa
João Gaspar Joshua Arnott Thomas Gratier Marco Bernasocchi Marie Silvestre
Ko Nagase Larry Shaffer Luigi Pirelli Konstantinos Niko-

laou
Maning Sambale

Manel Clos Mattheo Ghetta Bernhard Ströbl Luca Manganelli Nathan Woodrow
Nick Bearman Paul Blottière Vincent Picavet Maximilian Kram-

bach
René-Luc D’Hont

Tom Chadwin Patrick Sunter Nyall Dawson Milo Van der Lin-
den

Paolo Cavallini

Paolo Corti Hugo Mercier Gavin Macaulay Stefan Blumentrath Nicholas Duggan
David Adler Vincent Mora Tudor Bărăscu QGIS Koran Trans-

lator
Stéphane Brunner

Jaka Kranjc Tom Kralidis Zoltan Siki Sebastian Dietrich Uros Preloznik
Dick Groskamp Mezene Worku Alexandre Bus-

quets
Dominic Keller Andre Mano

Chris Mayo Håvard Tveite Mie Winstrup Jonathan Willitts Giovanni Manghi
Martina Savarese icephale Andrei GiordanoPezzola zstadler
Ramon embelding ajazepk

24.2 Traducteurs

QGIS est une application multi-langue et en tant que telle, publie également une documentation traduite dans
de nombreuses langues. Beaucoup d’autres langues sont traduites et seront utiliser dès qu’elles atteindront un
pourcentage de traduction raisonnable. Si vous désirez aider à améliorer une traduction ou en demander une
nouvelle, merci de vous reporter sur https://qgis.org/fr/site/getinvolved/index.html.

Les traductions actuelles ont été possible grâce à :
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LangueContributeurs
In-
donésien
ba-
hasien

Emir Hartato, I Made Anombawa, Januar V. Simarmata, Muhammad Iqnaul Haq Siregar, Trias Aditya

Chi-
nois
(Tra-
di-
tion-
nel)

Calvin Ngei, Zhang Jun, Richard Xie

Néer-
landais

Carlo van Rijswijk, Dick Groskamp, Diethard Jansen, Raymond Nijssen, Richard Duivenvoorde,
Willem Hoffman

FinnoisMatti Mäntynen, Kari Mikkonen
FrançaisArnaud Morvan, Augustin Roche, Didier Vanden Berghe, Dofabien, Etienne Trimaille, Harrissou Sant-

anna, Jean-Roc Morreale, Jérémy Garniaux, Loïc Buscoz, Lsam, Marc-André Saia, Marie Silvestre,
Mathieu Bossaert, Mathieu Lattes, Mayeul Kauffmann, Médéric Ribreux, Mehdi Semchaoui, Michael
Douchin, Nicolas Boisteault, Nicolas Rochard, Pascal Obstetar, Robin Prest, Rod Bera, Stéphane Hen-
riod, Stéphane Possamai, sylther, Sylvain Badey, Sylvain Maillard, Vincent Picavet, Xavier Tardieu,
Yann Leveille-Menez, yoda89

Gali-
cien

Xan Vieiro

Alle-
mand

Jürgen E. Fischer, Otto Dassau, Stephan Holl, Werner Macho

Hindi Harish Kumar Solanki
Ital-
ien

Alessandro Fanna, Anne Ghisla, Flavio Rigolon, Giuliano Curti, Luca Casagrande, Luca Delucchi,
Marco Braida, Matteo Ghetta, Maurizio Napolitano, Michele Beneventi, Michele Ferretti, Roberto An-
geletti, Paolo Cavallini, Stefano Campus

Japon-
ais

Baba Yoshihiko, Minoru Akagi, Norihiro Yamate, Takayuki Mizutani, Takayuki Nuimura, Yoichi
Kayama

CoréenOSGeo Korean Chapter
Polon-
ais

Andrzej Świąder, Borys Jurgiel, Ewelina Krawczak, Jakub Bobrowski, Mateusz Łoskot, Michał
Kułach, Michał Smoczyk, Milena Nowotarska, Radosław Pasiok, Robert Szczepanek, Tomasz Paul

Por-
tu-
gais

Alexandre Neto, Duarte Carreira, Giovanni Manghi, João Gaspar, Joana Simões, Leandro Infantini,
Nelson Silva, Pedro Palheiro, Pedro Pereira, Ricardo Sena

Por-
tu-
gais
(Brésil)

Arthur Nanni, Felipe Sodré Barros, Leônidas Descovi Filho, Marcelo Soares Souza, Narcélio de Sá
Pereira Filho, Sidney Schaberle Goveia

RoumainAlex Bădescu, Bogdan Pacurar, Georgiana Ioanovici, Lonut Losifescu-Enescu, Sorin Călinică, Tudor
Bărăscu

Russe Alexander Bruy, Artem Popov
Es-
pag-
nol

Carlos Dávila, Diana Galindo, Edwin Amado, Gabriela Awad, Javier César Aldariz, Mayeul Kauffmann

UkrainienAlexander Bruy
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CHAPTER 25

Annexe

25.1 licence GNU General Public License

Version 2, Juin 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Tout le monde est autorisé à copier et redistribuer à l’identique le texte de cette licence, mais le modifier n’est pas
autorisé.

Préambule

Les licences d’utilisation de la plupart des programmes sont définies pour limiter ou supprimer toute liberté à
l’utilisateur. À l’inverse, la GNU General Public License est destinée à vous garantir la liberté de partager et de
modifier les logiciels libres, et de s’assurer que ces logiciels sont effectivement accessibles à tout utilisateur. Cette
Licence Publique Générale s’applique à la plupart des programmes de la Free Software Foundation, comme à
tout autre programme dont l’auteur l’aura décidé (d’autres logiciels de la FSF sont couverts pour leur part par la
Licence Publique Générale pour Bibliothèques GNU (LGPL)). Vous pouvez aussi appliquer les termes de cette
Licence à vos propres programmes, si vous le désirez.

Liberté des logiciels ne signifie pas nécessairement gratuité. Notre Licence est conçue pour vous assurer la liberté
de distribuer des copies des programmes, gratuitement ou non, de recevoir le code source ou de pouvoir l’obtenir,
de modifier les programmes ou d’en utiliser des éléments dans de nouveaux programmes libres, en sachant que
vous y êtes autorisé.

Afin de garantir ces droits, nous avons dû introduire des restrictions interdisant à quiconque de vous les refuser ou
de vous demander d’y renoncer. Ces restrictions vous imposent en retour certaines obligations si vous distribuez
ou modifiez des copies de programmes protégés par la Licence.

Par exemple, si vous distribuez des copies de ce programme, soit gratuitement, soit contre une certaine somme
d’argent, vous devez transmettre aux destinataires tous les droits que vous possédez. Vous devez vous assurer
d’expédier aux destinataires le code source ou bien tenir celui-ci à leur disposition. Enfin, vous devez leur remettre
cette Licence afin qu’ils prennent connaissance de leurs droits.

Nous protégeons vos droits de deux façons : d’abord par le copyright du logiciel, ensuite par la remise de cette
Licence qui vous autorise légalement à copier, distribuer et/ou modifier le logiciel.

En outre, pour protéger chaque auteur ainsi que la FSF, nous affirmons solennellement que le programme concerné
ne fait l’objet d’aucune garantie. Si un tiers le modifie puis le redistribue, tous ceux qui en recevront une copie
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doivent savoir qu’il ne s’agit pas de l’original afin qu’une copie défectueuse n’entache pas la réputation de l’auteur
du logiciel.

Enfin, tout programme libre est sans cesse menacé par des dépôts de brevets. Nous souhaitons à tout prix éviter
que des distributeurs puissent déposer des brevets sur les Logiciels Libres pour leur propre compte. Pour éviter
cela, nous stipulons bien que tout dépôt éventuel de brevet doit accorder expressément à tout un chacun le libre
usage du produit.

Les dispositions précises et les conditions de copie, de distribution et de modification de nos logiciels sont les
suivantes : STIPULATIONS ET CONDITIONS RELATIVES A LA COPIE, LA DISTRIBUTION ET LA MOD-
IFICATION

0. La présente Licence s’applique à tout Programme (ou autre travail) où figure une note, placée par le déten-
teur des droits, stipulant que ledit Programme ou travail peut être distribué selon les termes de la présente
Licence. Le terme Programme désigne aussi bien le Programme lui-même que tout travail qui en est dérivé
selon la loi, c’est-à-dire tout ouvrage reproduisant le Programme ou une partie de celui-ci, à l’identique ou
bien modifié, et/ou traduit dans une autre langue (la traduction est considérée comme une modification).
Chaque personne concernée par la Licence Publique Générale sera désignée par le terme Vous.

Les activités autres que copie, distribution et modification ne sont pas couvertes par la présente Licence et
sortent de son cadre. Rien ne restreint l’utilisation du Programme et les données issues de celui-ci ne sont
couvertes que si leur contenu constitue un travail basé sur le logiciel (indépendemment du fait d’avoir été
réalisé en lançant le Programme). Tout dépend de ce que le Programme est censé produire.

1. Vous pouvez copier et distribuer des copies conformes du code source du Programme, tel que Vous l’avez
reçu, sur n’importe quel support, à condition de placer sur chaque copie un copyright approprié et une
restriction de garantie, de ne pas modifier ou omettre toutes les stipulations se référant à la présente Licence
et à la limitation de garantie, et de fournir avec toute copie du Programme un exemplaire de la Licence.

Vous pouvez demander une rétribution financière pour la réalisation de la copie et demeurez libre de pro-
poser une garantie assurée par vos soins, moyennant finances.

2. Vous pouvez modifier votre copie ou vos copies du Programme ou partie de celui-ci, ou d’un travail basé
sur ce Programme, et copier et distribuer ces modifications selon les termes de l’article 1, à condition de
Vous conformer également aux conditions suivantes :

(a) Ajouter aux fichiers modifiés l’indication très claire des modifications effectuées, ainsi que la date de
chaque changement.

(b) Distribuer sous les termes de la Licence Publique Générale l’ensemble de toute réalisation contenant
tout ou partie du Programme, avec ou sans modifications.

(c) Si le Programme modifié lit des commandes de manière interactive lors de son exécution, faire en
sorte qu’il affiche, lors d’une invocation ordinaire, le copyright approprié en indiquant clairement la
limitation de garantie (ou la garantie que Vous Vous engagez à fournir Vous-même), qu’il stipule que
tout utilisateur peut librement redistribuer le Programme selon les conditions de la Licence Publique
Générale GNU, et qu’il montre à tout utilisateur comment lire une copie de celle-ci (exception : si
le Programme original est interactif mais n’affiche pas un tel message en temps normal, tout travail
dérivé de ce Programme ne sera pas non plus contraint de l’afficher).

Toutes ces conditions s’appliquent à l’ensemble des modifications. Si des éléments identifiables de ce travail
ne sont pas dérivés du Programme et peuvent être raisonnablement considérés comme indépendants, la
présente Licence ne s’applique pas à ces éléments lorsque Vous les distribuez seuls. Mais, si Vous distribuez
ces mêmes éléments comme partie d’un ensemble cohérent dont le reste est basé sur un Programme soumis
à la Licence, ils lui sont également soumis, et la Licence s’étend ainsi à l’ensemble du produit, quel qu’en
soit l’auteur.

Cet article n’a pas pour but de s’approprier ou de contester vos droits sur un travail entièrement réalisé par
Vous, mais plutôt d’ouvrir droit à un contrôle de la libre distribution de tout travail dérivé ou collectif basé
sur le Programme.

En outre, toute fusion d’un autre travail, non basé sur le Programme, avec le Programme (ou avec un travail
dérivé de ce dernier), effectuée sur un support de stockage ou de distribution, ne fait pas tomber cet autre
travail sous le contrôle de la Licence.
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3. Vous pouvez copier et distribuer le Programme (ou tout travail dérivé selon les conditions énoncées dans
l’article 1) sous forme de code objet ou exécutable, selon les termes des articles 0 et 1, à condition de
respecter l’une des clauses suivantes :

(a) Fournir le code source complet du Programme, sous une forme lisible par un ordinateur et selon les
termes des articles 0 et 1, sur un support habituellement utilisé pour l’échange de données ; ou,

(b) Faire une offre écrite, valable pendant au moins trois ans, prévoyant de donner à tout tiers qui en fera
la demande une copie, sous forme lisible par un ordinateur, du code source correspondant, pour un
tarif n’excédant pas le coût de la copie, selon les termes des articles 0 et 1, sur un support couramment
utilisé pour l’échange de données informatiques ; ou,

(c) Informer le destinataire de l’endroit où le code source peut être obtenu (cette solution n’est recevable
que dans le cas d’une distribution non commerciale, et uniquement si Vous avez reçu le Programme
sous forme de code objet ou exécutable avec l’offre prévue à l’alinéa b ci-dessus).

Le code source d’un travail désigne la forme de cet ouvrage sous laquelle les modifications sont les plus
aisées. Sont ainsi désignés la totalité du code source de tous les modules composant un Programme exé-
cutable, de même que tout fichier de définition associé, ainsi que les scripts utilisés pour effectuer la com-
pilation et l’installation du Programme exécutable. Toutefois, l’environnement standard de développement
du système d’exploitation mis en oeuvre (source ou binaire) – compilateurs, bibliothèques, noyau, etc. –
constitue une exception, sauf si ces éléments sont diffusés en même temps que le Programme exécutable.

Si la distribution de l’exécutable ou du code objet consiste à offrir un accès permettant de copier le Pro-
gramme depuis un endroit particulier, l’offre d’un accès équivalent pour se procurer le code source au
même endroit est considéré comme une distribution de ce code source, même si l’utilisateur choisit de ne
pas profiter de cette offre.

4. Vous ne pouvez pas copier, modifier, céder, déposer ou distribuer le Programme d’une autre manière que
l’autorise la Licence Publique Générale. Toute tentative de ce type annule immédiatement vos droits
d’utilisation du Programme sous cette Licence. Toutefois, les tiers ayant reçu de Vous des copies du Pro-
gramme ou le droit d’utiliser ces copies continueront à bénéficier de leur droit d’utilisation tant qu’ils re-
specteront pleinement les conditions de la Licence.

5. Ne l’ayant pas signée, Vous n’êtes pas obligé d’accepter cette Licence. Cependant, rien d’autre ne Vous
autorise à modifier ou distribuer le Programme ou quelque travaux dérivés : la loi l’interdit tant que Vous
n’acceptez pas les termes de cette Licence. En conséquence, en modifiant ou en distribuant le Programme
(ou tout travail basé sur lui), Vous acceptez implicitement tous les termes et conditions de cette Licence.

6. La diffusion d’un Programme (ou de tout travail dérivé) suppose l’envoi simultané d’une licence autorisant
la copie, la distribution ou la modification du Programme, aux termes et conditions de la Licence. Vous
n’avez pas le droit d’imposer de restrictions supplémentaires aux droits transmis au destinataire. Vous
n’êtes pas responsable du respect de la Licence par un tiers.

7. Si, à la suite d’une décision de Justice, d’une plainte en contrefaçon ou pour toute autre raison (liée ou non
à la contrefaçon), des conditions Vous sont imposées (que ce soit par ordonnance, accord amiable ou autre)
qui se révèlent incompatibles avec les termes de la présente Licence, Vous n’êtes pas pour autant dégagé des
obligations liées à celle-ci : si Vous ne pouvez concilier vos obligations légales ou autres avec les conditions
de cette Licence, Vous ne devez pas distribuer le Programme.

Si une partie quelconque de cet article est invalidée ou inapplicable pour quelque raison que ce soit, le reste
de l’article continue de s’appliquer et l’intégralité de l’article s’appliquera en toute autre circonstance.

Le présent article n’a pas pour but de Vous pousser à enfreindre des droits ou des dispositions légales ni en
contester la validité ; son seul objectif est de protéger l’intégrité du système de distribution du Logiciel Libre.
De nombreuses personnes ont généreusement contribué à la large gamme de Programmes distribuée de cette
façon en toute confiance ; il appartient à chaque auteur/donateur de décider de diffuser ses Programmes selon
les critères de son choix.

Cette section a pour but de rendre totalement limpide ce que l’on pense être une conséquence du reste de la
présente Licence.

8. Si la distribution et/ou l’utilisation du Programme est limitée dans certains pays par des brevets ou des
droits sur des interfaces, le détenteur original des droits qui place le Programme sous la Licence Publique
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Générale peut ajouter explicitement une clause de limitation géographique excluant ces pays. Dans ce cas,
cette clause devient une partie intégrante de la Licence.

9. La Free Software Foundation se réserve le droit de publier périodiquement des mises à jour ou de nou-
velles versions de la Licence. Rédigées dans le même esprit que la présente version, elles seront cependant
susceptibles d’en modifier certains détails à mesure que de nouveaux problèmes se font jour.

Chaque version possède un numéro distinct. Si le Programme précise un numéro de version de cette Licence
et « toute version ultérieure », Vous avez le choix de suivre les termes et conditions de cette version ou de
toute autre version plus récente publiée par la Free Software Foundation. Si le Programme ne spécifie aucun
numéro de version, Vous pouvez alors choisir l’une quelconque des versions publiées par la Free Software
Foundation.

10. Si vous désirez incorporer des éléments du Programme dans d’autres Programmes libres dont les conditions
de distribution diffèrent, vous devez écrire à l’auteur pour lui en demander la permission. Pour ce qui est des
programmes directement déposés par la Free Software Foundation, écrivez-nous : une exception est toujours
envisageable. Notre décision sera basée sur notre volonté de préserver la liberté de notre Programme ou de
ses dérivés et celle de promouvoir le partage et la réutilisation du logiciel en général.

LIMITATION DE GARANTIE

11. Parce que l’utilisation de ce Programme est libre et gratuite, aucune garantie n’est fournie, comme le permet
la loi. Sauf mention écrite, les détenteurs du copyright et/ou les tiers fournissent le Programme en l’état, sans
aucune sorte de garantie explicite ou implicite, y compris les garanties de commercialisation ou d’adaptation
dans un but particulier. Vous assumez tous les risques quant à la qualité et aux effets du Programme. Si le
Programme est défectueux, Vous assumez le coût de tous les services, corrections ou réparations nécessaires.

12. Sauf lorsqu’explicitement prévu par la Loi ou accepté par écrit, ni le détenteur des droits, ni quiconque
autorisé à modifier et/ou redistribuer le Programme comme il est permis ci-dessus ne pourra être tenu pour
responsable de tout dommage direct, indirect, secondaire ou accessoire (pertes financières dues au manque
à gagner, à l’interruption d’activités ou à la perte de données, etc., découlant de l’utilisation du Programme
ou de l’impossibilité d’utiliser celui-ci).

Exception Qt à la GPL pour QGIS

De plus, l’équipe de développement de QGIS vous donne la permission, à titre d’exception spéciale, de lier le
code de ce programme avec la bibliothèque Qt, incluant sans limite les versions suivantes (à la fois libres et
commerciales) : Qt/Non-commercial Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded (ou avec des
versions modifiées de Qt qui utilisent la même licence que Qt) et de distribuer des combinaisons liées incluant les
deux. Vous devez respecter la GNU General Public Licence pour tout le code qui ne concerne pas Qt. Si vous
modifiez ce fichier, vous pouvez étendre cette exception à votre version de ce fichier mais vous n’êtes pas obligé
de le faire. Si vous ne voulez pas le faire, supprimez cette déclaration d’exception de votre version.

25.2 Licence GNU de documentation libre

Version 1.3, 3 Novembre 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

https://fsf.org/

Tout le monde est autorisé à copier et redistribuer à l’identique le texte de cette licence, mais le modifier n’est pas
autorisé.

Préambule

Le but de cette Licence est de rendre un manuel, un livre, ou un autre document fonctionnel et utile « libre » :
d’assurer à tout le monde la liberté effective de le copier et de le redistribuer, en le modifiant ou non, commerciale-
ment ou bénévolement. Accessoirement, cette Licence donne la possibilité à l’auteur et à l’éditeur d’être crédités
de leur travail, sans être considérés comme responsables des modifications faites par d’autres.
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Cette Licence est une sorte de « gauche d’auteur » (« copyleft »), ce qui signifie que les œuvres dérivées du
document doivent elles aussi être libres. Elle est le complément de la licence publique générale GNU, qui est une
licence de type gauche d’auteur conçue pour les logiciels libres.

Nous avons conçu cette Licence pour l’utiliser dans les manuels de logiciel libre, parce que les logiciels libres
nécessitent de la documentation libre : un programme libre doit être fourni avec des manuels assurant des libertés
identiques à celles qu’assurent le logiciel. Mais cette Licence n’est pas limitée aux manuels de logiciels : elle peut
être utilisée pour n’importe quelle œuvre textuelle, quel que soit le sujet traité, que cette œuvre soit publiée en tant
que livre imprimé ou non. Nous recommandons cette Licence principalement pour les œuvres à but éducatif ou
pour les manuels de référence.

1. APPLICABILITÉ ET DÉFINITIONS

Cette Licence s’applique à tout manuel ou autre œuvre, sur n’importe quel support, qui contient une mention,
placée par le détenteur des droits d’auteur, disant que le manuel ou l’œuvre peut être distribuée selon les termes
de cette Licence. Une telle mention accorde une autorisation valable dans le monde entier, gratuite, sans limite
de durée, d’utiliser l’œuvre selon les conditions établies ici. Le terme « Document », utilisé ci-après désigne tout
manuel ou œuvre contenant une telle mention. Tout membre du public est un licencié, et est désigné par « vous ».
Vous acceptez la licence si vous copiez, modifiez ou distribuez l’œuvre d’une façon qui requiert une permission
selon la loi sur le droit d’auteur.

Une « Version Modifiée » du Document désigne toute œuvre contenant le Document ou une portion du Document,
copié à l’identique, ou copié avec des modifications ou traduit dans une autre langue.

Une « Section Secondaire » est une annexe portant un nom spécifique ou une section préliminaire du Document
qui traite exclusivement de la relation des éditeurs ou des auteurs du Document au thème général du Document
(ou à des thèmes liés) et ne contient rien qui pourrait relever directement de ce thème général. (Ainsi, si le
Document est en partie un manuel de mathématiques, une Section Secondaire ne peut donner aucune explication
en mathématiques.) La relation peut être une connexion historique avec le sujet ou avec des sujets liés, ou elle
peut être un point de vue juridique, commercial, philosophique, éthique ou politique sur ces sujets.

Les « Sections Invariantes » sont certaines Sections Secondaires, dont les titres sont désignés comme étant des
Sections Invariantes dans la mention disant que le Document est publié selon les termes de cette Licence. Si
une section ne correspond pas à la définition de Section Secondaire établie ci-dessus, alors il n’est pas permis de
la désigner comme Invariante. Le Document peut contenir zéro Section Invariante. Si le Document n’identifie
aucune Section Invariante, alors il n’y en a aucune.

Les « Textes De Couverture » sont certains courts passages de texte qui sont mentionnés comme Textes De
Première De Couverture ou Textes De Quatrième De Couverture dans la mention disant que le Document est
publié selon les termes de cette Licence. Un Texte De Première De Couverture peut contenir 5 mots au maximum,
et un Texte De Quatrième De Couverture peut contenir 25 mots au maximum.

Une copie « Transparente » du Document désigne une copie lisible par une machine, représentée dans un format
dont les spécifications sont disponibles pour le grand public, qui permet de corriger facilement le document avec
des éditeurs de texte génériques ou (pour les images composées de pixels) avec des éditeurs d’image génériques
ou (pour les dessins) avec des éditeurs de dessin largement disponibles, et qui est approprié pour servir de données
d’entrée aux formateurs de texte ou pour être traduit automatiquement dans une variété de formats appropriés
pour servir de données d’entrée aux formateurs de texte. Une copie faite dans un format de fichier par ailleurs
Transparent, mais dont le marquage, ou l’absence de marquage, a été conçu de façon à empêcher ou décourager les
lecteurs de faire des modifications ultérieurement n’est pas Transparente. Un format d’image n’est pas Transparent
s’il est utilisé pour afficher toute quantité substantielle de texte. Une copie qui n’est pas « Transparente » est
appelée « Opaque ».

Voici des exemples de formats appropriés pour faire des copies Transparentes : du texte brut ASCII sans marquage
; le format d’entrée de Texinfo ; le format d’entrée de LaTeX ; le format SGML ou XML en utilisant une DTD
disponible publiquement ; du HTML simple et conforme aux standards ; du PostScript ou du PDF conçu pour
être modifié par des humains. Voici des exemple de formats d’image transparents : PNG, XCF et JPG. Voici des
exemples de formats opaques : les formats privateurs qui ne peuvent être lus et modifiés que par des logiciels
de traitement de texte privateurs ; du SGML ou du XML dont la DTD ou les outils de traitement ne sont pas
largement disponibles ; le HTML généré par une machine ; du PostScript ou du PDF produit par un logiciel de
traitement de texte dans un but d’affichage seulement.
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La « Page De Titre » désigne, pour un livre imprimé, la page de titre elle-même, plus les pages suivantes néces-
saires pour contenir, lisiblement, les mentions que cette Licence oblige à inscrire dans la page de titre. Pour les
œuvres dont le format ne possède pas de page de titre en tant que telle, « Page De Titre » désigne le texte placé à
côté de l’inscription la plus en vue du titre de l’œuvre, qui précède le début du corps du texte.

L” « éditeur » désigne toute personne ou entité qui distribue des copies du Document au public.

Une section « Intitulée XYZ » désigne soit une sous-unité du Document dont le titre est exactement XYZ, soit une
sous-unité du Document dont le titre contient XYZ entre parenthèses après le texte traduisant XYZ dans une autre
langue. (Ici XYZ représente un nom de section spécifique mentionné ci-après, tel que « Acknowledgements »
[Remerciements], « Dedications » [Dédicaces], « Endorsements » [Approbations], ou « History » [Historique]).
« Conserver le Titre » d’une telle section, quand vous modifiez le Document, signifie que cette section reste une
section « Intitulée XYZ » selon la présente définition.

Le Document peut inclure des Mentions De Limitation De Garantie à côté de la mention indiquant que cette
Licence s’applique au Document. Ces Mentions De Limitation De Garantie sont considérées comme incluses
par référence dans cette Licence, mais elles ne peuvent que limiter des garanties : toute autre implication que
ces Mentions De Limitation De Garantie pourraient avoir est nulle et n’a aucun effet sur la signification de cette
Licence.

2. COPIE À L’IDENTIQUE

Vous pouvez copier et distribuer le Document sur tout support, commercialement ou bénévolement, à condition
que cette Licence, les mentions de droit d’auteur, et la mention disant que cette Licence s’applique au Document
soient reproduites dans toutes les copies, et que vous n’ajoutiez absolument aucune autre condition aux conditions
de cette Licence. Vous ne pouvez pas utiliser de mesures techniques pour entraver ou contrôler la lecture ou la
copie des copies que vous faites ou distribuez. Toutefois, vous pouvez accepter une rémunération en échange de
copies. Si vous distribuez un nombre de copies suffisamment important, vous devez aussi vous conformer aux
conditions de la section 3.

Vous pouvez aussi prêter des copies, selon les mêmes conditions que ci-dessus, et vous pouvez afficher publique-
ment des copies.

3. COPIE EN GRANDE QUANTITÉ

Si vous publiez plus de 100 copies imprimées (ou 100 copies dans un média qui a communément une couverture
imprimée) du Document, et que la mention de licence du Document indique qu’il y a des Textes De Couverture,
vous devez insérer chaque copie dans une couverture qui porte, clairement et lisiblement, tous ces Textes De
Couverture : les Textes De Première De Couverture sur la première de couverture, et les Textes De Quatrième De
Couverture sur la quatrième de couverture. Ces deux pages de couvertures doivent aussi vous identifier clairement
et lisiblement comme l’éditeur de ces copies. La première de couverture doit présenter le titre complet, et tous
les mots du titre doivent avoir la même importance et la même visibilité. Vous pouvez ajouter d’autres choses
en supplément sur la couverture. Faire des copies avec des changements uniquement sur la couverture, tant que
les copies conservent le titre du Document et satisfont ces conditions, est considéré comme faire des copies à
l’identique.

Si les textes requis pour l’une ou l’autre des pages de couverture sont trop volumineux pour y figurer lisiblement,
vous devez mettre les premiers de la liste (autant qu’il est possible d’en mettre de façon lisible) sur la page de
couverture elle-même, et mettre le reste sur les pages adjacentes.

Si vous publiez ou distribuez plus de 100 copies Opaques du Document, vous devez soit inclure une copie Trans-
parente et lisible par une machine avec chaque copie Opaque, soit indiquer dans chaque copie Opaque (ou dans
une notice accompagnant chaque copie opaque) un emplacement sur le réseau informatique à partir duquel le
grand public utilisant le réseau peut accéder au téléchargement, en utilisant des protocoles réseau publics et stan-
dards, d’une copie complète et Transparente du Document, sans aucun ajout. Si vous utilisez cette dernière option,
vous devez prendre des précautions raisonnablement prudentes, quand vous commencez la distribution de copies
Opaques en grande quantité, pour garantir que cette copie Transparente restera accessible par les moyens et à
l’emplacement indiqués pendant au moins un an après la dernière distribution de copie Opaque (directement ou
par l’intermédiaire de vos agents ou de vos revendeurs au détail) de cette édition au public.

Il est demandé, sans que cela soit une obligation, que vous contactiez les auteurs du Document bien avant de
redistribuer tout nombre important de copies, pour leur donner une chance de vous fournir une version mise à jour
du Document.
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4. MODIFICATIONS

Vous pouvez copier et distribuer une Version Modifiée du Document selon les conditions des sections 2 et 3 ci-
dessus, à condition que vous accordiez le droit à tous ceux à qui vous distribuez la Version Modifiée de copier
et de distribuer la Version Modifiée selon les termes de cette Licence, avec la Version Modifiée jouant le rôle
du Document, autorisant ainsi la distribution et la modification de la Version Modifiée à toute personne qui en
possède une copie. De plus, vous devez faire les choses suivantes dans la Version Modifiée :

1. Utiliser dans la Page De Titre (et sur la couverture, s’il y en a) un titre distinct de celui du Document et
de ceux des précédentes versions (qui devraient, s’il y en a, être énumérées dans la section History de ce
Document). Vous pouvez utiliser le même titre que celui d’une version précédente si l’éditeur original de
cette version vous en donne la permission.

2. Citer sur la Page De Titre, en tant qu’auteurs, une ou plusieurs personnes ou entités responsables des modi-
fications faites dans la Version Modifiée, ainsi qu’au moins cinq des auteurs principaux du Document (tous
les auteurs principaux, s’il y en a moins de cinq), sauf s’ils vous dispensent de cette obligation.

3. Spécifier sur la Page de titre le nom de l’éditeur de la Version Modifiée, en précisant que c’est lui l’éditeur.

4. Conserver toutes les mentions de droit d’auteur du Document.

5. Ajouter une mention appropriée indiquant vos droits d’auteur pour les modifications que vous avez faites ;
cette mention doit être adjacente aux autres mentions de droit d’auteur.

6. Inclure, immédiatement après les mentions de droit d’auteur, une mention de licence donnant la permission
au public d’utiliser la Version Modifiée selon les termes de cette Licence, en respectant la forme indiquée
dans la section Addendum ci-dessous.

7. Conserver dans cette mention de licence les listes complètes des Sections Invariantes et des Textes De
Couverture inscrites dans la mention de licence du Document.

8. Inclure une copie non modifiée de cette Licence.

9. Conserver la section Intitulée « History », Conserver son Titre, et ajouter à cette section un paragraphe
indiquant au minimum le titre, l’année, les nouveaux auteurs, et l’éditeur de la Version Modifiée comme
cela est fait sur la Page De Titre. S’il n’y a pas de section Intitulée « History » dans le Document, en
créer une qui indique le titre, l’année, les auteurs, et l’éditeur du Document comme cela est fait sur la Page
De Titre, et ensuite ajouter un paragraphe décrivant la Version Modifiée comme indiqué dans la phrase
précédente.

10. Conserver l’indication d’emplacement sur le réseau, s’il y en a une, donnée dans le Document pour
l’accès public à une copie Transparente du Document, et Conserver de la même manière les indications
d’emplacement sur le réseau données dans le Document pour les versions précédentes sur lesquelles il
est basé. Celles-ci peuvent être placées dans la section « History ». Vous pouvez omettre une indication
d’emplacement sur le réseau pour une œuvre qui a été publiée au moins quatre ans avant le Document
lui-même, ou si l’éditeur original de la version à laquelle elle réfère vous en donne la permission.

11. Pour toute section Intitulée « Acknowledgements » ou « Dedications », Conserver le Titre de la section et,
à l’intérieur de la section, toute la substance et le ton de chacun des remerciements aux contributeurs ou de
chacune des dédicaces qui y figure.

12. Conserver toutes les Sections Invariantes du Document, non modifiées dans leurs textes et dans leurs titres.
Les numéros de sections ou leurs équivalents ne sont pas considérés comme faisant partie des titres de
section.

13. Supprimer toute section Intitulée « Endorsements ». Une telle section ne peut pas être incluse dans la
Version Modifiée.

14. Ne pas modifier le titre d’une section existante en lui donnant le titre « Endorsements » ou en lui donnant
un titre qui entre en conflit avec le titre d’une Section Invariante.

15. Conserver toute Mention De Limitation De Garantie.

Si la Version Modifiée inclut de nouvelles sections préliminaires ou de nouvelles annexes qui répondent à la
définition de Sections Secondaires et ne contiennent rien qui soit copié du Document, vous pouvez si vous le
souhaitez désigner certaines ou toutes ces sections comme invariantes. Pour faire cela, ajoutez leurs titres à la liste
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des Sections Invariantes dans la mention de licence de la Version Modifiée. Ces titres doivent être distincts de tout
autre titre de section.

Vous pouvez ajouter une section Intitulée « Endorsements », à condition qu’elle ne contienne que des marques de
soutien pour votre Version Modifiée faites par d’autres parties—par exemple, des déclarations d’évaluation par les
pairs ou des déclarations stipulant que votre texte a été approuvé par une organisation comme définition officielle
d’un standard.

Vous pouvez ajouter un passage de cinq mots au maximum comme Texte De Première De Couverture, et un
passage de 25 mots au maximum comme Texte De Quatrième De Couverture, à la fin de la liste des Textes De
Couverture dans la Version Modifiée. Un seul passage de Texte De Première De Couverture et un seul passage
de Texte De Quatrième De Couverture peut être ajouté par (ou par l’intermédiaire d’arrangements faits par) une
même entité. Si le Document inclut déjà un texte pour la même page de couverture, précédemment ajouté par
vous ou par arrangement fait par la même entité que celle au nom de laquelle vous agissez, vous ne pouvez pas
en ajouter d’autre ; mais vous pouvez remplacer l’ancien à condition que l’éditeur précédent ayant placé l’ancien
texte vous en donne la permission explicite.

Par cette Licence, l’auteur (ou les auteurs) et l’éditeur (ou les éditeurs) du Document ne donnent pas la permission
d’utiliser leurs noms pour un usage publicitaire ou pour exprimer explicitement ou implicitement leur soutien à
une Version Modifiée.

5. COMBINAISON DE DOCUMENTS

Vous pouvez combiner le Document avec d’autres documents publiés selon les termes de cette Licence, à condition
de respecter les termes définis dans la section 4 ci-dessus pour les Versions Modifiées, et à condition que vous
incluiez dans la combinaison toutes les Sections Invariantes de tous les documents originaux, non modifiées, et
que vous les énumériez toutes comme Sections Invariantes de votre œuvre combinée dans sa mention de licence,
et que de plus vous conserviez toutes les Mentions De Limitation De Garantie de tous les documents originaux.

L’œuvre combinée n’a besoin de contenir qu’une seule copie de cette Licence, et de multiples Sections Invariantes
identiques peuvent être remplacées par une seule d’entre elles. S’il y a plusieurs Sections Invariantes avec le même
nom mais avec des contenus différents, rendez unique le titre de chaque section en question en ajoutant à la fin de
celui-ci, entre parenthèses, le nom de l’auteur ou de l’éditeur original de cette section s’il est connu, ou, à défaut,
un nombre unique. Faites le même ajustement aux titres de section dans la liste des Sections Invariantes figurant
dans la mention de licence de l’œuvre combinée.

Dans la combinaison, vous devez combiner toutes les sections Intitulées « History » de tous les documents orig-
inaux, en formant une unique section Intitulée « History » ; de la même manière, combinez toutes les sections
Intitulées « Acknowledgements », puis toutes les sections Intitulées « Dedications ». Vous devez supprimer toutes
les sections Intitulées « Endorsements ».

6. COLLECTIONS DE DOCUMENTS

Vous pouvez faire une collection composée du Document et d’autres documents publiés selon les termes de cette
Licence, et remplacer les copies individuelles de cette Licence dans les divers documents par une unique copie
incluse dans la collection, à condition qu’à tous les autres égards et pour chacun des documents vous vous con-
formiez aux règles de cette Licence régissant la copie à l’identique.

Vous pouvez extraire un document d’une telle collection, et le distribuer individuellement selon les termes de cette
Licence, à condition que vous insériez une copie de cette Licence dans le document extrait, et que vous vous
conformiez à cette Licence à tous les autres égards, en ce qui concerne la copie du document extrait.

7. AGRÉGATION AVEC DES ŒUVRES INDÉPENDANTES

Une compilation du Document ou de ses dérivés avec d’autres documents ou œuvres séparés et indépendants, dans
une unité de stockage ou sur un support de distribution, est appelée « agrégat » si le droit d’auteur résultant de la
compilation n’est pas utilisé pour limiter les droits légaux des utilisateurs de la compilation au-delà de ce que les
œuvres individuelles permettent. Quand le Document est inclus dans un agrégat, cette Licence ne s’applique pas
aux autres œuvres de l’agrégat qui ne sont pas elles-mêmes des œuvres dérivées du Document.

Si l’obligation de Texte De Couverture de la section 3 est applicable à ces copies du Document, alors si le Doc-
ument correspond à moins de la moitié de l’agrégat entier, les Textes De Couverture du Document peuvent être
placés sur la couverture qui contient le Document à l’intérieur de l’agrégat, ou l’équivalent électronique de cette
couverture si le Document est sous forme électronique. Dans le cas contraire, elles doivent apparaître sur la
couverture imprimée qui contient l’agrégat entier.
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8. TRADUCTION

Une compilation du Document ou de ses dérivés avec d’autres documents ou œuvres séparés et indépendants, dans
une unité de stockage ou sur un support de distribution, est appelée « agrégat » si le droit d’auteur résultant de la
compilation n’est pas utilisé pour limiter les droits légaux des utilisateurs de la compilation au-delà de ce que les
œuvres individuelles permettent. Quand le Document est inclus dans un agrégat, cette Licence ne s’applique pas
aux autres œuvres de l’agrégat qui ne sont pas elles-mêmes des œuvres dérivées du Document.

Si une section du Document est Intitulée « Acknowledgements », « Dedications », ou « History », l’obligation
(section 4) de Conserver son Titre (section 1) nécessitera typiquement un ajustement du titre traduit.

9. EXPIRATION

Vous ne pouvez pas copier, modifier, sous-licencier, ou distribuer le Document sauf aux conditions expressément
prévues par la présente Licence. Toute tentative de le copier, le modifier, le sous-licencier ou le distribuer d’une
autre manière est nulle, et entrainera automatiquement l’expiration des droits qui vous ont été conférés par cette
Licence.

Toutefois, si vous cessez toute violation de cette Licence, alors la licence qui vous a été octroyée par un détenteur
particulier des droits d’auteur est rétablie (a) provisoirement, sauf si et jusqu’à ce que le détenteur des droits
d’auteur annule votre licence de manière explicite et définitive, et (b) définitivement, si le détenteur des droits
d’auteur ne parvient pas à vous notifier la violation par des moyens raisonnables dans un délai de 60 jours après
la cessation de la violation.

De plus, la licence qui vous a été octroyée par un détenteur particulier des droits d’auteur est rétablie définitivement
si ce détenteur des droits d’auteur vous notifie de la violation par des moyens raisonnables, si c’est la première
fois que vous avez reçu une notification de violation de cette Licence (pour toute œuvre) de la part de ce même
détenteur des droits d’auteur, et si vous remédiez à la violation dans un délai de 30 jours après avoir reçu la
notification.

L’expiration de vos droits engendrée par cette section n’entraine pas l’expiration des licences des parties
auxquelles vous avez envoyé des copies en les autorisant à utiliser les copies selon les termes de cette Licence. Si
vos droits ont expirés et n’ont pas été rétablis définitivement, le fait de recevoir une copie de la même œuvre ou
une copie d’une partie de la même œuvre ne vous donne aucun droit de l’utiliser.

10. RÉVISIONS FUTURES DE CETTE LICENCE

Il se peut que de temps en temps la Free Software Foundation publie une nouvelle version, révisée, de la licence
GNU de documentation libre. Ces nouvelles versions seront dans le même esprit, mais elles pourront différer dans
les détails, pour répondre à de nouveaux problèmes ou inquiétudes. Référez-vous à https://www.gnu.org/copyleft/.

Chaque version de la Licence possède un numéro de version distinct. Si le Document spécifie qu’il peut être
utilisé selon les termes d’une version numérotée particulière de cette Licence « ou toute version ultérieure », vous
avez le choix de vous conformer aux termes et aux conditions de la version spécifiée ou de toute version ultérieure
qui a été publiée (pas en tant que brouillon) par la Fondation pour le logiciel libre. Si le Document ne spécifie
pas de numéro de version, vous pouvez choisir n’importe quelle version publiée (pas en tant que brouillon) par la
Fondation pour le logiciel libre. Si le Document spécifie qu’un serveur mandataire peut décider quelles versions
futures de cette Licence peuvent être utilisées, la déclaration publique d’acceptation d’une version de la part de ce
serveur mandataire vous autorise de manière permanente à choisir cette version pour utiliser le Document.

11. RELICENCIER

« Site de Collaboration Massive Multi-auteur » (ou « Site CMM ») désigne tout serveur du World Wide Web qui
publie des œuvres auxquelles le droit d’auteur est applicable et qui fournit aussi une infrastructure conséquente
permettant à n’importe qui de modifier ces œuvres. Un wiki public que tout le monde peut modifier est un exemple
d’un tel serveur. Une « Collaboration Massive Multi-auteur » (ou « CMM ») contenue dans ce site désigne tout
ensemble d’œuvres concernées par le droit d’auteur ainsi publiées sur le site CMM.

« CC-BY-SA » désigne la licence Creative Commons attribution de paternité, partage à l’identique, 3.0, publiée
par l’organisation Creative Commons, une organisation à but non lucratif basée à San Francisco, en Californie,
ainsi que toute version future de type gauche d’auteur de cette licence, publiée par la même organisation.

« Incorporer » signifie publier ou republier un Document, en entier ou en partie, comme partie d’un autre Docu-
ment.
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Une CMM est « éligible pour relicencier » si elle est licenciée sous cette Licence, et si toutes les œuvres qui
ont été publiées antérieurement sous cette Licence ailleurs que sur cette CMM, et incorporées ensuite en totalité
ou en partie dans la CMM, (1) n’ont pas de textes de couverture ou de sections invariantes, et (2) ont été ainsi
incorporées avant le premier novembre 2008.

L’opérateur d’un Site CMM peut republier une CMM contenue dans le site sous licence CC-BY-SA sur le même
site, à n’importe quelle date avant le premier août 2009, à condition que la CMM soit éligible pour relicencier.

ADDENDUM : Comment utiliser cette Licence dans vos documents

Pour utiliser cette Licence dans un document que vous avez écrit, incluez une copie de cette Licence dans le
document et inscrivez les mentions de droit d’auteur et de licence suivantes juste après la page de titre :

Copyright © YEAR YOUR NAME.
Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.3
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled "GNU
Free Documentation License".

Si vous avez des Sections Invariantes, des Textes De Première de Couverture et des Textes De Quatrième De
Couverture, remplacez les lignes « sans Texte . . . » par :

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

Si vous avez des Sections Invariantes mais pas de Texte De Couverture, ou une autre combinaison des trois,
fusionner les deux possibilités pour que cela convienne à la situation.

Si votre document contient des exemples non triviaux de code source de logiciel, nous recommandons de publier
ces exemples en parallèle sous une licence de logiciel libre de votre choix, telle que la licence publique générale
GNU, pour permettre leur utilisation dans des logiciels libres.
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